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SAFETY PRECAUTIONS
Always read the precautions before using this product.
Also read this manual and the relevant manuals mentioned in this manual carefully, and use the product properly while paying 
full attention to safety.
Note that the precautions in this manual apply only to this product.
The safety precautions are divided into the following levels: warnings and cautions.

Note that failure to observe  CAUTION may lead to a serious accident depending on the circumstances.
Make sure to observe both warnings and cautions to ensure personal safety.
Ensure that this manual is easily accessible to all users of this product.

[DESIGN PRECAUTIONS]

WARNING
● Some failures of the personal computer, interface board, or cables may cause GT SoftGOT2000 to 

keep turning on or off an output.
An external monitoring circuit should be provided to check for output signals which may lead to a 
serious accident.
Not doing so may cause an accident due to a false output or malfunction.

● Do not use GT SoftGOT2000 as the warning device that may cause a serious accident.
An independent and redundant hardware or mechanical interlock is required to configure a device that 
displays or outputs a serious warning.
Not doing so may cause an accident due to a false output or malfunction.

● If you have changed a program or parameter of the controller (such as a PLC) that is monitored by GT 
SoftGOT2000, restart GT SoftGOT2000.
Not doing so may cause an accident due to a false output or malfunction.

● Create safety circuits external to the PLC to ensure that the entire system works safely even if the 
personal computer fails.
Not doing so may cause an accident due to a false output or malfunction.
(1) Create the following circuits external to the PLC: emergency stop circuits, protection circuits, 

interlock circuits that prevent an invert operation (such as a forward/reverse rotation), and 
interlock circuits that prevent a machine breakage (such as positioning at the upper or lower limit).

(2) If the station with an interface board is disconnected from the data link due to a data link error, the 
other stations retain the last-minute data output from that station. The data is retained until the 
data link resumes (the disconnected station is returned).
Establish a mechanism so that each station in the data link system monitors the data link status 
and handles data link errors.

● For the operating status of each station if an error occurs in network communications, refer to the 
manual for the interface board used.
Not doing so may cause an accident due to a false output or malfunction.

WARNING

CAUTION

Indicates that incorrect handling may cause hazardous conditions, 
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions, 
resulting in minor or moderate injury or property damage.
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[DESIGN PRECAUTIONS]

[DESIGN PRECAUTIONS]

[WIRING PRECAUTIONS]

WARNING
● If you change the data during operation, provide an interlock by using the program of the PLC to 

ensure that the entire system always works safely.
Establish a mechanism to handle data communication between the personal computer and PLC CPU 
if a data communication error occurs in the system.

● To maintain the security (confidentiality, integrity, and availability) of the GOT and the system against 
unauthorized access, DoS*1 attacks, computer viruses, and other cyberattacks from unreliable 
networks and devices via network, take appropriate measures such as firewalls, virtual private 
networks (VPNs), and antivirus solutions.
Mitsubishi Electric shall have no responsibility or liability for any problems involving GOT trouble and 
system trouble by unauthorized access, DoS attacks, computer viruses, and other cyberattacks.
*1 DoS: A denial-of-service (DoS) attack disrupts services by overloading systems or exploiting 
vulnerabilities, resulting in a denial-of-service (DoS) state.

CAUTION
● Do not run the control line cables and communication cables together with or near the main circuit 

cables, power line cables, etc.
Keep a distance of 100 mm or more between them as a guide.
Not doing so may cause a malfunction due to noise.

● When a GOT1000 series model is on an Ethernet network, do not set the IP address 192.168.0.18 for 
the GOT and the controller on this network.
Doing so may cause IP address duplication at the GOT startup, adversely affecting the 
communication of the device with the IP address 192.168.0.18.
The operation at IP address duplication depends on the devices and the system.

● Turn on the controllers and the network devices to be ready for communication before they 
communicate with GT SoftGOT2000.
Not doing so may cause a communication error on GT SoftGOT2000.

WARNING
● Make sure to shut off the external power supply for the system in all phases before wiring.

Not doing so may result in an electric shock, product damage or malfunction.



[WIRING PRECAUTIONS]

[TEST OPERATION PRECAUTIONS]

[STARTUP/MAINTENANCE PRECAUTIONS]

[REMOTE CONTROL PRECAUTIONS]

CAUTION
● Connect the communication cable to the interface connector of the personal computer, and tighten the 

mounting screws and terminal screws in the specified torque range.
Undertightening may cause a short circuit or malfunction.
Overtightening may damage the screws or personal computer interface, causing a short circuit or 
malfunction.

WARNING
● Before testing the operation of a user-created screen (such as turning on or off a bit device, changing 

the current value of a word device, changing the set value or current value of a timer or counter, and 
changing the current value of a buffer memory), thoroughly read the manual to fully understand the 
operating procedure.
During the test operation, never change the data of the devices which are used to perform significant 
operation for the system.
Doing so may cause an accident due to a false output or malfunction.

WARNING
● Do not touch the terminals while power is on.

Doing so may cause an electric shock or malfunction.
● Before cleaning or terminal screw retightening, make sure to shut off the external power supply in all 

phases.
Not doing so may cause damage to the personal computer interface or malfunction.
Undertightening may cause a short circuit or malfunction.
Overtightening may damage the screws or personal computer interface, causing a short circuit or 
malfunction.

WARNING
● Remote control is available through a network by using GOT functions, including the SoftGOT-GOT 

link function, the remote personal computer operation function, the VNC server function, and the GOT 
Mobile function.
If these functions are used to perform remote control of control equipment, the field operator may not 
notice the remote control, possibly leading to an accident.
In addition, a communication delay or interruption may occur depending on the network environment, 
and remote control of control equipment cannot be performed normally in some cases.
Before using the above functions to perform remote control, fully grasp the circumstances of the field 
site and ensure safety.
3
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[EXCLUSIVE AUTHORIZATION CONTROL PRECAUTIONS]

WARNING
● If you use the GOT network interaction function to control the authorization among pieces of 

equipment to prevent simultaneous operations, make sure to fully understand the function.
The exclusive authorization control of the GOT network interaction function can be enabled or 
disabled for each screen. (By default, the exclusive authorization control is disabled for all screens.)
Properly determine the screens for which the exclusive authorization control is required, and set the 
control by screen.
A screen for which the exclusive authorization control is disabled can be operated simultaneously 
from pieces of equipment. Make sure to determine the operation period for each operator, fully grasp 
the circumstances of the field site, and ensure safety to perform operations.



CAUTIONS FOR USING THIS SOFTWARE

Required PC memory
The processing may be terminated by Microsoft Windows on a personal computer of which main memory capacity is less than 
128M bytes. Make sure to secure the capacity of 128M bytes or more.

Free capacity of hard disk
At least 100M bytes of free capacity of virtual memory should be secured within hard disk to run this software.
The processing may be terminated by Windows, if free space of 100M bytes or more cannot be secured within hard disk while 
running GTSoftGOT2000.
Secure enough free capacity of virtual memory within hard disk space in order to run the software.

Display of GT SoftGOT2000 and GOT
Display of GT SoftGOT2000 may be different from display of GOT.
Confirm for actual display of GOT on the GOT.
5
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INTRODUCTION
Thank you for choosing Mitsubishi Electric Graphic Operation Terminal (GOT).
Before using the product, read this manual carefully and make sure you understand the functions and performance of the 
GOT for correct use.
Manuals for GT Works3
Abbreviations, Generic Terms, and Model Icons

How to Use Help
Displaying Help
Using Help

Displaying Help
■Displaying Help from the menu
To display Help, select [Help] → [GT SoftGOT2000 Help] from the menu.

■Difference between GT SoftGOT2000 and GT Designer3
On GT Designer3, display Help (e-Manual) by pressing the [F1] key.
On GT SoftGOT2000, display Help from the menu because the [F1] key is not usable.

Using Help
Help is viewable using e-Manual Viewer.
For information on how to use e-Manual Viewer, refer to the following.
e-Manual Viewer Help
15
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Manuals for GT Works3
The electronic manuals related to this product are installed together with the screen design software.
If you need the printed manuals, consult your local sales office.

Manuals for GT Designer3 (GOT2000)

e-Manual refers to the Mitsubishi Electric FA electronic book manuals that can be browsed using a dedicated 
tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • Hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.
 • Sample programs can be copied to the engineering tool.

■Screen design software-related manuals

■Connection manuals

■GT SoftGOT2000 manuals

Manual name Manual number
(Model code)

Format

GT Works3 Installation Instructions - PDF

GT Designer3 (GOT2000) Screen Design Manual SH-081220ENG
(1D7ML9)

PDF
e-Manual

GT Converter2 Version3 Operating Manual for GT Works3 SH-080862ENG PDF
e-Manual

GOT2000 Series MES Interface Function Manual for GT Works3 Version1 SH-081228ENG PDF
e-Manual

Manual name Manual number
(Model code)

Format

GOT2000 Series Connection Manual (Mitsubishi Electric Products) For GT Works3 Version1 SH-081197ENG
(1D7MJ8)

PDF
e-Manual

GOT2000 Series Connection Manual (Non-Mitsubishi  Electric Products 1) For GT Works3 
Version1

SH-081198ENG PDF
e-Manual

GOT2000 Series Connection Manual (Non-Mitsubishi  Electric Products 2) For GT Works3 
Version1

SH-081199ENG PDF
e-Manual

GOT2000 Series Connection Manual (Microcomputers, MODBUS/Fieldbus Products, Peripherals) 
For GT Works3 Version1

SH-081200ENG PDF
e-Manual

GOT2000 Series Handy GOT Connection Manual For GT Works3 Version1 SH-081867ENG
(1D7MS9)

PDF
e-Manual

GOT2000 Series Connection Manual (α2 Connection) for GT Works3 Version1 JY997D52301 PDF
e-Manual

Manual name Manual number
(Model code)

Format

GT SoftGOT2000 Version1 Operating Manual SH-081201ENG PDF
e-Manual

MELSOFT GT OPC UA Client Operating Manual SH-082174ENG PDF



■GOT2000 series user's manuals

■GOT SIMPLE series user's manuals

■Manuals related to GT Works3 add-on projects

Manuals for GT Designer3 (GOT1000)
Refer to the Help and manuals for GT Designer3 (GOT1000).

Manual name Manual number
(Model code)

Format

GOT2000 Series User's Manual (Hardware) SH-081194ENG
(1D7MJ5)

PDF
e-Manual

GOT2000 Series User's Manual (Utility) SH-081195ENG
(1D7MJ6)

PDF
e-Manual

GOT2000 Series User's Manual (Monitor) SH-081196ENG
(1D7MJ7)

PDF
e-Manual

Manual name Manual number Format
GOT SIMPLE Series User's Manual JY997D52901 PDF

e-Manual

Manual name Manual number
(Model code)

Format

GT Works3 Add-on License for GOT2000 Enhanced Drive Control (Servo) Project Data Manual 
(Fundamentals)

SH-082072ENG
(1D7MV1)

PDF
e-Manual

GT Works3 Add-on License for GOT2000 Enhanced Drive Control (Servo) Project Data Manual 
(Screen Details)

SH-082074ENG
(1D7MV3)

PDF
e-Manual
17
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Abbreviations, Generic Terms, and Model Icons
The following shows the abbreviations, generic terms, and model icons used in this manual.

GOT
■GOT2000 series
Abbreviations and generic terms Description Meaning of icon

Available Unavailable
GT27 GT27-X GT2715-X GT2715-XTBA

GT2715-XTBD

GT27-S GT2712-S GT2712-STBA
GT2712-STWA
GT2712-STBD
GT2712-STWD

GT2710-S GT2710-STBA
GT2710-STBD

GT2708-S GT2708-STBA
GT2708-STBD

GT27-V GT2710-V GT2710-VTBA
GT2710-VTWA
GT2710-VTBD
GT2710-VTWD

GT2708-V GT2708-VTBA
GT2708-VTBD

GT2705-V GT2705-VTBD

GT25 All GT25 models

GT25-W GT2512-WX GT2512-WXTBD
GT2512-WXTSD

GT2510-WX GT2510-WXTBD
GT2510-WXTSD

GT2507-W GT2507-WTBD
GT2507-WTSD

GT2507T-W GT2507T-WTSD

GT25-S GT2512-S GT2512-STBA
GT2512-STBD

GT2512F-S GT2512F-STNA
GT2512F-STND

GT25-V GT2510-V GT2510-VTBA
GT2510-VTWA
GT2510-VTBD
GT2510-VTWD

GT2510F-V GT2510F-VTNA
GT2510F-VTND

GT2508-V GT2508-VTBA
GT2508-VTWA
GT2508-VTBD
GT2508-VTWD

GT2508F-V GT2508F-VTNA
GT2508F-VTND

GT2505-V GT2505-VTBD

GT25HS-V
Handy GOT

GT2506HS-V GT2506HS-VTBD

GT2505HS-V GT2505HS-VTBD

GT23 GT23-V GT2310-V GT2310-VTBA
GT2310-VTBD

GT2308-V GT2308-VTBA
GT2308-VTBD



■GOT SIMPLE series

■GOT1000 series, GOT900 series, and GOT800 series

GT21 All GT21 models

GT21-W GT2107-W GT2107-WTBD
GT2107-WTSD

GT21-Q GT2105-Q GT2105-QTBDS
GT2105-QMBDS

GT21-R GT2104-R GT2104-RTBD

GT21-P GT2104-P GT2104-PMBD

GT2104-PMBDS

GT2104-PMBDS2

GT2104-PMBLS

GT2103-P GT2103-PMBD

GT2103-PMBDS

GT2103-PMBDS2

GT2103-PMBLS

GT SoftGOT2000 GT SoftGOT2000 Version1

Abbreviations and generic terms Description Meaning of icon

Available Unavailable
GS25 GS2512-WXTBD

GS21 GS21-W-N GS2110-WTBD-N
GS2107-WTBD-N

GS21-W GS2110-WTBD
GS2107-WTBD

Abbreviations and generic terms Description Meaning of icon

Available Unavailable
GOT1000 Series GOT1000 Series -

GOT900 Series GOT-A900 Series
GOT-F900 Series

-

GOT800 Series GOT-800 Series -

Abbreviations and generic terms Description Meaning of icon

Available Unavailable

GS25 GS25

GS21 GS21
19
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Communication unit

Option unit

Abbreviations and generic terms Description
Bus connection unit GT15-QBUS

GT15-QBUS2
GT15-ABUS
GT15-ABUS2
GT15-75QBUSL
GT15-75QBUS2L
GT15-75ABUSL
GT15-75ABUS2L

Serial communication unit GT15-RS2-9P
GT15-RS4-9S
GT15-RS4-TE

MELSECNET/H communication unit GT15-J71LP23-25
GT15-J71BR13

CC-Link IE TSN communication unit GT25-J71GN13-T2

CC-Link IE Controller Network communication unit GT15-J71GP23-SX

CC-Link IE Field Network communication unit GT15-J71GF13-T2

CC-Link communication unit GT15-J61BT13

Wireless LAN communication unit GT25-WLAN

Serial multi-drop connection unit GT01-RS4-M

Connection conversion adapter GT10-9PT5S

Field network adapter unit GT25-FNADP

Ethernet communication unit GT25-J71E71-100

RS-232/485 signal conversion adapter GT14-RS2T4-9P

Abbreviations and generic terms Description
Printer unit GT15-PRN

Video input unit GT27-V4-Z (A set of GT16M-V4-Z and GT27-IF1000)

RGB input unit GT27-R2
GT27-R2-Z (A set of GT16M-R2-Z and GT27-IF1000)

Video/RGB input unit GT27-V4R1-Z (A set of GT16M-V4R1-Z and GT27-IF1000)

RGB output unit GT27-ROUT
GT27-ROUT-Z (A set of GT16M-ROUT-Z and GT27-IF1000)

Digital video output unit GT27-VHOUT

Multimedia unit GT27-MMR-Z (A set of GT16M-MMR-Z and GT27-IF1000)

Video signal conversion unit GT27-IF1000

External I/O unit GT15-DIO
GT15-DIOR

Sound output unit GT15-SOUT

SD card unit GT21-03SDCD



Option
Abbreviations and generic terms Description
SD card NZ1MEM-2GBSD

NZ1MEM-4GBSD
NZ1MEM-8GBSD
NZ1MEM-16GBSD
L1MEM-2GBSD
L1MEM-4GBSD

Battery GT11-50BAT
GT15-BAT

Protective sheet GT27-15PSGC
GT25-12WPSGC
GT25-12PSGC
GT25-10WPSGC
GT25-10PSGC
GT25-08PSGC
GT21-07WPSGC
GT25T-07WPSVC
GT25-05PSGC
GT25-05PSGC-2
GT21-05PSGC
GT21-04RPSGC-UC
GT21-03PSGC-UC
GT21-04PSGC-UC
GT27-15PSCC
GT25-12WPSCC
GT25-12PSCC
GT25-10WPSCC
GT25-10PSCC
GT25-08PSCC
GT25-05PSCC
GT25-05PSCC-2
GT25-12PSCC-UC
GT25-10PSCC-UC
GT25-08PSCC-UC
GT21-07WPSCC
GT21-05PSCC
GT21-04RPSCC-UC
GT21-04PSCC-UC
GT21-03PSCC-UC
GT16H-60PSC
GT14H-50PSC

Antibacterial/antiviral protective sheet GT25-12PSAC
GT25-10PSAC
GT25-08PSAC

Environmental protection sheet GT25F-12ESGS
GT25F-10ESGS
GT25F-08ESGS

Protective cover for oil GT20-15PCO
GT20-12PCO
GT20-10PCO
GT20-08PCO
GT21-12WPCO
GT21-10WPCO
GT21-07WPCO
GT25T-07WPCO
GT25-05PCO
GT25-05PCO-2
GT05-50PCO
GT21-04RPCO
GT10-30PCO
GT10-20PCO

USB environmental protection cover GT25-UCOV
GT25-05UCOV
GT21-WUCOV
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Software
■Software related to GOT

■Software related to iQ Works

Stand GT15-90STAND
GT15-80STAND
GT15-70STAND
GT05-50STAND
GT25-10WSTAND
GT21-07WSTAND
GT25T-07WSTAND

Attachment GT15-70ATT-98
GT15-70ATT-87
GT15-60ATT-97
GT15-60ATT-96
GT15-60ATT-87
GT15-60ATT-77
GT21-04RATT-40

Panel-mounted USB port extension GT14-C10EXUSB-4S
GT10-C10EXUSB-5S

Connector conversion box GT16H-CNB-42S
GT16H-CNB-37S
GT11H-CNB-37S

Emergency stop switch guard cover GT16H-60ESCOV
GT14H-50ESCOV

Wall-mounting attachment GT14H-50ATT

Abbreviations and generic terms Description
GT Works3 SW1DND-GTWK3-J, SW1DND-GTWK3-E, SW1DND-GTWK3-C

GT Designer3 Version1 Screen design software GT Designer3 for GOT2000 and GOT1000 series

GT Designer3 Screen design software for GOT2000 series included in GT Works3

GT Designer3 (GOT2000)

GT Designer3 (GOT1000) Screen design software for GOT1000 series included in GT Works3

Speech synthesis license GT Works Text to Speech License (SW1DND-GTVO-M)

Add-on license GT Works3 add-on license for GOT2000 enhanced drive control (servo) project data (SW1DND-
GTSV-MZ)

GENESIS64 Advanced GENESIS64 server application (GEN64-APP)

GENESIS64 Basic SCADA GENESIS64 server application (GEN64-BASIC)

GENESIS64 Generic term of GENESIS64 Advanced and GENESIS64 Basic SCADA

GOT Mobile function license for GT SoftGOT2000 License required to use the GOT Mobile function with GT SoftGOT2000 (SGT2K-WEBSKEY-□)

GT Simulator3 Screen simulator GT Simulator3 for GOT2000, GOT1000, and GOT900 series

GT SoftGOT2000 GOT2000 compatible HMI software GT SoftGOT2000

GT OPC UA Client MELSOFT GT OPC UA Client (SW1DNN-GTOUC-MD)

GT Converter2 Data conversion software GT Converter2 for GOT1000 and GOT900 series

GT Designer2 Classic Screen design software GT Designer2 Classic for GOT900 series

GT Designer2 Screen design software GT Designer2 for GOT1000 and GOT900 series

DU/WIN Screen design software FX-PCS-DU/WIN for GOT-F900 series

Abbreviations and generic terms Description
iQ Works iQ Platform compatible engineering environment MELSOFT iQ Works

MELSOFT Navigator Integrated development environment software included in SW□DND-IQWK (iQ Platform 
compatible engineering environment MELSOFT iQ Works)
(□ represents a version.)

MELSOFT iQ AppPortal SW□DND-IQAPL-M type integrated application management software
(□ represents a version.)

Abbreviations and generic terms Description



■Other software

License key (for GT SoftGOT2000)

Abbreviations and generic terms Description
GX Works3 SW□DND-GXW3-E (-EA, -EAZ) type programmable controller engineering software

(□ represents a version.)

GX Works2 SW□DNC-GXW2-E (-EA, -EAZ) type programmable controller engineering software
(□ represents a version.)

Controller simulator GX Simulator3 Simulation function of GX Works3

GX Simulator2 Simulation function of GX Works2

GX Simulator SW□D5C-LLT-E (-EV) type ladder logic test tool function software package (SW5D5C-LLT (-V) or 
later versions)
(□ represents a version.)

GX Developer SW□D5C-GPPW-E (-EV)/SW□D5F-GPPW (-V) type software package
(□ represents a version.)

GX LogViewer SW□DNN-VIEWER-E type software package
(□ represents a version.)

MI Configurator Configuration and monitor tool for Mitsubishi Electric industrial computers (SW□DNNMICONF-M)
(□ represents a version.)

PX Developer SW□D5C-FBDQ-E type FBD software package for process control
(□ represents a version.)

MT Works2 Motion controller engineering environment MELSOFT MT Works2 (SW□DND-MTW2-E)
(□ represents a version.)

MT Developer SW□RNC-GSV type integrated start-up support software for motion controller Q series
(□ represents a version.)

CW Configurator Setting/monitoring tools for the C Controller module and MELSECWinCPU (SW□DND-RCCPU-E)
(□ represents a version.)

MR Configurator2 SW□DNC-MRC2-E type servo configuration software
(□ represents a version.)

MR Configurator MRZJW□-SETUP type servo configuration software
(□ represents a version.)

FR Configurator2 Inverter setup software (SW□DND-FRC2-E)
(□ represents a version.)

FR Configurator Inverter setup software (FR-SW□-SETUP-WE)
(□ represents a version.)

NC Configurator2 CNC parameter setting support tool (FCSB1221)

NC Configurator CNC parameter setting support tool

FX Configurator-FP Parameter setting, monitoring, and testing software package for FX3U-20SSC-H 
(SW□D5CFXSSCE)
(□ represents a version.)

FX Configurator-EN-L FX3U-ENET-L type Ethernet module setting software (SW1D5-FXENETL-E)

FX Configurator-EN FX3U-ENET type Ethernet module setting software (SW1D5C-FXENET-E)

RT ToolBox2 Robot program creation software (3D-11C-WINE)

RT ToolBox3 Robot program creation software (3F-14C-WINE)

MX Component MX Component Version□ (SW□D5C-ACT-E, SW□D5C-ACT-EA)
(□ represents a version.)

MX Sheet MX Sheet Version□ (SW□D5C-SHEET-E, SW□D5C-SHEET-EA)
(□ represents a version.)

CPU Module Logging Configuration Tool CPU module logging configuration tool (SW1DNN-LLUTL-E)

MELSOFT Mirror Logic simulator MELSOFT Mirror

Abbreviations and generic terms Description
License key GT27-SGTKEY-U
23
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Others
Abbreviations and generic terms Description
IAI IAI Corporation

AZBIL Azbil Corporation

OMRON OMRON Corporation

KEYENCE KEYENCE CORPORATION

JTEKT ELECTRONICS (formerly KOYO EI) JTEKT ELECTRONICS CORPORATION (formerly KOYO ELECTRONICS INDUSTRIES CO., 
LTD.)

JTEKT JTEKT CORPORATION

SHARP Sharp Corporation

SHINKO Shinko Technos Co., Ltd.

CHINO CHINO CORPORATION

TOSHIBA TOSHIBA CORPORATION

SHIBAURA MACHINE SHIBAURA MACHINE CO., LTD.

PANASONIC Panasonic Corporation

PANASONIC IDS Panasonic Industrial Devices SUNX Co., Ltd.

HITACHI IES Hitachi Industrial Equipment Systems Co., Ltd.

HITACHI Hitachi, Ltd.

HIRATA Hirata Corporation

FUJI FUJI ELECTRIC CO., LTD.

MURATEC Muratec products manufactured by Murata Machinery, Ltd.

YASKAWA YASKAWA Electric Corporation

YOKOGAWA Yokogawa Electric Corporation

RKC RKC INSTRUMENT INC.

ALLEN-BRADLEY Allen-Bradley products manufactured by Rockwell Automation, Inc.

CLPA CC-Link Partner Association

GE GE Intelligent Platforms, Inc.

HMS HMS Industrial Networks

LS ELECTRIC (formerly LS IS) LS ELECTRIC Co., Ltd (formerly LS Industrial Systems Co., Ltd.)

MITSUBISHI INDIA Mitsubishi Electric India Pvt. Ltd.

ODVA Open DeviceNet Vendor Association, Inc.

SCHNEIDER Schneider Electric SA

SICK SICK AG

SIEMENS Siemens AG

SCHNEIDER EJH Schneider Electric Japan Holdings Ltd.

PLC Programmable controller manufactured by its respective company

Control equipment Control equipment manufactured by its respective company

Temperature controller Temperature controller manufactured by its respective company

Indicating controller Indicating controller manufactured by its respective company

Controller Controller manufactured by its respective company

Industrial switch (for CC-Link IE TSN Class B) CC-Link IE TSN Class B (Synchronized Realtime Communication) hub certified by CC-Link 
Partner Association

Industrial switch (for CC-Link IE TSN Class A) CC-Link IE TSN Class A (Realtime Communication) hub certified by CC-Link Partner Association

CC-Link IE TSN-equipped module Generic term for the following CC-Link IE TSN master/local modules and CC-Link IE TSN Plus 
master/local module
• RJ71GN11-T2
• RJ71GN11-EIP
• FX5-CCLGN-MS
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1 FUNDAMENTALS OF GT SoftGOT2000
Page 25 GT SoftGOT2000
Page 30 Before Using This Software

1.1 GT SoftGOT2000
This manual explains the system configuration, specifications, screen structure, and operating method of monitoring software 
GT SoftGOT2000 (hereinafter abbreviated as GT SoftGOT2000).
GT SoftGOT2000 is the software that has the same functions as the GOT2000 series and is used to display lamps, data, and 
messages on personal computers and panel controllers.
When applying the following program examples to the actual system, make sure to examine the applicability and confirm that 
it will not cause system control problems.

Described contents in this manual
This manual describes the operation method for GT SoftGOT2000.
For other than the operation method, refer to the following manuals.
 • Installation method of GT SoftGOT2000
For the installation method of GT SoftGOT2000, refer to the following manuals.
GT Works3 Version1 Installation Instructions Manual
 • Project data creating method of GT Designer3
For the project data creating method of GT Designer3, refer to the following manuals.
GT Designer3 (GOT2000) Screen Design Manual
 • Available devices for monitoring
For the available devices for monitoring, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual
1  FUNDAMENTALS OF GT SoftGOT2000
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GT SoftGOT2000 module types
GT SoftGOT2000 consists of the following two types of modules.
GT SoftGOT2000 (Single channel): Monitors channel No. 1 only.
GT SoftGOT2000 (Multiple channels): Monitors channel No. 1 to No. 4.

GT SoftGOT2000 (Multiple channels) supports more functions than GT SoftGOT2000 (Single channel) does.
When monitoring a controller using a connection type that is supported by both GT SoftGOT2000 (Multiple channels) and GT 
SoftGOT2000 (Single channel), you are recommended to use GT SoftGOT2000 (Multiple channels).
For the difference between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels), refer to the 
following.
Page 38 Differences between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels)
You can select a module type in the [GT SoftGOT2000 Start-up] dialog that appears when GT SoftGOT2000 is started.

Select [GT SoftGOT2000] to start GT SoftGOT2000 (Single channel).
Select [GT SoftGOT2000 (Multi-channel)] to start GT SoftGOT2000 (Multiple channels).

Personal computer

GT SoftGOT2000
(Multiple channels)

Ethernet

PLCPLC PLC PLC

Personal computer

GT SoftGOT2000
(Single channel)

Ethernet

PLC

1CH1CH 2CH 3CH 4CH
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The features of the GOT series and advantages of personal computer and panel 
computer are available
■Interactive use with applications (including MELSOFT)
 • Interactive use with GT Designer3
Installation of GT SoftGOT2000 and GT Designer3 on the same personal computer allows operations from screen creation to 
monitoring to be supported by a single personal computer.

Immediately after creating or modifying a screen on GT Designer3, the screen can be monitored on GTSoftGOT2000. 
Therefore, design efficiency is improved greatly.
 • Interaction with PX Developer
With interaction between GT SoftGOT2000 and PX Developer, monitor tool functions for PX Developer can be called on GT 
SoftGOT2000.
GT SoftGOT2000 can also be started on PX Developer, and the functions can be shared.
For the monitor tool of PX Developer, refer to the following manual.
PX Developer Version □ Operating Manual (Monitor Tool)

 • Interactive use with Windows applications
A Windows application can be started up from GT SoftGOT2000.
Also, the data of GT SoftGOT2000 internal devices can be read/written from a user-created application.
With interaction between GT SoftGOT2000 and a user-created application, the user can control or manage data by own 
method.

Install

GT SoftGOT2000

GX Developer

GT Works3 Version 1.100E or later  
(GT Designer3)

GT SoftGOT2000

License key

CPU direct
connection
(RS-232, USB)

Attach

PX DeveloperGT SoftGOT2000

Call a monitor tool function for in PX Developer 
on GT SoftGOT2000.

Register GT SoftGOT2000 as a user graphic
screen of PX Developer, and start the registered
GT SoftGOT2000.

Personal computer

GT SoftGOT2000

User-created application

PLC
Communication with PLC

Screen display (alarm etc.)

User's own data control

Server

Reading/writing 
internal device value

User's own control
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■Flexible response to high-resolution
You can select a screen resolution from WUXGA to VGA, or specify the resolution in dots according to the application 
purpose.
For the resolutions supported by GT SoftGOT2000, refer to the following.
Page 33 Specifications of GT SoftGOT2000

The monitor screen data created for the GOT2000 series is applicable to GT 
SoftGOT2000.
The GT SoftGOT2000 uses monitor screen data created with GT Designer3.
By converting the GOT type for GT SoftGOT2000, the monitor screen data used for the GOT2000 series can be used without 
modification.
GT SoftGOT2000 uses the same screens and operations as GOT.
Therefore, there will be no discomfort or confusion for the operators and maintenance personnel.

GOT GT SoftGOT2000

The monitor screen data is compatible.
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Synchronizing GT SoftGOT2000 data with GOT data
The SoftGOT-GOT link function enables GT SoftGOT2000 to connect the GOT via Ethernet.
And then, the function synchronizes GT SoftGOT2000 data with GOT project data and resource data.
When input objects (touch switch, numerical input, and text input) are input or other operation is performed, the simultaneous 
operation between GT SoftGOT2000 and the GOT must be prevented.
The operation by either GT SoftGOT2000 or the GOT is allowed.
GT SoftGOT2000 can monitor a controller connected to the GOT.

With the GOT network interaction function, multiple GT SoftGOT2000 applications can communicate with one GOT.
Page 614 SoftGOT-GOT Link Function

Ethernet

GT SoftGOT2000

GOT Controller

Controller

GT SoftGOT2000 monitors the controller connected to the GOT.
GT SoftGOT2000 (Single channel) only monitors the controller with the 
channel number 1 assigned on the GOT. It cannot communicate with a 
controller of channel number other than 1.
GT SoftGOT2000 (Multiple channels) monitors the controllers with the 
channel number 1 to 4 assigned on the GOT.

GT SoftGOT2000 reads GOT project data from the GOT, 
and monitors the controller with the same project data as 
the read GOT project data.

Ethernet

GT SoftGOT2000

GT SoftGOT2000

GOT

Controller

When the GOT network 
interaction function is used, 
up to seven GT 
SoftGOT2000 modules can 
communicate with one 
GOT.

GT SoftGOT2000 reads GOT 
project data from the GOT, and 
monitors the controller with the 
same project data as the read 
GOT project data.
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1.2 Before Using This Software
Operating environment
The following shows the GT SoftGOT2000 operating environment.

Item Description
Personal computer • A personal computer that can run Windows

• PPC-852-21G, and PPC-852-22F manufactured by CONTEC CO., LTD *5

• MELIPC (MI5122-VW, MI3321G-W*11, MI3315G-W*11, MI2012-W, or MI2012-W-CL) *10

OS (English, Simplified 
Chinese, Traditional Chinese, 
Korean, German, or Italian 
version)*7

• Microsoft Windows Server 2019 Standard (64 bit)*2*3*6*12*13*14

• Microsoft Windows Server 2016 Standard (64 bit) *2*3*6*12*13

• Microsoft Windows 11 Education (64 bit)*2*3*6*9*12*13

• Microsoft Windows 11 Enterprise (64 bit)*2*3*6*9*12*13

• Microsoft Windows 11 Pro (64 bit)*2*3*6*9*12*13

• Microsoft Windows 11 Home (64 bit)*2*3*6*9*12*13

• Microsoft Windows 10 Enterprise (64 bit, 32 bit) *2*3*6*12*13

• Microsoft Windows 10 Pro (64 bit, 32 bit) *2*3*6*12*13

• Microsoft Windows 10 Home (64 bit, 32 bit) *2*3*6*12*13

• Microsoft Windows 10 IoT Enterprise 2021 LTSC (64-bit) (English OPK, or English OPK and a language pack for 
localization)*2*3*6*8*9*12*13

• Microsoft Windows 10 IoT Enterprise 2019 LTSC (64 bit) (English OPK, or English OPK and a language pack for 
localization) *2*3*6*8*9*12*13

• Microsoft Windows 10 IoT Enterprise 2016 LTSB (64 bit) (English OPK, or English OPK and a language pack for localization) 
*2*3*6*8*9*12*13

CPU • Windows 11: 64 bit-compatible processor with dual-core or more or System on a Chip (SoC)*15

• Other than Windows 11: Intel Core 2 Duo Processor 2.0 GHz or more recommended*15

Memory • For Windows 11: 4 GB or more recommended
• For 64-bit OS other than Windows 11: 2 GB or more recommended
• For 32-bit OS other than Windows 11: 1GB or more recommended

Display Resolution XGA (1024 × 768 dots) or higher

Hard disk space *1 • For installation: 5 GB or more recommended
For execution: 512 MB or more recommended

Display color High color (16 bits) or more

Hardware • GT27-SGTKEY-U (License key (for USB port))
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*1 When using GT Designer3 or PX Developer besides GT SoftGOT2000, additional free space is required.
For the available space required when using GT Designer3, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual
For the available space required when using monitor tool functions of PX Developer, refer to the following manual.
PX Developer Version □ Operating Manual (Monitor Tool)
When using a user-created application, free space is required separately.

*2 Administrator authority is required for installing and using GT SoftGOT2000.
If you use GT SoftGOT2000 and other MELSOFT products simultaneously on the same personal computer, run the MELSOFT products 
with administrator authority as well.

*3 The following functions are not supported.
Activating the application with Windows compatibility mode
Fast user switching
Changing the desktop theme (or font size)
Remote desktop
Setting the size of text and illustrations on the screen to any size other than [Small-100%]

*4 Use GT Designer3 included in GT Works3 that contains GT SoftGOT2000.
*5 Refer to the manual of the PC CPU module to be used.
*6 Tap and press-and-hold features are supported.

As operations such as flicking are not supported, the following operations are unavailable accordingly.
Touching two touch switches simultaneously
Moving an overlap window or key window by a slide operation
When [Allow press-and-hold of a mouse button to function as a right-click] is selected in the [Environment Setup] dialog of GT 
SoftGOT2000, the following operations are also unavailable.
Touching a touch switch ([Action]: [Momentary])
Touching a touch switch ([Delay]: [ON])
Touching the utility call key

*7 Operation in a virtual environment such as Hyper-V is not supported.
*8 The following OSs are not supported.

Microsoft Windows 10 IoT Enterprise for Retail or Thin Client
Microsoft Windows 10 IoT Enterprise for Tablets
Microsoft Windows 10 IoT Enterprise for Small Tablets

*9 The following lockdown features are not supported.
Unified Write Filter
Assigned Access
USB Filter
Layout Control
AppLocker
Shell Launcher
Text cursor indicator

Other software The following software is required to create the project data.
GT Designer3 Version1.100E or later *4

The following software is required for interaction with PX Developer.
PX Developer Version1.40S or later
GT Designer3 Version 1.105K or later

The following software is required to connect with GX Simulator.
GX Simulator Version5.00A or later

The following software is required to connect with GX Simulator2.
GX Works2 Version1.12N or later

The following software is required to connect with GX Simulator3.
GX Works3 Version1.007H or later

The following software is required to connect with MT Simulator2.
MT Works2 Version1.70Y or later

The following software is required to connect with MELSOFT Mirror.
• MELSOFT Mirror Version 1.000A or later*16

The following software is required to use the OPC UA client connection.
• GT OPC UA Client

Other hardware Use the hardware compatible with the above OSs.
For installation: Mouse, keyboard, or DVD drive
For execution: Mouse or keyboard
For printing: Printer
Prepare the following hardware if necessary.
For execution (only when outputting buzzer sound or others): Sound function or speaker

Item Description
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*10 Microsoft Windows 10 IoT Enterprise 2016 LTSB is preinstalled.
For the specifications of the MELIPC, refer to the following.
MELIPC MI5000 Series User's Manual (Startup)
MELIPC MI3000 User's Manual
MI2012-W User's Manual

*11 GT SoftGOT2000 (English version) is preinstalled.
*12 Disable high-speed startup.

If enabled, GT SoftGOT2000 may not operate properly when the personal computer is shut down and then started.
*13 Some digital pens are unusable.
*14 Only Desktop Experience is available.
*15 ARM64 and ARM32 are not supported.
*16 To run GT SoftGOT2000 and MELSOFT Mirror on the same personal computer, the operating environment of MELSOFT Mirror must be 

satisfied.

 • Operating environment when using a user-created application
A user-created application is used with GT SoftGOT2000.
When using a user-created application, therefore, prepare an operating environment where both the user 
created application and GT SoftGOT2000 can operate.
 • Resume function, suspend setting, power saving function, standby mode, and sleep function of the personal 

computer
The following phenomena may occur when the resume function setting, suspend setting, power saving 
function setting, standby mode setting, and sleep function setting are configured in the personal computer.
A communication error occurs when communicating with the PLC CPU.
License key becomes unrecognizable.
Therefore, do not set the above-mentioned items.
 • Operating environment for starting multiple modules or using the multi-channel function
Monitoring performance may be degraded or a timeout may occur depending on the specifications of the 
personal computer.
Request the network administrator to adjust each communication setting, which may improve such situations.
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Specifications of GT SoftGOT2000
The following shows the specifications of GT SoftGOT2000.

*1 X and Y are resolution values set by the user.
Page 68 [Environment Setup] dialog

Project data display
 • Full screen mode
If the resolution of the personal computer used is the same as that of GT SoftGOT2000, it is recommended to 
hide the frame and menu part using the full screen mode function.
When not using the full screen mode function, the top/bottom and left/right parts of the display are hidden by 
the frame and menu part.
 • GOT type and resolution
For GT SoftGOT2000, set the same resolution as the GOT type (model, resolution) of the project data created 
by GT Designer3.
If the resolution settings are different, the project data cannot be read into the GOT.

Item Specifications
Resolution (dots) 640 × 480, 800 × 600, 1024 × 768, 1280 × 1024, 1600 × 1200, 1920 × 1080, and X × Y (user-definable) *1

Display color (color) 65536 colors
Note that the following items are displayed in 16777216 colors.
• Parts display
• Parts movement
• Image file

Built-in flash memory (user area) 57MB

Memory for operation (RAM) (user 
area)

256MB
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Executable files for GT SoftGOT2000 and keywords
The executable files for GT SoftGOT2000 are stored in the folder where GT SoftGOT2000 is installed.
(Default: C:\Program Files\MELSOFT\SGT2000)
The executable files launch the following dialog or modules.
SGT2000Main.exe: [GT SoftGOT2000 Start-up] dialog
SGT2000.exe: GT SoftGOT2000 (Single channel)
SGT2000_MultiCH.exe: GT SoftGOT2000 (Multiple channels)
To start a specific GT SoftGOT2000 module, specify a module number or mode by appending the following keywords to the 
path to each executable file in its shortcut properties or by other methods.
Module number: -SGTn (n: Module number in the range of 1 to 32767)
Full screen mode (Full screen 1): -NOFRAME
Full screen mode (Full screen 2): -NOFRAMEDLG
Full screen mode (Full screen 3): -NOFRAMEDLGMENU
Monitor-only mode: /MNTONLY
A one-byte space is required before a keyword.
The following shows combinations of executable files and keywords.

Executable file Keyword Module to be started
SGT2000Main.exe -SGTn GT SoftGOT2000 (Single channel)

Example) Starting GT SoftGOT2000 (Single channel) module No. 2
C:\Program Files\MELSOFT\SGT2000\SGT2000Main.exe -SGT2

-NOFRAME GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 1).

-NOFRAMEDLG GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 2).

-NOFRAMEDLGMENU GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 3).

/MNTONLY GT SoftGOT2000 (Single channel)
The module starts in the monitor-only mode.

-MULTICH GT SoftGOT2000 (Multiple channels)
Example) Starting GT SoftGOT2000 (Multiple channels) module No. 3
C:\Program Files\MELSOFT\SGT2000\SGT2000Main.exe -MULTICH -SGT3

SGT2000.exe -SGTn GT SoftGOT2000 (Single channel)
Example) Starting GT SoftGOT2000 (Single channel) module No. 2
C:\Program Files\MELSOFT\SGT2000\SGT2000.exe -SGT2

-NOFRAME GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 1).

-NOFRAMEDLG GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 2).

-NOFRAMEDLGMENU GT SoftGOT2000 (Single channel)
The module starts in full screen mode (Full screen 3).

/MNTONLY GT SoftGOT2000 (Single channel)
The module starts in the monitor-only mode.

SGT2000_MultiCH.exe -SGTn GT SoftGOT2000 (Multiple channels)
Example) Starting GT SoftGOT2000 (Multiple channels) module No. 3
C:\Program Files\MELSOFT\SGT2000\SGT2000_MultiCH.exe -SGT3

-NOFRAME GT SoftGOT2000 (Multiple channels)
The module starts in full screen mode (Full screen 1).

-NOFRAMEDLG GT SoftGOT2000 (Multiple channels)
The module starts in full screen mode (Full screen 2).

-NOFRAMEDLGMENU GT SoftGOT2000 (Multiple channels)
The module starts in full screen mode (Full screen 3).

/MNTONLY GT SoftGOT2000 (Multiple channels)
The module starts in the monitor-only mode.
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Multiple keywords can be added in combination.
Example) Starting GT SoftGOT2000 (Single channel) module No. 2 in full screen mode (Full screen 2)

For specifying a module, refer to the following.
Page 58 Directly starting the specified GT SoftGOT2000 module
For the full screen mode, refer to the following.
Page 670 Full Screen Mode
For the monitor-only mode, refer to the following.
Page 684 Monitor-only Mode

Items managed by each GT SoftGOT2000 module
The following shows the items managed by each GT SoftGOT2000 module.

Item managed by each module Reference
Each setting -

Virtual drive Page 36 Virtual drive

GT SoftGOT2000 window position upon startup Page 52 Start GT SoftGOT2000

GOT internal device GT Designer3 (GOT2000) Screen Design Manual

Advanced APP setup file Page 601 [Advanced APP Setup] tab

Application start-up history Page 605 Application start-up history

PX Developer function call history Page 664 PX Developer function call history

Edgecross interaction configuration file Page 669 Settings on GT SoftGOT2000
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Virtual drive
GT SoftGOT2000 uses the following folder located on the hard disk of a personal computer as a virtual drive.
A virtual drive is created for each module.

Any folder can be set as a virtual drive.
For changing the folder specified as the virtual drive, refer to the following.
Page 67 Environment Setup

MELSOFT(installation folder)

SGT2000

Multi

00001 Folder for module No.1

Drive Stores a virtual drive

A

B

00002 Folder for module No.2

Drive Stores a virtual drive

C

D

E

F

G

A

B

C

D

E

F

G

N

S

N

S

V

V
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Resource data storage destination
Resource data is stored to the virtual A drive or a user-specified folder with the configuration shown below.

The file formats of resource data are described below.

*1 Before outputting a report for which any language other than Japanese and English is used to a CSV file, turn on GS522.b2.
Change the character code to Unicode, and the delimiter to tab-delimited.
If GS522.b2 is not turned on, the characters are not displayed correctly.
For the details of GS522.b2, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
When outputting a report in Japanese to a CSV file in the environment where the characters cannot be displayed in Japanese, the 
characters may not be displayed correctly if GS522.b2 is turned off.

Precautions on file names for the virtual drive
As a folder name for the virtual drive, only ASCII characters (excluding "|", "," and ";") can be used with up to 
78 characters.
Set the file name with up to 256 characters including the path name for file storage destination and file name 
to be stored (including extension).

Storage destination Function
Virtual A Drive
or user-specified folder

Folder name specified in project data Alarm observation Recipe, Logging,

Hard copy (File save), Operation log function

Time action

G2SgtReport Report (Print)

G2SgtHardcopy Hard copy (Print)

Function Folder name File format and file name
Alarm Observation Folder name set in project data File name set in project data

AAM*****.G2A

File name set in project data
AAM*****.CSV

File name set in project data
AAM*****.TXT

Recipe Folder name set in project data File name set in project data
ARP*****.G2P

File name set in project data
ARP*****.CSV

File name set in project data
ARP*****.TXT

Logging Folder name set in project data File name set in project data
LOG*****_*****.G2L

File name set in project data
LOG*****_*****.CSV

File name set in project data
LOG*****_*****.TXT

Hard copy (File save) Folder name set in project data File name set in project data
SNAP***.BMP

File name set in project data
SNAP****.JPG

Hard copy (Print) G2SgtHardcopy HARDCOPY.BMP

Report (Print) *1 G2SgtReport REP00001.CSV - REP00099.CSV

Operation log function Folder name set in project data File name set in project data
OPELOG_YYYYMMDD_SSSS.G2O

File name set in project data
OPELOG_YYYYMMDD_SSSS.CSV

File name set in project data
OPELOG_YYYYMMDD_SSSS.TXT

Time action Folder name set in project data File name set in project data
TIMEACTION.G2T
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Differences between GT SoftGOT2000 (Single channel) and GT 
SoftGOT2000 (Multiple channels)
The following shows the differences between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels).

Common function
○: Supported, ×: Not supported

Function GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
System font display ○ ○

Option font display ○ ○

Superimposition of objects ○ ○

Base screen display ○ ○

Overlap window display ○ ○

Superimpose window display ○ ○

Key window display ○ ○

Set overlay screen ○ ○

Screen Switching ○ ○

Station No. Switching ○ ○

Buffer memory unit No. switching ○ ○

Language Switching ○ ○

System information ○ ○

Security authentication ○ ○

Status observation ○ ○

Time action ○ ○

Hard copy function ○ ○

Comment ○ ○

Figure ○ ○

Internal device ○ ○

Cursor movement ○ ○

Operation Log ○ ○

Logging ○ ○

Recipe ○ ○

Script ○ ○

Multi-channel connection × ○

Vertical display ○ ○

Touch panel and touch key ○ ○

Lamp ○ ○

Numerical display/input ○ ○

Text display/input ○ ○

Historical data list display ○ ○

Clock display ○ ○

Comment display ○ ○

Parts display, parts movement ○ ○

Alarm display ○ ○

Alarm popup display ○ ○

Recipe display (record List) ○ ○

Graphical meter ○ ○

Panel meter display ○ ○

Historical trend graph ○ ○

Line graph ○ ○

Bar graph ○ ○

Scatter graph ○ ○

Statistics graph ○ ○
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*1 It is recommended to use GT SoftGOT2000 (Multiple channels) for this function.

Utility function
○: Supported, ×: Not supported

Extended function
○: Supported, ×: Not supported

*1 GT SoftGOT2000 supports the server function.

Level display ○ ○

Touch switch ○ ○

Slider ○ ○

Script parts ○ ○

Mobile screen display ○*1 ○

Hyperlink ○*1 ○

Function GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
System launcher × ○

System launcher (servo network) × ○

Drive recorder × ○

Servo amplifier graph × ○

Function GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
Kana-Kanji/Pinyin conversion ○ ○

SoftGOT-GOT link function ○ ○

System launcher × ○

System launcher (servo network) × ○

Backup/Restore Function × ○

Gateway(Server, Client) ○*1 ○*1

Barcode ○ ○

RFID ○ ○

Operation panel ○ ○

Report ○ ○

Printer ○ ○

Sound Output ○ ○

GOT Network Interaction ○ ○

Device Data Transfer ○ ○

Drive recorder × ○

Servo amplifier graph × ○

Recipe Operation ○ ○

Recipe Display (Record List) ○ ○

Operator authentication ○ ○

Document Display ○ ○

Function GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
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Communication function
For the connection types supported by GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels), refer to 
the following.
Page 115 Supported Connection Types

Access range
The access range is different between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels).
For GT SoftGOT2000 (Single channel), refer to the following.
Page 138 Access range
For GT SoftGOT2000 (Multiple channels), refer to the following.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

Controller
The supported controllers are the same between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple 
channels).
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Precautions for using GT SoftGOT2000

Numerical display
For the numerical display object where [Format] is set to [Real], if the specified device stores an invalid value, GT 
SoftGOT2000 displays the value.
(The GOT displays [non].)

Time display
The clock data of the personal computer is used for clock display when monitoring on GT SoftGOT2000.
When controlling a system using clock data, set the same clock data for the PLC CPU and personal computer.
GT SoftGOT2000 does not support the daylight saving function.
Do not check [Automatically adjust clock for daylight saving changes] on the personal computer.

Time settings
■Time setting function
The time of the personal computer where GT SoftGOT2000 runs is synchronized with the time of the controller.
Under the following conditions, the time setting function cannot be used on GT SoftGOT2000.
If the function is used under the following conditions, a time difference occurs.
The user who has started GT SoftGOT2000 does not have the authority to change the system time.
The clock of the personal computer is synchronized with an Internet time server.
Software that periodically adjusts the clock of the personal computer is used.

■Time notification function
The time of the controller is synchronized with the time of the personal computer where GT SoftGOT2000 runs.

■Controllers subjected to the time synchronization functions
Only Mitsubishi Electric controllers are applicable.
For the details of the applicable controllers, refer to the following.
Page 116 Controllers that can be monitored by connection type

■When connecting with a simulator
When [GX Simulator], [GX Simulator2], [GX Simulator3], or [MT Simulator2] is selected for [Connection] in the 
[Communication Setup] dialog, the time setting function and the time notification function are not available.

■Unavailable functions
GT SoftGOT2000 does not support the following functions.
Synchronizing the time with an SNTP server
Setting the time zone
Changing the current time with the GOT special registers (GS512 to GS516)

■Time zone of the personal computer
Set the same time zone for the personal computer and controller.
Otherwise, a time difference occurs.

■Performing the time setting function while the SoftGOT-GOT link function is used
To perform the time setting function while the SoftGOT-GOT link function is used, select [Adjust the clock] in the 
[Communication Setup] dialog.
For the [Communication Setup] dialog, refer to the following.
Page 75 [Communication Setup] dialog
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Version of GT SoftGOT2000
Be sure to use the GT SoftGOT2000 of the same version as GT Designer3 that the project data is created.
When using different versions of GT SoftGOT2000 and GT Designer3, the file may not be opened, functions/settings may be 
invalid, or GT SoftGOT2000 may not work correctly.
Refer to the following for the project data compatibility.
Page 736 Applicable Project Data

Hard copy function
■Output destination
Set the hard copy output destination in GT Designer3.
When [Printer] is selected as the output destination
Data is output to a printer.
At the same time, the data is saved to an image file in the G2SgtHardcopy folder of virtual drive A.
When [File] is selected as the output destination
Data is output to an image file and saved to the location specified in the hard copy function setting on GT Designer3.
Some settings made in the [Hard Copy] dialog in GT Designer3 may be invalid in GT SoftGOT2000.
For the details, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■System signals
GT SoftGOT2000 does not support the system signals related to the hard copy function.
For the details, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■GOT special registers (GS)
For GS devices available for GT SoftGOT2000, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■System alarm
GT SoftGOT2000 does not support PDF output of the hard copy function.
If project data for which [PDF] is specified for the hard copy output destination is used with the SoftGOT-GOT link function, a 
system alarm will occur when a hard copy output is executed.
No system alarm except the above occurs in GT SoftGOT2000 regarding the hard copy function.
For the troubleshooting for the hard copy function, refer to the following.
Page 733 Troubleshooting for print
Page 733 Troubleshooting for file save problems

Report function
Data cannot be output to a printer directly.
Print images (in CSV format) are stored to the virtual A drive of a personal computer once.
Output these images in each file to a printer.

Virtual drive V
To store image files in drive V and use them for parts displays, satisfy all the following conditions.
 • Store the image files directly under drive V using the FTP server function that can run on Windows.
 • Use IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg only for the file name and extension.
 • Limit the total file size to less than 6 MB.
 • Do not store any file other than IMG1.jpg, IMG2.jpg, IMG3.jpg, and IMG4.jpg.
The files in drive V are deleted when monitoring starts with GT SoftGOT2000 or GT SoftGOT2000 exits.
For the details, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
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Functions in which data are stored in the memory card in advance by the user
Store the BMP/JPEG/PNG files used for parts and the data used for the document display in a virtual drive.
(The drive to be used depends on the specifications and setting of the object.)
For details of each function, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual
Except for the virtual drive, GT SoftGOT2000 does not recognize BPM/JPEG files and other files.

*1 You can rename the folder.

When using the Buzzer Output signal (System signal 1-1.b14)
If the Buzzer Output signal (System signal 1-1.b14) remains on, the buzzer sound may be interrupted.

Using GT SoftGOT2000 (Multiple channels) with a MELSOFT product running as a 
Windows service
If you use a MELSOFT product that runs as a Windows service, start it as a process.
If GT SoftGOT2000 (Multiple channels) and a MELSOFT product running as a service perform communication 
simultaneously, a communication error will occur.

MELSOFT(installation folder)

SGT2000

Multi

00001

Drive

00002

A

B

PDFDAT
DOCIMG Stores the JPEG files for the document display.

Stores the PDF files for the document display.
Image Stores the BMP/JPEG/PNG files.*1
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License key
To use GT SoftGOT2000, a license key is required.
The following shows the model of the license key.

The license key is recognized by OS as a connected device.
To access the license key, install its system driver.
Page 45 Installing and uninstalling the system driver
Be sure to attach the license key before starting monitoring on GT SoftGOT2000.
When monitoring starts without a license key, GT SoftGOT2000 automatically ends in about three hours.
Also, from starting monitoring to exiting it, use GT SoftGOT2000 with the license key attached.
If the license key is disconnected during monitoring, GT SoftGOT2000 will exit automatically.
For troubleshooting the license key-related problems, refer to the following.
Page 728 Troubleshooting for license key

License key
 • License key use target
The GT27-SGTKEY-U is dedicated for GT SoftGOT2000.
It cannot be used for GT SoftGOT1000 or GT SoftGOT2.
 • Use of a USB hub
Do not use GT27-SGTKEY-U through a USB hub.
When using GT27-SGTKEY-U, connect GT27-SGTKEY-U to a personal computer directly.

Model name Attachment type
GT27-SGTKEY-U Attached to USB port
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Installing and uninstalling the system driver
Before installing or uninstalling the system driver, remove the license key GT27-SGTKEY-U.
Otherwise, installation may fail.
If installation has failed, remove the GT27-SGTKEY-U, uninstall the system driver, and then install it again.

■Installing the system driver
If the system driver is not installed, it will be installed when GT SoftGOT2000 is started.

1. Start GT SoftGOT2000 to display the following dialog.

2. Click the [Yes] button to display the following dialog.

3. Click the [OK] button to start installation.
The installation process may take a few minutes to complete.
Do not operate GT SoftGOT2000 until the installation of the system driver is complete.

4. When the installation is complete, the following dialog appears.

5. Click the [OK] button to restart GT SoftGOT2000.

■Uninstalling the system driver
In [Programs and Features] in the Windows Control Panel, uninstall [Sentinel Protection Installer □.□.□].

If the system driver cannot be installed or uninstalled properly, use the following installer.
(GT SoftGOT2000 installation folder)\SGT2000\SystemDriver\SPI_771.exe
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Function that can be used in GT SoftGOT2000, features that are 
not available
In GT SoftGOT2000, some functions available in GOT2000 series cannot be used.
Function that can be used in GT SoftGOT2000, it is identified in the following features that are not available.

Common function
○: Available, -: Unavailable

Function Supported/Unsupported Function Supported/Unsupported
System font display ○ Multi-channel connection ○

Option font display ○ Vertical display -

Superimposition of objects ○ Touch panel and touch key ○

Base screen display ○ Numerical display/input ○

Overlap window display ○ Text display/input ○

Superimpose window display ○ Historical data list display ○

Key window display ○ Clock display ○

Set overlay screen ○ Comment display ○

Screen Switching ○ Alarm display ○

Station No. Switching ○ Alarm popup display ○

Buffer memory unit No. switching ○ Recipe display (record List) ○

Language Switching ○ Graphical meter ○

System information ○ Panel meter display ○

Security authentication ○ Historical trend graph ○

Status observation ○ Line graph ○

Time action ○ Bar graph ○

Hard copy function ○ Scatter graph ○

Comment ○ Statistics graph ○

Figure ○ Level display ○

Internal device ○ Touch switch ○

Cursor movement ○ Slider ○

Operation Log ○ Video/RGB display object -

Logging ○ Script parts ○

Recipe ○ Mobile screen display ○

Script ○ Hyperlink ○
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Utility function
○: Available, -: Unavailable

*1 [Delete all labels] and [Sort out labels] are supported.
*2 [Initialize all] and [Initialize selected area] are supported.

Category Function Available/Unavailable Function Available/Unavailable
[GOT basic set] [Display] ○ [Time] -

[Language] ○ [Controller] -

[Specific Information] - [Ethernet Communication] -

[IP Address] - [Transparent Mode] -

[IP filter setting] - [GOT internal device monitor] -

[Operation] ○ [Security] ○

[Utility Call Key] ○ [Operator Authentication] ○

[USB Host] -

[Extended Setting] [SoftGOT-GOT Link Function] - [Wireless LAN Setting] -

[VNC Server Function] - [System launcher] ○

[Sequence Program Monitor] - [iQSS utility] -

[Backup/Restore] ○ [ANDON Setting] ○

[License Management] - [Ethernet printer] -

[Video/RGB] - [Network drive setting] -

[Multimedia] -

[Maintenance] [Batch Self Check] - [Font check] -

[USB Device Management] - [Touch panel check] -

[Clean/Display Screen] - [I/O check] -

[Touch panel calibration] - [Ethernet Status Check] -

[System Alarm] ○ [GOT Information] -

[Drawing check] - [GOT Mobile information] ○

[Monitor] [System launcher] ○ [Log viewer] -

[Device monitor] - [Network status display] -

[Seq. program monitor(Ladder)] - [FX list editor] -

[Seq. program monitor(iQ-R 
Ladder)]

- [CNC Machining Program Edit] -

[FX Ladder monitor] - [CNC data I/O] -

[Network monitor] - [Motion program editor] -

[Intelligent module monitor] - [Motion program I/O] -

[Servo amp Monitor] - [MELSEC-L Troubleshooting] -

[Q Motion monitor] - [iQSS utility] -

[R Motion monitor] - [Drive recorder] ○

[CNC monitor] - [CC-Link IE TSN/CC-Link IE Field 
Network diagnostics]

-

[CNC monitor2] - [Servo amplifier graph] ○

[Seq. program monitor(SFC)] - [Vision sensor monitor] -

[Motion SFC monitor]

[Data Control] [Alarm information] ○ [Package Management] ○ *1

[Image File Management] ○ [Backup/Restore Function] ○

[Recipe Information] ○ [SRAM control] ○ *2

[Logging information] ○ [Memory card format] -

[Operation log information] ○ [Memory check] -

[File manager] - [GOT Pkg. acquisition] -

[File print] -
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Extended function
○: Available, -: Unavailable

*1 GT SoftGOT2000 supports the server function.
*2 The keyboard input function can be used to perform the same operation as the operation panel function.

Function Available/Unavailable Function Available/Unavailable
Screen gesture - MES Interface -

Object gesture - Device monitor -

Kana-Kanji/Pinyin conversion ○ Network monitor -

Wireless LAN - Log viewer -

SoftGOT-GOT link function ○ iQSS Utility -

System launcher ○ Intelligent module monitor -

System launcher (servo network) ○ Servo amplifier monitor -

Sequence Program Monitor(Ladder) - Drive Recorder ○

Sequence Program Monitor(iQ-R Ladder) - Servo amplifier graph ○

Sequence Program Monitor(SFC) - R motion monitor -

FX Ladder Monitor - Q motion monitor -

Backup/restore ○ CNC Monitor -

Gateway(Server, Client) ○*1 CNC Data I/O -

Gateway(Mail) - CNC Manufacturing Program Editor -

Gateway(FTP Server) - CNC Monitor2 -

File Transfer - Motion Program Editor -

Barcode ○ Motion Program Input/Output -

RFID ○ Motion SFC monitor -

Remote personal computer operation (Serial) - FX list editor -

Remote personal computer operation (Ethernet) - CC-Link IE TSN/CC-Link IE Field 
Network diagnostics

-

VNC server - Recipe Operation ○

Video display - Recipe Display (Record List) ○

RGB display - Operation log screen image -

Multimedia - Operator authentication ○

Operation panel *2 ○ File Manager -

External I/O - Document Display ○

Report ○ MELSEC-L Troubleshooting Function -

Printer ○ Video/RGB display object -

Sound Output ○ GOT Platform Library -

GOT Network Interaction ○ Base screen size expansion -

GOT Mobile Setting - Vision sensor monitor -

Device Data Transfer ○
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Using GT SoftGOT2000 on an MI3000

License key
A license key for GT SoftGOT2000 is not required.

Software license agreement
The software license agreement screen appears at the first startup of GT SoftGOT2000.
Click the [Agree] button to activate GT SoftGOT2000.
The screen does not appear if you already accepted the software license agreement on GT SoftGOT2000 Commander.

Upgrade
To upgrade the preinstalled GT SoftGOT2000, use the English installer.

Linking GT SoftGOT2000 with Edgecross

OPC UA client connection
GT SoftGOT2000 connects to the Edgecross basic software (OPC UA server) by using the OPC UA client connection.
Page 326 OPC UA client connection

Edgecross interaction function
GT SoftGOT2000 monitors the data collected by Edgecross.
Page 665 Edgecross Interaction Function
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2 MONITORING THE PROJECT DATA WITH GT 
SoftGOT2000

Page 52 Starting and Exiting GT SoftGOT2000
Page 63 Screen Configuration of GT SoftGOT2000
Page 67 Environment Setup
Page 74 Setting the Communication Method
Page 104 Opening the Project
Page 108 Monitoring
Page 110 Help
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2.1 Starting and Exiting GT SoftGOT2000
Start GT SoftGOT2000
Start GT SoftGOT2000.
To use GT SoftGOT2000, attach a license key and install the system driver for accessing the license key.
For the details, refer to the following.
Page 44 License key

1. From the Windows start menu, select [MELSOFT] → [GT Works3] → [GT SoftGOT2000] to display the [GT 
SoftGOT2000 Start-up] dialog.

2. Set [Module No.], select a GT SoftGOT2000 module type, and click the [Start] button to display the dialog requesting the 
administrator authority.

3. Click the [OK] button to start GT SoftGOT2000.
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Display position when starting up the GT SoftGOT2000
Select either of the following items on the [Display Setup] tab in the [Environment Setup] dialog.
[Start at the display position of the previous termination]
[Start at the specified display position]
For the details, refer to the following.
Page 70 [Display Setup] tab
If GT SoftGOT2000 was abnormally terminated, its window at the next startup will be displayed in the position 
where the software was last exited properly.
Display position is stored for each CPU number of GT SoftGOT2000.

Precautions for launching other MELSOFT applications while GT SoftGOT2000 is 
running
Run other MELSOFT applications using the following procedure.

■When the User Account Control (UAC) is disabled
Run an application with no need to select [Run as administrator].

■When the User Account Control (UAC) is enabled
Run an application as the administrator.

1. Right-click an application to execute in the Windows start menu.

2. Select [More] → [Run as administrator] to run the software.

Select [Run as administrator] 
from the right-click context menu.
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■Always running an application as an administrator
To always run an application as an administrator, configure the following setting.

1. Select and right-click the application to execute from the start menu of Windows.
Right-click a MELSOFT application.

2. Select [More] → [Open file location] to open the folder of the application to be run.

3. Right-click the application to be run, and select [Properties].

4. In the [Properties] dialog, select the [Compatibility] tab.
Select [Run this program as an administrator] in [Settings].

5. Click the [OK] button to close the dialog.

Select [Open file location] from 
the right-click context menu.

Select [Properties] 
from the right-click context menu.

Select [Run this program as an administrator].
2  MONITORING THE PROJECT DATA WITH GT SoftGOT2000
2.1  Starting and Exiting GT SoftGOT2000



2

Starting up multiple GT SoftGOT2000 modules
Multiple modules of GT SoftGOT2000 can be started up simultaneously by a single computer.
Each module of GT SoftGOT2000 is started up as an "n" module, and can be monitored by different connection types.
The module number appears in the title bar.
Whether to display or hide the module number is selectable on the [Auxiliary Setup] tab in the [Environment Setup] dialog.
While a GT SoftGOT2000 (Single channel) module is running, you cannot start a GT SoftGOT2000 (Multiple channels) 
module having the same module number, and vice versa.
Once you open the [GT SoftGOT2000 Start-up] dialog to start a module, make sure to close the dialog afterward.
If you try to open the [GT SoftGOT2000 Start-up] dialog while it is already open, an error message will appear.
For information on how to specify a module in its shortcut properties, refer to the following.
Page 58 Directly starting the specified GT SoftGOT2000 module

When multiple SoftGOT2000 modules are used, a CPU is automatically assigned to each module when the module starts 
monitoring.

Precautions for starting multiple GT SoftGOT2000 modules
■Monitoring speed when starting up multiple GT SoftGOT2000 modules
When starting up multiple GT SoftGOT2000 modules, the monitoring speed may be reduced according to the performance of 
the personal computer.

The settable module number ranges from 1 to 32767.

■GOT internal device when multiple modules are started up
GOT internal device for each module is controlled separately.
GOT internal device cannot be shared by different modules.

■Data save location when multiple applications are started up
Data save location for each module is controlled separately.

■Monitoring PLCs while multiple modules are running
If the same port number is specified in multiple GT SoftGOT2000 modules to monitor PLCs, only the module that starts 
monitoring first can communicate with the PLCs.
Communication of the GT SoftGOT1000 module that begins monitoring later will time out.

Operating environment when multiple modules are running
Monitoring performance may be degraded or a timeout may occur depending on the specifications of the 
personal computer.
Request the network administrator to adjust each communication setting, which may improve such situations.

GT SoftGOT2000 Recommended number of modules
GT SoftGOT2000 (Single channel) Up to 4

GT SoftGOT2000 (Multiple channels) 1

GT SoftGOT2000 module No. 1 
is connected by the direct CPU 
connection (RS-232, USB).

GT SoftGOT2000 module No. 2
is connected by Ethernet.

GT SoftGOT2000
module No.1

GT SoftGOT2000
module No.2
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Starting GT SoftGOT2000 automatically when starting Windows
The following explains how to start up GT SoftGOT2000 automatically when Windows is started up by using [Online after 
starting].

Before automatic startup
Make sure that the power supply to the connected PLC CPU is turned on before starting up Windows when 
performing automatic startup.

Automatic startup settings
Configure the automatic startup settings using [Task Scheduler] of Windows.

1. Start GT SoftGOT2000, and read the project data to be used at automatic startup of GT SoftGOT2000.

2. In the [Environment Setup] dialog, select the [Auxiliary Setup] tab, and clear [Display the dialog about administrator 
authority when starting GT SoftGOT2000.].

Page 72 [Auxiliary Setup] tab

3. Choose any of the following.
[Online] → [Startup in Online Mode]
[Startup in Online Mode] by right-clicking the mouse

4. Close GT SoftGOT2000.

5. Start Task Scheduler.
For how to start Task Scheduler, refer to Windows Help.

6. Select [Create Task] from [Actions] in [Task Scheduler].

7. On the [General] tab, configure the following settings.

8. On the [Triggers] tab, click the [New] button and configure the following settings.

9. On the [Actions] tab, click the [New] button and configure the following settings.

Setting item Settings
[Name] Set a name.

[Run with highest privileges] Select this item.

[Configure for] Select the OS used.

Setting item Settings
[Begin the task] Select [At log on].

[Delay task for] Select [30 seconds].
According to the personal computer environment, set the optimum time.
When the multiple GT SoftGOT2000 modules do not start automatically although the automatic startup is 
enabled, adjust the delay time for each task.

[Enabled] Select this item.

Setting item Settings
[Action] Select [Start a program].

[Program/script] Specify the executable file of GT SoftGOT2000.
• For GT SoftGOT2000 (Single channel): SGT2000.exe
• For GT SoftGOT2000 (Multiple channels): SGT2000_MultiCH.exe

To start a GT SoftGOT2000 module by specifying the module number, enter the keyword for the module in [Add 
arguments (optional)].
For the keyword for the module number, refer to the following.
Page 58 Directly starting the specified GT SoftGOT2000 module
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10.On the [Settings] tab, configure the following settings.

11. Click the [OK] button to complete the settings.

Setting item Settings
[If the task fails, restart every] Set this item as required.

[Stop the task if it runs longer than] Set the duration before GT SoftGOT2000 automatically stops.
(Default: 3 days)
Deselect this item if you do not want GT SoftGOT2000 to stop automatically.
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Directly starting the specified GT SoftGOT2000 module
The following shows how to start the specified GT SoftGOT2000 module from a shortcut.
Create a shortcut to each module, and specify a module number in the [GT SoftGOT2000 Properties] dialog for each module.
In the following procedure, you start GT SoftGOT2000 (Single channel) module No. 2 as an example.

1. Create a shortcut to GT SoftGOT2000.
For GT SoftGOT2000 (Single channel): SGT2000.exe
For GT SoftGOT2000 (Multiple channels): SGT2000_MultiCH.exe

2. Right-click the shortcut, and select [Properties].

3. In the [GT SoftGOT2000 Properties] dialog, select the [Shortcut] tab, and append the keyword for the module to be 
started to the character string in [Target].

*1 A single-byte space is required before "_".

4. Press the [OK] button after entering the module number.

5. The specified GT SoftGOT2000 module will start upon the next startup.

6. Delete the keyword that was entered in the [Target] field when not specifying the module No.

When starting the GT SoftGOT2000 with the specified module number in the full-screen mode
The specified module of GT SoftGOT2000 can be started in the full-screen by entering the keyword for both 
full screen mode and module No. in the [Target] of [GT SoftGOT2000 Properties].
(There are no rules for the order of entering keywords.)
Example) Starting GT SoftGOT2000 (Single channel) module No. 3 in full screen 1

Refer to the following for the keyword for the full screen mode.
Page 670 Full Screen Mode

Keyword Description
-SGTn *1 -SGTn *1 Specifies the number of the module to be started up.

Set the number of the module to be started up to "n". (1 to 32767)

When module No. 2 is started

C:\Program Files\MELSOFT\SGT2000\SGT2000.exe -SGT3 -NOFRAME

A one-byte space is 
necessary in front of keyword
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Starting a module with linked project data
GT SoftGOT2000 links the project data to the module number before the user exits the program.
At the next startup, GT SoftGOT2000 reads the linked project data and starts monitoring.

1. Configure the settings to start GT SoftGOT2000 by specifying a module number.
Page 58 Directly starting the specified GT SoftGOT2000 module

2. Open the project data to be linked to the module number.

3. Exit GT SoftGOT2000.

4. Start the GT SoftGOT2000 module that has been specified in step 1.

5. Click the [Monitor Start] button to start monitoring using the project data linked in step 2.

How to start monitoring automatically
To start monitoring automatically upon startup of GT SoftGOT2000, select [Online] → [Startup in Online Mode] 
from the menu.
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Exiting from GT SoftGOT2000
This section describes how to exit from GT SoftGOT2000.

1. Perform either of the following operations.
Select [Project] → [Exit] from the menu.
Click the [X] on the tool bar.
Right-click the mouse and select [Exit] from the menu.

2. GT SoftGOT2000 is exited.

Exiting with GOT internal device
Turn ON the GOT internal device (system data area of GT SoftGOT2000: GS500.b0) to exit from GT 
SoftGOT2000.
Presetting the above device as a touch key enables to exit from GT SoftGOT2000 without selecting the menu.
(GT SoftGOT2000 may not be terminated if device ON time is too short. Keep the device ON until GT 
SoftGOT2000 is terminated.)
For details of the GOT internal device, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Select either method.

[Tool bar]
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Switching the display language of GT SoftGOT2000
You can use GT SoftGOT2000 in multiple languages on one personal computer by switching the display language of GT 
SoftGOT2000.

1. Select [View] → [Switch Display Language] from the menu.

2. The [Switch Display Language] dialog appears.
Configure the following setting and click the [OK] button.

3. Restart GT SoftGOT2000 to display the menu items, dialogs, messages, and others in the set language.

Restrictions on the display language switching
■Languages supported on the personal computer
When the personal computer does not support a language to be switched to, screen layouts collapse and characters become 
garbled on GT SoftGOT2000.
Install a language pack or others on the personal computer as needed.

■Items to which the display language switching is not applied
The display language switching is not applied to the following items.

Item Description
[Display Language] Select a display language.

• [English]
• [Japanese(日本語)]
• [Chinese Simplified(簡体中文)]

Item Display specifications
Some right-click context menu items The display language depends on the OS language.

Setting items and buttons in some dialogs The display language depends on the OS language.

Manuals The display language depends on the language version of the manual installed.

Advanced application 
setting

Advanced application 
setting files

The display language depends on the OS language.

Log files of setting check

Contents of the software license agreement Only available in Japanese and English.
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■Language of history data
In the following functions, history data after a display language switching is created in the new display language and added 
into an existing history file.
Therefore, the history file may contain data in multiple display languages set before and after the switching.
If a history file of the mail send function has already been created with GT SoftGOT2000 whose version is earlier than 1.122C, 
another history file is created to record history data after a display language switching.
Application start-up
Mail send function
Functions called from PX Developer

■Operation when multiple modules of GT SoftGOT2000 are started
The display language is shared among all modules of GT SoftGOT2000.
When the display language setting is changed, the setting change is reflected by exiting GT SoftGOT2000 where the setting 
change is made.
The display language of the last exited GT SoftGOT2000 is applied when you newly start a GT SoftGOT2000 module.
Example) When exiting GT SoftGOT2000 (Module No. 1) ([Display Language]: [English]), and then exiting GT SoftGOT2000 
(Module No. 2) ([Display Language]: [Japanese])
Japanese is applied as the display language when GT SoftGOT2000 (Module No. 1) is newly started.

Japanese → English → Japanese

Display language applied 
on the new startup

[Display Language]: [English]

GT SoftGOT2000 (Module No. 1)

1. Exit 2. Exit

3. Startup

1. 2.

Update Update

Apply

GT SoftGOT2000 (Module No. 2)

[Display Language]: [Japanese]

For the already started module of GT SoftGOT2000, 

its display language is not changed.

GT SoftGOT2000 (Module No. 3)

[Display Language]: [Japanese] [Display Language]: [Japanese]

GT SoftGOT2000 (Module No. 1)
2  MONITORING THE PROJECT DATA WITH GT SoftGOT2000
2.1  Starting and Exiting GT SoftGOT2000



2

2.2 Screen Configuration of GT SoftGOT2000
This section describes screen configuration.

Item Description
Title Bar Displays a GT SoftGOT2000 module type, project name and module number, or the comment set with GT SoftGOT2000 Commander.

• GT SoftGOT2000 module type
GT SoftGOT2000 (Single channel) or GT SoftGOT2000 (Multiple channels) is displayed as shown below.
• GT SoftGOT2000 (Single channel): GT SoftGOT2000
• GT SoftGOT2000 (Multiple channels): GT SoftGOT2000(Multi-channel)
• Project name and module number

If GT SoftGOT2000 displays the project data for the first time, the title bar displays [***] as the project name.
If the project title is not set for the project data monitored by GT SoftGOT2000, the title bar displays [No title] as the project name.
• Comment set with GT SoftGOT2000 Commander

Display the comment set with GT SoftGOT2000 Commander. (The line feeds are disabled, and the comment is displayed in one line.)
If GT SoftGOT2000 monitors the linked GOT for the first time, the title bar displays [***].
If the comment is not set with GT SoftGOT2000 Commander, the title bar displays [No comments (**.**.**.**)].
(**.**.**.** indicates the IP address of the linked GOT.)
To display the project name and/or the module number, or the comment set with GT SoftGOT2000 Commander, make a selection in 
the title bar setting in the [Environment Setup] dialog.
For the details of the title bar setting, refer to the following.
Page 67 Environment Setup

Menu Bar Operate GT SoftGOT2000 by using a drop-down menu.
For the details of the menu bar, refer to the following.
Page 64 Menu Bar

Tool Bar Operate GT SoftGOT2000 by selecting an icon.
For the details of the tool bar, refer to the following.
Page 66 Tool bar

Status Bar Displays a description of a command or icon and communication settings, including the channel settings, connection type, controller 
type, communication port, and baud rate.

Title Bar

Tool Bar
Menu Bar

Status Bar 

Dropdown menu
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Menu Bar
This section describes commands assigned to the menu bar.

[Project]

[View]

[Set]

Menu Description
[Open] [Open a Project] Opens a workspace format project created with GT Designer3.

[Open a File] Opens a single file format project (*.GTX) created with GT Designer3.

[Snap Shot] The screen image being monitored is saved into BMP or JPEG format file.

[Print Setup] Configure the print settings.

[Page Setup] Adjusts the page layout for printing.

[Print Preview] Displays a print preview.

[Print] The screen image being monitored is output to a printer.

[Properties] The project title, project ID and data size of project data being monitored are displayed.

[License Registration Information] Displays the license registration information of GT SoftGOT2000.

[Exit] Exit GT SoftGOT2000.

Menu Description
[Toolbar] Displays or hides the toolbar.

[Status Bar] Displays or hides the status bar.

[Scroll Bar] Displays or hides the scroll bar.

[Full Screen Mode] Switches to full screen mode.

[Back Screen Mode] Switches to back screen mode.

[Switch Display Language] Switches the display language of GT SoftGOT2000.

Menu Description
[Environment Setup] Performs environment settings for GT SoftGOT2000.

[Mail Setup] [Mail Setup] Performs mail settings such as dial-up, send address.

[Mail Condition] Disables the mail send setting of the project data.

[Mail History] Displays the operation history of mail sendings.

[Application Setup] [Application Start-up Setting] Allows settings for starting up applications from GT SoftGOT2000.

[Application Start-up History] Shows operation histories of application start-up.

[PX Developer Function 
Setting]

[PX Developer Function Call 
Setting]

Configure the setting to call the monitor tool functions of PX Developer on GT 
SoftGOT2000.

[PX Developer Function Call 
Sub-Setting]

Configure the setting to create a history of calling the PX Developer functions.

[PX Developer Function Call 
History]

Displays the history of calling the monitor tool functions of PX Developer.

[SoftGOT-GOT Link Function Setting] Set resource data to be synchronized together with project data.

[Edgecross Interaction Function Setting] Assign items of data that has been output from Edgecross to SoftGOT2000 internal 
devices.

[Keyboard] Enables or disables the keyboard input.

[Monitor-only Mode] Enables or disables mouse and keyboard operations on the monitored screen.

[Popup Menu] Enables or disables the mouse right click.

[Close Menu] Enables or disables the Close button.

[Exit Key [F12]] Enables or disables exiting GT SoftGOT2000 with the [F12] key.
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[Online]

[Tool]

*1 Not available to GT SoftGOT2000 (Multiple channels).

[Window]

*1 The number of menu options increases correspondingly with the increase in the number of displays.

[Help]

Menu Description
[Monitor Start] Starts monitoring.

[Monitor Stop] Stops monitoring.

[Startup in Online Mode] Starts or does not start monitoring upon startup of GT SoftGOT2000.

[Comm. Error Dialog] Displays or hides the communication error dialog when a communication error occurs.

[Communication Setup] Performs communication settings for GT SoftGOT2000.

Menu Description
[Resource Data] Refers to the resource data in the personal computer.

[File Information in PLC] *1 GT SoftGOT2000 displays the file information in the connected PLC (QCPU or QSCPU).

[SoftGOT-GOT Link Function] [GOT Project Data Acquisition] Synchronizes the project data and resource data of the GOT and GT SoftGOT2000 when 
the SoftGOT-GOT link function is used.

[Resource Data Upload Status] Check the upload status of resource data.

[Script Error] Monitor the execution status of a script (Error Information) to display the current status.

[Object Script Error] Monitor the execution status of an object script (Error Information) to display the current 
status.

[Import] Imports a setting file.

[Export] Exports a setting file.

Menu Description
[Cascade] Cascades the windows of the active GT SoftGOT2000.

[Minimize All Windows] Minimizes all the windows of the active GT SoftGOT2000 modules.

[Move Window] Moves the GT SoftGOT2000 window with a mouse or the Move buttons.

[Move to Start-up Display Position] Moves the GT SoftGOT2000 window to the startup display position.

[Move to Previous Display] Moves the GT SoftGOT2000 window to the display with the previous display No., when 
multiple displays are used.

[Move to Next Display] Moves the GT SoftGOT2000 window to the display with the next display No., when 
multiple displays are used.

Move to Display □ *1 Moves the GT SoftGOT2000 window to the specified display, when multiple displays are 
used.

Menu Description
[GT SoftGOT2000 Help] Displays Help (e-Manual) of GT SoftGOT2000.

[Manual List] Displays the index of PDF manuals.

[Connection to MITSUBISHI ELECTRIC FA Global Website] Connects to the Mitsubishi Electric Factory Automation Global Website.

[About GT SoftGOT2000] Used to check the GT SoftGOT2000 version.
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Tool bar
This section describes the tool bar.

Name Description
[Open a Project] Opens a workspace format project created with GT Designer3.

[Open a File] Opens a single file format project (*.GTX) created with GT Designer3.

[Monitor Start] Starts monitoring.

[Monitor Stop] Stops monitoring.

[Resource Data] Displays resource data.

[Environment Setup] Performs environment settings for GT SoftGOT2000.

[Communication Setup] Performs communication settings for GT SoftGOT2000.

[Mail Setup] Performs mail settings such as dial-up, send address.

[Mail Condition] Disables the mail send setting of the project data.

[Mail History] Displays the operation history of mail sendings.

[Application Start-up Setting] Allows settings for starting up applications from GT SoftGOT2000.

[Application Start-up History] Shows operation histories of application start-up.

[PX Developer Function Call Setting] Configure the setting to call the monitor tool functions of PX Developer on GT SoftGOT2000.

[PX Developer Function Call Sub-Setting] Configure the setting to create a history of calling the PX Developer functions.

[PX Developer Function Call History] Displays the history of calling the monitor tool functions of PX Developer.

[Edgecross Interaction Function Setting] Configure the settings of the Edgecross interaction function.

[Keyboard] Switches keyboard input enable/disable.

[Move to Previous Display] Moves the window to the display with the previous display No. when using multiple displays.

[Move to Next Display] Moves the window to the display with the next display No. when using multiple displays.

[GT SoftGOT2000 Help] Displays Help (e-Manual) of GT SoftGOT2000.
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2.3 Environment Setup
In Environment Setup, set the resolution, etc. of GT SoftGOT2000.

1. Perform either of the following operations.
Clicking  [Environment Setup]

Selecting [Set] → [Environment Setup] from the menu
Right-clicking the mouse to select [Environment Setup] from the menu

2. The [Environment Setup] dialog is displayed.

3. Set each item and click the [OK] button.
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[Environment Setup] dialog

[Action Setup] tab

Item Description
[Display Screen Size (Full 
Screen Mode)] *1

Set the size of the screen display of GT SoftGOT2000 applied when the full screen mode function is used.
• [Follow the resolution on the project data]: Select this item when displaying GT SoftGOT2000 on full-screen display in the size 

of the display screen that corresponds to the resolution set in the project data.
• [Any]: Select this item to set the size of the display screen of GT SoftGOT2000 on full-screen display. After selecting, set the 

size of the display screen.
(Width: [320] to [1920] dots, Height: [240] to [1200] dots)

[Virtual Drive Setting (Not 
set: Default)]

Specify a folder on a hard disk of the personal computer as a virtual drive.
(Default: Standard virtual drive)
Page 33 Specifications of GT SoftGOT2000
To specify the network drive as a virtual drive, set a shared folder on the personal computer.
In such a case, the shared folder must be accessible.
For information on how to set a shared folder on the personal computer, refer to Windows Help.
For the details of the network drive, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

[Internal Device Retention 
Setting]

Set whether to save the values of GOT internal devices (GB and GD) at the specified intervals while GTSoftGOT2000 monitors 
a controller.
• [Retain internal device values in the embedded memory in cycles]

Saves the values of GOT internal devices to the SRAM user area at the specified intervals.
If this item is deselected, the values will be saved when GT SoftGOT2000 exits.
• [Cycle]

Set a time interval to save the values of GOT internal devices to the SRAM user area.
The setting range is [1] minute to [60] minutes.
To use the internal device retention function, configure settings in GT Designer3.
GT Designer3 (GOT2000) Screen Design Manual

[Initialize SRAM user area at 
the time of initial monitoring]

Initializes the SRAM user area when GT SoftGOT2000 starts monitoring.
The following functions save data to the SRAM user area.
• User alarm observation
• System alarm observation
• Logging function
• Recipe function
• Internal device retention

Deselect this item when:
• GT SoftGOT2000 starts monitoring with the data in the SRAM user area at the last exit.
• [GOT Embedded Memory (SRAM)] is set to be uploaded in [SoftGOT-GOT Link Function Setting].
Page 639 SoftGOT-GOT link function setting
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*1 When [Display Screen Size (Full Screen Mode)] is set to a smaller size than the size set for [Resolution] in the [Environment Setup] 
dialog, the user can simultaneously use the full-screen GT SoftGOT2000 and other applications.

Displaying the scroll bars enables GT SoftGOT2000 to display the hidden part of the monitor screen.
Page 678 Scroll Function

Screen size in full screen mode
For selecting [User Setting] for [Display Screen Size (Full Screen Mode)], [Width] and [Height] can be set with 
GOT internal devices (Width: GS503, Height: GS504).
Input values into the corresponding GOT internal devices, and the screen size changes.
For GOT internal devices, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual

When the sizes set for [Resolution] and 

[Display Screen Size (Full Screen Mode)] are the same

  [Resolution] : 1280    1024

  [Display Screen Size (Full Screen Mode)] : 1280    1024

When [Display Screen Size (Full Screen Mode)] is 

set to a smaller size than the size set for [Resolution]

   [Resolution] : 1280    1024

   [Display Screen Size (Full Screen Mode)] : 1280    512
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[Display Setup] tab

Item Description
[Display Position] Specify the position where the GT SoftGOT2000 window is displayed at startup.

• [Start at the display position of the previous termination]
Start a GT SoftGOT2000 window at the position where the software was last exited.
However, if GT SoftGOT2000 was illegally terminated, the window is displayed where the last time GT SoftGOT2000 was 
normally closed.
When the coordinates of the display position of the last exit do not exist on the display, the window at startup is displayed on the 
X coordinate, Y coordinate (0, 0) on the upper-left corner of the main display.
• [Start at the specified display position]

Start a GT SoftGOT2000 window at a specified position.
When the coordinates of the specified display position do not exist on the display, the window at startup is displayed on the X 
coordinate, Y coordinate (0, 0) on the upper-left corner of the main display.

[Position Selection] When [Start at the specified display position] is selected, set the startup display position of the window by one of the following 
methods.
• Specify the display position with the GT SoftGOT2000 icon.

Move the GT SoftGOT2000 icon to the display position.
For the details, refer to the following.
Page 71 Setting procedure
• Specify the display position by directly entering values.

Enter values in [X-Position] and [Y-Position]. ([-32768] to [32767])
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Coordinates of each display
For the coordinates of each display, the X coordinate and Y coordinate on the upper-left corner of the main 
display are the base point (0, 0).
Example) When four displays are used

■Setting procedure
The following shows how to specify the display position.

1. Select [Start at the specified display position] on the [Display Setup] tab.

2. Click the GT SoftGOT2000 icon.

3. When [GT SoftGOT2000 Display Image] appears, drag it to the window display position at the next start.
Release the mouse button, and the values are stored in [X-Position] and [Y-Position].

Main display
1

(Resolution: 1920 × 1080) (Resolution: 1920 × 1200)

Display
2

(Resolution: 1920 × 1080)

Display
3

(Resolution: 1920 × 1080)

Display
4

0, 0 (Base point) 1920, -120

-640, 1080

1280, 1080

Click!

GT SoftGOT2000 Display Image
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[Auxiliary Setup] tab

Item Description
[Window Move Method] Select a means of moving the GT SoftGOT2000 window when its title bar is hidden in full screen mode or for other 

reasons.
For details on moving a window, refer to the following.
Page 679 Moving the Window
• [Mouse] :Uses a mouse to move the GT SoftGOT2000 window.

Determine the window position with a mouse-click.
• [Move Dialog] :The Move window dialog is displayed for window movement, and clicking the up,

down, left or right button moves GT SoftGOT2000 on a 10-dot basis.
A window can also be moved on a panel computer that cannot use a mouse.

[Title Bar] Select information to be displayed on the title bar.
• [Default] :Displays a project name or module number. Select an item to be displayed.
• [Set the comment of GT SoftGOT2000 Commander for the title] :Displays the comment set with GT SoftGOT2000 

Commander.
For information on how to set the comment, refer to the following.
Page 644 Managing GT SoftGOT2000 and GT SoftGOT1000 modules that use the SoftGOT-GOT link function (GT 
SoftGOT2000 Commander)

[Delete all resource data after 
reading project data.]

Deletes all resource data in the virtual drive after reading project data is complete.

[Display dialog when changing to 
full screen mode.]

Displays a confirmation dialog when GT SoftGOT2000 switches to full screen mode.

[Display dialog when changing to 
back screen mode.]

Displays a confirmation dialog when GT SoftGOT2000 switches to back screen mode.

[Display dialog when disabling 
popup menu.]

Displays a confirmation dialog when the popup menu becomes disabled.

[Display a splash when starting GT 
SoftGOT2000.]

Displays the splash screen at GT SoftGOT2000 startup.

[Display the dialog about 
administrator authority when 
starting GT SoftGOT2000.]

Displays a dialog requesting the administrator authority at GT SoftGOT2000 startup.

[Display dialog when starting GT 
SoftGOT2000, specified with the 
module that has been activated.]

Displays a caution dialog when the running GT SoftGOT2000 module is attempted to start again.

[Display dialog when closing GT 
SoftGOT2000.]

Displays a confirmation dialog when GT SoftGOT2000 exits.

[Terminate GT SoftGOT2000 when 
shutting down Windows.] *1

Exits GT SoftGOT2000 at Windows logoff or shutdown.
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*1 It may not work depending on the usage environment.

[Touch Operation Setup] tab

[Display dialog when using GOT 
Link.]

Displays a confirmation dialog when the GOT synchronizes project data.

[Display dialog at the start of 
monitoring in the monitor-only 
mode.]

Displays a confirmation dialog when monitoring starts in monitor-only mode.

[Unmute when starting GT 
SoftGOT2000]

Unmutes GT SoftGOT2000 at its startup regardless of the Windows sound settings.

[Display the start-up selection 
dialog (GT SoftGOT2000 Start-up) 
when starting GT SoftGOT2000]

Displays the [GT SoftGOT2000 Start-up] dialog when GT SoftGOT2000 starts.
This setting is invalid when [Startup in Online Mode] is enabled.

Item Description
[Adjustment for Touch Display] Set the delay time to be given after a touch operation is performed on the touch display or the tablet computer. (Setting 

range: [0] to [500] (ms))
If an object, such as a touch switch, does not operate upon being touched, set this item.
The optimal delay time varies depending on the operating environment.
Set 30 (ms) first and check the operation of an object.
When the object does not operate properly, adjust the time as follows.
• If the object does not operate, set a longer delay time.
• If the object operates with delay, set a shorter delay time.

[Allow press-and-hold of a mouse 
button to function as a right-click]

Displays the right-click context menu with press-and-hold operation.
When this item is selected, you cannot use touch switches whose action is set to [Momentary] and touch switches for 
which [Delay] is set to [ON].

Item Description
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2.4 Setting the Communication Method
In Communication Setup, set the type of the PLC CPU to be connected, the communication time-out period, etc.

1. Perform either of the following operations.
Clicking  [Communication Setup]

Select [Online] → [Communication Setup] from the menu.
Right-click the mouse to select [Communication Setup] from the menu.

2. The [Communication Setup] dialog is displayed.

3. Set each item and click the [OK] button.

Communication Setup
Make Communication Setup before starting monitoring.
After start of monitoring on GT SoftGOT2000, Communication Setup cannot be changed.
(The "Communication Error Dialog" setting can be changed during monitoring.)
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[Communication Setup] dialog

The [Communication Setup] dialog displays controller settings (connection type and controller type for each channel) and 
peripheral settings in the tree structure in the left part of the dialog.
To use channel No. 2 to 4 in GT SoftGOT2000 (Multiple channels), select [Use CH*].
The items selectable for [Connection] are different between GT SoftGOT2000 (Single channel) and GT SoftGOT2000(Multiple 
channels).
The following table shows the details.
○: Supported, ×: Not supported

*1 Only the microcomputer connection (serial) is supported.
*2 Connection via GOT is not supported.

Item in the tree 
structure

Selectable item in 
[Connection]

GT SoftGOT2000
(Single channel)

GT SoftGOT2000
(Multiple channels)

Reference

CH1 to CH4 [RS232] ○ ○ *1 Page 76 [RS232]

[USB] ○ × Page 79 [USB]

[C24] ○ × Page 80 [C24]

[NET/H] ○ × Page 81 [NET/H]

[CC IE Control] ○ × Page 82 [CC IE Control] or [CC IE Field]

[CC IE Field]

[Ethernet] ○ ○ *2 Page 83 [Ethernet]

[OPC] ○ ○ Page 88 [OPC]

[MELIPC Direct] ○ × Page 92 [MELIPC Direct]

[BUS] ○ × Page 93 [BUS]

[GX Simulator] ○ × Page 94 [GX Simulator]

[GX Simulator2] ○ × Page 95 [GX Simulator2]

[GX Simulator2/MT 
Simulator2]

○ × Page 96 [GX Simulator2/MT Simulator2]

[GX Simulator3] ○ × Page 97 [GX Simulator3]

[MELSOFT Mirror] ○ × Page 98 [MELSOFT Mirror]

[Barcode Reader] - ○ ○ Page 99 [Barcode Reader]

[RFID] - ○ ○ Page 100 [RFID]

GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
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[Communication Setup] dialog ([Connection Setup] tab)
This section explains how to configure settings in GT SoftGOT2000 (Single channel).

[RS232]

Item Description
[Connection] Select [RS232].

[Type] *1*2 Select the PLC to be connected.
([MELSEC iQ-F], [MELSEC-A], [MELSEC-QnA], [MELSEC-Q], [MELSEC-Q(A-Mode)], [MELSEC-L], [MELSEC-FX], [MELDAS 
C6*], [OMRON SYSMAC], [YASKAWA], or [Computer])

[Comm. Port] Select a communication port of the personal computer. ([COM1] to [COM63])
When starting multiple applications including GT SoftGOT2000, set a communication port different from those set for the other 
applications.
If the same communication port is specified, a communication timeout may occur, interrupting monitoring.

[Baud Rate] Set the transmission speed to/from the CPU.
([9.6Kbps], [19.2Kbps], [38.4Kbps], [57.6Kbps], [115.2Kbps])
If the connection target is FXCPU, select a baud rate that FXCPU supports.
When the set baud rate is not supported, communication is made at 9.6kbps.
When selecting a transmission speed that is not supported by OMRON SYSMAC, a communication error occurs.

[Time Out] Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor. ([1] to [90] sec)

[Other] Set the timeout period for other station monitor. ([1] to [90] sec)

[Retry] [0] time

[Option] The following items are settable only when [YASKAWA] is selected for [Type].

[Host Add.] Specify the host address (the station number of a programmable controller to which connects 
GT SoftGOT2000) within the connection network. ([1] to [31])

[Wait Time] Set the transmission wait time to reduce the load on the network and target PLC. ([0] to [300] 
(ms))

The following item is settable only when [MELSEC-Q] is selected for [Type].

[CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

The following item is settable only when [MELSEC iQ-F] is selected for [Type].

[Module No. switching GD 
device first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify module numbers. ([0] to 
[65520])

[Servo axis switching GD device 
first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify an axis number. ([0] to 
[65520])
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*1 To monitor the CNC C70, select [MELSEC-Q].
*2 Only [Computer] is available to GT SoftGOT2000 (Multiple channels).
*3 To use the DTR (ER) control as the control method, set [None].

[Option] The following items are settable only when [Computer] is selected for [Type].

[Baud Rate] Set the transmission speed to/from the CPU.
([9.6Kbps], [19.2Kbps], [38.4Kbps], [57.6Kbps], [115.2Kbps])
Set the baud rate to be used.

[Data Bit] Set this item when changing the data length in communication with controllers. ([7bit], [8bit])

[Stop Bit] Specify the stop bit length in communication. ([1bit], [2bit])

[Parity] Specify whether to perform a parity check during communication, and specify the type of the 
parity check when necessary. ([None], [Even], or [Odd])

[Host Add.] Specify the host address (the station number of the PLC connected to GT SoftGOT2000) in the 
connected network. ([0] to [31])

[Format] Select a communication format. ([1] to [15])
• Format 1: GOT-A900 Series microcomputer connection (format 1)
• Format 2: GOT-A900 Series microcomputer connection (format 2)
• Format 3: A compatible 1C frame (format 1)
• Format 4: A compatible 1C frame (format 2)
• Format 5: A compatible 1C frame (format 3)
• Format 6: A compatible 1C frame (format 4)
• Format 7: QnA compatible 4C frame (format 1)
• Format 8: QnA compatible 4C frame (format 2)
• Format 9: QnA compatible 4C frame (format 3)
• Format 10: QnA compatible 4C frame (format 4)
• Format 11: SCHNEIDER EJH's memory link method (compatibility mode)
• Format 12: SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:1)
• Format 13: SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n)
• Format 14: GOT-F900 Series microcomputer connection (format 1)
• Format 15: GOT-F900 Series microcomputer connection (format 2)

[Interrupt Data Byte] Set the number of bytes of the interrupt data. ([1Byte], [2Byte], or [4Byte])

[Special Interrupt Code] Set whether to output special interrupt codes. ([Done] or [None])

[Control Method] Set a control method. ([None] or [XON/XOFF])
• [None]: Does not set the control method. *3

• [XON/XOFF]: Uses the XON or XOFF control.

[32bit Storage] Select the storage order of 32-bit data.
• [LH Order]: The GOT writes data into controller devices in order of data from lower 16 bits to 

upper 16 bits.
• [HL Order]: The GOT writes data into controller devices in order of data from upper 16 bits to 

lower 16 bits.

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.

[Device Entry Mode] Select this item to enable high-speed monitoring on GT SoftGOT2000.
If the device entry mode is used when a FXCPU is connected, the device range for monitoring may be restricted, and monitoring 
may not be performed properly.
This item is selectable only when [CPU Direct Connection (RS232)] is selected for [Connection] and [MELSEC-Q], [MELSEC-L], 
or [MELSEC-FX] is selected for [Type].

Item Description
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■Precautions for using device entry mode (When the MELSEC-FX connection)
The precautions for applying the device entry mode are described below.
Apply the device entry mode after the adequate debugging.
 • Devices that can be set
An error (Communication time out) may occur if the following device (Bit device) is set.
For the device as objects, set other than the devices shown below when applying the device entry mode.

 • When using the offset function
When offset function is applied, the device range above may be monitored during an unintended moment and an error 
(Communication time out) may occur.
Create the project data so that any offset will not operate for the devices above.

■Outputting special interrupt codes
A special interrupt code is output when an event occurs.
If multiple events occur simultaneously, special interrupt codes may not be output.
The following shows special interrupt codes and the events that correspond to the codes.

Type of connected CPU Device name (Bit device) Device range
FX0(S),FX0N Counter contact (C) C224 to C239

C240 to C255

Special auxiliary relay (M) M8240 to M8255

FX1 Timer contact (T) T240 to T255

Counter contact (C) C128 to C143

C224 to C239

C240 to C255

FX1S Counter contact (C) C224 to C239

FX1N Counter contact (C) C192 to C207

FX2(C) Counter contact (C) C192 to C207

FX2N(C) Counter contact (C) C192 to C207

FX3U(C) Counter contact (C) C192 to C207

FX3G(C) Counter contact (C) C192 to C207

FX3S Counter contact (C) C192 to C207

Special interrupt code (Hex) Event type
20H Base screens and overlap windows 1 to 5

When a screen is switched according to the screen switching device, the special interrupt code is output.
Base screens and overlap windows are switched independently.
(Example)
If the values of the screen switching devices for a base screen and overlap windows 1 and 2 are changed, three 
special interrupt codes will be output.

21H When inputting a value or ASCII character is complete, the special interrupt code is output.

22H When reading or writing recipe data is complete, the special interrupt code is output.

23H When reading a barcode or RFID data is complete, the special interrupt code is output.
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[USB]

*1 To monitor the CNC C80, select [MELSEC iQ-R].
To monitor the CNC C70, select [MELSEC-Q].

Item Description
[Connection] Select [USB].

[Type] *1 Select the PLC to be connected.
([MELSEC iQ-R], [MELSEC iQ-L], [MELSEC iQ-F], [MELSEC-Q], [MELSEC-QS], [MELSEC-L], [MELSEC-FX])

[Time Out] Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor. ([1] to [90] sec)

[Other] Set the timeout period for other station monitor. ([1] to [90] sec)

[Retry] [0] time

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.

[Option] The following item is settable when [MELSEC iQ-R], [MELSEC-Q], or [MELSEC-QS] is selected for [Type].

[CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

The following item is settable when [MELSEC iQ-R] or [MELSEC iQ-F] is selected for [Type].

[Module No. switching GD 
device first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify module numbers. ([0] to 
[65520])

[Servo axis switching GD device 
first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify an axis number. ([0] to 
[65520])

[Device Entry Mode] Select this item to enable high-speed monitoring on GT SoftGOT2000.
If the device entry mode is used when a FXCPU is connected, the device range for monitoring may be restricted, and monitoring 
may not be performed properly.
This item is selectable only when [USB] is selected for [Connection] and [MELSEC-Q], [MELSEC-L], or [MELSEC-FX] is selected 
for [Type].
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[C24]

*1 To monitor the CNC C80, select [RJ71C24].
To monitor the CNC C70, select [QJ71C24(N)] or [QJ71CMO].

Item Description
[Connection] Select [C24].

[Type] *1 Select the PLC (computer link module or serial communication module) to be connected.([AJ71C24], [AJ71UC24], [AJ71QC24], 
[AJ71QC24N], [QJ71C24(N)], [QJ71CMO], [LJ71C24], [RJ71C24])

[Comm. Port] Select a communication port of the personal computer. ([COM1] to [COM63])
When starting multiple applications including GT SoftGOT2000, set a communication port different from those set for the other 
applications.
If the same communication port is specified, a communication timeout may occur, interrupting monitoring.

[Baud Rate] Set the transmission speed to/from the CPU.
([9.6Kbps], [19.2Kbps], [38.4Kbps], [57.6Kbps], [115.2Kbps])
Set the baud rate to be used.
When the set baud rate is not supported, communication is made at 9.6kbps.

[Time Out] Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor. ([1] to [90] sec)

[Other] Set the timeout period for other station monitor. ([1] to [90] sec)

[Retry] [0] time

[Option] The following item is settable when [QJ71C24(N)], [QJ71CMO], or [RJ71C24] is selected for [Type].

[CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

The following item is settable only when [RJ71C24] is selected for [Type].

[Module No. switching GD 
device first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify module numbers. ([0] to 
[65520])

[Servo axis switching GD device 
first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify an axis number. ([0] to 
[65520])

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[NET/H]

Item Description
[Connection] Select the [NET/H].

[Type] Select the PLC (MELSECNET/H unit) to be connected.([1st module], [2st module], [3st module], [4st module])

[Time Out] Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor. ([1] to [90] sec)

[Other] Set the timeout period for other station monitor. ([1] to [90] sec)

[Retry] [0] time to [10] times

[Option] [CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[CC IE Control] or [CC IE Field]

Item Description
[Connection] Select [CC IE Control] or [CC IE Field].

[Type] Select the PLC (CC-Link IE Controller Network communication unit or CC-Link IE Field Network communication unit) to be 
connected.([1st module], [2st module], [3st module], [4st module])

[Time Out] Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor. ([1] to [90] sec)

[Other] Set the timeout period for other station monitor. ([1] to [90] sec)

[Retry] [0] time to [10] times

[CC IE Control/CC IE 
Field]

Select a monitor speed.

[Monitor Speed] The following shows the items to be selected.
• [High]
• [Normal]
• [Low]

[Option] [CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

[Module No. switching GD 
device first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify module numbers. ([0] to 
[65520])

[Servo axis switching GD device 
first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify an axis number. ([0] to 
[65520])

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[Ethernet]

Item Description
[Connection] Select [Ethernet].

[Type] Select the PLC to be connected. ([MITSUBISHI ELECTRIC], [OMRON SYSMAC], [OMRON NJ/NX]*1, [YASKAWA], [YASKAWA 
MP3000], [YASKAWA Robot Controller], [YOKOGAWA], [TOSHIBA nv], [SIEMENS S7], [SIEMENS OP], [KEYENCE KV], 
[HITACHI], [LS Industrial Systems], [AB Control/CompactLogix(Tag)]*1, [MODBUS Slave(GOT:Master)], [MODBUS 
Master(GOT:Slave)], [SLMP], [GOT]*2, or [Computer])

[Time Out] The following items are settable when an item other than [Computer] is selected for [Type].
Set the timeout period and retry count.
Depending on the settings on the [Connection] menu, some items cannot be set.

[Host] Set the timeout period for host station monitor.

[MITSUBISHI ELECTRIC]
[OMRON SYSMAC]
[OMRON NJ/NX]
[YASKAWA]
[YASKAWA MP3000]
[YASKAWA Robot Controller]
[YOKOGAWA]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[HITACHI]
[LS Industrial Systems]
[AB Control/CompactLogix(Tag)]
[MODBUS Slave(GOT:Master)]
[SLMP]

[1] to [90] sec

[MODBUS Master(GOT:Slave)] [3] sec

[GOT] [3] to [90] sec

GT SoftGOT2000 (Single channel) GT SoftGOT2000 (Multiple channels)
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[Time Out] [Other] Set the timeout period for other station monitor.

[MITSUBISHI ELECTRIC]
[OMRON SYSMAC]
[OMRON NJ/NX]
[YASKAWA]
[YASKAWA MP3000]
[YASKAWA Robot Controller]
[YOKOGAWA]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[HITACHI]
[LS Industrial Systems]
[AB Control/CompactLogix(Tag)]
[MODBUS Slave(GOT:Master)]
[SLMP]

[1] to [90] sec

[MODBUS Master(GOT:Slave)] [3] sec

[GOT] [3] to [90] sec

[Retry] [MITSUBISHI ELECTRIC]
[GOT]

[0] to [10] Time(s)

[OMRON SYSMAC]
[YASKAWA]
[YASKAWA MP3000]
[YASKAWA Robot Controller]
[YOKOGAWA]
[TOSHIBA nv]
[KEYENCE KV]
[HITACHI]
[LS Industrial Systems]
[MODBUS Slave(GOT:Master)]
[SLMP]

[0] to [5] Time(s)

[OMRON NJ/NX]
[SIEMENS S7]
[SIEMENS OP]
[AB Control/CompactLogix(Tag)]
[MODBUS Master(GOT:Slave)]

[3] times

Item Description
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[Option] The following items are settable when [MITSUBISHI ELECTRIC] or [GOT] is selected for [Type].*2

[CPU No. switching GD device 
first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to 
[65520])

[Module No. switching GD 
device first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify a Unit No. ([0] to 
[65520])

[Servo axis switching GD device 
first No. (16 points)]

Set the start device number of the GOT data registers (GD) to specify module numbers. ([0] to 
[65520])

The following item is settable when [MODBUS Slave(GOT:Master)], [MODBUS Master(GOT:Slave)], or [Computer] is selected for 
[Type].

[32bit Storage] Select the storage order of 32-bit data.
• [LH Order] : The GOT writes data into controller devices in order of data from lower 16 bits to 

upper 16 bits.
• [HL Order] : The GOT writes data into controller devices in order of data from upper 16 bits 

to lower 16 bits.

The following items are settable when [MODBUS Slave(GOT:Master)] is selected for [Type].

[FunctionCode[0F]] Select whether to use the function code [0F].
• [Used]
• [Unused]

[FunctionCode[10]] Select whether to use the function code [10].
• [Used]
• [Unused]

[Coil read times] Set the number of coils to be read. ([1] to [2000])

[Input relay read times] Set the number of input relays to be read. ([1] to [2000])

[Holding register read times] Set the number of holding registers to be read. ([1] to [125])

[Input register read times] Set the number of input registers to be read. ([1] to [125])

[Coil write times] Set the number of coils to be written. ([1] to [800])

[Holding register write times] Set the number of holding registers to be written. ([1] to [100])

The following item is settable only when [SLMP] is selected for [Type].

[Message Format] Set a message format.
• [QnA compatible 3E frame]
• [4E frame]

[Communication data code] Set a communication data code.
• [ASCII code]
• [Binary code]

[Device read points] Set the number of consecutive devices from which data is read ([1] to [960]).

[Device write points] Set the number of consecutive devices to which data is written ([1] to [960]).

[Device read random points] Set the number of separate devices from which data is read ([0] to [192]).

[Device write random points] Set the number of separate devices to which data is written ([0] to [160]).

The following items are settable only when [Computer] is selected for [Type].

[Protocol] Select a communication protocol.
• [TCP/IP]
• [UDP/IP]

[Format] Select a communication format. ([1] to [9])

[Interrupt Data Byte] Select the number of bytes of the interrupt data.
• [1Byte]
• [2Byte]
• [4Byte]

[Special Interrupt Code] Select whether to have the special interrupt code output or not.
• [Done]
• [None]

[Living Confirmation] Select whether to perform the living confirmation.
• [Yes]
• [No]

[Living Confirmation Cycle] Set the cycle to perform the living confirmation. ([10] (sec) to [100] (sec))

[Destination module I/O 
number]

Select the I/O number and station number of the connection destination module that responds 
to the request from the controller.
• [0]
• [Same as requested value]

Item Description
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[Ethernet] [NET No.] Set the network number of GT SoftGOT2000.

[MITSUBISHI ELECTRIC]
[OMRON NJ/NX]
[YASKAWA]
[YASKAWA MP3000]
[YOKOGAWA]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[HITACHI]
[LS Industrial Systems]
[AB Control/CompactLogix(Tag)]
[MODBUS Slave(GOT:Master)]
[SLMP]
[Computer]

[1] to [239]

[OMRON SYSMAC] [1] to [127]

[YASKAWA Robot Controller] [1]

[MODBUS Master(GOT:Slave)]
[GOT]

[0]

[Port No.] Set the port number of the personal computer.

[MITSUBISHI ELECTRIC] GT SoftGOT2000 (Single channel): [1024] to [65535]
GT SoftGOT2000 (Multiple channels): [1024] to [65534]

[OMRON SYSMAC]
[YASKAWA]
[YASKAWA MP3000]
[YASKAWA Robot Controller]
[YOKOGAWA]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[HITACHI]
[LS Industrial Systems]
[MODBUS Slave(GOT:Master)]
[SLMP]
[Computer]

[1024] to [65534] (Except [5011], [5012], [5013], and 
[49153] to [49170])

[OMRON NJ/NX]
[AB Control/CompactLogix(Tag)]

[1024] to [65534] (Except [5011], [5012], [5013], [44818], 
and [49153] to [49170])

[MODBUS Master(GOT:Slave)] [502] to [65534] (Except [503] to [1023], [5011], [5012], 
[5013], and [49153] to [49170])

[GOT] [5001]

[PC No.] *3 Set the PLC station number of GT SoftGOT2000.

[MITSUBISHI ELECTRIC]
[YASKAWA Robot Controller]
[SLMP]

[1] to [120]

[OMRON SYSMAC]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[HITACHI]

[1] to [254]

[OMRON NJ/NX]
[YASKAWA]
[YASKAWA MP3000]
[YOKOGAWA]
[LS Industrial Systems]
[AB Control/CompactLogix(Tag)]
[Computer]

[1] to [64]

[MODBUS Slave(GOT:Master)] [1] to [247]

[MODBUS Master(GOT:Slave)] [255]

[GOT] [19]

Item Description
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*1 [OMRON NJ/NX] and [AB Control/CompactLogix(Tag)] are not available in GT SoftGOT2000 (Single channel).
*2 [GOT] is not available in GT SoftGOT2000 (Multiple channels).
*3 Set a different PLC number for each controller on the same network.

Also, when monitoring the controllers on a network through multiple GT SoftGOT2000 modules and other applications on a personal 
computer simultaneously, set different PLC numbers for the controllers.

*4 For configuring the settings in GT SoftGOT2000 (Multiple channels), refer to the following.
Page 101 [Communication Setup] dialog ([SoftGOT-GOT Link Function Setting] tab)

*5 The SoftGOT-GOT link function and gateway server function cannot be used at the same time.
This item cannot be set when [Use Gateway Server Function] in the [Gateway Server Function Setting] tab is selected.
Page 102 [Communication Setup] dialog ([Gateway Server Function Setting] tab)

[Ethernet] [Wait Time] Set the transmission wait time to reduce the load on the network and target PLC.

[MITSUBISHI ELECTRIC]
[OMRON SYSMAC]
[YASKAWA]
[YASKAWA MP3000]
[YOKOGAWA]
[TOSHIBA nv]
[SIEMENS S7]
[SIEMENS OP]
[KEYENCE KV]
[MODBUS Slave(GOT:Master)]
[GOT]

[0] to [10000] (x 10 ms)

[OMRON NJ/NX]
[YASKAWA Robot Controller]
[HITACHI]
[LS Industrial Systems]
[AB Control/CompactLogix(Tag)]
[MODBUS Master(GOT:Slave)]
[SLMP]
[Computer]

[0] to [10000] (ms)

[Use GOT Link] *4*5 Select this item to use the SoftGOT-GOT link function.
For the SoftGOT-GOT link function, refer to the following.
Page 614 SoftGOT-GOT Link Function

[Destination GOT IP Address] Set the IP address of the GOT.
Click the [Communication Test] button to execute the communication test with the GOT.

[Destination GOT Port No.] Set the port No. of the GOT.

[Data Transfer Password] Set a password to authenticate reading project data from the GOT as necessary.
Up to 32 characters can be set.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&()*+,-./:;<=>?@[\]^_`{|}~
By setting a password, an authentication is automatically executed when project data is read 
from the GOT.

[Communication method] Set the communication method.
[TCP]: Communication using TCP/IP
[UDP]: Communication using UDP/IP

[Communication Test] button Executes a communication test.

[Adjust the clock] *4 Synchronizes the time of the personal computer where GT SoftGOT2000 runs with the time of the controller while the SoftGOT-
GOT link function is used.
For precautions when using the time setting function, refer to the following.
Page 41 Precautions for using GT SoftGOT2000

[Communication Error 
Dialog] *4

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.

Item Description
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[OPC]

Item Description
[Connection] Select [OPC].

[Type] Select [OPC UA].

[Step1: Access destination 
device setting]

Configure or import the access destination device settings.
• [Not set]: The access destination device settings are not configured.
• [Set]: The access destination device settings are configured or imported.

[Set the access 
destination device 
setting]

Enables configuring the access destination device settings.
Click the [Detail Setting] button to display the [Access destination device setting] dialog.
For the details of the [Access destination device setting] dialog, refer to the following.
Page 89 [Access destination device setting] dialog

[Import the access 
destination device 
setting]

Imports the data of access destination device settings.
Click the [Browse] button to specify the file to be imported.
The following files can be imported.
• Access destination device setting file (*.gtpm)
• GT Designer3 Files(*.GTX)

[Step2: Client certificate 
setting]

Create or import a client certificate.
• [Not set]: The client certificate settings are not configured.
• [Set]: The client certificate setting is set, or the client certificate is imported.

[Create the client 
certificate]

Creates a client certificate.
Click the [Detail Setting] button to display the [Creation of client certificate] dialog.
For the details of the [Creation of client certificate] dialog, refer to the following.
Page 90 [Creation of client certificate] dialog
The location where a client certificate and security key are saved is different between GT 
SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple channels).
Example) When GT SoftGOT2000 (Single channel) module No. 1 has been started through channel 
No. 1
• Client certificate (client.der)

GT SoftGOT2000 installation folder\Multi\00001\OPC UA Set\SingleCh\PKI\certs
• Security key (client.pem)

GT SoftGOT2000 installation folder\Multi\00001\OPC UA Set\SingleCh\PKI\private
Example) If GT SoftGOT2000 (Multiple channels) module No. 1 has started through channel No. 1
• Client certificate (client.der)

GT SoftGOT2000 installation folder\Multi\00001\OPC UA Set\Ch1\PKI\certs
• Security key (client.pem)

GT SoftGOT2000 installation folder\Multi\00001\OPC UA Set\Ch1\PKI\private

[Import the client 
certificate]

Imports a client certificate.
Click the [Browse] button to specify the file to be imported.
The following files can be imported.
• Client certificate (*.gtcl)
2  MONITORING THE PROJECT DATA WITH GT SoftGOT2000
2.4  Setting the Communication Method



2

■[Access destination device setting] dialog
Configure the settings according to the settings of the OPC UA server to be connected.

[Step3: Connection check] Check the connection with the OPC UA server.
Click the [Communication Test] button to perform a communication test.

Item Description
[Setting of connection end server] [End point URL] Set the endpoint URL of the OPC UA server.

Up to 1024 characters can be entered directly.
Click the [Search] button to search for OPC UA servers on the host or subnet on which 
GTSoftGOT2000 resides.
For the details of the [Search] dialog, refer to the following.
Page 91 [Search] dialog

[Server Name] Displays the OPC UA server name.

[Security Policy] Select a security policy for communication.
• [None]

Does not encrypt messages.
• [Basic128Rsa15]

Uses 128-bit encryption.
• [Basic256]

Uses 256-bit encryption.
• [Basic256Sha256]

Uses digital signing and 256-bit encryption.

[Security Mode] Set whether to digitally sign or encrypt messages.
• [None]

Does not encrypt messages.
• [Sign]

Digitally signs messages.
• [SignAndEncrypt]

Digitally signs and encrypts messages.

[Timeout Time] Set a time-out period to connect to the server.
Set a time-out period to search for available servers and connect to the specified server.
The setting range is [1] (second) to [30] (seconds).

[Retry] Set the number of retries to connect to the server.
The setting range is [0] (times) to [10] (times).

[Delay Time] Set the wait time for sending when the server is connected.
The setting range is [0] (× 10 ms) to [10000] (× 10 ms).

[Check] button Displays the [Authentication of server certificate] dialog if the connection to the server succeeds.
For the details of the [Authentication of server certificate] dialog, refer to the following.
Page 91 [Authentication of server certificate] dialog

[User Token Type] Select a user authentication method.
• [Anonymous user]

Performs an anonymous login.
• [Use name/Password]

Authenticates users with a user name and password.
Select this item, and set [User Name] and [Password]

Item Description
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■[Creation of client certificate] dialog

*1 The application URI identifies its OPC UA client.
*2 The RSA key is a pair of a public key and a private key used in public-key cryptosystems.

Item Description
[Organization name] Specify an organization name within 256 characters.

This setting is mandatory.

[Unit of organization] Specify an organization unit within 256 characters.

[Region name] Specify a region name within 256 characters.

[Prefecture/State name] Specify a prefecture or state name within 256 characters.

[Country] Specify a country with its ISO 3166-1 alpha-2 code.
Up to two one-byte alphanumeric characters can be entered.
Example) Japan: JP

[Domain] Specify a domain within 16 characters.
This setting is mandatory.

[Application URI] Displays the application URI. *1

[Expiration date] Set the expiration date of the client certificate.
• [1 hour]
• [1 day]
• [1 week]
• [1 month]
• [1 year]
• [2 year]
• [3 year]
• [4 year]
• [5 year]
• [10 year]
• [20 year]

[Strength of RSA key] Set the strength of the RSA key *2

This setting is mandatory.
• [1024bits]
• [2048bits]
• [3072bits]
• [4096bits]

[Signature algorithm] Set a signature algorithm.
This setting is mandatory.
• [Sha1]
• [Sha256]
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■[Search] dialog

■[Authentication of server certificate] dialog

Item Description
[Host] Enter all or part of a host name and click the [Search] button to display the search results in the endpoint URL list.

Endpoint URL list Lists the endpoint URLs of the OPC UA servers found.
Select an endpoint URL and click the [OK] button to reflect it in [End point URL] in the [Access destination device setting] dialog.

Item Description
[Field] Displays the fields in the server certificate.

[Value] Displays the values obtained from the server certificate.
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[MELIPC Direct]
To connect GT SoftGOT2000 on the Windows part of a MELIPC to the VxWorks part of the MELIPC via virtual Ethernet, set 
[Connection] to [MELIPC Direct].
To connect GT SoftGOT2000 to a MELIPC via Ethernet or CC-Link IE Field, set [Connection] to [Ethernet], and set [Type] to 
[MITSUBISHI ELECTRIC].
Page 83 [Ethernet]

Item Description
[Connection] Select [MELIPC Direct].

[Type] Select the PLC to be connected. ([MELIPC])

[Time Out] Set the timeout period and retry count.

[Other] Set the timeout period for other station monitor.
([1] to [90] sec)

[Retry] [0] to [10] Time(s)

[Ethernet] [NET No.] [1] to [239]

[Port No.] [1024] to [65535]

[PC No.] [1] to [120]

[Wait Time] Set the transmission wait time to reduce the load on the network and target PLC.
[0] to [10000] (x 10ms)

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[BUS]

Item Description
[Connection] Select [BUS].

[Type] Select the PLC to be connected.([MELSEC-Q])

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[GX Simulator]

Item Description
[Connection] Select [GX Simulator].

[Type] Select the PLC to be connected.([MELSEC-A], [MELSEC-QnA], [MELSEC-Q], [MELSEC-Q(A-Mode)], [MELSEC-FX])

[Default] Reads sequence programs for the END instruction only.

[GX Developer Project] Specifies the sequence programs to be read.

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[GX Simulator2]

Item Description
[Connection] Select [GX Simulator2].

[Connect to activated 
GXSimulator2 (one of the 
projects)]

Select this item when connecting to a single module of GX Simulator2.

[Type] Select the PLC to be connected.

[Connect GX Simulator2 
(multiple projects)]

Select this item when connecting to multiple modules of GX Simulator2.

Select the simulator to be connected to enable the setting.

[Connection Simulator] Select the simulators to be connected.

[Host] Select this item when setting to the host station.

[NW No.] Set the network No. ([0] to [239])

[PC No.] Set the station No. ([0] to [255])

[CPU No.] Set the CPU No. ([0] to [4])

[Type] Select the PLC to be connected.

[Project Name] Set the project used with the simulator to be connected.

[Add Row] Adds a new row. (a maximum of 7 rows)

[Delete Row] Deletes a selected row.

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[GX Simulator2/MT Simulator2]

Item Description
[Connection] Select GX Simulator2/MT Simulator2.

[GX Simulator2 Setting] Select the simulator to be connected to enable the setting.

[Host] Select this item when setting to the host station.

[NW No.] Set the network No. ([0] to [239])

[PC No.] Set the station No. ([0] to [255])

[CPU No.] Set the CPU No. ([0] to [4])

[Project Name] Set the project used with the simulator to be connected.

[Add Row] Adds a new row. (a maximum of 4 rows)

[Delete Row] Deletes a selected row.

[MT Simulator2 Setting] Select a connection method to enable the setting.

[Host] Select this item when setting to the host station.

[NW No.] Set the network No. ([0] to [239])

[PC No.] Set the station No. ([0] to [255])

[CPU No.] Set the CPU No. ([2] to [4])

[Type] Select the PLC to be connected.

[OS] Select the OS used of PLC.

[Project Name] Set the project used with the simulator to be connected.

[User name] Set the user name used with the simulator to be connected.

[Password] Set the password used with the simulator to be connected.

[Add Row] Adds a new row. (a maximum of 3 rows)

[Delete Row] Deletes a selected row.

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[GX Simulator3]

Item Description
[Connection] Select GX Simulator3.

[GX Simulator3 Setting] Select the simulator to be connected to enable the setting.

[Host] Select this item when setting to the host station.

[NW No.] Set the network No. ([0] to [239])

[PC No.] Set the station No. ([0] to [255])

[CPU No.] Set the CPU No. ([0] to [4])

[Connecting Simulator No.] Set the simulator No. displayed on the corresponding GX Simulator3. ([1.1] to [64.4])

[Add Row] Adds a new row. (a maximum of 32 rows)

[Delete Row] Deletes a selected row.
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[MELSOFT Mirror]

Item Description
[Connection] Select [MELSOFT Mirror].

[Connection Destination 
Setting]

[Connection Destination URL] Specify the URL for connection with the MELSOFT Mirror server.
Specify the URL with one-byte alphanumerics and symbols within 2083 characters.

[Retrieve hardware configuration 
information from MELSOFT Mirror.] 
button

Acquires the hardware configuration being simulated in MELSOFT Mirror.
When this button is clicked, the hardware configuration information of MELSOFT Mirror 
is reflected in the detail setting table for [Monitor Target Setting].

[Monitor Target Setting] Select the monitoring target to be connected to enable the setting.

[No.] Displays the item number.

[Monitor] Select this item to monitor the network information.

[Host] Select this item to set it as the host station.

[System ID.] Set the system ID of the system to be simulated. ([1] to [30])

[Main base unit Slot No.] Set the slot number of the CPU module on the main base unit in the system to be 
simulated. ([slot CPU], [slot I/O 0] to [slot I/O 6])

[Add Row] Adds a row. (64 maximum)

[Delete Row] Deletes the selected row.

[Behavior of CPU devices 
not set as monitoring 
targets]

Set the behavior of CPU devices not targeted for monitoring.

[Monitor] All the CPU devices not targeted for monitoring are monitored.
To monitor these devices, set either of the following behaviors.
• [Same as Host Station]

The devices display the same as the devices of the monitored host station.
• [Display 0]

The devices all display zero.

[Not monitor] The CPU devices not targeted for monitoring are not monitored.

[CPU No. switching GD 
device first No. (3 points)]

Set the start device number of the GOT data registers (GD) to specify CPU numbers. ([0] to [65520])

[Communication Error 
Dialog]

Select this item to display the error dialog on the GT SoftGOT2000 module when a communication error occurs.
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[Barcode Reader]

Item Description
[Use Bar Code] Select this item to use barcodes.

[Comm. Port] Choose the communication port on the personal computer side. ([COM1] to [COM16])
When starting multiple applications including GT SoftGOT2000, set a communication port different from those set for the other 
applications.
If the same communication port is specified, a communication timeout may occur, interrupting monitoring.

[Baud Rate] Set this item when changing the baud rate in communication with controllers.([4.8kbps], [9.6kbps], [19.2kbps], [38.4kbps], 
[57.6kbps], [115.2kbps])

[Data Bit] Set this item when changing the data length in communication with controllers. ([7bit], [8bit])

[Stop Bit] Specify the stop bit length in communication. ([1bit], [2bit])

[Parity] Specify whether to carry out parity checks in communication and specify the type of parity check if carrying out. ([None], [Even], 
[Odd])
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[RFID]

Item Description
[Use RFID] Select this item to use RFID.

[Comm. Port] Choose the communication port on the personal computer side. ([COM1] to [COM16])
When starting multiple applications including GT SoftGOT2000, set a communication port different from those set for the other 
applications.
If the same communication port is specified, a communication timeout may occur, interrupting monitoring.

[Baud Rate] Set this item when changing the baud rate in communication with controllers.([4.8kbps], [9.6kbps], [19.2kbps], [38.4kbps], 
[57.6kbps], [115.2kbps])

[Data Bit] Set this item when changing the data length in communication with controllers. ([7bit], [8bit])

[Stop Bit] Specify the stop bit length in communication. ([1bit], [2bit])

[Parity] Specify whether to carry out parity checks in communication and specify the type of parity check if carrying out. ([None], [Even], 
[Odd])

[Sum Check] Select whether to carry out sum checks in communication. ([Done], [None])

[Retry] Set the number of retries to be performed when a communication error occurs. ([0] to [5] time(s))When receiving no response 
after retries, the communication times out.

[Time Out] Set the time required for communication to time out. ([3] to [30] sec)

[Delay Time] Set this item to adjust the timing with which a communication request is sent from the GOT. ([0] to [3000] ms)

[Format] Select the communication format. ([10], [11], [12], [15])
Dedicated protocol
Format10: Dedicated protocol (LSRF manufactured by LS Industrial Systems Co., Ltd.)
Format11: Dedicated protocol (ICU-60S manufactured by MARS TECHNO SCIENCE Corp.)
Format12: Dedicated protocol (ICU-215 (Mifare) manufactured by MARS TECHNO SCIENCECorp.)
Nonprocedural protocol
Format15
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[Communication Setup] dialog ([SoftGOT-GOT Link Function 
Setting] tab)
This dialog is displayed only when the settings are configured in GT SoftGOT2000 (Multiple channels).
The SoftGOT-GOT link function and gateway server function cannot be used at the same time.
This item cannot be set when [Use Gateway Server Function] in the [Gateway Server Function Setting] tab is selected.
Page 102 [Communication Setup] dialog ([Gateway Server Function Setting] tab)

Item Description
[Use GOT Link] Select this item to use the SoftGOT-GOT link function.

For the SoftGOT-GOT link function, refer to the following.
Page 614 SoftGOT-GOT Link Function

[Destination GOT IP Address] Set the IP address of the GOT.
Click the [Communication Test] button to execute the communication test with the GOT.

[Destination GOT Port No.] Set the port No. of the GOT.

[Data Transfer Password] Set a password to authenticate reading project data from the GOT as necessary.
Up to 32 characters can be set.
Numeric characters, A to Z, a to z, a one-byte space, and the following symbols are available.
!"#$%&()*+,-./:;<=>?@[\]^_`{|}~
By setting a password, an authentication is automatically executed when project data is read 
from the GOT.

[Communication Test] button Executes a communication test.

[Adjust the clock] Synchronizes the time of the personal computer where GT SoftGOT2000 runs with the time of the controller while the SoftGOT-
GOT link function is used.
For precautions when using the time setting function, refer to the following.
Page 41 Precautions for using GT SoftGOT2000

[Communication Error 
Dialog]

Select this item to display the error dialog on GT SoftGOT2000 when a communication error occurs.
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[Communication Setup] dialog ([Gateway Server Function 
Setting] tab)
Set this item when using the gateway server function with GT SoftGOT2000 as the server.
For the details, refer to the description of the server/client function in the following manual.
GT Designer3 (GOT2000) Screen Design Manual
The SoftGOT-GOT link function and gateway server function cannot be used at the same time.
This item cannot be set when [Use Gateway Server Function] in the [Connection Setup] tab or [SoftGOT-GOT Link Function 
Setting] tab is selected.
Page 76 [Communication Setup] dialog ([Connection Setup] tab)
Page 101 [Communication Setup] dialog ([SoftGOT-GOT Link Function Setting] tab)

Item Description
[Use Gateway Server 
Function]

Select this item to enable the gateway server function.

[NET No.] Set the network number of the GT SoftGOT2000.
([1] to [239])

[PC No.] Set the PLC station number of the GT SoftGOT2000.
([1] to [64])

[Port No.] Set the Ethernet port number of the device with GT SoftGOT2000 installed.
([1024] to [65534])

[IP Address] Set the IP address of the device with GT SoftGOT2000 installed.
([0.0.0.0] to [255.255.255.255])
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[Communication Setup] dialog ([GOT network interaction 
function settings] tab)
Configure the settings to specify GT SoftGOT2000 as the master GOT when using the GOT network interaction function.

Item Description
[Control authorization 
using GT SoftGOT2000 
(this module)]

Select this item to specify this module as the master GOT.

[IP Address] Set the IP address of the device with GT SoftGOT2000 installed.
([0.0.0.0] to [255.255.255.255])

[Port No.] Set the Ethernet port number of the device with GT SoftGOT2000 installed.
([1024] to [65534])
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2.5 Opening the Project
Set a project data for monitoring and start monitoring.
The project data that can be set is the GT Designer3 project, a single file format project, and the GT Designer2 file.
 • GT Designer3 project: Project data created with GT Designer3
 • A single file format project (*.GTX) of GT Designer3: Compressed project data created with GT Designer3

Opening workspace files
1. Perform either of the following operations.

Click  [Open a Project].
Select [Project] → [Open] → [Open a Project.] from the menu.
Right-click the mouse and select [Open] → [Open a Project.] from the menu.

2. The [Open Project] dialog is displayed.
Set the following items, and click the [Open] button.

3. The confirmation dialog is displayed.
(The dialog is not displayed if GT SoftGOT2000 is already in online mode.)

Item Description
[Save Folder Path] Enter the path of the location where the workspace is stored.

[Workspace/Project List] Displays the workspace or project existing in the same path entered for [Folder path to save].
Double-click the workspace to be opened to display projects stored in the workspace.
Select the project to be opened.

[Workspace Name] Displays the workspace name where the project selected in [Workspace/Project List] is stored.

[Project Name] Displays the project name selected in [Workspace/Project List].
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4. Select [Yes] to start monitoring with the project selected in the [Open Project] dialog.

If you select [No], no project is displayed.
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Opening a single file format project
1. Perform either of the following operations.

Click  [Open a File].
Select [Project] → [Open] → [Open a File] from the menu.
Right-click the mouse and select [Open] → [Open a File] from the menu.

2. The [Open project.] dialog is displayed.
Set up the following items and click the [Open] button.

3. The confirmation dialog is displayed.
(The dialog is not displayed if GT SoftGOT2000 is already in online mode.)

Item Description
[Look in] Enter the path of the location where the workspace is stored.

[File name] Sets project data name for monitoring.

[Files of type] Selects a file format of the project data.
GOT2000 file (*.GTX): GTX format
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4. Select [Yes] to start monitoring with the project selected in the [Open Project] dialog.

If you select [No], no project is displayed.
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2.6 Monitoring
Starting Monitoring
This section describes how to perform monitoring with the project data monitored previously.

1. Perform either of the following operations.
Click [Monitor Start]

Select [Online] → [Monitor Start] from the menu.
Right-click the mouse and select [Monitor Start] from the menu.

2. Monitoring is started with the project data monitored previously.

Before monitoring
The following shows the procedure used when not starting monitoring with the project data monitored 
previously.
 • When performing a monitoring for the first time
Select [Project] → [Open] and set a project data to be monitored.
Page 104 Opening the Project
When performing a monitoring for the first time, performing the operation shown in this section causes GT 
SoftGOT2000 to display the Utility.
 • When project data has been changed after previous monitoring
Select [Project] → [Open] and set the project data to be monitored before starting monitoring.
Page 104 Opening the Project
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Operation while monitoring
During monitoring, you can operate GT SoftGOT2000 with a mouse or via the touchscreen.

Monitor Stop
This section describes how to stop a monitoring.

1. Perform either of the following operations.
Click  [Monitor Stop].

Select [Online] → [Monitor Stop] from the menu.
Right-click the mouse and select [Monitor Stop] from the menu.

2. The monitoring stops.

Select either method.

[Tool bar]
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2.7 Help
With Help, You can view GT SoftGOT2000 Help (e-Manual) and PDF manual, and check the software version.

 • Before viewing Help (e-Manual)
To view an e-Manual, install e-Manual Viewer.
 • Before viewing the PDF manual
To view the PDF manual, GT Manual3 and Adobe Reader must be installed.

Operating method
1. Click an item within [Help].

How to view a PDF manual (When [Manual List] is selected)
1. Select [Help] → [Manual List] from the menu to display the following screen, and then click a manual to view.

Since the above page was created for explanation purpose, it differs from the actual page.

2. The selected manual is displayed.
(For the operation of Adobe Reader, refer to the Adobe Reader Help.)

Since the above page was created for explanation purpose, it differs from the actual page.

Item Description
[GT SoftGOT2000 Help] Displays Help (e-Manual) of GT SoftGOT2000.

[Manual List] Displays the index of PDF manuals.

[Connection to the Mitsubishi Electric Factory Automation Global 
Website.]

Connects to the Mitsubishi Electric Factory Automation Global Website.

[About GT SoftGOT2000] Used to check the GT SoftGOT2000 version.

Click.

Switches the current display 
to the page of the selected 
section.

Returns to INDEX MENU.
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Confirming GT SoftGOT2000 version (When [About GT SoftGOT2000...] is selected)
1. After operation in [Help] → [About GT SoftGOT2000], the screen about GT SoftGOT2000 is displayed.

Item Description
[GT SoftGOT2000] Displays GT SoftGOT2000 version.

[Name] Displays the name entered during GT SoftGOT2000 installation.

[Company] Displays the company name entered during GT SoftGOT2000 installation.

[Software License Agreement] Appears when GT SoftGOT2000 is used on an MI3000.
Click this item to display the software license agreement screen.

[OK] Closes the About GT SoftGOT2000 screen.

When GT SoftGOT2000 is installed When GT SoftGOT2000 is preinstalled
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3 CONNECTION BETWEEN GT SoftGOT2000 
AND DEVICES

Page 114 Required Devices
Page 115 Supported Connection Types
Page 116 Controller that can be Monitored and the Accessible Range
Page 169 How to Monitor the Redundant System (RCPU)
Page 203 How to Monitor the Redundant System (QCPU)
Page 229 Ethernet Connection
Page 299 Direct CPU connection (RS-232, USB)
Page 308 Serial Communication Connection
Page 318 Bus Connection
Page 319 MELSECNET/H, MELSECNET/10 Connection
Page 322 CC-Link IE Controller Network Connection
Page 324 CC-Link IE Field Network Connection
Page 326 OPC UA client connection
Page 331 MELIPC Connection
Page 339 CNC Connection
Page 344 Robot Controller Connection
Page 349 Inverter Connection (Direct Connection)
Page 360 Inverter Connection (via PLC)
Page 362 Servo amplifier connection (via Motion controller or Simple Motion module)
Page 365 Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)
Page 367 Servo Amplifier Connection (via Motion Module)
Page 369 Servo Amplifier Connection (via CC-Link IE TSN-equipped Module)
Page 371 Servo Amplifier Connection (Direct Connection)
Page 377 Connecting with GX Simulator3
Page 378 Connecting with GX Simulator2, MT Simulator2
Page 379 Connecting with GX Simulator
Page 380 MELSOFT Mirror connection
Page 381 Non-Mitsubishi Electric PLC connection
Page 421 Microcomputer Connection (Serial)
Page 488 Microcomputer Connection (Ethernet)
Page 560 MODBUS/TCP Master Connection
Page 563 MODBUS/TCP Slave Connection
Page 565 SLMP Connection
Page 568 Barcode Reader Connection
Page 570 RFID Connection
Page 572 Sound Output Device Connection
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3.1 Required Devices
Type of personal computer to be used
The system configuration and connection conditions differ according to the type of the PC used with GT SoftGOT2000.

Personal computer that can run Windows
Connect a PC/AT compatible PC with the controller using a cable.
Use an interface board according to the communication type.

PC CPU
Mount a PC CPU to the base unit of Q series PLC CPU.
Bus connection is available between PC CPUs on the same base unit.
In other connection types, connect a PC CPU with the controller using a cable.

MELIPC
To connect GT SoftGOT2000 on a MELIPC to the VxWorks part of the MELIPC, no connection cable is required.
To connect GT SoftGOT2000 on a MELIPC to any other controller, use applicable cables according to the connection type 
used.

Connectable devices
For the connection types of GT SoftGOT2000 and the controllers that can be monitored by each connection type, refer to the 
following.
Page 116 Controllers that can be monitored by connection type

Usable converters and cables
The converters and cables used for GX Work2 or GX Developer can also be used for GT SoftGOT2000.

MELIPCPC CPUPersonal computer that can run Windows
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3.2 Supported Connection Types
The supported connection types are different between GT SoftGOT2000 (Single channel) and GT SoftGOT2000 (Multiple 
channels).
Refer to the following table, and select GT SoftGOT2000 (single channel) or GT SoftGOT2000 (Multiple channels) according 
to the number of channels and the connection type to be used.
○: Supported, ×: Not supported

Connection type GT 
SoftGOT2000 
(Single channel)

GT SoftGOT2000 
(Multiple 
channels)

Reference

Ethernet connection ○ ○ Page 229 Ethernet Connection

Direct CPU connection (RS-232, USB) ○ × Page 299 Direct CPU connection (RS-232, USB)

Serial communication connection ○ × Page 308 Serial Communication Connection

Bus connection ○ × Page 318 Bus Connection

MELSECNET/H or MELSECNET/10 connection ○ × Page 319 MELSECNET/H, MELSECNET/10 
Connection

CC-Link IE Controller Network connection ○ × Page 322 CC-Link IE Controller Network 
Connection

CC-Link IE Field Network connection ○ × Page 324 CC-Link IE Field Network Connection

OPC UA client connection ○ ○ Page 326 OPC UA client connection

MELIPC connection ○ ○ *1 Page 331 MELIPC Connection

CNC connection ○ ○ *1 Page 339 CNC Connection

Robot controller connection ○ ○ Page 344 Robot Controller Connection

Inverter connection × ○ *1 Page 349 Inverter Connection (Direct Connection)
Page 360 Inverter Connection (via PLC)

Servo amplifier connection (via Motion controller or 
Simple Motion module)

○ ○ *1 Page 362 Servo amplifier connection (via Motion 
controller or Simple Motion module)

Servo amplifier connection (via Simple Motion 
module or CC-Link IE Field Network master/local 
module)

× ○ *1 Page 365 Servo amplifier connection (via Simple 
Motion module or CC-Link IE Field Network master/local 
module)

Servo amplifier connection (via Motion module) × ○ *1 Page 367 Servo Amplifier Connection (via Motion 
Module)

Servo Amplifier Connection (via CC-Link IE TSN 
Master/Local Module)

× ○ *1 Page 369 Servo Amplifier Connection (via CC-Link 
IE TSN-equipped Module)

Servo amplifier connection (direct connection) × ○ Page 371 Servo Amplifier Connection (Direct 
Connection)

Connecting with GX Simulator3 ○ × Page 377 Connecting with GX Simulator3

Connecting with GX Simulator2 or MT Simulator2 ○ × Page 378 Connecting with GX Simulator2, MT 
Simulator2

Connecting with GX Simulator ○ × Page 379 Connecting with GX Simulator

MELSOFT Mirror connection ○ × Page 380 MELSOFT Mirror connection

OMRON PLC connection ○ ○ *1 Page 381 Non-Mitsubishi Electric PLC connection

KEYENCE PLC connection ○ ○ Page 388 KEYENCE PLC

TOSHIBA PLC connection ○ ○ Page 391 TOSHIBA PLC

HITACHI IES PLC ○ ○ Page 394 HITACHI IES PLC

YASKAWA PLC connection ○ ○ *1 Page 397 YASKAWA PLC

YASKAWA robot controller ○ ○ Page 405 YASKAWA robot controller

YOKOGAWA PLC connection ○ ○ Page 408 YOKOGAWA PLC

LS Industrial Systems PLC ○ ○ Page 411 LS Industrial Systems PLC

ALLEN-BRADLEY PLC × ○ Page 414 ALLEN-BRADLEY PLC

SIEMENCE PLC connection ○ ○ Page 417 SIEMENS PLC

Microcomputer Connection (Serial) ○ ○ *2 Page 421 Microcomputer Connection (Serial)

Microcomputer Connection (Ethernet) ○ ○ Page 488 Microcomputer Connection (Ethernet)

MODBUS/TCP master connection ○ ○ Page 560 MODBUS/TCP Master Connection

MODBUS/TCP slave connection ○ ○ Page 563 MODBUS/TCP Slave Connection

SLMP connection ○ ○ Page 565 SLMP Connection
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*1 Only the Ethernet connection is supported.
*2 One of channels 1 to 4 is available only.

3.3 Controller that can be Monitored and the 
Accessible Range

Controllers that can be monitored by connection type
This section describes the controllers that can be monitored by GT SoftGOT2000 and the supported connection types.
The controllers listed in this section are explained with the abbreviations and generic terms.
The following shows an example of a list of controllers.
Some of the contents are different from the contents in the actual list of controllers.

Barcode reader connection ○ ○ Page 568 Barcode Reader Connection

RFID connection ○ ○ Page 570 RFID Connection

Sound output device connection ○ ○ Page 572 Sound Output Device Connection

No. Abbreviations and generic terms Description
1) CPU direct RS-232 Direct CPU connection (RS-232)

USB Direct CPU connection (USB)

2) C24 Serial communication connection

3) Ether Via PLC Ethernet connection (via PLC)

Via servo amplifier Ethernet connection (via servo amplifier)

Direct Direct Ethernet connection

4) MODBUS/TCP M MODBUS/TCP master connection

S MODBUS/TCP slave connection

5) MNET H MELSECNET/H connection

10 MELSECNET/10 connection

6) CC IE Cont CC-Link IE Controller Network connection

7) CC IE Field Via PLC CC-Link IE Field Network connection (via PLC)

Direct CC-Link IE Field Network connection

8) Clock function Time setting function, time notification function

Connection type GT 
SoftGOT2000 
(Single channel)

GT SoftGOT2000 
(Multiple 
channels)

Reference

1) 2) 3) 4) 5) 6) 7) 8)
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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MELSEC PLC
■RCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 Mount the safety function module (R6SFM) next to the CPU module on the base unit.
The CPU module and the safety function module (R6SFM) must have the same pair version.
If their pair versions differ, the CPU module does not operate.

*3 The Ethernet port built in the CPU (CPU P1 or P2), RJ71EN71, RJ71GN11-T2, RJ71GN11-EIP, or Motion module (RD78G□) is usable.
The connection with RJ71GN11-T2, RJ71GN11-EIP, or the Motion module (RD78G□) is only available to GT SoftGOT2000 (Multiple 
channels).

*4 Use RJ71GP21-SX.
*5 The Ethernet port built in the CPU (port P1 or port P2), RJ71EN71, RJ71GF11-T2, RD77GF4, RD77GF8, RD77GF16, or RD77GF32 is 

usable.
*6 The MELSEC redundant system is configurable by mounting the redundant function module (R6RFM).
*7 For a redundant system, use a CC-Link IE Field Network interface board that has a serial number starting with 18042 or later.
*8 Not applicable to the redundant system.
*9 For the redundant system, use a communication module having a firmware version as shown below.

RJ71EN71, RJ71GP21-SX, and RJ71GF11-T2: Firmware version 12 or later
RJ61BT11: Firmware version 04 or later
RJ71C24, RJ71C24-R2, and RJ71C24-R4: Firmware version 07 or later

*10 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No. 1.

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /

TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

PLC CPU R00CPU × ○ ○ ○ ○ *13 × × × × ○ ○ ○ *10*11

R01CPU

R02CPU

R04CPU × ○ ○ ○ ○ *13 × × × × ○ ○ ○ *10*11

R08CPU

R16CPU

R32CPU

R120CPU

Process CPU R08PCPU *6 × ○ ○ *8 × ○ *9 × × × × ○ *9 ○ *7*9 ○ *10*11

R16PCPU *6

R32PCPU *6

R120PCPU *6

Safety CPU R08SFCPU *2 × ○ ○ × ○ × × × × ○ ○ ○ *10*11

R16SFCPU *2

R32SFCPU *2

R120SFCPU *2

SIL2 process CPU 
(redundant mode)

R08PSFCPU *12 × ○ × × ○ *9 × × × × ○ *9 ○ *7*9 ○ *10*11

R16PSFCPU *12

R32PSFCPU *12

R120PSFCPU *12

CPU with built-in 
CC-Link IE

R04ENCPU × ○ ○ ○ ○ *3 × × × × ○ *4 ○ *5 ○ *10*11

R08ENCPU

R16ENCPU

R32ENCPU

R120ENCPU
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*11 For the CC-Link IE Controller Network connection or CC-Link IE Field Network connection, the time setting function and the time 
notification function are not available.

*12 Mount a SIL2 function module (R6PSFM) and a redundant function module (R6RFM) next to a SIL2 process CPU on the base unit.
*13 RJ71EN71, RJ71GN11-T2, RJ71GN11-EIP, or the Motion module (RD78G□) is usable.

The connection with RJ71GN11-T2, RJ71GN11-EIP, or the Motion module (RD78G□) is only available to GT SoftGOT2000 (Multiple 
channels).

■LHCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 Communication is established through the built-in Ethernet port.
Configure the Ethernet settings, including the IP address.

■LCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 The direct CPU connection (RS-232) requires an adapter L6ADP-R2.
*3 The CPU having a serial number starting with 13012 or later in the first 5 digits can be monitored.

Use version 1.50C or later of GX Works2.
*4 For the CC-Link IE Field Network connection, the time setting function and the time notification function are not available.

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /

TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

MELSEC iQ-L 
series

L04HCPU × ○ × ○ ○ × × × × × × ○

L08HCPU

L16HCPU

L32HCPU

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /

TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

MELSEC-L series L02CPU ○ *2 ○ ○ ○ ○ × × × × × ○ *3 ○ *4

L06CPU

L26CPU

L26CPU-BT

L02CPU-P

L06CPU-P

L26CPU-P

L26CPU-PBT

L02SCPU ○ ×

L02SCPU-P
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■QCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
The bus connection can be used only when a PC CPU module is used.
For the connectable QCPU, refer to the following.
User's manual of the PC CPU used
○: Applicable, ×: Inapplicable

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /

TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

Basic model CPU Q00JCPU ○ × ○ × ○ × × ○ *5 ○ *5 ○ *6*7 × ○ *16*17

Q00CPU *2*3

Q01CPU *2*3

High Performance 
model CPU

Q02CPU *3*4 ○ *8*9 ○ *16*17

Q02HCPU *3*4 ○

Q06HCPU *3*4

Q12HCPU *3*4

Q25HCPU *3*4

Process CPU Q02PHCPU ○ ○ ○ × ○ × × ○ *5 ○ *5 ○ *9 × ○ *16*17

Q06PHCPU

Q12PHCPU ○ *9*10

Q25PHCPU

Redundant CPU 
(main base)

Q12PRHCPU ○ ○ × × ○ × × ○ 
*5*11*12

○ 
*5*11

○ *6*10 × ○ *17

Q25PRHCPU

Redundant CPU 
(extension base)

Q12PRHCPU × × ○ × ○ × × × × × × ○

Q25PRHCPU

Universal model Q00UJCPU *2 ○ ○ ○ × ○ × × ○ *5 ○ *5 ○ *13 ○ ○ *16*17

Q00UJCPU(-S8) *2

Q00UCPU *2

Q01UCPU *2

Q02UCPU *2 ○ 
*13*14

Q03UDCPU *2

Q04UDHCPU *2 ○ *13

Q06UDHCPU *2

Q10UDHCPU *2

Q13UDHCPU *2

Q20UDHCPU *2

Q26UDHCPU *2

Universal model 
(Built-in Ethernet 
port CPU)

Q03UDECPU ○ *15 ○ ○ × ○ × × ○ *5 ○ *5 ○ 
*13*14

○ ○ *16*17

Q04UDEHCPU ○ *13

Q06UDEHCPU

Q10UDEHCPU

Q13UDEHCPU

Q20UDEHCPU

Q26UDEHCPU

Q50UDEHCPU

Q100UDEHCPU
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*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 The serial communication function is not supported.
*3 To configure a multiple CPU system, use a CPU with function version B or later.
*4 To monitor a High Performance model CPU by the MELSECNET/10 connection, the CPU function version must be B or later.
*5 Use a MELSECNET/H network module with function version B or later.
*6 Use a CC-Link IE Controller Network module with function version D or later.
*7 Use a CPU with function version B or later.
*8 Use a CPU having a serial number stating with 09012 or later in the first 5 digits.
*9 If the number of stations on one network is 65 or more, use a CC-Link IE Controller Network module with a serial number starting with 

09042 or later in the first 5 digits.
*10 Use a CPU having a serial number stating with 10042 or later in the first 5 digits.
*11 Use a MELSECNET/H interface board driver (SW0DNC-MNETH-B) with version K or later.
*12 The MELSECNET/H extended mode cannot be used in a QCPU redundant system.
*13 Use a CC-Link IE Controller Network module having a serial number starting with 09042 or later in the first 5 digits.
*14 Use a CPU having a serial number stating with 09042 or later in the first 5 digits.
*15 No interface for direct connection is provided.

Use the serial port of the QCPU in a multiple CPU system.
*16 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No. 1.
*17 For the bus connection, MELSECNET/H connection, CC-Link IE Controller Network connection, or CC-Link IE Field Network 

connection, the time setting function and the time notification function are not available.

High-speed 
Universal model 
(Built-in Ethernet 
port CPU)

Q03UDVCPU ○ *15 ○ ○ ○ ○ × × ○ *5 ○ *5 ○ *13 ○ ○ *16*17

Q04UDVCPU

Q06UDVCPU

Q13UDVCPU

Q26UDVCPU

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /

TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct
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■C Controller module
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 Use a C Controller module having a serial number starting with 12042 or later in the first 5 digits.
*3 This module has no USB port to connect to a personal computer.

Monitor the module via an RCPU in the multiple CPU system.
*4 Use a serial port of the serial communication module controlled by another module in the multiple CPU system.
*5 R12CCPU-V is not compatible with RJ71EN71.

Use the Ethernet port built in the CPU.
*6 No interface for direct connection is provided.

Use the serial port of the QCPU in a multiple CPU system.
*7 Use the C24 serial port controlled by another module in the multiple CPU system.
*8 C Controller modules are not compatible with QJ71E71.

Use the Ethernet port built in the CPU.
*9 Use a CC-Link IE Controller Network module having a serial number starting with 09042 or later in the first 5 digits.
*10 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No.1.
*11 For the MELSECNET/H connection, CC-Link IE Controller Network connection, or CC-Link IE Field Network connection, the time setting 

function and the time notification function are not available.

■MELSECWinCPU
Supported by GT SoftGOT2000 (Multiple channels) only.
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS 

/TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

MELSEC iQ-R 
series

R12CCPU-V × ○ *3 ○ *4 ○ ○ *5 × × × × ○ ○ ○ *10*11

MELSEC-Q 
series

Q12DCCPU-V *2 ○ *6 ○ ○ *7 × ○ *8 × × ○ ○ ○ *9 ○ ○ *11

Q24DHCCPU-V

Q24DHCCPU-LS

Q26DHCCPU-LS

Q24DHCCPU-VG

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSEC iQ-R 
series

R102WCPU-W × × × ○ × × × × × × ×
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■MELSECNET/H remote I/O station
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

■QSCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 Writing data to a QS001CPU always causes an error.
*2 To communicate with the CPU, configure the following settings in the device setting dialog on GT Designer3.

Set [CPU No.] to 0.
Select [Host].

*3 A safety CPU cannot be set as a relay station for another network connection.
*4 Use a CC-Link IE Controller Network module with the function version D or later.
*5 Use a CPU having a serial number stating with 13042 or later in the first 5 digits.

Use GX Developer version 8.98C or later.

■QCPU(A mode)
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 Monitor the CPU as an A4UCPU.
*2 Other MELSOFT products (such as GX Developer) cannot be connected while GT SoftGOT2000 is connected.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSECNET/H remote 
I/O station

QJ72LP25-25 ○ × × × × × × × × × ×

QJ72LP25G

QJ72BR15

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSEC-QS series QS001CPU *1 × ○ *2 × ○ *3 × × ○ *3 ○ *3 ○ *3*4 ○ *3*5 ×

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSEC-Q series (A 
mode)

Q02CPU-A *1 ○ *2 × ○ ○ × × × ○ × × ×

Q02HCPU-A *1

Q06HCPU-A *1
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■QnACPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 GT SoftGOT2000 cannot monitor a QnACPU that uses an A series computer link module or Ethernet module.
*2 Use function version B or later of an AJ71QE71 and QnACPU.

If function version of an AJ71QE71 or QnACPU is earlier than B, this connection is not available.

■ACPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
QnACPU type Q2ACPU ○ × ○ *1 ○ *1*2 × × × ○ × × ×

Q2ACPU-S1

Q3ACPU

Q4ACPU

Q4ARCPU

QnASCPU type Q2ASCPU

Q2ASCPU-S1

Q2ASHCPU

Q2ASHCPU-S1

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
AnCPU 
type

AnUCPU A2UCPU ○ × ○ *3 ○ × × × ○ × × ×

A2UCPU-S1

A3UCPU

A4UCPU

AnACPU A2ACPU

A2ACPUP21

A2ACPUR21

A2ACPU-S1

A2ACPUP21-S1

A2ACPUR21-S1

A3ACPU

A3ACPUP21

A3ACPUR21

AnNCPU A1NCPU ○ *2

A1NCPUP21

A1NCPUR21

A2NCPU

A2NCPUP21

A2NCPUR21

A2NCPU-S1

A2NCPUP21-S1

A2NCPUR21-S1

A3NCPU

A3NCPUP21

A3NCPUR21
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*1 A0J2-C214-S1 (computer link module dedicated to A0J2HCPU) cannot be used.
*2 Data can be written to the CPUs having the software version as show below.

AnNCPU(S1) (with data link): Version L or later, AnNCPU(S1) (without data link): Version H or later
A2SCPU: Version H or later, A0J2HCPU: Version E or later
A0J2HCPU-DC24: Version B or later, A2CCPU: Version H or later

*3 A0J2-C214-S3, A2CCPU, and A2CJCPU are not connectable by the computer link connection.
*4 Use a computer link module having software version U or later for the computer link connection.

■MELSEC iQ-F
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

*2 The time setting function or the time notification function is performed to CPU No. 1.

AnCPU 
type

AnUS(H)C
PU

A2USCPU ○ × ○ *3*4 ○ × × × ○ × × ×

A2USCPU-S1

A2USHCPU-S1

AnS(H)CP
U

A1SCPU

A1SCPUC24-R2

A1SHCPU

A2SCPU ○ *2

A2SCPU-S1

A2SHCPU ○

A2SHCPU-S1

A1SJ(H)C
PU

A1SJCPU

A1SJCPU-S3

A1SJHCPU

A0J2HCPU A0J2HCPU *1 ○ *2 ×

A0J2HCPUP21 *1

A0J2HCPUR21 *1

A0J2HCPU-DC24 
*1

A2CCPU A2CCPU × ×

A2CCPU-P21 ○

A2CCPU-R21

A2CCPUC24 ○ *3*4

A2CCPUC24-PRF

A2CJCPU ×

A2CJCPU-S3

A1FXCPU A1FXCPU

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS 

/TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via servo 
amplifier

Direct M S H 10 Direct

MELSEC iQ-F series FX5U ○ × × ○ ○ × × × × × × ○ *2

FX5UC

FX5UJ ○

FX5S

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
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■FXCPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

■CC-Link IE Field Network head module
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

■CC-Link IE Field Network Ethernet adapter module
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

*2 The host station cannot be monitored.

Controller Connection type Clock 
functionCPU direct C24 Ether 

*1
MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSEC-FX series FX0 series ○ × × × × × × × × × ×

FX0S series

FX0N series

FX1 series

FX1S series

FX1N series

FX1NC series

FX2 series

FX2C series

FX2N series

FX2NC series

FX3U series ○

FX3UC series

FX3G series ○

FX3GC series

FX3GE

FX3S series

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
CC-Link IE Field Network 
head module

RJ72GF15-T2 × ○ ○ ○ × × × × × ○ ×

LJ72GF15-T2 ×

Controller Connection type Clock 
functionCPU direct C24 Ether 

*1
MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
CC-Link IE Field 
Network Ethernet 
adapter module *2

NZ2GF-ETB × × × ○ × × × × × × ×
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■Motion CPU
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 Only the PLC CPU area (CPU No.1) can be monitored.
The PERIPHERAL I/F cannot be used.

*3 Monitor the CPU as a Q03UDCPU.
*4 The following requirements must be satisfied.

Software: MT Works2 Version 1.23Z
CPU model name: Q170M SV43

*5 No interface for direct connection is provided.
Use the serial port of the QCPU in a multiple CPU system.

*6 If a motion controller (A series) is used as a remote I/O station, the controller cannot be connected by any connection type.
*7 Monitor the CPU as an A3UCPU.
*8 Monitor the CPU as an A2SHCPU.
*9 Use a computer link module having software version U or later for the computer link connection.
*10 Other MELSOFT products (such as GX Developer) cannot be connected while GT SoftGOT2000 is connected.
*11 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No. 1.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MELSEC iQ-R series R16MTCPU × ○ ○ ○ × × × × ○ ○ ○ *11

R32MTCPU

R64MTCPU

MELSEC-Q series Q170MCPU *2*3*4 ○ ○ ○ ○ × × ○ ○ ○ ○ ○ *11

Q170MSCPU *2*3

Q170MSCPU-S1 
*2*3

Q172DSCPU ○ *5

Q173DSCPU

MELSEC-A 
series *6

Large type A273UHCPU *7 ○ *10 × ○ ○ × × × ○ × × ×

A273UHCPU-S3 *7

Compact 
type

A171SHCPU *8*9

A171SHCPUN *8

A172SHCPU *8*9

A172SHCPUN *8

A173UHCPU *7

A173UHCPU-S1 *7
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OPC UA server
For the connectable OPC UA servers and system equipment, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series OPC UA Server Connection (GOT-A-0137)
For Technical News, contact your local distributor.

MELIPC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

CNC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 No interface for direct connection is provided.
Use the USB port of the RCPU in a multiple CPU system.

*3 Use an Ethernet connector or RJ71EN71.
*4 CNC C70 cannot be used as a relay station for another network connection.
*5 No interface for direct connection is provided.

Use the serial port of the QCPU in a multiple CPU system.
*6 No interface for direct connection is provided.

Use the USB port of the QCPU in a multiple CPU system.
*7 Use a CPU having a serial number stating with 09042 or later in the first 5 digits.
*8 Use an NC system with the software version D0 or later.
*9 Monitor the controller as a Q4ACPU.
*10 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No. 1.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS 

/TCP
MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Via 
servo 
amplifier

Direct M S H 10 Direct

MELIPC MI5122-VW × × × ○ ○ × × × × × ○ ○

Controller Connection type Clock 
functionCPU direct C24 Ether 

*1
MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
CNC C80 R16NCCPU-S1 × ○ *2 × ○ *3 × × × × × × ○ *10

CNC C70 Q173NCCPU *4 ○ *5 ○ *6 ○ ○ ○ ○ ○ *7 ○ ○ *10

MELDAS C6/C64 FCA C6 *8*9 ○ × × ○ × × × × ×

FCA C64 *8*9
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Robot controller
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 No interface for direct connection is provided.
Use the serial port of the QCPU in a multiple CPU system.

*3 The Ethernet connection is available only by using an Ethernet module (QJ71E71) or the Ethernet port built in the QnUDECPU.
*4 The Display I/F cannot be used.
*5 Use a CPU having a serial number stating with 09042 or later in the first 5 digits.
*6 This connection type can be used only in a multiple CPU configuration.
*7 Monitor the controller as a Q03UDCPU.
*8 No interface for direct connection is provided.

Use the USB port of the RCPU in a multiple CPU system.
*9 No interface for direct connection is provided.

Use the USB port of the QCPU in a multiple CPU system.
*10 For the multiple CPU system, the time setting function or the time notification function is performed to CPU No. 1.
*11 The time setting function or the time notification function is performed to CPU No. 1.
*12 For CR800-Q (Q172DSRCPU), the Ethernet connection is available via one of the following.

Ethernet port built in the robot controller (PERIPHERAL I/F)
Ethernet module (QJ71E71)
Ethernet port built in the QnUD(E/V)CPU

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
Robot controller CR800-R(R16RTCPU) × ○ *8 × ○ × × × × × × ○ *10

CR800-D × × × × × × × × × ○ *11

CRnQ-700 ○ *2 ○ *9 ○ ○ *3*4*12 × × ○ ○ ○ *5 ○ *6 ○ *10

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

CRnD-700 *7 × × × ○ × × × × × × ○ *11

CR750-D *7

CR751-D *7
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Inverter
Supported by GT SoftGOT2000 (Multiple channels) only.
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC 

IE 
Cont

CC IE 
Field

RS-232 USB Via PLC Direct M S H 10 Direct
FR-E700 series FR-E7□0-NE × × × ○ ○ × × × × × × ×

FR-A800 series FR-A8□0 × × × ○ × × × × × × × ×

FR-A8□2

FR-A8□6

FR-A8□0-E × × × ○ ○ × × × × × × ×

FR-A8□2-E

FR-A8□6-E

FR-A8□0-GF × × × ○ × × × × × × × ×

FR-A8□2-GF

FR-A8□0-GN × × × ○ ○ × × × × × × ×

FR-A8□2-GN

FR-A800 Plus 
series

FR-A8□0-CRN × × × ○ × × × × × × × ×

FR-A8□2-CRN

FR-A8□0-R2R

FR-A8□2-R2R

FR-A8□0-LC

FR-A8□0-E-CRN × × × ○ ○ × × × × × × ×

FR-A8□2-E-CRN

FR-A8□0-E-R2R

FR-A8□2-E-R2R

FR-A8□0-E-AWH

FR-A8□0-E-LC

FR-F800 series FR-F8□0 × × × ○ × × × × × × × ×

FR-F8□2

FR-F8□6

FR-F8□0-E × × × ○ ○ × × × × × × ×

FR-F8□2-E

FR-E800 series FR-E8□0 × × × ○ × × × × × × × ×

FR-E8□0-E × × × ○ ○ × × × × × × ×
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.3  Controller that can be Monitored and the Accessible Range 129



13
Servo amplifier
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 Access a servo amplifier through a Motion controller in the multiple CPU system or a Simple Motion module.
*2 A servo amplifier cannot be monitored through the Simple Motion module FX5-40SSC-S or FX5-80SSC-S.
*3 Access a servo amplifier through a Simple Motion module or a CC-Link IE Field Network master/local module.
*4 Supported by GT SoftGOT2000 (Multiple channels) only.
*5 Access a servo amplifier through a Motion module.
*6 Supported by GT SoftGOT2000 (Multiple channels) only when accessed through a CC-Link IE Field Network master/local module.
*7 Access a servo amplifier through a CC-Link IE TSN-equipped module.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /

TCP
MNET CC IE 

Cont
CC IE Field

RS-232 USB Via 
PLC

Direct M S H 10 Via 
PLC

Direct

MELSERVO-J4 
series

MR-J4-□B*1 × ○ *2 ○ *2 ○ × × × × × ○ *2 ○ *2 × ×

MR-J4-□B-RJ*1

MR-J4W2-□B*1

MR-J4W3-□B*1

MR-J4-GF(-RJ)*3*6 × × × ○ × × × × × × ○*2 × ×

MELSERVO-J5 
series *4

MR-J5-□G*5*7 × × × ○ ○ × × × × × × × ×

MR-J5-□G-RJ*5*7

MR-J5W2-□G*5*7

MR-J5W3-□G*5*7

MR-J5D1-□G4*5*7

MR-J5D2-□G4*5*7

MR-J5D3-□G4*5*7

MR-J5-□B*1 ×

MR-J5-□B-RJ*1

MR-J5W2-□B*1

MR-J5W3-□B*1

MELSERVO-JE 
series *1

MR-JE-□B
MR-JE-□BF

× ○ *2 ○ *2 ○ × × × × × ○ *2 ○ *2 × ×

MELSERVO-JET 
series*4*5*7

MR-JET-□G × × × ○ ○ × × × × × × × ×
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Other PLC
■OMRON PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 CQM1-CPU1 cannot be connected because it has no RS-232 interface.
*3 The Ethernet network redundancy is not supported.
*4 Only CJ2M-CPU1 □ can be connected by the direct CPU connection (RS-232).
*5 E-type CP1E cannot be connected.
*6 The CPU module upgraded to version V1 can be connected.

The following shows model names of the CPU modules with the upgraded version.
Model: CVM1-CPU01-V1
Model: CVM1-CPU11-V1
Model: CV500-CPU01-V1
Model: CV1000-CPU01-V1
Model: CV2000-CPU01-V1

*7 Only models supporting the direct CPU connection (RS-232) can be connected.
*8 Only available to GT SoftGOT2000 (Multiple channels).

Controller Connection type Clock 
functionCPU direct C24 Ether 

*1
MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
SYSMAC CPM CPM2A ○ × × × × × × × × × ○

SYSMAC α C200HX ○ × × × × × × × × × ○

C200HG

C200HE

SYSMAC CQM1 CQM1 ○ *2 × × × × × × × × × ○

SYSMAC CQM1H CQM1H ○ × × × × × × × × × ○

SYSMAC CS1 CS1H ○ × × ○ × × × × × × ○

CS1G

CS1D ○ *3

SYSMAC CJ1 CJ1H ○ × × ○ × × × × × × ○

CJ1G

CJ1M

SYSMAC CJ2 CJ2H(-EIP) ○ × × ○ × × × × × × ○

CJ2M ○ *4

SYSMAC CP1 CP1E ○ *5 × × × × × × × × × ○

SYSMAC CP2 CP2E-E ○ × × × × × × × × × ○

CP2E-S

CP2E-N × × × ○ × × × × × × ○

SYSMAC CVM1/CV CV500 *6 ○ *7 × × × × × × × × × ○

CV1000 *6

CV2000 *6

CVM1 *6

NJ NJ101*8 × × × ○ × × × × × × ○

NJ301*8

NJ501*8

NX NX1P2*8

NX701*8

NX102*8
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■KEYENCE PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

■TOSHIBA PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be connected through the Ethernet port.
To communicate with the CPU, configure the Ethernet setting, including the IP address.
The setting method is the same as when the CPU is connected through an Ethernet module.

*2 Use a CPU with firmware version V01.90 or later.
Use nV-Tool V4.14.5 or later.

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
KEYENCE PLC KV-700 × × × ○ × × × × × × ○

KV-1000

KV-3000

KV-5000

KV-5500

KV-7300

KV-7500

KV-8000

Controller Connection type Clock 
functionCPU direct C24 Ether 

*1
MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
Unified Controller 
nv series

Controller type1 PU811 × × × ○ × × × × × × ○

Controller type1 
light *2

PUM11

PUM12

PUM14
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■HITACHI IES PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

■YASKAWA PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
EHV series EHV-CPU08 × × × ○ × × × × × × ○

EHV-CPU16

EHV-CPU32

EHV-CPU64

EHV-CPU128

MICRO-EHV series MVH-A40□□□

MVH-D40□□□

MVH-A64□□□

MVH-D64□□□

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
YASKAWA PLC GL120 ○ × × × × × × × × × ○

GL130

GL60S × ○ ×

GL60H

GL70H

CP-9200SH

CP-9300MS ○ × ×

MP-920 ○ ○

MP-930 × ×

MP-940

MP2200 × ○ ○

MP2300

MP2300S

MP3200 ×

MP3300

PROGIC-8 ○ ×

CP-9200(H)

CP-312 ×

CP-317 ○ ○
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■YASKAWA robot controller
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The high speed Ethernet server function (option) of the YRC1000 or YRC1000micro is required.
*2 The YRC1000 and YRC1000micro have the clock function but cannot acquire clock information from the GOT.

■YOKOGAWA PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
YASKAWA robot 
controller

YRC1000 × × × ○*1 × × × × × × ×*2

YRC1000micro

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
FA-M3 F3SP05 × × × ○ × × × × × × ○

F3SP08

F3FP36

F3SP21

F3SP25

F3SP35

F3SP28

F3SP38

F3SP53

F3SP58

F3SP59

F3SP66

F3SP67

FA-M3V F3SP71-4N

F3SP71-4S

F3SP76-7S

STARDOM NFCP100 × ○ ×

NFJT100
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■LS Industrial Systems PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

■ALLEN-BRADLEY PLC
Only available to GT SoftGOT2000 (Multiple channels).
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
XGT series XGK-CPUU × × × ○ × × × × × × ○

XGK-CPUH

XGK-CPUA

XGK-CPUS

XGK-CPUE

XGK-CPUUN

XGK-CPUHN

XGK-CPUSN

Controller Connection type Clock 
functionCPU direct C24 Ether*1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
ControlLogix 
series

1756-L × × × ○ × × × × × × ×

1756-L1M1

1756-L1M2

1756-L1M3

1756-L55M12

1756-L55M13

1756-L55M14

1756-L55M16

1756-L55M22

1756-L55M23

1756-L55M24

1756-L61

1756-L62

1756-L63

1756-L72S

1756-L71

1756-L72

1756-L73

1756-L74

1756-L75

1756-L81E

1756-L82E

1756-L83E

1756-L84E

1756-L85E
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*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

■SIEMENS PLC
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

*2 Only SIEMENS OP (Ethernet connection) is supported.

Microcomputer
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 The built-in Ethernet port CPU can be communicated through the Ethernet port.
In that case, the Ethernet setting, including the IP address setting, is required, like Ethernet module connection.

CompactLogix 
series

1769-L32E × × × ○ × × × × × × ×

1769-L35E

FlexLogix series 1794-L33

1794-L34

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
SIEMENS PLC SIMATIC S7-200 × × × ○ *2 × × × × × × ×

SIMATIC S7-200 
SMART

○

SIMATIC S7-300 ○

SIMATIC S7-400

SIMATIC S7-1200 ○ *2 ×

SIMATIC S7-1500

Controller Connection type Clock 
functionCPU direct C24 Ether *1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
Host ○ × × ○ × × × × × × ○

Controller Connection type Clock 
functionCPU direct C24 Ether*1 MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
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MODBUS/TCP equipment
For the explanation of the table, refer to the following.
Page 116 Controllers that can be monitored by connection type
○: Applicable, ×: Inapplicable

*1 For connectable MODBUS/TCP and system equipment, refer to the following Technical News.
 List of Valid Devices Applicable for GOT2000 Series MODBUS Connection for Overseas (GOT-A-0170)
For Technical News, contact your local distributor.

SLMP-compatible device
For the connectable SLMP-compatible devices and system devices, refer to the following Technical News.
List of SLMP-compatible Equipment Validated to Operate with the GOT2000 Series (GOT-A-0085)
For Technical News, contact your local distributor.

Barcode reader
For connectable barcode readers and system equipment, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
For Technical News, contact your local distributor.

RFID controller
For connectable RFID controllers and system equipment, refer to the following Technical bulletin.
List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
For Technical News, contact your local distributor.

Controller Connection type Clock 
functionCPU direct C24 Ether MODBUS /TCP MNET CC IE 

Cont
CC IE 
Field

RS-232 USB Direct M S H 10 Direct
MODBUS/TCP equipment *1 × × × × ○ ○ × × × × ○
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Access range
This section explains networks accessible by GT SoftGOT2000 (Single channel).

Networks accessible by GT SoftGOT2000 (Multiple channels)
GT SoftGOT2000 (Multiple channels) can access the networks that are accessible by the GOT2000 series 
(hardware).
For the networks accessible by the GOT2000 series (hardware), refer to the following.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

Page 139 Ethernet connection
Page 145 Direct CPU connection (RS-232, USB), serial communication connection
Page 152 Bus connection
Page 153 MELSECNET/H connection, MELSECNET/10 connection
Page 156 CC-Link IE Controller Network connection
Page 159 CC-Link IE Field Network connection
The following shows the correspondence of an illustration and a table in this section.

R : RCPU

Communication module 
to connect to relay network 1

Communication module 
to connect to relay network 2

L : LCPU
Q(Q) : QCPU(Q mode)
QS : QSCPU

C6 : MELDAS C6*
QnA : QnACPU
A : ACPU
FX5 : FX5CPU

Q(A) : QCPU(A mode)

MNET/10 (H) : MELSECNET/10 or MELSECNET/H connection
MNET (II) : MELSECNET (II) connection
Ethernet : Ethernet connection
CC IE Cont : CC-Link IE Controller Network connection
CC IE Field : CC-Link IE Field Network connection

MI5 : MI5000 series

LH : LHCPU
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Ethernet connection
When GT SoftGOT2000 is connected to a station by Ethernet, the range accessible by GT SoftGOT2000 via the station is 
shown below.

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, configure the routing parameter setting.
For the routing parameter setting, refer to the following.
Page 229 Ethernet Connection
 • When monitoring the devices of other stations on the same network
If the GOT monitors the devices, such as D and M, of other stations on the same network, the GOT takes a 
long time to display data.
In such a case, monitor the device assigned to the link relay (B) or link register (W) of the network parameter.

■Connecting with RCPU
For the correspondence of the illustration and the table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

Connected 
station

Relay station

RCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX
5 *7

MI
5

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX
5 *7

MI
5

○ Ethernet ○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE Cont 
*3

○ × × ○ ○ × × × × ×

CC IE Field ○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Cont

○ × × ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE Cont 
*3

○ × × ○ ○ × × × × ×

CC IE Field ○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Field

○ × ○ ○ ○ × × × ○ 
*5*6

× MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE Cont 
*3

○ × × ○ ○ × × × × ×

CC IE Field ○ × ○ ○ *4 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection
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*1 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*2 This network is inaccessible through an RCPU or LCPU in relay station No. 1.
*3 This network is inaccessible through an LCPU in relay station No. 1.
*4 Only Universal model QCPU is applicable.
*5 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE Field Network.
*6 This CPU is applicable only when it is connected through the built-in Ethernet port of the RCPU.

This CPU is not applicable when it is connected through the Ethernet port of the RJ71EN71.
*7 The routing parameter cannot be set for an FX5CPU, and therefore the networks on which the CPU is not located are inaccessible.

■Connecting with LHCPU
Only the connected station can be accessed.

■Connecting with QCPU or Q series Motion CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only the PLC CPU area (CPU No.1) is applicable for Q170MCPU and Q170MSCPU.
*2 CNC C70 on other networks cannot be monitored.
*3 AnNCPU cannot be monitored.

Connected 
station

Relay station

QCPU *1, 
QSCPU

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R LH L Q
(Q) 
*2

QS Q
(A)

Qn
A

A FX
5

MI
5

R LH L Q
(Q) 
*2

QS Q
(A)

Qn
A

A FX
5

MI
5

○ MNET/
10(H)

× × × ○ ○ ○ ○ ○ 
*3

× × MNET/
10(H)

× × × ○ ○ ○ ○ ○ 
*3

× ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

○ Ethernet × × ○ ○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ 
*3

× ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

○ CC IE 
Cont

× × × ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

○ CC IE 
Field

× × ○ ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection
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■Connecting with LCPU
This connection is available only when routing parameters can be set on the PLC side.
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

Connected 
station

Relay station

LCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R LH L Q
(Q)

QS Q
(A)

Qn
A

A FX
5

MI
5

R LH L Q
(Q)

QS Q
(A)

Q
nA

A FX
5

MI
5

○ Ethernet × × ○ ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

○ CC IE 
Field

× × ○ ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection
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■Connecting with QnACPU or MELDAS C6/C64
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 CNC C70 on other networks cannot be monitored.

■Connecting with FX5CPU
For the correspondence of the illustration and the table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE Field Network.

Connected 
station

Relay station

QnACPU, 
MELDAS 
C6*

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R LH L Q
(Q)

QS Q
(A)

Qn
A 
*1

A FX
5

MI
5

R LH L Q
(Q)

QS Q
(A)

Qn
A 
*1

A FX
5

MI
5

○ MNET/
10(H)

× × × × × × ○ × × × MNET/
10(H)

× × × × × × ○ × × ×

Ethernet × × × × × × ○ × × ×

○ Ethernet × × × × × × ○ × × × MNET/
10(H)

× × × × × × ○ × × ×

Ethernet × × × × × × ○ × × ×

Connected 
station

Relay station

FX5CPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI5 R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5 

MI5

○ CC IE 
Field

× × × × × × × × ○ *1 × CC IE 
Field

× × × × × × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection
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■Connecting with FX5-ENET or FX5-ENET/IP
Only the connected station can be accessed.

■Connecting with ACPU
Only the connected station can be accessed.

■Connecting with FXCPU
The stations set in [Connected Ethernet Controller Setting] of GT Designer3 can be accessed.

■Connecting with a MELIPC
Only the connected station can be accessed.

■Connecting with the robot controller (CR800-D, CRnD-700, CR750-D, CR751-D)
Only the connected station can be accessed.

■Connecting with the robot controller (CR800-Q)
For the connection through the Ethernet port built in CR800-Q (Q172DSRCPU), only the connected station can be accessed.
To establish connection in other configurations, access the controller through a CPU in the multiple CPU system as shown 
below.

■Connecting with a servo amplifier
A servo amplifier is accessible through one of the following connected stations.
Motion CPU in the multiple CPU system
Simple motion module
CC-Link IE Field Network Master/Local Module
For the details of the system configuration, refer to the following.
Page 362 Servo amplifier connection (via Motion controller or Simple Motion module)
Page 365 Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)

Controller Relay CPU
Robot controller CR800-Q Q172DSRCPU QnUDECPU, QnUDVCPU, QnUDEHCPU
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■Connecting with the CC-Link IE Field Network Ethernet adapter module
Only the other stations on the CC-Link IE Field network via a CC-Link IE Field Network Ethernet adapter module can be 
accessed.
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

 • Host in the Ethernet connection
Although the MELSECNET/H, MELSECNET/10, and CC-Link connections use the GOT as the host station, 
the Ethernet connection uses the station (Ethernet module) specified in [Connected Ethernet Controller 
Setting] of GT Designer3 as the host station.
 • Precautions for using the redundant system
For the following connection types, do not set an RCPU or QCPU redundant system as a relay station.
Doing so causes GT SoftGOT2000 not to switch the monitoring target automatically when system switching 
occurs.
A timeout error occurs due to failed monitoring.
MELSECNET/10, MELSECNET/H connection
CC-Link IE Controller Network connection
CC-Link IE Field Network connection
 • When system switching occurs due to a cable disconnection
For the MELSECNET/H, MELSECNET/10, or CC-Link connection, the GOT is handled as the host station.
When system switching occurs due to a cable disconnection, GT SoftGOT2000 can monitor the control 
system through the tracking cable, but cannot monitor the controllers on a different network through the 
redundant system.

■Various settings
For [Connected Ethernet Controller Setting] in GT Designer3, refer to the following.
Page 229 Ethernet Connection

Connected 
station

Relay station

NZ2GF-
ETB

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI5 R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI5

× CC IE 
Field

× × ○ ○ ○ × × × × × CC IE 
Field

× × ○ ○ ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Ethernet connection
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Direct CPU connection (RS-232, USB), serial communication connection
When GT SoftGOT2000 is connected to a station by the direct CPU connection (RS-232, USB) or the serial communication 
connection, the range of relay stations accessible by GT SoftGOT2000 via the connected station is shown below.

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, setting of routing parameters is required.
For the setting of the routing parameters, refer to the reference manual of the network connected.
 • Monitoring the devices of other stations on the network
Monitoring devices, such as D and M, of a station on another network slows the display processing.
When monitoring devices of other stations, monitor the devices that are assigned to the link relay (B) or link 
register (W) with the network parameter.

■Connecting with RCPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*2 This network is inaccessible through an RCPU or LCPU in relay station No. 1.
*3 This network is inaccessible through an LCPU in relay station No. 1.
*4 Only Universal model QCPU is applicable.
*5 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE Field Network.

Connected 
station

Relay station

RCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5  
*6

MI
5

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5 
*6

MI
5

○ Ethernet ○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 × × × × ×

○ CC IE 
Cont

○ × × ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Field

○ × ○ ○ ○ × × × × *5 × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (USB), 
serial communication connection
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*6 The routing parameter cannot be set for an FX5CPU, and therefore the networks on which the CPU is not located are inaccessible.

■Connecting with LHCPU
Only the connected station can be accessed.

■Connecting with QCPU or Q series Motion CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 When QSCPU is connected by USB, access to other stations or other PLCs is unavailable.
*3 Depending on the CPU type, the access range is different.

Refer to the following table.
○: Accessible, ×: Not accessible, : Accessible when the connected station is a control station

Connected 
station

Relay station

QCPU, 
QSCPU

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

Qn
A

A 
*3

FX5 MI
5

R L
H

L Q
(Q)

QS Q
(A)

Qn
A

A 
*3

FX5 MI
5

○ *2 MNET/
10(H)

× × × ○ ○ ○ ○ ○ × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

○ *2 Ethernet × × ○ ○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

○ *2 CC IE 
Cont

× × × ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

○ *2 CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

Connected station Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU
QCPU ○ × ○

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (RS-232, USB), 
serial communication connection
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■Connecting with LCPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 This network is accessible only through a QCPU in relay station No. 1.

Connected 
station

Relay station

LCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI5 R L
H

L Q
(Q)

QS Q
(A)

QnA A FX5 MI5

○ Ethernet × × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *2

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

○ CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *2

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 × × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (RS-232, USB), 
serial communication connection
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.3  Controller that can be Monitored and the Accessible Range 147



14
■Connecting with QnACPU or MELDAS C6/C64
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only the link relay device or link register device assigned to the network parameter can be monitored.
Depending on the type of the connected station, the access range is different.
For a master station, its local stations can be monitored.
For a local station, only its master station can be monitored.
For the master station on the third hierarchy, the master station on the second hierarchy and the local stations on the third hierarchy can 
be monitored.
For the details of the data link system, refer to the following.
Page 167 Access range in the data link system (MELSECNET/B, (II))

*2 MELDAS C6* is inaccessible.

Connected 
station

Relay station

QnACPU, 
MELDAS 
C6*

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

QnA, 
C6

A FX
5

MI
5

R L
H

L Q
(Q)

QS Q
(A)

QnA, 
C6

A FX5 MI
5

○ MNET/10 × × × × × × ○ × × × MNET/10 × × × × × × ○ × × ×

MNET(II) × × × × × × × × × ×

Ethernet × × × × × × ○ × × ×

○ MNET(II) 
*1

× × × × × × ○ *2 ○ × × MNET/10 × × × × × × × × × ×

MNET(II) × × × × × × × × × ×

Ethernet × × × × × × × × × ×

○ Ethernet × × × × × × ○ × × × MNET/10 × × × × × × ○ × × ×

MNET(II) × × × × × × × × × ×

Ethernet × × × × × × ○ × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (RS-232), 
serial communication connection
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■Connecting with ACPU or QCPU (A mode)
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Depending on the CPU type, the access range is different.
Refer to the following table.
○: Accessible, ×: Not accessible, : Accessible when the connected station is a control station, : Accessible when the monitored CPU 
is in a control station

*2 Only the link relay device or link register device assigned to the link parameter can be monitored.
Depending on the type of the connected station, the access range is different.
For a master station, its local stations can be monitored.
For a local station, only its master station can be monitored.
For the master station on the third hierarchy, the master station on the second hierarchy and the local stations on the third hierarchy can 
be monitored.
For the details of the data link system, refer to the following.
Page 167 Access range in the data link system (MELSECNET/B, (II))

Connected 
station

Relay station

ACPU, 
QCPU
(A mode)

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

Q
nA

A FX5 MI5 R L
H

L Q
(Q)

QS Q
(A)

Q
nA

A FX5 MI5

○ MNET/10 *1 × × × × × ○ × ○ × × MNET/
10(H)

× × × × × ○ × ○ × ×

MNET(II) × × × × × × × × × ×

○ MNET(II) *2 × × × × × ○ ○ ○ × × MNET/
10(H)

× × × × × × × × × ×

MNET(II) × × × × × × × × × ×

Connected station Relay network 1 Relay network 2

AnA(AnN)CPU AnUCPU AnA(AnN)CPU AnUCPU
AnA(AnN)CPU × × ×

AnUCPU ○ × ○

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (RS-232), 
serial communication connection
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■Connecting with FX5CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range
The FX5CPU is accessible by the direct CPU connection (RS-232, USB) only.

○: Accessible, ×: Not accessible

*1 Use an intelligent function module (FX5-CCLIEF) as an intelligent device station to connect to the CC-Link IE Field Network.

■Connecting with FXCPU
Only the connected CPU can be accessed.

■Connecting with a CNC (CNC C80, CNC C70) or robot controller (CRnQ-700, CR750-Q, CR751-
Q, CR800-Q)

Access the controller through a CPU in the multiple CPU system as shown below.

■Connecting with a servo amplifier
A servo amplifier is accessible through one of the following connected stations.
Motion CPU in the multiple CPU system
Simple motion module
CC-Link IE Field Network Master/Local Module
For the details of the system configuration, refer to the following.
Page 362 Servo amplifier connection (via Motion controller or Simple Motion module)
Page 365 Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)

Connected 
station

Relay station

FX5CPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI
5

R L
H

L Q
(Q)

QS Q
(A)

QnA A FX
5

MI5

○ CC IE 
Field

× × × × × × × × ○ *1 × CC IE 
Field

× × × × × × × × × ×

Controller Relay CPU
CNC C80 R16NCCPU-S1 RCPU

CNC C70 Q173NCCPU QnUCPU

Robot controller CRnQ-700 Q172DRCPU

CR750-Q

CR751-Q

CR800-Q Q172DSRCPU QnUDECPU, QnUDVCPU, QnUDEHCPU

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

Direct CPU connection (RS-232, USB)
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■Connecting with remote I/O stations in the MELSECNET/H network system
When connected to the remote I/O station of the MELSECNET/H network system, the GT SoftGOT2000 can monitor the PLC 
CPU of the master station.
When connecting the GT SoftGOT2000 to the remote I/O station, use the following connection methods.

Connection to remote I/O station of MELSECNET/B, (II) or /10
The GT SoftGOT2000 cannot be connected to the remote I/O station on the MELSECNET/B, (II) data link 
system and MELSECNET/10 network system.
Connect the GT SoftGOT2000 to the remote I/O station on the MELSECNET/H network system.

 • Network modules in a remote I/O station
The network units (QJ72LP25-25, QJ72LP25G, QP72BR15) of the remote I/O station are handled as PLC CPU.
Connect the GT SoftGOT2000 to the RS-232 interface of the network unit.
For the details of the cable and others required for connection with the network module, refer to the following.
Page 301 Connection cable
 • Display of objects
Specify a type including MELSEC-Q (including multiple), or MELSEC-QnU for the controller type on GT Designer3.
Then, specify [[NW No.] (Network No. of the remote I/O network) to 1, and specify [Station No.] (Master station) to 0.] as the 
monitoring target in the network setting of the device setting dialog.
The GT SoftGOT2000 monitors stations on the MELSECNET/H network with the transient transmission.
Therefore, a longer time-lag occurs for displaying objects compared with directly monitoring the PLC CPU.
For displaying objects with a shorter time-lag, execute the cyclic transmission so that the GT SoftGOT2000 can monitor link 
devices B and W of the host station set in the MELSECNET/H network.
For the settings required for the PLC CPU, refer to the following.
Q corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)

GT SoftGOT2000 Q
J71E71-100

Q
J72LP25-25

Q
J71C

24N

Q33B

Q
J71LP21-25

Q33BPow
er supply

m
odule

Pow
er supply

m
odule

Direct CPU 
connection (RS-232)

Network No.1
Station No.1
(remote I/O station)

Network No.1
Station No.0
(master station) 

MELSECNET/H remort I/O Network

Em
pty

Em
pty

Em
pty

PLC
 C

PU

Monitor 
target
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■Connecting with a head module in the CC-Link IE Field Network
When connected to the head module of the CC-Link IE Field Network, the GT SoftGOT2000 can monitor the PLC CPU of the 
master station and local stations.
When connecting the GT SoftGOT2000 to the head module, use the following connection methods.

 • Head module
GT SoftGOT2000 monitors a head module (RJ72GF15-T2 or LJ72GF15-T2) as a PLC CPU.
For cables required for connection with the head module and other details, refer to the following.
Page 301 Connection cable
 • Display of objects
Specify a type including MELSEC-QnU for the controller type on GT Designer3. Then, specify [NW No.] (Network No. of the 
CC-Link IE Field Network) to 1, and specify [Station No.] (Master station) to 0.] as the monitoring target in the network setting 
of the device setting dialog.
The GT SoftGOT2000 monitors stations on the CC-Link IE Field Network with the transient transmission.
Therefore, a longer time-lag occurs for displaying objects compared with directly monitoring the PLC CPU.
For displaying objects with a shorter time-lag, execute the cyclic transmission so that the GT SoftGOT2000 can monitor link 
devices B and W of the host station set in the CC-Link IE Field Network.
For the settings required for the PLC CPU, refer to the following.
MELSEC-L CC-Link IE Field Network Head Module User's Manual

Bus connection
When the multiple CPU system is created, the PC CPU module can access the other CPUs on the same main base unit.
The PC CPU module cannot access CPUs on the other main base units.

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, configure the routing parameter setting.
For the routing parameter setting, refer to the reference manual of the network connected.
 • Monitoring the devices of other stations on the network
Monitoring devices, such as D and M, of a station on another network slows the display processing.
When monitoring devices of other stations, monitor the devices that are assigned to the link relay (B) or link 
register (W) with the network parameter.

GT SoftGOT2000 Q
J71G

F11-T2

LJ72G
F15-T2

LJ71C
24

LX40C
6

LY10R
2

Q33B

Em
pty

Em
pty

CC-Link IE Field Network

Pow
er supply

m
odule

Pow
er supply

m
odule

PLC
 C

PU

Network No. 1, 
Station No. 1

Network No. 1, 
Station No. 0

Monitor 
target

Direct CPU 
connection (USB)

power 
supply

1:CPU No.1
2:CPU No.2
3:CPU No.3

PC CPU module
(GT SoftGOT2000)

Q series CPU
(Q Mode)

1 2 3
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MELSECNET/H connection, MELSECNET/10 connection
When GT SoftGOT2000 is connected to a station in the MELSECNET/H or MELSECNET/10 network, the range accessible by 
GT SoftGOT2000 via the station is shown below.
The GT SoftGOT2000 is regarded as a normal station and monitors the control station and all normal stations on the network.
If the monitoring target is a PLC CPU within a multiple CPU system, CPU No. 1 to CPU No. 4 can be monitored.
When monitoring devices of other stations, monitoring of all devices is possible in the PLC CPU to be accessed.
Page 166 When using MELSECNET/10 connection

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, configure the routing parameter setting.
For the routing parameter setting, refer to the following.
MELSECNET/H Interface Board User's Manual
Q Corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)
 • Monitoring the devices of other stations on the network
Monitoring devices, such as D and M, of a station on another network slows the display processing.
When monitoring devices of other stations, monitor the devices that are assigned to the link relay (B) or link 
register (W) with the network parameter.
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■Connecting with QCPU or Q series Motion CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 Only the PLC CPU area (CPU No.1) is applicable for Q170MCPU and Q170MSCPU.
*3 The routing parameter cannot be set for a QSCPU, and therefore the GOT cannot access the networks on which the CPU is not located.
*4 MELDAS C6* is not applicable.
*5 CNC C70 on other networks cannot be monitored.
*6 This network is accessible only through a QCPU in relay station No. 1.

Connected 
station

Relay station

QCPU *2, 
QSCPU *3

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q) 
*5

QS 
*3

Q
(A)

QnA, 
C6

A FX
5

MI
5

R L
H

L Q
(Q) 
*5

QS 
*3

Q
(A)

QnA, 
C6

A FX
5

MI
5

○ MNET/
10(H)

× × × ○ ○ ○ ○ *4 ○ × × MNET/
10(H)

× × × ○ ○ ○ ○ *4 ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *6

× × × ○ ○ × × × × ×

CC IE 
Field *6

× × ○ ○ *1 ○ × × × × ×

○ Ethernet × × ○ ○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ *4 ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *6

× × × ○ ○ × × × × ×

CC IE 
Field *6

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Cont

× × × ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *6

× × × ○ ○ × × × × ×

CC IE 
Field *6

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H)

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *6

× × × ○ ○ × × × × ×

CC IE 
Field *6

× × ○ ○ *1 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

MELSECNET/H connection, 
MELSECNET/10 connection
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■Connecting with QnACPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 MELDAS C6* is not applicable.
*2 The routing parameter cannot be set for a QSCPU, and therefore the GOT cannot access the networks on which the CPU is not located.
*3 CNC C70 on other networks cannot be monitored.
*4 This network is accessible only through a QCPU in relay station No. 1.
*5 Only Universal model QCPU is applicable.

Connected 
station

Relay station

QnACPU 
*1

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*2

Q
(A)

QnA, 
C6 *3

A FX
5

MI
5

R L
H

L Q
(Q)

QS 
*2

Q
(A)

QnA, 
C6 *3

A FX
5

MI
5

○ MNET/10 × × × ○ ○ ○ ○ *1 ○ × × MNET/
10(H)

× × × ○ ○ ○ ○ *1 ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *4

× × × ○ ○ × × × × ×

CC IE 
Field *4

× × ○ ○ *5 ○ × × × × ×

○ Ethernet × × ○ ○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ *1 ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *4

× × × ○ ○ × × × × ×

CC IE 
Field *4

× × ○ ○ *5 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

MELSECNET/H connection, 
MELSECNET/10 connection
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■Connecting with ACPU or QCPU (A mode)
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 The routing parameter cannot be set for a QSCPU, and therefore the GOT cannot access the networks on which the CPU is not located.
*2 This network is accessible only through a QCPU in relay station No. 1.
*3 Only Universal model QCPU is applicable.

■Connecting with the robot controller (CR800-Q)
Access the controller through a CPU in the multiple CPU system as shown below.

CC-Link IE Controller Network connection
The following shows the access range via the connected station in a configuration in which GT SoftGOT2000 and a station 
are connected by CC-Link IE Controller Network.
The GT SoftGOT2000 is regarded as a normal station and monitors the control station and all normal stations on the network.
If the monitoring target is a PLC CPU within a multiple CPU system, CPU No. 1 to CPU No. 4 can be monitored.
When monitoring devices of other stations, monitoring of all devices is possible in the PLC CPU to be accessed.
Page 166 When using MELSECNET/10 connection

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, setting of routing parameters is required.
For the routing parameter setting, refer to the following.
CC-Link IE Controller Network Interface Board User's Manual
MELSEC-Q CC-Link IE Controller Network Reference Manual
 • Monitoring the devices of other stations on the network
Monitoring devices, such as D and M, of a station on another network slows the display processing.
When monitoring devices of other stations, monitor the devices that are assigned to the link relay (B) or link 
register (W) with the network parameter.

Connected 
station

Relay station

ACPU, 
QCPU
(A mode)

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5 MI5 R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5 MI5

○ MNET/10 × × × ○ ○ ○ × ○ × × MNET/10 × × × ○ ○ ○ × ○ × ×

CC IE 
Cont

× × × ○ *2 ○ *2 × × × × ×

CC IE 
Field

× × ○ 
*2

○ 
*2*3

○ *2 × × × × ×

Controller Relay CPU
Robot controller CR800-Q Q172DSRCPU QnUDECPU, QnUDVCPU, QnUDEHCPU

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

MELSECNET/H connection, 
MELSECNET/10 connection
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■Connecting with RCPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*2 This network is inaccessible through an RCPU or LCPU in relay station No. 1.
*3 This network is inaccessible through an LCPU in relay station No. 1.
*4 Only Universal model QCPU is applicable.

Connected 
station

Relay station

RCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*1

Q
(A)

QnA
, C6

A FX
5

MI
5

R L
H

L Q
(Q)

QS 
*1

Q
(A)

QnA
, C6

A FX
5

MI
5

○ Ethernet ○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Cont

○ × × ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Field

○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
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network 1

CPU of 
relay 

station No. 1

Module for 
relay 
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Module for 
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CC-Link IE Controller 
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■Connecting with QCPU or Q series Motion CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*3 LCPU is accessible only when QJ71E71-100, QJ71E71-B2, or QJ71E71-B5 is used.

(Built-in Ethernet port QCPU is inapplicable.)
*4 CNC C70 on other networks cannot be monitored.
*5 This network is accessible only through a QCPU in relay station No. 1.

Connected 
station

Relay station

QCPU, 
QSCPU *2

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q) 
*4

QS 
*2

Q
(A)

QnA
, C6

A FX
5

MI
5

R L
H

L Q
(Q) 
*4

QS 
*2

Q
(A)

QnA
, C6

A FX
5

MI
5

○ MNET/
10(H)

× × × ○ ○ ○ ○ ○ × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field *5

× × ○ ○ *1 ○ × × × × ×

○ Ethernet × × ○ 
*3

○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Cont

× × × ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field *5

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×
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CPU of a 
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Module for 
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network 1

CPU of 
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station No. 1

Module for 
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Module for 
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network 2

CPU of 
relay 

station No. 2

CC-Link IE Controller 
Network connection
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■Connecting with a servo amplifier
A servo amplifier is accessible through one of the following connected stations.
Motion CPU in the multiple CPU system
Simple motion module
CC-Link IE Field Network Master/Local Module
For the details of the system configuration, refer to the following.
Page 362 Servo amplifier connection (via Motion controller or Simple Motion module)
Page 365 Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)

■Connecting with the robot controller (CR800-Q)
Access the controller through a CPU in the multiple CPU system as shown below.

CC-Link IE Field Network connection
When GT SoftGOT2000 is connected to a station in the CC-Link IE Filed Network, the range accessible by GT SoftGOT2000 
via the station is shown below.
The GT SoftGOT2000 is regarded as a normal station and monitors the control station and all normal stations on the network.
If the monitoring target is a PLC CPU within a multiple CPU system, CPU No. 1 to CPU No. 4 can be monitored.
When monitoring devices of other stations, monitoring of all devices is possible in the PLC CPU to be accessed.
Page 166 When using MELSECNET/10 connection

 • When monitoring other networks (Routing parameter setting)
To monitor other networks, setting of routing parameters is required.
For the setting of the routing parameters, refer to the reference manual of the network connected.
MELSEC-L CC-Link IE Field Network Master/Local Module User's Manual
 • Monitoring the devices of other stations on the network
Monitoring devices, such as D and M, of a station on another network slows the display processing.
When monitoring devices of other stations, monitor the devices that are assigned to the link relay (B) or link 
register (W) with the network parameter.

Controller Relay CPU
Robot controller CR800-Q Q172DSRCPU QnUDECPU, QnUDVCPU, QnUDEHCPU
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■Connecting with RCPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible  ×: Not accessible

*1 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*2 This network is inaccessible through an RCPU or LCPU in relay station No. 1.
*3 This network is inaccessible through an LCPU in relay station No. 1.
*4 This network is inaccessible only when the CPU of relay station No. 1 is an LCPU.

Connected 
station

Relay station

RCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5 MI5 R L
H

L Q
(Q)

QS 
*1

Q
(A)

Qn
A

A FX5 MI5

○ Ethernet ○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Cont

○ × × ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

○ CC IE 
Field

○ × ○ ○ ○ × × × × × MNET/
10(H) *2

× × × ○ ○ × × × × ×

Ethernet ○ × ○ ○ ○ × × × × ×

CC IE 
Cont *3

○ × × ○ ○ × × × × ×

CC IE 
Field

○ × ○ ○ *4 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

CC-Link IE Field 
Network connection
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■Connecting with QCPU or Q series Motion CPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 Only the PLC CPU area (CPU No.1) is applicable for Q170MCPU and Q170MSCPU.
*3 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*4 CNC C70 on other networks cannot be monitored.
*5 This network is accessible only through a QCPU in relay station No. 1.

Connected 
station

Relay station

QCPU *1*2, 
QSCPU *3

Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q) 
*4

QS 
*3

Q
(A)

Qn
A

A FX
5

MI
5

R L
H

L Q
(Q) 
*4

QS 
*3

Q
(A)

Qn
A

A FX
5

MI
5

○ MNET/
10(H)

× × × ○ ○ ○ ○ ○ × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field *5

× × ○ ○ *1 ○ × × × × ×

○ Ethernet × × ○ ○ ○ × ○ × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Cont

× × × ○ ○ × × × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H)

× × × ○ ○ ○ ○ ○ × ×

Ethernet × × ○ ○ ○ × ○ × × ×

CC IE 
Cont *5

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

CC-Link IE Field 
Network connection
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■Connecting with LCPU
For how to refer to the illustration and table, refer to the following.
Page 138 Access range

○: Accessible, ×: Not accessible

*1 Only Universal model QCPU is applicable.
*2 GT SoftGOT2000 cannot access other networks because the routing parameter cannot be set for QSCPU.
*3 This network is accessible only through a QCPU in relay station No. 1.

 • Precautions for using the redundant system
For the following connection types, do not set an RCPU or QCPU redundant system as a relay station.
Doing so causes GT SoftGOT2000 not to switch the monitoring target automatically when system switching 
occurs.
A timeout error occurs due to failed monitoring.
MELSECNET/10, MELSECNET/H connection
CC-Link IE Controller Network connection
CC-Link IE Field Network connection
 • When system switching occurs due to a cable disconnection
When system switching occurs due to a cable disconnection, GT SoftGOT2000 can monitor the control 
system through the tracking cable, but cannot monitor the controllers on a different network through the 
redundant system.

Connected 
station

Relay station

LCPU Relay 
network 
1

CPU of relay station No. 1 Relay 
network 
2

CPU of relay station No. 2

R L
H

L Q
(Q)

QS 
*2

Q
(A)

QnA, 
C6

A FX
5

MI
5

R L
H

L Q
(Q)

QS 
*2

Q
(A)

QnA, 
C6

A FX
5

MI
5

○ Ethernet × × ○ ○ ○ × × × × × MNET/
10(H) *3

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *3

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

○ CC IE 
Field

× × ○ ○ *1 ○ × × × × × MNET/
10(H) *3

× × × ○ ○ × × × × ×

Ethernet × × ○ ○ ○ × × × × ×

CC IE 
Cont *3

× × × ○ ○ × × × × ×

CC IE 
Field

× × ○ ○ *1 ○ × × × × ×

GT SoftGOT2000

CPU of a 
connected 

station

Module for 
relay 

network 1

CPU of 
relay 

station No. 1

Module for 
relay 

network 1

Module for 
relay 

network 2

Relay network 1 Relay network 2

Module for 
relay 

network 2

CPU of 
relay 

station No. 2

CC-Link IE Field 
Network connection
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■Connecting with a MELIPC
Only the connected station can be accessed.

■Connecting with a servo amplifier
A servo amplifier is accessible through one of the following connected stations.
Motion CPU in the multiple CPU system
Simple motion module
CC-Link IE Field Network Master/Local Module
For the details of the system configuration, refer to the following.
Page 362 Servo amplifier connection (via Motion controller or Simple Motion module)
Page 365 Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)

■Connecting with the robot controller (CR800-Q)
Access the controller through a CPU in the multiple CPU system as shown below.

Controller Relay CPU
Robot controller CR800-Q Q172DSRCPU QnUDECPU, QnUDVCPU, QnUDEHCPU
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System setting examples
The following shows an example of the monitor accessible range of other stations and setting method of monitor devices.

When using the direct CPU connection (RS-232, USB) or serial communication 
connection (without the data link system)

■Monitor accessible range of devices (other than B or W) of other stations or other networks
Specify the accessing network No. or station as shown in the following table.
To monitor the connected station (host station), and devices B and W assigned to network parameters, specify the host 
station.
To monitor another station (Devices other than B and W) or another network, specify the target station (Network No. and 
station No.).

Monitoring link device B or W
To monitor devices B and W assigned to network parameters, specify the host station even though these 
devices have been assigned to other stations.
Otherwise, the display speed will be reduced.

Station connected to 
GT SoftGOT2000

Station to be accessed

Network No.1 Network No.2

AnU (1-1) Q (Q mode) (1-2) AnA (1-3) AnU (1-4) QnA (2-1) AnU (2-2) AnN (2-3) AnU (2-4)
AnU (1-1) ○ × ○ ○ × ○ × ×

Host ─ Other (1-3) Other (1-4) ─ Other (2-2) ─ ─

Q (Q mode) (1-2) ○ ○ × ○ ○ ○ × ○

Other (1-1) Host ─ Other (1-4) Other (2-1) Other (2-2) ─ Other (2-4)

AnA (1-3) ○ × ○ × × × × ×

Other (0-0) ─ Host ─ ─ ─ ─ ─

AnU (1-4) ○ × × ○ × ○ × ×

(2-2) Other (1-1) ─ ─ Host ─ Host ─ ─

QnA (2-1) × × × × ○ × × ×

─ ─ ─ ─ Host ─ ─ ─

AnN (2-3) × × × × × × ○ ×

─ ─ ─ ─ ─ ─ Host ─

AnU (2-4) × × × × × ○ × ○

─ ─ ─ ─ ─ Other (2-2) ─ Host

How to
read the 
table

Upper line: Accessibility
○: Accessible
×: Not accessible
Lower line: Network settings
Host
Other (Network No. - Station number)

Control station Control station

Network No.1 Network No.2

AnU
(1-1)

Q(Q mode)
(1-2)

AnA
(1-3)

AnN
(2-3)

AnU
(2-4)

QnA
(2-1)

AnU
(1-4)
(2-2)
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When using the direct CPU connection (RS-232, USB) or serial communication 
connection (with the data link system)

■Monitor accessible range of devices (other than B or W) of other stations or other networks
Specify the accessing network No. or station as shown in the following table.
To monitor B or W of the connected station (Host station) assigned with a network parameter, specify the host station.
To monitor another station (Devices other than B or W) or another network, specify the station (network No. and station No.).

*1 When monitoring the data link system, set the network No. to 0.

Station connected 
to GT 
SoftGOT2000

Station to be accessed

Network No.1 Network No.2 Data link system

QnA (1-1) AnA (1-2) QnA (1-3) AnU (2-1) QnA (2-2) AnU (2-3) AnU (2-4) QnA (M) QnA 
(L1)

AnA 
(L2)

Q (Q mode) (1-1) ○ ○ ○ ○ ○ ○ ○ ○ × ×

Host Other (1-2) Other (1-3) Other (2-1) Other (2-2) Other (2-3) Other (2-4) Other (1-3)
or
Other (2-2)

─ ─

AnA (1-2) × ○ × × × × × × × ×

─ Host ─ ─ ─ ─ ─ ─ ─ ─

QnA (1-3) ○ × ○ ○ ○ ○ ○ ○ × ○

(2-2) Other (1-1) ─ Host Other (2-1) Host Other (2-3) Other (2-4) Host ─ Other 
(0-2) *1(M)

AnU (2-1) × × × ○ × ○ ○ × × ×

─ ─ ─ Host ─ Other (2-3) Other (2-4) ─ ─ ─

AnU (2-3) × × × ○ × ○ ○ × × ×

─ ─ ─ Other (2-1) ─ Host Other (2-4) ─ ─ ─

AnU (2-4) × × × ○ × ○ ○ × × ×

─ ─ ─ Other (2-1) ─ Other (2-3) Host ─ ─ ─

QnA (L1) × × × × × × × × ○ ×

─ ─ ─ ─ ─ ─ ─ ─ Host ─

AnA (L2) × × × × × × × × × ○

─ ─ ─ ─ ─ ─ ─ ─ ─ Host

How to
read the 
table

Upper line: Accessibility
○: Accessible
×: Not accessible
Lower line: Network settings
Host
Other (Network No. - Station number)

Control station

AnU
(2-4)QnA

(1-3)
(2-2)
(M)

Network No.2

AnU
(2-1)

Network No.1

AnA
(1-2)

QnA
(L1)

AnA
(L2)

Data link
system

Control station

Q(Q mode)
(1-1)

AnU
(2-3)
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Monitoring link device B or W
To monitor devices B and W assigned to network parameters, specify the host station even though these 
devices have been assigned to other stations.
Otherwise, the GOT takes a long time to display data.

When using MELSECNET/10 connection

■Monitor access range for other station devices (other than B and W)
○: Accessible, ×: Not accessible

■Designating network No. and station number for setting monitor device
 • Monitoring devices B and W that are allocated in the network parameter
NW No.: 1, Station number: Host
For monitoring devices B and W that are allocated by the link parameter, use the local device number if designating devices 
allocated to another station.
Otherwise, the display speed will be reduced.
 • Monitoring other stations (Devices other than B and W)

Station connected to GT 
SoftGOT2000

Station to be accessed

Network No.1 Network No.2

QnA
(1-1)

Q (Q mode)
(1-2)

GT SoftGOT2000
(1-3)

AnU
(1-4)

Q (Q mode)
(2-1)

QnA
(2-2)

AnN
(2-3)

AnU
(2-4)

GT SoftGOT2000 (1-3) ○ ○ ― ○ ○ ○ × ○

Station connected
to GT SoftGOT2000

Station to be accessed

QnA
(1-1)

Q (Q mode)
(1-2)

GT SoftGOT2000
(1-3)

AnU
(1-4)

SoftGOT2000 (1-3) 1, Other (1) 1, Other (2) ― 1, Other (4)

How to read the table 1, Other (2)
↑ ↑
NW No. Station number

GT Soft
GOT2000

(1-3)

QnA
(1-1)

AnU
(1-4)
(2-4)

Q (Q mode) Network No. 1 Network No. 2
(1-2)

Q (Q mode)
(2-1)

QnA
(2-2)

AnN
(2-3)
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.3  Controller that can be Monitored and the Accessible Range



3

Access range in the data link system (MELSECNET/B, (II))

Direct CPU connection (RS-232), serial communication connection
■When connecting to the master station

Local stations can be monitored.
However, when a QnACPU is used as the PLC CPU of the local station, the devices other than B and W assigned to the 
network parameters cannot be monitored.

■When connecting to a local station

The master station can be monitored.
However, when a QnACPU is used as the PLC CPU of the master station, the devices other than B and W assigned to the link 
parameters cannot be monitored.
Other local stations cannot be monitored.

■When connecting to the master station on the third hierarchy

The master station on the second hierarchy and local stations on the third hierarchy can be monitored.
However, when a QnACPU is used as the PLC CPU of the master station, the devices other than B and W assigned to the 
network parameters cannot be monitored.
Local stations on the second hierarchy cannot be monitored.

■When connecting to ACPU or QnACPU
Only other stations with the same PLC CPU type of the connected station can be monitored.

Monitoring devices of other stations
If the GOT monitors the devices of other stations on the data link system, the GOT takes a considerably long time to display 
data.
Monitor link relay (B) and link register (W) assigned to the network parameters.

L3

M

L1

L2

GT SoftGOT2000

GT SoftGOT2000

L1

L2

M

L3

GT SoftGOT2000
L3

M

L1

L2
m

2

1 3
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Setting method of monitor device
The following example describes the method of setting the network No. and the station numbers when setting monitor devices 
.

■Monitoring the connected station (Host station) and devices B and W assigned to the network 
parameters

Specify the host station.
To monitor devices B and W assigned to network parameters, specify the host station even though these devices have been 
assigned to other stations.
Otherwise, the display speed will be reduced.

■Monitoring devices of other stations
Network No.: 0, Station number: Refer to the following table.
Setting of the station No.

Station connected
to GT SoftGOT2000

Station to be accessed

M L1 L2
m

L3 ℓ1 ℓ2 ℓ3

M Host Other 1 Other 2 Other 3 ― ― ―

L1 Other 0 Host ― ― ― ― ―

L2
m

Other 0 ― Host ― Other 1 Other 2 Other 3

L3 Other 0 ― ― Host ― ― ―

ℓ1 ― ― Other 0 ― Host ― ―

ℓ2 ― ― Other 0 ― ― Host ―

ℓ3 ― ― Other 0 ― ― ― Host

GT SoftGOT2000

L3

M

L1

L2
m

2

1 3
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3.4 How to Monitor the Redundant System (RCPU)
You can monitor a redundant system on GT SoftGOT2000 by specifying the control system and the standby system.
When system switching occurs in the redundant system, the standby system takes over the control to continue the system 
operation.
GT SoftGOT2000 switches the monitoring target automatically upon system switching.
To achieve this behavior, configure the relevant settings on GT Designer3.
Page 221 MELSEC redundant setting

When an error occurs in System A, System B switches from standby system to control system.
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Module configuration when a SIL2 process CPU is used
To configure a redundant system using a SIL process CPU, mount a SIL2 function module (R6PSFM) and a 
redundant function module (R6RFM) next to the SIL2 process CPU on the base unit.
Make sure to mount a SIL2 process CPU, SIL2 function module, and redundant function module on the base 
unit in that order.

The following lists the connection types available for the redundant system (RCPU).

For details of PLC CPUs that can be monitored in each connection method of GT SoftGOT2000, refer to the following.
Page 116 Controllers that can be monitored by connection type
For the configuration of the redundant system (RnPCPU), refer to the following.
MELSEC iQ-R Module Configuration Manual

Connection type Connection destination Reference
Direct CPU connection (USB) Built-in USB port RCPU Page 171 Monitoring using the direct CPU 

connection (USB) (Built-in USB port RCPU)

CC-Link IE Field Network head module Page 175 Monitoring using the direct CPU 
connection (USB) (Remote head module)

Ethernet connection Built-in Ethernet port RCPU Page 181 Built-in Ethernet port RCPU

Ethernet module Page 183 Ethernet module

Ethernet module in a remote I/O station on the 
CC-Link IE Field Network

Page 191 Accessing the Ethernet module

Ethernet module mounted on the redundant 
extension base unit

Page 199 Accessing the Ethernet module

CC-Link IE Controller Network connection CC-Link IE Controller Network module Page 187 Monitoring using the CC-Link IE Field 
Network connection

CC-Link IE Field Network connection CC-Link IE Field Network module Page 185 Monitoring using the CC-Link IE 
Controller Network connection

Serial communication connection Serial communication module Page 197 Monitoring using the serial 
communication connection

Serial communication module in a remote I/O 
station on the CC-Link IE Field Network

Page 193 Accessing the serial communication 
module

Serial communication module mounted on the 
redundant extension base unit

Page 200 Accessing the serial communication 
module

R
16P

S
FC

P
U

R6PSFM

R6RFM

P
ow

er supply
m

odule

E
m

pty

E
m

pty
0 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.4  How to Monitor the Redundant System (RCPU)



3

Monitoring using the direct CPU connection (USB) (Built-in USB 
port RCPU)
This section explains how to monitor a redundant system by connecting GT SoftGOT2000 and a PLC with a USB cable.

Redundant system (host station)
■System configuration example
The following shows a configuration example of monitoring the redundant system (host station).

■Connection method
Connect the USB port of an RCPU and the personal computer (GT SoftGOT2000) directly with a USB cable.
For the details of the connection method, refer to the following.
Page 299 Direct CPU connection (RS-232, USB)

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 79 [USB]

Setting item Settings
Communication Setup Connection [USB]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Select [Follow the redundant system via a serial interface.].
Setting a pair of PLCs to be monitored is unnecessary.
According to the above system configuration example, configure the setting as shown below.
• [Follow the redundant system via a serial interface.]: Selected

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify a PLC (host station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Host]
• [Control System/Standby System]: [Control System]
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Redundant system (another station)
■System configuration example
The following shows a configuration example of monitoring the redundant system (another station).

■Connection method
Connect the USB port of a PLC (connected station) and the personal computer (GT SoftGOT2000) directly with a USB cable.
For the details of the connection method, refer to the following.
Page 299 Direct CPU connection (RS-232, USB)

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 79 [USB]

Setting item Settings
Communication Setup Connection [USB]

Type [MELSEC iQ-R]

Personal computer
(GT SoftGOT2000)

Control
system

(System A)

Standby
system

(System B)

R
16C

P
U

E
m

pty

E
m

pty

E
m

pty

P
ow

er supply
m

odule

R
J71G

P
21-S

X

R
16P

C
P

U

R
6R

FM

E
m

pty

E
m

pty

P
ow

er supply
m

odule

R
J71G

P
21-S

X

R
16P

C
P

U

R
6R

FM

E
m

pty

E
m

pty

P
ow

er supply
m

odule

R
J71G

P
21-S

X
CC-Link IE Controller Network

USB cable

Tracking cable

Redundant function 
module

Redundant function 
module

Monitoring target
   Network No. 1
   Station No. 1

Connected station
   Network No. 1
   Station No. 3

Network No. 1
Station No. 2
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.4  How to Monitor the Redundant System (RCPU) 173



17
■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 1 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 2 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 1
• [Control System/Standby System]: [Control System]
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Monitoring using the direct CPU connection (USB) (Remote head 
module)
This section explains how to monitor a redundant system on the CC-Link IE Field Network by connecting GT SoftGOT2000 
and a CC-Link IE Field Network head module with a USB cable.
In this section, the CC-Link IE Field Network head module is abbreviated as the remote head module.

Redundant system (master station)
■System configuration example
The following shows a configuration example of monitoring the redundant system (master station).

■Connection method
Connect the remote head module in a remote I/O station and the personal computer (GT SoftGOT2000) directly with a USB 
cable.
For the details of the connection method, refer to the following.
Page 299 Direct CPU connection (RS-232, USB)

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 79 [USB]

Setting item Settings
Communication Setup Connection [USB]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 1 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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Redundant system comprising two remote head modules
■System configuration example
The following shows a configuration example of monitoring the redundant system comprising two remote head modules.

■Connection method
Connect the remote head module in a remote I/O station and the personal computer (GT SoftGOT2000) directly with a USB 
cable.
For the details of the connection method, refer to the following.
Page 299 Direct CPU connection (RS-232, USB)

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 79 [USB]

Setting item Settings
Communication Setup Connection [USB]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 1 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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Redundant system using two network lines
■System configuration example
The following shows a configuration example of monitoring the redundant system using two network lines.

■Connection method
Connect the remote head module in a remote I/O station and the personal computer (GT SoftGOT2000) directly with a USB 
cable.
For the details of the connection method, refer to the following.
Page 299 Direct CPU connection (RS-232, USB)

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 79 [USB]

Setting item Settings
Communication Setup Connection [USB]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 0 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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Monitoring using the Ethernet connection
This section explains how to monitor a redundant system on the Ethernet network.

Built-in Ethernet port RCPU
The following explains how to monitor a redundant system by accessing the built-in Ethernet port RCPU in the redundant 
system.

■System configuration example
The following shows a configuration example of monitoring multiple redundant systems from one GT SoftGOT2000 module.

■Connection method
Connect the personal computer (GT SoftGOT2000) to the Ethernet network on which the target redundant systems reside.
For the details of the connection method, refer to the following.
Page 229 Ethernet Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 83 [Ethernet]

Setting item Settings
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the standby system (system B), select [Not Use] for [Use of Control System IP Address] in the redundant setting.
If [Use] is selected, the GOT cannot switch the monitoring target automatically when system switching occurs.
For the setting method, refer to the following.
GX Works3 Operating Manual

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

Connected Ethernet 
Controller Setting

Specify the PLCs (control system and standby system) in the redundant system.
To also monitor controllers other than the redundant system, specify the controllers as well.
According to the above system configuration example, configure the setting as shown below.

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 1 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 2 for [Station No.]
• Pair No. 2 (upper row): 1 for [Net No.], 3 for [Station No.]
• Pair No. 2 (lower row): 1 for [Net No.], 4 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Host station Specify a PLC that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Host]
• [Control System/Standby System]: [Control System]

Other stations Specify a PLC that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 1 to 3
• [Control System/Standby System]: [Control System]
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Ethernet module
The following explains how to monitor a redundant system by accessing the Ethernet module in the redundant system.

■System configuration example
The following shows a configuration example of monitoring multiple redundant systems from one GT SoftGOT2000 module.

■Connection method
Connect the personal computer (GT SoftGOT2000) to the Ethernet network on which the target redundant systems reside.
For the details of the connection method, refer to the following.
Page 229 Ethernet Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 83 [Ethernet]

Setting item Settings
Communication Setup Connection [Ethernet]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the standby system (system B), select [Not Use] for [Use of Control System IP Address] in the redundant setting.
If [Use] is selected, the GOT cannot switch the monitoring target automatically when system switching occurs.
For the setting method, refer to the following.
GX Works3 Operating Manual

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

Connected Ethernet 
Controller Setting

Specify the PLCs (control system and standby system) in the redundant system.
To also monitor controllers other than the redundant system, specify the controllers as well.
According to the above system configuration example, configure the setting as shown below.

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 1 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 2 for [Station No.]
• Pair No. 2 (upper row): 1 for [Net No.], 3 for [Station No.]
• Pair No. 2 (lower row): 1 for [Net No.], 4 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Host station Specify a PLC that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Host]
• [Control System/Standby System]: [Control System]

Other stations Specify a PLC that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 1 to 3
• [Control System/Standby System]: [Control System]
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3.4  How to Monitor the Redundant System (RCPU)



3

Monitoring using the CC-Link IE Controller Network connection
This section explains how to monitor a redundant system on the CC-Link IE Controller Network.

System configuration example
The following shows a configuration example of monitoring multiple redundant systems from one GT SoftGOT2000 module.

Connection method
Connect GT SoftGOT2000 to the CC-Link IE Controller Network by using the CC-Link IE Controller Network interface board.
For the details of the connection method, refer to the following.
Page 322 CC-Link IE Controller Network Connection
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Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 82 [CC IE Control] or [CC IE Field]

Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Communication Setup Connection [CC IE Control]

Type CC-Link IE Controller Network interface board
([1st module] to [4th module])

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 1 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 2 for [Station No.]
• Pair No. 2 (upper row): 1 for [Net No.], 3 for [Station No.]
• Pair No. 2 (lower row): 1 for [Net No.], 4 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 1 or 3
• [Control System/Standby System]: [Control System]
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Monitoring using the CC-Link IE Field Network connection
This section explains how to monitor a redundant system on the CC-Link IE Field Network.
The system configuration varies with the connection of the CC-Link IE Field Network.
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Star connection
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System configuration example
The following shows a configuration example of monitoring multiple redundant systems on the line-connected CC-Link IE 
Field Network from one GT SoftGOT2000 module.
Monitoring the redundant system on the ring-connected or star-connected network is also available.
The settings on GT SoftGOT2000 and GT Designer3 are the same as those for monitoring the redundant system on the line-
connected network.

Connection method
Connect GT SoftGOT2000 to the CC-Link IE Field Network by using the CC-Link IE Field Network interface board.
For the details of the connection method, refer to the following.
Page 322 CC-Link IE Controller Network Connection
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Setting on GT SoftGOT2000
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
Page 82 [CC IE Control] or [CC IE Field]

Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Communication Setup Connection [CC IE Field]

Type CC-Link IE Field Network interface board
([1st module] to [4th module])

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 1 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 2 for [Station No.]
• Pair No. 2 (upper row): 1 for [Net No.], 3 for [Station No.]
• Pair No. 2 (lower row): 1 for [Net No.], 4 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 1 or 3
• [Control System/Standby System]: [Control System]
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Monitoring through a remote I/O station on the CC-Link IE Field 
Network
This section explains how to monitor a redundant system through a remote I/O station on the CC-Link IE Field Network.
GT SoftGOT2000 accesses the Ethernet module or serial communication module in the remote I/O station.

Accessing the Ethernet module
■System configuration example
The following shows a configuration example of monitoring the redundant system through the Ethernet module in a remote I/
O station.

■Connection method
Connect the Ethernet module in a remote I/O station and the personal computer (GT SoftGOT2000) by the Ethernet 
connection.
For the details of the connection method, refer to the following.
Page 229 Ethernet Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 83 [Ethernet]
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■Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

Connected Ethernet 
Controller Setting

Set an Ethernet module as the relay station.
According to the above system configuration example, configure the setting as shown below.

Routing Information To monitor a PLC on another network, set the routing information.
According to the above system configuration example, configure the setting as shown below.
• [Transfer Net No.]: 1
• [Relay Net No.]: 2
• [Relay Station No.]: 1

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 1 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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Accessing the serial communication module
The following shows how to monitor a redundant system through the serial communication module in a remote I/O station.

■System configuration example
The following shows a configuration example of monitoring the redundant system (master station).

The following shows a configuration example of monitoring the redundant system comprising two remote head modules.
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The following shows a configuration example of monitoring the redundant system using two network lines.

■Connection method
Connect the serial communication module in a remote I/O station and the personal computer (GT SoftGOT2000) with an RS-
232 cable.
For the details of the connection method, refer to the following.
Page 308 Serial Communication Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 80 [C24]

Setting item Settings
Communication Setup Connection [C24]
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■Setting on GT Designer3
 • Redundant system (master station) or redundant system comprising two remote head modules
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 1 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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 • Redundant system using two network lines
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 0 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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3.4  How to Monitor the Redundant System (RCPU)



3

Monitoring using the serial communication connection
This section explains how to monitor a redundant system (another station) by using the serial communication connection.

System configuration example
The following shows a configuration example of monitoring the redundant system (another station) through a serial 
communication module.

Connection method
Connect the serial communication module and the personal computer (GT SoftGOT2000) with an RS-232 cable.
For the details of the connection method, refer to the following.
Page 308 Serial Communication Connection

Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 80 [C24]

Setting item Settings
Communication Setup Connection [C24]
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Setting on GT Designer3
Configure the settings as shown below.

*1 Monitoring devices of the standby system is also available.
To monitor devices of the standby system, select [Standby System] for [Control System/Standby System].

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Setting on the PLC side (GX Works3)
The setting of the redundant system must be configured on GX Works3.
For the setting method, refer to the following.
GX Works3 Operating Manual

Setting item Settings
Controller Setting Controller Type [MELSEC iQ-R, RnMT/NC/RT, CR800-D]

MELSEC Redundant Set a pair of PLCs to be monitored.
According to the above system configuration example, configure the setting as shown below.
• Pair No. 1 (upper row): 1 for [Net No.], 0 for [Station No.]
• Pair No. 1 (lower row): 1 for [Net No.], 1 for [Station No.]

For the setting method, refer to the following.
Page 221 MELSEC redundant setting

Device setting
(Network setting)

Specify the PLC (another station) that performs control in the redundant system. *1

According to the above system configuration example, configure the setting as shown below.
• [CPU No.]: 1
• [Host] or [Other]: [Other]
• [Network No.]: 1
• [Station No.]: 0
• [Control System/Standby System]: [Control System]
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Monitoring through a module on the redundant extension base 
unit
The following shows how to monitor a redundant CPU system through the Ethernet module or the serial communication 
module mounted on the redundant extension base unit.
Page 199 Accessing the Ethernet module
Page 200 Accessing the serial communication module

Accessing the Ethernet module
■System configuration example
The following shows a configuration example of monitoring the redundant CPU system through the Ethernet module mounted 
on the redundant extension base unit.

■Connection method
Connect the Ethernet module mounted on the redundant extension base unit to the personal computer (GT SoftGOT2000) 
with the Ethernet connection.
For the details of the connection method, refer to the following.
Page 229 Ethernet Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 83 [Ethernet]

■GT Designer3 and PLC (GX Works3) settings
No redundant setting is required.
Connect the devices to an Ethernet module.
For the setting method, refer to the following.
Page 229 Ethernet Connection

Setting item Settings
Communication Setup Connection [Ethernet]

Type [MITSUBISHI ELECTRIC]

2)1) 2)1)

3)

4)

1) Process CPU
2) Redundant function module
3) Tracking cable
4) Extension cable
5) Ethernet module
6) Extension base unit for the redundant system

6)

5)

N/W No.: 1
PC No.: 18
IP address: 192.168.3.18
Port No.: 5001

N/W No.: 1
PC No.: 1
IP address: 192.168.3.3
Port No.: 5001

Control system 
(system A)
Connected to IN1

Standby system 
(system B)
Connected to IN2

IN1

IN2

Ethernet

Personal computer
(GT SoftGOT2000)
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Accessing the serial communication module
■System configuration example
The following shows a configuration example of monitoring the redundant CPU system through the serial communication 
module mounted on the redundant extension base unit.

■Connection method
Connect the Ethernet module mounted on the redundant extension base unit to the personal computer (GT SoftGOT2000) 
with the RS-232 cable.
For the details of the connection method, refer to the following.
Page 308 Serial Communication Connection

■Setting on GT SoftGOT2000
Configure the settings as shown below.

For the setting method, refer to the following.
Page 80 [C24]

■GT Designer3 and PLC (GX Works3) settings
No redundant setting is required.
Connect the devices to a serial communication module.
For the setting method, refer to the following.
Page 308 Serial Communication Connection

Setting item Settings
Communication Setup Connection [C24]

Type [RJ71C24]

2)1) 2)1)

3)

4)

1) Process CPU
2) Redundant function module
3) Tracking cable
4) Extension cable
5) Serial communication module
6) Extension base unit for the redundant system

5)

6)

Control system 
(system A)
Connected to IN1

Standby system 
(system B)
Connected to IN2

RS232

IN1

IN2

Personal computer
(GT SoftGOT2000)
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Precautions

Precautions for system switching
System switching may cause the communication route from GT SoftGOT2000 to the redundant system to be changed as 
shown below.

■System switching by a user-created sequence program
GT SoftGOT2000 does not change the communication route to monitor the control system after system switching.
No system alarm occurs.

■System switching due to cable disconnection or other accidental causes
GT SoftGOT2000 changes the communication route to monitor the control system after system switching.
A system alarm occurs. (Error code 450, "Path has changed or timeout occurred in redundant system.")

Precautions for the configuration and operation mode of a redundant system
In the following cases, a redundant system cannot be monitored normally, and a system alarm occurs. (Error code 451, 
"MELSEC redundant system settings and current config. do not match.")
The MELSEC redundant setting is inconsistent with the actual redundant system configuration.
The redundant system does not operate in the backup mode.

Precautions for changing the MELSEC redundant setting
When you change the MELSEC redundant setting, make sure to restart GT SoftGOT2000.
Otherwise, the new MELSEC redundant setting is not reflected to GT SoftGOT2000.

Precautions for monitoring controllers other than a redundant system when the 
MELSEC redundant setting is configured
Even if controllers other than a redundant system are set as a pair in the MELSEC redundant setting, GT SoftGOT2000 is 
started without errors and operates normally.
However, if an error (such as power-off or communication timeout) occurs in the station that is specified in the MELSEC 
redundant setting, GT SoftGOT2000 may not behave according to the setting.
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Precautions for monitoring a redundant system without configuring the MELSEC 
redundant setting
Without the MELSEC redundant setting, GT SoftGOT2000 does not switch the monitoring target automatically when system 
switching occurs in the redundant system.
Even if GT SoftGOT2000 writes data to a device of the standby system after system switching, the written data is not reflected 
to the device because the standby system synchronizes to the control system.
As GT SoftGOT2000 has written data to the device of the standby system successfully, a specific system alarm does not 
occur. (Error code 315, "Device writing error. Correct device.")

Using a script to switch the monitoring target at system switching
When monitoring the redundant system (RCPU), do not use a script to switch the monitoring target at system switching.
Doing so causes GT SoftGOT2000 to monitor the control system after system switching incorrectly.

Personal computer
(GT SoftGOT2000)

Control
system

(System A)

Standby
system

(System B)

Personal computer
(GT SoftGOT2000)

Control
system

(System B)

Standby
system

(System A)

Writing a value to the device
D100 ← 100

Device value
D100 = 50

System switching

Synchronization between the systems causes the 
device of the standby system (system A) to be overwritten.
D100 ← 50

The monitoring target 
is not switched.
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3.5 How to Monitor the Redundant System (QCPU)
You can monitor a redundant system on GT SoftGOT2000 by specifying the control system and the standby system.
When system switching occurs in the redundant system, the standby system takes over the control to continue the system 
operation.
GT SoftGOT2000 switches the monitoring target automatically upon system switching.
To achieve this behavior, configure the relevant settings on GT Designer3.
Page 221 MELSEC redundant setting

Monitor target

MELSECNET/H remote I/O network

Station No. 0
(Multiplexed remote master station)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Station No. 1
(Multiplexed remote sub master station)

Standby
system

(System B)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Station No. 2 
(remote I/O station)

Tracking cable

Q
J72LP25-25

Q
J71C

24N

The GT SoftGOT2000 
monitors the control 
system PLC CPU.

When an error occurs in System A, System B switches from standby system to control system.

Monitor target

MELSECNET/H remote I/O network

Direct CPU 
connection 
(RS-232) 

Station No. 0
(Multiplexed remote master station)

Standby
system 

(System A)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Station No. 1
(Multiplexed remote sub master station)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Station No. 2 
(remote I/O station)

Tracking cable

Q
J72LP25-25

Q
J71C

24N

The GT SoftGOT2000 
monitors the PLC CPU 
of the new control system 
after system switching.

Em
pty

Em
pty

Pow
er supply

m
odule

Pow
er supply

m
odule

Em
pty

Em
pty

Pow
er supply

m
odule

Pow
er supply

m
odule

Em
pty

Em
pty

Pow
er supply

m
odule

Em
pty

Em
pty

Pow
er supply

m
odule

Control
system

(System A)

Control
system

(System B)

GT Soft
GOT2000

GT Soft
GOT2000

Direct CPU 
connection 
(RS-232) 
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The following lists the connection types available for the redundant system (QCPU).

For details of PLC CPUs that can be monitored in each connection method of GT SoftGOT2000, refer to the following.
Page 116 Controllers that can be monitored by connection type

Connection type Reference
Connection to remote I/O station in MELSECNET/H 
network system

Page 208 Connection to remote I/O station in MELSECNET/H network system

Direct CPU connection (RS-232, USB) Page 209 Direct CPU connection (RS-232, USB)

MELSECNET/H connection, MELSECNET/10 connection 
(Network system)

Page 216 MELSECNET/H and MELSECNET/10 connections (network systems)

CC-Link IE Controller Network connection (Network 
system)

Page 217 CC-Link IE Controller Network connection (network system)

Ethernet connection Page 218 Ethernet connection

Connection to 
the redundant 
type extension 
base unit

Serial communication connection 
(Serial communication module 
mounted on the redundant type 
extension base unit)

Page 219 Serial communication connection (Serial communication module mounted on the 
redundant type extension base unit)

Ethernet connection (Ethernet 
module mounted on the redundant 
type extension base unit)

Page 220 Ethernet connection (Ethernet module mounted on the redundant type extension 
base unit)
4 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.5  How to Monitor the Redundant System (QCPU)



3

The following table shows the features of each connection method.

Connection type Before system switching After system switching
• Direct CPU connection 

(RS-232)
(Remote I/O station of 
MELSECNET/H network 
system)

The monitoring target is automatically changed to the control 
system PLC CPU.

• Direct CPU connection 
(RS-232, USB)

The MELSEC redundant setting enables GT SoftGOT2000 to 
monitor the control system after system switching 
automatically. *1

Monitor the PLC CPU of the control system by GT 
SoftGOT2000 1).

Monitor the PLC CPU of the control system by GT 
SoftGOT2000 2).

GT Soft
GOT2000

Control system

Multiplexed remote
master station

MELSECNET/H remote I/O network

Standby system

Multiplexed remote
sub master station

Remote 
I/O station

GT Soft
GOT2000

Standby system

MELSECNET/H remote I/O network

Remote 
I/O station

Multiplexed remote
master station

Multiplexed remote
sub master station

Control system

GT Soft
GOT2000

Control system

MELSECNET/H remote I/O network

Standby system

Remote 
I/O station

Multiplexed remote
master station

Multiplexed remote
sub-master station

GT Soft
GOT2000

Multiplexed remote
master station

MELSECNET/H remote I/O network

Standby system

Remote 
I/O station

Multiplexed remote
sub-master station

Control system

GT Soft
GOT2000 

1)

GT Soft
GOT2000 

2)

Control system

MELSECNET/H remote I/O network

Standby system

Remote 
I/O station

Multiplexed remote
master station

Multiplexed remote
sub-master station

GT Soft
GOT2000 

1)

GT Soft
GOT2000 

2)

MELSECNET/H remote I/O network

Remote 
I/O station

Control systemStandby system

Multiplexed remote
master station

Multiplexed remote
sub-master station
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*1 To monitor the control system after system switching without the MELSEC redundant setting, disconnect the cable from the PLC that 
goes on standby, and then connect the cable to the PLC that takes over the control.

*2 To monitor the control system after system switching without the MELSEC redundant setting, refer to the following.
Page 223 Switch the monitor target to the control system using the script function

• MELSECNET/H 
connection, MELSECNET/ 
10 connection (Network 
system)

The MELSEC redundant setting enables GT SoftGOT2000 to 
monitor the control system after system switching 
automatically. *2

• CC-Link IE Controller 
Network connection 
(Network system)

The MELSEC redundant setting enables GT SoftGOT2000 to 
monitor the control system after system switching 
automatically. *2

• Ethernet connection

The MELSEC redundant setting enables GT SoftGOT2000 to 
monitor the control system after system switching 
automatically. *2

• Serial communication 
connection

(Serial communication 
module mounted on the 
redundant type extension 
base unit)
• Ethernet connection

(Ethernet module mounted 
on the redundant type 
extension base unit)

Connection type Before system switching After system switching

GT Soft
GOT2000

Station No.3 
(normal station)

MELSECNET/H PLC 
to PLC network 
(MELSECNET/H mode or 
MELSECNET/10 mode)

Station No.1
(control station)

Station No.2
(normal station)

Control 
system

Standby 
system

GT Soft
GOT2000

Station No.3 
(normal station)

MELSECNET/H PLC 
to PLC network 
(MELSECNET/H mode or 
MELSECNET/10 mode)

Station No.1
(normal station)

Station No.2
(sub control station)

Control 
system

Standby 
system

GT Soft
GOT2000

Station No.3 
(normal station)

CC-Link IE 
Controller Network

Station No.1
(control station)

Station No.2
(normal station)

Control 
system

Standby 
system

GT Soft
GOT2000

Station No.3 
(normal station)

CC-Link IE 
Controller Network

Station No.1
(normal station)

Station No.2
(sub control station)

Control 
system

Standby 
system

GT Soft
GOT2000

Station No. 3

Ethernet

Station No. 1 Station No. 2

Control
system

Standby
system

GT Soft
GOT2000

Station No. 3

Ethernet

Station No. 1 Station No. 2

Standby
system

Control
system

GT Soft
GOT2000 

1)

GT Soft
GOT2000 

2)

Control system

Station
No. 1

Station
No. 2

Serial
communication 
module

Ethernet
module

Serial communication 
connection

Ethernet
connection

GT Soft
GOT2000 

1)

GT Soft
GOT2000 

2)

Control system Standby system

Station
No. 1

Station
No. 2

Serial
communication
module

Ethernet
module

Serial communication 
connection

Ethernet
connection
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Precautions for monitoring a redundant system
 • System switching in the redundant system may cause a system alarm on the GOT.
When the MELSEC redundant setting is configured: Error code 450, "Path has changed or timeout occurred 
in redundant system."
When the MELSEC redundant setting is not configured: Error code 402, "Communication timeout. Confirm 
communication pathway or modules."
However, even if the error occurs, the GT SoftGOT2000 automatically resumes monitoring and there are no 
problems in the monitoring operation.
 • The system alarm is displayed when the system is switched due to cable disconnection etc. (when the path 

is changed).
The system alarm is not displayed when the system is switched by the user.
 • Without the MELSEC redundant setting, GT SoftGOT2000 does not switch the monitoring target 

automatically when system switching occurs in the redundant system.
When the GT SoftGOT2000 is connected to the standby system, data written to a device are overwritten by 
the data of the control system, failing to be reflected.
In this case, when data are written to a device in the standby system normally, the system alarm "315 Device 
writing error.
Correct device." is not detected.
 • Do not check-mark the [Comm. Error Dialog] in [Communication Setup] from [Online], for GT SoftGOT2000.
If [Comm. Error Dialog] is checked, a communication error dialog appears and the monitor stops when some 
error occurs in the communication path.
Page 74 Setting the Communication Method
 • To monitor the redundant system (QCPU) by using the MELSECNET/H connection, the QCPU must have 

function version D or later and a serial number starting with 07102 or later.
Also, use GX Developer of Version 8.29F or later.
 • If a system switching occurs while an extended function such as a sequence program monitor is being 

used, a message saying [Unable to communicate with CPU.] appears.
 • For the MELSECNET/H connection or MELSECNET/10 connection, if the control station on the 

MELSECNET/H network or MELSECNET/10 network fails and is taken over by a station other than the 
redundant system (QCPU), a timeout occurs as a system alarm on the GOT.

If this occurs, the monitor display speed may slow down.
 • In the direct CPU connection (RS-232, USB), GT SoftGOT2000 fails to automatically change the monitoring 

target in the following cases.
When the power supply to the CPU where the GT SoftGOT2000 is connected is OFF
When the cable connecting the GT SoftGOT2000 with the CPU is broken
When the tracking is disabled
 • Even if the MELSEC redundant setting is configured for a system without redundancy, GT SoftGOT2000 is 

started without errors and operates normally.
However, if an error (such as power-off or communication timeout) occurs in the station that is specified in the 
MELSEC redundant setting, GT SoftGOT2000 may not behave according to the setting.
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Connection to remote I/O station in MELSECNET/H network 
system
This section explains the direct CPU connection (RS-232) used to connect GT SoftGOT2000 and the remote I/O station of the 
MELSECNET/H network system.
The following shows an example of connecting the GT SoftGOT2000 to the remote I/O station of the MELSECNET/H network 
system.

Connection method
Connect the GT SoftGOT2000 to the RS-232 interface of the network module (QJ72LP25-25, QJ72LP25G, QJ72BR15) on 
the remote I/O station of the MELSECNET/H network system.

Setting on GT Designer3
Set GT Designer3 as follows.

In this case, the GT SoftGOT2000 monitoring is performed by transient transmission of the MELSECNET/H network system.
Therefore, a longer time-lag occurs for displaying objects compared with directly monitoring the PLC CPU.
For displaying objects with a shorter time-lag, execute the cyclic transmission so that the GT SoftGOT2000 can monitor link 
devices B and W of the host station set in the MELSECNET/H network.

Switching the monitoring target when system switching occurs in the redundant 
system
When the system switching occurs, the multiplexed remote sub master station switched to the control system takes over the 
master operation of MELSECNET/H.
Since the GT SoftGOT2000 monitors the master station, the monitoring target is automatically changed to the PLC CPU that 
is operating as the master.

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Host Host

Remote master station Other (NW No. 1 (network No. of remote I/O network), Station No. 0 (master station))

MELSEC Redundant Do not set the item.

Monitor target

MELSECNET/H remote I/O network

Direct CPU connection (RS-232)

Network No. 1, Station No. 0
(Multiplexed remote master station)

Control system
(System A)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Network No. 1, Station No. 1
(Multiplexed remote sub master station)

Standby system
(System B)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Q
J72LP25-25

Q
J71C

24NNetwork No. 1, Station No. 2
(Remote I/O station)

Em
pty

Em
pty

Pow
er supply

m
odule

Em
pty

Pow
er supply

m
odule

Em
pty

Pow
er supply

m
odule

GT SoftGOT2000
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Direct CPU connection (RS-232, USB)
This section describes the direct CPU connection (RS-232, USB) used to connect GT SoftGOT2000 and a PLC CPU in the 
redundant system.
For the direct CPU connection (RS-232, USB), use one or two GT SoftGOT2000.

When using one GT SoftGOT2000

■Connection method
Connect GT SoftGOT2000 to the control system CPU module (Q12PRHCPU, Q25PRHCPU) of the redundant system using 
an RS-232 cable or USB cable.

■Setting on GT Designer3
Set GT Designer3 as follows.

■Switching the monitoring target when system switching occurs in the redundant system
When system switching occurs, the standby PLC (another station) takes over the host station operation.
Since the GT SoftGOT2000 monitors the control system, the monitoring target is automatically changed to other station.

When monitoring the control system without configuring the MELSEC redundant setting
Without the MELSEC redundant setting, GT SoftGOT2000 cannot switch the monitoring target automatically 
when system switching occurs. Therefore, even after system switching, GT SoftGOT2000 still monitors the 
PLC (host station).
As a contermeasure, change the cable connection from the PLC CPU in the previous control system to the 
control system after system switching.

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Host Host

MELSEC Redundant Page 221 MELSEC redundant setting

Monitor target

MELSECNET/H remote I/O network

Direct CPU connection (RS-232, USB)
Network No. 1, Station No. 0 
(Multiplexed remote master station)

Control system 
(System A)

Q
25PR

H
C

PU

Pow
er 

supply m
odule

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Em
pty

Pow
er 

supply m
odule

Em
pty

Pow
er 

supply m
odule

Em
pty

Em
pty

Network No. 1, Station No. 1 
(Multiplexed remote sub master station)

Standby system 
(System B)

Q
J72LP25-25

Q
J71C

24NNetwork No. 1, Station No. 2 
(remote I/O station)

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

GT SoftGOT2000
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When using two GT SoftGOT2000
Connect a GT SoftGOT2000 module to each PLC to monitor the control system after system switching.

■Connection method
Connect GT SoftGOT2000 and the PLCs (Q12PRHCPU, Q25PRHCPU) of the control system and standby system in the 
redundant system using an RS-232 cable or USB cable.

■Setting on GT Designer3
Set GT Designer3 as follows.

■Switching the monitoring target when system switching occurs in the redundant system
When the system switching occurs, the GT SoftGOT2000 cannot change the monitor target automatically in response to the 
system switching.
The GT SoftGOT2000 that is connected to the control system CPU module after system switching continues the monitoring.
Different from the case using one GT SoftGOT2000, no cable reconnection is required.

To monitor the control system after system switch automatically with one GT SoftGOT2000 module, configure 
the MELSEC redundant setting.
Page 221 MELSEC redundant setting

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Host Host

MELSEC Redundant Do not set the item.

Monitor
target

Network No. 1, Station No. 0
(Multiplexed remote master station)

Network No. 1, Station No. 1
(Multiplexed remote sub master station)

Network No. 1, Station No. 2
(remote I/O station)

Pow
er supply

m
odule

Pow
er supply

m
odule

Pow
er supply

m
odule

MELSECNET/H remote I/O network

Direct CPU connection (RS-232, USB)

Control system
 (System A)

Em
pty

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Standby system 
(System B)

Q
J72LP25-25

Q
J71C

24N

Em
pty

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Em
pty

Em
pty

Direct CPU connection (RS-232, USB)

GT SoftGOT2000 1) GT SoftGOT2000 2)
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Precautions for connecting a PLC in the redundant system by the direct CPU 
connection (RS-232, USB) without configuring the MELSEC redundant setting
As the GT SoftGOT2000 monitors exclusively the PLC CPU that is directly connected to, the monitor target cannot be 
changed in response to the system switching of the redundant system.
To change the target monitor in response to the system switching, change the target of the connection cable between the GT 
SoftGOT2000 and PLC CPU to the other PLC CPU, or configure the system using GT SoftGOT2000 connected to each PLC 
CPU.
In direct CPU connection (RS-232, USB), when monitoring a PLC in the redundant system, only the PLC that is directly 
connected to the GT SoftGOT2000 can be monitored.
When connected to the standby system PLC CPU, the writing of the GT SoftGOT2000 to a device in the connected PLC CPU 
is not reflected.
Design a monitor screen that disables writing to the standby system.
In the redundant system, the tracking function transfers device data from control system to standby system.
When the tracking function is enabled, the device value of the standby system PLC CPU is overwritten by the device value 
transferred from the control system to the standby system even if the GT SoftGOT2000 writes to the standby system PLC 
CPU (Numerical input, Ascii input, Script, Recipe, or others).

Numerically input D100=100
from  GT SoftGOT2000.

1) D100=100

2) D100=5

Tracks D100=5 from control
system to standby system.

Pow
er supply

m
odule

Pow
er supply

m
odule

Pow
er supply

m
odule

MELSECNET/H remote I/O network

Direct CPU connection (RS-232, USB) Direct CPU connection (RS-232, USB)

Control system
(System A)

Em
pty

Em
pty

Em
pty

Em
pty

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

Standby system
 (System B)

Q
J72LP25-25

Q
J71C

24N

Q
25PR

H
C

PU

Q
J71LP21-25

Q
J71BR

11

Q
J71E71-100

Q
J61BT11N

GT SoftGOT2000 1) GT SoftGOT2000 2)
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As countermeasures to the above, perform the following.
Set a monitor screen indicating that the standby system PLC CPU is connected to GT SoftGOT2000.
To display such a screen when connecting GT SoftGOT2000 to the standby system PLC CPU, use special relay SM1515 
(Control status identification flag) of the PLC CPU.
(When SM1515 is off, the standby system PLC CPU is connected.)
Control the operation of each object by SM1515, which is set for the operation condition.
For the screen switching device, use a GT SoftGOT2000 internal device.
If a device of the PLC CPU is used, the trigger action may be disabled since the device data is transferred by the tracking 
function of the redundant system.
The following diagram shows an example of screen setting using SM1515.
System configuration example: when using one GT SoftGOT2000

Create a monitor screen on the base screen 1 that performs the following operations for when connecting a GT SoftGOT2000 
to control system and standby system.
1) When connecting to the control system, the monitor screen displays a message calling a touch switch operation, by which 
the screen switches to the next screen.
2) When connecting to the standby system, the monitor screen displays a message calling the reconnection of the connection 
cable.
1) When connecting to the control system 2) When connecting to the standby system

Control
system
(System A)

Q25PRH
CPU
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Standby
system 
(System B)

Station
No. 0

Q25PRH
CPU

QJ71
BR11

Station 
No. 1

QJ72
BR15
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No. 2

GT SoftGOT2000
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1. Set the screen switching device of the base screen.
Choose [Common] → [GOT Environmental Setting] → [Screen Switching/Window], and set the internal device GD100 as the 
base screen switching device.
(Do not use PLC CPU devices for the screen switching device. The trigger action may be disabled since the device data is 
transferred by the tracking function of the redundant system.)

2. Set the trigger action.
Make the setting so that the base screen 1 is displayed when the connected PLC CPU is standby system (SM1515 = OFF) in 
the project specified by selecting [Common] → [Trigger Action].

Create the trigger action in the project of the [Project] tab.

Condition 1 : SM1515 (while OFF) ← When the SM1515 is OFF, the connected PLC CPU is the standby system.
Operation : GD100=1 ← The screen switches to the base screen 1.
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3. Set the comment display on the base screen 1.
Set a comment to be displayed on the base screen 1 depending on the system status (ON/OFF of the SM1515) of the 
connected PLC CPU using the Comment Display (Bit).
Select [Object] → [Comment Display] → [Bit Comment] and set Comment Display (Bit).

Dvice/Style tab
Device : SM1515
Shape : None
Comment tab : Basic Comment
Comment Display Type Text (ON) : The operation status is control system.
Touch the screen to display the next screen.
Comment Display Type Text (OFF) : The operation status is standby system.
Reconnect the PLC connection cable to the control system CPU.

1) [Dvice/Style] tab screen 2) [Comment] tab screen (ON status)

3) [Comment] tab screen (OFF status)
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4. Set the touch switches on the base screen 1.
By using the go to screen switch function, set a touch switch for shifting the screen to the next screen with a screen touch, 
when the connected PLC CPU is the control system (SM1515 is ON).
Select [Object] → [Switch] → [Go To Screen Switch] and set the screen switching function.
Set the same size for the touch switch as the base screen size so that touching any place of the screen enables the switch 
operation.

Next Screen tab
Screen Type : Base
Go To Screen : Fixed 2
Style tab
Display Style : None (Shape)
Trigger tab
Trigger Type : ON
Trigger Device : SM1515

1) [Next Screen] tab screen 2) [Style] tab screen 3) [Trigger] tab screen

The following shows the created base screen 1.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.5  How to Monitor the Redundant System (QCPU) 215



21
MELSECNET/H and MELSECNET/10 connections (network 
systems)
This section explains the MELSECNET/H and MELSECNET/10 connections (network systems) that connect the GT 
SoftGOT2000 to the MELSECNET/H and MELSECNET/10 network system.
The following provides an example of connecting the GT SoftGOT2000 set as a normal station to the MELSECNET/ H 
network system.

Connection method
Connect the MELSECNET/H network system to the GT SoftGOT2000.

Setting on GT Designer3
Set GT Designer3 as follows.

Monitoring target change when system switching occurs in a redundant system
When system switching occurs, the network module station No. 2 changes from the normal station to the sub control station 
and takes over the control of the MELSECNET/H network system.
Since the GT SoftGOT2000 monitors the control system, the monitoring target is automatically changed to the network 
module station No. 2.

When monitoring the control system without configuring the MELSEC redundant setting
When system switching occurs, the network module station No. 2 changes from the normal station to the sub 
control station and takes over the control of the MELSECNET/H network system.
Since the GT SoftGOT2000 monitors the station of the specified station number, the monitoring target cannot 
be changed to the station No. 2 in response to the system switching.
As a countermeasure, create a screen to monitor the PLC CPU of the control system by switching the station 
numbers between System A and System B using the script function.
Page 223 Switch the monitor target to the control system using the script function

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Other station Other (NW No. 1 (network No. of PLC to PLC network), Station No. ** (** indicates the station number of the 
control system. Station No. 1, in the above example))
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CC-Link IE Controller Network connection (network system)
This section explains the CC-Link IE Controller Network connection (network system) that connects the GT SoftGOT2000 to 
the CC-Link IE Controller Network.
The following shows an example of connecting the GT SoftGOT2000 set as a normal station to the CC-Link IE Controller 
Network.

Connection method
Connect the GT SoftGOT2000 to the CC-Link IE Controller Network.

Setting on GT Designer3
Set GT Designer3 as described below.

Switching the monitoring target when system switching occurs in the redundant 
system
When system switching occurs, the network module station No.2 changes from a normal station to the sub control station, and 
the system with the module takes over the control of the CC-Link IE Controller Network as the control system.
Since the GT SoftGOT2000 monitors the control system, the monitoring target is automatically changed to the network 
module station No. 2.

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Other station Other (NW No.1 (Network No. of CC-Link IE Controller Network), Station No. ** (** indicates the station 
number of the control system. Station No. 1 in the above example))
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Ethernet connection
This section explains the Ethernet connection that connects the GT SoftGOT2000 to the Ethernet network system.
The following shows an example of connecting the GT SoftGOT2000 to the Ethernet network.

Connection method
Connect the Ethernet network system to the GT SoftGOT2000.

Setting on GT Designer3
Set GT Designer3 as follows.

Switching the monitoring target when system switching occurs in the redundant 
system
When system switching occurs, Ethernet module station No. 2 takes over the control of the Ethernet network system as the 
control system.
Since the GT SoftGOT2000 monitors the control system, he monitoring target is automatically changed to the Ethernet 
module station No. 2.

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Host Host

Other station Other (NW No. 1 (network No. of Ethernet), Station No. ** (** indicates the station number of the control 
system. Station No. 1, in the above example))
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Connection to the redundant type extension base unit

Serial communication connection (Serial communication module mounted on the 
redundant type extension base unit)
This section explains the serial communication connection for connecting the GT SoftGOT2000 to the serial communication 
module mounted on the redundant type extension base unit.
The following shows an example of connecting GT SoftGOT2000 to the serial communication module mounted on the 
redundant type extension base unit.

■Connection method
Connect the GT SoftGOT2000 to the serial communication module (QJ71C24N) mounted on the redundant type extension 
base unit.

■Setting on GT Designer3
Set GT Designer3 as follows.

■Switching the monitoring target when system switching occurs in the redundant system
When the system switching occurs, the GT SoftGOT2000 automatically changes the monitoring target to the PLC CPU 
switched to the control system.

Setting item Settings
Controller Type [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700]

Device setting
(Network setting)

Host Host

MELSEC Redundant Do not set the item.
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Ethernet connection (Ethernet module mounted on the redundant type extension base 
unit)
This section explains the Ethernet connection for connecting the GT SoftGOT2000 to the Ethernet module mounted on the 
redundant type extension base unit.
The following shows an example of connecting the GT SoftGOT2000 to the Ethernet module mounted on the redundant type 
extension base unit.

■Connection method
Connect the GT SoftGOT2000 to the Ethernet module (QJ71E71-100, QJ71E71-B5, QJ71E71-B2, LJ71E71-100) mounted 
on the redundant type extension base unit.

■Setting on GT Designer3
Set GT Designer3 as follows.

■Switching the monitoring target when system switching occurs in the redundant system
When the system switching occurs, the GT SoftGOT2000 automatically changes the monitoring target to the PLC CPU 
switched to the control system.

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions
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MELSEC redundant setting
This section explains how to configure settings in GT Designer3 to enable GT SoftGOT2000 to switch the monitoring target 
automatically when system switching occurs in a redundant system.
For the details of GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Before configuring the MELSEC redundant setting
In the MELSEC redundant setting, do not specify a station outside the redundant system.

1. Select [Common] → [Controller Setting] from the menu.

2. The [Controller Setting] window appears.
Select [MELSEC Redundant] from the setting tree, and select [Use the function of MELSEC Redundant].

3. Configure the MELSEC redundant setting.

Item Description
[Follow the redundant system 
via a serial interface.]

Automatically switches the monitoring target upon system switching if the redundant system is connected to the GOT by the 
serial connection.

[Pair No.] *1 Pair number of the MELSEC redundant setting.
The numbers are assigned automatically starting from 1.

[Net No.] Set the network Nos. for each pair No.
The upper row is for the setting of the first redundant CPU.
The setting range is [1] to [239].
The lower row is for the setting of the second redundant CPU.
The network No. of the second redundant CPU is the same as the one for the first CPU.

[Station No.] Set the station numbers of the redundant CPUs for each pair No.
The upper row is for the setting of the first redundant CPU.
The setting range is [0] to [120].
The lower row is for the setting of the second redundant CPU.
The setting range is [0] to [120].

[New] Adds the pair No. setting below the bottom row in the list.

[MELSEC Redundant]

[Use the function of MELSEC Redundant]
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*1 For details of *1, refer to the explanation below.
*1 Pair number
[Pair No.] displays a number that is assigned to a pair of PLCs in a redundant system.
Example: Ethernet connection (Pair No. 1 and Pair No. 2)

Precautions for the MELSEC redundant setting
When configuring the MELSEC redundant setting, note the following.
In the MELSEC redundant setting, set the station numbers for a pair according to the system configuration.
Some system configurations require adjacent station numbers to be set for system A and system B.
Make sure that both stations specified in the MELSEC redundant setting have a Redundant CPU or Process 
CPU (redundant mode).
If either station does not have such a CPU, GT SoftGOT2000 cannot switch the monitoring target 
automatically when system switching occurs.
For the MELSECNET/H connection, MELSECNET/10 connection, or Ethernet connection, check the station 
number of the network module and then configure the MELSEC redundant setting.
If the actual station number of the network module is not specified in the MELSEC redundant setting, GT 
SoftGOT2000 cannot switch the monitoring target automatically when system switching occurs.
When monitoring the redundant system (host station) by using the Ethernet connection, make sure to 
configure the pair number setting in the MELSEC redundant setting so that GT SoftGOT2000 switches the 
monitoring target automatically upon system switching.
The setting of [Follow the redundant system via a serial interface.] in the MELSEC redundant setting is invalid 
for the Ethernet connection.

[Duplicate] Duplicates a selected pair No. setting below the bottom row in the list.

[Delete] Deletes a selected pair No. setting.

[Delete All] Deletes all the pair No. settings.

[Copy All] Copies all the pair No. settings in the list of the selected tab.
Use this button to utilize the settings for other channels.

[Paste All] Pastes the copied settings to the list.
The existing settings are overwritten.
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Switch the monitor target to the control system using the script 
function
This section explains how to use the script function to switch the monitoring target (station number) automatically upon 
system switching while the MELSEC redundant setting is not configured.
This method is usable for the MELSECNET/H connection.
The script executes the station number switching function or screen switching function.
The following shows the advantages and disadvantages of the station number switching function and screen switching 
function.

The following explains how to use each function.

Method for using the station number switching function
As a feature of this function, monitor screens for Station No. 1 (control system) and Station No. 2 (standby system) can be 
created on one screen.
If the system switching occurs, the GT SoftGOT2000 can change the monitoring target to the control system PLC CPU on the 
same monitor screen.
To achieve this, the script of the GT SoftGOT2000 monitors the special relay SM1515 (Control system identification flag) of 
the PLC CPU and stores the station number of the latest control system into the station number switching device.
Restrictions: Some objects do not allow the station number to be switched.
GT Designer3 (GOT2000) Screen Design Manual

■Setting method
<System configuration example>

Function Advantage Disadvantage
Station number switching 
function

The monitor screens for Station No. 1 (control system) and 
Station No. 2 (standby system) can be created on one screen.

Some objects do not allow the station number to be switched.

Screen switching function All objects can be used since monitor screens are created for 
each station number.

Monitor screens must be created separately for Station No. 1 
(control system) and Station No. 2 (standby system).

Connected module Network No. Station No.
MELSECNET/H network module of control system 1 1

MELSECNET/H network module of standby system 2

GT SoftGOT2000 connected to MELSECNET/H network 3
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(MELSECNET/H mode or MELSECNET/10 mode)
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1. Set the station number switching device.
Select [Common] → [Controller Setting] → [Station No. Switching], and set the internal device GD100 as the station number 
switching device. (Do not use PLC CPU devices for the screen switching device.
The trigger action may be disabled since the device data is transferred by the tracking function of the redundant system.)

2. Set the trigger action.
Make the settings so that the station number is switched when the faulty station information (SW70) of MELSECNET/H turns 
ON in the project specified by selecting [Common] → [Trigger Action].

3. Create a monitor screen.
In the device setting (network setting) of each object, set Network No. 1 and Station No. 1 of the control system.

Condition 1: SW70.b0 (while ON) ← When b0 is ON, Station No. 1 is abnormal.
Operation: GD100=2 ← Station No. is changed to 2.

Condition 1: SW70.b1 (while ON) ← When b1 is ON, Station No. 2 is abnormal.
Operation: GD100=1 ← Station No. is changed to 1.

Condition 1: GD100==0 ← The value of the Station No. changing device is 0.
Condition 2: SW56<=2 ← The current control station is a redundant CPU.
Operation: GD100=SW56 ← Station No. is changed to a current control station.

Condition 1: GD100==0 ← The value of the Station No.changing device is 0.
Condition 2: SW56>2 ← The current control station is not a redundant CPU.
Operation: GD100=1 ← Station No. is changed to a current control station in normal condition.

Set here.
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4. Enable the station No. switching function.
Select [Screen] → [Screen Property] from the menu to display the [Screen Property] dialog. On the [Basic] tab, select [Switch 
Station No.] to enable the station No. switching function.

5. Change the station number switching device value in the script.
By selecting [Common] → [Script] → [Script], create a script for each monitor screen that checks the SM1515 status of the 
current monitor station, and if it is OFF (standby system), changes the station number switching device value.
Set the trigger type of the script as [Ordinary] or [Sampling(about 3s)].

Set the created script for each screen on the [Screen] tab.

// If the monitoring target is a standby station, the Station No. is changed.
if([b:SM1515]==OFF){       //Is the monitoring target standby?
if([w:GD100]==1){             //The Station No. is 1 to 2.
[w:GD100]=2;
}else{                                //The Station No. is 2 to 1.
[w:GD100]=1;
}
}

Check here.
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Setting for the trigger action function
For the trigger action function, hexadecimal numbers cannot be used.
To use the trigger action function, set the N/W No. and the station No. of the PLC CPU in [Unsigned BIN].
(For the trigger action function, set [Unsigned BIN] for [Device Write].)
Example:
When Net No.: 1 and Station No.: 1 (0101H)
Set "257".
When Net No.: 10 and Station No.: 10 (0A0AH)
Set "2570".

When a redundant system is only connected to the MELSECNET/H network, SW56 (Current control station) 
can be set as the station number switching device.
In this case, even if the system switching occurs, GT SoftGOT2000 always monitors the station number that is 
currently the control station.

Method for using the screen changing function
As a feature of this function, monitor screens are created for each station number.
When the system switching occurs, the GT SoftGOT2000 can change the monitoring target to the control system PLC CPU 
on the other monitor screen.
To achieve this, the script of the GT SoftGOT2000 monitors the special relay SM1515 (Control system identification flag) of 
the PLC CPU and stores the screen number corresponding to the latest station number of the control system into the screen 
switching devices.
Precautions:
There are the following 8 different screen switching devices.Set the screen switching devices for all screens to be used.
Base screen switching device
Overlap window 1 switching device
Overlap window 2 switching device
Overlap window 3 switching device
Overlap window 4 switching device
Overlap window 5 switching device
Superimpose window 1 switching device
Superimpose window 2 switching device
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■Setting method
<System configuration example>

1. Set the screen switching device of the base screen.
Select [Common] → [GOT Environmental Setting] → [Screen Switching/Window], and set the internal device GD100 as the 
base screen switching device.

2. Set the trigger action.
Set the trigger action so that the station number is switched when the faulty station information (SW70) of MELSECNET/H 
turns ON in the project specified by selecting [Common] → [Trigger Action].

Connected module Network No. Station No.
MELSECNET/H network module of control system 1 1

MELSECNET/H network module of standby system 2

GT SoftGOT2000 connected to MELSECNET/H network 3

Condition 1: SW70.b0 (while ON) ← Station No. 1 is abnormal.
Condition 2: GD100<100
Operation: GD100= GD100+100 ← Station No. is changed to 2.

Condition 1: SW70.b1 (while ON) ← Station No. 2 is abnormal.
Condition 2: GD100>100
Operation: GD100= GD100-100 ← Station No. is changed to 1.

Condition 1: GD100==0 ← The value of the screen changing device is 0.
Condition 2: SW56==1 ← The current control station is Station No. 1.
Operation: GD100=2 ← Screen No. is changed to 2 (for Station No. 1).

Condition 1: GD100==0 ← The value of the screen changing device is 0.
Condition 2: SW56==2 ← The current control station is Station No. 2.
Operation: GD100=102 ← Screen No. is changed to 102 (for Station No. 2).

Condition 1: GD100==0 ← The value of the screen changing device is 0.
Condition 2: SW56>2 ← The current control station is not a redundant CPU.
Operation: GD100=2 ← Screen No. is changed to 2 (for Station No. 1).

MELSECNET/H
(MELSECNET/H mode)
Network No. 1

Station No. 3
Control 
system

(System A)
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3. Set monitor screens.
Create a monitor screen with each object whose network setting is Station No. 1 on Screen No. 2 to 3.
Create a monitor screen with each object whose network setting is Station No. 2 on Screen No. 102 to 103.

4. Change the screen switching device value in the script.
By selecting [Common] → [Script] → [Script], create a script for each monitor screen that checks the SM1515 status of the 
current monitor station, and if it is OFF (standby system), changes the station number switching device value.
Set the trigger type of the script as [Ordinary] or [Sampling(about 3s)].
Screen scripts

// The script of Screen No. 2 to 3 (for Station No.1)
// If the monitoring target is a standby station, the screen is changed to the other one.
if ([1-1: b: SM1515]==OFF){
//Is Station No.1 standby?
if([w: GD100]<100){
[w: GD100]= [w: GD100]+100;
//The screen is changed from Station No.1 to 2.
}
      }

// The script of Screen No. 102 to 103 (for Station No.2)
// If the monitoring target is a standby station, the screen is changed to the other one.
if ([1-2: b: SM1515]==OFF){
//Is Station No.2 standby?
if([w: GD100]>100){
[w: GD100]= [w: GD100]-100;
//The screen is changed from Station No.2 to 1.
}
      }

Script screen of Screen No. 2 (for Station 1) Script screen of Screen No. 102 (for Station 2)
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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3.6 Ethernet Connection
System configuration

Direct connection

PLC Conne
ction 
cable 
*4

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet interface Commu
nication 
type

RCPU*12 Built-in 
Ethernet 
port*5

RnCPU
RnPCPU
RnSFCPU
RnPSFCPU
RnENCPU*11*13

Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

UDP: 119
TCP: 17

UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)Ethernet 

module
RJ71EN71 UDP: 119*3

TCP: 17*3

CC-Link IE 
TSN master/
local module*8

RJ71GN11-T2 UDP: 119*3

TCP: 17*3

CC-Link IE 
TSN Plus 
master/local 
module*8

RJ71GN11-EIP*10

Motion 
module*8

RD78G4
RD78G8
RD78G16
RD78G32
RD78G64
RD78GHV
RD78GHW

UDP: 64
TCP: 64

128

LHCPU Built-in 
Ethernet 
port*5

LnHCPU UDP: 119
TCP: 17

UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

FX5CPU Built-in 
Ethernet 
port*5

FX5U
FX5UC
FX5UJ
FX5S

8 128

Ethernet 
module

FX5-ENET
FX5-ENET/IP

UDP: 32 (16 or 
less 
recommended)
TCP: 32 (16 or 
less 
recommended)

CC-Link IE 
TSN master/
local 
module*8*14

FX5-CCLGN-MS 8

Motion 
module*8*9

FX5-40SSC-G
FX5-80SSC-G

8

PLC CPU GT SoftGOT2000

Connection cable

Ethernet 
interface
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LCPU Built-in 
Ethernet 
port*5

LnCPU
LnCPU-P
L26CPU-BT
L26CPU-PBT

Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

UDP: 16
TCP: 16

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

Ethernet 
module

LJ71E71-100 UDP: 63
TCP: 17

QCPU (Q mode) Built-in 
Ethernet 
port*5

QnUDECPU
QnUDEHCPU
QnUDVCPU

UDP: 16
TCP: 16

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

Ethernet 
module

QJ71E71
QJ71E71-B2
QJ71E71-B5

UDP: 63
TCP: 17

QJ71E71-100

QCPU (A mode) Ethernet 
module

AJ71E71-S3
A1SJ71E71-B2-S3
A1SJ71E71-B5-S3
AJ71E71N-T
AJ71E71N-B5
AJ71E71N-B2
AJ71E71N3-T
AJ71E71N-B5T
A1SJ71E71N-T
A1SJ71E71N-B2
A1SJ71E71N-B5
A1SJ71E71N-B5T
A1SJ71E71N3-T

UDP: 8
TCP: -

UDP: 63 (4 or 
less 
recommended)
TCP: -

QnACPU Ethernet 
module

AJ71QE71
AJ71QE71-B5
AJ71QE71N-T
AJ71QE71N-B2
AJ71QE71N-B5
AJ71QE71N-B5T
AJ71QE71N3-T
A1SJ71QE71-B2
A1SJ71QE71-B5
A1SJ71QE71N-T
A1SJ71QE71N-B2
A1SJ71QE71N-B5
A1SJ71QE71N-
B5T
A1SJ71QE71N3-T

ACPU Ethernet 
module

AJ71E71-S3
A1SJ71E71-B2-S3
A1SJ71E71-B5-S3
AJ71E71N-T
AJ71E71N-B5
AJ71E71N-B2
AJ71E71N3-T
AJ71E71N-B5T
A1SJ71E71N-T
A1SJ71E71N-B2
A1SJ71E71N-B5
A1SJ71E71N-B5T
A1SJ71E71N3-T

FXCPU *2 Ethernet 
module

FX3U-ENET
FX3U-ENET-ADP

4 128

FX3U-ENET-L 2

PLC Conne
ction 
cable 
*4

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet interface Commu
nication 
type
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C 
Controller 
module

MELSEC 
iQ-R 
series

Built-in 
Ethernet port

R12CCPU-V Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

1 128

Ethernet 
module

RJ71EN71 UDP: 119*3

TCP: 17*3
UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

CC-Link IE 
TSN master/
local module*8

RJ71GN11-T2 UDP: 64*3

TCP: 64*3
128

Motion 
module*8

RD78G4
RD78G8
RD78G16
RD78G32
RD78G64
RD78GHV
RD78GHW

UDP: 64
TCP: 64

Q series Built-in 
Ethernet port

Q24DHCCPU-V
Q24DHCCPU-VG
Q24DHCCPU-LS
Q26DHCCPU-LS

16

Q12DCCPU-V Basic mode: 1
Extended mode: 
16

Ethernet 
module

QJ71E71
QJ71E71-B2
QJ71E71-B5

UDP: 63
TCP: 17

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

QJ71E71-100

MELSEC
WinCPU*8

MELSEC 
iQ-R 
series

Built-in 
Ethernet 
port*5

R102WCPU-W UDP: 119
TCP: 17

UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

CC-Link IE 
TSN master/
local module*8

RJ71GN11-T2 UDP: 64*3

TCP: 64*3

PLC Conne
ction 
cable 
*4

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet interface Commu
nication 
type
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Motion 
CPU

MELSEC 
iQ-R 
series

Built-in 
Ethernet 
port*5

RnMTCPU Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

UDP: 16*6

TCP: 16*6
128

Ethernet 
module

RJ71EN71 UDP: 119
TCP: 17

UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

Q series Built-in 
Ethernet 
port*5

Q17nDSCPU
Q170MCPU*1

Q170MSCPU*1

Q170MCPU-S1*1

Q170MSCPU-S1*1

16 128

Ethernet 
module

QJ71E71
QJ71E71-B2
QJ71E71-B5

UDP: 63
TCP: 17

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

QJ71E71-100

A series Ethernet 
module

AJ71E71-S3
A1SJ71E71-B2-S3
A1SJ71E71-B5-S3
AJ71E71N-T
AJ71E71N-B5
AJ71E71N-B2
AJ71E71N3-T
AJ71E71N-B5T
A1SJ71E71N-T
A1SJ71E71N-B2
A1SJ71E71N-B5
A1SJ71E71N-B5T
A1SJ71E71N3-T

UDP: 8
TCP: -

UDP: 63 (4 or 
less 
recommended)
TCP: -

NC CNC 
C80

Built-in 
Ethernet 
port*7

R16NCCPU-S1 Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

8 128

Ethernet 
module

RJ71EN71 UDP: 119*3

TCP: 17*3
UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

CNC 
C70

Built-in 
Ethernet 
port*7

Q173NCCPU 16 128

Ethernet 
module

QJ71E71
QJ71E71-B2
QJ71E71-B5

UDP: 63
TCP: 17

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

QJ71E71-100

MELDAS Ethernet 
module

FCU6-EX875
FCA C6
FCA C64

128 128

PLC Conne
ction 
cable 
*4

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet interface Commu
nication 
type
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*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU, Q170MSCPU, Q170MCPU-
S1, and Q170MSCPU-S1 can be accessed.

*2 The required conversion adapter and function extension board vary with the combination of an FXCPU and an Ethernet module.
The following shows the combinations.

*3 The number of personal computers for one port.
*4 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver, or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*5 For the applicable CPUs, refer to the following.
Page 236 Ethernet interface

*6 The total number of personal computers used for UDP and TCP must be 16.
*7 Ethernet is connected to Display I/F.
*8 Only available to GT SoftGOT2000 (Multiple channels).
*9 The connectable PLC CPUs are FX5U and FX5UC.
*10 Connect the module to P1 of RJ71GN11-EIP via a hub.
*11 Only GT SoftGOT2000 (Multiple channels) supports the connection in the multiple CPU system.
*12 For connection to RnENCPU No. 2 or later in the multiple CPU system, the firmware version of the RnENCPU must be 14 or later.
*13 For connection to Motion module No. 2 or later in the multiple CPU system, the firmware version of the RnENCPU must be 10 or later.
*14 The connectable PLC CPUs are FX5U, FX5UC, and FX5UJ.

Robot 
controller

MELSEC 
iQ-R 
series

Built-in 
Ethernet port

CR800-
R(R16RTCPU)

Ethernet Twisted 
pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

UDP: 16
TCP: 16

128

CR800-D 1

Ethernet 
module

RJ71EN71 UDP: 119*3

TCP: 17*3
UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

Q series Built-in 
Ethernet 
port*5

CRnD-700
CR750-D
CR751-D

1 128

CR800-
Q(Q172DSRCPU)

8 (1 
recommended)

Ethernet 
module

QJ71E71
QJ71E71-B2
QJ71E71-B5

UDP: 63
TCP: 17

UDP: 63 (16 or 
less 
recommended)
TCP: 63 (16 or 
less 
recommended)

QJ71E71-100

CC-Link IE Field 
Network head module

Built-in 
Ethernet port

RJ72GF15-T2 UDP: 64
TCP: 64

128

CC-Link IE Field 
Network Ethernet 
adapter module

Built-in 
Ethernet port

NZ2GF-ETB UDP: 1
TCP: 1

Ethernet module CPU Conversion adapter, function extension board
FX3U-ENET-L
FX3U-ENET

FX3UC
FX3GC

FX2NC-CNV-IF
FX3UC-1PS-5V

FX3U-ENET-ADP FX3U
FX3UC-32MT-LT(-2)

FX3U-CNV-BD
FX3U-422-BD
FX3U-232-BD

FX3G FX3G-CNV-ADP

FX3S FX3S-CNV-ADP

PLC Conne
ction 
cable 
*4

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet interface Commu
nication 
type
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Connection via a servo amplifier

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*2 For the settings in GT SoftGOT2000, refer to the following.
Page 238 Controller setting

*3 Use a PLC whose firmware version is as shown below.

*4 Use a PLC with a serial number starting with a 5-digit number as shown below.

PLC Servo amplifier connection 
cable*1

Max. 
distance

GT 
SoftGOT2000*2

Number of 
connectable 
devices

Series Communication 
type

Model name Connection 
type

MELSEC iQ-R 
series*3

C Controller module 
(MELSEC iQ-R series)
MELSEC iQ-L series
MELSEC iQ-F series*3

MELSEC-Q (Q 
mode)*4

MELSEC-L*4

CC-Link IE Field 
Network Basic

MR-J5-□G
MR-J5-□G-RJ
MR-J5D1-□G4
MR-JET-□G

Ethernet Ethernet cable that 
meets the 
1000BASE-T 
standard: Category 
5e or higher (double 
shielded, STP), 
straight cable

100 m
(Maximum 
segment 
length)

Windows-
compatible personal 
computer
PC CPU module
MELIPC

One GT 
SoftGOT2000 
module for one 
servo amplifier

Series Model name Applicable firmware version
MELSEC iQ-R series R00CPU

R01CPU
R02CPU

From the first product

R04CPU
R08CPU
R16CPU
R32CPU
R120CPU

25 or later

R04ENCPU
R08ENCPU
R16ENCPU
R32ENCPU
R120ENCPU

MELSEC iQ-F series FX5U
FX5UC
FX5UJ
FX5S

1.040 or later

Series Model name Applicable version
MELSEC-Q (Q mode) Q03UDVCPU

Q04UDVCPU
Q06UDVCPU
Q13UDVCPU
Q26UDVCPU

PLCs having a serial number starting with 18112 or later

Connection cable

CC-Link IE Field Network Basic

PLC CPU
GT SoftGOT2000Servo

amplifier
Servo
amplifier
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MELSEC-L L02CPU
L06CPU
L26CPU
L26CPU-BT
L02CPU-P
L06CPU-P
L26CPU-P
L26CPU-PBT

PLCs having a serial number starting with 18112 or later

Series Model name Applicable version
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Ethernet interface
The following shows connectable Built-in Ethernet port CPUs, Ethernet modules, and Ethernet boards/cards.

Built-in Ethernet port CPU, Ethernet module
Item Model name
RCPU Built-in Ethernet port CPU R00CPU, R01CPU, R02CPU, R04CPU, R08CPU, R16CPU, R32CPU, R120CPU, R16MTCPU, 

R32MTCPU, R64MTCPU, R08PCPU, R16PCPU, R32PCPU, R120PCPU, R08SFCPU, R16SFCPU, 
R32SFCPU, R120SFCPU, R08PSFCPU *6, R16PSFCPU *6, R32PSFCPU *6, R120PSFCPU *6, 
R04ENCPU *5, R08ENCPU *5, R16ENCPU *5, R32ENCPU *5, R120ENCPU *5, CNC C80(R16NCCPU-
S1)

Ethernet module RJ71EN71

CC-Link IE TSN master/
local module *7

RJ71GN11-T2

CC-Link IE TSN Plus 
master/local module*7

RJ71GN11-EIP

Motion module *7 RD78G4, RD78G8, RD78G16, RD78G32, RD78G64, RD78GHV, RD78GHW

LHCPU Built-in Ethernet port CPU L04HCPU, L08HCPU, L16HCPU, L32HCPU

QCPU (Q mode) Built-in Ethernet port CPU Q03UDECPU, Q04UDEHCPU, Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU, Q20UDEHCPU,
Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU,
Q03UDVCPU, Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU

Ethernet module QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

QCPU (A mode) AJ71E71-S3, A1SJ71E71-B2-S3, A1SJ71E71-B5-S3, AJ71E71N-T, AJ71E71N-B5, AJ71E71N-B2, 
AJ71E71N3-T, AJ71E71N-B5T, A1SJ71E71N-T, A1SJ71E71N-B2, A1SJ71E71N-B5, A1SJ71E71N-B5T, 
A1SJ71E71N3-T

C Controller module 
(MELSEC iQ-R 
series)

Built-in Ethernet port CPU R12CCPU-V

Ethernet module RJ71EN71

CC-Link IE TSN master/
local module *7

RJ71GN11-T2

Motion module *7 RD78G4, RD78G8, RD78G16, RD78G32, RD78G64, RD78GHV, RD78GHW

C Controller module 
(Q series)

Built-in Ethernet port CPU Q12DCCPU-V, Q24DHCCPU-V, Q24DHCCPU-LS, Q26DHCCPU-LS, Q24DHCCPU-VG

Ethernet module QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

MELSECWinCPU 
(MELSEC iQ-R 
series)*7*9

Built-in Ethernet port CPU R102WCPU-W

CC-Link IE TSN master/
local module *7

RJ71GN11-T2

MELSEC-QS Ethernet module QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

QnACPU AJ71QE71, AJ71QE71-B5, AJ71QE71N-T, AJ71QE71N-B2, AJ71QE71N-B5, AJ71QE71N-B5T, 
AJ71QE71N3-T, A1SJ71QE71-B2, A1SJ71QE71-B5, A1SJ71QE71N-T, A1SJ71QE71N-B2, 
A1SJ71QE71N-B5, A1SJ71QE71N-B5T, A1SJ71QE71N3-T

ACPU AJ71E71-S3, A1SJ71E71-B2-S3, A1SJ71E71-B5-S3, AJ71E71N-T, AJ71E71N-B5, AJ71E71N-B2, 
AJ71E71N-B2, AJ71E71N3-T, AJ71E71N-B5T, A1SJ71E71N-T, A1SJ71E71N-B2, A1SJ71E71N-B5, 
A1SJ71E71N-B5T, A1SJ71E71N3-T

LCPU Built-in Ethernet port CPU L02CPU, L06CPU, L26CPU, L26CPU-BT, L02CPU-P, L06CPU-P, L26CPU-P, L26CPU-PBT

Ethernet module LJ71E71-100

Motion CPU (MELSEC iQ-R series) RJ71EN71

Motion CPU (Q series)*1 QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

Motion CPU (A series) AJ71E71-S3, A1SJ71E71-B2-S3, A1SJ71E71-B5-S3, AJ71E71N-T, AJ71E71N-B5, AJ71E71N-B2, 
AJ71E71N-B2, AJ71E71N3-T, AJ71E71N-B5T, A1SJ71E71N-T, A1SJ71E71N-B2, A1SJ71E71N-B5, 
A1SJ71E71N-B5T, A1SJ71E71N3-T

CC-Link IE Field Network head module RJ72GF15-T2

CC-Link IE Field Network Ethernet adapter module NZ2GF-ETB

CNC C80 Built-in Ethernet port CPU R16NCCPU-S1

Ethernet module RJ71EN71

CNC C70 Built-in Ethernet port CPU Q173NCCPU

Ethernet module QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

CR800-
R(R16RTCPU)

Built-in Ethernet port CPU R16RTCPU

Ethernet module RJ71EN71
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*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*2 To use the FX3U-ENET-L or FX3U-ENET with the FX3UC, the FX2NC-CNV-IF or FX3UC-1PS-5V is required.
*3 To use FX3U-ENET-ADP, FX3U-CNV-BD, FX3U-422-BD, or FX3U-232-BD is required.
*4 Supported by the basic unit with Version 3.10. or later.
*5 The Ethernet port built in the CPU (port CPU P1 or port P2) is usable.
*6 Mount a SIL2 function module (R6PSFM) and a redundant function module (R6RFM) next to a SIL2 process CPU on the base unit.
*7 Supported by GT SoftGOT2000 (Multiple channels) only.
*8 Use firmware version 1.100 or later for the FX5-ENET and FX5-ENET/IP.

Use firmware version 1.240 or later for the FX5U, FX5UC, and FX5UJ that support the FX5-ENET or FX5-ENET/IP.
*9 To connect with a CC-Link IE TSN master/local module, use firmware version 02 for the MELSECWinCPU (MELSEC iQ-R series).

Ethernet board/card
Applicable Ethernet bords/cards are shown in the following.

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

MELSEC iQ-F Built-in Ethernet port CPU FX5U, FX5UC, FX5UJ, FX5S

Ethernet module FX5-ENET *8, FX5-ENET/IP *8

Motion module *7 FX5-40SSC-G, FX5-80SSC-G

CC-Link IE TSN master/
local module *7

FX5-CCLGN-MS

FXCPU FX3U-ENET-L*2, FX3U-ENET*2, FX3U-ENET-ADP*3*4

CR800-Q
(Q172DSRCPU)

Built-in Ethernet port CPU Q172DSRCPU

Ethernet module QJ71E71, QJ71E71-B2, QJ71E71-B5, QJ71E71-100

Manufacturer Model name Remarks
3COM EthernetLink III LAN PC Card Ethernet board/card

- Ethernet board built in the personal computer as standard Ethernet board

Item Model name
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Controller setting
Page 239 When using Built-in Ethernet port RCPU (one-to-one connection, multi-connection)
Page 243 When using Ethernet module for RCPU
Page 248 When using Built-in Ethernet port LHCPU (one-to-one connection, multi-connection)
Page 251 When using Built-in Ethernet port MELSEC iQ-F (one-to-one connection, multi-connection)
Page 254 When using Ethernet module for FX5CPU
Page 257 When using Built-in Ethernet port QCPU (one-to-one connection, multi-connection)
Page 262 When using Ethernet module for QCPU
Page 267 When using Built-in Ethernet port LCPU (one-to-one connection, multi-connection)
Page 270 When using C Controller module
Page 273 When using MELSECWinCPU (MELSEC iQ-R series)
Page 276 When using Ethernet module (QnA series)
Page 281 When using Ethernet module (A series)
Page 285 When using Ethernet module (FX series)
Page 290 When using CNC C70 (Q17nNCCPU)
Page 293 When using CC-Link IE Field Network Ethernet adapter module

Ethernet connection
 • Before Ethernet connection
Read the manual for the Ethernet module to be used thoroughly and understand it fully before setting up the 
Ethernet connection.
 • Time-out error
If many devices (including GT SoftGOT2000) are connected, line traffic may become dense, causing a time-
out error.
If a time-out error occurs, reduce the number of connected devices or increase the time-out value in the 
Communication Setup of GT SoftGOT2000.
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When using Built-in Ethernet port RCPU (one-to-one connection, multi-connection)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to Built-in Ethernet port RCPU.
The explanations are given using the following system configuration to monitor the host station.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 241 Settings in GT Designer3

■Before setting
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models

*1 The MELSEC redundant system is configurable by mounting the redundant function module (R6RFM).
*2 Mount a SIL2 function module (R6PSFM) and a redundant function module (R6RFM) next to a SIL2 process CPU on the base unit.

Compatible models
R00CPU R01CPU R02CPU R04CPU R08CPU

R16CPU R32CPU R120CPU R16MTCPU R32MTCPU

R64MTCPU R08PCPU *1 R16PCPU *1 R32PCPU *1 R120PCPU *1

R08SFCPU R16SFCPU R32SFCPU R120SFCPU R08PSFCPU *2

R16PSFCPU *2 R32PSFCPU *2 R120PSFCPU *2 R04ENCPU R08ENCPU

R16ENCPU R32ENCPU R120ENCPU CNC C80
(R16NCCPU-S1)

CR800-R
(R16RTCPU)

:5001

<GT SoftGOT2000>PLC 2

PLC 1

:1
:3
:192.168.3.18

N/W No.
PC No.
IP address
Port No. :5006 

:1
:2
:192.168.3.40

:5006 

:1
:1
:192.168.3.39

<Built-in Ethernet port RCPU>
  Other station

N/W No.
PC No.
IP address
Port No.

<Built-in Ethernet port RCPU>
  Host

N/W No.
PC No.
IP address
Port No.
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■Setting on GX Works3 (Module parameter setting)
Configure the Built-in Ethernet port setting in a target module parameter (only when multiple modules are connected).
To make communications with GX Works3, ask the person in charge of the network about the IP address setting to confirm, 
and set the IP address.
Set the other items according to the system used.
For the details of the settings, refer to the following.
GX Works3 Operating Manual
Set the IP address for PLC1 in [IP Address].

■Routing Parameter Setting
Up to 64 network numbers are settable for a target station.
However, you cannot set duplicate network numbers for one target station.
The GOT (host station) can access other networks that have the network numbers specified in the routine parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 241 Settings in GT Designer3

Item Range
[Relay Station Network No.] [1] to [239]

[Relay Station No.] [0] to [120]

[Target Station Network No.] [1] to [239]

Set the IP address of PLC1.
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■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192.  168. 3. 40
Reply from 192.168.3.40:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192.  168. 3. 40
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 To monitor CNC C80 (R16NCCPU-S1), select [RnNCCPU] for [Unit Type].
*2 If you select [MELIPC], set [Controller Type] to [MELIPC].
*3 When 0 is set in [Station], GT SoftGOT2000 (Multiple channels) can access the master station on the CC-Link IE TSN network.

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120] (When [Unit Type] is set to 
[RCPU] or [MELIPC])
[0] to [120] (When [Unit Type] is set to 
[RJ71GN11-T2/RD78G(H)]) *3

[Unit Type] Select the type of the target Ethernet module. [RCPU] *1, [MELIPC] *2, [RJ71GN11-T2/
RD78G(H)]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
MELSEC iQ-R Ethernet User's Manual (Application)

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 240 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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When using Ethernet module for RCPU
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the Ethernet 
module.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module for RCPU and GT SoftGOT2000.
Page 246 Settings in GT Designer3

■Before setting
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

N/W No.
PC No.

: 5001

Host

GT SoftGOT2000
: 1
: 3
: 192.168.3.18

N/W No.
PLC No.
IP address
Port No. : 5001

: 1
: 2
: 192.168.3.40

Other station

N/W No.
PLC No.

: 5001

: 1
: 1
: 192.168.3.39IP address

Port No.

Port No.
IP address

Ethernet module for RCPU

Ethernet module for RCPU

PLC 2

PLC 1
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■Compatible models

*1 The following shows the connectable PLC CPUs and firmware versions that support the connection with each module.

Module Model name
Ethernet module RJ71EN71(E-CCIE), RJ71EN71(E-E)

CC-Link IE TSN master/local module *1 RJ71GN11-T2

CC-Link IE TSN Plus master/local 
module*1

RJ71GN11-EIP

Motion module *1 RD78G4, RD78G8, RD78G16, RD78G32, RD78G64, RD78GHV, RD78GHW

Model Firmware version

Connecting to 
RJ71GN11-T2

Connecting to 
RJ71GN11-EIP

Connecting to RD78G4, 
RD78G8, RD78G16, RD78G32, 
or RD78G64

Connecting to RD78GHV or 
RD78GHW

R00CPU 11 or later 29 or later 12 or later 14 or later

R01CPU

R02CPU

R04CPU 43 or later 62 or later 44 or later 46 or later

R08CPU

R16CPU

R32CPU

R120CPU

R04ENCPU

R08ENCPU

R16ENCPU

R32ENCPU

R120ENCPU

R08SFCPU 20 or later Unavailable 21 or later 21 or later

R16SFCPU

R32SFCPU

R120SFCPU
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■Setting on GX Works3 (Module parameter setting)
Configure the Ethernet module (MELSEC iQ-R series) setting in a target module parameter (only when multiple modules are 
connected).
For the details of the settings, refer to the following.
GX Works3 Operating Manual
Set the IP address for PLC1 in [IP Address].

■Routing Parameter Setting
Up to 64 network numbers are settable for a target station.
However, you cannot set duplicate network numbers for one target station.
The GOT (host station) can access other networks that have the network numbers specified in the routine parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 246 Settings in GT Designer3

Item Range
[Relay Station Network No.] [1] to [239]

[Relay Station No.] [0] to [120]

[Target Station Network No.] [1] to [239]

Set the IP address of PLC1.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.6  Ethernet Connection 245



24
■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192.  168. 3. 40
Reply from 192.168.3.40:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192.  168. 3. 40
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 When 0 is set in [Station], the master station of CC-Link IE TSN can be accessed with GT SoftGOT2000 (Multiple channels).
*2 When using the CC-Link IE TSN Plus master/local module (RJ71GN11-EIP), set [Unit Type] to [RJ71GN11-T2/RD78G(H)].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120] (When [Unit Type] is set to 
[RJ71EN71])
[0] to [120] (When [Unit Type] is set to 
[RJ71GN11-T2/RD78G(H)]) *1

[Unit Type] Select the type of the target Ethernet module. [RJ71EN71], [RJ71GN11-T2/RD78G(H)]*2

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5001], [5002]

[Communication] Displays the communication method. [UDP] (for port No. 5001),
[TCP] (for port No. 5002)
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.6  Ethernet Connection



3

Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
MELSEC iQ-R Ethernet User's Manual (Application)

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 245 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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When using Built-in Ethernet port LHCPU (one-to-one connection, multi-connection)
The following shows the setting items and precautions for communication from GT SoftGOT2000 via a Built-in Ethernet port 
LHCPU.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the CPU module 
and GT SoftGOT2000.
Page 250 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
L04HCPU L08HCPU L16HCPU

L32HCPU

N/W No.
PC No.
IP address
Port No. : 5001

<GT SoftGOT2000>
: 1
: 3
: 192.168.3.18

N/W No.
PC No.
IP address
Port No. : 5006

: 1
: 2
: 192.168.3.40

N/W No.
PC No.
IP address
Port No. : 5006

: 1
: 1
: 192.168.3.39

<Built-in Ethernet port 
  LHCPU> Other station

<Built-in Ethernet port 
  LHCPU> Host

PLC 2

PLC 1
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■Setting on GX Works3 (Module parameter setting)
Configure the Built-in Ethernet port setting in a target module parameter (only when multiple modules are connected).
To make communications with GX Works3, ask the person in charge of the network about the IP address setting to confirm, 
and set the IP address.
Set the other items according to the system used.
For the details of the settings, refer to the following.
GX Works3 Operating Manual
Set the IP address for PLC1 in [IP Address].

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>Ping 192. 168. 3. 39
Reply from 192.168.3.39: bytes=32 time<1ms TTL=32
When connections are not good
C:\>Ping 192. 168. 3. 39
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

Set the IP address of PLC1.
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select the type of the target Ethernet module. [LHCPU]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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When using Built-in Ethernet port MELSEC iQ-F (one-to-one connection, multi-
connection)
The following shows the setting items and precautions for communication from GT SoftGOT2000 via a Built-in Ethernet port 
MELSEC iQ-F.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the CPU module 
and GT SoftGOT2000.
Page 253 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
FX5U FX5UC FX5UJ FX5S

N/W No.
PC No.
IP address
Port No. :5562 (Fixed)

:1
:2
:192.168.3.251

<Built-in Ethernet port 
  MELSEC iQ-F> Other station

:5001

<GT SoftGOT2000>

:1
:3
:192.168.3.18

N/W No.
PC No.
IP address
Port No.

:5562 (Fixed)

:1
:1
:192.168.3.250

N/W No.
PC No.
IP address
Port No.

<Built-in Ethernet port 
  MELSEC iQ-F> Host

PLC 2

PLC 1
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■Setting on GX Works3 (Module parameter setting)
Configure the Built-in Ethernet port setting in a target module parameter (only when multiple modules are connected).
To make communications with GX Works3, ask the person in charge of the network about the IP address setting to confirm, 
and set the IP address.
Set the other items according to the system used.
For the details of the settings, refer to the following.
GX Works3 Operating Manual
Set the IP address for PLC1 in [IP Address].

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192.  168. 3. 251
Reply from 192.168.3.251:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192.  168. 3. 251
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

Set the IP address of PLC1.
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select the type of the target Ethernet module. [FX5CPU]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5562]

[Communication] Displays the communication method. [TCP]
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When using Ethernet module for FX5CPU
The following shows the setting items and precautions for communication from GT SoftGOT2000 via an Ethernet module for 
FX5CPU.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Example) Connection via the FX5-CCLGN-MS

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the CPU module 
and GT SoftGOT2000.
Page 256 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
 • Use a switching hub.
 • Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
 • Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Module Model name
Ethernet module FX5-ENET, FX5-ENET/IP

Motion module FX5-40SSC-G, FX5-80SSC-G

CC-Link IE TSN master/local module FX5-CCLGN-MS

N/W No.
PC No.
IP address
Port No. :5001

:1
:2
:192.168.3.251

Ethernet module for FX5CPU
Other station

:5001

<GT SoftGOT2000>

:1
:3
:192.168.3.18

N/W No.
PC No.
IP address
Port No.

:5001

:1
:1
:192.168.3.250

N/W No.
PC No.
IP address
Port No.

Ethernet module for FX5CPU
Host

PLC 2

PLC 1
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■Setting on GX Works3 (Module parameter setting)
Configure the Ethernet module (MELSEC iQ-F series) setting in a target module parameter (only when multiple modules are 
connected).
To make communications with GX Works3, ask the person in charge of the network about the IP address setting to confirm, 
and set the IP address.
Set the other items according to the system used.
For the details of the settings, refer to the following.
GX Works3 Operating Manual
Set the IP address for PLC1 in [IP Address].

■Setting on the personal computer
Set the IP address.

Set the IP address of PLC1.

When connecting GT SoftGOT2000 to the 
FX5-ENET or FX5-ENET/IP

When connecting GT SoftGOT2000 to the FX5-CCLGN-MS

When connecting GT SoftGOT2000 to the 
FX5-40SSC-G or FX5-80SSC-G
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■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192.  168. 3. 251
Reply from 192.168.3.251:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192.  168. 3. 251
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 The following shows the setting range.

■Setting on GT SoftGOT2000
Communication setup
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. *1

[Unit Type] Select the type of the target Ethernet module. [FX5-CCLGN-MS/FX5-nSSC-G], [FX5-ENET]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. *1

[Communication] Displays the communication method. *1

[Unit Type] [Station] [Port No.] [Communication]
[FX5-CCLGN-MS/FX5-nSSC-G] [0] to [120] [5001] [UDP]

[5554] [TCP]

[FX5-ENET] [1] to [120] [5554] [TCP]

[5555] [UDP]
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When using Built-in Ethernet port QCPU (one-to-one connection, multi-connection)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to Built-in Ethernet port QCPU.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 260 Settings in GT Designer3

■Before setting
 • Monitoring the CPUs on other networks
Monitoring the CPUs on other networks requires the routing parameter to be set.
Refer to the following for how to set the routing parameters.
Page 259 Routing Parameter Setting
Page 260 Settings in GT Designer3
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

:5001

<GT SoftGOT2000>

:1
:3
:192.168.0.18

N/W No.
PC No.
IP address
Port No. :5006

:1
:1
:192.168.0.1

:5006

:1
:2
:192.168.0.2

<Built-in Ethernet port QCPU>
  Other station

N/W No.
PC No.
IP address
Port No.

<Built-in Ethernet port QCPU>
  Host

N/W No.
PC No.
IP address
Port No.
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■Compatible models

■Setting on GX Works2/GX Developer (Q parameter setting)
Set the Built-in Ethernet port for the Q parameter setting. (multi-connection only)

Compatible models
Q03UDECPU Q04UDEHCPU Q06UDEHCPU Q10UDEHCPU Q13UDEHCPU

Q20UDEHCPU Q26UDEHCPU Q50UDEHCPU Q100UDEHCPU

Q03UDVCPU Q04UDVCPU Q06UDVCPU Q13UDVCPU Q26UDVCPU

Item Setting Screen Examples
[Built-in Ethernet port setting]

[Open settings]

To make communications with GX Works2/GX Developer, ask the person in charge of the network about the IP address 
setting to confirm, and set the IP address.
Set the other items according to the specifications of the nodes or applications connected to an Ethernet module.
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■Routing Parameter Setting
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 260 Settings in GT Designer3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

Item Range
[Transfer Network No.] [1] to [239]

[Relay Network No.] [1] to [239]

[Relay Station No.] [0] to [120]
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 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [QnUD(P)V/QnUDEH]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
Q Corresponding Ethernet Interface Module User's Manual (Application)

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 259 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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When using Ethernet module for QCPU
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the Ethernet 
module.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 265 Settings in GT Designer3

■Before setting
 • Monitoring the CPUs on other networks
Monitoring the CPUs on other networks requires the routing parameter to be set.
For the routing parameter setting, refer to the following.
Page 264 Routing Parameter Setting
Page 265 Settings in GT Designer3
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
QJ71E71-100, QJ71E71-B5, QJ71E71-B2, QJ71E71, LJ71E71-100

N/W No.
PC No.

: 5001

Host

GT SoftGOT2000
: 1
: 3
: 192.168.0.3

N/W No.
PLC No.
IP address
Port No. : 5001

: 1
: 1
: 192.168.0.1

Other station

N/W No.
PLC No.

: 5001

: 1
: 2
: 192.168.0.2IP address

Port No.

Port No.
IP address

Ethernet module

Ethernet module
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■Setting on GX Works2/GX Developer (Network parameter setting)
Parameter setting can be made from the MELSECNET/ETHERNET network parameter setting screen.
Set the network type, first I/O No., network No., group No., station number, mode and operation setting.

Item Setting Screen Examples
[Ethernet Parameters]

[Operation Setting]

To make communications with GX Works2/GX Developer, ask the person in charge of the network about the IP address 
setting to confirm, and set the IP address.
Set the other items according to the specifications of the nodes or applications connected to an Ethernet module 
compatible with QCPU or LCPU.
The following are the operation setting items that can be set on GX Works2 or GX Developer.
[Communication data code]: The binary code or ASCII code is available.
[Initial timing]: Communications can be made from GX Works2 or GX Developer even when the PLC CPU is in the STOP 
status.
[Enable Write at RUN time]: The online change or device test can be performed with GX Works2 or GX Developer.
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■Routing Parameter Setting
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 265 Settings in GT Designer3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Item Range
[Transfer Network No.] [1] to [239]

[Relay Network No.] [1] to [239]

[Relay Station No.] [0] to [120]
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Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [QJ71E71/LJ71E71]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5001], [5002]

[Communication] Displays the communication method. [UDP] (for port No. 5001),
[TCP] (for port No. 5002)
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
Q Corresponding Ethernet Interface Module User's Manual (Application)

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 264 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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When using Built-in Ethernet port LCPU (one-to-one connection, multi-connection)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to Built-in Ethernet port LCPU.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the CPU module 
and GT SoftGOT2000.
Page 269 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different sstation number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
L02CPU, L06CPU, L26CPU, L26CPU-BT, L02CPU-P,

L06CPU-P, L26CPU-P, L26CPU-PBT

N/W No.: 1
PC No.: 3
IP address: 192.168.0.18
Port No.: 5001

<GT SoftGOT2000>

N/W No.: 1
PC No.: 1
IP address: 192.168.0.1
Port No.: 5006

N/W No.: 1
PC No.: 2
IP address: 192.168.0.2
Port No.: 5006

<Built-in Ethernet
 port LCPU> Other station 

<Built-in Ethernet
 port LCPU> Host station 
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■Setting on GX Works2/GX Developer (L parameter setting)
Set the Built-in Ethernet port for the L parameter setting. (multi-connection only)

■Setting on the personal computer
Set the IP address.

Item Setting Screen Examples
[Built-in Ethernet port setting]

To make communications with GX Works2/GX Developer, ask the person in charge of the network about the IP address 
setting to confirm, and set the IP address.
Set the other items according to the specifications of the nodes or applications connected to an Ethernet module.

[Open settings]
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■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [LCPU]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

When using C Controller module
For communications with GT SoftGOT2000 via C Controller module, setting items and precautions are described below.
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of C Controller 
module and GT SoftGOT2000.
Page 272 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
GT SoftGOT2000 cannot monitor CPUs on the other networks.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
R12CCPU-V, Q12DCCPU-V, Q24DHCCPU-V, Q24DHCCPU-LS Q26DHCCPU-LS

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:1
:3
:192.168.0.3

N/W No.
PC No.
IP address
Port No. :5006

:1
:1
:192.168.0.1

N/W No.
PC No.
IP address
Port No. :5006

:1
:2
:192.168.0.2

<C Controller module> Other station

<C Controller module> Host
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■Setting on C Controller module setting utility (Parameter setting)
Set the parameter on C Controller module setting utility.
Use SW3PVC-CCPU-J Ver.3.05F or later for the C Controller module setting utility.
For details of the C Controller module setting utility, refer to the following manual.
 C Controller Module User's Manual (Utility Operation, Programming)

Item Setting Screen Examples
[Connection settings]

If the IP address of the C controller module has been changed, input the changed IP address or host name.
If the account of the C controller module has been changed, input the changed user name and password.

[Online operation]

[Detailed settings]

[System settings]
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■Setting on personal computer
Set the IP address.

■Communications check
 • Ping test
When C Controller module is ready for communications, execute the Ping command with the command prompt of Windows.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 Set the same value as that of GOT Net No.
*2 Set a value different from that of the GOT PLC No. and the PLC No. of other PLCs on the same network.

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target C Controller module. [1] to [239] *1

[Station] Set the station number of the target C Controller module. [1] to [120] (when [RnCCPU/RnWCPU] is selected for [Unit Type])*2

[1] to [64] (when [QnD(H)CCPU] is selected for [Unit Type])*2

[Unit Type] Select the type of the target C Controller module. [RnCCPU/RnWCPU]
[QnD(H)CCPU]

[IP Address] Set the IP address of the target C Controller module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target C Controller module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.6  Ethernet Connection



3

When using MELSECWinCPU (MELSEC iQ-R series)
Supported by GT SoftGOT2000 (Multiple channels) only.
The following shows the setting items and precautions for communication from GT SoftGOT2000 via a MELSECWinCPU 
(MELSEC iQ-R series).
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the 
MELSECWinCPU (MELSEC iQ-R series) and GT SoftGOT2000.
Page 275 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
R102WCPU-W

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:1
:3
:192.168.3.18

N/W No.
PC No.
IP address
Port No. :5006

:1
:1
:192.168.3.3

N/W No.
PC No.
IP address
Port No. :5006

:1
:2
:192.168.3.4

<MELSECWinCPU (MELSEC iQ-R series)> 
Other station

<MELSECWinCPU (MELSEC iQ-R series)> 
Host

Communication :UDP

Communication :UDP

Communication :UDP

PLC1

PLC2
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■[Internet Protocol Version 4 (TCP/IPv4) Properties]
The communication settings of the MELSECWinCPU (MELSEC iQ-R series) can be configured from [Internet Protocol 
Version 4 (TCP/IPv4) Properties] of Windows installed on the MELSECWinCPU (MELSEC iQ-R series).

○: Required, ×: Not required

*1 Set an IP address which corresponds to the CH number used for connection with GT SoftGOT2000.

■Firewall setting
To connect with the MELSECWinCPU (MELSEC iQ-R series), configure the firewall setting.
For the details, refer to the following.
MELSEC iQ-R MELSECWinCPU Module User's Manual

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192.  168. 3. 3
Reply from 192.168.3.3:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192.  168. 3. 3
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3 Version1

Item*1 Set value Setting (with GT SoftGOT2000 
connected)1 2

[IP address] 192.168.3.3 192.168.3.4 ○

[Subnet mask] 255.255.255.0 255.255.255.0 ○

[Default gateway] - - ×

[Preferred DNS server] - - ×

[Alternate DNS server] - - ×
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 Set the same value as that of GOT Net No.
*2 Set a value different from that of the GOT PLC No. and the PLC No. of other PLCs on the same network.

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target MELSECWinCPU (MELSEC iQ-R series). [1] to [239]*1

[Station] Set the network number of the target MELSECWinCPU (MELSEC iQ-R series). [1] to [120]*2

[Unit Type] Select the type of the target MELSECWinCPU (MELSEC iQ-R series). [RnCCPU/RnWCPU]

[IP Address] Set the IP address of the target MELSECWinCPU (MELSEC iQ-R series). [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target MELSECWinCPU (MELSEC iQ-R series). [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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When using Ethernet module (QnA series)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the Ethernet 
module (QnA series).
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 279 Settings in GT Designer3

■Before setting
 • Monitoring the CPUs on other networks
Monitoring the CPUs on other networks requires the routing parameter to be set.
For the routing parameter setting, refer to the following.
Page 278 Routing Parameter Setting
Page 279 Settings in GT Designer3
 • Precautions for communication
Only communications within the same segment are applicable.
No communications via a router or gateway can be monitored.
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

<GT SoftGOT2000>

<QE71> Host
N/W No.   

    PLC No.    
: 1
: 2 
: 192.168.0.2
: 5001 (Fixed)

<QE71> Other station
N/W No.   

    

Port No.
IP address
PLC No.    

: 1
: 1 
: 192.168.0.1
: 5001 (Fixed)

N/W No.   
    PC No.    

: 1
: 3 
: 192.168.0.3
: 5001

Port No.
IP address

Port No.
IP address

Ethernet module (QnA series)

Ethernet module (QnA series)
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■Compatible models

*1 When using AJ71QE71, AJ71QE71-B5, A1SJ71QE71-B2 or A1SJ71QE71-B5, use a module or PLC CPU of function version B or later.

■Ethernet module (QnA series) switch settings
Operation mode setting switch: 0 (online)
Automatic start mode: SW3 ON
When SW3 is ON, initial processing is performed independently of Y19 (initial processing request). Communications are also 
enabled if the CPU module is stopped.
For the initial processing using Y19 (initial processing request), create the program for initial processing while referring to the 
"For QnA Ethernet Interface Module User's Manual".

■Setting on GX Works2/GX Developer (Network parameter setting)
On the MELSECNET/Ethernet setting screen of network parameter, set the network type, starting I/O No., network No., group 
No., station number and IP address.

Compatible models *1

AJ71QE71N3-T, AJ71QE71N-B5, AJ71QE71N-B2, AJ71QE71N-T, AJ71QE71N-B5T,

AJ71QE71, AJ71QE71-B5, A1SJ71QE71N3-T, A1SJ71QE71N-B5, A1SJ71QE71N-B2,

A1SJ71QE71N-T, A1SJ71QE71N-B5T, A1SJ71QE71-B5, A1SJ71QE71-B2

Item Setting screen example
[Ethernet Parameters]

[IP Address Setting]
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■Routing Parameter Setting
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 279 Settings in GT Designer3

■Setting on the personal computer
Set the IP address.

Item Range
[Transfer Network No.] [1] to [239]

[Relay Network No.] [1] to [239]

[Relay Station No.] [0] to [120]
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■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [AJ71QE71]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5001]

[Communication] Displays the communication method. [UDP]
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
For QnA Ethernet Interface Module User's Manual

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 278 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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When using Ethernet module (A series)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the Ethernet 
module (A series).
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.

Setting items
The N/W No. and PLC No. to be specified for Ethernet connection to the E71 should be those set as desired 
on GT Designer3.
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 284 Settings in GT Designer3

The following shows the procedure for performing communications via E71.

■Before setting
 • Monitoring precautions
The connection target cannot be monitored via MELSECTNET/10 or MELSECNET/H.
 • Communication precautions
Only communications within the same segment can be monitored.
No communications via a router or gateway can be monitored.
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
AJ71E71N3-T, AJ71E71N-B5, AJ71E71N-B2, AJ71E71N-T, AJ71E71N-B5T,

AJ71E71-S3, A1SJ71E71N3-T, A1SJ71E71N-B5, A1SJ71E71N-B2, A1SJ71E71N-T,

A1SJ71E71N-B5T, A1SJ71E71-B5-S3, A1SJ71E71-B2-S

<GT SoftGOT2000>

<E71> Host
N/W No. : 1

    

Port No. : 5001
IP address : 192.168.0.2
PLC No. : 2 

<E71> Other station
N/W No.  : 1

    

Port No. : 5001 
IP address : 192.168.0.1
PLC No.     : 1

N/W No. : 1
    

Port No. : 5001
IP address : 192.168.0.3
PC No. : 3

Ethernet module (A series)

Ethernet module (A series)
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■E71 switch settings

■Sequence programs
Initial processing and communication line open processing sequence programs are needed.
Necessary communication parameters and sequence program examples are given below.
 • Communication parameters
The following are the communication parameter setting examples for the host side.

*1 Value specified for application setting
The user can change the settings of 1), 2) and 3).
4), 5) and 6) are fixed settings.
The following shows details of the application setting.

1):   Fixed buffer application
0: For send/no communication
1: For receive
2):   Existence check
0: No
1: Yes
3):   Paring open
0: No
1: Yes
4):   Communication system (Set to 1: UDP/IP)
0: TCP/IP
1: UDP/IP
5):   Fixed buffer communication (Set to 0: With procedure)
0: With procedure
1: Without procedure
6):   Open system (Set to 00: Active, UDP/IP)
00: Active, UDP/IP
10: Unpassive
11: Fullpassive

*2 The other node port number is a fixed setting.
The user can change the other settings.

Switch AJ71E71N3-T,AJ71E71N-B5,AJ71E71N-
B2,AJ71E71N-T,AJ71E71N-B5T,AJ71E71-
S3,A1SJ71E71N3-T,A1SJ71E71N-
B5,A1SJ71E71N-B2,A1SJ71E71N-
T,A1SJ71E71N-B5T

A1SJ71E71-B2-S3, A1SJ71E71-B5-S3

Operation mode setting switch 0 (Online mode) 0 (Online mode)

Exchange condition 
setting switch

Data code setting SW2    OFF (Binary code) SW2    OFF (Binary code)

CPU exchange timing 
setting

SW7    ON (Online change enabled) SW3    ON (Online change enabled)

Setting item Set value
Application setting *1 100H

IP address of E71 192.168.0.2

E71 port number 5001

IP address of other node FFFFFFFFH

Other node port number *2 FFFFH

b12b15 b14 b13 b11 b10 b9 b8 b7 b6 b5 b4 b3 b2 b1 b0

0 0 0 0 0 0 0 1 0 0 0 0 0 0 0 0

5)6) 1)2)3)4)
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 • Sequence program
In a communications-ready status, the E71's RUN LED comes on and RDY LED flickers.

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

IP address of Ethernet 
module(192.168.0.2)

Initial request

COM. ERR turned off request

Clear the initial fault code.

Set to the permit of 
communication while stopping 
the PLC CPU.

Communication 
format(UDP/IP)

Port No. of Ethernet 
module(5001)

IP address of GT SoftGOT
(When GT SoftGOT is used, 
FFFFFFFFH)
Port No. of GT SoftGOT 
(When GT SoftGOT is used, 
FFFFH)

Read the initial fault code.

Request to open

Normal 
completed 
initial

No. 1 
open 
completed

Initial request

COM. 
ERR 
turned off 
command

Initial 
fault 
detection

WDT ERR 
detection

Turned on 
at first scan 
only while 
running

WDT
ERR 
detection

* Initial processing

* Opening processing of communication line 
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 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [AJ71QE71]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [1024] to [65534]

[Communication] Displays the communication method. [UDP]
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When using Ethernet module (FX series)
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the Ethernet 
module (FX series).
This section explains the system configuration to monitor the host as shown below.
When monitoring other stations, follow the same procedure as the host.
 • For FX3U-ENET-L

 • For FX3U-ENET

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the Ethernet 
module and GT SoftGOT2000.
Page 289 Settings in GT Designer3

<GT SoftGOT2000>

<FX3U-ENET-L> Host station
N/W No.   

Port No.
IP address
PC No.    

: 1
: 2 
: 192.168.0.2
: 5551 or 5556

<FX3U-ENET-L> Other station
N/W No.   

Port No.
IP address
PC No.    

: 1
: 1 
: 192.168.0.1
: 5551 or 5556

N/W No.   

Port No. 
IP address
PC No.    

: 1
: 3 
: 192.168.0.3
: 5001

Ethernet module
(FX series)

Ethernet module
(FX series)

<GT SoftGOT2000>

<FX3U-ENET> Host station
N/W No.   

Port No.
IP address
PC No.    

: 1
: 2 
: 192.168.0.2
: 5551 (Fixed)

<FX3U-ENET> Other station
N/W No.   

Port No.
IP address
PC No.    

: 1
: 1 
: 192.168.0.1
: 5551 (Fixed)

N/W No.   

Port No. 
IP address
PC No.    

: 1
: 3 
: 192.168.0.3
: 5001

Ethernet module
(FX series)

Ethernet module
(FX series)
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.6  Ethernet Connection 285



28
■Before setting
 • Precautions for monitoring
The CPUs on other networks cannot be monitored.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
FX3U-ENET-L FX3U-ENET FX3U-ENET-ADP
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■Setting with FX Configurator-EN-L or FX Configurator-EN (Network parameter setting)
Set the Ethernet parameter using FX Configurator-EN-L or FX Configurator-EN.
To use FX Configurator-EN-L, GX-Developer Ver.8.88S or later is required.
For the details of the FX Configurator-EN-L, refer to the following manual.
FX Configurator-EN-L Operation Manual
To use FX Configurator-EN, GX-Developer Ver.8.25B or later is required.
For the details of the FX Configurator-EN, refer to the following manual.
FX Configurator-EN Operation Manual

■Setting on the personal computer
Set the IP address.

Item Setting Screen Examples
[Ethernet Module settings]

Set the Ethernet station No. in the Ethernet module setting.
Set the station No. of the Ethernet module not to overlap with the station No. of GT SoftGOT2000.

[Operation settings]

Since the port No. 5551 is used, the operation, regardless of the settings, is as follows.
• Communication data code setting: [Binary code]
• Initial timing: [Always wait for OPEN] (Communication is applicable while stopping the PLC CPU.)

[Open settings]
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■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on Windows.
When connections are OK
C:\>ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
You can run a ping test using FX Configurator-EN-L or FX Configurator-EN.
For details of the ping test, refer to the following.
FX Configurator-EN-L Operation Manual
FX Configurator-EN Operation Manual

 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [FX]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. FX3U-ENET-L, FX3U-ENET: [5551]
FX3U-ENET-ADP: [5556]

[Communication] Displays the communication method. [TCP]
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When using CNC C70 (Q17nNCCPU)
For communications with GT SoftGOT2000 via the Display I/F of the CNC C70, setting items and precautions are described 
below.
This section explains the system configuration to monitor the host as shown below.

Before creating Display I/F connection
 • Display I/F connection
For the Display I/F connection, read the following manual carefully, and fully understand the details.
C70 Setup Manual
 • Setting items
Refer to the following for how to set the Net No., IP address, and port No. of the CNC C70 and GT 
SoftGOT2000.
Page 292 Settings in GT Designer3

■Before setting
 • Precautions for monitoring
GT SoftGOT2000 cannot monitor CPUs on the other networks.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
Q173NCCPU

N/W No.
PC No.
IP address
Port No. : 5001

<GT SoftGOT2000>

: 1
: 3
: 192.168.0.18

N/W No.
PC No.
IP address
Port No. : 5001

: 1
: 2
: 192.168.0.19

<Q17nNC> Host
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■Setting with remote monitor tool (IP address setting)

○: Required    : Set if necessary   ×: Not required

■Setting on personal computer
Set the IP address.

■Communication check
 • Ping test
The INIT.LED of the CNC C70 turns on when the CNC C70 is ready for communications.
When the CNC C70 is ready for communications, execute the Ping command with the command prompt of Windows.
When the Ping test is verified
C:\>Ping  192. 168. 0. 19
Reply from 192.168.0.19:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping  192. 168. 0. 19
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

Item Setting Setting
(with GOT connected)

[IP address] [192.168.0.19] ○

[Subnet mask] [255.255.255.0] ○

[Gateway address] [0.0.0.0] ○

[Port number] [64758] ○

[Speed auto/10M] [0] ○
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [Q17nNC]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5001], [5002]

[Communication] Displays the communication method. [UDP] (for port No. 5001),
[TCP] (for port No. 5002)
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When using CC-Link IE Field Network Ethernet adapter module
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the PLC CPU via the CC-Link IE 
Field Network Ethernet adapter module.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the CC-Link IE 
Field Network Ethernet adapter module and GT SoftGOT2000.
Page 296 Settings in GT Designer3

The following shows the procedure for communicating GT SoftGOT2000 to the PLC CPU via the CC-Link IE Field Network 
Ethernet adapter module.

■Before setting
 • Precautions for monitoring
The GOT cannot monitor the host station.
 • Monitoring the CPUs on other networks
Monitoring the CPUs on other networks requires the routing parameter to be set.
For the routing parameter setting, refer to the following.
Page 294 Routing Parameter Setting
Page 296 Settings in GT Designer3
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models
Compatible models
NZ2GF-ETB

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:3
:1
:192.168.3.18

Network type
N/W No.
PC No.
Total stations :2

:CC IE Field (Master station)
:1
:0

<CC-Link IE Field Network Master/Local Module>

<CC-Link IE Field Network Master/Local Module>

HUB

IP address
N/W No.
Station No.

:192.168.3.30
:3
:30

<Ethernet adapter unit>

Network type
N/W No.
PC No.

:CC IE Field (Local station)
:1
:2

Ethernet

CC-Link IE 
Field 
Network

Port No. :5001
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■Setting on GX Works2/GX Developer (Network parameter setting)
Parameter setting can be made from the Ethernet/CC IE/MELSECNET network parameter setting screen.
Set the network type, network No., total stations and station number.

■Routing Parameter Setting
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting for the request source
The GOT at the request source also requires the routing parameter setting.
For the setting, refer to the following.
Page 296 Settings in GT Designer3

Item Setting Screen Examples
[Ethernet parameter]

Setting item Range
[Transfer Network No.] [1] to [239]

[Relay Network No.] [1] to [239]

[Relay Station No.] [0] to [120]
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■Parameter setting
Set the parameter with the Ethernet adapter unit setting tool.
For details of the Ethernet adapter unit setting tool, refer to the following manual.
 CC-Link IE Field Network Ethernet Adapter Module User's Manual

■Setting on personal computer
Set the IP address.

■Communications check
 • Ping test
When C Controller module is ready for communications, execute the Ping command with the command prompt of Windows.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

Ping test
The ping test can also be performed with GX Developer (SW6D5C-GPPW 6.01B or later).
For details of the ping test, refer to the following.
GX Developer Version□ Operating Manual

Item Setting Screen Examples
[CC-Link IE Field Network Setting]

For the network No., set the same value as the setting on the PLC side.
For the station No., set a value other than the setting on the PLC side.

[Ethernet Setting]

Set the IP address within the following range.

192.168. 3. 30

Set the fourth octet within the range from 1 to 64.

Set the third octet within the range from 1 to 239.
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 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 Set according to the third octet (network No.) of the Ethernet adapter unit IP address.
*2 Set according to the fourth octet (PC No.) of the Ethernet adapter unit IP address.
*3 Set according to the Ethernet adapter unit IP address.

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] *1 Set the network number of the CC-Link IE Field Network Ethernet adapter 
module.

[1] to [239]

[Station] *2 Set the station number of the CC-Link IE Field Network Ethernet adapter module. [1] to [64]

[Unit Type] Select the type of the CC-Link IE Field Network Ethernet adapter module. [NZ2GF-ETB]

[IP Address] *3 Set the IP address of the CC-Link IE Field Network Ethernet adapter module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the CC-Link IE Field Network Ethernet adapter module. [5001], [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5001 or 5006),
[TCP] (for port No. 5007)
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.

For the details of the routing parameter setting, refer to the following.
Q Corresponding Ethernet Interface Module User's Manual (Application)

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Page 294 Routing Parameter Setting

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Setting item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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Precautions

Controller port
A communication module is required for a PLC having no built-in Ethernet port.

Communication load due to the increased number of devices connected
The increased number of connected devices may increase the load on the communication, affecting the communication 
performance.

Duplication of the port number
To use multiple GT SoftGOT2000 modules or use GT SoftGOT2000 with another MELSOFT application, set different port 
numbers for them.
If the same port No. is specified, a communication timeout may occur, interrupting monitoring.

Setting the same number for the PLC and station numbers
Set different numbers for [PC No.] in the [Communication Setup] dialog of GT SoftGOT2000 and [Station] in [Connected 
Ethernet Controller Setting] in the [Controller Setting] window of GT Designer3.
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3.7 Direct CPU connection (RS-232, USB)
System configurations

PLC Connection 
cable

Max. distance GT 
SoftGOT2000

Number of connectable devices 
*2

Model name Communication 
type

RCPU USB USB 1)
USB 4)
USB 6)

3m Windows-
compatible 
personal 
computer
PC CPU module
MELIPC*4

1

LHCPU USB USB 1)
USB 4)
USB 6)

3m 1

QCPU (Q mode) RS-232
USB

RS-232 1)
USB 1)
USB 2)
USB 3)
USB 4)
USB 5)

RS-232:3m
USB:3m

1
(2 units are connectable when using 
both RS-232 and USB connections.)

QCPU (A mode) RS-232 RS-232 1) 3m 1

C Controller module RS-232 (via a QCPU in the multiple CPU system)
USB (same as QCPU (Q mode))

QSCPU USB USB 5) 3m Windows-
compatible 
personal 
computer
PC CPU module
MELIPC*4

1

LCPU RS-232
USB

RS-232 1)
USB 1)
USB 2)

RS-232:3m
USB:3m

1
(2 units are connectable when using 
both RS-232 and USB connections.)

QnACPU RS-422 RS-422 1) 15m 1

ACPU RS-422 RS-422 1) 15m 1

MELSEC iQ-F RS-232 RS-232 2) 4.5m 1
(2 units are connectable when using 
both RS-232 and USB connections.)

USB *5 USB 1)
USB 3)
USB 6)

3m

FXCPU RS-232
RS-422

RS-232 2)
RS-422 1)
RS-422 2)*6

RS-232:4.5m
RS-422:4.5m

1
(2 units are connectable when using 
both RS-232 and USB connections.)

USB *3 USB 1) 3m

Motion CPU MELSEC iQ-R 
series

USB USB 1)
USB 4)
USB 6)

5m 1
(2 units are connectable when using 
both RS-232 and USB connections.)

Q series *1 RS-232
USB

RS-232 1)
USB 1)
USB 2)
USB 3)
USB 4)
USB 5)

RS-232:3m
USB:3m

A series RS-422 RS-422 1) 15m 1

MELSECNET/H remote I/O station RS-232 RS-232 1) 3m 1

CC-Link IE Field Network head unit USB USB 1)
USB 2)

3m 1

CNC C80 Access the controller via an RCPU in the multiple CPU system.

CR800-R (R16RTCPU)

PLC CPU GT SoftGOT2000

Connection cable
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*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*2 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*3 The USB connection is available for the following.

FX3G series
FX3GC series
FX3GE series
FX3S series

*4 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.
*5 The USB connection is available for FX5UJ only.
*6 Use a USB/RS-422 converter and function extension board to connect the personal computer and the FXCPU with a USB cable.

CNC C70 Access the CPU via a QCPU in the multiple CPU system.

CRnQ-700

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

PLC Connection 
cable

Max. distance GT 
SoftGOT2000

Number of connectable devices 
*2

Model name Communication 
type
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Connection cable

RS-232 1)
■MITSUBISHI SYSTEM & SERVICE product

*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*2 The adapter L6ADP-R2 is required for the connection with LCPU.

RS-232 2)
■MITSUBISHI SYSTEM & SERVICE product

Use the cables to connect to the function extension board or function adaptor of MELSEC iQ-F and FXCPU.
The following table shows the available communication types.

■The following communication types are available in the GT01-C30R2-9S.

RS-232 cable *1*2

RS-232 cable

Model name Function expansion board Function adapter PC side connector
FX5U
FX5UJ

FX5-232-BD - 9-pin D-sub

FX5U
FX5UC
FX5UJ

- FX5-232ADP 9-pin D-sub

FX3U series,
FX3UC series
(FX3UC-□□-LT)

FX3U-232-BD - 9-pin D-sub

FX3U-232-BD, FX3U-485-BD,
FX3U-422-BD, FX3U-USB-BD,
FX3U-CNV-BD

FX3U-232ADP, FX3U-232ADP-MB

FX3UC series
(FX3UC-□□/D,
FX3UC-□□/DSS)

- FX3U-232ADP, FX3U-232ADP-MB 9-pin D-sub

FX3S series FX3G-232BD - 9-pin D-sub

- FX3S-CNV-ADP + FX3U-232ADP, FX3U-232ADP-MB 9-pin D-sub

FX3G series FX3G-232BD - 9-pin D-sub

- FX3S-CNV-ADP + FX3U-232ADP, FX3U-232ADP-MB

FX3GC series - FX3U-232ADP, FX3U-232ADP-MB 9-pin D-sub

FX3GE series FX3G-232BD FX3U-232ADP 9-pin D-sub

FX2N series FX2N-232-BD - 9-pin D-sub

FX2N-CNV-BD FX2NC-232ADP

FX1NC,
FX2NC series

- FX2NC-232ADP 9-pin D-sub

FX1S, FX1N series FX1N-232-BD - 9-pin D-sub

FX1N-CNV-BD FX2NC-232ADP

Controller: MINI-DIN 6-pin Personal computer: D-sub 9-pin

GT01-C30R2-6P (3m) 

GT01-C30R2-9S(3m)

GT01-C30R2-25P(3m)
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■The following communication types are available in the GT01-C30R2-25P.
Model name Function expansion board Function adapter PC side connector
FX3U series,
FX3UC series
(FX3UC-□□-LT)

FX3U-232-BD - 25-pin D-sub

FX3U-232-BD, FX3U-485-BD,
FX3U-422-BD, FX3U-USB-BD,
FX3U-CNV-BD

FX3U-232ADP, FX3U-232ADP-MB

FX3UC series
(FX3UC-□□/D,
FX3UC-□□/DSS)

- FX3U-232ADP, FX3U-232ADP-MB 25-pin D-sub

FX3S series FX3G-232BD - 25-pin D-sub

- FX3S-CNV-ADP + FX3U-232ADP, FX3U-232ADP-MB

FX3G series FX3G-232BD - 25-pin D-sub

- FX3S-CNV-ADP + FX3U-232ADP, FX3U-232ADP-MB

FX3GC series - FX3U-232ADP, FX3U-232ADP-MB 25-pin D-sub

FX3GE series FX3G-232BD FX3U-232ADP 25-pin D-sub

FX2N series FX2N-CNV-BD FX0N-232ADP 9-pin D-sub

FX2N-232-BD - 25-pin D-sub

FX2N-CNV-BD FX2NC-232ADP

FX1NC,
FX2NC series

- FX0N-232ADP 9-pin D-sub

- FX2NC-232ADP 25-pin D-sub

FX1S, FX1N series FX1N-CNV-BD FX0N-232ADP 9-pin D-sub

FX1N-232-BD - 25-pin D-sub

FX1N-CNV-BD FX2NC-232ADP
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RS-422 1)
■MITSUBISHI ELECTRIC product

*1 A straight cable for conversion between 9-pin D-sub and 25-pin D-sub is required separately.
*2 How to distinguish products compatible with QnACPU, ACPU.

Check the model name label of the cable. (Incompatible cables cannot be used.)

*3 When connecting the FX-232AWC-H to the FX3UC/FX3UCPU, transmission speed of 9600/19200/38400/57600/115200 bps is 
available.
When connecting the FX-232AWC or FX-232AW, either of transmission speed of 9600/19200bps is available.

RS-422 2)
■MITSUBISHI ELECTRIC product

*1 Drivers respectively stored in the CD-ROMs included in the FX-USB-AW and FX3U-USB-BD must be installed on the personal 
computer for using the converters.
(The converters can be used by assigning the USB-serial conversion driver to the COM number.)

PLC CPU Side(RS-422 cable) RS-232/RS-422 
Converter *3

PC side (RS-232 cable)

USB/RS-422 converter and function extension board Personal computer side (USB cable)
(Use the cable included in the FX-USB-AW.)

(Use the cable included in the FX3U-USB-BD.)

FX-422CAB (0.3 m), FX-422CAB-150 (1.5 m)
(For connecting to QnACPU, ACPU, 
Motion CPU (A series), FX1CPU, FX2CPU, 
or FX2CCPU) FX-232AW

FX-232AWC

FX-232AWC-H
(FX series only)

F2-232CAB(3m) *1*2

(For the 25-pin D-sub connector of the PC side)

F2-232CAB-1(3m) *2
(For the 9-pin D-sub connector  of the PC side)FX-422CAB0 (1.5m)

(For connecting to FX0/FX0S/FX0N/FX1S/
FX1N/FX2N/FX1NC/FX2NC/FX3G/FX3GC/
FX3GE/FX3U/FX3UC/FX3SCPU and AC30N2A)

AC30N2A(3m) *1
(For the 25-pin D-sub connector of the PC side)

F2-232CAB

Y990C*****

F2-232CAB-1

Y990C*****

F2-232CAB(F/FX/A)

  Y990C*****

F2-232CAB-1(F/FX/A)

  Y990C*****

Icompatible products Compatible products (with indication of F/FX/A)

FX-USB-AW *1

FX3U-USB-BD *1
(FX3UC/FX3U only)
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USB cable 1)
■MITSUBISHI ELECTRIC product

■Product manufactured by Mitsubishi Electric System & Service Co., Ltd.

Refer to the following for FXCPU-applicable USB cables other than the above.
 FX3G USER'S MANUAL [Hardware Edition]

USB cable 2)
■Product manufactured by ELECOM CO., LTD. (Recommended Product)

■Product manufactured by LOAS CO., LTD. (Recommended Product)

USB cable 3)
■Product manufactured by ELECOM CO., LTD. (Recommended Product)

USB cable 4)
■Product manufactured by BUFFALO KOKUYO SUPPLY INC. (Recommended Product)

USB cable

USB cable

USB cable

USB cable

USB cable/USB conversion adapter

USB cable/USB conversion adapter

Controller: USB Mini-B Personal computer: USB TYPE-A

MR-J3USBCBL3M (3m)

Controller: USB Mini-B Personal computer: USB TYPE-A

GT09-C30USB-5P (3m)

Controller: USB Mini-B Personal computer: USB TYPE-A

USB-M53 (3m)

Controller: USB Mini-B Personal computer: USB TYPE-A

ZUM-430 (3m)

Controller: USB Mini-B Personal computer: USB TYPE-A

+

)m3( 03-2BSUM5MTFBBSU-DA

Controller: USB Mini-B Personal computer: USB TYPE-A

+

)m3(03-2UA5MBUXUA
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USB cable 5)
■Product manufactured by ELECOM CO., LTD. (Recommended Product)

■Product manufactured by BUFFALO KOKUYO SUPPLY INC. (Recommended Product)

USB cable 6)
■Product manufactured by SANWA SUPPLY INC. (Recommended Product)

GT SoftGOT2000 setting
To establish communication between GT SoftGOT2000 and a PLC by the direct CPU connection (RS-232, USB), configure 
the communication setup.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 76 [RS232]
Page 79 [USB]

USB cable

USB cable

USB cable

Controller: USB TYPE-B Personal computer: USB TYPE-A

USB2-30 (3m)

Controller: USB TYPE-B Personal computer: USB TYPE-A

AU2-30 (3m)

Controller: USB Mini-B Personal computer: USB TYPE-A

KU-AMB530 (3 m) or KU-AMB550 (5 m)
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Controller setting
When connecting GT SoftGOT2000 and LCPU via the L6ADP-R2 adapter, configure the communication settings using GX 
Works2.
For other configurations, no setting is required on the controller.

1. Click [PLC parameter] → [Adapter Serial Setting].

2. Check that [Not Used] (default) is set in [Select Function].

L6ADP-R2 adapter
For details of the L6ADP-R2 adapter, refer to the following manual.
MELSEC-L CPU Module User's Manual (Hardware Design, Maintenance and Inspection)

Precautions

Converters and cables
■Specifications and precautions for converters and cables
For the specifications and precautions for converters and cables, refer to the manual of each product.

■When connecting or disconnecting the converter or cable that receives a 5 V DC power
Turn off the power on the PLC side before connecting or disconnecting the converter or cable that receives a 5 V DC power 
from the PLC side.

■When connecting or disconnecting the converter or cable that does not receive a 5 V DC 
power

Connect or disconnect the peripheral device or cable that receives an external power instead of the 5 V DC power from the 
PLC side according to the following procedure.

1. Make sure to touch the static discharge wrist strap or grounded metal before operation and discharge electrostatic from 
cables, human body or others.

2. Turn off the PC.

3. Turn off the converter.
Ground the FG terminal if provided.

4. Connect or disconnect the converter or cable between the personal computer and the PLC.

5. Turn on the converter.

6. Turn on the PC.

7. Start the software package.
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USB cable
■Before using USB cable
The USB cable can be used with the USB driver already installed.

■Number of connectable programmable controllers when using USB cable
A single programmable controller can be connected when using the USB cable.
The following shows the system configurations, which do not meet the above conditions.

■Precautions for connecting programmable controller
Connect or remove the USB cable, reset a programmable controller or turn the power on/off after stop the monitor.
Page 109 Monitor Stop
If operated without stop, a communication timeout occurs, which cannot be fixed.
If not fixed, remove the USB cable completely.
After 5 seconds or more, reconnect the cable.
(The error may occur at first communication after the above operation. From the next time, the programmable controller 
functions normally.)

Duplication of communication ports
The following shows the precaution for the RS-232 connection.
When running multiple GT SoftGOT2000 modules or using GT SoftGOT2000 with another MELSOFT application, set different 
communication ports for them.
If the same communication port is specified, a communication timeout may occur, interrupting monitoring.

QCPU (Q mode)

USB cable

QCPU (Q mode)
USB cable

Connecting from a personal computer with multiple USB ports to  

multiple QCPUs (Qmode)

QCPU (Q mode)

USB cable
USB cable

QCPU (Q mode)

USB cable

Connecting from a personal computer to multiple QCPUs (Q mode)  

through USB hub

USB hub
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3.8 Serial Communication Connection
System configurations

PLC Connection 
cable

Max. 
distance

GT SoftGOT2000 Number of 
connectable 
devices *1

Model name Communication 
module

Communication 
type

RCPU RJ71C24,
RJ71C24-R2

RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*4

1

QCPU (Q mode) QJ71C24,
QJ71C24-R2,
QJ71C24N,
QJ71C24N-R2,
QJ71CMO,
QJ71CMON

Windows-compatible 
personal computer
PC CPU module
MELIPC*4

QCPU (A mode) A1SJ71UC24-R2,
A1SJ71UC24-PRF,
A1SJ71C24-R2,
A1SJ71C24-PRF

RS-232 2)

C Controller 
module *3

MELSEC 
iQ-R series

RJ71C24,
RJ71C24-R2

RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*4

1

Q series QJ71C24,
QJ71C24-R2,
QJ71C24N,
QJ71C24N-R2,
QJ71CMO,
QJ71CMON

LCPU LJ71C24,
LJ71C24-R2

RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*4

1

QnACPU AJ71QC24,
AJ71QC24-R2,
AJ71QC24N,
AJ71QC24N-R2,
A1SJ71QC24,
A1SJ71QC24-R2,
A1SJ71QC24N,
A1SJ71QC24N-R2

RS-232 2)

ACPU AJ71C24-S8,
AJ71UC24,
A1SJ71C24-R2,
A1SJ71C24-PRF,
A1SJ71UC24-R2,
A1SJ71UC24-PRF

RS-232 2)

GT SoftGOT2000PLC CPU

Connection cable

Serial 
communication

module 
Computer link 

module
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*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*3 Use the serial port of a serial communication module controlled by another CPU on the multiple CPU.
*4 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.

Serial communication module, computer link module
The following table shows connectable serial communication modules and computer link modules.
Connection via RS-422 communication cannot be used.

*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.

Motion CPU MELSEC 
iQ-R series

RJ71C24,
RJ71C24-R2

RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*4

1

Q series *2 QJ71C24,
QJ71C24-R2,
QJ71C24N,
QJ71C24N-R2,
QJ71CMO,
QJ71CMON

RS-232 1)

A series AJ71C24-S8,
AJ71UC24,
A1SJ71C24-R2,
A1SJ71C24-PRF,
A1SJ71UC24-R2,
A1SJ71UC24-PRF

RS-232 2)

CC-Link IE 
Field 
Network 
head 
module

MELSEC 
iQ-R series

RJ71C24,
RJ71C24-R2

RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*4

1

L series LJ71C24,
LJ71C24-R2

CNC C80 Configure the multiple CPU system using an RCPU.

CNC C70 Configure the multiple CPU system using a QCPU (Q mode).

CRnQ-700

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

Item Model name
RCPU RJ71C24, RJ71C24-R2

QCPU (Q mode) QJ71C24, QJ71C24-R2, QJ71C24N, QJ71C24N-R2, QJ71CMO, QJ71CMON

QCPU (A mode) A1SJ71UC24-R2, A1SJ71UC24-PRF, A1SJ71C24-R2, A1SJ71C24-PRF

C Controller module (MELSEC iQ-R series) RJ71C24, RJ71C24-R2

C Controller module (Q series) QJ71C24, QJ71C24-R2, QJ71C24N, QJ71C24N-R2, QJ71CMO, QJ71CMON

LCPU LJ71C24, LJ71C24-R2

QnACPU AJ71QC24, AJ71QC24-R2, AJ71QC24N, AJ71QC24N-R2, A1SJ71QC24, A1SJ71QC24-R2, 
A1SJ71QC24N, A1SJ71QC24N-R2

ACPU AJ71C24-S8, AJ71UC24, A1SJ71C24-R2, A1SJ71C24-PRF, A1SJ71UC24-R2, A1SJ71UC24-PRF

Motion CPU (MELSEC iQ-R series) RJ71C24, RJ71C24-R2

Motion CPU (Q series)*1 QJ71C24, QJ71C24-R2, QJ71C24N, QJ71C24N-R2, QJ71CMO, QJ71CMON

Motion CPU (A series) AJ71C24-S8, AJ71UC24, A1SJ71C24-R2, A1SJ71C24-PRF, A1SJ71UC24-R2, A1SJ71UC24-PRF

CC-Link IE Field Network head module
(MELSEC iQ-R series)

RJ71C24, RJ71C24-R2

CC-Link IE Field Network head module
(MELSEC L series)

LJ71C24, LJ71C24-R2

PLC Connection 
cable

Max. 
distance

GT SoftGOT2000 Number of 
connectable 
devices *1

Model name Communication 
module

Communication 
type
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Connection cable

RS-232 1)
■Connection example which can turn ON/OFF CD signal (No. 1 pin)

■Connection example which cannot turn ON/OFF CD signal (No. 1 pin)
Connection example for exercising CD code control or DTR/DSR control.

RS-232 2)
■MITSUBISHI ELECTRIC product

*1 When the port on the PC side is 9-pin D-sub, a 9-25 pin converter is required separately.

RS-232 cable

Cable Connection and Signal Direction
(Connection example for full duplex/half duplex communication)

RS(RTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

CD

CS(CTS)

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

7

3

2

6

5

4

1

8

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Cable Connection and Signal Direction 
(Connection example for full duplex)

RS(RTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

CD

CS(CTS)

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

7

3

2

6

5

4

1

8

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Controller: D-sub 25-pin Personal computer: D-sub 25-pin

AC30N2A(3m)*1
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■User-created
 • QnA Series (large-scale QC24(N))
Example of connection to an external device that allows the CD signal (No. 8 pin) to be turned ON/OFF

DC code control or DTR/DSR control is enabled by connecting the QC24 (N) to an external device as shown above.
Example of connection to an external device that does not allow the CD signal (No. 8 pin) to be turned ON/OFF

DC code control or DTR/DSR control is enabled by connecting the QC24 (N) to an external device as shown above.
 • QnA Series (compact-scale QC24(N))
Example of connection to an external device that allows the CD signal (No.1 pin) to be turned ON/OFF

DC code control or DTR/DSR control is enabled by connecting the QC24 (N) to an external device as shown above.

Cable Connection and Signal Direction 
(Connection example for full duplex/half duplex communication)

CS(CTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

RS

CD

FG

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

5

2

3

6

7

20

4

8

1

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Cable Connection and Signal Direction 
(Connection example for full duplex)

CS(CTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

RS

CD

FG

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

5

2

3

6

7

20

4

8

1

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Cable Connection and Signal Direction 
(Connection example for full duplex/half duplex communication)

RS(RTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

CD

CS(CTS)

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

7

3

2

6

5

4

1

8

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side
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Example of connection to an external device that does not allow the CD signal (No. 1 pin) to be turned ON/OFF

DC code control or DTR/DSR control is enabled by connecting the QC24 (N) to an external device as shown above.
 • A series
Connection example 1 when the C24 (computer link module) has a 25-pin connector

Connection example 2 when the C24 (computer link module) has a 25-pin connector

When performing a communication in the connection shown above, the CD signal is not required to be connected.
For the RS-232C CD terminal check setting (set by the buffer memory address "10BH"), specify "without CD terminal check 
(writing "1")"

Cable Connection and Signal Direction 
(Connection example for full duplex)

RS(RTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

CD

CS(CTS)

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

7

3

2

6

5

4

1

8

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Cable Connection and Signal Direction

FG

RD(RXD)

SD(TXD)

RS

CD

DTR(ER)

SG

CS(CTS)

DSR(DR)

FG

SD(TXD)

RD(RXD)

RS

CS(CTS)

DSR(DR)

SG

CD

DTR(ER)

1

3

2

4

8

20

7

5

6

PLC side

1

2

3

4

5

6

7

8

20

GT SoftGOT2000 side

Cable Connection and Signal Direction

FG

RD(RXD)

SD(TXD)

RS

CD

DTR(ER)

SG

CS(CTS)

DSR(DR)

FG

SD(TXD)

RD(RXD)

RS

CS(CTS)

DSR(DR)

SG

CD

DTR(ER)

1

3

2

4

8

20

7

5

6

PLC side

1

2

3

4

5

6

7

8

20

GT SoftGOT2000 side
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Connection example 1 when the C24 (computer link module) has a 9-pin connector

Connection example 2 when the C24 (computer link module) has a 9-pin connector

DC code control or DTR/DSR control is enabled by connecting the DTR and DSR signals of the computer link module to an 
external device as shown above.
When performing a communication in the connection shown above, the CD signal is not required to be connected.
For the RS-232C CD terminal check setting (set by the buffer memory address "10BH"), specify "without CD terminal check 
(writing "1")".

Cable Connection and Signal Direction

CS(CTS)

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

RS(RTS)

CD

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

8

3

2

6

5

4

7

1

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side

Cable Connection and Signal Direction

CD

SD(TXD)

RD(RXD)

DSR(DR)

SG

DTR(ER)

RS(RTS)

CS(CTS)

-

CD

RD(RXD)

SD(TXD)

DTR(ER)

SG

DSR(DR)

RS(RTS)

CS(CTS)

-

1

3

2

6

5

4

7

8

9

PLC side

1

2

3

4

5

6

7

8

9

GT SoftGOT2000 side
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GT SoftGOT2000 side
For the communication between GT SoftGOT2000 and a PLC in serial communication connection, communication setup is 
required.
The following table shows the transmission specifications for a serial communication module or a computer link module.

Refer to the following for performing GT SoftGOT2000 communication setup.
Page 80 [C24]

Model name Settings

Transmission 
speed

Data length Stop bit Parity bit Sum check

Serial communication 
module
(MELSEC iQ-R series)

RJ71C24,
RJ71C24-R2

9600bps/
19200bps/
38400bps/
57600bps/
115200bps

8 bits 1 bit Yes (odd) Yes

Serial communication 
module
(Q series)

QJ71C24,
QJ71C24-R2,
QJ71C24N,
QJ71C24N-R2,
QJ71CMO,
QJ71CMON

Serial communication 
module
(L series)

LJ71C24,
LJ71C24-R2

Serial communication 
module
(QnA series)

AJ71QC24N,
AJ71QC24N-R2,
A1SJ71QC24N,
A1SJ71QC24N-R2

AJ71QC24,
AJ71QC24-R2,
A1SJ71QC24,
A1SJ71QC24-R2

9600bps/
19200bps

Computer link module AJ71C24-S8,
AJ71UC24,
A1SJ71C24-R2,
A1SJ71C24-PRF,
A1SJ71UC24-R2,
A1SJ71UC24-PRF
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Controller setting

When connecting to serial communication module (MELSEC iQ-R seires, Q series, L 
series)
No switch setting is required for the serial communication module (MELSEC iQ-R series, Q series, L series).
(GOT monitors via it without making switch setting in the I/O assignment setting of GX Works3 or GX Works2 or GX 
Developer.)
The following settings are also available for monitoring, according to the CH (interface) of the module to be connected with GT 
SoftGOT2000.
However, if QJ71CMO or QJ71CMON is connected, only CH2 can be used.
For the GX Developer operating method, refer to the GX Works3 or GX Work2 or GX Developer Operating Manual.

When connecting to serial communication module (QnA series)

*1 38400 bps, 57600 bps and 115200 bps can be set only for the following modules.
AJ71QC24N
AJ71QC24N-R2
A1SJ71QC24N
A1SJ71QC24N-R2

Channel where GT 
SoftGOT2000 is 
connected

Settings

Switch 1 Switch 2 Switch 3 Switch 4 Switch 5

CH1 0000 0000 0000

CH2 0000 0000 0000

Switch Baud rate (Transmission speed) *1

9600bps 19200bps 38400bps 57600bps 115200bps
Station number switch 0

Mode switch 5

sw01 OFF

sw02 ON

sw03 ON

sw04 OFF

sw05 OFF

sw06 ON

sw07 ON

sw08 OFF

sw09 ON OFF ON OFF ON

sw10 OFF ON ON ON ON

sw11 ON ON ON OFF OFF

sw12 OFF OFF OFF ON ON
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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When connecting to computer link module
■AJ71C24-S8

■AJ71UC24

Switch RS-232 communication

Baud rate (Transmission speed)

9600bps 19200bps
Station number switch 0

Mode switch 1

sw11 OFF

sw12 ON

sw13 ON OFF

sw14 OFF ON

sw15 ON ON

sw16 ON

sw17 OFF

sw18 OFF

sw21 ON

sw22 ON

sw23 OFF

sw24 OFF

Switch RS-232 communication

Baud rate (Transmission speed)

9600bps 19200bps
Station number switch 0

Mode switch 1

sw11 OFF

sw12 ON

sw13 ON OFF

sw14 OFF ON

sw15 ON ON

sw16 ON

sw17 OFF

sw18 OFF

sw21 ON

sw22 ON

sw23 ON

sw24 OFF
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■A1SJ71UC24-R2, A1SJ71C24-R2, A1SJ71UC24-PRF and A1SJ71C24-PRF
Switch RS-232 communication

Baud rate (Transmission speed)

9600bps 19200bps
Station number switch No applicable switch

Mode switch 1

SW01 No applicable switch

SW02 No applicable switch

sw03 OFF

sw04 ON

sw05 ON OFF

sw06 OFF ON

sw07 ON ON

sw08 ON

sw09 ON

sw10 OFF

sw11 OFF

sw12 ON
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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3.9 Bus Connection
System configurations

*1 Connect the PC CPU with a PLC CPU on the same base unit as the PC CPU.
*2 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.

GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a PLC in bus connection, communication setup is required.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 93 [BUS]

PLC Connection cable Max. distance GT SoftGOT2000 Number of 
connectable 
devices

Model name Communication 
type

QCPU (Q mode) Bus *1 *1 PC CPU 1 *2

Main base
PLC CPU
PC CPU
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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3.10 MELSECNET/H, MELSECNET/10 Connection
System configurations

*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*2 Distance between stations for using QSI optical cable and 5C-2V coaxial cable.

The overall distance and distance between stations differs according to the type and the number of total stations for the cable to be 
used.
For details on the cable, refer to the following manual.
Q corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)

PLC Max. distance GT SoftGOT2000 Number of connectable 
devicesModel name Network 

module
Communication 
type

QCPU QJ71LP21,
QJ71LP21-25,
QJ71LP21S-25,
QJ71BR11,
AJ71LP21,
A1SJ71LP21,
AJ71BR11,
A1SJ71BR11

MELSECNET/H
MELSECNET/10

Optical fiber cable: 1km *2

Coaxial cable: 500m *2
Windows-compatible 
personal computer*5

PC CPU module

Optical fiber cable: 64 *3*4

Coaxial cable: 32 *3*4

C Controller module QJ71LP21-25,
QJ71LP21S-25,
QJ71BR11

QSCPU QJ71LP21,
QJ71LP21-25,
QJ71LP21S-25,
QJ71BR11

QnACPU AJ71QLP21,
AJ71QLP21S,
A1SJ71QLP21,
A1SJ71QLP21S,
AJ71QBR11,
A1SJ71QBR11

MELSECNET/10

ACPU AJ71LP21,
A1SJ71LP21,
AJ71BR11,
A1SJ71BR11

Motion 
CPU

Q series *1 QJ71LP21,
QJ71LP21-25,
QJ71LP21S-25,
QJ71BR11

MELSECNET/H
MELSECNET/10

A series AJ71LP21,
A1SJ71LP21,
AJ71BR11,
A1SJ71BR11

MELSECNET/10

CNC C70 Configure the multiple CPU system using QCPUs (Q mode).

CRnQ-700

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

PLC CPU
MELSECNET/H
network module,
MELSECNET/10
network module

GT SoftGOT2000

Connection cable
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*3 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*4 Applicable when using one MELSECNET/H board per personal computer.

Up to four MELSECNET/H boards can be mounted per personal computer.
*5 A MELSECNET/H interface board is required.

Page 320 Interface board

Network module, interface board
The following shows connectable network modules and interface boards.

Network module
■MELSECNET/H

*1 Use function version B or later of the MELSECNET/H network module and CPU.

■MELSECNET/10

*1 Use function version B or later of the MELSECNET/H network module and CPU.

Interface board

Refer to the following manual for the settings of the interface board.
 MELSECNET/H Interface Board User's Manual (For SW0DNC-MNETH-B)

When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.

Item Model name

Optical loop Coaxial bus
QCPU (Q mode) *1 QJ71LP21, QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

QSCPU

Motion CPU (Q series)

C Controller module QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

Item Model name

Optical loop Coaxial bus
QCPU(Q mode) *1 QJ71LP21, QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

C Controller module QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

QCPU(A mode) AJ71LP21, A1SJ71LP21 AJ71BR11, A1SJ71BR11

QSCPU QJ71LP21, QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

QnACPU AJ71QLP21, AJ71QLP21S, A1SJ71QLP21, 
A1SJ71QLP21S

AJ71QBR11, A1SJ71QBR11

ACPU AJ71LP21, A1SJ71LP21 AJ71BR11, A1SJ71BR11

Motion CPU (Q series) QJ71LP21, QJ71LP21-25, QJ71LP21S-25 QJ71BR11 *1

Motion CPU (A series) AJ71LP21, A1SJ71LP21 AJ71BR11, A1SJ71BR11

Type Model name Bus format Driver
MELSECNET/H Q80BD-J71LP21-25 (Optical loop), Q80BD-J71LP21G (Optical loop), 

Q80BD-J71LP21S-25 (Optical loop, with external power supply function), 
Q80BD-J71BR11 (Coaxial loop)

PCI SWODNC-MNETH-B

Q81BD-J71LP21-25 (Coaxial loop) PCI Express
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Connection cable
The cables are the same as the fiber-optic cables and coaxial cables used in the MELSECNET/H or MELSECNET/10 network 
system.
Refer to the following for details of cables.
Q corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)

GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a PLC in MELSECNET/H or MELSECNET/10 network system, communication 
setup is required.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 81 [NET/H]

Controller setting
For the settings of the MELSECNET/H network module and MELSECNET/10 network module, refer to the following.
Q corresponding MELSECNET/H Network System Reference Manual (PLC to PLC network)
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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3.11 CC-Link IE Controller Network Connection
System configurations

*1 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*2 Distance between stations for using the fiber-optic cable (core/cladding = 50/125(μm)).

The overall distance and distance between stations differs according to the type and the number of total stations for the cable to be 
used.
For details on the cable, refer to the following manual.
 CC-Link IE Controller Network Reference Manual

*3 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*4 A CC-Link IE Controller Network interface board is required.

Page 323 Interface board

PLC Max. distance GT SoftGOT2000 Number of 
connectable 
devices

Model name Network 
module

Communication type

RCPU RJ71GP21-SX CC-Link IE Controller Network 550m *2 Windows-compatible 
personal computer*4

PC CPU module

120 *3

QCPU QJ71GP21-SX,
QJ71GP21S-SX

C Controller 
module

MELSEC iQ-R 
series

RJ71GP21-SX

Q series QJ71GP21-SX,
QJ71GP21S-SX

QSCPU QJ71GP21-SX,
QJ71GP21S-SX

Motion CPU MELSEC iQ-R 
series

RJ71GP21-SX

Q Series *1 QJ71GP21-SX,
QJ71GP21S-SX

CNC C70 Configure the multiple CPU system using QCPUs (Q mode).

CRnQ-700

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

PLC CPU
CC-Link IE Controller
Network module GT SoftGOT2000

Connection cable
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Network module, interface board
The following shows connectable network modules and interface boards.

Network module

Interface board

Refer to the following manual for the settings of the interface board.
CC-Link IE Controller Network Interface Board User's Manual (For SW1DNC-MNETG-B)

 • When using PC CPU module
An interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
MELIPC MI5000 Series User's Manual

Connection cable
The cables are the same as the fiber-optic cables used in the CC-Link IE Controller Network.
Refer to the following for details of cables.
CC-Link IE Controller Network Reference Manual

GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a PLC in CC-Link IE Controller Network, communication setup is required.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 82 [CC IE Control] or [CC IE Field]

Controller setting
For the settings of the CC-Link IE Controller Network module, refer to the following.
CC-Link IE Controller Network Reference Manual

Item Model name
RCPU RJ71GP21-SX

C Controller module MELSEC iQ-R series

Motion CPU MELSEC iQ-R series

QCPU (Q mode) QJ71GP21-SX, QJ71GP21S-SX

C Controller module Q series

QSCPU

Motion CPU Q series

Type Model name Bus format Driver
CC-Link IE Controller Q80BD-J71GP21-SX, Q80BD-J71GP21S-SX PCI SW1DNC-MNETG-B

Q81BD-J71GP21-SX (Coaxial loop),
Q81BD-J71GP21S-SX (Optical loop, with external power 
supply function)

PCI Express
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3.12 CC-Link IE Field Network Connection
System configurations

*1 Compatible with only the universal model QCPU.
*2 For the connection with Motion CPUs (Q series), only the PLC CPU area (CPU No. 1) of the Q170MCPU or Q170MSCPU is available.
*3 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*4 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver, or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*5 A CC-Link IE Field Network interface board is required.
Page 325 Interface board

PLC connection cable *4 Max. 
distance

GT 
SoftGOT2000

Number of 
connectable 
devices

Model name Network 
module

Communication 
type

RCPU RJ71GF11-T2,
RJ71EN71,
RD77GF4,
RD77GF8,
RD77GF16,
RD77GF32

CC-Link IE Field 
Network

Ethernet cable that 
meets the 1000BASE-T 
standard:
Category 5e or higher,
(double-shielded, STP)
straight cable.

100 m
(Maximum 
segment 
length)

Windows-
compatible 
personal 
computer*5

PC CPU module
MELIPC

120 *3

QCPU(Q mode) *1 QJ71GF11-T2

C Controller 
module

MELSEC iQ-R 
series

RJ71GF11-T2,
RJ71EN71,
RD77GF4,
RD77GF8,
RD77GF16,
RD77GF32

Q series QJ71GF11-T2

QSCPU QS0J71GF11-T2

LCPU LJ71GF11-T2

Motion CPU MELSEC iQ-R 
series

RJ71GF11-T2,
RJ71EN71,
RD77GF4,
RD77GF8,
RD77GF16,
RD77GF32

Q Series *2 QJ71GF11-T2

CNC C70 Configure the multiple CPU system using QCPUs (Q mode).

CRnQ-700

CR750-Q

CR751-Q

CR800-Q
(Q172DSRCPU)

GT SoftGOT2000PLC CPU

Connection cable

CC-Link IE Field 
Network module
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Network module, interface board
The following shows connectable network modules and interface boards.

Network module

Interface board

Refer to the following manual for the settings of the interface board.
CC-Link IE Field Network Interface Board User's Manual(For SW1DNC-CCIEF-B)

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a PLC in the CC-Link IE Field Network system, communication setup is required.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 82 [CC IE Control] or [CC IE Field]

Controller setting
For the settings of the CC-Link IE Field Network module, refer to the following.
CC-Link IE Field Network Master/Local Module User's Manual

Precautions

Precautions for using an interface board
When system switching occurs while GT SoftGOT2000 monitors the master station (station No. 0) on the network where the 
submaster station is set, monitoring is performed as follows.

■When the function version of the interface board is A
GT SoftGOT2000 monitors the submaster station whose station number is assumed to be zero.
The station monitoring function assumes that the previous submaster station number is faulty.

■When the function version of the interface board is B or later
GT SoftGOT2000 cannot monitor the master station (station No. 0), and a timeout error occurs.
The station monitoring function does not detect the faulty station.

Item Model name
RCPU Network module RJ71GF11-T2, RJ71EN71, RD77GF4, RD77GF8, 

RD77GF16, RD77GF32C controller module (MELSEC iQ-R Series)

Motion CPU (MELSEC iQ-R series)

QCPU (Q mode) QJ71GF11-T2

C Controller module (Q Series)

Motion CPU (Q series)

QSCPU QS0J71GF11-T2

LCPU LJ71GF11-T2

Type Model name Bus format Driver
CC-Link IE Field Q81BD-J71GF11-T2 PCI Express SW1DNC-CCIEF-B
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3.13 OPC UA client connection
System configuration

Connecting with an OPC UA server via Ethernet

*1 For connectable servers, refer to the following.
Page 328 Supported servers

*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*3 An Ethernet board/card is required.
Page 327 Ethernet board/card

Connecting with an OPC UA server on the same personal computer

*1 The server must be installed on the personal computer where GT SoftGOT2000 resides.
*2 For connectable servers, refer to the following.

Page 328 Supported servers

Model name Connection 
type

Connection cable *2 Max. distance GT SoftGOT2000 Number of 
connectable 
devices per 
channel

OPC UA server *1 Ethernet Ethernet cable that meets the 
1000BASE-T standard: Category 
5e or higher, (double-shielded, 
STP) straight cable.

100m
(max. segment 
length)

Windows-compatible personal 
computer*3

MELIPC

1

Model name Connection 
type

Connection cable *2 Max. distance GT SoftGOT2000 Number of 
connectable 
devices per 
channel

OPC UA server *1*2 - - - Windows-compatible personal 
computer
MELIPC

1

Connection cable 

GT SoftGOT2000OPC UA server

OPC UA server
GT SoftGOT2000
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Access range
The following shows OPC UA servers accessible by GT SoftGOT2000.

Ethernet board/card

When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
MELIPC MI5000 Series User's Manual

Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

Manufacturer Model name Remarks
3COM EthernetLink LAN PC Card Ethernet board/card

- Ethernet board built in the personal computer as 
standard

Ethernet board

OPC UA server

OPC UA-compliant controllerEthernet

Reading/writing data from/ to OPC UA tags

Ethernet

GT SoftGOT2000

OPC UA server

OPC UA server on the same network

On the same personal computer
Access range

Read and write OPC UA tag
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Controller setting
The following shows settings and precautions to establish communication between GT SoftGOT2000 and an OPC UA server.

Before setting
■Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and controller.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

Supported servers
Servers must be compliant with OPC UA 1.03 or later and support the following OPC UA service sets.
Discovery Service Set
SecureChannel Service Set
Session Service Set
View Service Set
Attribute Service Set
For recommended OPC UA servers, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series OPC UA Server Connection (GOT-A-0137)
For Technical News, contact your local distributor.

OPC UA server settings
Check the following settings of the OPC UA server.

For information on how to check each setting, refer to the following.
Manual of the OPC UA server connected

Setting on the personal computer
Set the IP address.

Item Description
Port No. Port number of the OPC UA server.

Endpoint URL Endpoint URL of the OPC UA server.
• opc.tcp://(Host name of the OPC UA server):(port number of the OPC UA server)

Security policy Security policy setting for communication.
• None: Does not encrypt messages.
• Basic128Rsa15: Uses 128-bit encryption
• Basic256: Uses 256-bit encryption.
• Basic256: Uses digital signing and 256-bit encryption.

Security mode Mode of digital signing and encryption.
• None: Does not encrypt messages.
• Sign: Digitally signs messages.
• Sign & Encrypt: Digitally signs and encrypts messages.

User authentication User authentication method setting for connecting an OPC UA client.

User name Specified user name.

Password Specified password.
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Communications check
■Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 3. 40
Reply from 192.168.3.40:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 3. 40
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.

■Communication Test
After configuring settings to communicate with an OPC UA server in the [Communication Setup] dialog, execute a 
communication test with the [Communication Test] button in the [Communication Setup] dialog.
For the details of the [Communication Setup] dialog, refer to the following.
Page 88 [OPC]

Installing GT OPC UA Client and configuring the settings
To access an OPC UA server to read/write data from/to the OPC UA tags, install GT OPC UA Client and configure the 
settings.
For obtaining GT OPC UA Client, contact your local sales office.
For details, refer to the following.
MELSOFT GT OPC UA Client Operating Manual

Settings in GT Designer3
Setting [Connected Ethernet Controller Setting] is not required.

Importing a tag information file
Import a tag information file.
For the details, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
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Settings on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 88 [OPC]

Precautions

When GT SoftGOT2000 requests increase the load on the OPC UA server
The increased load on the OPC UA server may affect updating of the server's viewer.
Set [Wait Time] in the communication setup to adjust the load on the OPC UA server.
Page 88 [OPC]

Troubleshooting when connecting to an OPC UA server
If a system alarm occurs when you try to connect to an OPC UA server, refer to the following and check the details of the 
alarm.
Page 734 Troubleshooting for the OPC UA client connection
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3.14 MELIPC Connection
The following shows how to connect GT SoftGOT2000 to a MELIPC.
Ethernet connection between GT SoftGOT2000 and a MELIPC
Page 331 Ethernet connection
CC-Link IE Field Network connection between GT SoftGOT2000 and a MELIPC
Page 336 CC-Link IE Field Network connection
Virtual Ethernet connection between GT SoftGOT2000 installed on the Windows part of a MELIPC and the VxWorks part of 
the MELIPC
Page 337 Direct MELIPC connection

Ethernet connection

System configuration
■Direct connection

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 An Ethernet board/card is required.
Page 333 Ethernet board/card

PLC Connection 
cable*1

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet 
module

Communication 
type

MELIPC MI5000 
series

(Built-in Ethernet 
port)

Ethernet Twisted pair 
cable

100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*2

PC CPU module
MELIPC

UDP: 119
TCP: 17

UDP: 119 (16 or 
less 
recommended)
TCP: 119 (16 or 
less 
recommended)

MELIPC GT SoftGOT2000

Connection cable
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■Connection via a servo amplifier

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*2 For the settings in GT SoftGOT2000, refer to the following.
Page 238 Controller setting

*3 An Ethernet board/card is required.
Page 333 Ethernet board/card

PLC Servo amplifier Connection 
cable*1

Max. 
distance

GT 
SoftGOT2000*2

Number of 
connectable 
devices

Model name Communication 
type

Model name Communication 
type

MELIPC MI5000 
series

CC-Link IE Field 
Network Basic

MR-J5-□G
MR-J5-□G-RJ
MR-J5D1-□G4
MR-JET-□G

Ethernet Ethernet 
cable that 
meets the 
1000BASE-T 
standard: 
Category 5e 
or higher 
(double 
shielded, 
STP), straight 
cable

100 m
(Maximum 
segment 
length)

Windows-compatible 
personal computer*3

PC CPU module
MELIPC

One GT 
SoftGOT2000 
module for one 
servo amplifier

Connection cable

CC-Link IE Field Network Basic

GT SoftGOT2000Servo
amplifier

Servo
amplifierMELIPC
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Built-in Ethernet port CPU and Ethernet board/card
The following shows connectable built-in Ethernet port CPUs and Ethernet boards/cards.

■Built-in Ethernet port CPU

■Ethernet board/card
Applicable Ethernet bords/cards are shown in the following.

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
MELIPC MI5000 Series User's Manual

Connection cable
Use an applicable cable according to the Ethernet board/card used.

Controller setting
The following shows the necessary settings and precautions when GT SoftGOT2000 communicates with a MELIPC.
The explanations are given using the following system configuration to monitor the host station.
When monitoring other stations, follow the same procedure as the host.

Setting items
For setting the network number, station number, IP address, and port number of a MELIPC and GT 
SoftGOT2000, refer to the following.
Page 335 Settings in GT Designer3

Item Model name
MELIPC MI5122-VW

Manufacturer Model name Remarks
3COM EthernetLink III LAN PC Card Ethernet board/card

- Ethernet board built in the personal computer as standard Ethernet board

:5001

<GT SoftGOT2000>

:1
:3
:192.168.3.18N/W No.

PC No.
IP address
Port No. :5006 

:1
:2
:192.168.3.40

:5006 

:1
:1
:192.168.3.39

<MELIPC>
Other station

N/W No.
PC No.
IP address
Port No.

<MELIPC>
  Host

N/W No.
PC No.
IP address
Port No.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.14  MELIPC Connection 333



33
■Before setting
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Settings on MI Configurator (Basic parameters)
Set the basic parameters for the built-in Ethernet port.
Set the other items according to the system used.
For the details of the settings, refer to the following.
MI Configurator Operating Manual
Set the IP address for PLC1 in [IP Address].

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 3. 39
Reply from 192.168.3.39:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 3. 39
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3
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■Settings in GT Designer3
Up to 120 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select the type of the target Ethernet module. [MELIPC]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)
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CC-Link IE Field Network connection

System configurations

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver, or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*3 An Ethernet board/card is required.
Page 336 Interface board

Built-in Ethernet port CPU and interface board
■Built-in Ethernet port CPU

■Interface board

Refer to the following manual for the settings of the interface board.
CC-Link IE Field Network Interface Board User's Manual(For SW1DNC-CCIEF-B)

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a PLC in the CC-Link IE Field Network system, communication setup is required.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 82 [CC IE Control] or [CC IE Field]

Controller setting
For the settings of the CC-Link IE Field Network module, refer to the following.
CC-Link IE Field Network Master/Local Module User's Manual

PLC connection cable *2 Max. 
distance

GT SoftGOT2000 Number of 
connectable 
devices

Model name Network 
module

Communication 
type

MELIPC MI5000 
series

(Built-in Ethernet 
port)

CC-Link IE Field 
Network

Ethernet cable that meets the 
1000BASE-T standard:
Category 5e or higher,
(double-shielded, STP)
straight cable.

100 m
(Maximum 
segment 
length)

Windows-compatible 
personal computer*3

PC CPU module
MELIPC

120 *1

Item Model name
MELIPC MI5122-VW

Type Model name Bus format Driver
CC-Link IE Field Q81BD-J71GF11-T2 PCI Express SW1DNC-CCIEF-B

MELIPC GT SoftGOT2000

Connection cable
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Direct MELIPC connection

System configurations

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.

Settings in GT Designer3
One setting can be configured in [Connected Ethernet Controller Setting].

*1 Specify the IP address that is assigned for the virtual Ethernet connection.

MELIPC connection cable Max. 
distance

GT SoftGOT2000 Number of 
connectable devicesModel name Communication 

type
MI5122-VW (VxWorks part) Virtual Ethernet - - MELIPC (Windows part) 1 *1

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select the type of the target Ethernet module. [MELIPC]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255] *1

[Port No.] Set the port number of the target Ethernet module. [5006], [5007]

[Communication] Displays the communication method. [UDP] (for port No. 5006),
[TCP] (for port No. 5007)

MELIPC
(VxWorks part, Windows part)
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Setting on GT SoftGOT2000
To establish communication between GT SoftGOT2000 installed on the Windows part and the VxWorks part, configure the 
communication settings.
For the details of the [Communication Setup] dialog, refer to the following.
Page 92 [MELIPC Direct]

Controller setting
For setting up a MELIPC, refer to the following.
User's manual of MELIPC

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions
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3.15 CNC Connection
Direct CPU connection (RS-232)

System configurations

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.

Connection cable
The user is required to make a conversion cable for connecting to the MELDAS C6/C64.
The following describes the connection diagram for each cable and specifications of connectors.

■RS-232 1)
 • Connection diagram

 • Connector specifications
PC side connector
Use the connector compatible with the PC side.
MELDAS C6/C64 side connector
Use the connector compatible with MELDAS C6/C64 side.
For details, refer to the following manual.
User's Manual for the MELDAS C6/C64
 • Precautions for creating cables
The length of the conversion cable must be 15m or shorter.

PLC Connection cable Max. distance GT SoftGOT2000 Number of 
connectable 
devices

Model name Communication 
type

MELDAS C6/C64 RS-232 RS-232 1) 15m Windows-compatible 
personal computer
PC CPU module
MELIPC*2

1 *1

GT SoftGOT2000MELDAS
C6/C64

Connection cable

GT SoftGOT2000 side

1

6

16

-

11

-

-

18

-

1

2

3

4

5

6

7

8

9

GND

SD

RD(RXD)

-

GND

-

-

ER(DTR)

-

GND

RD(RXD)

SD(TXD)

-

GND

DR(DSR)

-

CS(CTS)

-

MELDAS C6/C64 side
(20 pin half pitch)

*1
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GT SoftGOT2000 setting
To establish communication between GT SoftGOT2000 and MELDAS C6/C64 by the direct CPU connection (RS-232), 
configure the communication setup.
Refer to the following for performing GT SoftGOT2000 communication setup.
Page 76 [RS232]

Ethernet connection

System configurations and connection conditions

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

Connection cable
Use a cable applicable to the Ethernet module to be used.

Controller setting
The setting items and precautions are shown below for communicating GT SoftGOT2000 to the MELDAS C6/C64.
This section describes the system configuration to monitor the host station as shown below.

Setting items
Refer to the following for how to set the Net No., PLC No./PC No., IP address and port No. of the MELDAS 
C6/C64 and GT SoftGOT2000.
Page 343 Settings on GT Designer3

PLC Connection 
cable *2

Max. distance GT SoftGOT2000 Number of 
connectable 
devices per CH

Model name Extension 
unit

Communication 
type

MELDAS C6/C64 FCU6-EX875 Ethernet Twisted pair cable 100 m
(max. segment length)

Windows-compatible 
personal computer
PC CPU module
MELIPC

128 *1

Connection cable

GT SoftGOT2000MELDAS
C6/C64

Extension 
unit

<GT SoftGOT2000>

<MELDAS C6/C64>

N/W No.
    PC No.

:1
:2 
:192.168.0.2
:5001

<MELDAS C6/C64>

N/W No.
    PC No.

:1
:1 
:192.168.0.1
:5001

:1
:3 
:192.168.0.3
:5001

Other station

Host 

Port No.
IP address

IP address
Port No.

N/W No.
PC No.

Port No.
IP address
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The following shows the procedure for communicating GT SoftGOT2000 to the MELDAS C6/C64.

■Before setting
 • Precautions for monitoring
GT SoftGOT2000 cannot monitor CPUs on the other networks.
 • Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Compatible models

■Network parameter setting
Set the network parameters by peripheral devices and write them to the MELDAS C6/C64.
The following shows an example of the parameter setting for GX Developer.
Set the start I/O No. that corresponds to the extension slot to be connected with the Ethernet unit.
When using two extension slots, unit numbers are assigned as shown in the following figures from 1) to 3).
 • Start I/O No.

Compatible models
FCA C6, FCA C64

Extension 
slot

Start I/O 
No.

Mounting position of extension unit

EXT1 0200

EXT2 0280

EXT3 0300

EXT2 

EXT1 

Unit2

Unit1

EXT3 

EXT1 

EXT2 

EXT3

EXT1 

(e)When mounted in EXT2 only (f)When mounted in EXT3 only

EXT2 

EXT3 

(a)When mounted in EXT1 and EXT2 (b)When mounted in EXT1 and EXT3 (c)When mounted in EXT2 and EXT3 

(d)When mounted in EXT1 only

Unit2

Unit2 Unit1
Unit1

Unit1Unit1 Unit1
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 • Example of GX Developer setting

For details of the parameter setting, refer to the following.
MELDAS C6/C64 NETWORK MANUAL BNP-B2373

IP address setting
The IP address setting on GX Developer is invalid.
Set the IP address by the 7-segment LED and rotary switch of the MELDAS C6/C64 side, referring to the next 
page.

■MELDAS C6/C64 side parameter setting
Set the IP address, gateway address, subnet mask, and port No. for the 7-segment LED and rotary switch of the MELDAS 
C6/C64 side, and then check the settings.
For details of the parameter setting, refer to the following.
 MELDAS C6/C64 NETWORK MANUAL BNPB2373 IV Setting the Ethernet IP Address

 

  
 

 

 

7-segment LED

Rotary switch
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■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
When ready to communicate, execute the Ping command at the command prompt on the Windows.
When connections are OK
C:\>ping 192. 168. 0. 19
Reply from 192.168.0.19:bytes=32 time<1ms TTL=32
When connections are not good
C:\>ping 192. 168. 0. 19
Request timed out.
When the Ping test is not verified, check the connections of the cable and module, and settings, including the IP address, for 
Windows.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

■Settings on GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. [AJ71QE71]

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. [5001]

[Communication] Select a communication method. [UDP]
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3.16 Robot Controller Connection
System configurations

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

Connection cable
Use a cable compatible with CR800-D, CRnD-700, CR750-D, or CR751-D.

Controller setting
The following shows the setting items and precautions for communication between GT SoftGOT2000 and CR800-D, CRnD-
700, CR750-D, or CR751-D.
This section describes the system configuration to monitor the host as shown below.
CR800-D

*1 Although the setting is nonexistent on the robot controller side, set a virtual value on the GOT side.

PLC Connection cable *2 Max. distance GT SoftGOT2000 Number of 
connectable 
devices per CH

Model name Communication 
type

CR800-D Ethernet Twisted pair cable 100 m
(max. segment length)

Windows-compatible 
personal computer
PC CPU module
MELIPC

1 *1

CRnD-700

CR750-D

CR751-D

GT SoftGOT2000Robot 
controller

Connection cable

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:1
:1
:192.168.0.18

N/W No.
PC No.
IP address

: 1 (virtual)
: 2 (virtual)
:192.168.0.19

<CR800-D>

*1
*1
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CRnD-700, CR750-D, CR751-D

Setting items
For setting the network number, station number, IP address, and port number of CR800-D, CRnD-700, 
CR750-D, CR751-D, and GT SoftGOT2000, refer to the following.
Page 348 Settings in GT Designer3

The following shows the settings for communication with CR800-D, CRnD-700, CR750-D, or CR751-D.

Before setting
■Precautions for monitoring
GT SoftGOT2000 cannot monitor other stations.
GT SoftGOT2000 cannot monitor CPUs on the other networks.

■Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

Compatible models

Parameter settings for CR800-D, CRnD-700, CR750-D, and CR751-D
Set the parameters for CR800-D, CRnD-700, CR750-D, or CR751-D.

Robot controller (CR800-D, CRnD-700, CR750-D, CR751-D)
For the details of the robot controller (CR800-D, CRnD-700, CR750-D, or CR751-D), refer to the following.
Manual of the robot controller used

Compatible models
CR800-D, CRnD-700, CR750-D, CR751-D

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:1
:1
:192.168.0.18

N/W No.
PC No.
IP address
Port No. :5001

:1
:2
:192.168.0.19

<CRnD-700, CR750-D, CR751-D>
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■CR800-D
Use RT ToolBox3 to set parameters.

○: Required    : Set if necessary    ×: Not required

■CRnD-700, CR750-D, CR751-D
Use RT ToolBox2 or R32TB/R56TB to set parameters.
 • For RT ToolBox2

○: Required : Set if necessary ×: Not required

Item Setting Setting
(with GOT connected)

IP Address (NETIP) [192.168.0.19] ○

Item Setting Setting
(with GOT connected)

[NETIP] [192.168.0.19] ○

[GOTPORT] [5001] ○
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 • For R32TB or R56TB

(For R56TB)

○: Required : Set if necessary ×: Not required

Setting on personal computer
Set the IP address.

Communication check
■Ping test
When the CNC C70 is ready for communications, execute the Ping command with the command prompt of Windows.
When the Ping test is verified
C: \>Ping  192. 168. 0. 19
Reply from 192.168.0.19:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C: \>Ping  192. 168. 0. 19
Request timed out.
When the Ping test is not verified, check the connections of the cable and unit, and settings, including the IP address, for 
Windows.

■Station monitoring function
For details on the station monitoring function, refer to the following manual.
 GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

Item Setting Setting
(with GOT connected)

[NETIP] [192.168.0.19] ○

[GOTPORT] [5001] ○
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Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 To select [CRnD-700] in [Unit Type], set [Controller Type] to [MELSEC-Q/QS, Q17nD/M/NC/DR, CRnD-700].

Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select the type of the target Ethernet module. • CR800-D: [CR800]
• CRnD-700: [CRnD-700] *1

[IP Address] Set the IP address of the target Ethernet module. [0.0.0.0] to [255.255.255.255]

[Port No.] Set the port number of the target Ethernet module. • CR800-D: [5006], [5007]
• CRnD-700: [5001]

[Communication] Select a communication method. • CR800-D:
[UDP] (for port No. 5006),[TCP] (for port 
No. 5007)
• CRnD-700: [UDP]
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3.17 Inverter Connection (Direct Connection)
Only available to GT SoftGOT2000 (Multiple channels).
For connecting GT SoftGOT2000 and an inverter via a PLC, refer to the following.
Page 360 Inverter Connection (via PLC)

System configuration

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver, or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 Indicates the number of personal computers connectable to one inverter.
*3 Indicates the number of inverters connectable to one personal computer.
*4 When the communication type is Ethernet connection and the communication format is TCP, use an inverter with SERIAL (serial 

No.)"□7Z******" or later.
SERIAL (serial No.) is described on a rating plate of the inverter.

*5 Use an inverter with SERIAL (serial No.) "□88******" or later.
For FR-E700-SC-NNE and FR-E700-SC-ENE, use an inverter with SERIAL (serial No.) "□89******" or later.
SERIAL (serial No.) is described on a rating plate of the inverter.

*6 A built-in option (FR-A8NCG) is required.
Use an inverter with the following SERIAL (serial No.).
SERIAL (serial No.) is described on a rating plate of the inverter.

Inverter Connection 
cable *1

Max. distance GT SoftGOT2000 Number of connectable devices 
per channel

Model name Communication 
type

Personal 
computer *2

Inverter *3

FR-E7□0-NE *5

FR-A8□0 *6

FR-A8□2 *6

FR-A8□6 *6

FR-A8□0-GN
FR-A8□2-GN
FR-A8□0-E *4

FR-A8□2-E *4

FR-A8□6-E *4

FR-A8□0-E-CRN
FR-A8□2-E-CRN
FR-A8□0-E-R2R
FR-A8□2-E-R2R
FR-A8□0-E-AWH
FR-A8□0-E-LC
FR-F8□0 *6

FR-F8□2 *6

FR-F8□6 *6

FR-F8□0-E *4

FR-F8□2-E *4

FR-E8□0-E

Ethernet Twisted pair cable 100 m
(max. segment 
length)

Windows-compatible 
personal computer
PC CPU module
MELIPC

UDP: Unlimited
TCP: 1

UDP: 128
(16 or less 
recommended)
TCP: 128
(16 or less 
recommended)

Country of origin indication SERIAL (serial No.)
MADE in Japan □96****** and later

MADE in China □97****** and later

Inverter GT SoftGOT2000
Connection cable
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Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

Controller setting

Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

 • When connecting to an inverter in communication format [TCP]
When setting [TCP] to the communication format for connection to an inverter, use an inverter with SERIAL 
(serial No.) "□7Z******" or later.
SERIAL (serial No.) is provided on the rating plate of the inverter.

Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Set value
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select the type of the target Ethernet module. [FREQROL]

[IP Address] Set the IP address of the target Ethernet module. Inverter side IP address

[Port No.] Set the port number of the target Ethernet module. Inverter side port No.

[Communication] Displays the communication method. Adjust the settings with the Inverter settings.
[UDP] only for the connection to FR-E700-NE
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Inverter side settings
For details of the inverter, refer to the manual of each series.

■Connecting to FR-A800, FR-F800, or FR-E800 series (FR-A8□0-E, FR-A8□2-E, FR-A8□6-E, FR-
F8□0-E, FR-F8□2-E, or FR-E8□0-E)

 • Communication settings
For setting up the inverter, refer to the following.
Manual of the inverter used
 • Communication port and corresponding parameters

 • Communication settings of inverter
Set the following parameters using the PU (parameter unit).
Do not change the communication setting parameters from GT SoftGOT2000.
If the parameters are changed, communication with GT SoftGOT2000 may be disabled.
○: Required : Set if necessary

GT SoftGOT2000 
connection destination

Parameters corresponding to inverter

Ethernet connector Pr.79, Pr.340, Pr.342, Pr.414, Pr.502, Pr.549 to 551, Pr.779, Pr.1424 to 1429, Pr.1431 to 1432, Pr.1434 to 1455

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 
connected)

Operation mode switching Pr.79 0 (default) *3 

Communication startup mode Pr.340 10 *3 

Communication EEPROM write selection Pr.342 0 (default) *3 

PLC function operation *4 Pr.414 0 (default) *3*4 

Stop mode selection at communication error Pr.502 0 (default) *3 

Protocol selection Pr.549 0 (default) ○

NET mode command source selection Pr.550 5 *3 

PU mode command source selection Pr.551 2 *3 

Operation frequency during communication error Pr.779 9999 (default) *3 

Ethernet communication network number *2 Pr.1424 1 to 239 ○

Ethernet communication station number *2 Pr.1425 1 to 120 ○

Link speed and duplex mode selection Pr.1426 0 (default) *3 

Ethernet function selection 1 *2 Pr.1427 5000 to 5002,
5006 to 5008

○

Ethernet function selection 2 Pr.1428 9999 (default) *3 

Ethernet function selection 3 Pr.1429 9999 (default) *3 

Ethernet signal loss detection function selection Pr.1431 0 (default) *3 

Ethernet communication check time interval Pr.1432 9999 (default) *3 

Ethernet IP address 1 (Built-in Ethernet) *2 Pr.1434 0 to 255 ○

Ethernet IP address 2 (Built-in Ethernet) *2 Pr.1435 0 to 255 ○

Ethernet IP address 3 (Built-in Ethernet) *2 Pr.1436 0 to 255 ○

Ethernet IP address 4 (Built-in Ethernet) *2 Pr.1437 0 to 255 ○

Subnet mask 1 *2 Pr.1438 255 (default) *3 

Subnet mask 2 *2 Pr.1439 255 (default) *3 

Subnet mask 3 *2 Pr.1440 255 (default) *3 

Subnet mask 4 *2 Pr.1441 0 (default) *3 

Ethernet IP filter address 1 Pr.1442 0 (default) *3 

Ethernet IP filter address 2 Pr.1443 0 (default) *3 

Ethernet IP filter address 3 Pr.1444 0 (default) *3 

Ethernet IP filter address 4 Pr.1445 0 (default) *3 

Ethernet IP filter address 2 range specification Pr.1446 9999 (default) *3 

Ethernet IP filter address 3 range specification Pr.1447 9999 (default) *3 

Ethernet IP filter address 4 range specification Pr.1448 9999 (default) *3 
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*1 Setting items are the parameter names described in the FR-A800, FR-F800, and FR-E800 series manuals.
*2 You can change the GT SoftGOT2000 side settings.

When you change the GT SoftGOT2000 side settings, change the inverter side settings accordingly.
*3 Change the setting depending on the usage environment.
*4 The inverter side setting defaults to [0] (invalid). To use the PLC function, set [1] or [2].

Ethernet command source selection IP address 1 Pr.1449 0 (default) *3 

Ethernet command source selection IP address 2 Pr.1450 0 (default) *3 

Ethernet command source selection IP address 3 Pr.1451 0 (default) *3 

Ethernet command source selection IP address 4 Pr.1452 0 (default) *3 

Ethernet command source selection IP address 3 range specification Pr.1453 9999 (default) *3 

Ethernet command source selection IP address 4 range specification Pr.1454 9999 (default) *3 

Keepalive time Pr.1455 3600 *3 

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 
connected)
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■Connecting to FR-E700 series (FR-E7□0-NE)
 • Communication settings
For setting up the inverter, refer to the following.
Manual of the inverter used
 • Communication port and corresponding parameters

 • Communication settings of inverter
Set the following parameters using the PU (parameter unit).
Do not change the communication setting parameters from GT SoftGOT2000.
If the parameters are changed, communication with GT SoftGOT2000 may be disabled.
○: Required : Set if necessary

GOT connection 
destination

Parameters corresponding to inverter

Ethernet connector Pr.79, Pr.340,Pr.342, Pr.442 to 445, Pr.502, Pr.549 to 551, Pr.805 to 812, Pr.830 to 835, Pr.837 to 852

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 
connected)

Operation mode switching Pr.79 0 (default) *3 

Communication startup mode Pr.340 10 *3 

Communication EEPROM write selection Pr.342 0 (default) *3 

Stop mode selection at communication error Pr.502 0 (default) *3 

Protocol selection Pr.549 0 (default) ○

NET mode command source selection Pr.550 0 (default) *3 

PU mode command source selection Pr.551 2 *3 

Ethernet communication network number *2 Pr.830 1 to 239 ○

Ethernet communication station number *2 Pr.831 1 to 120 ○

Link speed and duplex mode selection Pr.832 0 (default) 

Ethernet function selection 1 *2 Pr.833 30, 31, 36, 38 ○

Ethernet function selection 2 Pr.834 20 (default) *3 

Ethernet function selection 3 Pr.835 9999 (default) *3 

Ethernet signal loss detection function selection Pr.851 3 (default) *3 

Ethernet communication check time interval Pr.852 1.5 seconds (default) *3 

Ethernet IP address 1 (Built-in Ethernet) *2 Pr.805 0 to 255 ○

Ethernet IP address 2 (Built-in Ethernet) *2 Pr.806 0 to 255 ○

Ethernet IP address 3 (Built-in Ethernet) *2 Pr.807 0 to 255 ○

Ethernet IP address 4 (Built-in Ethernet) *2 Pr.808 0 to 255 ○

Subnet mask 1 *2 Pr.809 255 (default) *3 

Subnet mask 2 *2 Pr.810 255 (default) *3 

Subnet mask 3 *2 Pr.811 255 (default) *3 

Subnet mask 4 *2 Pr.812 0 (default) *3 

Gateway address 1 *2 Pr.442 0 (default) *3 

Gateway address 2 *2 Pr.443 0 (default) *3 

Gateway address 3 *2 Pr.444 0 (default) *3 

Gateway address 4 *2 Pr.445 0 (default) *3 

Ethernet IP filter address 1 Pr.837 0 (default) *3 

Ethernet IP filter address 2 Pr.838 0 (default) *3 

Ethernet IP filter address 3 Pr.839 0 (default) *3 

Ethernet IP filter address 4 Pr.840 0 (default) *3 

Ethernet IP filter address 2 range specification Pr.841 9999 (default) *3 

Ethernet IP filter address 3 range specification Pr.842 9999 (default) *3 

Ethernet IP filter address 4 range specification Pr.843 9999 (default) *3 

Ethernet command source specification IP address 1 Pr.844 0 (default) *3 

Ethernet command source specification IP address 2 Pr.845 0 (default) *3 

Ethernet command source specification IP address 3 Pr.846 0 (default) *3 
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*1 Setting items are the parameter names described in the FR-E700 series manuals.
*2 You can change the GT SoftGOT2000 side settings.

When you change the GT SoftGOT2000 side settings, change the inverter side settings accordingly.
*3 Change the setting depending on the usage environment.

Ethernet command source specification IP address 4 Pr.847 0 (default) *3 

Ethernet command source selection IP address 3 range specification Pr.848 9999 (default) *3 

Ethernet command source selection IP address 4 range specification Pr.849 9999 (default) *3 

Ethernet TCP disconnection time coefficient Pr.850 3600 *3 

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 
connected)
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■Connecting to FR-A800 Plus series (FR-A8□0-E-CRN, FR-A8□2-E-CRN, FR-A8□0-E-R2R, FR-
A8□2-E-R2R, FR-A8□0-E-AWH, or FR-A8□0-E-LC)

 • Communication settings
For setting up the inverter, refer to the following.
Manual of the inverter used
 • Communication port and corresponding parameters

 • Communication settings of inverter
Set the following parameters using the PU (parameter unit).
Do not change the communication setting parameters from GT SoftGOT2000.
If the parameters are changed, communication with GT SoftGOT2000 may be disabled.
○: Required : Set if necessary

GOT connection 
destination

Inverter side parameter (R2R) Inverter side parameter (CRN, AWH, LC)

Ethernet connector Pr.79, Pr.340, Pr.342, Pr.442 to 445, Pr.502, Pr.549 to 551, 
Pr.1073 to 1078, Pr.1431 to 1432, Pr.1434 to 1455

Pr.79, Pr.340, Pr.342, Pr.442 to 445, Pr.502, Pr.549 to 551, 
Pr.1424 to 1429, Pr.1431 to 1432, Pr.1434 to 1455

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 connected)

Operation mode switching Pr.79 0 (default) *3 

Communication startup mode Pr.340 10 *3 

Communication EEPROM write selection Pr.342 0 (default) *3 

Stop mode selection at communication error Pr.502 0 (default) *3 

Protocol selection Pr.549 0 (default) ○

NET mode command source selection Pr.550 9999 (default) *3 

PU mode command source selection Pr.551 2 *3 

Ethernet communication network number *2 Pr.1073 (R2R) or Pr.1424 (CRN, 
AWH, LC)

1 to 239 ○

Ethernet communication station number *2 Pr.1074 (R2R) or Pr.1425 (CRN, 
AWH, LC)

1 to 120 ○

Link speed and duplex mode selection Pr.1075 (R2R) or Pr.1426 (CRN, 
AWH, LC)

0 (default) 

Ethernet function selection 1 *2 Pr.1076 (R2R) or Pr.1427 (CRN, 
AWH, LC)

5000 to 5002, 5006 to 
5008

○

Ethernet function selection 2 Pr.1077 (R2R) or Pr.1428 (CRN, 
AWH, LC)

45237 (default) *3 

Ethernet function selection 3 Pr.1078 (R2R) or Pr.1429 (CRN, 
AWH, LC)

9999 (default) *3 

Ethernet signal loss detection function selection Pr.1431 0 (default) *3 

Ethernet communication check time interval Pr.1432 9999 (default) *3 

Ethernet IP address 1 (Built-in Ethernet) *2 Pr.1434 0 to 255 ○

Ethernet IP address 2 (Built-in Ethernet) *2 Pr.1435 0 to 255 ○

Ethernet IP address 3 (Built-in Ethernet) *2 Pr.1436 0 to 255 ○

Ethernet IP address 4 (Built-in Ethernet) *2 Pr.1437 0 to 255 ○

Subnet mask 1 *2 Pr.1438 255 (default) *3 

Subnet mask 2 *2 Pr.1439 255 (default) *3 

Subnet mask 3 *2 Pr.1440 255 (default) *3 

Subnet mask 4 *2 Pr.1441 0 (default) *3 

Ethernet IP filter address 1 Pr.1442 0 (default) *3 

Ethernet IP filter address 2 Pr.1443 0 (default) *3 

Ethernet IP filter address 3 Pr.1444 0 (default) *3 

Ethernet IP filter address 4 Pr.1445 0 (default) *3 

Ethernet IP filter address 2 range specification Pr.1446 9999 (default) *3 

Ethernet IP filter address 3 range specification Pr.1447 9999 (default) *3 

Ethernet IP filter address 4 range specification Pr.1448 9999 (default) *3 

Ethernet command source selection IP address 1 Pr.1449 0 (default) *3 

Ethernet command source selection IP address 2 Pr.1450 0 (default) *3 
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*1 Setting items are the parameter names described in the FR-A800 Plus series manuals.
*2 You can change the GT SoftGOT2000 side settings.

When you change the GT SoftGOT2000 side settings, change the inverter side settings accordingly.
*3 Change the setting depending on the usage environment.
*4 For the precautions for the TCP/IP connection, refer to the following.

Page 359 Connecting GT SoftGOT2000 and an inverter using TCP/IP
 • Parameters for monitoring data specific to FR-A800 Plus series
How to monitor the winding length (upper + lower) (PV29)
Set Pr.645 (Winding diameter storage selection) to [1], and set Pr.1263 (Stored winding length (lower 4 digits)) and Pr.1298 
(Stored winding length (upper 4 digits)) on the inverter side.
Communication drivers of FREQROL (Batch monitor) that supports monitoring PV are the setting target.

*1 Setting items are the parameter names described in the FR-A800 Plus series manuals.
*2 The unit differs depending on the setting of Pr.1262.

Ethernet command source selection IP address 3 Pr.1451 0 (default) *3 

Ethernet command source selection IP address 4 Pr.1452 0 (default) *3 

Ethernet command source selection IP address 3 range 
specification

Pr.1453 9999 (default) *3 

Ethernet command source selection IP address 4 range 
specification

Pr.1454 9999 (default) *3 

Keepalive time Pr.1455 3600s (default) *3*4 

Setting item *1 Parameter No. Setting range Description
Winding diameter storage selection Pr.645 0, 1 Select whether to store the winding diameter or winding 

length.
0: Not stored.
1: The current winding diameter is stored.

Stored winding diameter Pr.646 1 to 6553 mm The stored winding diameter can be read/written.

Operation time with stored winding 
diameter

Pr.647 0 to 100 s Set the time to hold the stored winding diameter after the 
start signal turns on.

Target winding diameter Pr.648 1 to 6563 mm Set the winding diameter to output the Target Winding 
Diameter signal (Y233).

Winding length increment Pr.1262 0 1km

1 100m

2 10m

3 1m

4 1cm

5 1mm

Stored winding length (lower 4 digits) Pr.1263 0 to 9999 m *2 The stored winding length (lower 4 digits) can be read/
written.

Winding length detection (lower 4 digits) Pr.1264 0 to 9999 m *2 Set the winding length (lower 4 digits) to output the 
Winding/Unwinding Completion signal (Y234).

Stored winding length (upper 4 digits) Pr.1298 0 to 9999 m *2 The stored winding length (upper 4 digits) can be read/
written.

Stored winding length increment Pr.1299 0 1m

1 1cm

2 1mm

Winding length detection (upper 4 digits) Pr.1346 0 to 9999 m *2 Set the winding length (upper 4 digits) to output the 
Winding/Unwinding Completion signal (Y234).

Setting item *1 Parameter No. Set value Setting (with GT 
SoftGOT2000 connected)
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How to monitor the actual line speed (PV27)
The actual line speed can be set with the input value of the line speed command by setting Pr.362 (Actual line speed input se-
lection) to [0].
For the line speed command, a value can be set in Pr.360 by setting Pr.361 (Line speed command input selection) to [8].
Communication drivers of FREQROL (Batch monitor) that supports monitoring PV are the setting target.

Setting item *1 Parameter No. Setting range Description
Line speed command voltage/current bias Pr.350 0 to 100% Set the converted value (%) of the bias voltage (current) 

for analog input.

Line speed command bias Pr.351 0 to 6553.4 m/min *2 Set the bias line speed command value for analog input.

Line speed command voltage/current gain Pr.352 0 to 100% Set the converted value (%) of the gain voltage (current) 
for analog input.

Line speed command gain Pr.353 0 to 6553.4 m/min *2

9999
Set the gain line speed command value for analog input.

Line speed command pulse input bias Pr.354 0 to 500k pulses/s Set the number of bias input pulses for pulse train input.

Line speed command pulse input gain Pr.355 0 to 500k pulses/s Set the number of gain input pulses for pulse train input.

Line speed command digital input bias Pr.356 0 to 65535 Set the bias line speed command value for pulse train 
input.

Line speed command digital input gain Pr.357 0 to 65535 Set the gain line speed command value for pulse train 
input.

Line speed unit Pr.358 0 m/min

1 m/sec

2 mm/min

3 mm/sec

Line speed command value Pr.360 0 to 6553.4 m/min *2 Set the line speed command value.

Line speed command input selection Pr.361 0 According to the priority of the speed command rights

1 Terminal JOG single-phase pulse train input

2 FR-A8AP/FR-A8AL/FR-A8TP encoder pulse train input

3 Terminal 2 (0% to 100%)

4 Terminal 4 (20% to 100%)

5 Terminal 1 (-100% to 100%)

6 Terminal 6 (FR-A8AZ) (-100% to 100%)

7 FR-A8AL single-phase pulse train input

8 Line speed command according to the setting of Pr.360 
(Line speed command value)

9999 No function

Actual line speed input selection Pr.362 0 (Default) V* (line speed command)

1 Terminal JOG single-phase pulse train input

2 FR-A8AP/FR-A8AL/FR-A8TP encoder pulse train input 
(complementary 12 V / differential 5 V (A-, B-phases))  *3

3 Terminal 2 (analog value: 0% to 100%) (0 to 5 V DC) *4

4 Terminal 4 (analog value: 20% to 100%) (4 to 20 mA DC) 
*4

5 Terminal 1 (analog value: -100% to 100%) (0 to ±10 V 
DC) *4

6 Terminal 6 (FR-A8AZ) (analog value: -100% to 100%) (0 
to ±10 V DC) *4

7 FR-A8AL single-phase pulse train input (PP, NP)

9999 No function *5

Command pulse selection Pr.428 0 Forward/Reverse pulse train (negative logic)

1 Pulse train + rotation direction sign (negative logic)

2 A/B-phase pulse train (negative logic)

3 Forward/Reverse pulse train (positive logic)

4 Pulse train + rotation direction sign (positive logic)

5 A/B-phase pulse train (positive logic)

Start line speed command Pr.622 0 to 6553.4 m/min *2 Set the line speed command to start operation.

Line multi-speed setting (high-speed) Pr.1265 0 to 6553.4 m/min *2 Set the line speed command value when the RH signal is 
ON.
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*1 Setting items are the parameter names described in the FR-A800 Plus series manuals.
*2 The unit differs depending on the setting of Pr.358.
*3 When Pr.362 is set to [2], select the option to input the actual line speed with Pr.862.
*4 These input specifications are the default.
*5 When Pr.362 is set to [9999] (No function), the actual line speed is handled as 0.

Line multi-speed setting (middle-speed) Pr.1266 0 to 6553.4 m/min *2 Set the line speed command value when the RM signal is 
ON.

Line multi-speed setting (low-speed) Pr.1267 0 to 6553.4 m/min *2 Set the line speed command value when the RL signal is 
ON.

Line multi-speed setting (4-speed) Pr.1268 0 to 6553.4 m/min *2 The line speed can be set from 4-speed to 15-speed 
according to the combination of the RH, RM, RL, and 
REX signals.

Line multi-speed setting (5-speed) Pr.1269 0 to 6553.4 m/min *2

Line multi-speed setting (6-speed) Pr.1270 0 to 6553.4 m/min *2

Line multi-speed setting (7-speed) Pr.1271 0 to 6553.4 m/min *2

Line multi-speed setting (8-speed) Pr.1272 0 to 6553.4 m/min *2

Line multi-speed setting (9-speed) Pr.1273 0 to 6553.4 m/min *2

Line multi-speed setting (10-speed) Pr.1274 0 to 6553.4 m/min *2

Line multi-speed setting (11-speed) Pr.1275 0 to 6553.4 m/min *2

Line multi-speed setting (12-speed) Pr.1276 0 to 6553.4 m/min *2

Line multi-speed setting (13-speed) Pr.1277 0 to 6553.4 m/min *2

Line multi-speed setting (14-speed) Pr.1278 0 to 6553.4 m/min *2

Line multi-speed setting (15-speed) Pr.1279 0 to 6553.4 m/min *2

Setting item *1 Parameter No. Setting range Description
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Precautions

Connection port of the inverter
Make sure to connect an Ethernet cable to an Ethernet port of an inverter.
When connecting an Ethernet cable by mistake to a PU port, there is a fear that equipment is damaged.

Monitoring virtual devices (RS, WS, A, Pr, PG, SP)
Virtual devices (RS, WS, A, Pr, PG, SP) of a single inverter cannot be monitored simultaneously from multiple GOTs.

Connecting GT SoftGOT2000 and an inverter using TCP/IP
When GT SoftGOT2000 and an inverter connected using TCP/IP are disconnected, reconnection may not be established.
In such a case, reset the inverter, or shorten the keepalive time and Ethernet TCP disconnection time coefficient.
For setting the keepalive time and Ethernet TCP disconnection time coefficient, refer to the following.
Manual of the inverter used

Monitoring PLC devices and virtual devices of an inverter simultaneously
In the following cases, the speed of monitoring the PLC devices through GT SoftGOT2000 and the inverter decreases.
 • Monitoring PLC devices and virtual devices of an inverter on the same screen or background
 • Resetting the inverter
By connecting a different channel for each controller with the multi-channel function, the decreasing device monitor speed of 
the PLC can be improved.

Link device of the CC-Link IE Field Network
When functions (signals) are assigned to the link devices (RX, RY, RWr, RWw) on the inverter side, GT SoftGOT2000 cannot 
write data to the virtual devices of these functions.
Example) CMD1 (Forward rotation command)
Since the forward rotation command is assigned to RY0 on the inverter side, GT SoftGOT2000 cannot write data to a virtual 
device CMD1 (forward rotation command).
For the functions (signals) assigned to link devices, refer to the following.
Manual of the inverter used
Control the functions (signals) assigned to the link devices (RX, RY, RWw, and RWr) on the master station.
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3.18 Inverter Connection (via PLC)
Only available to GT SoftGOT2000 (Multiple channels).
For directly connecting GT SoftGOT2000 and an inverter, refer to the following.
Page 349 Inverter Connection (Direct Connection)

System configuration

*1 Use the inverter whose SERIAL (serial No.) is "□88******" or later.
For the FR-E700-SC-NNE and FR-E700-SC-ENE, use the inverter whose SERIAL (serial No.) is "□89******" or later.
SERIAL (serial No.) is described on a rating plate of the inverter.

*2 When the communication type is Ethernet connection and the communication format is TCP, use the inverter whose SERIAL (serial No.) 
is "□7Z******" or later.
SERIAL (serial No.) is described on a rating plate of the inverter.

Inverter PLC Connection type GT SoftGOT2000 Number of 
connectable 
devices

Model Communication 
type

CPU model

FR-E7□0-NE *1

FR-A8□0-E *2

FR-A8□2-E *2

FR-A8□6-E *2

FR-A8□0-E-CRN
FR-A8□2-E-CRN
FR-A8□0-E-R2R
FR-A8□2-E-R2R
FR-A8□0-E-AWH
FR-A8□0-E-LC
FR-F8□0-E *2

FR-F8□2-E *2

FR-E8□0-E

Ethernet RCPU
QCPU
LCPU

For details on the system configuration 
between GT SoftGOT2000 and a PLC, 
refer to the following.
Page 229 Ethernet Connection

Windows-compatible 
personal computer
PC CPU module
MELIPC

Varying with the 
connection type

FR-A8□0 *3

FR-A8□2 *3

FR-A8□6 *3

FR-A8□0-GF
FR-A8□2-GF
FR-A8□0-CRN *3

FR-A8□2-CRN *3

FR-A8□0-R2R *3

FR-A8□2-R2R *3

FR-A8□0-LC *3

FR-F8□0 *3

FR-F8□2 *3

FR-F8□6 *3

CC-Link IE Field 
Network*6

RCPU
QCPU
LCPU

FR-A8□0 *4

FR-A8□2 *4

FR-A8□6 *4

FR-A8□0-GN
FR-A8□2-GN
FR-F8□0 *4

FR-F8□2 *4

FR-F8□6 *4

FR-E8□0-E

CC-Link IE TSN*5 RCPU

PLC
Ethernet

Inverter
Ethernet 
CC-Link IE Field Network
CC-Link IE TSN

GT SoftGOT2000
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*3 CC-Link IE Field Network Communication Option (FR-A8NCE) is required.
Use a CC-Link IE Field Network communication option (FR-A8NCE) whose SERIAL (serial No.) is "□83***" or later. 
SERIAL (serial No.) is described on the CC-Link IE Field Network communication option (FR-A8NCE).

*4 A built-in option (FR-A8NCG) is required.
Use the inverter whose SERIAL (serial No.) is the following.
SERIAL (serial No.) is described on a rating plate of the inverter.

*5 When connecting a GOT and inverter via the PLC, set the third octet of the inverter IP address to the network No., and the fourth octet 
to the station No.
The following shows a setting example of the IP address when the network No. is "1" and the station No. is "2".

For the setting details, refer to the following. 
FR-A800-GN CC-LINK IE TSN FUNCTION MANUAL
FR-A8NCG INSTRUCTION MANUAL

*6 Use an inverter with SERIAL (serial No.) "□83******" or later. 
SERIAL (serial No.) is described on a rating plate of the inverter.

Connection cable
For details on the cable between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection
For details on the cable between an inverter and a PLC, refer to the following.
FR-E700-NE ETHERNET FUNCTION MANUAL
FR-A800-E/F800-E ETHERNET FUNCTION MANUAL
FR-A8NCE INSTRUCTION MANUAL

Controller setting

Setting of a controller through which GT SoftGOT2000 monitors an inverter
For details on the setting between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection

Precautions
For the precautions for the inverter connection, refer to the following.
Page 359 Precautions

Country of origin indication SERIAL (serial No.)
MADE in Japan □96****** and later

MADE in China □97****** and later

192.168

Station No.

Network No.

. 2. 1
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3.19 Servo amplifier connection (via Motion controller 
or Simple Motion module)

System configuration

Servo amplifier Motion controller or PLC GT 
SoftGOT2000

Number of connectable 
devices

Model Communication 
type

Simple motion 
module

CPU 
model

Connection type Personal 
computer 
*3

Motion 
controller 
or PLC *4

MR-J4-□B
MR-J4-□B-RJ
MR-J4W2-□B
MR-J4W3-□B

SSCNET III/H *1 - RnMTCPU
Q17nDS *8

Q170MS *8

Varying with the CPU 
model *5

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC*6

Varying with 
the 
connection 
type *5

Varying with 
the 
connection 
type *5RD77MS2

RD77MS4
RD77MS8
RD77MS16

RnCPU

QD77MS2 *7

QD77MS4 *7

QD77MS16 *7

QnCPU *8

LD77MS2
LD77MS4
LD77MS16

LnCPU *8

FX5-40SSC-S *2

FX5-80SSC-S*2*11
FX5CPU

MR-J5-□B*8

MR-J5-□B-RJ*8

MR-J5W2-□B*8

MR-J5W3-□B*8

- RnMTCPU
Q17nDS*9

Q170MS

RD77MS2
RD77MS4
RD77MS8
RD77MS16

RnCPU

QD77MS2*10

QD77MS4*10

QD77MS16*10

QnCPU

MR-JE-□B
MR-JE-□BF

SSCNET III/H *1 RD77MS2*12

RD77MS4*12

RD77MS8*12

RD77MS16*12

RnCPU

QD77MS2*13

QD77MS4*13

QD77MS16*13

QnCPU *8

LD77MS2 *13

LD77MS4 *13

LD77MS16 *13

LnCPU *8

FX5-40SSC-S *2

FX5-80SSC-S *2
FX5CPU

GT SoftGOT2000Servo
amplifier

Servo
amplifier

Motion controller 
CPU, or PLC CPU

Varies according to the
connection type.
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*1 The MR-J3 compatibility mode is not supported.
*2 This module is usable for the Ethernet connection only.
*3 Indicates the number of personal computers connectable to one motion controller or one PLC.
*4 Indicates the number of motion controllers and PLCs connectable to one personal computer.
*5 For the system configuration between GT SoftGOT2000 and a motion controller or PLC, refer to the following.

Page 229 Ethernet Connection
Page 299 Direct CPU connection (RS-232, USB)
Page 308 Serial Communication Connection
Page 322 CC-Link IE Controller Network Connection
Page 324 CC-Link IE Field Network Connection

*6 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.
*7 Use a module with the upper five digits later than 12042.
*8 Only available to GT SoftGOT2000 (Multiple channels).
*9 Use a module with OS software version 00Y or later.
*10 Use a module that has a serial number starting with 23092 or later.
*11 Use a module with software version 1.004 or later.
*12 Use firmware version 3 or later.
*13 Use a module with the upper five digits later than 16102.

Connection cable
The connection cable between GT SoftGOT2000 and a motion controller or PLC for monitoring a servo amplifier varies with 
the connection type.
For the details of the cable, refer to the following.
Page 229 Ethernet Connection
Page 299 Direct CPU connection (RS-232, USB)
Page 308 Serial Communication Connection
Page 322 CC-Link IE Controller Network Connection
Page 324 CC-Link IE Field Network Connection
For the details of the cable between a servo amplifier and a motion controller, refer to the following.
MELSEC iQ-R Motion Controller User's Manual
For the details of the cable between a servo amplifier and a simple motion module, refer to the following.
MELSEC iQ-R Simple Motion Module User's Manual (Startup)
MELSEC iQ-F FX5 Simple Motion Module User's Manual (Startup)
For the details of the cable between servo amplifiers, refer to the following.
MELSEC iQ-R Motion Controller User's Manual

Controller setting

Setting of a controller through which GT SoftGOT2000 monitors a servo amplifier
The setting of a motion controller or PLC through which GT SoftGOT2000 monitors a servo amplifier varies with the 
connection type.
For the setting details, refer to the following.
Page 229 Ethernet Connection
Page 299 Direct CPU connection (RS-232, USB)
Page 308 Serial Communication Connection
Page 322 CC-Link IE Controller Network Connection
Page 324 CC-Link IE Field Network Connection
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Precautions

Monitoring a servo amplifier during the test operation
When GT SoftGOT2000 monitors a servo amplifier during the test operation, if the communication between them is 
interrupted for 0.5 ms or more, the servo motor decelerates to a stop (servo-lock status).
Ensure the constant communication during the test operation by performing operations on GT SoftGOT2000, such as 
monitoring the servo amplifier status.

When accessing a servo amplifier simultaneously with a GOT or software application
Do not monitor or write a device value to a servo amplifier simultaneously from a GOT, GT Simulator3, GT SoftGOT2000, and 
other MELSOFT applications (such as MR Configurator2).
Doing so may cause the incorrect display of parameters and others on the GOT and software applications, or a servo 
amplifier malfunction.

When monitoring a PLC and a servo amplifier simultaneously
Do not monitor the following devices on one screen.
Doing so decreases the monitoring speed.
Devices of a PLC and devices of a servo amplifier
Devices of multiple servo amplifiers

Precautions for drawing
Set the data type of the monitoring target device according to the servo amplifier parameter specifications.
If you set the data type incorrectly, an unexpected value may be written to the device.
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3.20 Servo amplifier connection (via Simple Motion 
module or CC-Link IE Field Network master/local 
module)

Only available to GT SoftGOT2000 (Multiple channels).

System configuration

*1 Indicates the number of personal computers connectable to a PLC.
*2 Indicates the number of PLCs connectable to a personal computer.
*3 When connecting to the servo amplifier via the CC-Link IE Field network master/local unit, connect via the master station. In this case, a 

different network will be accessed, so the routing must be set.
*4 Use the following version or later.

Servo amplifier Motion controller or PLC GT 
SoftGOT2000

Number of connectable 
devices per CH

Model Communication 
type

Simple motion 
module or 
master/local 
module

CPU 
model

Connection type Personal 
computer 
*1

Motion 
controller 
or PLC *2

MR-J4-GF(-RJ) CC-Link IE Field 
Network

RD77GF4 *4

RD77GF8 *4

RD77GF16 *4

RD77GF32

RCPU For details on the system 
configuration between GT 
SoftGOT2000 and a PLC, 
refer to the following.
Page 229 Ethernet 
Connection

Windows-
compatible 
personal 
computer
PC CPU module
MELIPC

For details on the system 
configuration between GT 
SoftGOT2000 and a PLC, 
refer to the following.
Page 229 Ethernet 
Connection

QD77GF4 *4

QD77GF8 *4

QD77GF16 *4

QCPU

RnENCPU RCPU

RJ71EN71
RJ71GF11-T2 *3

RCPU

QJ71GF11-T2 *3*4 QCPU

LJ71GF11-T2 *3*4 LCPU

Simple motion module or master/local module Motion mode I/O mode
RD77GF4, RD77GF8, RD77GF16 Software version [01] or later Software version [02] or later

QD77GF4, QD77GF8, QD77GF16 From first product First 5 digits of serial No. 18022 or higher

QJ71GF11-T2 - First 5 digits of serial No. 14102 or higher

LJ71GF11-T2 - First 5 digits of serial No. 14102 or higher

GT SoftGOT2000Servo
amplifier

Servo
amplifier

PLC

Ethernet

CC-Link IE Field Network
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Connection cable
For details of the cable between GT SoftGOT2000 and a PLC through which servo amplifiers are monitored, refer to the 
following.
Page 229 Ethernet Connection
For the details of the cable between a servo amplifier and a simple motion module, refer to the following.
MELSEC iQ-R Simple Motion Module User's Manual (Startup)
MELSEC iQ-F FX5 Simple Motion Module User's Manual (Startup)
For the details of the cable between servo amplifiers, refer to the following.
MELSEC iQ-R Motion Controller User's Manual

Controller setting

Setting of a controller through which GT SoftGOT2000 monitors a servo amplifier
For details of the settings between GT SoftGOT2000 and a PLC through which servo amplifiers are monitored, refer to the 
following.
Page 229 Ethernet Connection

Precautions
For the precautions for the servo amplifier connection, refer to the following.
Page 364 Precautions
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.20  Servo amplifier connection (via Simple Motion module or CC-Link IE Field Network master/local module)



3

3.21 Servo Amplifier Connection (via Motion Module)
Only available to GT SoftGOT2000 (Multiple channels).

System configuration

*1 Select either of the following for [Unit Type] in [Connected Ethernet Controller Setting] in GT Designer3.
• For RnCPU and RnENCPU: [RCPU]
• For R12CCPU-V: [RnCCPU/RnWCPU]
Set either of the following values for [Port No.] according to the communication method.
• UDP: [5006]
• TCP: [5007]
For [Connected Ethernet Controller Setting] in GT Designer3, refer to the following.
• For RnCPU or RnENCPU
Page 241 Settings in GT Designer3
• For R12CCPU-V
Page 272 Settings in GT Designer3

*2 Select [FX5CPU] for [Unit Type] in [Connected Ethernet Controller Setting] in GT Designer3.
For [Connected Ethernet Controller Setting] in GT Designer3, refer to the following.
Page 256 Settings in GT Designer3

*3 When monitoring a servo amplifier through a Motion module, the modes available for the servo amplifier depend on the firmware version 
of the Motion module to be used.
The following shows the details.

Servo amplifier PLC GT 
SoftGOT2000

Number of 
connectable 
devices

Model Communication 
type

Motion 
module*3

CPU model Connection type

MR-J5-□G
MR-J5-□G-RJ
MR-J5W2-□G
MR-J5W3-□G
MR-J5D1-□G4
MR-J5D2-□G4
MR-J5D3-□G4
MR-JET-□G

CC-Link IE TSN RD78G4
RD78G8
RD78G16
RD78G32
RD78G64
RD78GHV
RD78GHW

RnCPU *1

RnENCPU *1

R12CCPU-V *1

For details on the system 
configuration between GT 
SoftGOT2000 and a PLC, refer 
to the following.
Page 239 When using 
Built-in Ethernet port RCPU 
(one-to-one connection, multi-
connection)
For connection between GT 
SoftGOT2000 and a PLC, use 
an Ethernet port built in the 
PLC CPU.

Windows-
compatible personal 
computer
PC CPU module
MELIPC

One GT 
SoftGOT2000 
module for one 
Motion module

FX5-40SSC-G
FX5-80SSC-G

FX5U*2

FX5UC*2

Motion module Motion mode Simple Motion mode
RD78G4
RD78G8
RD78G16

From the first product Firmware version 16 or later

RD78G32
RD78G64

From the first product Unavailable

RD78GHV
RD78GHW

From the first product Unavailable

FX5-40SSC-G
FX5-80SSC-G

Unavailable From the first product

CC-Link IE TSN

Ethernet

PLC CPU GT SoftGOT2000
Servo
amplifier

Servo
amplifier
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Connection cable
For details on the cable between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection
For details on the cable between a servo amplifier and a Motion module, refer to the following.
MELSEC iQ-R Simple Motion Module User's Manual
For the details of the cable between servo amplifiers, refer to the following.
MELSEC iQ-R Motion Controller User's Manual

Controller setting

Setting of a controller through which GT SoftGOT2000 monitors an inverter
For details on the setting between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection

Precautions
For the precautions for the servo amplifier connection, refer to the following.
Page 364 Precautions
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3.22 Servo Amplifier Connection (via CC-Link IE TSN-
equipped Module)

Only available to GT SoftGOT2000 (Multiple channels).

System configuration

*1 Select either of the following for [Unit Type] in [Connected Ethernet Controller Setting] in GT Designer3.
• For RnCPU, RnENCPU, or RnSFCPU: [RCPU]
• For R12CCPU-V or R102WCPU-W: [RnCCPU/RnWCPU]
Set either of the following values for [Port No.] according to the communication method.
• UDP: [5006]
• TCP: [5007]
For [Connected Ethernet Controller Setting] in GT Designer3, refer to the following.
• For RnCPU, RnENCPU, or RnSFCPU
Page 241 Settings in GT Designer3
• For R12CCPU-V
Page 272 Settings in GT Designer3
• For R102WCPU-W
Page 275 Settings in GT Designer3

*2 Use the CC-Link IE TSN master/local module with firmware version 11 or later.
*3 Use a servo amplifier with firmware version as shown below.

Servo amplifier PLC GT 
SoftGOT2000

Number of 
connectable 
devices

Model Communication 
type

CC-Link IE 
TSN-equipped 
module

CPU model*1 Connection type

MR-J5-□G*3

MR-J5-□G-RJ*3

MR-J5W2-□G*3

MR-J5W3-□G*3

MR-J5D1-□G4*3

MR-J5D2-□G4*3

MR-J5D3-□G4*3

MR-JET-□G*3

CC-Link IE TSN RJ71GN11-T2*2 RnCPU 
RnENCPU
RnSFCPU
R12CCPU-V 
R102WCPU-W

For details on the system 
configuration between GT 
SoftGOT2000 and a PLC, 
refer to the following.
Page 229 Ethernet 
Connection

Windows-
compatible personal 
computer
PC CPU module
MELIPC

For details on the 
system configuration 
between GT 
SoftGOT2000 and a 
PLC, refer to the 
following.
Page 229 
Ethernet Connection

RJ71GN11-EIP RnCPU 
RnENCPU

Servo amplifier Applicable firmware version
MR-J5-□G
MR-J5-□G-RJ
MR-J5W2-□G
MR-J5W3-□G
MR-JET-□G

B9 or later

MR-J5D1-□G4
MR-J5D2-□G4
MR-J5D3-□G4

C0 or later

CC-Link IE TSN

Ethernet

PLC CPU GT SoftGOT2000
Servo
amplifier

Servo
amplifier
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Connection cable
For details on the cable between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection
For details on the cable between the servo amplifier and the CC-Link IE TSN master/local module, refer to the following.
MELSEC iQ-R CC-Link IE TSN User's Manual (Startup)
For details on the cable between the servo amplifier and the CC-Link IE TSN Plus master/local module, refer to the following.
MELSEC iQ-R CC-Link IE TSN Plus Master/Local Module User's Manual
For the details of the cable between servo amplifiers, refer to the following.
MELSEC iQ-R Motion Controller User's Manual

Controller setting

Setting of a controller through which GT SoftGOT2000 monitors an inverter
For details on the setting between GT SoftGOT2000 and a PLC, refer to the following.
Page 229 Ethernet Connection

Precautions
For the precautions for the servo amplifier connection, refer to the following.
Page 364 Precautions
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3.23 Servo Amplifier Connection (Direct Connection)
Only available to GT SoftGOT2000 (Multiple channels).

System configuration

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 1000BASE-T, ANSI/TIA/EIA-568-B (category 5e) standard.

*2 An Ethernet board/card is required.
Page 327 Ethernet board/card

*3 When GT SoftGOT2000 and Motion Control Software SWM-G are installed on the same personal computer, GT SoftGOT2000 can 
monitor a servo amplifier controlled by Motion software SWM-G.
Use firmware version 1.001B or later for Motion software SWM-G.
Since GT SoftGOT2000 and Motion Control Software SWM-G have different methods of connection with a servo amplifier, the IP 
communication mixed function needs to be set.
For Motion Control Software SWM-G and the IP communication mixed function, refer to the following.
Motion Control Software SWM-G User's Manual (Startup)

Model Communication 
type

connection cable *1 Max. 
distance

GT SoftGOT2000*3 Number of 
connectable 
devices per CH

MR-J5-□G
MR-J5-□G-RJ
MR-J5W2-□G
MR-J5W3-□G
MR-J5D1-□G4
MR-J5D2-□G4
MR-J5D3-□G4
MR-JET-□G

Ethernet Ethernet cable that meets the 
1000BASE-T standard:
Category 5e or higher,
(double-shielded, STP)
straight cable.

100 m
(Maximum 
segment 
length)

Windows-compatible personal 
computer*2

PC CPU module
MELIPC

One GT 
SoftGOT2000 
module for one 
servo amplifier

Ethernet

GT SoftGOT2000
Servo
amplifier
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Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

Controller setting
The following shows the settings and precautions for establishing communication between GT SoftGOT2000 and 
MELSERVO-J5 or MELSERVO-JET.
This section describes the system configuration to monitor the host as shown below.

*1 Although the setting is nonexistent on the servo amplifier side, set a virtual value on the GOT side.

Setting items
For setting the network number, station number, IP address, and port number of MELSERVO-J5, 
MELSERVO-JET, and GT SoftGOT2000, refer to the following.
Page 375 Settings in GT Designer3

The following shows the settings for communication with MELSERVO-J5 or MELSERVO-JET.

N/W No.
PC No.
IP address
Port No. :5001

<GT SoftGOT2000>

:1
:1
:192.168.3.18

N/W No.
PC No.
IP address

:1 (Fixed)
:2 (virtual)
:192.168.3.1

<CR800-D>

*1
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Before setting
■Precautions for communication
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

Compatible models

IP address setting for MELSERVO-J5, MELSERVO-JET
Set the IP address of MELSERVO-J5 or MELSERVO-JET.

Servo amplifier (MELSERVO-J5, MELSERVO-JET)
For the details of the servo amplifier (MELSERVO-J5, MELSERVO-JET), refer to the following manual.
Manual of the servo amplifier used

Compatible models
MR-J5-□G, MR-J5-□G-RJ, MR-J5W2-□G, MR-J5W3-□G, MR-J5D1-□G4, MR-J5D2-□G4, MR-J5D3-□G4, MR-JET-□G
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■[Network basic] of MR Configurator2

■IP address setting

Setting item Description Setting value
[NPA01] Select whether to set the IP address by the rotary switches or parameter.

The following shows the IP address when the rotary switches are used.
• First octet to third octet: Values set in [NPA02]
• Fourth octet: Values set by the rotary switches SW1 and SW2

When the parameter is used, the values set in [NPA02] are used as the IP address.

0: Use rotary switch
1: Use parameter

[NPA02] Set the IP address. 192.168.3.1 (Default)

[NPA04] Set the subnet mask. 255.255.255.0 (Default)

Setting value of [NPA01] Rotary switch (SW1, SW2) IP address
0 : Use rotary switch 00h First octet The first octet set in [NPA02] is used.

Second octet The second octet set in [NPA02] is used.

Third octet The third octet set in [NPA02] is used.

Fourth octet The fourth octet set in [NPA02] is used.

01h to FEh First octet The first octet set in [NPA02] is used.

Second octet The second octet set in [NPA02] is used.

Third octet The third octet set in [NPA02] is used.

Fourth octet The setting values of the rotary switches (SW1 and SW2) are used.

FFh First octet Not applicable

Second octet

Third octet

Fourth octet

1 : Use parameter ― First octet The first octet set in [NPA02] is used.

Second octet The second octet set in [NPA02] is used.

Third octet The third octet set in [NPA02] is used.

Fourth octet The fourth octet set in [NPA02] is used.
4 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Setting on personal computer
Set the IP address.

Communication check
■Ping test
When the CNC C70 is ready for communications, execute the Ping command with the command prompt of Windows.
When the Ping test is verified
C:\>Ping 192.168.3.1
Reply from 192.168.3.1:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192.168.3.1
Request timed out.
When the Ping test is not verified, check the connections of the cable and unit, and settings, including the IP address, for 
Windows.

■Station monitoring function
For details on the station monitoring function, refer to the following manual.
 GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 [Net No.] and [Station] should match [Network No.] and [Station No.] set for the monitoring target device.
*2 Since [0.0.0.0] and [255.255.255.255] cannot be set in the servo amplifier, set the IP address within the range of [0.0.0.1] to 

[255.255.255.254].
When [0.0.0.0] or [255.255.255.255] is set, a communication error occurs.

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] *1 Set the network number for the target servo amplifier. [1]

[Station] *1 Set the station number of the target servo amplifier. [1] to [254]

[Unit Type] Select the type of the target servo amplifier. [MR-J5(D)-G/MR-JET-G]

[IP Address] Set the IP address of the target servo amplifier. [0.0.0.1] to [255.255.255.254] *2

[Port No.] Set the port number of the target servo amplifier. [5010]

[Communication] Select a communication method. [UDP]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions
For the precautions for the servo amplifier connection, refer to the following.
Page 364 Precautions
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3.24 Connecting with GX Simulator3
System configuration
Install GX Works3 in the personal computer beforehand.
When global labels are set, use GX Works3 version 1.040S or later.
For details, refer to the following.
GX Works3 Operating Manual

Operating procedure
The following shows the procedure for connecting GT SoftGOT2000 with GX Simulator3.

1. Start GX Works3.
GX Works3 Operating Manual

2. Start GX Simulator3.
GX Simulator3 does not start automatically when GT SoftGOT2000 monitors project data.
Start GX Simulator3 from GX Works3 in advance.
GX Works3 Operating Manual

3. Start GT SoftGOT2000.
Page 52 Start GT SoftGOT2000

4. Set [Communication Setup] on GT SoftGOT2000.
Page 75 [Communication Setup] dialog

5. Open the project data to be monitored.
Page 104 Opening the Project

6. Monitor the project data with GT SoftGOT2000.
Page 108 Monitoring

7. Exit GT SoftGOT2000.
Page 60 Exiting from GT SoftGOT2000

Setting of GT SoftGOT2000
To establish communication between GT SoftGOT2000 and GX Simulator3, configure the communication setup.
For the communication setting of GT SoftGOT2000, refer to the following.
Page 97 [GX Simulator3]
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3.25 Connecting with GX Simulator2, MT Simulator2
System configuration
Install GX Works2 or MT Simulator2 in the personal computer beforehand.
For details, refer to the following.
GX Works2 Version□ Operating Manual

Operating procedure
The following shows the procedure for connecting GT SoftGOT2000 with GX Simulator2.

1. Start GX Works2.
GX Works2 Version□ Operating Manual (Common)

2. Start GX Simulator2.
GX Simulator2 does not start automatically when GT SoftGOT2000 monitors project data.
Start GX Simulator2 from GX Works2 in advance.
GX Works2 Version□ Operating Manual (Common)

3. Start GT SoftGOT2000.
Page 52 Start GT SoftGOT2000

4. Set [Communication Setup] on GT SoftGOT2000.
Page 75 [Communication Setup] dialog

5. Open the project data to be monitored.
Page 104 Opening the Project

6. Monitor the project data with GT SoftGOT2000.
Page 108 Monitoring

7. Exit GT SoftGOT2000.
Page 60 Exiting from GT SoftGOT2000

Setting of GT SoftGOT2000
Configure the communication setting for the communication between GT SoftGOT2000 and GX Simulator2.
For the communication setting of GT SoftGOT2000, refer to the following.
Page 95 [GX Simulator2]
Page 96 [GX Simulator2/MT Simulator2]
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3.26 Connecting with GX Simulator
System configuration
Install GX Simulator in the personal computer beforehand.
For details, refer to the following.
GX Simulator Version□ Operating Manual

Operating procedure
The following shows the procedure for connecting GT SoftGOT2000 with GX Simulator.

1. Start GX Simulator when using GX Developer.
If GX Developer is not used, GX Simulator is started automatically when GT SoftGOT2000 monitors data.
GX Simulator Version□ Operating Manual

2. Start GT SoftGOT2000.
Page 52 Start GT SoftGOT2000

3. Set [Communication Setup] on GT SoftGOT2000.
Page 75 [Communication Setup] dialog

4. Open the project data to be monitored.
Page 104 Opening the Project

5. Monitor the project data with GT SoftGOT2000.
Page 108 Monitoring

6. Exit GT SoftGOT2000.
Page 60 Exiting from GT SoftGOT2000

Setting of GT SoftGOT2000
Configure the communication setting for the communication between GT SoftGOT2000 and GX Simulator.
For the communication setting of GT SoftGOT2000, refer to the following.
Page 94 [GX Simulator]
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3.27 MELSOFT Mirror connection
System configuration
Connect the personal computer on which MELSOFT Mirror is installed and the personal computer on which GT SoftGOT2000 
is installed via Ethernet.
Otherwise, install MELSOFT Mirror and GT SoftGOT2000 on the same personal computer.

Operating procedure
The following shows the procedure for connecting GT SoftGOT2000 and MELSOFT Mirror.

1. Start MELSOFT Mirror.

2. Start GT SoftGOT2000.
Page 52 Start GT SoftGOT2000

3. Set [Communication Setup] on GT SoftGOT2000.
Page 75 [Communication Setup] dialog

4. Open the project data to be monitored.
Page 104 Opening the Project

5. Monitor the project data with GT SoftGOT2000.
Page 108 Monitoring

6. Exit GT SoftGOT2000.
Page 60 Exiting from GT SoftGOT2000

Setting of GT SoftGOT2000
To establish communication between GT SoftGOT2000 and MELSOFT Mirror, configure the communication settings.
Refer to the following, and configure the communication settings in GT SoftGOT2000.
Page 98 [MELSOFT Mirror]
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3.28 Non-Mitsubishi Electric PLC connection
OMRON PLC

Serial connection
■System configurations and connection conditions

*1 For the applicable CPUs, refer to the following.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3

*2 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.

PLC Connection 
cable

Max. 
distance

GT SoftGOT2000 Number of 
connectable 
devices

Model name Communication 
module

Communication 
type

SYSMAC CQM1H (Built-in serial port) *1 RS-232 RS-232 1)
RS-232 2)

15m Windows-compatible 
personal computer
PC CPU module
MELIPC*2

1

SYSMAC CJ1

SYSMAC CJ2

SYSMAC CP1

SYSMAC α

SYSMAC CS1

SYSMAC CP2

SYSMAC CVM1/CV

CQM1

CPM2A

OMRON PLC GT SoftGOT2000

Connection cable
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■Connection cable
 • MITSUBISHI SYSTEM & SERVICE product
RS-232 1)

 • Using an RS-232 cable prepared by user
The following describes the connection diagram, connector and others for each cable.
Connection diagram
RS-232 2)

Connector specifications
1) PC side connector
Use the connector compatible with the PC side.
2) Omron PLC CPU side connector
Use the connector compatible with Omron PLC CPU side.
For details, refer to the following manual.
User's Manual for Omron PLC CPU
Precautions for creating cables
The length of the cable must be 15m or less.

■GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to an OMRON PLC, communication setup is required.

*1 Transmission speed supported by the PLC must be set.
*2 The settings on the PLC and GT SoftGOT2000 must be the same.

For the communication setting of GT SoftGOT2000, refer to the following.
Page 76 [RS232]

■Controller setting
For the OMRON PLC side setting, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3

RS-232 cable

GT09-C30R20101-9P(3m) (For the 9-pin D-sub connector of the PC side)

Item *2 Setting
Transmission speed *1 9600/19200/38400/57600/115200bps

Data length 7bits

Stop bit 2bits

Parity Even

Communication condition format Individual

Host link station No. 00

FG

SD

RD

RS

SG

CS

-

FR

ER

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

1

2

3

4

9

5

6

7

8

OMRON PLC side

1

2

3

4

5

6

7

8

9

GOT side
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Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 The CJ2H-CPU6□-EIP or CJ2M-CPU3□ can be connected by using its Ethernet port or an Ethernet module.
*3 Available only when CS1D is used.
*4 An Ethernet board/card is required.

Page 384 Ethernet module and Ethernet board/card
*5 Only available to GT SoftGOT2000 (Multiple channels).
*6 The numbers of connectable devices depend on the connection target and type.

PLC Connection 
cable*1

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Controller Ethernet 
module

Communication 
type

SYSMAC CJ1 CJ1W-ETN21
CJ1W-EIP21

Ethernet Twisted pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer*4

PC CPU module
MELIPC

UDP: Unlimited
TCP: 16

UDP: 128
TCP: 128SYSMAC CJ2*2

SYSMAC CS1 CS1W-ETN21,
CS1W-EIP21,
CS1D-ETN21D *3

SYSMAC CP2 CP2E-N -

NJ*5 (Built-in Ethernet 
port)

UDP: Not 
supported
TCP: 128*6

UDP: Not 
supported
TCP: 128*6

CJ1W-EIP21

NX*5 (Built-in Ethernet 
port)

Controller Ethernet module Connection Number of 
connectable devices

NJ series Built-in Ethernet port Class3 32 or less

UCMM

Ethernet module Class3 128 or less

UCMM 32 or less

NX series NX1P2 Built-in Ethernet port Class3 32 or less

UCMM

NX701 Built-in Ethernet port Class3 128 or less per port
(256 or less for 2 ports)

UCMM 32 or less per port
(64 or less for 2 ports) 

NX102 Built-in Ethernet port Class3 32 or less per port
(64 or less for 2 ports) UCMM

OMRON PLC Ethernet 
module

GT SoftGOT2000

Connection cable
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■Ethernet module and Ethernet board/card
The following shows connectable Ethernet modules and Ethernet boards/cards.
 • Ethernet module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

Item Model name
CS1H, CS1G CS1W-ETN21, CS1W-EIP21

CS1D CS1W-ETN21, CS1W-EIP21, CS1D-ETN21D

CJ1H, CJ1M, CJ1G, CJ2H(-EIP), CJ2M CJ1W-ETN21, CJ1W-EIP21

NJ501, NJ301, NJ101 CJ1W-EIP21
4 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for Ethernet connection
 • OMRON PLC
For details of OMRON PLCs, refer to the following manual.
User's manual for OMRON PLC CPU
 • Precautions for Ethernet connection
Specify the Net No. and the PLC No. of the OMRON PLC connected to the GOT via the Ethernet connection.
The specified Net No. and the PLC No. must be the same as those set on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 386 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of programmable controller, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
 • [Controller Type]: [OMRON SYSMAC]
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [127]

[Station] Set the station number of the target Ethernet module. [1] to [254]

[Unit Type] Select [OMRON]. [OMRON]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [256] to [65534]

[Communication] Select a communication method. [UDP], [TCP]
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.28  Non-Mitsubishi Electric PLC connection



3

 • [Controller Type]: [OMRON NJ/NX]
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 [CJ1W-EIP21] is not available for NX series.
*2 NX701 and NX102 have two built-in EtherNet/IP ports.

Set [IP Address] in [Connected Ethernet Controller Setting] in GT Designer3, according to the port number set for NX701 or NX102 to be 
connected.

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
■Precautions for Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

■Simultaneous use of other connections
The RFID connection cannot be used simultaneously.

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Set the unit type according to the destination of connection from GT 
SoftGOT2000.
• When connecting to a built-in Ethernet port: [OMRON NJ/NX]
• When connecting to a communication unit: [CJ1W-EIP21]*1

[OMRON NJ/NX], [CJ1W-EIP21]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side*2

[Port No.] Set the port number of the target Ethernet module. [44818]

[Communication] Select a communication method. [TCP]

[Connection] Set a connection. [UCMM], [Class3]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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KEYENCE PLC

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 An Ethernet board/card is required.
Page 388 Ethernet module and Ethernet board/card

■Ethernet module and Ethernet board/card
The following shows connectable Ethernet modules and Ethernet boards/cards.
 • Ethernet module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

PLC Connection 
cable*1

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet 
module

Communication 
type

KV-700
KV-1000
KV-3000
KV-5000
KV-5500
KV-7300
KV-7500
KV-8000

KV-LE20V
KV-LE21V

Ethernet Twisted pair cable 100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*2

PC CPU module
MELIPC

UDP: 1
TCP: 15

UDP: 128
TCP: 128

KV-7300
KV-7500
KV-8000

KV-EP21V
KV-XLE02

Item Model name
Ethernet module KV-LE20V, KV-LE21V

Connection cable

GT SoftGOT2000Ethernet 
moduleKEYENCE PLC
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for setting items
 • KEYENCE PLC
For details on KEYENCE PLC, refer to the following manual.
User's manual for KEYENCE PLC CPU
 • Precautions for Ethernet connection
The Net No. and PLC No. are specified when connecting to the KEYENCE PLC via the Ethernet. In such 
cases, set the Net No. and PLC No. arbitrarily on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 390 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of the programmable controller, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
Up to 64 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Set the communication setting in the [Communication Setup] dialog of GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module [1] to [254]

[Unit Type] Select [KEYENCE]. [KEYENCE]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [1024] to [5010], [5014] to [49152], [49154] 
to [65534]

[Communication] Select a communication method. [UDP], [TCP]
0 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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TOSHIBA PLC

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 Use a CPU with firmware version V01.90 or later.
Use nV-Tool V4.14.5 or later.

*3 An Ethernet board/card is required.
Page 391 Ethernet module and Ethernet board/card

■Ethernet module and Ethernet board/card
The following shows connectable Ethernet modules and Ethernet boards/cards.
 • Ethernet module

 • Ethernet moduleEthernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

PLC Connection 
cable *1

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet 
module

Commu
nication 
type

Unified 
Controller nv 
series

Controller 
type1

PU811 EN811 Ethernet Twisted pair 
cable

100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*3

PC CPU module
MELIPC

Unlimited 32

Controller 
type1 
light*2

PUM11 (Built-in 
Ethernet)PUM12

PUM14

Item Model name
Unified Controller nv series EN811

TOSHIBA PLC Ethernet 
module

GT SoftGOT2000

Connection cable
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■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for Ethernet connection
 • TOSHIBA PLC
For the details of TOSHIBA PLCs, refer to the following manual.
User's manual for TOSHIBA PLC
 • Precautions for Ethernet connection
Specify the Net No. and station number of the TOSHIBA PLC connected to the GOT by the Ethernet 
connection.
The specified Net No. and station number must be the same as those set on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 393 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of programmable controller, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 1) for GT Works3
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
■Precautions for Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

■Channels available in GT SoftGOT2000 (Multiple channels)
Up to 2 of channels 1 to 4 are available for connecting TOSHIBA PLCs.

■Simultaneous use of other connections
The following connections cannot be used simultaneously.
Microcomputer connection (serial)
Barcode reader connection
RFID connection

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[N/W No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [254]

[Unit Type] Select [TOSHIBA]. [TOSHIBA]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [1024] to [65534]

[Communication] Select a communication method. [UDP]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.28  Non-Mitsubishi Electric PLC connection 393



39
HITACHI IES PLC

Ethernet connection
■System configurations and connection conditions

*1 This PLC is manufactured by HITACHI IES. For the products, contact HITACHI IES.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*3 The number of connectable personal computers includes the number of total GT SoftGOT2000 modules started in a personal computer.
*4 An Ethernet board/card is required.

Page 394 Ethernet module and Ethernet board/card

■Ethernet module and Ethernet board/card
The following shows connectable Ethernet modules and Ethernet boards/cards.
 • Ethernet module

 • Ethernet moduleEthernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

PLC Connection 
cable*2

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet 
module*1

Communication 
type

EHV-CPU08
EHV-CPU16
EHV-CPU32
EHV-CPU64
EHV-CPU128

(Built-in 
Ethernet)

Ethernet Twisted pair 
cable

100 m
(max. 
segment 
length)

Windows-compatible personal 
computer*4

PC CPU module
MELIPC

4 128

EH-ETH
EH-ETH2
EH-ELK
EH-ORML
EH-R2LH
EH-OR2LH

36*3

MVH-A40□□□
MVH-D40□□□
MVH-A64□□□
MVH-D64□□□

(Built-in 
Ethernet)

4

Item Model name
Unified Controller nv series EH-ETH

EH-ETH2
EH-ELK
EH-ORML
EH-R2LH
EH-OR2LH

HITACHI IES 
PLC

Ethernet 
module

GT SoftGOT2000

Connection cable
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 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
· Use a switching hub.
· Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
· Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for Ethernet connection
 • HITACHI IES PLC
For details on the HITACHI IES PLC, refer to the following manual.
Manual of the HITACHI IES PLC
 • Precautions for Ethernet connection
Specify the network number and station number of the HITACHI IES PLC connected by the Ethernet 
connection. The network number and station number must be the same as those set in GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 396 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of programmable controller, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Setting on the personal computer
Set the IP address.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[N/W No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [254]

[Unit Type] Select [HITACHI IES]. [HITACHI IES]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [1024] to [65534]

[Communication] Select a communication method. [UDP], [TCP]
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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YASKAWA PLC

Serial connection
■System configurations and connection conditions

*1 For the applicable CPUs, refer to the following.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

*2 The maximum transmission speed of 218IF-02 is 115200bps.
However, the maximum transmission speed selectable from the GOT is 57600bps.

*3 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.
*4 To connect an MP2200, MP2300, or MP2300S via RS-232, make sure that the software version of the CPU is 2.60 or later.

PLC Connection 
cable

Max. 
distance

GT 
SoftGOT2000

Number of 
connectable 
devices

Model name MODBUS module
Communication 
module

Communication 
type

GL60S, GL60H, GL70H JAMSC-IF60,
JAMSC-IF61

RS-232 RS-232 1)
RS-232 3)

15m Windows-
compatible 
personal 
computer
PC CPU module
MELIPC*3

1

GL120, GL130 (Built-in serial port) *1 RS-232 1)
RS-232 3)

CP-9300MS
(CP-9300M compatible/non-
compatible)

(Built-in serial port) *1 RS-232 2)
RS-232 5)

CP-9200(H) (Built-in serial port) *1 RS-232 1)
RS-232 3)

PROGIC-8 For connecting 
to port 1

(Built-in serial port) *1 RS-232 1)
RS-232 3)

For connecting 
to port 2

(Built-in serial port) *1 RS-232 4)

MP-920 (Built-in serial port) *1 RS-232 1)
RS-232 3)

217IF RS-232 1)
RS-232 3)

MP-930 (Built-in serial port) *1 RS-232 1)
RS-232 3)

MP-940 (Built-in serial port) *1 RS-232 6)

CP-9200SH, CP-317 CP-217IF For 
connecting 
to CN1

RS-232 1)
RS-232 3)

For 
connecting 
to CN2

RS-232 7)

MP2200, MP2300, MP2300S 217IF-01,
218IF-01,
218IF-02 *2*4

RS-232 1)
RS-232 3)

YASKAWA PLC GT SoftGOT2000

Connection cable
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■MEMOBUS modules and communication module
The following table shows connectable MEMOBUS Modules and Communication module.
Connection via RS-422 communication cannot be used.

■Connection cable
 • MITSUBISHI SYSTEM & SERVICE product
RS-232 1)

RS-232 2)

 • Using an RS-232 cable prepared by user
The following describes the connection diagram, connector and others for each cable.
Connection diagram
RS-232 3)

Item Model name
GL-60S, GL-60H, GL-70H JAMSC-IF60, JAMSC-IF61

MP920/NSC40 217IF

CP-9200SH, CP-317 CP-217IF

MP2000 JEPMC-MP2200 217IF-01, 218IF-01, 218-IF02

JEPMC-MP2300 217IF-01, 218IF-01, 218-IF02

JEPMC-MP2300S 217IF-01, 218IF-01, 218-IF02

RS-232 cable

GT09-C30R20201-9P (3m) (For the 9-pin D-sub connector of the personal computer side)

RS-232 cable

GT09-C30R20203-9P (3m) (For the 9-pin D-sub connector of the personal computer side)

FG

TXD

RXD

DSR

GND

DTR

RTS

CTS

EST

1

2

3

6

7

9

4

5

8

1

2

3

4

5

6

7

8

9

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

YASKAWA products side GOT side
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RS-232 4)

RS-232 5)

RS-232 6)

FG

TXD

RXD

DSR

GND

DTR

RTS

CTS

NC

1

2

3

6

7

9

4

5

8

1

2

3

4

5

6

7

8

9

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

YASKAWA products side GOT side

FG

TXD

RXD

RTS

GND

DSR

OP/CTS

PWR

DTR

1

2

3

4

7

6

5

8

9

1

2

3

4

5

6

7

8

9

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

YASKAWA products side GOT side

Clamped on hood

TXD

RXD

RTS

GND

-

CTS

1

3

12

14

2

6

1

2

3

4

5

6

7

8

9

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

YASKAWA products side GOT side
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RS-232 7)

Connector specification
1) Personal computer side connecter
Use the connector compatible with the personal computer side.
2) YASKAWA PLC CPU side connector
Use the connector compatible with YASKAWA PLC CPU side.
For details, refer to the following manual.
User's manual for YASKAWA PLC CPU
Precautions for creating cables
The length of the cable must be 15m or less.

■GT SoftGOT2000 setting
When communicating GT SoftGOT2000 to a YASKAWA PLC, communication setup is required.

*1 The baud rate supported by the programmable controller must be set.
*2 The settings on the programmable controller and GT SoftGOT2000 must be the same.

Refer to the following for performing GT SoftGOT2000 communication setup.
Page 76 [RS232]

■Controller setting
For the programmable controller side setting, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

Send delay time
Set the transmission wait time as shown below when connecting to the programmable controller of CP-
9200(H) or CP-9300MS.

Item *2 Setting
Comm. port COM1 to COM6

Baud Rate *1 9600/19200/38400/57600bps

Host Add. 1 to 31

Wait Time 0 to 300ms

FG

TXD

RXD

DSR

SG

DTR

RS

CS

CD

1

2

3

6

7

20

4

5

8

1

2

3

4

5

6

7

8

9

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

YASKAWA products side GOT side

Model name Send delay time

erom ro sm03)H(0029-PC

CP-9300MS
For connecting to port 0 10ms or more

For connecting to port 1 30ms or more
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Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 To connect an MP2200, MP2300, or MP2300S via Ethernet, make sure that the software version of the CPU is 2.60 or later.
*3 An Ethernet board/card is required.

Page 401 Communication module, Ethernet board/card

■Communication module, Ethernet board/card
The following table shows connectable communication modules and Ethernet board/card.
 • Communication module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

PLC Connection 
cable*1

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model 
name

Communication 
module

Communication 
type

MP920 218IF Ethernet
(Controller type: 
YASKAWA MP2000/
MP900/CP9200SH)

Twisted pair cable 100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer*3

PC CPU module
MELIPC

10 UDP: 128
TCP: 10MP2200,

MP2300,
MP2300S

218IF-01,
218IF-02*2

CP-317 218TXB

MP3200,
MP3300

(Built-in Ethernet) Ethernet
(Controller type: 
YASKAWA MP3000)

Item Model name
For MP920 218IF

For MP2200, MP2300, MP2300S 218IF-01, 218IF-02

For CP-317 218TXB

YASKAWA PLC Communication 
module

GT SoftGOT2000

Connection cable
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■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for Ethernet connection
 • YASKAWA PLC
For details on YASKAWA PLC, refer to the following manual.
User's manual for YASKAWA PLC CPU
 • Precautions for Ethernet connection
The Net No. and PLC No. are specified when connecting to the YASKAWA PLC via the Ethernet connection.
In such cases, set the Net No. and PLC No. arbitrarily on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 403 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of programmable controller, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
 • [Controller Type]: [YASKAWA MP2000/MP900/CP9200SH]
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select [YASKAWA]. [YASKAWA]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [256] to [65534]

[Communication] Select a communication method. [UDP], [TCP]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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 • [Controller Type]: [YASKAWA MP3000]
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Precautions
■Precautions for Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

■Simultaneous use of other connections
The following connections cannot be used simultaneously.
Barcode reader connection
RFID connection

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [64]

[Unit Type] Select [YASKAWA]. [YASKAWA]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [256] to [65534]

[Communication] Select a communication method. [UDP], [TCP]
4 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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YASKAWA robot controller

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 An Ethernet board/card is required.
Page 405 Ethernet board/card

*3 Connect GT SoftGOT2000 to a LAN connector which can be used for the Ethernet function of YRC1000.
Do not connect GT SoftGOT2000 to a LAN connector dedicated to the programming pendant.
For the details, refer to the manual of the YASKAWA robot controller.

■Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Robot controller Connection 
cable*1

Max. distance GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
robot 
controllers 
connectable 
to GT 
SoftGOT2000

Model name Communication 
type

YRC1000*3 Ethernet Twisted pair cable 100 m
(max. segment 
length)

Windows-compatible personal 
computer*2

PC CPU module
MELIPC

1 1

YRC1000micro

Connection cable

YASKAWA 
robot controller

GT SoftGOT2000
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and robot controller.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for setting items
 • YASKAWA robot controller
For the details on YASKAWA robot controller, refer to the following manual.
User's manual for YASKAWA robot controller
 • Precautions for Ethernet connection
Specify the Net No. and station number of the YASKAWA robot controller connected to the GOT by the 
Ethernet connection.
The specified Net No. and station number must be the same as those set on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 407 Settings in GT Designer3

■Robot controller settings
For the settings of the robot controller, refer to the following.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
[Controller Type]: [YASKAWA Robot Controller]
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1]

[Station] Set the station number of the target Ethernet module. [1] to [120]

[Unit Type] Select [YASKAWA(YRC1000)]. [YASKAWA(YRC1000)]

[IP Address] Set the IP address of the target Ethernet module. IP address of the robot controller

[Port No.] Set the port number of the target Ethernet module. [10040]

[Communication] Select a communication method. [UDP]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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YOKOGAWA PLC

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 The multiple CPU system can be configured via an Ethernet Interface Module.
For the details of the multiple CPU system, refer to the following manual.
Manual of YOKOGAWA PLC

*3 For the applicable CPUs, refer to the following.
Page 408 Ethernet Interface Module and Ethernet board/card

*4 An Ethernet board/card is required.
Page 408 Ethernet Interface Module and Ethernet board/card

■Ethernet Interface Module and Ethernet board/card
The following table shows connectable Ethernet Interface Modules and Ethernet boards/cards.
 • Ethernet Interface Module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

PLC*2 Connection 
cable*1

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model 
name

Ethernet 
Interface 
Module

Communication 
type

FA-M3 (Sequence CPU 
module with built-in 
network functions)*3

Ethernet Twisted pair cable 100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*4

PC CPU module
MELIPC

UDP: 128
TCP: 8

UDP: 128
TCP: 10

F3LE01-5T,
F3LE11-0T,
F3LE12-0T

Item Model name
For FA-M3 F3LE01-5T, F3LE11-0T, F3LE12-0T

Sequence CPU module with built-in network functions F3SP66, F3SP67, F3SP71-4N, F3SP71-4S, F3SP76-7S

YOKOGAWA PLC
Ethernet 
Interface 
Module

GT SoftGOT2000

Connection cable
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for setting items
 • YOKOGAWA PLC
For details on YOKOGAWA PLC, refer to the following manual.
User's manual for YOKOGAWA PLC CPU
 • Precautions for Ethernet connection
The Net No. and PLC No. are specified when connecting to the YOKOGAWA PLC via the Ethernet.
In such cases, set the Net No. and PLC No. arbitrarily on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 410 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of the programmable controller, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 Set the IP address and the communication method set for the PLC.
*2 Set the port number of the higher-level link service used for the PLC.

■Setting on GT SoftGOT2000
Set the communication setting in the [Communication Setup] dialog of GT SoftGOT2000.
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module [1] to [64]

[Unit Type] Select [YOKOGAWA]. [YOKOGAWA]

[IP Address] *1 Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] *2 Set the port number of the target Ethernet module. [12289], [12291]

[Communication] *1 Select a communication method. [UDP], [TCP]
0 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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LS Industrial Systems PLC

Ethernet connection
■System configurations and connection conditions

*1 The number of connectable personal computers includes the number of total GT SoftGOT2000 modules started in a personal computer.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*3 An Ethernet board/card is required.
Page 411 Communication module, Ethernet board/card

■Communication module, Ethernet board/card
The following table shows connectable communication modules and Ethernet board/card.
 • Communication module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

PLC Connection 
cable *2

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model 
name

Communication 
module

Communication 
type

XGK-CPUU
XGK-CPUH
XGK-CPUA
XGK-CPUS
XGK-CPUE

XGL-EFMT(B) Ethernet Twisted pair cable 100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*3

PC CPU module
MELIPC

16 *1 63

XGK-CPUUN
XGK-CPUHN
XGK-CPUSN

XGL-EFMT(B) 16 *1

(Built-in Ethernet) 4

Item Model name
Communication module XGL-EFMT(B)

Connection cable

LS Industrial 
Systems PLC

GT SoftGOT2000Communication 
module
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for setting items
 • LS Industrial Systems PLC
For details on LS Industrial Systems PLC, refer to the following manual.
User's manual for LS Industrial Systems PLC
 • Precautions for Ethernet connection
Specify the Net No. and station number of the LS Industrial Systems PLC connected to the GOT by the 
Ethernet connection.
The specified Net No. and station number must be the same as those set on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 413 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of the programmable controller, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1

■Setting on the personal computer
Set the IP address.

■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 The default value and setting range may differ depending on the setting of [Unit Type] of the connection destination.

■Setting on GT SoftGOT2000
Set the communication setting in the [Communication Setup] dialog of GT SoftGOT2000.
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range*1

[XGK-CPU] [XGL-EFMT(B)]
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module [1] to [64]

[Unit Type] Set this item according to the connection destination for GT SoftGOT2000.
• When connecting to a built-in Ethernet port: [XGK-CPU]
• When connecting to a communication module: [XGL-EFMT(B)]

[XGK-CPU] [XGL-EFMT(B)]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Set the port number of the target Ethernet module. [2004] [2004], [2005]

[Communication] Select a communication method. [TCP] [UDP], [TCP]
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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ALLEN-BRADLEY PLC
Only available to GT SoftGOT2000 (Multiple channels).

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 An Ethernet board/card is required.
Page 414 EtherNet/IP communication module and Ethernet board/card

*3 The mountable EtherNet/IP communication module differs depending on the PLC model.
For the applicable CPUs, refer to the following.
Page 414 EtherNet/IP communication module and Ethernet board/card

■EtherNet/IP communication module and Ethernet board/card
The following shows connectable EtherNet/IP communication modules and Ethernet boards/cards.
 • EtherNet/IP communication module

 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

PLC Connection 
cable*1

Max. 
distance

GT SoftGOT2000 Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Series EtherNet/IP 
communication 
module

Communication 
type

ControlLogix *3 Ethernet Twisted pair cable 100 m
(max. 
segment 
length)

Windows-compatible 
personal computer*2

PC CPU module
MELIPC

UDP: Not 
supported
TCP: 32

UDP: Not 
supported
TCP: 16

CompactLogix - UDP: Not 
supported
TCP: 20

UDP: Not 
supported
TCP: 16

FlexLogix 1788-ENBT/A

Item Model name
1756-L, 1756-L1M1, 1756-L1M2, 1756-L1M3 1756-ENET (10Mbps), 1756-ENBT (10/100Mbps)

1756-L61, 1756-L62, 1756-L63 1756-ENET (10Mbps), 1756-ENBT (10/100Mbps)

1756-L64 1756-ENET (10Mbps), 1756-ENBT (10/100Mbps), 1756-EN2T (10/100Mbps)

1756-L55M12, 1756-L55M13, 1756-L55M14, 1756-
L55M16, 1756-L55M22, 1756-L55M23, 1756-L55M24

1756-ENET (10Mbps), 1756-ENBT (10/100Mbps)

1756-L72S 1756-EN2T (10/100Mbps)

1756-L71, 1756-L72, 1756-L73, 1756-L74, 1756-L75 1756-EN2T (10/100Mbps), 1756-EN2TR (10/100Mbps), 1756-EN3TR (10/100Mbps), 1756-ENBT 
(10/100Mbps)

1756-L81E, 1756-L82E, 1756-L83E, 1756-L84E, 1756-
L85E

1756-EN2T (10/100Mbps), 1756-EN2TR (10/100Mbps), 1756-EN3TR (10/100Mbps), 1756-ENBT 
(10/100Mbps), 1756-EN2TSC (10/100Mbps)

1794-L33, 1794-L34 1788-ENBT/A (100Mbps)

Connection cable

ControlLogix, 
CompactLogix

GT SoftGOT2000
EtherNet/IP 
communication 
module
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3.28  Non-Mitsubishi Electric PLC connection



3

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for setting items
 • ALLEN-BRADLEY PLC
For details of the ALLEN-BRADLEY PLC, refer to the following manual.
Manual of the ALLEN-BRADLEY PLC
 • Precautions for Ethernet connection
Specify the network number and station number of the ALLEN-BRADLEY PLC connected by the Ethernet 
connection. The network number and station number must be the same as those set in GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 416 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of the programmable controller, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1

■Setting on the personal computer
Set the IP address.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) For GT Works3 Version1

■Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Set the communication setting in the [Communication Setup] dialog of GT SoftGOT2000.
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module [1] to [64]

[Unit Type] Select [AB(Tag)]. [AB(Tag)]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable 
controller side

[Port No.] Set the port number of the target Ethernet module. [44818]

[Communication] Displays the communication method. [TCP]

[Connection] Set the message communication type according to the connected Ethernet module. [UCMM], [Class3]

[Slot No.] Set the slot number to which the CPU module is installed in the PLC. [0] to [20]
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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SIEMENS PLC

Ethernet connection
■System configurations and connection conditions

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 For the applicable CPUs, refer to the following.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

*3 An Ethernet board/card is required.
Page 417 Ethernet module and Ethernet board/card

■Ethernet module and Ethernet board/card
The following shows connectable Ethernet modules and Ethernet boards/cards.
 • Ethernet module
Ethernet connection type: FETCH/WRITE

Ethernet connection type: OP communication

PLC Connection 
cable *1

Max. 
distance

GT 
SoftGOT2000

Number of 
GT 
SoftGOT2000 
modules 
connectable 
to a module

Number of 
PLCs 
connectable 
to GT 
SoftGOT2000

Model name Ethernet module Communication 
type

SIMATIC S7-300 CP343-1 IT,
CP343-1,
CP343-1 Lean,
CP343-1 Advanced

Ethernet (Ethernet 
connection type: 
FETCH/WRITE)

Twisted pair 
cable

100 m
(max. 
segment 
length)

Windows-
compatible 
personal 
computer*3

PC CPU module
MELIPC

32 16

SIMATIC S7-400 CP443-1 IT,
CP443-1

SIMATIC S7-200 CP 243-1,
CP 243-1 IT

Ethernet (Ethernet 
connection type: OP 
communication)

32 128

SIMATIC S7-200 
SMART

(Built-in Ethernet port)*2

SIMATIC S7-300 CP 343-1,
CP 343-1 Lean,
CP 343-1 Advanced-IT

SIMATIC S7-400 CP 443-1,
CP 443-1 Advanced-IT

SIMATIC S7-1200 (Built-in Ethernet port)*2

SIMATIC S7-1500 (Built-in Ethernet port)*2

Item Model name
SIMATIC S7-300 CP343-1 IT, CP343-1, CP343-1 Lean, CP343-1 Advanced

SIMATIC S7-400 CP443-1 IT, CP443-1

Item Model name
SIMATIC S7-200 CP 243-1, CP 243-1 IT

SIMATIC S7-300 CP 343-1, CP 343-1 Lean, CP 343-1 Advanced-IT

SIMATIC S7-400 CP 443-1, CP 443-1 Advanced-IT

SIEMENS PLC Ethernet 
module

GT SoftGOT2000

Connection cable
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 • Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

■Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

■Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

■Controller setting

Precautions for Ethernet connection
 • SIEMENS PLC
For the details of SIEMENS PLCs, refer to the following manual.
User's manual for SIEMENS PLC
 • Precautions for Ethernet connection
Specify the Net No. and the PLC No. of the SIEMENS PLC connected to the GOT via the Ethernet 
connection.
The specified Net No. and the PLC No. must be the same as those set on GT Designer3.
For the Ethernet module settings and GT SoftGOT2000 settings, refer to the following.
Page 296 Settings in GT Designer3

■Setting of programmable controller side
For settings for each part of programmable controller, refer to the following manual.
 GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Setting on the personal computer
Set the IP address.
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■Communications check
 • Ping test
Execute the Ping command with Command Prompt of Windows when the preparations for communication are complete.
When the Ping test is verified
C:\>Ping 192. 168. 0. 2
Reply from 192.168.0.2:bytes=32 time<1ms TTL=32
When the Ping test is not verified
C:\>Ping 192. 168. 0. 2
Request timed out.
If the Ping test is not verified, check connections of the cable and unit, Windows side IP address and other settings.
 • Station monitoring function
For details on the station monitoring function, refer to the following manual.
GOT2000 Series Connection Manual (Non-Mitsubishi Electric Products 2) for GT Works3

■Settings in GT Designer3
 • Ethernet connection type: FETCH/WRITE
Up to 64 settings can be configured in [Connected Ethernet Controller Setting].

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [254]

[Unit Type] Select [SIEMENS S7]. [SIEMENS S7]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[FETCH Port No.] Set the FETCH port No. of the connected Ethernet module. [1024] to [65534]

[WRITE Port No.] For the WRITE port No. of the connected Ethernet module, the value that the 
FETCH port No. is incremented by one is set automatically.

[1025] to [65535]

[Communication] Displays the communication method. [TCP]
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 • Ethernet connection type: OP communication
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

■Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

■Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Host] Indicate the host station. (The host station is indicated as *.) -

[Net No.] Set the network number of the target Ethernet module. [1] to [239]

[Station] Set the station number of the target Ethernet module. [1] to [254]

[Unit Type] Set a PLC type to be connected. [S7-1500 OP]
[S7-200 OP]
[S7-200 SMART OP]
[S7-300/400 OP]
[S7-1200 OP]

[IP Address] Set the IP address of the target Ethernet module. IP address of programmable controller 
side

[Port No.] Displays the port number of the destination Ethernet module. [102]

[Connection No./Rack No.] Set this item when [Controller Type] is set to [S7-200 OP] or [S7-300/400 OP].
Set the connection No./rack No. which is set in the PLC side.

[0] to [7]

[Module Position/Slot No.] Set the module position/slot No. which is set in the PLC side. S7-1500 OP: [0] to [31]
S7-200 OP: [0] to [6]
S7-200 SMART OP: [1]
S7-300/400 OP: [0] to [31]
S7-1200 OP: [1]

[Communication] Displays the communication method. [TCP]
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3.29 Microcomputer Connection (Serial)
The microcomputer connection (serial) is established between GT SoftGOT2000 and the host (such as a personal computer, 
microcomputer board, or PLC) via a serial cable, and allows the host to read/write data from/to the virtual devices of GT 
SoftGOT2000.
GT SoftGOT2000 can send an interrupt output to the host.

Virtual devices of GT SoftGOT2000
The virtual devices of GT SoftGOT2000 are used when the microcomputer connection is established.
PLC devices are not used.
Page 425 Device data area

Virtual devices of GT SoftGOT2000

Microcomputer board

S
T
X

RW 0100 000A 0163 0362
E
T
X

D3

Write,Read Command Interrupt 
output

D0

D100

D4095

D163

000A

0362D
0 

to
 4

09
5
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Flow of data processing
■Reading or writing data

1. The host sends a request message (a read or write command) to GT SoftGOT2000.

2. GT SoftGOT2000 services the request for reading/writing data from/to the virtual devices.

3. When reading or writing data is complete, GT SoftGOT2000 sends a response message (a read or write result) to the 
host.

The following objects can use the data that has been read/written from/to the virtual devices.
Numerical display object for displaying the data written by a write command
Numerical input object for inputting the data to be sent to the host

Host

Display(D4 to 9)

Input(D20)

GT SoftGOT2000

2.

3. 1.

Screen data

04/06/01 18:46:49

1254

Screen display
Device data area
(Virtual devices)

Response
message

Request
message
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■Sending interrupt outputs

1. In GT SoftGOT2000, write the data to be output to the host to the virtual device by using a touch switch or other methods.

2. GT SoftGOT2000 sends the written data to the host (Interrupt output).
For the details of the message formats for interrupt outputs and the device data area, refer to the following.
Page 437 Data format type and application
Page 425 Device data area

2.

1.

Host

GT SoftGOT2000

Screen data

Interrupt output

Screen display
Device data area
(virtual devices)

Interrupt(D13) D13 3139H

31H

output value1 output value2

39H

(When the number of 
 interrupt data bytes is 2)
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.29  Microcomputer Connection (Serial) 423



42
System configuration

*1 Activating multiple GT SoftGOT2000 modules enables you to perform monitoring from multiple screens.
*2 Assign the RS-232 port on the MELIPC to the Windows part.

Connection cable

RS-232 cable
Example of when the DTR/DSR signal is not used

Example of when the DTR/DSR signal is used

Host Connection cable Maximum length GT SoftGOT2000 Number of 
connectable 
devices

Unit Type Communication type

Personal computer, 
microcomputer board, 
PLC, or other devices

RS-232 RS-232 cable Depending on the 
specifications of the host

Windows-compatible 
personal computer
PC CPU module
MELIPC*2

1 *1

Host

Connection cable

GT SoftGOT2000

Host side

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

1

2

3

4

5

6

7

8

9

FG

SD(TXD)

RD(RXD)

RS(RTS)

SG

CS(CTS)

-

-

ER(DTR)

GT SoftGOT2000 side

GT SoftGOT2000 side Host side

FG

SD(TXD)

RD(RXD)

DR(DSR)

SG

ER(DTR)

RS(RTS)

CS(CTS)

5V

CD

RD(RXD)

SD(TXD)

ER(DTR)

SG

DR(DSR)

RS(RTS)

CS(CTS)

-

1

2

3

4

5

6

7

8

9
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Device data area
The following shows the GT SoftGOT2000 virtual devices that are usable when the microcomputer connection (serial) is used 
and the address specification values for each data format.
The address specification values for the GT SoftGOT2000 virtual devices vary by data format. *1

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

*2 When reusing GOT900 Series project data
GOT-A900 Series virtual devices (D0 to 2047)
Can be used as they are without changing the assignments.
GOT-F900 Series virtual devices
Since some of the assigned virtual device values differ as indicated below, change the assignment using device batch edit of GT 
Designer3.
Refer to the following manual for device batch edit of GT Designer3.
GT Designer3 (GOT2000) Screen Design Manual

*3 Access to SD3 to 9 can also be made by the specification of the addresses (3000 to 300DH) of GD0 to 6 on the GOT-F900 Series.

Values of the GT SoftGOT2000 virtual devices
Exiting or resetting GT SoftGOT2000 clears the values of the virtual devices to their defaults (bit devices: OFF, 
word devices: 0).
If you close and reopen a project, the stored values will be held.

Virtual device *2 Address specification value Refer to

Name Device 
range 
(decimal)

Device 
type

Format 1, 2 Format 3 to 6 Format 7 to 10 Format 11 to 13 Format 14, 15

D 0 to 4095 Word 0 to 4095 D0 to 4095 D0 to 4095 0000 to 0FFFH 8000 to 9FFFH Page 426 D 
devices

R 0 to 4095 Word 4096 to 8191 R0 to 4095 R0 to 4095 1000 to 1FFFH 0000 to 1FFFH Page 430 R 
devices

L 0 to 2047 Bit 8192 to 8319 L0 to 2047 L0 to 2047 2000 to 207FH A000 to A0FFH Page 431 L 
devices

M 0 to 2047 Bit 8320 to 8447 M0 to 2047 M0 to 2047 2080 to 20FFH 2000 to 20FFH Page 431 M 
devices

SD 0 to 15 Word 8448 to 8463 D9000 to 9015 SD0 to 15 2100 to 210FH 2100 to 211FH
(3000 to 300DH) 
*3

Page 432 SD 
devices

SM 0 to 63 Bit 8464 to 8467 M9000 to 9063 SM0 to 63 2110 to 2113H 2200 to 2207H Page 435 SM 
devices

GOT2000 Series virtual devices GOT-F900 Series virtual devices
D0 to 2047 -

D2048 to 4095 -

R0 to 4095 D0 to 4095

L0 to 2047 -

M0 to 2047 M0 to 2047

SD0 to 15 D8000 to 8015
GD0 to 6

SM0 to 63 M8000 to 8063
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.29  Microcomputer Connection (Serial) 425



42
D devices
The D devices are word devices to store data, including the communication error data and clock data of GT SoftGOT2000.
The following shows the D devices which are the virtual devices of GT SoftGOT2000.

List of D devices
The following shows the D devices which are the virtual devices of GT SoftGOT2000.

Address Description Set by
D0 to 2 Unused -

D3 Communication error status
The communication error details of GT SoftGOT2000 are stored.

• b4 to 6 turn ON when an SIO error occurs, and turn OFF when an request message from the host is received 
successfully after the error occurrence.

• b7 turns ON about 3 seconds after the host side DTR becomes OFF, and turns OFF when transmission is performed 
successfully to the host after the error occurrence.

System

D4 Clock data (year)

D5 Clock data (month)

D6 Clock data (day)

D7 Clock data (hour)

b15 b0– b3

Unused

–b4

SIO framing error

b5

SIO parity error
SIO overrun error

b6b7

Communication timeout 
error
Unused

b8

0: Normal
1: Error

b15 b0–

Lower 2 digits of calendar 
year stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of months 01 to 
12 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of days 01 to 
31 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of hours 00 to 
23 stored as 2-digit BCD

–b7

Unused

b8
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D8 Clock data (minute) System

D9 Clock data (second)

D10 Clock data (day of week)

D11 to 12 Unused -

D13 Interrupt output
If you write data to D13 and D14 by using a touch switch or other methods in GT SoftGOT2000, the written data will be 
sent to the host (Interrupt output). *1*2

Set the amount of data (number of bytes) to be sent with [Interrupt Data Byte] in the [Communication Setup] dialog.
Page 76 [RS232]
• Output value when [1Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog

• Output value when [2Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog

• Output value when [4Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog*3

(1) When [LH Order] is set for [32bit Storage:] in the [Communication Setup] dialog

(2) When [HL Order] is set for [32bit Storage:] in the [Communication Setup] dialog

User

D14

D15 to 19 Unused -

D20 to 2031 User area User

D2032 to 2034 Unused -

Address Description Set by

b15 b0–

Data of minutes 00 to 
59 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of seconds 00 to 
59 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Day-of-week data stored as 
2-digit BCD

–b7

Unused

b8

00: Sunday 01: Monday
02: Tuesday 03: Wednesday
04: Thursday 05: Friday
06: Saturday

D13

Lower 8 bits

1 byte

D13

Upper 8 bits Lower 8 bits

2 bytes

Upper 8 bits

D14 D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

Upper 8 bits

D13 D14

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes
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*1 An interrupt output is sent within 1 to 10 ms after data is written to the devices.
*2 If the host writes data to D13 and D14, an interrupt output will not be sent.
*3 When 32-bit data are written to D13 and D14, the values are output to the host side regardless of the setting for [32bit Storage] in the 

[Communication Setup] dialog.
Example) When outputting 0x12345678 with unsigned 32-bit binary data

 • Who sets values in the virtual devices
System: The system sets values in the virtual devices.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).
 • Interrupt outputs using D13 and D14
To disable interrupt outputs, turn on SM52 (Disable interrupt code output flag).
Page 435 SM devices
When performing interrupt output in format 1, 2, 11, 14, or 15, set [Data Bit] to [8bit] in the [Communication 
Setup] dialog.
When [7bit] is set, data is output with ignoring the most significant bit (8th bit).
(Example: FFH→7FH)
Page 76 [RS232]

D2035 1-second binary counter
The counter is incremented every second after GT SoftGOT2000 is started.
(The time elapsed after monitoring is started is stored in seconds.)
Data are stored in binary format.

System

D2036 to 4095 User area User

Address Description Set by

Upper 8 bits

D14 D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

<GT SoftGOT2000> <Host>

· LH Order

· HL Order

Upper 8 bits

D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x56 0x78 0x12 0x34

Upper 8 bits

D13 D14

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

<GT SoftGOT2000> <Host>

Upper 8 bits

D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

Interrupt output

Interrupt output

D14

D14
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Differences in address specifications by data format
The address specification of devices varies depending on the data format. *1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

Address Address specification value

Format 1, 2 Format 3 to 6 Format 7 to 10 Format 11 to 13 Format 14, 15
D0 0 D0 D0 0000H 8000H, 8001H

D1 1 D1 D1 0001H 8002H, 8003H

: : : : : :

D4095 4095 D4095 D4095 0FFFH 9FFEH, 9FFFH

Upper 8 bits

8000H

Lower 8 bits

8001H

Upper 8 bits

8002H

Lower 8 bits

8003H

Upper 8 bits

9FFEH

Lower 8 bits

9FFFH
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R devices
The R devices are word devices into which user data are stored.
All of these devices can be used as a user area.

List of R devices and differences in address specification by data format
The following shows the R devices which are the virtual devices of GT SoftGOT2000.
The address specification values vary by data format as shown below. *1

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

Address Address specification value

Format 1, 2 Format 3 to 6 Format 7 to 10 Format 11 to 13 Format 14, 15
R0 4096 R0 R0 1000H 0000H, 0001H

R1 4097 R1 R1 1001H 0002H, 0003H

: : : : : :

R4095 8191 R4095 R4095 1FFFH 1FFEH, 1FFFH

Upper 8 bits

0000H

Lower 8 bits

0001H

Upper 8 bits

0002H

Lower 8 bits

0003H

Upper 8 bits

1FFEH

Lower 8 bits

1FFFH
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L devices
The L devices are bit devices into which user data are stored.
All of these devices can be used as a user area.

List of L devices and differences in address specification by data format
The following shows the L devices which are the virtual devices of GT SoftGOT2000.
The address specification values vary by data format as shown below. *1

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

*2 Specify addresses in increments of 16 for reading or writing data in word units. (Example: L0, L16, L32,...)

M devices
The M devices are bit devices into which user data are stored.
All of these devices can be used as a user area.

List of M devices and differences in address specification by data format
The following shows the M devices which are the virtual devices of GT SoftGOT2000.
The address specification values vary by data format as shown below. *1

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

*2 Specify addresses in increments of 16 for reading or writing data in word units. (Example: M0, M16, M32,...)

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 
3 to 6

Format 
7 to 10

Format 
11 to 13

Format 
14, 15

L7 L6 L5 L4 L3 L2 L1 L0 8192 Same as address 
column on left *2

2000H A000H

L15 L14 L13 L12 L11 L10 L9 L8 A001H

L23 L22 L21 L20 L19 L18 L17 L16 8193 2001H A002H

L31 L30 L29 L28 L27 L26 L25 L24 A003H

: : : :

L2039 L2038 L2037 L2036 L2035 L2034 L2033 L2032 8319 207FH A0FEH

L2047 L2046 L2045 L2044 L2043 L2042 L2041 L2040 A0FFH

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 
3 to 6

Format 
7 to 10

Format 
11 to 13

Format 
14, 15

M7 M6 M5 M4 M3 M2 M1 M0 8320 Same as address 
column on left *2

2080H 2000H

M15 M14 M13 M12 M11 M10 M9 M8 2001H

M23 M22 M21 M20 M19 M18 M17 M16 8321 2081H 2002H

M31 M30 M29 M28 M27 M26 M25 M24 2003H

: : : :

M2039 M2038 M2037 M2036 M2035 M2034 M2033 M2032 8447 20FFH 20FEH

M2047 M2046 M2045 M2044 M2043 M2042 M2041 M2040 20FFH
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SD devices
The SD devices are word devices to store data, including the communication error codes and clock data of GT SoftGOT2000.

List of SD devices
The following shows the SD devices which are the virtual devices of GT SoftGOT2000.

*1 For details and corrective actions for the errors (error codes) that are stored into SD2, refer to the following:
Page 433 Details and actions for errors (error codes) stored into SD2

Who sets values in the virtual devices
System: The system sets values in the virtual devices.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).

Address Description Set by
SD0
SD1

100ms counter (32bits)
The counter is incremented by 100 ms after GT SoftGOT2000 is started.
(The time elapsed after GT SoftGOT2000 is started is stored in increments of 100 ms.)
(1) When [LH Order] is set for [32bit Storage:] in the [Communication Setup] dialog
The lower and upper bits are stored in SD0 and SD1 respectively.

(2) When [HL Order] is set for [32bit Storage:] in the [Communication Setup] dialog
The upper and lower bits are stored in SD0 and SD1 respectively.

System

SD2 *1 Communication error status
A communication error code is stored.
• Host station (Communication error in the destination GT SoftGOT2000)

0: No error
1: Parity error
2: Framing error
3: Overrun error
4: Communication message error
5: Command error
6: Clock data setting error

SD3 Clock data (second)
Second data of 00 to 59 is stored.

SD4 Clock data (minute)
Minute data of 00 to 59 is stored.

SD5 Clock data (hour)
Hour data of 00 to 23 is stored.

SD6 Clock data (day)
Day data of 00 to 31 is stored.

SD7 Clock data (month)
Month data of 01 to 12 is stored.

SD8 Clock data (year)
The last two digits of four-digit year data are stored.

SD9 Clock data (day of week)
Day-of-the-week data is stored.
0: Sunday
1: Monday
2: Tuesday
3: Wednesday
4: Thursday
5: Friday
6: Saturday

SD10 to 15 Unused -

SD0SD1

Lower wordUpper word

SD1SD0

Lower wordUpper word
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Details and actions for errors (error codes) stored into SD2
Error code Description Action
0 No error -

1, 101 Parity error
The parity bit does not match.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Configure the same transmission settings in GT SoftGOT2000 

and on the host.

2, 102 Framing error
The data bit and/or stop bit are not correct.

3, 103 Overrun error
Before GT SoftGOT2000 finishes processing the received data, GT 
SoftGOT2000 has received new data from the host.

• Check the settings of the [Communication Setup] dialog.
• Decrease the transmission speed.

4, 104 Communication message error
EXT/CR could not be found before the upper limit of the receive 
buffer was exceeded.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

5 Command error
An unsupported command was used.

• Review the contents of the message to transmit.
• Check the commands in the message.

105 Timeout error
There is no response from GT SoftGOT2000, or the specified 
station is nonexistent.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

106 Multiple units not connectable
The RS-232 port is occupied.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Check to see if the RS-232 port is occupied.

6, 107 Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.
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Differences in address specifications by data format
The address specification of devices varies depending on the data format. *1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

*2 SD3 to 9 correspond to GD0 to 6 on the GOT-F900 Series.
Access to SD3 to 9 can be also made by the specification of the addresses (3000 to 300DH) of GD0 to 6 on the GOT-F900 Series.

Address Address specification value

Format 1, 2 Format 3 to 6 Format 7 to 10 Format 11 to 13 Format 14, 15 *2

SD0 8448 D9000 SD0 2100H 2100H, 2101H

SD1 8449 D9001 SD1 2101H 2102H, 2103H

SD2 8450 D9002 SD2 2102H 2104H, 2105H

SD3 8451 D9003 SD3 2103H 2106H(3000H), 2107H(3001H)

SD4 8452 D9004 SD4 2104H 2108H(3002H), 2109H(3003H)

SD5 8453 D9005 SD5 2105H 210AH(3004H), 210BH(3005H)

SD6 8454 D9006 SD6 2106H 210CH(3006H), 210DH(3007H)

SD7 8455 D9007 SD7 2107H 210EH(3008H), 210FH(3009H)

SD8 8456 D9008 SD8 2108H 2110H(300AH), 2111H(300BH)

SD9 8457 D9009 SD9 2109H 2112H(300CH), 2113H(300DH)

Upper 8 bits

2100H

Lower 8 bits

2101H

Upper 8 bits

2102H

Lower 8 bits

2103H

Upper 8 bits

2104H

Lower 8 bits

2105H

Upper 8 bits

2106H(3000H)

Lower 8 bits

2107H(3001H)

Upper 8 bits

2108H(3002H)

Lower 8 bits

2109H(3003H)

Upper 8 bits

210AH(3004H)

Lower 8 bits

210BH(3005H)

Upper 8 bits

210CH(3006H)

Lower 8 bits

210DH(3007H)

Upper 8 bits

210EH(3008H)

Lower 8 bits

210FH(3009H)

Upper 8 bits

2110H(300AH)

Lower 8 bits

2111H(300BH)

Upper 8 bits

2112H(300CH)

Lower 8 bits

2113H(300DH)
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SM devices
The SM devices are bit devices to store data, including the data to be used for interrupt outputs and clock data (ON or OFF 
status in every seconds).

List of SM devices
The following shows the SM devices which are the virtual devices of GT SoftGOT2000.

*1 An interrupt output is sent within 1 to 10 ms after the ON or OFF status is changed.
*2 If the host changes the ON or OFF status of any device in the range from SM0 to SM49, an interrupt output will not be sent.

 • Who sets values in the virtual devices
System: The system sets values in the virtual devices.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).
 • Interrupt outputs using SM0 to SM49
To disable interrupt outputs, turn on SM52 (Disable interrupt code output flag).
Page 435 SM devices
When performing interrupt output in format 1, 2, 11, 14, or 15, set [Data Bit] to [8bit] in the [Communication 
Setup] dialog.
When [7bit] is set, data is output with ignoring the most significant bit (8th bit).
(Example: FFH→7FH)
Page 76 [RS232]

Address Description Set by
SM0 to 49 Interrupt output

If you change the ON or OFF status of any device in the range from SM0 to SM49 by using a touch switch or other 
methods in GT SoftGOT2000, an interrupt code will be sent to the host as shown below (Interrupt output). *1*2

Set the amount of data (number of bytes) to be sent with [Interrupt Data Byte] in the [Communication Setup] dialog.
Page 76 [RS232]

User

SM50 1-second cycle clock
Turns ON/OFF at a 1-second cycle.

System

SM51 2-second cycle clock
Turns ON/OFF at a 2-second cycle.

SM52 Disable interrupt code output flag
Enable or disable the output of interrupt codes and special interrupt codes.
OFF: Enabled, ON: Disabled
When the output is disabled, GT SoftGOT2000 does not send interrupt outputs to the host.
(Relevant devices: D13, D14, SM0 to 49)

User

SM53 to 63 Unused -

Address Event type

SM0
Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Interrupt code

SM1

SM2

50H

51H

52H

53H

54H

55H

SM48
B0H

B1H

SM49
B2H

B3H

: : :

0.5 0.5

1 1
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Differences in address specifications by data format
The address specification of devices varies depending on the data format. *1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 437 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3 to 6: A compatible 1C frame
Formats 7 to 10: QnA compatible 3C/4C frame
Formats 11 to 13: SCHNEIDER EJH's memory link method
Formats 14, 15: GOT-F900 Series microcomputer connection

*2 In formats 3 to 6, values are specified within a range of M9000 to 9052.
*3 In formats 7 to 10, values are specified within a range of SM0 to 52.
*4 Specify addresses in increments of 16 for reading or writing data in word units. (Example: SM0, SM16, SM32,...)

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 
3 to 6

Format 
7 to 10

Format 
11 to 13

Format 
14, 15

SM7 SM6 SM5 SM4 SM3 SM2 SM1 SM0 8464 *2*4 *3*4 2110H 2200H

SM15 SM14 SM13 SM12 SM11 SM10 SM9 SM8 2201H

SM23 SM22 SM21 SM20 SM19 SM18 SM17 SM16 8465 2111H 2202H

SM31 SM30 SM29 SM28 SM27 SM26 SM25 SM24 2203H

SM39 SM38 SM37 SM36 SM35 SM34 SM33 SM32 8466 2112H 2204H

SM47 SM46 SM45 SM44 SM43 SM42 SM41 SM40 2205H

Unused SM52 SM51 SM50 SM49 SM48 8467 2113H 2206H

Unused - -
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.29  Microcomputer Connection (Serial)



3

Data format type and application

Data format type and application
Communication is possible using any of the data formats shown below.

■Formats 1, 2 (GOT-A900 Series microcomputer connection)
This is the same message format as when a microcomputer connection is established with the GOT-A900 series.

■Formats 3 to 6 (A compatible 1C frame)
This is the same message format as when communication is performed using the dedicated protocol of the A series computer 
link module.

■Formats 7 to 10 (QnA compatible 3C/4C frame)
This is the same message format as when a communication is performed using the MC protocol of Q/QnA Series serial 
communication module.

■Format 11 to 13 (SCHNEIDER EJH's memory link method)
These are the same message formats as the formats for the protocol of the SCHNEIDER EJH's memory link method.

Type Name Description Refer to
Format 1 GOT-A900 Series microcomputer 

connection (format 1)
This format is used when one host and one GT SoftGOT2000 
module are connected.

Page 439 Formats 1, 
2 (GOT-A900 Series 
microcomputer 
connection)

Format 2 GOT-A900 Series microcomputer 
connection (format 2)

This is the appended format with error code at the error response of 
the GOT-A900 Series microcomputer connection (format 1).

Type Name Description Refer to
Format 3 A compatible 1C frame (format 1) This is the basic format of the dedicated protocols. Page 452 Formats 3 

to 6 (A compatible 1C 
frame)

Format 4 A compatible 1C frame (format 2) This is the appended format of the A compatible 1C frame (format 
1) with a block No.

Format 5 A compatible 1C frame (format 3) This is the enclosed format of the A compatible 1C frame (format 1) 
with STX and ETX.

Format 6 A compatible 1C frame (format 4) This is the appended format of the A compatible 1C frame (format 
1) with CR and LF.

Type Name Description Refer to
Format 7 QnA compatible 3C/4C frame (format 1) This is the basic format of the MC protocols. Page 457 Formats 7 

to 10 (QnA compatible 3C/
4C frame)

Format 8 QnA compatible 3C/4C frame (format 2) This is the appended format of the QnA compatible 3C/4C frame 
(format 1) with block No.

Format 9 QnA compatible 3C/4C frame (format 3) This is the enclosed format of the QnA compatible 3C/4C frame 
(format 1) with STX and ETX.

Format 10 QnA compatible 3C/4C frame (format 4) This is the appended format of the QnA compatible 3C/4C frame 
(format 1) with CR and LF.

Type Name Description Refer to
Format 11 SCHNEIDER EJH's memory link method

(compatible mode)
This is the standard format of the SCHNEIDER EJH's memory link 
method.

Page 463 Format 11 
to 13 (SCHNEIDER EJH's 
(formerly Digital 
Electronics Corporation's) 
memory link method)

Format 12 SCHNEIDER EJH's memory link method
(extended mode, ASCII code 1:1)

This is the format of the SCHNEIDER EJH's memory link method 
(compatibility mode) with a sum check code, CR, and LF added.

Format 13 SCHNEIDER EJH's memory link method
(extended mode, ASCII code 1:n)

This is the format of the SCHNEIDER EJH's memory link method 
(extended mode, ASCII code 1:1) with a station number added.
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■Formats 14, 15 (GOT-F900 Series microcomputer connection)
This is the same message format as when a microcomputer connection is established with the GOT-F900 Series.

How to set data format
Set the data format in the [Communication Setup] dialog.
For details of the data format setting method, refer to the following.
Page 76 [RS232]

Type Name Description Refer to
Format 14 GOT-F900 Series microcomputer 

connection (format 1)
This format is used to establish a 1:1 or m:n connection between 
the host and GT SoftGOT2000.
The end code is CR.

Page 472 Formats 14, 
15 (GOT-F900 Series 
microcomputer 
connection)Format 15 GOT-F900 Series microcomputer 

connection (format 2)
This format is used to establish a 1:1 or m:n connection between 
the host and GT SoftGOT2000.
The end code is ETX or sum check.
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Formats 1, 2 (GOT-A900 Series microcomputer connection)

Basic format of data communication

*1 Set the number of interrupt data bytes in the [Communication Setup] dialog.
For setting the number of interrupt data bytes, refer to the following.
Page 76 [RS232]

*2 To send an interrupt output, write data to the interrupt output devices (D13 and D14).
Page 426 D devices

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

(1) When servicing a read command

(2) When servicing a write command

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 
1))

(format 2: GOT-A900 Series microcomputer connection (format 
2))

When sending an 
interrupt output *2

(format 1: GOT-A900 Series microcomputer connection (format 
1))

(format 2: GOT-A900 Series microcomputer connection (format 
2))

Sum check is performed in this range.

(H) (L)

Command Data

02H

STX

03H

ETX

(H) (L)

Sum
Check

Sum check is performed in this range.

Data

02H

STX

03H

ETX

(H) (L)

Sum
Check

06H

ACK

15H

NAK

15H

NAK Error
Code

Output value

1/2/4
bytes*1

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

Sum checkOutput value

1/2/4
bytes*1
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Details of data items in message format

Data code during communication
The ASCII code is used for communication. (Excluding interrupt outputs)

■Control codes

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
For details of the commands that can be used, refer to the following.
Page 441 List of commands for formats 1, 2 (GOT-A900 Series microcomputer connection)

■Address
Specify the first device of consecutive devices that are used for reading and writing data.
The address notated in decimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Number of points
Specify the number of devices that are used for reading and writing data. (Setting range: 1 to 99)
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
Page 448 Read clock data (TR) command
Page 449 Set clock data (TS) command

■Data
Specify the data to be read from or written to the specified device. (in word units)
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.

■Error code
This is the response message at faulty communication appended with error contents.
Error code is transmitted in 1 byte.
For details of the error codes generated in format 2 (GOT-A900 Series microcomputer connection (format 2)), refer to the 
following.
Page 451 Error code list

Symbol ASCII code Description
STX 02H Start of Text (start marker of message frame)

ETX 03H End of Text (end marker of message frame)

EOT 04H End of Transmission

ENQ 05H Enquiry (inquiry start)

NAK 15H Negative ACK (error response)

ACK 06H Acknowledge (write completion response)

LF 0AH Line Feed

CL 0CH Clear

CR 0DH Carriage Return
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■Sum check code
The sum check code is obtained by converting the lower 1 byte (8 bits) of the result (sum), after having added the sum check 
target data as binary data, to 2-digit ASCII code (Hex).

List of commands for formats 1, 2 (GOT-A900 Series microcomputer connection)

*1 Mixed specification of bit devices and word devices is also possible.

Command Command name Description Max. number of 
points processedSymbol ASCII code

RD 52H 44H Batch read in word units Reads bit devices in 16-point units. 99 words(1584points)

Reads word devices in 1-point units. 99 points

WD 57H 44H Batch write in word units Writes to bit devices in 16-point units. 99 words(1584points)

Writes to word devices in 1-point units. 99 points

RR 52H 52H Random read in word units *1 Reads multiple different bit devices in 16-point units. 256 words(4096points)

Reads multiple different word devices in 1-point units. 256 points

RW 52H 57H Random write in word units *1 Writes to multiple different word devices in 16-point units. 128 words(2048points)

Writes to multiple different word devices in 1-point units. 128 points

TR 54H 52H Read clock data Reads the clock data of the personal computer. -

TS 54H 53H Set clock data Sets the clock data of the personal computer. -

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

B C
42H 43H

Sum
Check

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

0 1
30H 31H

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

52H + 44H + 30H + 31H + 30H + 30H + 30H + 32H + 03H = 1BCH
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Message Formats
■Batch read in word units (RD) command
 • When reading a word device
The following shows an example of reading the two points of the virtual devices D100 and D101.
(Assuming D100=0102H, D101=0304H are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

D100

D101

0102H

0304H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

B C
42H 43H

Sum
Check

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

0 1
30H 31H

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

8 D
38H 44H

Sum
Check

(H) (L)

0 1
30H 31H

0
30H

2
32H

(H) (L)

0 3
30H 33H

0
30H

4
34H

Data 1 (D100) Data 2 (D101)

15H

NAK

The above is a case 
where the sum check error 
(06H) has occurred.

15H

NAK

06H

Error 
code
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 • When reading a bit device
The following shows an example of reading the two points of the virtual devices M0 to M31.
(Assuming M0="1" and M31="1" are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

M15 to 0

M31 to 6

0001H

8000H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

8C
38H43H

Sum
Check

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

8 3
38H 33H

2
32H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

8 C
38H 43H

Sum
Check

(H) (L)

Data 1 (M15 to 0)

0
30H

0
30H

1
31H

0
30H

(H) (L)

8
38H

0
30H

0
30H

0
30H

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

Data 2 (M31 to 16)

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Batch write in word units (WD) command
 • When writing to a word device
The following shows as example of writing "0064H"and "0065H"to virtual devices D100 and D101.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

D100

D101

0000H

0000H

D100

D101

0064H

0065H

Before execution After execution

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

5 6
35H 36H

Sum
Check

(H) (L)

Command

W D
57H 44H

(H) (L)

Address

0 1
30H 31H

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

(H) (L)

Data 1(D100)

0 0
30H 30H

6
36H

4
34H

(H) (L)

Data 2 (D101)

0 0
30H 30H

6
36H

5
35H

06H

ACK

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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 • When writing to a bit device
The following shows an example of writing "1"s to virtual devices M0 and M31.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

M15 to 0 0000H

0000H

0001H

8000H

Before execution After execution

M31 to 16

M15 to 0

M31 to 16

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

5 6
35H 36H

Sum
Check

(H) (L)

Data 1 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

(H) (L)

Data 2 (M31 to 16)

8
38H

––

0
30H

0
30H

0
30H

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

(H) (L)

W D
57H 44H

Command

(H) (L)

Address

8
38H

––

0
30H

2
32H

3
33H

(H) (L)

0 2
30H 32H

Number 
of points

06H

ACK

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Random read in word units (RR) command
The following shows an example of reading the two points of the virtual devices D100 and M0 to M15.
(Assuming D100=0064H, M0=1are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

D100 0064H

0001HM15 to 0

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

3 5

33H 35H

Sum
Check

(H) (L)

Command

R R

52H 52H

(H) (L)

Address 1

0 1

30H 31H

––

0

30H

0

30H

(H) (L)

Address 2

8 3

38H 33H

––

2

32H

0

30H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

8 E
38H 45H

Sum
Check

(H) (L)

Data 1 (D100)

0
30H

––

6
36H

4
34H

0
30H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

(H) (L)

Data 2 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Random write in word units (RW) command
The following shows an example of writing "0064H" and "1" to virtual devices D100 and M0, respectively.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

M15 to 0

0000H

Before execution After execution

D100

0000H M15 to 0

0064HD100

0001H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

C 5
43H 35H

Sum
Check

(H) (L)

Address 2

8
38H

––

2
32H

0
30H

3
33H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

(H) (L)

Data 2 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

(H) (L)

R W
52H 57H

Command

(H) (L)

Address 1

0
30H

––

1
31H

0
30H

0
30H

(H) (L)

Data 1 (D100)

0
30H

––

6
36H

4
34H

0
30H

*1

Following*1

06H

ACK

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Read clock data (TR) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

Time display

2004/06/01 18:46:49 TUE

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

A 9
41H 39H

Sum
Check

(H) (L)

Command

T R
54H 52H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

D 0
44H 30H

Sum
Check

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Set clock data (TS) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Tuesday, June 1, 2004.)

Setting the wrong day of the week by the clock data setting command
If the wrong day of the week is set by the clock data setting command, it will be corrected.
Example: Setting the clock to Thursday, June 1, 2004 by the clock data setting command (The actual day of 
the week is Tuesday.)
Tuesday will be set.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

(format 1: GOT-A900 Series microcomputer connection (format 1))

(format 2: GOT-A900 Series microcomputer connection (format 2))

Time display

2004/06/01 18:46:49 TUE

After execution

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

7
37H

Sum
Check

7
37H

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

(H) (L)

Command

T S
54H 53H

06H

ACK

15H

NAK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Sending interrupt outputs
Writing data to the interrupt output devices (D13 and D14) sends the data to the host.
(The following shows a case where 3139H is written to D13 and AA55H is written to D14.)

Item Message format
Interrupt output
(GT SoftGOT2000 → 
Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt

Interrupt output

Example) When [Interrupt Data Byte] in "Communication Detail Settings" is 
set to "2 byte" as (2) in the following table

31H

Output 
value 1

3139HD13

39H

Output 
value 2

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

3
33H

Sum check

C
43H39H

Output 
value 1

39H

Output 
value 1

(format 1: in the case of GOT-A900 Series 
microcomputer connection 
(format 1))

(format 2: in the case of GOT-A900 Series 
microcomputer connection 
(format 2))

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

6
36H

Sum check

D
44H31H 39H 31H 39H

Output 
value 1

Output 
value 2

Output 
value 1

Output 
value 2

(format 1: in the case of GOT-A900 Series 
microcomputer connection 
(format 1))

(format 2: in the case of GOT-A900 Series 
microcomputer connection 
(format 2))

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

6
36H

Sum 
Check

C
43HAAH

Output 
value1

55H

Output 
value2

31H

Output 
value3

39H

Output 
value4

AAH

Output 
value1

55H

Output 
value2

31H

Output 
value3

39H

Output 
value4

(format 1: in the case of GOT-A900 Series 
microcomputer connection 
(format 1))

(format 2: in the case of GOT-A900 Series 
microcomputer connection 
(format 2))

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

6
36H

Sum 
Check

C
43H31H

Output 
value1

39H

Output 
value2

AAH

Output 
value3

55H

Output 
value4

31H

Output 
value1

39H

Output 
value2

AAH

Output 
value3

55H

Output 
value4

(format 1: in the case of GOT-A900 Series 
microcomputer connection 
(format 1))

(format 2: in the case of GOT-A900 Series 
microcomputer connection 
(format 2))
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Interrupt output
To disable interrupt outputs, turn on SM52 (Disable interrupt code output flag).
Page 435 SM devices
When performing interrupt output in format 1, 2, 11, 14, or 15, set [Data Bit] to [8bit] in the [Communication 
Setup] dialog.
When [7bit] is set, data is output with ignoring the most significant bit (8th bit).
(Example: FFH→7FH)
Page 76 [RS232]

Error code list
In the case of format 2 (GOT-A900 series microcomputer connection (format 2)), the error contents (error code) are appended 
to the response message during faulty communication.
The following shows error code, error contents, cause, and measures.

Precautions
■Storage order for 32-bit data
When 32-bit data is set to maintain program compatibility with GOT-A900 series, set [32bit Storage:] to [HL Order] in the 
[Communication Setup] dialog.
When [LH Order] is set, the higher-order bits and lower-order bits of 32-bit data are displayed or written in reverse order in GT 
SoftGOT2000.

Error code Description Action
06H Sum check error

The sum check code created from received data differs from the 
sum check code in the receive data.

• Review the contents of the message to transmit.

10H Command error
An unsupported command was used.

• Review the contents of the message to transmit.
• Check the commands in the message.

11H Message length error
The data length is greater than the maximum data length for GT 
SoftGOT2000.

• Review the contents of the message to transmit.
• Check the data length of the message.(data length of the data 

section, etc.)

12H Communication message error
EXT was not found within the upper limit of the receive buffer.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

15H Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.

7AH Address error
The start address of the devices specified for reading or writing data 
is out of range.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 425 Device data area

7BH Exceeded number of points error
The number of devices specified for reading and writing data has 
exceeded the number of devices specified for GT SoftGOT2000.
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.29  Microcomputer Connection (Serial) 451



45
Formats 3 to 6 (A compatible 1C frame)

Basic format of data communication
This is the same message format as when communication is performed using the dedicated protocol (A compatible 1C frame) 
of the A Series computer link module.
For details of the basic format of data communication, refer to the following manual.
MELSEC Communication Protocol Reference Manual
This section explains settings that differ from the dedicated protocol settings of the A series computer link modules, and the 
commands dedicated to the microcomputer connection.
Example: Request message for the batch read in word units (QR) command in format 4 (A-compatible 1C frame (format 2))

Details of data items in message format

Data code during communication
Communication is performed in ASCII code.

■Block No, PLC No.
These items are ignored when the microcomputer connection is used.
Specify "00".
"00" is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Station No.
This item is used by the host to identify the destination GT SoftGOT2000.
(Setting range: 0 to 31)
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
GT SoftGOT2000 processes the command specified in the message that includes the station number matching with the set 
value of [Host Add.: (0 to 31)] in the [Communication Setup] dialog.
(GT SoftGOT2000 ignores the messages that do not include the matched station number.)
For the settings in the [Communication Setup] dialog, refer to the following.
Page 76 [RS232]

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
For details of the commands that can be used, refer to the following.
Page 453 List of commands for formats 3 to 6 (A compatible 1C frame)

■Wait
This item is ignored when the microcomputer connection is used.
Specify 0.
The value 0 is converted to its 1-digit ASCII code (hexadecimal), and the code is sent.

Sum check is performed in this range.

05H

ENQ

(H) (L)

B A
42H 41H

Sum
Check

(H) (L)

Command

R
52H

Q
51H

(H)

Address

D 1
44H 31H

––

0
30H

0
30H

(H) (L)

Number 
of points

0 2
30H 32H

(H) (L)

Block No.

0
30H

0
30H

(H) (L)

Station 
No.

0
30H

0
30H

(H) (L)

PLC No.

0
30H

0
30H 30H

Wait

0

–

0
30H

(L)

0
30H

0
30H

– –

Character A section
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■Address
Specify the first device of consecutive devices that are used for reading and writing data.
The data annotated in decimal is converted to a 5- or 7-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Number of points
Specify the number of devices that are used for reading and writing data. (Setting range: 1 to 40H)
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
Page 454 Read clock data (TR) command
Page 455 Set clock data (TS) command

■Error code
This is the response message at faulty communication appended with error contents.
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
For details of error codes generated in formats 3 to 6 (A compatible 1C frame), refer to the following:
Page 456 Error code list

Connecting microcomputers or other devices that use the dedicated protocol of the A series computer link 
modules
If you connect microcomputers or other devices that use the dedicated protocol of the A series computer link 
modules, change the commands and the devices according to the specifications of GT SoftGOT2000.

List of commands for formats 3 to 6 (A compatible 1C frame)

*1 This command is usable only when the microcomputer connection is used.
*2 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Command name Description Max. number of 
points processedSymbol ASCII code

BR
JR

42H 52H
4AH 52H

Batch read in bit units Reads bit devices in 1-point units. 64 points

WR
QR

57H 52H
51H 52H

Batch read in word units Reads bit devices in 16-point units. *2 64 words (1024 points)

Reads word devices in 1-point units. 64 points

BW
JW

42H 57H
4AH 57H

Batch write in bit units Writes to bit devices in 1-point units. 64 points

WW
QW

57H 57H
51H 57H

Batch write in word units Writes to bit devices in 16-point units. *2 64 words (1024 points)

Writes to word devices in 1-point units. 64 points

BT
JT

42H 54H
4AH 54H

Test in bit units (random write) Writes to multiple different bit devices in 1-point units. 64 points

WT
QT

57H 54H
51H 54H

Test in word units (random write) Writes to multiple different bit devices in 16-point units. *2 64 words (1024 points)

Writes to multiple different word devices in 1-point units. 64 points

TR *1 54H 52H Read clock data Reads the clock data of the personal computer. -

TS *1 54H 53H Set clock data Sets the clock data of the personal computer. -
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Message format
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Read clock data (TR) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 3 (A compatible 1C frame (format 1))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 3 (A compatible 1C frame (format 1))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 3 (A compatible 1C frame (format 1))

Time display

2004/06/01 18:46:49 TUE

Sum check is performed in this range.

05H

ENQ

(H) (L)

9 6
39H 36H

Sum
Check

(H) (L)

Command

R
52H

T
54H

(H) (L)

Station No.

0
30H

0
30H

(H) (L)

PLC No.

0
30H

0
30H 30H

Wait

0

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

9 0
39H 30H

Sum
Check

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute 
data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

*1

(H) (L)

Station No.

0
30H

0
30H

Following*1

Character B section

(H) (L)

PLC No.

0
30H

0
30H

The above is the case where an 
overrun error (05H) has occurred.

15H

NAK

(H) (L)
30H 35H

Error code

(H) (L)
30H

Station No.

0
30H

0

(H) (L)
30H

PLC No.

0
30H

0 0 5
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■Set clock data (TS) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Tuesday, June 1, 2004.)

Setting the wrong day of the week by the clock data setting command
If the wrong day of the week is set by the clock data setting command, it will be corrected.
Example: Setting the clock to Thursday, June 1, 2004 by the clock data setting command (The actual day of 
the week is Tuesday.)
Tuesday will be set.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 3 (A compatible 1C frame (format 1))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 3 (A compatible 1C frame (format 1))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 3 (A compatible 1C frame (format 1))

Time display

2004/06/01 18:46:49 TUE

After execution

Sum check is performed in this range.

05H

ENQ

(H) (L)

6 4
36H 34H

Sum
Check

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

*1

(H) (L)

Station No.

0
30H

0
30H

Following*1

Character C section

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Command

T
54H

S
53H 30H

Wait

0

06H

ACK

(H) (L)
30H

Station No.

0
30H

0

(H) (L)
30H

PLC No.

0
30H

0

The above is the case where an 
overrun error (05H) has occurred.

15H

NAK

(H) (L)
30H 35H

Error code

(H) (L)
30H

Station No.

0
30H

0

(H) (L)
30H

PLC No.

0
30H

0 0 5
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Error code list
The following shows error code, error contents, cause, and measures.

Error code Description Action
01H Parity error

The parity bit does not match.
• Check the communication cable and communication module 

attachment.
• Check the settings of the [Communication Setup] dialog.
• Configure the same transmission settings in GT SoftGOT2000 

and on the host.

02H Sum check error
The sum check code created from received data differs from the 
sum check code in the receive data.

• Review the contents of the message to transmit.

03H Protocol error
GT SoftGOT2000 has received a message that does not follow the 
control procedure of the format set in the [Communication Setup] 
dialog.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

05H Overrun error
Before GT SoftGOT2000 finishes processing the received data, GT 
SoftGOT2000 has received new data from the host.

• Check the settings of the [Communication Setup] dialog.
• Decrease the transmission speed.

06H Character section error
The character section specification error.
• The method of specifying the character section is wrong.
• The specified command has error.
• The number of points of the processing requests exceeds the 

allowable range.
• A non-existent device has been specified.
• The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check the commands in the message.
• Check the devices that can be used and the device ranges.
Page 425 Device data area
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.

07H Character error
A character other than "A to Z", "0 to 9", space, and control codes 
has been received.

• Review the contents of the message to transmit.
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Formats 7 to 10 (QnA compatible 3C/4C frame)

Basic format of data communication
This is the same message format as when communication is performed using the MC protocol (QnA compatible 3C/4C frame) 
of the Q/QnA Series serial communication module.
For details of the basic format of data communication, refer to the following manual:
MELSEC Communication Protocol Reference Manual
This section explains the settings that differ from the MC protocol settings of the Q/QnA series serial communication modules, 
and the commands dedicated to the microcomputer connection.
Example: Request message for the batch read in word units (0401) command in format 8 (QnA-compatible 4C frame (format 
2))

QnA compatible 4C frame (format 5)
The QnA-compatible 4C frame (format 5) cannot be used in GT SoftGOT2000.

Sum check is performed in this range.

05H

ENQ

(H) (L)

5 4
35H 34H

Sum check

(H) (L)

Device 
code

*
2AH

D
44H

(H) (L)

Block No.

0
30H

0
30H

(H) (L)

Frame ID 
No.

F
46H

8
38H

(H) (L)

PLC No.

0
30H

0
30H

(H)

Head Device

1
31H

––

0
30H

–

0
30H

(L)

0
30H

–

0
30H

0
30H

Character A section

(H) (L)

Station No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H) –

Request destination 
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request destination 
module station No.

0
30H

0
30H

(H) (L)

Host Address 
No.  

0
30H

0
30H

(H) –

Command

0
30H

4
34H

– (L)

0
30H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

– (H) –

Device points

0
30H

0
30H

– (L)

0
30H

2
32H

Following
*1

*1
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Details of data items in message format

Data code during communication
Communication is performed in ASCII code.

■Block No., network No., PLC No., request destination module I/O No. and station No.
These items are ignored when the microcomputer connection is used.
Specify "00". (The request destination module I/O No. is "0000".)
"00" is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
(The request destination module I/O No. is 4-digit.)

■Station No.
This item is used by the host to identify the destination GT SoftGOT2000.
(Setting range: 0 to 1FH)
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
GT SoftGOT2000 processes the messages that include the station number that matches the value set to [Host Add.: (0 to 31)] 
in the [Communication Setup] dialog.
(GT SoftGOT2000 ignores the messages that do not include the matched station number.)
For the settings in the [Communication Setup] dialog, refer to the following.
Page 76 [RS232]

■Command, sub-command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.
For details of the commands that can be used, refer to the following.
Page 459 Command lists for formats 7 to 10 (QnA compatible 3C/4C frame)

■Device code
Specify the code to identify the device data to be read and written.
The command is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Head device
Specify the first device of consecutive devices that are used for reading and writing data.
The address notated in decimal is converted to a 6-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Device points
Specify the number of devices that are used for reading and writing data. (Setting range: 1 to 40H)
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
When specifying multiple devices as follows, limit the total device points to within 64 points.
 • Using random read/write commands
When setting multiple bit accesses, word accesses or double word accesses, limit the total number of access points to within 
64 points
 • Using multi-block batch read/write commands
When setting multiple blocks, limit the total number of points of all blocks to within 64 points.
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■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
Page 460 Read clock data (1901) command
Page 461 Set clock data (0901) command

■Error code
This is the response message at faulty communication appended with error contents.
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.
For details of error codes that are generated in formats 7 to 10 (QnA compatible 3C/4C frame), refer to the following.
Page 462 Error code list

Connecting microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules
If you connect microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules, change the commands and the devices according to the specifications of GT 
SoftGOT2000.

Command lists for formats 7 to 10 (QnA compatible 3C/4C frame)

*1 Mixed specification of bit devices and word devices is also possible.
*2 This command is usable only when the microcomputer connection is used.
*3 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Subcommand Command name Description Max. number of 
points processed

0401 0001 Batch read in bit units Reads bit devices in 1-point units. 64 points

0401 0000 Batch read in word units Reads bit devices in 16-point units. *3 64 words (1024 points)

Reads word devices in 1-point units. 64 points

1401 0001 Batch write in bit units Writes to bit devices in 1-point units. 64 points

1401 0000 Batch write in word units Writes to bit devices in 16-point units. *3 64 words (1024 points)

Writes to word devices in 1-point units. 64 points

0403 0000 Random read in word units *1 Reads multiple different bit devices in 16-point and 32-point 
units. *3

64 words (1024 points)

Reads multiple different word devices in 1-point and 2-point 
units.

64 points

1402 0001 Random write in bit units Writes to multiple different bit devices in 1-point units. 64 points

1402 0000 Random write in word units *1 Writes to multiple different bit devices in 16-point and 32-point 
units. *3

64 words (1024 points)

Writes to multiple different word devices in 1-point and 2-point 
units.

64 points

0406 0000 Multi-block batch read Reads multiple blocks. A bit device (16 bits for 1 point) or a 
word device (1 word for 1 point) is regarded as one block. *3

64 points

1406 0000 Multi-block batch write Writes multiple blocks. A bit device (16 bits for 1 point) or a 
word device (1 word for 1 point) is regarded as one block. *3

64 points

1901 *2 0000 Read clock data Reads the clock data of the personal computer. -

0901 *2 0000 Set clock data Sets the clock data of the personal computer. -
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Message format
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Read clock data (1901) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 7 (QnA compatible 4C frame (format 1))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 7 (QnA compatible 4C frame (format 1))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 7 (QnA compatible 4C frame (format 1))

Time display

2004/06/01 18:46:49 TUE

Sum check is performed in this range.

05H

ENQ

(H) (L)

9
39H

Sum check

A
41H

(H) (L)

Frame ID 
No.

F
46H

8
38H

(H) (L)

PLC No.

0
30H

0
30H

Character A section

(H) (L)

Station No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H) –

Request destination 
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request destination 
module station No.

0
30H

0
30H

(H) (L)

Host 
Address No.

0
30H

0
30H

(H) –

Command

9
39H

– (L)

0
30H

1
31H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

Following
*1

*1

Sum check is performed in this range.

02H

STX

(H) (L)

Sum check

E
43H

E
43H

(H) (L)

Frame ID 
No.

F
46H

8
38H

(H) (L)

PLC No.

0
30H

0
30H

Character B section

(H) (L)

Station No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H)

Request destination 
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request destination 
module station No.  

0
30H

0
30H

(H) (L)

Host 
Address No.

0
30H

0
30H

Following
*1

*1

03H

ETX

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

–

NAK

15H

(H) (L)

Frame ID 
No.

F
46H

8
38H

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Station No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H) –

Request destination 
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request destination 
module station No.

0
30H

0
30H

(H) (L)

Host 
Address No.

0
30H

0
30H

*1

Following
*1

(H) –

Error code

7
37H

F
46H

– (L)

6
36H

9
39H

The above is the case where a parity error 
(7F69H) has occurred.
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■Set clock data (0901) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 7 (QnA compatible 4C frame (format 1))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 7 (QnA compatible 4C frame (format 1))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 7 (QnA compatible 4C frame (format 1))

Time display

2004/06/01 18:46:49 TUE

After execution

Sum check is performed in this range.

05H

ENQ

(H) (L)

7
37H

5
35H

(H) (L)

F
46H

8
38H

(H) (L)

0
30H

0
30H

Character C section

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

*1

(H) (L)

0 4
30H 34H

(H) (L)

0 6
30H 36H

(H) (L)

0 1
30H 31H

(H) (L)

1 8
31H 38H

(H) (L)

4 6
34H 36H

(H) (L)

4 9
34H 39H

(H) (L)

0 2
30H 32H

(H) –

Command

0
30H

9
39H

– (L)

0
30H

1
31H

(H) –

Sub-command

0
30H

0
30H

– (L)

0
30H

0
30H

Character C section

1)

Sum checkFrame ID 
No. PLC No.Station No. Network 

No.
Request destination 

module I/O No.

Request 
destination 
module station No.  

Host 
Address No.

Following
*1

Year data Month data Day data Hour data Minute data Second 
data

Day-of-
week data

1)

06H

ACK

(H) (L)

F
46H

8
38H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

Frame ID 
No. PLC No.Station No. Network 

No.
Request destination 

module I/O No.
Request destination 
module station No.  

Host 
Address No.

NAK

15H

(H) (L)

F
46H

8
38H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

(H) (L)

0
30H

0
30H

*1

(H) –

Error code

7
37H

F
46H

– (L)

6
36H

9
39H

The above is the case where a 
parity error (7F69H) has occurred.

Frame ID 
No. PLC No.Station No. Network 

No.
Request destination 

module I/O No.
Request destination 
module station No.  

Host 
Address No.

Following*1
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When a wrong day of the week has been set by the clock data setting command
If the wrong day of the week is set by the clock data setting command, it will be corrected.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday will be set.

Error code list
The following shows error code, error contents, cause, and measures.

Error code Description Action
7E40H Command error

An unsupported command or sub-command was used.
• Review the contents of the message to transmit.
• Check the commands in the message.

7E41H Data length error
The number of devices specified for random read or write exceeds 
the settable number of devices.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 425 Device data area

7E42H Number of data error
The number of requests exceeds the command range.

7E43H Device error
A non-existent device has been specified.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 425 Device data area

7E46H Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.

7E4FH Exceeded number of points error
The range of devices specified for reading and writing data is 
outside the device range.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 425 Device data area

7F20H Character error
A character other than "A to Z", "0 to 9", space, and control codes 
has been received.

• Review the contents of the message to transmit.

7F23H Communication message error
EXT/CR+LF was not found within the upper limit of the receive 
buffer.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

7F24H Sum check error
The sum check code created from received data differs from the 
sum check code in the receive data.

• Review the contents of the message to transmit.

7F67H Overrun error
Before GT SoftGOT2000 finishes processing the received data, GT 
SoftGOT2000 has received new data from the host.

• Check the settings of the [Communication Setup] dialog.
• Decrease the transmission speed.

7F68H Framing error
The data bit and/or stop bit are not correct.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Configure the same transmission settings in GT SoftGOT2000 

and on the host.

7E40H Parity error
The parity bit does not match.

7F6AH Buffer full error
The receive buffer overflowed.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.
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Format 11 to 13 (SCHNEIDER EJH's (formerly Digital Electronics 
Corporation's) memory link method)

Basic format of data communication
These are the same message formats as the formats for the protocol of the SCHNEIDER EJH's memory link method.
For details of the basic format of data communication, refer to the following manual.
SCHNEIDER EJH device connection manual
This section explains the settings that differ from the protocol settings of the SCHNEIDER EJH's memory link method, and the 
commands dedicated to the microcomputer connection.
Example: Request message for the batch read in word units (R) command in format 13 (SCHNEIDER EJH's memory link 
method (extended mode, ASCII code 1:n))

Compatibility with SCHNEIDER EJH's memory link method
In formats 12 and 13 (SCHNEIDER EJH's memory link method (extended mode)), some communication 
packets are incompatible with SCHNEIDER EJH's memory link method. Therefore, a communication error 
may occur.
To give the compatibility, turn on the digital compatible signals (GS580 to GS583) of the GOT internal device 
and communicate in the fully compatible message format.

When the digital compatible signal turns on, interrupt outputs (D13 to D14, SM0 to SM49) are invalid.
To use interrupt outputs, turn off the digital compatible signal.
For the GOT internal device, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual

Sum check is performed in this range.

05H

ENQ

(H) (L)

5 E
35H 45H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H

(H) –

Address

0
30H

4
34H

– (L)

0
30H

6
36H

(H) –

Number of points

0
30H

0
30H

– (L)

0
30H

2
32H1BH

ESC

52H

R
0DH

CR

0AH

LFCom-
mand

Device Function

GS580 b0

b0

b0

b0

Microcomputer connection 
extended setting (CH1)

Microcomputer connection 
extended setting (CH2)

Microcomputer connection 
extended setting (CH3)

Microcomputer connection 
extended setting (CH4)

Bit Bit position Settings

GS581

GS582

GS583

Digital compatible 
signal

0: Partly compatible (Default)
1: Fully compatible

0: Partly compatible (Default)
1: Fully compatible

0: Partly compatible (Default)
1: Fully compatible

0: Partly compatible (Default)
1: Fully compatible

Digital compatible 
signal

Digital compatible 
signal

Digital compatible 
signal
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Details of data items in message format

Data code during communication
Communication is performed in ASCII code.

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 1-digit ASCII code (Hex) and transmitted.
For details of the commands that can be used, refer to the following.
Page 465 Commands for formats 11 to 13 (SCHNEIDER EJH's memory link method)

■Station No.
This item is used by the host to identify the destination GT SoftGOT2000.
(Setting range: 0 to 1FH)
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
GT SoftGOT2000 processes the messages that include the station number matching with the set value of [Host Add.: (0 to 
31)] in the [Communication Setup] dialog.
(GT SoftGOT2000 ignores the messages that do not include the matched station number.)
For the settings in the [Communication Setup] dialog, refer to the following.
Page 76 [RS232]

■Address
Specify the first device of consecutive devices that are used for reading and writing data.
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Number of points
Specify the number of devices that are used for reading and writing data.
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upperdigit.
The setting range depends on the format and command.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
For details of error codes generated in formats 12 and 13 (Digital Electronics Corporation's memory link method (extended 
mode)), refer to the following.
Page 465 Read clock data (N) command
Page 467 Set clock data (M) command

■Error code
This is the response message at faulty communication appended with error contents.
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
For the codes of errors that may occur using formats 12 and 13 (SCHNEIDER EJH's memory link method (extended mode)), 
refer to the following.
Page 471 Error code list

Format Command Command name Setting range
11 R Batch read in word units 1 to 100H

W Batch write in word units 1 to 1F0H

12 R Batch read in word units 1 to 100H

W Batch write in word units

13 R Batch read in word units 1 to 100H

W Batch write in word units
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Connecting microcomputers or other devices that use the protocol of the SCHNEIDER EJH's memory link 
method
If you connect microcomputers or other devices that use the protocol of the SCHNEIDER EJH's memory link 
method, change the commands and the devices according to the specifications of GT SoftGOT2000.

Commands for formats 11 to 13 (SCHNEIDER EJH's memory link method)

*1 This command is usable only when the microcomputer connection is used.

Message format
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Read clock data (N) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Tuesday, June 1, 2004.)

Command Command name Description Max. number of points processed

Symbol ASCII code
R 52H Batch read in word units Reads bit devices in 16-point units. 256 words (4096 devices)

Reads word devices in 1-point units. 256 devices

W 57H Batch write in word units Writes to bit devices in 16-point units. Format 11: 496 words (7936 devices)
Format 12: 256 words (4096 devices)
Format 13: 256 words (4096 devices)

Writes to word devices in 1-point units. Format 11: 496 devices
Format 12: 256 devices
Format 13: 256 devices

I 49H Interrupt inquiry Sends an interrupt inquiry. (Format 13 only) -

N *1 4DH Read clock data Reads the clock data of the personal computer. -

M *1 4EH Set clock data Sets the clock data of the personal computer. -

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
• Digital compatible signal (GS580 to GS583): OFF (Partly compatible)

• Digital compatible signal (GS580 to GS583): ON (Fully compatible)

Time display

2004/06/01 18:46:49 TUE

This range Sum check

05H

ENQ

(H) (L)

C E
43H 45H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

4EH

N
0DH

CR

0AH

LFCom-
mand

This range Sum check

05H

ENQ

(H) (L)

C 9
43H 39H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

4EH

N
0DH

CR

0AH

LFCom-
mand
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Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
• Digital compatible signal (GS580 to GS583): OFF (Partly compatible)

• Digital compatible signal (GS580 to GS583): ON (Fully compatible)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))

Item Message format

This range Sum check

02H

STX

(H) (L)

8 E
38H 45H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

41H

A
0DH

CR

0AH

LF

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data
4 9

34H 39H

(H) (L)

Day-of-
week data
0 2

30H 32H

*1

Following*1

03H

ETXCom-
mand

This range Sum check

02H

STX

(H) (L)

8 C
38H 43H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

41H

A
0DH

CR

0AH

LF

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data
4 9

34H 39H

(H) (L)

Day-of-
week data
0 2

30H 32H

*1

Following*1

03H

ETXCom-
mand

The above is a case where the sum 
check error (06H) has occurred.

15H

NAK

(H) (L)
30H 36H

Error code

(H) (L)
30H

Station No.

0
30H

0 0 6
0DH

CR

0AH

LF
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■Set clock data (M) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
• Digital compatible signal (GS580 to GS583): OFF (Partly compatible)

• Digital compatible signal (GS580 to GS583): ON (Fully compatible)

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))

Time display

2004/06/01 18:46:49 TUE

After execution

Sum check is performed in this range.

05H

ENQ

(H) (L)

9 A
39H 41H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

4DH

M
0DH

CR

0AH

LF

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

*1

Following*1

Com-
mand

Sum check is performed in this range.

05H

ENQ

(H) (L)

9 5
39H 35H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

4DH

M
0DH

CR

0AH

LF

(H) (L)

Year data

0 4
30H 34H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

*1

Following*1

Com-
mand

06H

ACK

(H) (L)
30H

Station No.

0
30H

0
0DH

CR

0AH

LF

The above is a case where the sum 
check error (06H) has occurred.

15H

NAK

(H) (L)
30H 36H

Error code

(H) (L)
30H

Station No.

0
30H

0 0 6
0DH

CR

0AH

LF
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When a wrong day of the week has been set by the clock data setting command
If the wrong day of the week is set by the clock data setting command, it will be corrected.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday will be set.

■Interrupt inquiry
The following shows an example of interrupt inquiry when data are written to the interrupt output devices (D13 and D14).
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
• Digital compatible signal (GS580 to GS583): OFF (Partly compatible)

• Digital compatible signal (GS580 to GS583): ON (Fully compatible)

Interrupt output

Example: When the number of interrupt data bytes is 2 in format 11

31H

Output 
value 1

3139HD13

39H

Output 
value 2

Interrupt

This range Sum check

05H

ENQ

(H) (L)

C 9
43H 39H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LFCom-
mand

This range Sum check

05H

ENQ

(H) (L)

C 4
43H 34H

Sum
Check

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LFCom-
mand
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Interrupt inquiry
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog

Item Message format

This range Sum check is performed.

02H

STX

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

9 4
39H 44H

Sum
Check

(H) (L)

3 9
33H 39H

Output 
value 1

03H

ETXCom-
mand

(H) (L)

0
30H 31H

Data 
quantity

1

Sum check is performed in this range.

02H

STX

(H) (L)

9
39H

Sum
Check

F
46H

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

3 1
33H 31H

Output 
value 1

03H

ETX

(H) (L)

3 9
33H 39H

Output 
value 2

Com-
mand

(H) (L)

0
30H 31H

Data 
quantity

1

Sum check is performed in this range.

02H

STX

(H) (L)

7
37H

Sum
Check

E
45H

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

A
41H

Output 
value 1

A
41H 03H

ETX

(H) (L)

5
35H

Output 
value 2

5
35H

(H) (L)

3 1
33H 31H

Output 
value 3

(H) (L)

3 9
33H 39H

Output 
value 4

Com-
mand

(H) (L)

0
30H 31H

Data 
quantity

1
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■Sending interrupt outputs
Writing data to the interrupt output devices (D13 and D14) sends the data to the host.
(The following shows a case where 3139H is written to D13 and AA55H is written to D14.)

Item Message format
Interrupt output
(GT SoftGOT2000 → 
Host)

Example: Format 13 (SCHNEIDER EJH's memory link method (extended mode, ASCII code 1:n))
(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt

Interrupt output

Example) When [Interrupt Data Byte] in "Communication Detail Settings" is 
set to "2 byte" as (2) in the following table

31H

Output 
value 1

3139HD13

39H

Output 
value 2

This range Sum check is performed.

02H

STX

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

9 4
39H 44H

Sum
Check

(H) (L)

3 9
33H 39H

Output 
value 1

03H

ETXCom-
mand

(H) (L)

0
30H 31H

Data 
quantity

1

Sum check is performed in this range.

02H

STX

(H) (L)

9
39H

Sum
Check

F
46H

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

3 1
33H 31H

Output 
value 1

03H

ETX

(H) (L)

3 9
33H 39H

Output 
value 2

Com-
mand

(H) (L)

0
30H 32H

Data 
quantity

2

Sum check is performed in this range.

02H

STX

(H) (L)

7
37H

Sum
Check

E
45H

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

A
41H

Output 
value 1

A
41H 03H

ETX

(H) (L)

5
35H

Output 
value 2

5
35H

(H) (L)

3 1
33H 31H

Output 
value 3

(H) (L)

3 9
33H 39H

Output 
value 4

Com-
mand

(H) (L)

0
30H 34H

Data 
quantity

4

Sum check is performed in this range.

02H

STX

(H) (L)

7
37H

Sum
Check

E
45H

(H) (L)

Station No.

0
30H

0
30H 1BH

ESC

49H

I
0DH

CR

0AH

LF

(H) (L)

3
33H

Output 
value 1

1
31H 03H

ETX

(H) (L)

3
39H

Output 
value 2

9
39H

(H) (L)

A A
41H 41H

Output 
value 3

(H) (L)

5 5
35H 35H

Output 
value 4

Com-
mand

(H) (L)

0
30H 34H

Data 
quantity

4
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Interrupt output
To disable interrupt outputs, turn on SM52 (Disable interrupt code output flag).
Page 435 SM devices
When performing interrupt output in format 1, 2, 11, 14, or 15, set [Data Bit] to [8bit] in the [Communication 
Setup] dialog.
When [7bit] is set, data is output with ignoring the most significant bit (8th bit).
(Example: FFH→7FH)
Page 76 [RS232]

Error code list
When the message format is 12 or 13 (SCHNEIDER EJH's memory link method (extended mode)), if there is an error, the 
error code is added to the response message.
The following shows error code, error contents, cause, and measures.

Precautions
■Storage order for 32-bit data
When 32-bit data is set to maintain program compatibility with the SCHNEIDER EJH's memory link method, set [32bit 
Storage:] to [HL Order] in the [Communication Setup] dialog.
When [LH Order] is set, the higher-order bits and lower-order bits of 32-bit data are displayed or written in reverse order in GT 
SoftGOT2000.

Error code Description Action
06H Sum check error

The sum check code created from received data differs from the 
sum check code in the receive data.

• Review the contents of the message to transmit.

10H Command error
An unsupported command was used.

• Review the contents of the message to transmit.
• Check the commands in the message.

12H Message length error
The data length is greater than the maximum data length for GT 
SoftGOT2000.

16H Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.

FAH Address error
The start device number of the read or write devices is outside the 
range.

• Review the contents of the message to transmit.
• Check the data length of the message.(data length of the data 

section, etc.)

FBH Exceeded number of points error
The number of devices specified for reading and writing data has 
exceeded the number of devices specified for GT SoftGOT2000.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 425 Device data area

FCH Message format error
The format of the received message has error.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

FFH Timeout error
There is no response from GT SoftGOT2000, or the specified 
station is nonexistent.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.
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Formats 14, 15 (GOT-F900 Series microcomputer connection)

Basic format of data communication

*1 Set the number of interrupt data bytes in the [Communication Setup] dialog.
For setting the number of interrupt data bytes, refer to the following.
Page 76 [RS232]

*2 To send an interrupt output, write data to the interrupt output devices (D13 and D14).
Page 426 D devices

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection 
(format 1))
(1) w/out station No.

(2) w/station No.

(format 15: GOT-F900 Series microcomputer connection 
(format 2))
(1) w/out station No.

(2) w/station No.

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

(1) When servicing a read command
(format 14: GOT-F900 Series microcomputer connection 
(format 1))

(format 15: GOT-F900 Series microcomputer connection 
(format 2))

(2) When servicing a write command

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Sending an interrupt 
output *2

02H

STX

0DH

CRDataCom-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

Sum
CheckDataCom-

mand

02H

STX

0DH

CRData

(H) (L)

Station No.Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

Sum
CheckData

(H) (L)

Station No.Com-
mand

02H

STX

0DH

CRData

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

Sum
CheckData

06H

ACK

15H

NAK

Output 
value 

1/2/4 
bytes*1
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Details of data items in message format

Data code during communication
The ASCII code is used for communication. (Excluding interrupt outputs)

■Control codes

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 1-digit ASCII code (Hex) and transmitted.
For details of the commands that can be used, refer to the following.
Page 475 List of commands for formats 14, 15 (GOT-F900 series microcomputer connection)

■Station No.
This item is used by the host to identify the destination GT SoftGOT2000.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
GT SoftGOT2000 processes the messages that include the station number matching with the set value of [Host Add.: (0 to 
31)] in the [Communication Setup] dialog.
(GT SoftGOT2000 ignores the messages that do not include the matched station number.)
For the settings in the [Communication Setup] dialog, refer to the following.
Page 76 [RS232]

■Address
Specify the first device of consecutive devices that are used for reading and writing data.
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.
For the range of accessible devices, refer to the following.
Page 425 Device data area

■Bit pattern
Specifies the pattern of the bits to change.
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
Page 480 Multi-point write in bit units (3) command (without station No.), Multi-point write in bit units (D) command (with 
station No.)

■Write specification
Specifies how to change the data of the specified address by bit pattern.
(Setting range: 0 to 3)
Data notated in decimal is converted to a 1-digit ASCII code (Hex) and transmitted.
Page 480 Multi-point write in bit units (3) command (without station No.), Multi-point write in bit units (D) command (with 
station No.)

Symbol ASCII code Description
STX 02H Start of Text (start marker of message frame)

ETX 03H End of Text (end marker of message frame)

EOT 04H End of Transmission

ENQ 05H Enquiry (inquiry start)

NAK 15H Negative ACK (error response)

ACK 06H Acknowledge (write completion response)

LF 0AH Line Feed

CL 0CH Clear

CR 0DH Carriage Return
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■Number of bytes
Specify the number of bytes to be read/written from/to devices in one go. (Setting range: 0 to FFH)
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Number of points
Specifies the number of devices that are used for multi-point write in bits.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The address notated in decimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.
Page 483 Read clock data (6) command (without station No.) and the read clock data (G) command (with station No.)
Page 484 Set clock data (5) command (w/out station No.), set clock data (F) command (w/station No.)

■Data
Specifies data (word unit) to be read or written to the specified device data.
The address notated in hexadecimal is converted to a 4-digit ASCII code (Hex) and transmitted from the upper digit.

■Writing data
Specify data to be written to the specified device data.
The address notated in hexadecimal is converted to a 2-digit ASCII code (Hex) and transmitted from the upper digit.

■Sum check code (for format 15: GOT-F900 series microcomputer connection (format 2) only)
The sum check code is obtained by converting the lower 1 byte (8 bits) of the result (sum), after having added the sum check 
target data as binary data, to 2-digit ASCII code (Hex).

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

B C
42H 43H

Sum
Check

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

0 1
30H 31H

––

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

52H + 44H + 30H + 31H + 30H + 30H + 30H + 32H + 03H = 1BCH 
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List of commands for formats 14, 15 (GOT-F900 series microcomputer connection)
Command Command name Description Max. number of 

points processedSymbol ASCII code
0 30H Batch read (without station No.) Reads bit devices in byte units. 255bytes (2040 points)

Reads word devices in byte units. 255bytes (127 points)

A 41H Batch read (with station No.) Reads bit devices in byte units. 255bytes (2040 points)

Reads word devices in byte units. 255bytes (127 points)

1 31H Batch write (without station No.) Writes to bit devices in byte units. 255bytes (2040 points)

Writes to word devices in byte units. 255bytes (127 points)

B 42H Batch write (with station No.) Writes to bit devices in byte units. 255bytes (2040 points)

Writes to word devices in byte units. 255bytes (127 points)

3 33H Multi-point write in bit units (without 
station No.)

Writes bit patterns (bit ON/OFF, inversion, direct specification) 
in 1-point units (8 bits for 1 point) to a specified device.

70bytes (560 points)

D 44H Multi-point write in bit units (with 
station No.)

4 34H Fill command (w/out station No.) Writes the same value to a range of specified devices. -

E 45H Fill command (w/ station No.)

5 35H Set clock data (w/out station No.) Sets the clock data of the personal computer. -

F 46H Set clock data (w/ station No.)

6 36H Read clock data (without station 
No.)

Reads the clock data of the personal computer. -

G 47H Read clock data (with station No.)
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Message format
■Batch read (0) command (without station No.) and the batch read (A) command (with station 

No.)
 • When reading a word device
The following shows an example of reading 4-byte data from virtual devices R100 and R101 for GT SoftGOT2000 (station No. 
15).
(Assuming R100=3D21H, R101=3604H are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

R100

R101

3D21H

3604H

02H

STX

0DH

CR

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

––

0
30H

8
38H

(H) (L)

Number 
of bytes

0 4
30H 34H

A
41H

C
43H

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

E 9
45H 39H

Sum
Check

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

––

0
30H

8
38H

(H) (L)

Number of 
bytes

0 4
30H 34H

A
41H

C
43H

Com-
mand

02H

STX

0DH

CR

(H)

Data 1
(R100 upper)

3
33H

(L)

D
44H

(H)

Data 2
(R100 lower)

2
32H

(L)

1
31H

(H)

Data 3
(R101 upper)

3
33H

(L)

6
36H

(H)

Data 4
(R101 lower)

0
30H

(L)

4
34H

02H

STX

03H

ETX

(H) (L)

A
41H

A
41H

(H)

Data 1
(R100 upper)

Data 3
(R101 upper)

3
33H

(L)

D
44H

(H)

Data 2
(R100 lower)

Data 4
(R101 lower)

2
32H

(L)

1
31H

(H)

3
33H

(L)

6
36H

(H)

0
30H

(L)

4
34H

Sum check is performed in this range.

Sum
Check

15H

NAK
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 • When reading a bit device
The following shows an example of reading four bytes of the virtual devices M0 to M31.
(Assuming M0="1" and M31="1" are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

M15 to 0

M31 to 16

0001H

8000H

02H

STX

0DH

CR

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

2
32H

––

0
30H

(H) (L)

Number of 
bytes

0 4
30H 34H

A
41H

0
30H

0
30H

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

D 0
44H 30H

Sum
Check

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

2
32H

––

0
30H

(H) (L)

Number of 
bytes

0 4
30H 34H

A
41H

0
30H

0
30H

Com-
mand

02H

STX

0DH

CR

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

(H) (L)

Data 1
(M7 to 0)

0
30H

1
31H

(H) (L)

Data 2
(M15 to 8)

0
30H

0
30H

(H) (L)

Data 3
(M23 to 16)

0
30H

0
30H

(H) (L)

Data 4
(M31 to 24)

8
38H

0
30H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

8 C
38H 43H

Sum
Check

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

(H) (L)

Data 1
(M7 to 0)

0
30H

1
31H

(H) (L)

Data 2
(M15 to 8)

0
30H

0
30H

(H) (L)

Data 3
(M23 to 16)

0
30H

0
30H

(H) (L)

Data 4
(M31 to 24)

8
38H

0
30H  

15H

NAK
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■Batch write (1) command (without station No.) and the batch write (B) command (with station 
No.)

 • When writing to a word device
The following shows an example of writing 0064H and 0065H to virtual devices R100 and R101 for GT SoftGOT2000 (station 
No. 15).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

R100

R101

0000H

0000H

R100

R101

0064H

0065H

Before execution After execution

02H

STX

0DH

CR

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

0
30H

8
38H

(H) (L)

Number of 
bytes

0 4
30H 34H

B
42H

C
43H

Following*1

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

1
31H

Sum
Check

9
39H

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

––

0
30H

8
38H

(H) (L)

Number 
of bytes

0 4
30H 34H

B
42H

C
43H

(H) (L)

Data 1
(R100 upper)

0 0
30H 30H

(H) (L)

Data 2
(R100 lower)

6 4
36H 34H

(H) (L)

Data 3
(R101 upper)

0 0
30H 30H

(H) (L)

Data 4
(R101 lower)

6 5
36H 35H

Following*1

*1

Com-
mand

06H

ACK

15H

NAK
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 • When writing to a bit device
The following shows an example of writing 1 to virtual devices M0 and M31 for GT SoftGOT2000 (station No. 15).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

M15 to 0 0000H

0000H

Before execution After execution

M31 to 16

M15 to 0 0001H

8000HM31 to 16

02H

STX

0DH

CR

42H

B

(H) (L)

Station No.

5
35H

1
31H

(H) –

Address

0
30H

2
32H

– (L)

0
30H

0
30H

(H) (L)

Number of 
bytes

4
34H

0
30H

Following*1

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

5 A
35H 41H

Sum
Check

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

(H) (L)

Data 1
(M7 to 0)

0
30H

1
31H

(H) (L)

Data 2
(M15 to 8)

0
30H

0
30H

(H) (L)

Data 3
(M23 to 16)

0
30H

0
30H

(H) (L)

Data 4
(M31 to 24)

8
38H

0
30H

42H

B

(H) (L)

Station No.

5
35H

1
31H

(H) –

Address

0
30H

2
32H

– (L)

0
30H

0
30H

(H) (L)

Byte 
Number

4
34H

0
30H

Following*1

*1

3

Com-
mand

06H

ACK

15H

NAK
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■Multi-point write in bit units (3) command (without station No.), Multi-point write in bit units (D) 
command (with station No.)

The following shows an example of turning off virtual device M31 and turning on M2038 for GT SoftGOT2000 (station No. 31).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

02H

STX

0DH

CR

(H) (L)

Station No.

3
33H

1
31H

D
44H

Following*1

(H) (L)

Number of 
points

0
30H

2
32H

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

C
43H

Sum check

E
45H

(H) (L)

Station No.

3
33H

1
31H

(H) (L)

Address1 Address2

2
32H

––

0
30H

(H) (L)

Bit pattern1

8
38H

0
30H

D
44H

Following *1

*1

(H) (L)

Number of 
points

0
30H

2
32H

Write 
specification
1

1
31H

0
30H

3
33H

(H) (L)

2
32H

––

0
30H

(H) (L)

Bit pattern2

4
34H

0
30H

Write 
specification
2

0
30H

F
46

E
45H

*2 *2

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

01010101Source data 
bit pattern 00000001

01010100Result

(write specification1=1)

M
2
0
3
2

M
2
0
3
3

M
2
0
3
4

M
2
0
3
5

M
2
0
3
6

M
2
0
3
7

M
2
0
3
8

M
2
0
3
9

01010101Source data 
bit pattern 00000010

01010111Result

(write specification2=0)

Com-
mand

06H

ACK

15H

NAK
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*1 For write specification, specify how to change the data of specified address with bit pattern.

Write 
specification

Function Description Action example

0 ON specification Bits set to "1" by the bit pattern are turned ON. Original data1010
Bit pattern1100
Result1110

1 OFF 
specification

Bits set to "1" by the bit pattern are turned OFF. Original data1010
Bit pattern1100
Result0010

2 Invert 
specification

Bits set to "1" by the bit pattern are inverted. Original data1010
Bit pattern1100
Result0110

3 Write 
specification

The numerical values to write by the bit pattern are specified directly. Original data1010
Bit pattern1100
Result1100
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■Fill command (4) (w/out station No.), fill command (E) (w/station No.)
The following shows an example of writing 16 to virtual devices R50 to R100 for GT SoftGOT2000 (station No. 27).

 • Start address/end address specification conditions
Specify addresses so that the start address is the same or less than the end address.
Error response occurs in the following cases:
The address to specify has the start address greater than the end address.
Either of the start address or end address exceeds the device range that can be specified.
 • Address specifying crossing over different devices
The start address and end address can be specified crossing over different devices.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

R100

0000H

Before execution After execution

R50

0000H

0000H

R100

1616HR50

1616H

1616H

02H

STX

0DH

CR

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Write
Data

1 6
31H 36H

E
45H

(H) (L)

Start address

0
30H

––

0
30H

4
34H

6
36H

(H) (L)

End address

0
30H

––

0
30H

9
39H

C
43H

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

B
42H

Sum
Check

E
45H

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Write
Data

1 6
31H 36H

E
45H

(H) (L)

Start address

0
30H

––

0
30H

4
34H

6
36H

(H) (L)

End address

0
30H

––

0
30H

9
39H

C
43H

Com-
mand

06H

ACK

15H

NAK
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■Read clock data (6) command (without station No.) and the read clock data (G) command (with 
station No.)

The following shows an example of reading the clock data from GT SoftGOT2000 (station No. 27).
(The clock is set to 18:46:49 on Tuesday, June 1, 2004.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Time display

2004/06/01 18:46:49 TUE

02H

STX

0DH

CR

(H) (L)

Station No.

2 7
32H 37H

G
47H

Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

B
42H

Sum
Check

3
33H

(H) (L)

Station No.

2 7
32H 37H

G
47H

Com-
mand

02H

STX

0DH

CR

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

(H) (L)

Year data

0 4
30H 34H

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

D 0
44H 30H

Sum
Check

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

(H) (L)

Year data

0 4
30H 34H

15H

NAK
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.29  Microcomputer Connection (Serial) 483



48
■Set clock data (5) command (w/out station No.), set clock data (F) command (w/station No.)
The following shows an example of setting the clock data for GT SoftGOT2000 (station No. 27).
(The clock will be set to 18:46:49 on Tuesday, June 1, 2004.)

When a wrong day of the week has been set by the clock data setting command
If the wrong day of the week is set by the clock data setting command, it will be corrected.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday will be set.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 14: GOT-F900 Series microcomputer connection (format 1))

(format 15: GOT-F900 Series microcomputer connection (format 2))

Response message 
during normal 
communication
(GT SoftGOT2000 → 
Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 → 
Host)

Time display

2004/06/01 18:46:49 TUE

After execution

46H

F
0DH

CR

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day Data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

(H) (L)

Year data

0 4
30H 34H02H

STX Com-
mand

Sum check is performed in this range.

02H

STX

03H

ETX

(H) (L)

7 F
37H 46H

Sum
Check

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Month data

0 6
30H 36H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 2
30H 32H

(H) (L)

Year data

0 4
30H 34H

46H

F Following*1

*1

Com-
mand

06H

ACK

15H

NAK
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■Sending interrupt outputs
Writing data to the interrupt output devices (D13 and D14) sends the data to the host.
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)

Interrupt output
To disable interrupt outputs, turn on SM52 (Disable interrupt code output flag).
Page 435 SM devices
When performing interrupt output in format 1, 2, 11, 14, or 15, set [Data Bit] to [8bit] in the [Communication 
Setup] dialog.
When [7bit] is set, data is output with ignoring the most significant bit (8th bit).
(Example: FFH→7FH)
Page 76 [RS232]

Item Message format
Interrupt output
(GT SoftGOT2000 → 
Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
• When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

• When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt

Interrupt output

Example) When [Interrupt Data Byte] in "Communication Detail Settings" is 
set to "2 byte" as (2) in the following table

31H

Output 
value 1

3139HD13

39H

Output 
value 2

39H

Output 
value 1

31H

Output 
value 1

39H

Output 
value 2

AAH

Output 
value 1

55H

Output 
value 2

31H

Output 
value 3

39H

Output 
value 4

31H

Output 
value 1

39H

Output 
value 2

AAH

Output 
value 3

55H

Output 
value 4
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Error code list
When faulty, the error code is stored in SD2.
For details of error code stored in SD2, the error contents, cause and measures, refer to the following.
Page 433 Details and actions for errors (error codes) stored into SD2
When an error other than those to be stored in SD2 occurs, at faulty, only the NAK response is executed.

Controller setting

Settings in GT Designer3
Configure the settings in GT Designer3 as shown below.

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Settings in GT SoftGOT2000
To establish communication between GT SoftGOT2000 and the host by using the microcomputer connection (serial), 
configure the communication settings.
Refer to the following, and configure the communication settings in GT SoftGOT2000.
Page 76 [RS232]

Item Description Range
[Manufacturer] Select the manufacturer of the controller connected to GT SoftGOT2000. [Others]

[Controller Type] Select the type of the controller connected to GT SoftGOT2000. [Computer]
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Precautions

Clock control in GT SoftGOT2000
The time setting and time notification set in GT Designer3 will be disabled.
To read or write the clock data between GT SoftGOT2000 and a host, use the dedicated command.

Placing GT SoftGOT2000 into offline mode
Before placing GT SoftGOT2000 into offline mode, stop data transmission between GT SoftGOT2000 and the host.
In offline mode, GT SoftGOT2000 cannot respond to the requests from the host.
Even after GT SoftGOT2000 switches back from offline mode, GT SoftGOT2000 may not communicate with the host until the 
communication timeout period of the host elapses.

Channels available in GT SoftGOT2000 (Multiple channels)
One of channels 1 to 4 is available for the microcomputer connection (serial).

Simultaneous use of other connections
The following connections cannot be used simultaneously.
Connection to TOSHIBA PLCs
Barcode reader connection
RFID connection
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3.30 Microcomputer Connection (Ethernet)
The microcomputer connection (Ethernet) is established between GT SoftGOT2000 and the host (such as a personal 
computer, microcomputer board, or PLC) via Ethernet, and allows the host to read/write data from/to the virtual devices of GT 
SoftGOT2000.
GT SoftGOT2000 can send an interrupt output to the host.
For the flow of the data processing, such as reading or writing data and interrupt output, refer to the following.
Page 421 Microcomputer Connection (Serial)

System Configuration

*1 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.
Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*2 An Ethernet board/card is required.
Page 488 Ethernet board/card

Ethernet board/card
Use the same Ethernet board or Ethernet card as the one used for connection to a MITSUBISHI ELECTRIC PLC.
Page 236 Ethernet interface

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Connection cable
Use a cable applicable to the Ethernet module or the Ethernet board/card to be used.

Host Connection 
cable*1

Maximum length GT SoftGOT2000 Number of 
connectable GT 
SoftGOT2000 
modules per 
host

Number of 
connectable 
hosts per GT 
SoftGOT2000 
channel

Unit Type Communication 
type

Personal computer, 
microcomputer 
board, PLC, or other 
devices

Ethernet Twisted pair cable 100 m(max. 
segment length)

Windows-compatible 
personal computer*2

PC CPU module
MELIPC

UDP: Unlimited
TCP: Unlimited

UDP: Unlimited
TCP: 1

Host

Connection cable

GT SoftGOT2000
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Device data area
The following shows the GT SoftGOT2000 virtual devices that are usable when the microcomputer connection (Ethernet) is 
used and the address specification values for each data format.
The address specification values for the GT SoftGOT2000 virtual devices vary by data format.*1

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

*2 When reusing GOT900 Series project data
GOT-A900 Series virtual devices (D0 to 2047)
Can be used as they are without changing the assignments.
GOT-F900 Series virtual devices
Since some of the assigned virtual device values differ as indicated below, change the assignment using device batch edit of GT 
Designer3.
Refer to the following manual for device batch edit of GT Designer3.
GT Designer3 (GOT2000) Screen Design Manual

*3 Access to SD3 to 9 can also be made by the specification of the addresses (3000 to 300DH) of GD0 to 6 on the GOT-F900 Series.

Values of the GT SoftGOT2000 virtual devices
Exiting GT SoftGOT2000 clears the values of the virtual devices to their defaults (bit devices: OFF, word 
devices: 0).
If you close and reopen a project, the stored values will be held.

Virtual device*2 Address specification value Refer to

Name Device 
range 
(decimal)

Device 
type

Format 1, 2 Format 3, 4 Format 5 Format 6 to 9

D 0 to 4095 Word 0 to 4095 8000 to 9FFFH 0000 to 0FFFH D0 to D4095 Page 490 D devices

R 0 to 4095 Word 4096 to 8191 0000 to 1FFFH 1000 to 1FFFH R0 to R4095 Page 494 R devices

L 0 to 2047 Bit 8192 to 8319 A000 to A0FFH 2000 to 207FH L0 to L2047 Page 495 L devices

M 0 to 2047 Bit 8320 to 8447 2000 to 20FFH 2080 to 20FFH M0 to M2047 Page 496 M devices

SD 0 to 15 Word 8448 to 8463 2100 to 211FH 
(3000 to 300DH)*3

2100 to 210FH SD0 to SD15 Page 497 SD devices

SM 0 to 63 Bit 8464 to 8467 2200 to 2207H 2110 to 2113H SM0 to SM63 Page 500 SM devices

GOT2000 Series virtual devices GOT-F900 Series virtual devices
D0 to 2047 ―

D2048 to 4095 ―

R0 to 4095 D0 to 4095

L0 to 2047 ―

M0 to 2047 M0 to 2047

SD0 to 15 D8000 to 8015
GD0 to 6

SM0 to 63 M8000 to 8063
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D devices
The D devices are word devices to store data, including the communication error data and clock data of GT SoftGOT2000.
The user can also store data in the user area.

List of D devices
The following shows the D devices which are the virtual devices of GT SoftGOT2000.

Address Description Set side
D0 to 2 Unused ―

D3 Communication error status
The communication error details of GT SoftGOT2000 are stored.

• b4 to 6 turn ON when an SIO error occurs, and turn OFF when an request message from the host is received 
successfully after the error occurrence.

• b7 turns ON about 3 seconds after the host side DTR becomes OFF, and turns OFF when transmission is 
performed successfully to the host after the error occurrence.

System

D4 Clock data (year)

D5 Clock data (month)

D6 Clock data (day)

b15 b0– b3

Unused

–b4

SIO framing error

b5

SIO parity error
SIO overrun error

b6b7

Communication timeout 
error
Unused

b8

0: Normal
1: Error

b15 b0–

Lower 2 digits of calendar 
year stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of months 01 to 
12 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of days 01 to 
31 stored as 2-digit BCD

–b7

Unused

b8
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D7 Clock data (hour) System

D8 Clock data (minute)

D9 Clock data (second)

D10 Clock data (day of the week)

D11, D12 Unused ―

Address Description Set side

b15 b0–

Data of hours 00 to 
23 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of minutes 00 to 
59 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Data of seconds 00 to 
59 stored as 2-digit BCD

–b7

Unused

b8

b15 b0–

Day-of-week data stored as 
2-digit BCD

–b7

Unused

b8

00: Sunday 01: Monday
02: Tuesday 03: Wednesday
04: Thursday 05: Friday
06: Saturday
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*1 After writing data, the interrupt data is output within a period of 1 to 10 ms.
*2 When data are written to D13 and D14 from the host side, interrupt output is not performed.
*3 When 32-bit data are written to D13 and D14, the values are output to the host side regardless of the setting for [32bit Storage] in the 

[Communication Setup] dialog.
Example) When outputting 0x12345678 with unsigned 32-bit binary data

D13 Interrupt output
If you write data to D13 and D14 by using a touch switch or other methods in GT SoftGOT2000, the written data will 
be sent to the host (Interrupt output).*1*2

Set the amount of data (number of bytes) to be sent with [Interrupt Data Byte] in the [Communication Setup] dialog.
Page 83 [Ethernet]
• Output value when [1Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog

• Output value when [2Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog

• Output value when [4Byte] is set for [Interrupt Data Byte] in the [Communication Setup] dialog*3

(1) When [LH Order] is set for [32bit Storage:] in the [Communication Setup] dialog

(2) When [HL Order] is set for [32bit Storage:] in the [Communication Setup] dialog

User

D14

D15 to 19 Unused ―

D20 to 2031 User area User

D2032 to 2034 Unused ―

D2035 1-second binary counter
The counter is incremented every second after GT SoftGOT2000 is started.
(The time elapsed after monitoring is started is stored in seconds.)
Data are stored in binary format.

System

D2036 to 4095 User area User

Address Description Set side

D13

Lower 8 bits

1 byte

D13

Upper 8 bits Lower 8 bits

2 bytes

Upper 8 bits

D14 D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

Upper 8 bits

D13 D14

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

Upper 8 bits

D14 D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

<GT SoftGOT2000> <Host>

· LH Order

· HL Order

Upper 8 bits

D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x56 0x78 0x12 0x34

Upper 8 bits

D13 D14

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

<GT SoftGOT2000> <Host>

Upper 8 bits

D13

Upper 8 bitsLower 8 bits Lower 8 bits

4 bytes

0x12 0x34 0x56 0x78

Interrupt output

Interrupt output

D14

D14
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 • The side where virtual devices are set
System: Set on the system side.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).
 • Interrupt output (D13, D14)
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Differences in address specifications by data format
The address specification of devices varies depending on the data format.*1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

Address Address specification value

Format 1, 2 Format 3, 4 Format 5 Format 6 to 9
D0 0 8000H 0000H D0

8001H

D1 1 8002H 0001H D1

8003H

: : : : : :

D4095 4095 9FFEH 0FFFH D4095

9FFFH

Upper 8 bits

8000H

Lower 8 bits

8001H

Upper 8 bits

8002H

Lower 8 bits

8003H

Upper 8 bits

9FFEH

Lower 8 bits

9FFFH
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R devices
The R devices are word devices into which user data are stored.
All of these devices can be used as a user area.

List of R devices and differences in address specification by data format
The following shows the R devices which are the virtual devices of GT SoftGOT2000.
The address specification values different depending on the data format are also given below.*1

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

Address Address specification value

Format 1, 2 Format 3, 4 Format 5 Format 6 to 9
R0 4096 0000H 1000H R0

0001H

R1 4097 0002H 1001H R1

0003H

: : : : : :

R4095 8191 1FFEH 1FFFH R4095

1FFFH

Upper 8 bits

0000H

Lower 8 bits

0001H

Upper 8 bits

0002H

Lower 8 bits

0003H

Upper 8 bits

1FFEH

Lower 8 bits

1FFFH
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L devices
The L devices are bit devices into which user data are stored.
All of these devices can be used as a user area.

List of L devices and differences in address specification by data format
The following shows the L devices which are the virtual devices of GT SoftGOT2000.
The address specification values different depending on the data format are also given below.*1

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

*2 For reading or writing data in word units, specify the addresses in 16-point units. (Example: L0, L16, L32, and others)

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 3, 4 Format 5 Format 6 to 9

When 
GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
ON

When 
GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
OFF

L7 L6 L5 L4 L3 L2 L1 L0 8192 A000H A001H 2000H Same as address 
column on left*2L15 L14 L13 L12 L11 L10 L9 L8 A001H A000H

L23 L22 L21 L20 L19 L18 L17 L16 8193 A002H A003H 2001H

L31 L30 L29 L28 L27 L26 L25 L24 A003H A002H

: : : : :

L2039 L2038 L2037 L2036 L2035 L2034 L2033 L2032 8319 A0FEH A0FFH 207FH

L2047 L2046 L2045 L2044 L2043 L2042 L2041 L2040 A0FFH A0FEH
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M devices
The M devices are bit devices into which user data are stored.
All of these devices can be used as a user area.

List of M devices and differences in address specification by data format
The following shows the M devices which are the virtual devices of GT SoftGOT2000.
The address specification values different depending on the data format are also given below.*1

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

*2 For reading or writing data in word units, specify the addresses in 16-point units. (Example: M0, M16, M32, and others)

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 3, 4 Format 5 Format 6 to 9

When 
GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
ON

When 
GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
OFF

M7 M6 M5 M4 M3 M2 M1 M0 8320 2000H 2001H 2080H Same as 
address column 
on left*2

M15 M14 M13 M12 M11 M10 M9 M8 2001H 2000H

M23 M22 M21 M20 M19 M18 M17 M16 8321 2002H 2003H 2081H

M31 M30 M29 M28 M27 M26 M25 M24 2003H 2002H

: : : : :

M2039 M2038 M2037 M2036 M2035 M2034 M2033 M2032 8447 20FEH 20FFH 20FFH

M2047 M2046 M2045 M2044 M2043 M2042 M2041 M2040 20FFH 20FEH
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.30  Microcomputer Connection (Ethernet)



3

SD devices
The SD devices are word devices to store data, including the communication error codes and clock data of GT SoftGOT2000.

List of SD devices
The following shows the SD devices which are the virtual devices of GT SoftGOT2000.

*1 For details and corrective actions for the errors (error codes) that are stored into SD2, refer to the following:
Page 498 Details and actions for errors (error codes) stored into SD2

The side where virtual devices are set
System: Set on the system side.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).

Address Description Set side
SD0
SD1

100ms counter (32bits)
The counter is incremented by 100 ms after GT SoftGOT2000 is started.
(The time elapsed after GT SoftGOT2000 is started is stored in increments of 100 ms.)
(1) When [LH Order] is set for [32bit Storage:] in the [Communication Setup] dialog
The lower and upper bits are stored in SD0 and SD1 respectively.

(2) When [HL Order] is set for [32bit Storage:] in the [Communication Setup] dialog
The upper and lower bits are stored in SD0 and SD1 respectively.

System

SD2*1 Communication error status
An error data (error code) occurred during communication is stored.
• Host station (Communication error in the destination GT SoftGOT2000)

0: No error
1: Parity error
2: Framing error
3: Overrun error
4: Communication message error
5: Command error
6: Clock data setting error

SD3 Clock data (second)
Second data of 00 to 59 is stored.

SD4 Clock data (minute)
Minute data of 00 to 59 is stored.

SD5 Clock data (hour)
Hour data of 00 to 23 is stored.

SD6 Clock data (day)
Day data of 00 to 31 is stored.

SD7 Clock data (month)
Month data of 01 to 12 is stored.

SD8 Clock data (year)
The last two digits of four-digit year data are stored.

SD9 Clock data (day of the week)
Day-of-the-week data is stored.
0: Sunday
1: Monday
2: Tuesday
3: Wednesday
4: Thursday
5: Friday
6: Saturday

SD10 to 15 Unused ―

SD0SD1

Lower wordUpper word

SD1SD0

Lower wordUpper word
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Details and actions for errors (error codes) stored into SD2
Error code Description Action
0 No error ―

1 Parity error
The parity bit does not match.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Configure the same transmission settings in GT SoftGOT2000 

and on the host.

2 Framing error
The data bit and/or stop bit are not correct.

3 Overrun error
Before GT SoftGOT2000 finishes processing the received data, GT 
SoftGOT2000 has received new data from the host.

• Check the settings of the [Communication Setup] dialog.
• Decrease the transmission speed.

4 Communication message error
EXT/CR could not be found before the upper limit of the receive 
buffer was exceeded.

• Check the communication cable and communication module 
attachment.

• Check the settings of the [Communication Setup] dialog.
• Review the contents of the message to transmit.

5 Command error
An unsupported command was used.

• Review the contents of the message to transmit.
• Check the commands in the message.

6 Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at 

the day of the week) as clock data.
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Differences in address specifications by data format
The address specification of devices varies depending on the data format.*1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

*2 SD3 to 9 correspond to GD0 to 6 on the GOT-F900 Series.
Access to SD3 to 9 can be also made by the specification of the addresses (3000 to 300DH) of GD0 to 6 on the GOT-F900 Series.

Address Address specification value

Format 1, 2 Format 3, 4*2 Format 5 Format 6 to 9
SD0 8448 2100H 2100H SD0

2101H

SD1 8449 2102H 2101H SD1

2103H

SD2 8450 2104H 2102H SD2

2105H

SD3 8451 2106H 
(3000H)

2103H SD3

2107H 
(3001H)

SD4 8452 2108H 
(3002H)

2104H SD4

2109H 
(3003H)

SD5 8453 210AH 
(3004H)

2105H SD5

210BH 
(3005H)

SD6 8454 210CH 
(3006H)

2106H SD6

210DH 
(3007H)

SD7 8455 210EH 
(3008H)

2107H SD7

210FH 
(3009H)

SD8 8456 2110H 
(300AH)

2108H SD8

2111H 
(300BH)

SD9 8457 2112H 
(300CH)

2109H SD9

2113H 
(300DH)

Upper 8 bits

2100H

Lower 8 bits

2101H

Upper 8 bits

2102H

Lower 8 bits

2103H

Upper 8 bits

2104H

Lower 8 bits

2105H

Upper 8 bits

2106H(3000H)

Lower 8 bits

2107H(3001H)

Upper 8 bits

2108H(3002H)

Lower 8 bits

2109H(3003H)

Upper 8 bits

210AH(3004H)

Lower 8 bits

210BH(3005H)

Upper 8 bits

210CH(3006H)

Lower 8 bits

210DH(3007H)

Upper 8 bits

210EH(3008H)

Lower 8 bits

210FH(3009H)

Upper 8 bits

2110H(300AH)

Lower 8 bits

2111H(300BH)

Upper 8 bits

2112H(300CH)

Lower 8 bits

2113H(300DH)
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SM devices
The SM devices are bit devices into which interrupt outputs and clock data that turn ON or OFF in 1-second cycles are stored.

List of SM devices
The following shows the SM devices which are the virtual devices of GT SoftGOT2000.

*1 After the ON or OFF state is changed, the interrupt data is output within a period of 1 to 10 ms.
*2 When the ON or OFF state of SM0 to 49 is changed from the host side, interrupt output is not performed.

 • The side where virtual devices are set
System: Set on the system side.
User: The user sets values in the virtual devices (in response to the requests from the host or by using a touch 
switch or other methods in GT SoftGOT2000).
 • Interrupt outputs (SM0 to 49)
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Address Description Set side
SM0 to 49 Interrupt output

If you change the ON or OFF status of any device in the range from SM0 to SM49 by using a touch switch or other 
methods in GT SoftGOT2000, an interrupt code will be sent to the host as shown below (Interrupt output).*1*2

Set the amount of data (number of bytes) to be sent with [Interrupt Data Byte] in the [Communication Setup] dialog.
Page 83 [Ethernet]

User

SM50 1-second cycle clock
Turns ON and OFF in 1-second cycles.

System

SM51 2-second cycle clock
Turns ON and OFF in 2-second cycles.

SM52 Interrupt code output disable flag
Enables or disables the output of the interrupt code and special interrupt code.
OFF: Output enabled, ON: Output disabled
When the output is set to be disabled, no interrupt data are output to the host.
(Relevant devices: D13, D14, SM0 to 49)

User

SM53 to 63 Unused ―

Address Event type

SM0
Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Changed from OFF to ON

Changed from ON to OFF

Interrupt code

SM1

SM2

50H

51H

52H

53H

54H

55H

SM48
B0H

B1H

SM49
B2H

B3H

: : :

0.5 0.5

1 1
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Differences in address specifications by data format
The address specification of devices varies depending on the data format.*1

The following shows the address specification values for each data format.

*1 For the address specification method for each data format, refer to the following.
Page 502 Data format type and application
Formats 1, 2: GOT-A900 Series microcomputer connection
Formats 3, 4: GOT-F900 Series microcomputer connection
Format 5: SCHNEIDER EJH's memory link method
Formats 6. 7: 4E frame
Formats 8, 9: QnA compatible 3E frame

*2 In formats 6 to 9, values are specified within a range of SM0 to 52.
*3 For reading or writing data in word units, specify the addresses in 16-point units. (Example: SM0, SM16, SM32, and others)

Address Address specification value

b7 b6 b5 b4 b3 b2 b1 b0 Format 
1, 2

Format 3, 4 Format 5 Format 
6 to 9When 

GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
ON

When 
GS580.b8, 
GS581.b8, 
GS582.b8, or 
GS583.b8 is 
OFF

SM7 SM6 SM5 SM4 SM3 SM2 SM1 SM0 8464 2200H 2201H 2110H *2*3

SM15 SM14 SM13 SM12 SM11 SM10 SM9 SM8 2201H 2200H

SM23 SM22 SM21 SM20 SM19 SM18 SM17 SM16 8465 2202H 2203H 2111H

SM31 SM30 SM29 SM28 SM27 SM26 SM25 SM24 2203H 2202H

SM39 SM38 SM37 SM36 SM35 SM34 SM33 SM32 8466 2204H 2205H 2112H

SM47 SM46 SM45 SM44 SM43 SM42 SM41 SM40 2205H 2204H

Unused SM52 SM51 SM50 SM49 SM48 8467 2206H 2207H 2113H

Unused ― ― ―
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Data format type and application
Communication is possible using any of the data formats shown below.

Formats 1, 2 (GOT-A900 Series microcomputer connection)
This is the same message format as when a microcomputer connection is established with the GOT-A900 series.

Formats 3, 4 (GOT-F900 series microcomputer connection)
This is the compatible message format with when a microcomputer connection is established with the GOT-F900 Series.

Format 5 (SCHNEIDER EJH's memory link method)
This is the message format compatible with the protocol of the SCHNEIDER EJH's memory link method.

Formats 6, 7 (4E frame)
This is the compatible message format with when a communication is performed using the MC protocol of Q/QnA Series 
serial communication module.

Formats 8, 9 (QnA compatible 3E frame)
This is the compatible message format with when a communication is performed using the MC protocol of Q/QnA Series 
serial communication module.

Type Name Description Refer to
Format 1 GOT-A900 series microcomputer 

connection (ASCII)
This format is used when one host and one GT 
SoftGOT2000 module are connected.
The data format is ASCII.

Page 503 Formats 1, 2 (GOT-A900 
Series microcomputer connection)

Format 2 GOT-A900 series microcomputer 
connection (Binary)

This format is used when one host and one GT 
SoftGOT2000 module are connected.
The data format is Binary.

Type Name Description Refer to
Format 3 GOT-F900 series microcomputer 

connection (ASCII)
This format is used to establish a 1:1 or m:n connection 
between the host and GT SoftGOT2000.
The data format is ASCII.

Page 516 Formats 3, 4 (GOT-F900 
Series microcomputer connection)

Format 4 GOT-F900 series microcomputer 
connection (Binary)

This format is used to establish a 1:1 or m:n connection 
between the host and GT SoftGOT2000.
The data format is Binary.

Type Name Description Refer to
Format 5 SCHNEIDER EJH's memory link 

method
This is the basic format of the SCHNEIDER EJH's memory 
link method.

Page 530 Format 5 (SCHNEIDER 
EJH's (formerly Digital Electronics 
Corporation's) memory link method)

Type Name Description Refer to
Format 6 4E frame (ASCII) This is the basic format of the MC protocols.

The data format is ASCII.
Page 534 Formats 6, 7 (4E frame)

Format 7 4E frame (Binary) This is the basic format of the MC protocols.
The data format is Binary.

Type Name Description Refer to
Format 8 QnA compatible 3E frame (ASCII) This is the basic format of the MC protocols.

The data format is ASCII.
Page 546 Formats 8, 9 (QnA compatible 
3E frame)

Format 9 QnA compatible 3E frame (Binary) This is the basic format of the MC protocols.
The data format is Binary.
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How to set data format
Set the data format in the [Communication Setup] dialog.
For details of the data format setting method, refer to the following.
Page 83 [Ethernet]

Formats 1, 2 (GOT-A900 Series microcomputer connection)
The following describes the message formats 1 and 2 (GOT-A900 Series microcomputer connection).

Basic format of data communication

*1 Set the number of interrupt data bytes in the [Communication Setup] dialog.
For setting the number of interrupt data bytes, refer to the following.
Page 83 [Ethernet]

*2 Interrupt output can be executed by writing the data to the interrupt output devices (D13 and D14).
Page 490 D devices

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(1) During processing of read commands

(2) During processing of write commands

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

During interrupt 
output *2

(H) (L)

Command Data

Data

06H

ACK

15H

NAK Error
Code

Output value

1/2/4
bytes*1
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Details of data items in message format

Data code during communication
Communication of the format 1 is performed in ASCII code. (excluding interrupt output)
Communication of the format 2 is performed in Binary code.

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 2-byte ASCII code, and transmitted from the higher-order byte.
For details of the commands that can be used, refer to the following.
Page 505 List of commands for format 1 (GOT-A900 series microcomputer connection (ASCII))
Page 505 List of commands for format 2 (GOT-A900 series microcomputer connection (Binary))

■Address
Specifies the head No. of the device data to be read or written.
The data notated in decimal in format 1 is converted to a 4-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 2 is converted to a 2-byte binary code and transmitted from the higher-order byte.
For the range of accessible devices, refer to the following.
Page 489 Device data area

■Number of points
Specifies the device data points to be read or written. (Setting range: Range of the maximum number of points processed for 
each command)
The data notated in decimal in format 1 is converted to a 2-byte ASCII code and transmitted from the higher-order
byte.
The data notated in decimal in format 2 is converted to a 1-byte binary code and transmitted.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The data notated in decimal in format 1 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 2 is converted to a 1-byte binary code and transmitted.
Page 512 Read clock data (TR) command
Page 513 Set clock data (TS) command

■Data
Specifies the data to read from or write to the specified device data. (word unit)
The data notated in hexadecimal in format 1 is converted to a 4-byte ASCII code and transmitted from the higher-order byte.
The data notated in hexadecimal in format 2 is converted to a 2-byte binary code and transmitted from the higher-order byte.

■Error code
This is the response message at faulty communication appended with error contents. Error code is transmitted in 1 byte.
For the error codes, refer to the following.
Page 515 Error code list
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List of commands for format 1 (GOT-A900 series microcomputer connection (ASCII))

*1 Mixed specification of bit devices and word devices is also possible.

List of commands for format 2 (GOT-A900 series microcomputer connection (Binary))

*1 Mixed specification of bit devices and word devices is also possible.

Command Command name Description Max. number of points 
processedSymbol ASCII code

RD 52H 44H Batch read in word units Reads bit devices in 16-point units. 99 words (1584 points)

Reads word devices in 1-point units. 99 points

WD 57H 44H Batch write in word units Writes to bit devices in 16-point units. 99 words (1584 points)

Writes to word devices in 1-point units. 99 points

RR 52H 52H Random read in word units *1 Reads multiple different bit devices in 16-point units. 256 words (4096 points)

Reads multiple different word devices in 1-point units. 256 points

RW 52H 57H Random write in word units *1 Writes to multiple different word devices in 16-point 
units.

128 words (2048 points)

Writes to multiple different word devices in 1-point 
units.

128 points

TR 54H 52H Read clock data Reads the clock data of the personal computer. ―

TS 54H 53H Set clock data Sets the clock data of the personal computer. ―

Command Command name Description Max. number of points processed
RD Batch read in word units Reads bit devices in 16-point units. 255 words (4080 points)

Reads word devices in 1-point units. 255 points

WD Batch write in word units Writes to bit devices in 16-point units. 255 words (4080 points)

Writes to word devices in 1-point units. 255 points

RR Random read in word units *1 Reads multiple different bit devices in 16-point units. 512 words (8192 points)

Reads multiple different word devices in 1-point 
units.

512 points

RW Random write in word units *1 Writes to multiple different word devices in 16-point 
units.

256 words (4096 points)

Writes to multiple different word devices in 1-point 
units.

256 points

TR Read clock data Reads the clock data of the personal computer. ―

TS Set clock data Sets the clock data of the personal computer. ―
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Message Formats
■Batch read in word units (RD) command
 • When reading a word device
The following shows an example of reading the two points of the virtual devices D100 and D101.
(Assuming D100=0102H, D101=0304H are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

D100

D101

0102H

0304H

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

0 1
30H 31H

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

Command

R D

Address

00H 64H

Number
of points

02H

(H) (L)

0 1
30H 31H

0
30H

2
32H

(H) (L)

0 3
30H 33H

0
30H

4
34H

Data 1 (D100) Data 2 (D101)

01H 02H 03H 04H

Data 1
(D100)

Data 2
(D101)

The above is a case 
where the sum check error 
(06H) has occurred.

15H

NAK

06H

Error 
code
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.30  Microcomputer Connection (Ethernet)



3

 • When reading a bit device
The following shows an example of reading the two points of the virtual devices M0 to M31.
(Assuming M0="1" and M31="1" are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

M15 to 0

M31 to 6

0001H

8000H

(H) (L)

Command

R D
52H 44H

(H) (L)

Address

8 3
38H 33H

2
32H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

Command

R D

Address

83H 20H

Number
of points

02H

(H) (L)

Data 1 (M15 to 0)

0
30H

0
30H

1
31H

0
30H

(H) (L)

8
38H

0
30H

0
30H

0
30H

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

Data 2 (M31 to 16)

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

00H 01H 80H 00H

Data 1
(M15 to 0)

Data 2
(M31 to 16)

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Batch write in word units (WD) command
 • When writing to a word device
The following shows as example of writing "0064H"and "0065H"to virtual devices D100 and D101.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

D100

D101

0000H

0000H

D100

D101

0064H

0065H

Before execution After execution

(H) (L)

Command

W D
57H 44H

(H) (L)

Address

0 1
30H 31H

0
30H

0
30H

(H) (L)

Number of 
points

0 2
30H 32H

(H) (L)

Data 1(D100)

0 0
30H 30H

6
36H

4
34H

(H) (L)

Data 2 (D101)

0 0
30H 30H

6
36H

5
35H

Command

W D

Address

00H 64H

Number
of points

02H

Data1
(D100)

00H 64H

Data 2
(D101)

00H 65H

06H

ACK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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 • When writing to a bit device
The following shows an example of writing "1"s to virtual devices M0 and M31.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

M15 to 0 0000H

0000H

0001H

8000H

Before execution After execution

M31 to 16

M15 to 0

M31 to 16

(H) (L)

Data 1 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

(H) (L)

Data 2 (M31 to 16)

8
38H

––

0
30H

0
30H

0
30H

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

(H) (L)

W D
57H 44H

Command

(H) (L)

Address

8
38H

––

0
30H

2
32H

3
33H

(H) (L)

0 2
30H 32H

Number 
of points

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000 00000001 00000000

Command

W D

Address

20H 80H

Number
of points

02H

Data 1
(M15 to 0)

00H 01H

Data 2
(M31 to 16)

80H 00H

06H

ACK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Random read in word units (RR) command
The following shows an example of reading the two points of the virtual devices D100 and M0 to M15.
(Assuming D100=0064H, M0=1are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

D100 0064H

0001HM15 to 0

(H) (L)

Command

R R
52H 52H

(H) (L)

Address 1

0 1
30H 31H

––

0
30H

0
30H

(H) (L)

Address 2

8 3
38H 33H

––

2
32H

0
30H

Command

R R

Address 1

00H 64H

Address 2

20H 80H

(H) (L)

Data 1 (D100)

0
30H

––

6
36H

4
34H

0
30H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

(H) (L)

Data 2 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

Data 1
(D100)

00H 64H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

Data 2
(M15 to 0)

00H 01H

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Random write in word units (RW) command
The following shows an example of writing "0064H" and "1" to virtual devices D100 and M0, respectively.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

M15 to 0

0000H

Before execution After execution

D100

0000H M15 to 0

0064HD100

0001H

(H) (L)

Address 2

8
38H

––

2
32H

0
30H

3
33H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

(H) (L)

Data 2 (M15 to 0)

0
30H

––

0
30H

1
31H

0
30H

(H) (L)

R W
52H 57H

Command

(H) (L)

Address 1

0
30H

––

1
31H

0
30H

0
30H

(H) (L)

Data 1 (D100)

0
30H

––

6
36H

4
34H

0
30H

Address 2

20H 80H

00000000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

10000000

Data 2
(M15 to 0)

00H 01HR W

Command Address 1

00H 64H

Data 1
(D100)

00H 00H

06H

ACK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Read clock data (TR) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

Time display

2009/10/01 18:46:49 THU

(H) (L)

Command

T R
54H 52H

(H) (L)

Year data

0 9
30H 39H

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

Year
data

09H

Month
data

0AH

Day
data

01H

Hour
data

12H

Minute
data

2EH

Second 
data

31H

Day-of-
week data

04H

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■Set clock data (TS) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Thursday, October 1, 2009.)

When a wrong day of the week has been set by the clock data setting command
If a wrong day of the week is set by the clock data setting commands, the corrected day of the week will be 
set.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday (TUE) will be set.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 1: GOT-A900 Series microcomputer connection (ASCII))

(format 2: GOT-A900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

Time display

2009/10/01 18:46:49 THU

After execution

(H) (L)

Year data

0 9
30H 39H

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

(H) (L)

Command

T S
54H 53H

Command

T S

Year
data

09H

Month
data

0AH

Day
data

01H

Hour
data

12H

Minute
data

2EH

Second 
data

31H

Day-of-
week data

04H

06H

ACK

The above is a case where 
the sum check error (06H) 
has occurred.

15H

NAK

06H

Error 
code
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■In the case of interrupt outputs
Write data to the interrupt output devices (D13 and D14) to output the data to the host.
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)
Interrupt output is available only when [TCP/IP] is set for [Protocol] in the [Communication Setup] dialog.

Interrupt output
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Item Message format
Interrupt output
(GT SoftGOT2000 
→ Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt output

Example) When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [2Byte] as (2) in the following table

31H

Output 
value 1

39H

Output 
value 2

Interrupt

3139HD13

39H

Output 
value 1

31H 39H

Output 
value 1

Output 
value 2

AAH

Output 
value1

55H

Output 
value2

31H

Output 
value3

39H

Output 
value4

31H

Output 
value1

39H

Output 
value2

AAH

Output 
value3

55H

Output 
value4
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Error code list
The error contents (error code) are appended to the response message during faulty communication.
The following shows error code, error contents, cause, and measures.

Precautions
■Storage order for 32-bit data
When 32-bit data is set to maintain program compatibility with GOT-A900 series, set [32bit Storage:] to [HL Order] in the 
[Communication Setup] dialog.
When [LH Order] is set, the higher-order bits and lower-order bits of 32-bit data are displayed or written in reverse order in GT 
SoftGOT2000.

Error code Description Action
10H Command error

An unsupported command was used.
• Review the contents of the message to transmit.
• Check the commands in the message.
Page 505 List of commands for format 1 (GOT-A900 series 
microcomputer connection (ASCII))
Page 505 List of commands for format 2 (GOT-A900 series 
microcomputer connection (Binary))

11H Message length error
The data length is greater than the maximum data length for GT 
SoftGOT2000.

• Review the contents of the message to transmit.
• Check the data length of the message. (data length of the data 

section, etc.)

15H Clock data setting error
The setting value of the clock data has error.

• Review the contents of the message to transmit.
• Check whether the non-existent data is set (e.g. setting "07" at the 

day of the week) as clock data.

7AH Address error
The start address of the read or write device is out of range.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 489 Device data area7BH Exceeded number of points error

The read or write range has exceeded the device range.
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Formats 3, 4 (GOT-F900 Series microcomputer connection)
The following describes the message formats 3 and 4 (GOT-F900 Series microcomputer connection).

Basic format of data communication

*1 Set the number of interrupt data bytes in the [Communication Setup] dialog.
For setting the number of interrupt data bytes, refer to the following.
Page 83 [Ethernet]

*2 Interrupt output can be executed by writing the data to the interrupt output devices (D13 and D14).
Page 490 D devices

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(1) w/out station No.

(2) w/station No.

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(1) During processing of read commands

(2) During processing of write commands

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

During interrupt 
output *2

DataCom-
mand

Data

(H) (L)

Station No.Com-
mand

Data

06H

ACK

15H

NAK

Output 
value 

1/2/4 
bytes*1
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Details of data items in message format

Data code during communication
Communication of the format 3 is performed in ASCII code. (excluding interrupt output)
Communication of the format 4 is performed in Binary code.

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 1-byte ASCII code and transmitted.
For details of the commands that can be used, refer to the following.
Page 519 List of commands for formats 3, 4 (GOT-F900 series microcomputer connection)

■Station No.
This item is used by the host to identify the destination GT SoftGOT2000. (Setting range: 0 to 31)
The data notated in decimal in format 3 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 4 is converted to a 1-byte binary code and transmitted.
GT SoftGOT2000 processes the messages that include the station number matching with the set value of [PC No. (1 to 64)] in 
the [Communication Setup] dialog. (GT SoftGOT2000 ignores the messages that do not include the matched station number.)
For the settings in the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

■Address
Specifies the head No. of the device data to be read or written.
The data notated in hexadecimal in format 3 is converted to a 4-byte ASCII code and transmitted from the higher-order byte.
The data notated in hexadecimal in format 4 is converted to a 2-byte binary code and transmitted from the higher-order byte.
For the range of accessible devices, refer to the following.
Page 489 Device data area

■Bit pattern
Specifies the pattern of the bits to change.
The data notated in hexadecimal in format 3 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in hexadecimal in format 4 is converted to a 1-byte binary code and transmitted.
Page 524 Multi-point write in bit units (3) command (without station No.), multi-point write in bit units (D) command (with 
station No.)

■Write specification
Specifies how to change the data of the specified address by bit pattern.
(Setting range: 0 to 3)
The data notated in decimal is converted to a 1-byte ASCII code and transmitted.
Page 524 Multi-point write in bit units (3) command (without station No.), multi-point write in bit units (D) command (with 
station No.)
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■Number of bytes
Specifies the number of bytes of the device data to be batch read or written. (Setting range: 0 to FFH)
The data notated in hexadecimal in format 3 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in hexadecimal in format 4 is converted to a 1-byte binary code and transmitted.

■Number of points
Specifies the device data points to be written to multi-point in bit units. (Setting range: Range of the maximum number of 
points processed for each command)
The data notated in decimal in format 3 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 4 is converted to a 1-byte binary code and transmitted.

■Year, month, day, hour, minute, second and day of the week data
Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal 
computer.
The data notated in decimal in format 3 is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 4 is converted to a 1-byte binary code and transmitted.
Page 527 Read clock data (6) command (without station No.), read clock data (G) command (with station No.)
Page 528 Set clock data (5) command (without station No.), set clock data (F) command (with station No.)

■Data
Specifies the data to read from or write to the specified device data. (word unit)
The data notated in hexadecimal in format 3 is converted to a 4-byte ASCII code and transmitted from the higher-order byte.
The data notated in hexadecimal in format 4 is converted to a 2-byte binary code and transmitted from the higher-order byte.

■Write data
Specifies the data to write to the specified device data.
The data notated n format 3 in decimal is converted to a 2-byte ASCII code and transmitted from the higher-order byte.
The data notated in decimal in format 4 is converted to a 1-byte binary code and transmitted.
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List of commands for formats 3, 4 (GOT-F900 series microcomputer connection)
Command Command name Description Max. number of points processed

Symbol ASCII code
0 30H Batch read

(without station No.)
Reads bit devices in byte units. 255 bytes (2040 points)

Reads word devices in byte units. 255 bytes (127 points)

A 41H Batch read
(with station No.)

Reads bit devices in byte units. 255 bytes (2040 points)

Reads word devices in byte units. 255 bytes (127 points)

1 31H Batch write
(without station No.)

Writes to bit devices in byte units. 255 bytes (2040 points)

Writes to word devices in byte units. 255 bytes (127 points)

B 42H Batch write
(with station No.)

Writes to bit devices in byte units. 255 bytes (2040 points)

Writes to word devices in byte units. 255 bytes (127 points)

3 33H Multi-point write in bit units 
(without station No.)

Writes bit patterns (bit ON or OFF, 
inversion, direct specification) in 1-point 
units (8 bits for 1 point) to a specified 
device.

99 points

D 44H Multi-point write in bit units (with 
station No.)

4 34H Fill command
(without station No.)

Writes the same value to a range of 
specified devices.

―

E 45H Fill command
(with station No.)

5 35H Set clock data
(without station No.)

Sets the clock data of the personal 
computer.

―

F 46H Set clock data
(with station No.)

6 36H Read clock data
(without station No.)

Reads the clock data of the personal 
computer.

―

G 47H Read clock data
(with station No.)
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Message format
■Batch read (0) command (without station No.), batch read (A) command (with station No.)
 • When reading a word device
The following shows an example of reading 4-byte data from virtual devices R100 and R101 for GT SoftGOT2000 (station No. 
15).
(Assuming R100=3D21H, R101=3604H are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

R100

R101

3D21H

3604H

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

––

0
30H

8
38H

(H) (L)

Number 
of bytes

0 4
30H 34H

A
41H

C
43H

Com-
mand

Station
No.

0FH

Address

C8H

Number 
of bytes

04HA 00H

Com-
mand

(H)

Data 1
(R100 upper)

3
33H

(L)

D
44H

(H)

Data 2
(R100 lower)

2
32H

(L)

1
31H

(H)

Data 3
(R101 upper)

3
33H

(L)

6
36H

(H)

Data 4
(R101 lower)

0
30H

(L)

4
34H

Data 1
(R100 upper)

3DH

Data 2
(R100 lower)

21H

Data 3
(R101 upper)

36H

Data 4
(R101 lower)

04H

15H

NAK
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 • When reading a bit device (GS580.b8, GS581.b8, GS582.b8, and GS583.b8 are on)
The following shows an example of reading four bytes of the virtual devices M0 to M31.
(Assuming M0="1" and M31="1" are stored.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

M15 to 0

M31 to 16

0001H

8000H

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

2
32H

––

0
30H

(H) (L)

Number of 
bytes

0 4
30H 34H

A
41H

0
30H

0
30H

Com-
mand

Station
No.

0FH

Address Number
of bytes

04HA 20H 00H

Com-
mand

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

(H) (L)

Data 1
(M7 to 0)

0
30H

1
31H

(H) (L)

Data 2
(M15 to 8)

0
30H

0
30H

(H) (L)

Data 3
(M23 to 16)

0
30H

0
30H

(H) (L)

Data 4
(M31 to 24)

8
38H

0
30H

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1
3

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

Data 1
(M7 to 0)

01H

Data 2
(M15 to 8)

00H

Data 3
(M23 to 16)

00H

Data 4
(M31 to 24)

80H

15H

NAK
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■Batch write (1) command (without station No.), batch write (B) command (with station No.)
 • When writing to a word device
The following shows an example of writing 3D21H and 3604H to virtual devices R100 and R101 for GT SoftGOT2000 (station 
No. 15).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

R100

R101

0000H

0000H

R100

R101

0064H

0065H

Before execution After execution

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

0
30H

––

0
30H

8
38H

(H) (L)

Number 
of bytes

0 4
30H 34H

B
42H

C
43H

Following*1

Com-
mand

(H) (L)

Data 1
(R100 upper)

3 D
33H 44H

(H) (L)

Data 2
(R100 lower)

2 1
32H 31H

(H) (L)

Data 3
(R101 upper)

3 6
33H 36H

(H) (L)

Data 4
(R101 lower)

0 4
30H 34H

*1

Station
No.

0FH

Address

C8H

Number 
of bytes

04HB 00H

Following*2

Com-
mand

Data 1
(R100 upper)

3DH 21H

Data 2
(R100 lower)

Data 3
(R101 upper)

36H 04H

Data 4
(R101 lower)

*2

06H

ACK

15H

NAK
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 • When writing to a bit device (GS580.b8, GS581.b8, GS582.b8, and GS583.b8 are on)
The following shows an example of writing 1 to virtual devices M0 and M31 for GT SoftGOT2000 (station No. 15).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

M15 to 0 0000H

0000H

Before execution After execution

M31 to 16

M15 to 0 0001H

8000HM31 to 16

(H) (L)

Station No.

1 5
31H 35H

(H) (L)

Address

2
32H

––

0
30H

0
30H

(H) (L)

Number 
of bytes

0 4
30H 34H

B
42H

0
30H

Following*1

Com-
mand

(H) (L)

Data 1
(M7 to 0)

0 1
30H 31H

(H) (L)

Data 2
(M15 to 8)

0 0
30H 30H

(H) (L)

Data 3
(M23 to 16)

0 0
30H 30H

(H) (L)

Data 4
(M31 to 24)

8 0
38H 30H

*1

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

3

Station
No.

0FH

Address

00H

Number 
of bytes

04HB 20H

Following*2

Com-
mand

Data 1
(M7 to 0)

01H 00H

Data 2
(M15 to 8)

Data 3
(M23 to 16)

00H 80H

Data 4
(M31 to 24)

*2

M
1
6

M
1
7

M
1
8

M
1
9

M
2
0

M
2
1

M
2
2

M
2
3

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

00000000
M
8

M
9

M
1
0

M
1
2

M
1

M
1
4

M
1
5

M
1
1

00000
M
0

M
1

M
2

M
3

M
4

M
5

M
6

M
7

10000000 00100000000

3

06H

ACK

15H
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■Multi-point write in bit units (3) command (without station No.), multi-point write in bit units (D) 
command (with station No.)

The following shows an example of turning off virtual device M31 and turning on M2038 for GT SoftGOT2000 (station No. 31).

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

(H) (L)

Station No.

3
33H

1
31H

D
44H

Following *2

(H) (L)

Number of 
points

0
30H

2
32H

Com-
mand

(H) (L)

Address1 Address2

2
32H

––

0
30H

(H) (L)

Bit pattern1

8
38H

0
30H

*2
Write 
specification
1

1
31H

0
30H

3
33H

(H) (L)

2
32H

––

0
30H

(H) (L)

Bit pattern2

4
34H

0
30H

Write 
specification
2

0
30H

F
46

E
45H

*1 *1

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

01010101Source data 
bit pattern 00000001

01010100Result

(write specification1=1)

M
2
0
3
2

M
2
0
3
3

M
2
0
3
4

M
2
0
3
5

M
2
0
3
6

M
2
0
3
7

M
2
0
3
8

M
2
0
3
9

01010101Source data 
bit pattern 00000010

01010111Result

(write specification2=0)

Station
No.

1FH 02HD
Following *3

Number
of points

Com-
mand

Address1 Address2

20H 03H

Bit
pattern1

80H

*3
Write 
specification
1

1 20H FEH

Bit
pattern2

40H

Write 
specification
2

0

*1 *1

M
2
4

M
2
5

M
2
6

M
2
7

M
2
8

M
2
9

M
3
0

M
3
1

01010101Source data 
bit pattern 00000001

01010100Result

(write
specification1=1)

M
2
0
3
2

M
2
0
3
3

M
2
0
3
4

M
2
0
3
5

M
2
0
3
6

M
2
0
3
7

M
2
0
3
8

M
2
0
3
9

01010101Source data 
bit pattern 00000010

01010111Result

(write
specification2=0)

06H

ACK

15H

NAK
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*1 The write specification specifies how the data of the specified address is changed in the bit pattern.

Write specification Function Description Action example
0 ON specification Bits set to "1" by the bit pattern are turned ON. Original data1010

Bit pattern1100

Result1110

1 OFF specification Bits set to "1" by the bit pattern are turned OFF. Original data1010
Bit pattern1100

Result0010

2 Invert specification Bits set to "1" by the bit pattern are inverted. Original data1010
Bit pattern1100

Result0110

3 Write specification The numerical values to write by the bit pattern are specified directly. Original data1010
Bit pattern1100

Result1100
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■Fill command (4) (without station No.), fill command (E) (with station No.)
The following shows an example of writing 16 to virtual devices R50 to R100 for GT SoftGOT2000 (station No. 27).

 • Start address/end address specification conditions
Specify addresses so that the start address is the same or less than the end address.
Error response occurs in the following cases:
The address to specify has the start address greater than the end address.
Either of the start address or end address exceeds the device range that can be specified.
 • Address specifying crossing over different devices
The start address and end address can be specified crossing over different devices.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

R100

0000H

Before execution After execution

R50

0000H

0000H

R100

1616HR50

1616H

1616H

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Write
Data

1 6
31H 36H

E
45H

(H) (L)

Start address

0
30H

––

0
30H

4
34H

6
36H

(H) (L)

End address

0
30H

––

0
30H

9
39H

C
43H

Com-
mand

Station
No.

1BH

Write
Data

16HE

Start
address

64H00H

End
address

C9H00H

Com-
mand

06H

ACK

15H

NAK
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■Read clock data (6) command (without station No.), read clock data (G) command (with station 
No.)

The following shows an example of reading the clock data of the personal computer from GT SoftGOT2000 (station No. 27).
(The clock is set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

Time display

2009/10/01 18:46:49 THU

(H) (L)

Station No.

2 7
32H 37H

G
47H

Com-
mand

Station
No.

1BHG

Com-
mand

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

(H) (L)

Year data

0 9
30H 39H

Month
data

0AH

Day
data

01H

Hour
data

12H

Minute
data

2EH

Second
data

31H

Day-of-
week data

04H

Year
data

09H

15H

NAK
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■Set clock data (5) command (without station No.), set clock data (F) command (with station 
No.)

The following shows an example of setting the clock data of the personal computer for GT SoftGOT2000 (station No. 27).
(The clock will be set to 18:46:49 on Thursday, October 1, 2009.)

When a wrong day of the week has been set by the clock data setting command
If a wrong day of the week is set by the clock data setting commands, the corrected day of the week will be 
set.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday (TUE) will be set.

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 3: GOT-F900 Series microcomputer connection (ASCII))

(format 4: GOT-F900 Series microcomputer connection (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

Time display

2009/10/01 18:46:49 THU

After execution

46H

F

(H) (L)

Station No.

2 7
32H 37H

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day Data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second 
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

(H) (L)

Year data

0 9
30H 39H

Com-
mand

F

Station
No.

1BH

Month
data

0AH

Day
data

01H

Hour
data

12H

Minute
data

2EH

Second 
data

31H

Day-of-
week data

04H

Year
data

09H

Com-
mand

06H

ACK

15H

NAK
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■In the case of interrupt outputs
Write data to the interrupt output devices (D13 and D14) to output the data to the host.
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)
Interrupt output is available only when [TCP/IP] is set for [Protocol] in the [Communication Setup] dialog.

Interrupt output
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Error code list
When faulty, the error code is stored in SD2.
For details on error code stored in SD2, the error contents, cause and measures, refer to the following.
Page 498 Details and actions for errors (error codes) stored into SD2
When an error other than those to be stored in SD2 occurs, at faulty, only the NAK response is executed.

Item Message format
Interrupt output
(GT SoftGOT2000 
→ Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt output

Example) When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [2Byte] as (2) in the following table

31H

Output 
value 1

39H

Output 
value 2

Interrupt

3139HD13

39H

Output 
value 1

31H

Output 
value 1

39H

Output 
value 2

AAH

Output 
value 1

55H

Output 
value 2

31H

Output 
value 3

39H

Output 
value 4

31H

Output 
value 1

39H

Output 
value 2

AAH

Output 
value 3

55H

Output 
value 4
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.30  Microcomputer Connection (Ethernet) 529



53
Format 5 (SCHNEIDER EJH's (formerly Digital Electronics 
Corporation's) memory link method)
The following describes the message format 5 (SCHNEIDER EJH's (former Digital Electronics Corporation) memory link 
method).

Basic format of data communication
This is the same format as the protocol of the SCHNEIDER EJH's memory link method.
For details of the basic format of data communication, refer to the following manual:
The connection manual of the device manufactured by SCHNEIDER EJH
This section explains the settings that differ from the protocol settings of the SCHNEIDER EJH's memory link method, and the 
commands dedicated to the microcomputer connection.
Example: Request message for the batch read in word units (R) command in format 5 (SCHNEIDER EJH's memory link 
method)

Details of data items in message format

Data code during communication
Communication is performed in Binary code.

■Command
Specify the contents to be accessed from the host to GT SoftGOT2000.
The command is converted to a 1-byte ASCII code and transmitted.
For details of the commands that can be used, refer to the following.
Page 531 List of commands for format 5 (SCHNEIDER EJH's memory link method)

■Address
Specifies the head No. of the device data to be read or written.
The address notated in hexadecimal is converted to a 2-byte binary code and transmitted from the higher-order byte.
For the range of accessible devices, refer to the following.
Page 489 Device data area

■Number of points
Specifies the device data points to be read or written. (Setting range: Range of the maximum number of points processed for 
each command)
The number of points notated in hexadecimal is converted to a 2-byte binary code and transmitted from the higher-order byte.

■Error code
This is the response message at faulty communication appended with error contents.
The error code notated in hexadecimal is converted to a 1-byte binary code and transmitted.
For details on error code generated in format 5 (SCHNEIDER EJH's memory link method), refer to the following.
Page 533 Error code list

Connecting microcomputers or other devices that use the protocol of the SCHNEIDER EJH's memory link 
method
If you connect microcomputers or other devices that use the protocol of the SCHNEIDER EJH's memory link 
method, change the commands and the devices according to the specifications of GT SoftGOT2000.

Data length

00H 06H

Address

64H00H

Number
of points

00H 02H1BH

ESC

52H

R

Com-
mand

00H 00H 00H 00H42H 00H

B
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List of commands for format 5 (SCHNEIDER EJH's memory link method)

Message Formats
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Batch read in word units (R) command
The following shows an example of reading the two points of the virtual devices D100 and D101.
(Assuming D100=0102H, D101=0304H are stored.)

■Batch write in word units (WD) command
 • When writing to a word device
The following shows as example of writing "0064H"and "0065H"to virtual devices D100 and D101.

Command Command name Description Max. number of points processed

Symbol ASCII code
R 52H Batch read in word units Reads bit devices in 16-point units. 512 words (8192 points)

Reads word devices in 1-point units. 512 points

W 57H Batch write in word units Writes to bit devices in 16-point units. 512 words (8192 points)

Writes to word devices in 1-point units. 512 points

I 49H Interrupt inquiry Issues an interrupt inquiry. ―

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

D100

D101

0102H

0304H

Data length

00H 06H

Address

64H00H

Number
of points

00H 02H1BH

ESC

52H

R

Com-
mand

00H 00H 00H 00H42H 00H

B

Data length

00H 06H

Address

02H01H

Number
of points

03H 04H1BH

ESC

41H

A

Com-
mand

00H 00H 00H 00H42H 00H

b

D100

D101

0000H

0000H

D100

D101

0064H

0065H

Before execution After execution

Data length

00H 0AH

Address

64H00H

Number
of points

00H 02H1BH

ESC

57H

W

Com-
mand

00H 00H 00H 00H42H 00H

B

Data 1

64H00H

Data 2

00H 65H

Data length

00H 06H 06H

ACK

00H 00H 00H 00H42H 00H

b
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■In the case of interrupt outputs
Write data to the interrupt output devices (D13 and D14) to output the data to the host.
(Assuming that "31H" is written to D13.)
Interrupt output is available only when [TCP/IP] is set for [Protocol] in the [Communication Setup] dialog.

Interrupt output
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Item Message format
Interrupt output
(GT SoftGOT2000 
→ Host)

When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [1Byte]

Example: When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [1Byte]

31H

Output 
value 1

Interrupt

3139HD13

Interrupt output

31H

Output 
value 1
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Error code list
In the case of format 5 (SCHNEIDER EJH's memory link method), the details (error code) of the error are appended to the 
response message during faulty communication.
The following shows error code, error contents, cause, and measures.

Precautions
■Storage order for 32-bit data
When 32-bit data is set to maintain program compatibility with the SCHNEIDER EJH's memory link method, set [32bit 
Storage:] to [HL Order] in the [Communication Setup] dialog.
When [LH Order] is set, the higher-order bits and lower-order bits of 32-bit data are displayed or written in reverse order in GT 
SoftGOT2000.

Error code Description Action
10H Command error

An unsupported command was used.
• Review the contents of the message to transmit.
• Check the commands in the message.
Page 531 List of commands for format 5 (SCHNEIDER EJH's 
memory link method)

12H Message length error
The data length is greater than the maximum data length for GT 
SoftGOT2000.

FAH Address error
The start address of the read or write device is out of range.

• Review the contents of the message to transmit.
• Check the data length of the message.(data length of the data 

section, etc.)

FBH Exceeded number of points error
The read or write range has exceeded the device range.

• Review the contents of the message to transmit.
• Check the devices that can be used and the device ranges.
Page 489 Device data area

FCH Message format error
The format of the received message has error.

• Check the settings in the communication detail settings.
• Review the contents of the message to transmit.

FFH Timeout error
There is no response from GT SoftGOT2000, or the specified station 
is nonexistent.

• Check the communication cable and communication module 
attachment.

• Check the settings in the communication detail settings.
• Review the contents of the message to transmit.
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Formats 6, 7 (4E frame)
The following describes the message formats 6 and 7 (4E frame).

Basic format of data communication
This is the same message format as when communication is performed using the MC protocol (4E frame) of the Q/QnA 
Series serial communication module.
For details of the basic format of data communication, refer to the following manual:
MELSEC Communication Protocol Reference Manual
This section explains the settings that differ from the MC protocol settings of the Q/QnA series serial communication modules, 
and the commands dedicated to the microcomputer connection.
Example: Request message for the batch read (0401) command in word units
Device name : D
Head device : 100
Device points : 2
Communication setting in GT SoftGOT2000: Network number = 1, PC number = 1
(Format 6 (4E frame (ASCII))

(format 7:4E frame (Binary))

(H) –

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H) –

Request destination 
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request destination 
module station No.

0
30H

0
30H

Following
*10 0

30H 30H

(H) (L)(H) (L)

Serial No.

0
30H

0
30H

0 0
30H 30H

(H) (L)(H) (L)

Request type

0
30H

0
30H

5 4
35H 34H

(H) (L)

(H) (L)

Device 
code

*
2AH

D
44H

(H)

Head Device

1
31H

––

0
30H

–

0
30H

(L)

0
30H

–

0
30H

0
30H

Character A section

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

– (H) –

Device points

0
30H

0
30H

– (L)

0
30H

2
32H

(H) (L)

Request data length

0
30H

0
30H

(H) (L)

1
31H

8
38H

(H) (L)

CPU monitoring timer

0
30H

0
30H

(L)

0
30H

0
30H

(H) (H) –

Command

0
30H

4
34H

– (L)

0
30H

1
31H

*1

1)

1)

Data length target range

Data length target range

00H 00H 00H 00H0CH54H 00H

Request 
type

Fixed 
value

00H 00H 00H 00H00H 00H

Serial No.

01H 01H

Data length target range

00H 00H64H 00H02HA8H01H 04H 00H 00H

PLC 
No.

Network 
No.

Request 
destination 

module I/O No.

Request 
destination 
module 

station No.

Device 
codeHead DeviceSub-

command Device pointsRequest 
data length

CPU 
monitoring 

timer
Command
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Details of data items in message format

Data code during communication
Communication of format 6 is performed in ASCII code.
Communication of the format 7 is performed in Binary code.

The following table shows the contents of the data items.

Data item name Contents

Format 6 Format 7
Request type 
(Microcomputer side)

Indicates it is a command message.

Command message: ASCII "5400" (Fixed value) Command message: 54H (Upper digit) (Fixed value)

Response type (GT 
SoftGOT2000 side)

Indicates it is a response message.

Response message: ASCII "D400" (Fixed value) Response message: D4H (Upper digit) (Fixed value)

Serial No. Arbitrary number for recognition of the message appended at the microcomputer side.
GT SoftGOT2000 sends the response message appending this Serial No.

Fixed value Should be ASCII "0000". Should be "0000H".

Network No. Set the same number as the network number set in GT SoftGOT2000.
For the settings in the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Transmit the data converted to a 2-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 1-byte binary code.

PLC No. Set the same number as the PC number set in GT SoftGOT2000.
For the settings in the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Transmit the data converted to a 2-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 1-byte binary code.

Request destination 
module I/O No.

GT SoftGOT2000 ignores this item.

Request destination 
module station No.

GT SoftGOT2000 ignores this item.

Request data length Number of bytes from the start of CPU monitoring timer to the last request data.

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Response data length Appended to the response message from the microcomputer side.
Number of bytes from the start of end code to the last response data or last error response data.

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

CPU monitoring timer GT SoftGOT2000 ignores this item.

Command, Sub-command Specifies the access contents from the microcomputer side to GT SoftGOT2000.
For details of the commands that can be used, refer to the following.
Page 537 Commands for format 6 (4E frame (ASCII))
Page 538 Commands for format 7 (4E frame (binary))

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Device code Specify the code to identify the device data to be read and written.
For the range of accessible devices, refer to the following.
Page 489 Device data area

Transmit the 2-byte ASCII code corresponding to the following 
device codes from the higher-order byte.

Transmit the 1-byte binary code corresponding to the following 
device codes.

D*

R*
SD

L*

M*
SM

SD

R

L

SM
M

D

Device codeDevice name

A8H

AFH
A9H

92H

90H
91H

SD

R

L

SM
M

D

Device codeDevice name
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Connecting microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules
If you connect microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules, change the commands and the devices according to the specifications of GT 
SoftGOT2000.

Head device Specifies the head No. of the device data to be read or written.
For the range of accessible devices, refer to the following.
Page 489 Device data area

Convert the decimal data to 6-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 3-byte binary code from the 
lower-order byte.

Device points Specifies the device data points to be read or written. (Setting range: Range of the maximum number of points processed for each 
command)
<When using the random read or write command>
When setting multiple bit access points, word access points, or double-word access points, the total points must be within the 
maximum points processed by each command.
<When using multiple block batch read or write commands>
When setting multiple blocks, limit the total number of points of all blocks to within the maximum number of points processed for 
each command.

Convert the decimal data to 4-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Year, month, day, hour, 
minute, second and day of 
the week data

Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal computer.
Page 539 Read clock data (1901) command
Page 542 Set clock data (0901) command

Convert the decimal data to 2-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 1-byte binary code.

End code (Microcomputer 
side)

Appended to the response message from the microcomputer side. If an error occurs at the microcomputer side, the error code is 
displayed.
Page 545 Error code list

Convert the hexadecimal data to 4-byte ASCII code and 
transmit the data from the higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Data item name Contents

Format 6 Format 7
6 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Commands for format 6 (4E frame (ASCII))

*1 Mixed specification of bit devices and word devices is also possible.
*2 This command is usable only when the microcomputer connection is used.
*3 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Sub-
command

Command name Description Max. number of points processed

0401 0001 Batch read in bit units Reads bit devices in 1-point units. 896 points

0401 0000 Batch read in word units Reads bit devices in 16-point units.*3 256 words (4096 points)

Reads word devices in 1-point units. 256 points

1401 0001 Batch write in bit units Writes to bit devices in 1-point units. 896 points

1401 0000 Batch write in word units Writes to bit devices in 16-point units.*3 244 words (3904 points)

Writes to word devices in 1-point units. 244 points

0403 0000 Random read in word units *1 Reads multiple different bit devices in 16-
point and 32-point units.*3

128 words (2048 points)

Reads multiple different word devices in 1-
point and 2-point units.

128 points

1402 0001 Random write in bit units Writes to multiple different bit devices in 1-
point units.

96 points

1402 0000 Random write in word units *1 Writes to multiple different bit devices in 
16-point and 32-point units.*3

64 words (1024 points)

Writes to multiple different word devices in 
1-point and 2-point units.

64 points

0406 0000 Multiple block batch read Reads multiple blocks. A bit device (16 
bits for 1 point) or a word device (1 word 
for 1 point) is regarded as one block.*3

80 points

1406 0000 Multiple block batch write Writes multiple blocks. A bit device (16 bits 
for 1 point) or a word device (1 word for 1 
point) is regarded as one block.*3

64 points

1901*2 0000 Read clock data Reads the clock data of the personal 
computer.

―

0901*2 0000 Set clock data Sets the clock data of the personal 
computer.

―
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Commands for format 7 (4E frame (binary))

*1 Mixed specification of bit devices and word devices is also possible.
*2 This command is usable only when the microcomputer connection is used.
*3 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Sub-
command

Command name Description Max. number of points processed

0401 0001 Batch read in bit units Reads bit devices in 1-point units. 896 points

0401 0000 Batch read in word units Reads bit devices in 16-point units. *3 512 words (8192 points)

Reads word devices in 1-point units. 512 points

1401 0001 Batch write in bit units Writes to bit devices in 1-point units. 896 points

1401 0000 Batch write in word units Writes to bit devices in 16-point units. *3 496 words (7936 points)

Writes to word devices in 1-point units. 496 points

0403 0000 Random read in word units *1 Reads multiple different bit devices in 16-
point and 32-point units. *3

255 words (4080 points)

Reads multiple different word devices in 1-
point and 2-point units.

255 points

1402 0001 Random write in bit units Writes to multiple different bit devices in 1-
point units.

188 points

1402 0000 Random write in word units *1 Writes to multiple different bit devices in 
16-point and 32-point units. *3

128 words (2048 points)

Writes to multiple different word devices in 
1-point and 2-point units.

128 points

0406 0000 Multiple block batch read Reads multiple blocks. A bit device (16 
bits for 1 point) or a word device (1 word 
for 1 point) is regarded as one block. *3

160 points

1406 0000 Multiple block batch write Writes multiple blocks. A bit device (16 bits 
for 1 point) or a word device (1 word for 1 
point) is regarded as one block. *3

128 points

1901 *2 0000 Read clock data Reads the clock data of the personal 
computer.

―

0901 *2 0000 Set clock data Sets the clock data of the personal 
computer.

―
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Message format
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Read clock data (1901) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Time display

2009/10/01 18:46:49 THU

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Request data length

0
30H

– (L)

0
30H

C
43H

0
30H

(H) –

CPU monitoring timer

0
30H

0
30H

(L)

0
30H

0
30H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Request type

0
30H

0
30H

(H) –

5
35H

4
34H

Character A section

(H) –

Command

9
39H

– (L)

0
30H

1
31H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

1)

1)

Request destination 
module I/O No.

Request destination 
module station No.

Fixed value

00H

PLC
No.

Network 
No.

06H 00H

Request
data length

Following
*1

*1

00H 00H

Serial No.

01H00H 01H00H 00H54H 00H

Data length target range

Command

00H 01H 19H00H

Sub-
command

00H 00H

Request destination 
module I/O No.

Request
destination
module
station No.

CPU monitoring
timer

Request
   type

00H
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Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Item Message format

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Response data length

0
30H

– (L)

1
31H

2
32H

0
30H

(H) –

End code

0
30H

0
30H

(L)

0
30H

0
30H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Response type

0
30H

0
30H

(H) –

D
44H

4
34H

Character B section

(H) (L)

9
39H

(H) (L)

1
31H

0
30H

0
30H

(H) (L)

0
30H

1
31H

(L)

1
31H

8
38H

(H)

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

1)

1)

Request destination 
module I/O No.

Request destination 
module station No.

(H) (L)

6
36H

(H) (L)

4
34H

9
39H

4
34H

(H) (L)

0
30H

4
34H

Year data Month data Day data Hour data Minute data Second 
data

Day-of-
week data

Data length target range

End code

00H 00H

*1
Year
data

09H 0AH

Month
data

01H 12H

Day
data

2EH 31H

Hour
data

04H

Minute
data

Second 
data

Day-of-
week data

Fixed value

00H

PLC
No.

Network 
No.

09H 00H

Response
data length

Following
*100H 00H

Serial No.

01H 01H00H

Request
type

00H 00HD4H 00H

Request destination 
module I/O No.

00H

Request
destination
module
station No.
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Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Item Message format

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Response data length

0
30H

– (L)

1
31H

6
36H

0
30H

(H) –

End code

0
30H

0
30H

(L)

5
35H

6
36H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Response type

0
30H

0
30H

(H) –

D
44H

4
34H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

1)

1)

Request destination 
module I/O No.

Request destination 
module station No.

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H)

0
30H

0
30H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

Request destination 
module I/O No.

Request destination 
module station No.

– (L)

Sub-command

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Command

0
30H

1
31H

(H) –

1
31H

9
39H

Data length target range

End code

56H 00H

*1

Fixed value

00H

PLC
No.

0BH 00H

Response
data length

Following
*1

00H 00H

Serial No.

01H 01H00H

Request
type

00H 00HD4H 00H

Request destination 
module I/O No.

Command

01H 19H

Sub-
command

00H 00H00H

PLC
No.

00H 00H00H 00H

Request destination 
module I/O No.

Network 
No.

Request
destination
module
station No.

00H

Network 
No.

Request
destination
module
station No.
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■Set clock data (0901) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Time display

2009/10/01 18:46:49 THU

After execution

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Request data length

0
30H

– (L)

1
31H

A
41H

0
30H

(H) –

CPU monitoring timer

0
30H

0
30H

(L)

0
30H

0
30H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Response type

0
30H

0
30H

(H) –

5
35H

4
34H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

1)

Request destination 
module I/O No.

Request destination 
module station No.

Character C section

(H) (L)

9
39H

(H) (L)

1
31H

0
30H

0
30H

(H) (L)

0
30H

1
31H

(L)

1
31H

8
38H

(H)

1)

(H) (L)

6
36H

(H) (L)

4
34H

9
39H

4
34H

(H) (L)

0
30H

4
34H

Year data Month data Day data Hour data Minute data Second 
data

Day-of-
week data

– (L)

Command

0
30H

1
31H

(H) –

0
31H

9
39H

– (L)

Sub-command

0
30H

0
30H

(H) –

0
30H

0
30H

Data length target range

CPU monitoring
timer

00H 00H

*1
Year
data

09H 0AH

Month
data

01H 12H

Day
data

2EH 31H

Hour
data

04H

Minute
data

Second 
data

Day-of-
week data

Fixed value

00H

PLC
No.

Network 
No.

0DH 00H

Request
data length

Following
*1

00H 00H

Serial No.

01H 01H00H

Request
type

00H 00H54H 00H

Request destination 
module I/O No.

01H 09H 00H 00H

Command Sub-
command

00H

Request
destination
module
station No.
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Response 
message during 
normal 
communication
(GT SoftGOT2000 
→ Host)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Response 
message during 
faulty 
communication
(GT SoftGOT2000 
→ Host)

(format 6:4E frame (ASCII))

(format 7:4E frame (Binary))

Item Message format

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Response data length

0
30H

– (L)

0
30H

4
34H

0
30H

(H) –

End code

0
30H

0
30H

(L)

0
30H

0
30H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Response type

0
30H

0
30H

(H) –

D
44H

4
34H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

Request destination 
module I/O No.

Request destination 
module station No.

Data length
target range

00H 00H

Fixed value

00H

PLC
No.

Network 
No.

02H 00H

Response
data length

00H 00H

Serial No.

01H 01H00H00H

Request
type

00H 00HD4H 00H

Request destination 
module I/O No. End code

Request
destination
module
station No.

– (L)

Fixed value

0
30H

0
30H

(H) (L)

PLC No.

0
30H

1
31H

(H) (L)

Network 
No.

0
30H

1
31H

(H)

0
30H

0
30H

(H) –

Response data length

0
30H

– (L)

1
31H

6
36H

0
30H

(H) –

End code

0
30H

0
30H

(L)

5
35H

6
36H

–

Following
*1

*1

(H) –

0
30H

0
30H

– (L)

Serial No.

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Response type

0
30H

0
30H

(H) –

D
44H

4
34H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

1)

1)

Request destination 
module I/O No.

Request destination 
module station No.

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Network 
No.

0
30H

0
30H

(H)

0
30H

0
30H

– (L)–

0
30H

0
30H30H

(H) (L)

0
30H

0
30H

Request destination 
module I/O No.

Request destination 
module station No.

– (L)

Sub-command

0
30H

0
30H

(H) –

0
30H

0
30H

– (L)

Command

0
30H

1
31H

(H) –

0
30H

9
39H

D4H 00H 00H 01H 00H00H 00H00H 01H 00H 00H 0BH 0H

*1

56H 00H 00H 00H 00H 00H 01H 09H 00H 00H00H

Serial No. Fixed value Request 
   type

Request destination 
module I/O No.

Response 
data length

Request destination 
module I/O No.

Following*1

PLC 
No.

End code PLC 
No.

Sub-
commandCommand

Data length target range

Network 
No.

Request
destination
module
station No.

Network 
No.

Request
destination
module
station No.
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When a wrong day of the week has been set by the clock data setting command
If a wrong day of the week is set by the clock data setting commands, the corrected day of the week will be 
set.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday (TUE) will be set.

■In the case of interrupt outputs
Write data to the interrupt output devices (D13 and D14) to output the data to the host.
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)
Interrupt output is available only when [TCP/IP] is set for [Protocol] in the [Communication Setup] dialog.

Interrupt output
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Item Message format
Interrupt output
(GT SoftGOT2000 
→ Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt output

Example) When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [2Byte] as (2) in the following table

31H

Output 
value 1

39H

Output 
value 2

Interrupt

3139HD13

39H

Output 
value 1

31H 39H

Output 
value 1

Output 
value 2

AAH

Output 
value1

55H

Output 
value2

31H

Output 
value3

39H

Output 
value4

31H

Output 
value1

39H

Output 
value2

AAH

Output 
value3

55H

Output 
value4
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Error code list
The following shows error code, error contents, cause, and measures.

Error code Description Action
0002H Device point error

The specified device range to be read or written is incorrect.
• Check the specified head device and number of points, and 

correct it.
Page 489 Device data area

0050H Request (command) type or response (response) type code error
A code other than the specified value is set for the command type or 
response type.

• Check and correct the command type or response type set in the 
microcomputer.

0056H Device error
A non-existent device has been specified.

• Check the devices that can be used and the device ranges.
Page 489 Device data area

0057H Device point error
• The command number of points specification from the 

microcomputer exceeds the maximum number of points 
processed at each process (number of points processed in one 
communication).

• The start address (head device number) to specified number of 
points exceeds the maximum address (device number, step 
number) for each process.

• Correct the specified number of points, or the start address 
(device number).

Page 489 Device data area

When writing data which the command bit length is longer or shorter 
than the specification, the set number of write data points differs from 
the specified number of points value.

• Check the command data length and set the data again.

0058H • The command start address (head device number, start step 
number) specification from the microcomputer exceeds the range 
that can be specified.

• A value outside the GT SoftGOT2000 parameter setting range is 
specified for reading or writing the microcomputer program or file 
register (R).

• Correct the values to values that can be specified in each process.

• Word device is specified in the command for bit device.
• In the command for word device, a bit device start number is 

specified in other than hexadecimal.

• Correct the command or the specified device.

00A1H • Request content cannot be analyzed because the text length or 
request data length is too short.

• Review the text length or the head request data length.

00A2H • Request cannot be processed. • Correct the request content and command.

C0D6H • The specification of network No. and station No. have error. • Review the network No., station No. specification method.
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Formats 8, 9 (QnA compatible 3E frame)
The following describes the message formats 8 and 9 (QnA compatible 3E frame).

Basic format of data communication
This is the same message format as when communication is performed using the MC protocol (QnA compatible 3E frame) of 
the Q/QnA Series serial communication module.
For details of the basic format of data communication, refer to the following manual:
MELSEC Communication Protocol Reference Manual
This section explains the settings that differ from the MC protocol settings of the Q/QnA series serial communication modules, 
and the commands dedicated to the microcomputer connection.
Example: Request message for the batch read (0401) command in word units
Device name : D
Head device : 100
Device points : 2
Communication setting in GT SoftGOT2000: Network number = 1, PC number = 1
(Format 8: QnA compatible 3E frame (ASCII))

(Format 9: QnA compatible 3E frame (Binary))

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

(H)

Request destination
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request 
destination 

module station No.

0
30H

0
30H

Following
*1

(H) –

Command

0
30H

4
34H

– (L)

0
30H

1
31H

*1

(H) (L)

Device
code

*
2AH

D
44H

(H)

Start Device

1
31H

––

0
30H

–

0
30H

(L)

0
30H

–

0
30H

0
30H

Character A section

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

– (H) –

Device points

0
30H

0
30H

– (L)

0
30H

2
32H

(H) (L)

5
35H

0
30H

(H) (L)

Subheader

0
30H

0
30H

1 1
31H31H

(H) (L)

0
30H

0
30H

(H) (L)

Request data length

1
31H

8
38H

(H) (L)

0
30H

0
30H

(H) (L)

CPU monitoring timer

0
30H

0
30H

Data length target data

–

00H 00H 00H 00H0CH50H 00H

Subheader PLC 
No.

Network
No.

Request 
destination

module I/O No.

Request 
data length

CPU 
monitoring timer

Request 
destination

module 
station No.

00H 00H01H 01H

Sub-
command

00H 00H64H

Start Device Device
code Device points

00H02HA8H

Command

01H 04H 00H 00H

Data length target data
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Details of data items in message format

Data code during communication
Communication of format 8 is performed in ASCII code.
Communication of the format 9 is performed in Binary code.

The following table shows the contents of the data items.

Data item name Contents

Format 8 Format 9
Subheader 
(Microcomputer side)

Indicates it is a command message.

Command message: ASCII "5000" (Fixed value) Command message: 50H (Upper digit) (Fixed value)

Subheader (GT 
SoftGOT2000 side)

Indicates it is a response message.

Response message: ASCII "D000" (Fixed value) Response message: D0H (Upper digit) (Fixed value)

Network No. Set the same number as the network number set in GT SoftGOT2000.
For the settings in the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Transmit the data converted to a 2-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 1-byte binary code.

PLC No. Set the same number as the PC number set in GT SoftGOT2000.
For the settings in the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

Transmit the data converted to a 2-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 1-byte binary code.

Request destination 
module I/O No.

GT SoftGOT2000 ignores this item.

Request destination 
module station No.

GT SoftGOT2000 ignores this item.

Request data length Number of bytes from the start of CPU monitoring timer to the last request data.

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Response data length Appended to the response message from the microcomputer side.
Number of bytes from the start of end code to the last response data or last error response data.

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

CPU monitoring timer GT SoftGOT2000 ignores this item.

Command, Sub-command Specifies the access contents from the microcomputer side to GT SoftGOT2000.
For details of the commands that can be used, refer to the following.
Page 549 Commands for format 8 (QnA compatible 3E frame (ASCII))
Page 550 Commands for format 9 (QnA compatible 3E frame (binary))

Transmit the data converted to a 4-byte ASCII code from the 
higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Device code Specifies the code by which the device data to be read or written is recognized.
For the range of accessible devices, refer to the following.
Page 489 Device data area

Transmit the 2-byte ASCII code corresponding to the following 
device codes from the higher-order byte.

Transmit the 1-byte binary code corresponding to the following 
device codes.

Head device Specifies the head No. of the device data to be read or written.
For the accessible device range, refer to the following.
Page 489 Device data area

Convert the decimal data to 6-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 3-byte binary code from the 
lower-order byte.

Device code

D*

R*
SD

L*

M*
SM

Device name

SD

R

L

SM
M

D A8H

AFH
A9H

92H

90H
91H

SD

R

L

SM
M

D

Device codeDevice name
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Connecting microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules
If you connect microcomputers or other devices that use the MC protocol of the Q/QnA series serial 
communication modules, change the commands and the devices according to the specifications of GT 
SoftGOT2000.

Device points Specifies the device data points to be read or written. (Setting range: Range of the maximum number of points processed for each 
command)
<When using random read or write command>
When setting multiple bit access points, word access points, or double-word access points, the total points must be within the 
maximum points processed by each command.
<When using multiple block batch read or write commands>
When setting multiple blocks, limit the total number of points of all blocks to within the maximum number of points processed for 
each command.

Convert the decimal data to 4-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Year, month, day, hour, 
minute, second and day of 
the week data

Specify the year, month, day, hour, minute, second, and day of the week to read or set the clock data of the personal computer.
Page 551 Read clock data (1901) command
Page 553 Set clock data (0901) command

Convert the decimal data to 2-byte ASCII code and transmit the 
data from the higher-order byte.

Transmit the data converted to a 1-byte binary code.

End code (Microcomputer 
side)

Appended to the response message from the microcomputer side. If an error occurs at the microcomputer side, the error code is 
displayed.
Page 556 Error code list

Convert the hexadecimal data to 4-byte ASCII code and 
transmit the data from the higher-order byte.

Transmit the data converted to a 2-byte binary code from the 
lower-order byte.

Data item name Contents

Format 8 Format 9
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Commands for format 8 (QnA compatible 3E frame (ASCII))

*1 Mixed specification of bit devices and word devices is also possible.
*2 This command is usable only when the microcomputer connection is used.
*3 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Sub-
command

Command name Description Max. number of points processed

0401 0001 Batch read in bit units Reads bit devices in 1-point units. 896 points

0401 0000 Batch read in word units Reads bit devices in 16-point units.*3 256 words (4096 points)

Reads word devices in 1-point units. 256 points

1401 0001 Batch write in bit units Writes to bit devices in 1-point units. 896 points

1401 0000 Batch write in word units Writes to bit devices in 16-point units.*3 244 words (3904 points)

Writes to word devices in 1-point units. 244 points

0403 0000 Random read in word units *1 Reads multiple different bit devices in 16-
point and 32-point units.*3

128 words (2048 points)

Reads multiple different word devices in 1-
point and 2-point units.

128 points

1402 0001 Random write in bit units Writes to multiple different bit devices in 1-
point units.

96 points

1402 0000 Random write in word units *1 Writes to multiple different bit devices in 
16-point and 32-point units.*3

64 words (1024 points)

Writes to multiple different word devices in 
1-point and 2-point units.

64 points

0406 0000 Multiple block batch read Reads multiple blocks. A bit device (16 
bits for 1 point) or a word device (1 word 
for 1 point) is regarded as one block.*3

80 points

1406 0000 Multiple block batch write Writes multiple blocks. A bit device (16 bits 
for 1 point) or a word device (1 word for 1 
point) is regarded as one block.*3

64 points

1901*2 0000 Read clock data Reads the clock data of the personal 
computer.

―

0901*2 0000 Set clock data Sets the clock data of the personal 
computer.

―
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Commands for format 9 (QnA compatible 3E frame (binary))

*1 Mixed specification of bit devices and word devices is also possible.
*2 This command is usable only when the microcomputer connection is used.
*3 Specifies the address of bit devices in 16-point units. (Example: M0, M16, M32, and others)

Command Sub-
command

Command name Description Max. number of points processed

0401 0001 Batch read in bit units Reads bit devices in 1-point units. 896 points

0401 0000 Batch read in word units Reads bit devices in 16-point units. *3 512 words (8192 points)

Reads word devices in 1-point units. 512 points

1401 0001 Batch write in bit units Writes to bit devices in 1-point units. 896 points

1401 0000 Batch write in word units Writes to bit devices in 16-point units. *3 496 words (7936 points)

Writes to word devices in 1-point units. 496 points

0403 0000 Random read in word units *1 Reads multiple different bit devices in 16-
point and 32-point units. *3

255 words (4080 points)

Reads multiple different word devices in 1-
point and 2-point units.

255 points

1402 0001 Random write in bit units Writes to multiple different bit devices in 1-
point units.

188 points

1402 0000 Random write in word units *1 Writes to multiple different bit devices in 
16-point and 32-point units. *3

128 words (2048 points)

Writes to multiple different word devices in 
1-point and 2-point units.

128 points

0406 0000 Multiple block batch read Reads multiple blocks. A bit device (16 
bits for 1 point) or a word device (1 word 
for 1 point) is regarded as one block. *3

160 points

1406 0000 Multiple block batch write Writes multiple blocks. A bit device (16 bits 
for 1 point) or a word device (1 word for 1 
point) is regarded as one block. *3

128 points

1901 *2 0000 Read clock data Reads the clock data of the personal 
computer.

―

0901 *2 0000 Set clock data Sets the clock data of the personal 
computer.

―

0 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.30  Microcomputer Connection (Ethernet)



3

Message format
The following shows the message formats for the commands that are usable only when the microcomputer connection is 
used.

■Read clock data (1901) command
The following shows an example of reading the clock data of the personal computer.
(The clock is set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request message
(Host → GT 
SoftGOT2000)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Response message 
during normal 
communication
(GT SoftGOT2000 
→ Host)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Time display

2009/10/01 18:46:49 THU

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

(H) –

Request destination
module I/O No.

0
30H

0
30H

–

– – – –

(L)

0
30H

0
30H

(H) (L)

Request 
destination module 
station No.

0
30H

0
30H

Following
*1

*1

(H)

0
30H

0
30H

(L)

Request data length

0
30H

C
43H

(H)

0
30H

0
30H

(L)

CPU monitoring timer

0
30H

0
30H

(H)

5
35H

0
30H

(L)

Subheader

0
30H

0
30H

– –

(H) –

Command

1
31H

9
39H

– (L)

0
30H

1
31H

Character A section

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

1 1
31H31H

Data length target data

Command

00H 00H

Data length target data

01H 19H 00H 00H

Sub-
command

CPU monitoring 
timer

00H

Network
No.

PLC 
No.

00H50H

Subheader

00H 00H 00H

Request 
destination

module I/O No.

Request
destination
module 
station No.

Request 
data length

01H01H 06H

Character B section

(H) (L)

Year data

0 9
30H 39H

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

Following
*1

(H)

D
44H

0
30H

(L)

Subheader

0
30H

0
30H

– – (H) –

Request destination
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

*1

(H)

0
30H

0
30H

(L)

Response data length

1
31H

2
32H

(H)

0
30H

0
30H

(L)

End code

0
30H

0
30H

– –

– –

11
31H31H

Data length target data

00H

Network
No.

PLC 
No.

00HD0H

Subheader

00H 00H 00H

Request 
destination
module I/O No.

Request 
destination
module 
station No.

Response 
data length

00H 00H

End code Year 
data

Month
 data

Day
data

Hour 
data

09H

Minute 
data

0AH 01H

Second
data

12H 2EH

Day-of-
week data

31H 04H01H01H 09H

Data length target data
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Response message 
during faulty 
communication
(GT SoftGOT2000 
→ Host)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Item Message format

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

(H) –

Request destination
module I/O No.

0
30H

0
30H

– – –

– –

(L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

Following
*1

*1

(H)

0
30H

0
30H

(L)

Response data length

1
31H

6
36H

(H)

0
30H

0
30H

(L)

End code

5
35H

6
36H

(H)

D
44H

0
30H

(L)

Subheader

0
30H

0
30H

– –

(H) –

Request destination
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Network
No.

0
30H

0
30H

11
31H 31H

1)

1)

(H) –

Command

1
31H

9
39H

– (L)

0
30H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

Data length target data

Data length target data

01H

*1

Command

01H 19H 00H 00H

Sub-
commandEnd code

Network
No.

00H01H

PLC 
No.

00HD0H

Subheader

00H 00H 00H

Following
*1

Request 
destination

module I/O No.

Request 
destination
module 
station No.

Response 
data length

Network
No.

PLC 
No.

00H

01H

00H 00H56H 00H 00H 00H

Request 
destination
module 
station No.

0BH

Data length target data

Request 
destination

module I/O No.
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■Set clock data (0901) command
The following shows an example of setting the clock data of the personal computer.
(The clock will be set to 18:46:49 on Thursday, October 1, 2009.)

Item Message format
Request 
message
(Host → GT 
SoftGOT2000)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Time display

2009/10/01 18:46:49 THU

After execution

Character C section

(H) (L)

Year data

0 9
30H 39H

(H) (L)

Month data

1 0
31H 30H

(H) (L)

Day data

0 1
30H 31H

(H) (L)

Hour data

1 8
31H 38H

(H) (L)

Minute data

4 6
34H 36H

(H) (L)

Second
data

4 9
34H 39H

(H) (L)

Day-of-
week data

0 4
30H 34H

1)

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

Following
*1

(H)

5
35H

0
30H

(L)

Subheader

0
30H

0
30H

– – (H) –

Request destination
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

*1

(H)

0
30H

0
30H

(L)

Response data length

1
31H

A
41H

(H)

0
30H

0
30H

(L)

CPU monitoring timer

0
30H

0
30H

1)

– – – –

11

(H) –

Command

0
31H

9
39H

– (L)

0
30H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

31H31H

Data length target data

Data length target data

00H

Network
No.

00H 0DH50H

Subheader

00H 00H 00H

Following
*1

Request 
destination

module I/O No.

Request 
destination
module
station No.

Request 
data length

00H 00H

CPU 
monitoring timer

*1
Year
data

Month
data

Day
data

Hour 
data

09H

Minute 
data

0AH 01H

Second
data

12H 2EH

Day-of-
week data

31H 04H

01H 01H

PLC 
No.

Command

01H 09H 00H 00H

Sub-
command

Data length target data
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Response 
message during 
normal 
communication
(GT 
SoftGOT2000 
→ Host)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Response 
message during 
faulty 
communication
(GT 
SoftGOT2000 
→ Host)

(format 8:QnA compatible 3E frame (ASCII))

(format 9:QnA compatible 3E frame (Binary))

Item Message format

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

(H) –

Request destination
module I/O No.

0
30H

0
30H

–

– – – –

(L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

Following
*1

*1

(H)

0
30H

0
30H

(L)

Response data length

0
30H

4
34H

(H)

0
30H

0
30H

(L)

End code

0
30H

0
30H

(H)

D
44H

0
30H

(L)

Subheader

0
30H

0
30H

– –
31H 31H

1 1

Data length target data

00H 00H

End code

00H

Network
No.

PLC
No.

00H 02HD0H

Subheader

00H 01H 01H 00H 00H

Request 
destination

module I/O No.

Request 
destination
module 
station No.

Response
data length

Data length
target data

(H) (L)

PLC No.

0
30H

(H) (L)

Network
No.

0
30H

(H) –

Request destination
module I/O No.

0
30H

0
30H

– – –

– –

(L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

Following
*1

*1

(H)

0
30H

0
30H

(L)

Response data length

1
31H

6
36H

(H)

0
30H

0
30H

(L)

End code

5
35H

6
36H

(H)

D
44H

0
30H

(L)

Subheader

0
30H

0
30H

– –

(H) –

Request destination
module I/O No.

0
30H

0
30H

– (L)

0
30H

0
30H

(H) (L)

Request 
destination
module station No.

0
30H

0
30H

(H) (L)

PLC No.

0
30H

0
30H

(H) (L)

Network
No.

0
30H

0
30H

11
31H 31H

1)

1)

(H) –

Command

0
30H

9
39H

– (L)

0
30H

1
31H

(H) –

Sub-command

0
30H

0
30H

(L)

0
30H

0
30H

–

Data length target data

Data length target data

01H

*1

Command

01H 09H 00H 00H

Sub-
command

End code

Network
No.

00H01H

PLC
No.

00HD0H

Subheader

00H 00H 00H

Following
*1

Request 
destination

module I/O No.

Request 
destination
module 
station No.

Response
data length

Network
No.

PLC
No.

00H

01H

00H 00H56H 00H 00H 00H

Request 
destination

module I/O No.

Request 
destination
module 
station No.

0BH

Data length target data
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When a wrong day of the week has been set by the clock data setting command
If a wrong day of the week is set by the clock data setting commands, the corrected day of the week will be 
set.
Example: When June 1, 2004 (Thursday) is set by the clock data setting command (The actual day of week is 
Tuesday.)
Tuesday (TUE) will be set.

■In the case of interrupt outputs
Write data to the interrupt output devices (D13 and D14) to output the data to the host.
(Assuming that "3139H" is written to D13 and "AA55H" to D14.)
Interrupt output is available only when [TCP/IP] is set for [Protocol] in the [Communication Setup] dialog.

Interrupt output
To disable the interrupt output, turn on SM52 (interrupt code output disable flag).
Page 500 SM devices

Item Message format
Interrupt output
(GT SoftGOT2000 
→ Host)

(1) When [Interrupt Data Byte] is set to [1Byte] in the [Communication Setup] dialog

(2) When [Interrupt Data Byte] is set to [2Byte] in the [Communication Setup] dialog

(3) When [Interrupt Data Byte] is set to [4Byte] in the [Communication Setup] dialog
When [32bit Storage:] is set to [LH Order] in the [Communication Setup] dialog

When [32bit Storage:] is set to [HL Order] in the [Communication Setup] dialog

Interrupt output

Example) When [Interrupt Data Byte] in the [Communication Setup] dialog is set to [2Byte] as (2) in the following table

31H

Output 
value 1

39H

Output 
value 2

Interrupt

3139HD13

39H

Output 
value 1

31H 39H

Output 
value 1

Output 
value 2

AAH

Output 
value1

55H

Output 
value2

31H

Output 
value3

39H

Output 
value4

31H

Output 
value1

39H

Output 
value2

AAH

Output 
value3

55H

Output 
value4
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Error code list
For the error codes, refer to the following.
Page 545 Error code list
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Controller setting

Before setting
When multiple network devices (including a GT SoftGOT2000 module) are connected to the same segment, the network load 
increases, possibly degrading the communication performance between the GT SoftGOT2000 module and PLC.
The following countermeasures may improve the communication performance.
Use a switching hub.
Configure the system compliant with the high-speed 100BASE-TX (100 Mbps) standard.
Reduce the number of devices monitored by GT SoftGOT2000.
When multiple GT SoftGOT2000 modules are connected to the same Ethernet network, set a different station number for 
each module.
When a GT SoftGOT2000 module is used with a GOT1000 series model, do not set IP address 192.168.0.18 for the GT 
SoftGOT2000 module.
Doing so may cause a communication error on the GOT1000 series model.

Setting on the personal computer
Set the IP address.
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Settings in GT Designer3
Configure the settings in GT Designer3 as shown below.

For the setting method, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Settings in GT SoftGOT2000
To establish communication between GT SoftGOT2000 and the host by using the microcomputer connection (Ethernet), 
configure the communication settings.
Refer to the following, and configure the communication settings in GT SoftGOT2000.
Page 83 [Ethernet]

Precautions for Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Item Description Range
[Manufacturer] Select the manufacturer of the controller connected to GT SoftGOT2000. [Others]

[Controller Type] Select the type of the controller connected to GT SoftGOT2000. [Computer]
8 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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Precautions

Clock control in GT SoftGOT2000
The time setting and time notification set in GT Designer3 will be disabled.
To read or write the clock data between GT SoftGOT2000 and a host, use the dedicated command.

UDP/IP connection
When the commands are sent from multiple controllers simultaneously using the UDP/IP connection, GT SoftGOT2000 may 
not receive all the commands.
Resend the commands from the controllers so that GT SoftGOT2000 can receive the commands.

Station monitoring function
The microcomputer connection (Ethernet) does not support the station monitoring function.

Interrupt output
The interrupt output is available only for the TCP/IP connection.
The interrupt output cannot be executed in the UDP/IP connection.

Channels available in GT SoftGOT2000 (Multiple channels)
Two of channels 1 to 4 are available for the microcomputer connection (Ethernet).

Simultaneous use of other connections
When one device is connected with the microcomputer connection (Ethernet), only one more device can be connected with 
any of the following connections simultaneously.
 • Microcomputer connection (serial)
 • Connection to TOSHIBA PLCs
 • Barcode reader connection
 • RFID connection
More than three devices in total cannot be connected.
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3.31 MODBUS/TCP Master Connection
System configuration

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*3 For the connectable MODBUS/TCP slave equipment, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series with MODBUS Connection (GOT-A-0037)
For Technical News, contact your local distributor.

*4 Indicates the number of personal computers connectable to one controller.
*5 Indicates the number of controllers connectable to one personal computer.
*6 For the details, refer to the manual of the MODBUS/TCP slave equipment used.
*7 An Ethernet board/card is required.

Page 560 Ethernet board/card

Ethernet board/card
The Ethernet port built in the personal computer can be used.
Use an Ethernet board or Ethernet card compatible with the MODBUS/TCP slave equipment used.

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Connection cable
Use a cable compatible with the Ethernet module or MODBUS/TCP slave equipment used.

Controller Communication 
type

Connection 
cable *2

Max. distance GT SoftGOT2000 Number of connectable devices 
per channel

Personal 
computer *4

PLC *5

MODBUS/TCP 
slave equipment *3

Ethernet Twisted pair 
cable

100 m
(max. segment 
length)

Windows-compatible 
personal computer*7

PC CPU module
MELIPC

Depending on the 
MODBUS/TCP 
slave equipment 
used *6

128 *1

GT SoftGOT2000
(MODBUS/TCP master equipment)

Connection cable

MODBUS/TCP 
slave equipment
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Controller setting

Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 To fix the unit ID at 255, select [MODBUS/TCP(unit ID fixed)].

Setting on GT SoftGOT2000
Set the communication setting in the [Communication Setup] dialog of GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

MODBUS/TCP slave equipment settings
For the MODBUS/TCP slave equipment settings, refer to the manual of the MODBUS/TCP slave equipment used.

Item Description Range
[Host] Indicate the host station. (The host station is 

indicated as *.)
-

[Net No.] Set the network number of the target Ethernet 
module.

[1] to [239]

[Station] Set the station number of the target Ethernet 
module

[1] to [247]

[Unit Type] *1 Select a target Ethernet module. [MODBUS/TCP],
[MODBUS/TCP(unit ID fixed)]

[IP Address] Set the IP address of the target MODBUS/TCP 
equipment.

IP address of the MODBUS/TCP equipment side

[Port No.] Displays the port number of the MODBUS/TCP 
equipment.

[1] to [65535]

[Communication] Displays the connection method. [TCP]
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MODBUS communication control function on the GOT special register (GS device)
This function is to prevent the communication response delay that occurs because the devices on the MODBUS network differ 
from each other in network specification.
This function is effective for the MODBUS network conditions as described below:
When only a part of function codes is supported (Example: "0F" is not supported)
When the maximum transfer size of function code is small (Example: The maximum number of coil read times is 1000)

■Communication setting
The device (GS579.b0) switches between two communication settings.
When GS579.b0 is off, the communication setting 1 (GS570 to GS576) is applied.
When GS579.b0 is on, the communication setting 2 (GS590 to GS596) is applied.
The following shows the communication setting.

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

GS device Description Set value

Communication 
setting 1

Communication 
setting 2

GS570 GS590 Command selection Bit0: 0 Using Function Code "0F"
1 Not using Function Code "0F"
Bit1: 0 Using Function Code "10"
1 Not using Function Code "10"

GS571 GS591 Function Code "01"
Specification for the max. number of coil read 
times

0:1000
1 to 2000: Specify the maximum number.
Other than above: 2000

GS572 GS592 Function Code "02"
Specification for the max. number of input 
relay read times

0:1000
1 to 2000: Specify the maximum number.
Other than above: 2000

GS573 GS593 Function Code "03"
Specification for the max. number of holding 
register read times

0:125
1 to 125: Specify the maximum number.
Other than above: 125

GS574 GS594 Function Code "04"
Specification for the max. number of input 
register read times

0:125
1 to 125: Specify the maximum number.
Other than above: 125

GS575 GS595 Function Code "0F"
Specification for the max. number of multiple-
coil write times

0:800
1 to 800: Specify the maximum number.
Other than above: 800
When Bit0 of GS570 is "1", the function code "0F" is not used, 
and therefore the setting of GS575 will be disabled.

GS576 GS596 Function Code "10"
Specification for the max. number of multiple-
holding register write times

0:100
1 to 100: Specify the maximum number.
Other than above: 100
When Bit1 of GS570 is "1", the function code "10F" is not used, 
and therefore the setting of GS576 will be disabled.
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3.32 MODBUS/TCP Slave Connection
System configuration

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*3 For the connectable MODBUS/TCP master equipment, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series with MODBUS Connection (GOT-A-0037)
For Technical News, contact your local distributor.

*4 Indicates the number of personal computers connectable to one controller.
*5 Indicates the number of controllers connectable to one personal computer.
*6 For the details, refer to the manual of the MODBUS/TCP master equipment used.
*7 An Ethernet board/card is required.

Page 563 Ethernet board/card

Ethernet board/card
The Ethernet port built in the personal computer can be used.
Use an Ethernet board or Ethernet card compatible with the MODBUS/TCP master equipment used.

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Connection cable
Use a cable compatible with the Ethernet module or MODBUS/TCP master equipment used.

Controller Communication 
type

Connection 
cable *2

Max. distance GT SoftGOT2000 Number of connectable devices 
per channel

Personal 
computer *4

PLC *5

MODBUS/TCP 
master equipment *3

Ethernet Twisted pair cable 100 m
(max. segment 
length)

Windows-compatible 
personal computer*7

PC CPU module
MELIPC

Depending on the 
MODBUS/TCP 
master equipment 
used *6

16 *1

GT SoftGOT2000
(MODBUS/TCP slave equipment)

Connection cable

MODBUS/TCP 
master equipment
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Controller setting

Settings in GT Designer3
Configure the settings on GT Designer3 as shown below.

Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

MODBUS/TCP master equipment settings
For the MODBUS/TCP master equipment settings, refer to the manual of the MODBUS/TCP master equipment used.

Precautions
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions
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3.33 SLMP Connection
System configuration

*1 When starting up multiple GT SoftGOT2000 modules, monitoring is enabled on the multiple screens.
*2 The destination connected with the twisted pair cable varies with the configuration of the applicable Ethernet network system.

Connect to the Ethernet module, hub, transceiver or other system equipment corresponding to the applicable Ethernet network system.
Use cables, connectors, and hubs that meet the IEEE802.3 10BASE-T/100BASE-TX standard.

*3 For the connectable SLMP-compatible devices, refer to the following Technical News.
List of SLMP-compatible Equipment Validated to Operate with the GOT2000 Series (GOT-A-0085)
For Technical News, contact your local distributor.

*4 Indicates the number of personal computers connectable to one SLMP-compatible device.
*5 Indicates the number of SLMP-compatible devices connectable to one personal computer.
*6 For the details, refer to the manual of the SLMP-compatible device in use.
*7 An Ethernet board/card is required.

Page 565 Ethernet board/card

Ethernet board/card
The Ethernet port built in the personal computer can be used.
Use an Ethernet board or Ethernet card compatible with the SLMP-compatible device to be connected.

 • When using PC CPU module
A interface board is not required.
For the system configuration of the PC CPU module, refer to the manual of the PC CPU module.
 • When using a MELIPC
To use a MELIPC, no interface board is required.
For the system configuration of a MELIPC, refer to the following.
User's manual of MELIPC

Connection cable
Use a cable compatible with the Ethernet module or SLMP-compatible device in use.

Controller Communication 
type

Connection 
cable *2

Max. distance GT 
SoftGOT2000

Number of connectable devices 
per channel

Personal 
computer *4

SLMP-
compatible 
device *5

SLMP-compatible 
device *3

Ethernet Twisted pair cable 100 m
(max. segment 
length)

Windows-
compatible personal 
computer*7

PC CPU module
MELIPC

Depending on the 
SLMP-compatible 
device used *6

128 *1

GT SoftGOT2000

Connection cable

SLMP-compatible 
device
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Controller setting

Settings in GT Designer3
Up to 128 settings can be configured in [Connected Ethernet Controller Setting].

*1 When 125 is set in [Station], GT SoftGOT2000 (Multiple channels) can access the master station on the CC-Link IE TSN network.

Setting on GT SoftGOT2000
Configure the settings in the [Communication Setup] dialog in GT SoftGOT2000.
For the details of the [Communication Setup] dialog, refer to the following.
Page 83 [Ethernet]

SLMP-compatible device settings
For the SLMP-compatible device settings, refer to the manual of the SLMP-compatible device in use.

Item Description Range
[Host] Indicate the host station. (The host station is 

indicated as.)
-

[Net No.] Set the network number of the target Ethernet 
module.

[1] to [239]

[Station] Set the station number of the target Ethernet 
module

[1] to [120], [125] *1

[Unit Type] Select [SLMP]. [SLMP]

[IP Address] Set the IP address of the target SLMP-compatible 
device.

IP address of the SLMP-compatible device side

[Port No.] Displays the port number of the SLMP-compatible 
device.

[1] to [65535]

[Communication] Displays the connection method. [UDP], [TCP]
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Routing Parameter Setting
Set the routing parameter in [Routing Information] in the [Controller Setting] window on GT Designer3.
Up to 64 transfer destination network numbers are settable.
However, you cannot set duplicate transfer destination network numbers.
The GOT (host station) can access other networks that have the transfer destination network numbers specified in the routine 
parameter setting.

Routing parameter setting
Communication within the host network does not require routing parameter setting.
For the details of the routing parameter setting, refer to the following.
Manuals of SLMP-compatible

Routing parameter setting for the relay station
The PLC at the relay station also requires the routing parameter setting.
For the setting, refer to the following.
Manuals of SLMP-compatible

Precautions

Communication with the SLMP-compatible device
Do not use GT SoftGOT2000 with other MELSOFT applications when SLMP-compatible devices are connected.
To start multiple GT SoftGOT2000 modules connected by Ethernet, set a different port number for each module.

Precautions for the Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Setting item Range
[Transfer Net No.] [1] to [239]

[Relay Net No.] [1] to [239]

[Relay Station No.] [0] to [120]
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3.34 Barcode Reader Connection
Serial connection

System configurations and connection conditions

*1 For connectable bar code readers, system equipment, available bar code types and connection cables, refer to the following Technical 
News.
List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
For Technical News, contact your local distributor.

*2 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.

Controller setting
■Barcode function setting on GT Designer3
Before connecting the barcode reader, make the barcode function and system data settings.
For details, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual

■Setting on GT SoftGOT2000
Set the [Communication Setup] dialog of GT SoftGOT2000.
For details on the [Communication Setup] dialog, refer to the following manual.
Page 99 [Barcode Reader]

■Barcode reader setting
For details on the barcode reader setting, refer to the following manual.
 Manual of the barcode reader used

Precautions
■Using barcode reader connection on multiple started GT SoftGOT2000 modules
A barcode reader cannot be used by multiple started GT SoftGOT2000 modules or other applications simultaneously.
The barcode reader communicates with the GT SoftGOT2000 which first establishes the connection.

Controller Connection cable GT SoftGOT2000 Number of connectable 
devices

Barcode reader *1 Varies according to the specifications of 
the barcode reader used. *1

Windows-compatible personal 
computer
PC CPU module
MELIPC*2

1 barcode reader for 1 GT 
SoftGOT2000 module

GT SoftGOT2000

Connection cable

Barcode reader

GT SoftGOT2000
module No.1

GT SoftGOT2000
module No.2

Barcode reader 1

Connecting

Barcode reader 1

Connecting

Barcode reader 2

GT SoftGOT2000
module No.1

GT SoftGOT2000
module No.2Connection with the second barcode reader enabled

Connection 
not enabled

1) Example of connection failure 
    with two modules started

2) Example of succeeded connection 
    with two modules started
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USB connection

System configuration

*1 For connectable bar code readers, system equipment, available bar code types and connection cables, refer to the following Technical 
News.
List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
For Technical News, contact your local distributor.

Controller setting
■Setting on GT SoftGOT2000
A USB barcode reader can be used by enabling the keyboard input function.
For the details of the settings, refer to the following.
Page 583 Keyboard Input

■Barcode reader setting
For details on the barcode reader setting, refer to the following manual.
 Manual of the barcode reader used

Precautions
■Restriction on using the USB barcode reader
A USB barcode reader can be used only for the text input and the numerical input.
To use the barcode function, connect the barcode reader to the RS-232 interface.
Page 568 Serial connection

Controller Connection cable GT SoftGOT2000 Number of connectable 
devices

Barcode reader *1 Varies according to the specifications of 
the barcode reader used. *1

Windows-compatible personal 
computer
PC CPU module
MELIPC

1 barcode reader for 1 GT 
SoftGOT2000 module

Connection cable

Barcode reader GT SoftGOT2000
3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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3.35 RFID Connection
System configurations

*1 For connectable RFID controllers, system equipment, and connection cables, refer to the following Technical News.
List of Valid Devices Applicable for GOT2000 Series and GOT SIMPLE Series (for Overseas) (GOT-A-0160)
For Technical News, contact your local distributor.

*2 To establish connection via RS-232, assign the RS-232 port on a MELIPC to the Windows part.

Controller setting

RFID function setting on GT Designer3
Before connecting the RFID controller, make the RFID function and system data settings.
For details, refer to the following manual.
 GT Designer3 (GOT2000) Screen Design Manual

Setting on GT SoftGOT2000
Set the [Communication Setup] dialog of GT SoftGOT2000.
For details on the [Communication Setup] dialog, refer to the following manual.
Page 100 [RFID]

RFID controller setting
For details on the RFID controller setting, refer to the following manual.
 Manual of the RFID controller used

Controller Connection cable GT SoftGOT2000 Number of connectable 
devices

RFID controller *1 Varies according to the specifications of 
the RFID controller used. *1

Windows-compatible personal 
computer
PC CPU module
MELIPC*2

1 RFID controller for 1 GT 
SoftGOT2000 module

GT SoftGOT2000

Connection cable

RFID 
controller
0 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
3.35  RFID Connection
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Precautions

Using RFID connection on multiple started GT SoftGOT2000 modules
An RFID controller cannot be used by multiple started GT SoftGOT2000 modules or other applications simultaneously.
The RFID controller communicates with the GT SoftGOT2000 which first establishes the connection.

RFID controller 1 RFID controller 1

RFID controller 2

1) Example of connection failure 
    with two modules started

2) Example of succeeded connection 
    with two modules started

Connecting

GT SoftGOT2000
module No.1

GT SoftGOT2000
module No.2

Connection with the second RFID controller enabled

GT SoftGOT2000
module No.1

GT SoftGOT2000
module No.2

Connecting

Connection 
not enabled
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3.36 Sound Output Device Connection
System configurations

*1 If your personal computer has no sound function, use a sound card.

Controller setting

Sound output function setting on GT Designer3
Before connecting the sound output, make the sound output function settings.
For details, refer to the following manual.
 GT Designer3 (GOT2000) Screen Design Manual

Controller Connection cable GT SoftGOT2000
Speaker built in a personal computer and 
external speaker *1

Varies according to the specifications of the external 
speaker used.

Windows-compatible personal computer

Speaker

Varies according to 
the specifications of the speaker used.

Connection cable

GT SoftGOT2000
2 3  CONNECTION BETWEEN GT SoftGOT2000 AND DEVICES
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4 FUNCTIONS OF GT SoftGOT2000
Page 574 Snap Shot
Page 575 Print
Page 577 License Registration Information
Page 578 Property
Page 579 Resource Data
Page 581 Displaying File Information in PLC
Page 583 Keyboard Input
Page 586 Popup Menu
Page 587 Script Error Information
Page 588 Object Script Error Information
Page 589 Importing and Exporting the Settings
Page 597 Application Start-up
Page 608 Mail Send Function
Page 614 SoftGOT-GOT Link Function
Page 658 Interaction with PX Developer
Page 665 Edgecross Interaction Function
Page 670 Full Screen Mode
Page 675 Close Menu
Page 676 Back Screen Mode
Page 677 Enabling or Disabling the Exit Key
Page 678 Scroll Function
Page 679 Moving the Window
Page 684 Monitor-only Mode
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4.1 Snap Shot
The screen image being monitored is saved into BMP or JPEG format file.

1. Perform the following operation.
Select [Project] → [Snap Shot...] from the menu.

2. The [save as] dialog is displayed.
Set the following items and click the [Save] button.

Item Description
[Save in] Selects the area where the file is saved.

[File name] Selects the file name to be saved.

[Save as type] Selects a format of the file.
• [Bitmap Files (*.bmp) ]: BMP format
• [JPEG Files (*.jpg) ]    : JPEG format-
4 4  FUNCTIONS OF GT SoftGOT2000
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4.2 Print
The screen image being monitored is output to a printer.

Printing
1. Perform the following operation.
Select [Project] → [Print...] from the menu.

2. The [Print] dialog of Windows is displayed.
Click the [OK] button to start printing.

Displaying the print preview
1. Perform the following operation.
Select [Project] → [Print Preview] from the menu.

2. The print preview is displayed.

Precautions for using the print preview
The print preview of the GT SoftGOT2000 screen may look smaller than the actual GT SoftGOT2000 screen 
depending on the paper type or size, and the screen resolution.
Therefore, what is printed may not match the print preview.
Check what has been printed.
4  FUNCTIONS OF GT SoftGOT2000
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Performing page setup
1. Perform the following operation.
Select [Project] → [Page Setup] from the menu.

2. The [Page Setup] dialog is displayed.
Set the following items and click the [OK] button.

Performing print setup
1. Perform the following operation.
Select [Project] → [Print Setup] from the menu.

2. The [Print Setup] dialog of Windows is displayed.

3. Configure the print settings (such as selecting a printer, paper size, and orientation), and then click the [OK] button.

 • Precautions for the printer used
Each GT SoftGOT2000 module has its own print settings.
However, when you perform one of the following operations, the printer selected for [Set as default printer] in 
Windows is specified.
Deleting the selected printer
Selecting a printer whose name contains 31 characters or more
 • Precautions for the print settings
Depending on the printer used, some print settings are not retained.

Item Description
[Margin] Set the margins on a page to be printed.

[Reverse screen image] Select this item to reverse the colors of screen image when printing.

[Reverse Mode] Set the reverse mode for screen image.
• [Color]                   : Reverse all the colors of screen image to be printed.
• [Black and White]  : Reverse the black and white colors of screen image to be printed.
6 4  FUNCTIONS OF GT SoftGOT2000
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4.3 License Registration Information
Displays the license registration status of the GOT Mobile function.

1. Perform the following operations.
Select [Project] → [License Registration Information] from the menu.

2. The [License Registration Information] dialog appears.

Item Description
License registration status When the license is registered, [License registered] is displayed.

[Product ID] When the license is registered, the product ID is displayed.

When the license is not registered When the license is registered

License registration status
4  FUNCTIONS OF GT SoftGOT2000
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4.4 Property
The project title, project ID and data size of project data being monitored are displayed.

1. Perform the following operation.
Select [Project] → [Properties...] from the menu.

2. The [Properties] dialog is displayed.

When the [Properties] dialog is displayed before starting monitoring
When the [Properties] dialog is displayed before starting monitoring, the [Project Data Path], [Project Title], 
[Project ID] and [Data Size] of project data monitored previously are displayed.
(If project data has not been loaded, the [Project Data Path], [Project Title], [Project ID] and [Data Size] are not 
displayed.)

Item Description
[Project Data Path] Displays the path of the read project data.

[Project Title] Displays the project title.

[Project ID] Displays the project ID.

[Data Size] Displays the data size of project data.
8 4  FUNCTIONS OF GT SoftGOT2000
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4.5 Resource Data
The following data saved in the personal computer can be referenced.
Alarm log
Recipe
Data log
Operation log
Image file (Hard copy and etc)

1. Perform the following operation.
Select [Tool] → [Resouce Data] from the menu.
Right-click the mouse to select [Tool] → [Resource Data].

2. The [Refer To Resource Data] dialog is displayed.

Item Description
[Look in] Selects the location to which the resource data is stored.

[File name] Specifies the file to be read.

[Files of type] Selects the file format of the resource data.
• [CSV Files (*.csv)] : CSV format
• [Unicode Text Files (*.txt)] : Unicode text file format
• [Bitmap Files (*.bmp)] : BMP format
• [JPEG Files (*.jpg)] : JPEG format
4  FUNCTIONS OF GT SoftGOT2000
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Resource data
The black and white inversion is not available for image files of the hard copy function.
Data cannot be updated while being referenced. (The data is held.)
(The held data is reflected when the print data is updated after the data reference is over.)
When creating a table in the report function, create the table as shown in example 1.
A table as shown in example 2 cannot be properly displayed in a CSV file.

When outputting the characters specified with a text print object by using the report function, store the 
characters in the specified devices according to the setting of [Display in order of High -> Low].
If the characters are not stored in the specified byte order, the characters are displayed incorrectly in the 
output CSV file.
If the [Fail in the start of application.] message is displayed during data reference, check the application 
relating setting or hard disk/memory capacity.

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

A B
X

Y

1 2

3 4

 Table created with 
 GT Designer3 CSV file table

CSV file table
(Example 2) Table created with
                    GT Designer3

(Example 1)
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4.6 Displaying File Information in PLC
GT SoftGOT2000 displays the file information in the connected PLC (QCPU or QSCPU).
This function is supported by GT SoftGOT2000 (Single channel) only.

 • Requirements to display file information
The file information is displayed when the host station is set to a MITSUBISHI ELECTRIC PLC (QCPU or 
QSCPU) and GT SoftGOT2000 is in the online mode after monitoring is started.
 • Displaying the dialog by using the GOT special register (GS device)
Turning on the PLC file display signal (GS500.b2) displays the [File Information in PLC] dialog.

Setting method
1. Perform either of the following operations.
Select [Tool] → [File Information in PLC] from the menu.
Right-click the mouse and select [Tool] → [File Information in PLC] from the menu.

2. The [File Information in PLC] dialog is displayed.
Set the connection setup by referring to the table on the next page, and then click the [Connection] button.

3. With successful communication, the PLC CPU model, the default target memory ([Program memory/Device memory]), 
and the file information in the memory are displayed.

4. To display file information in a memory other than the program memory/device memory, change the target memory.
4  FUNCTIONS OF GT SoftGOT2000
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Precautions for use

Communication processing of monitor screen while file information is displayed
Displaying file information in the PLC interrupts communication processing of the monitor screen.
Therefore, communication processing of the monitor screen takes more time.

When connecting to redundant system
Even if system switching occurs, the currently displayed file list is not updated.
To display the file information in the new monitor target, set the connection setup and click the [Connection] button again.

Updating read information
Even if the program and others are updated on the PLC side while the File Information in PLC dialog is displayed, the 
currently displayed file list is not updated.
To display the latest file information, click the [Connection] button again to update the displayed information.

Item Description
[Connection Setup] Set the connected station to the host station or another station.

(The default is [Host].)

[Host] Check this item to set the connected station to the host station.

[Other] Check this item to set the connected station to another station.

[NET No.] When the connected station is set to another station, set the network No. of the PLC that has the file information to be 
displayed.
[0] to [239]                                                                                                                                                 (The default is [1].)

[Station number] When the connected station is set to another station, set the station No. of the PLC that has the file information to be 
displayed.
[1] to [255]                                                                                                                                                 (The default is [1].)

[CPU No.] Select the target CPU No.
[0] to [4]                                                                                                                                                     (The default is [0].)

[PLC Information] Displays the file information in the target PLC CPU.

[Target] Select the PLC CPU memory that has files to be displayed on the GOT.
[Program memory/Device memory], [Memory card(RAM)], [Memory card(ROM)], [Standard RAM], [Standard ROM]
(The default is [Program memory/Device memory].)

[PLC Type] Displays the target PLC CPU model.

[Name] Displays the names of the files.

[Type] Displays the types of the files.
(The files are displayed in the order of type priorities starting from the left as shown below.)
[Program], [Device comment], [Parameter], [Device init], [File register]

[Title] Displays the titles of the files.

[Date] Displays the last modified dates of the files.

[Time] Displays the last modified time of the files.

[Size] Displays the sizes of the files.
2 4  FUNCTIONS OF GT SoftGOT2000
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4.7 Keyboard Input
The following can be operated using the keyboard input function.
Inputting text or a value on the numerical input object or text input object by operating a keyboard or a USB barcode reader
Operations, including displaying a ladder with the alarm display, can be operated with function keys of a keyboard.

Keyboard input enabling/disabling procedure
1. When switching the keyboard input enable/disable, perform the following operation.

Click  [Keyboard].
Select [Set] → [Keyboard] from the menu.
Right-click the mouse to select [Set] → [Keyboard] from the menu.

Operations on numerical and text input objects

Keyboard
Text or numerical values can be input using the keyboard of the personal computer when numerical input objects or text input 
objects are used.
The following lists the operation when each key is pressed.

*1 The operation on the target object varies depending on the setting in the [Environmental Setting] window ([Key Windows]) on GT 
Designer3.
For the details, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Keyboard operation GOT key code Operation on the numerical input Operation on the text input
[Back space] 0008h Delete the character on the cursor.

[Enter] *1 000Dh Write the entry to a specified device, display the cursor on the target object, move the cursor to 
a different object, or close the key window.

[Esc] 001Bh Cancel the entry.

[-] (Hyphen) 002Dh Reverse the sign of the value. –

[.] (Period) 002Eh Enter a decimal point. –

[0] to [9] 0030h to 0039h Enter a numeric character. Enter a character. (ASCII or Unicode 2.1-
compatible)[A] to [Z], [a] to [z] 0041h to 005Ah, 0061h to 

007Ah
Enter a numeric character in hexadecimal ([A] 
to [F], [a] to [f]).

Symbol keys Character codes (ASCII) –

Enter text (such as hiragana 
or kanji characters).

Character codes (Unicode) – Enter text. (Unicode 2.1-compatible)

[→], [←], [↑], [↓] 0080h, 0081h, 0082h, 0083h Move the cursor to a different object.

[Home] 0084h – Convert the entry to kanji characters.

[Page Up] 0085h – Select the previous candidate.

[Page Down] 0086h – Select the next candidate.

[End] 0087h – Confirm the entry, or select the next group of 
hiragana characters to be converted to kanji 
characters.

[Delete] 0088h Delete all the entered characters.

[Ctrl]+[←], [Ctrl]+[→] 0090h, 0091h Move the cursor on the target object.

[Ctrl]+[↑], [Ctrl]+[↓] FFFAh, FFFBh Increment or decrement the value. –
4  FUNCTIONS OF GT SoftGOT2000
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USB barcode reader
If numerical input objects or text input objects are used, a USB barcode reader can be used as a keyboard to input text or 
numerical values.
For the details of the USB barcode reader, refer to the following.
Page 569 USB connection
With a USB barcode reader, you can input a key code to an object or a key window, move the cursor, delete text, and 
determine or cancel an input value.
For the details of the settings, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

How to use function keys
With assigning key codes to the following function keys, objects, including the alarm history, can be operated with a keyboard.
F1 to F8
Shift + F1 to F8
Ctrl + F1 to F8
Ctrl + Shift + F1 to F8

How to assign key codes
Key codes are assigned in the OperationPanel screen on GT Designer3.
For settings in the OperationPanel dialog, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual

Assign key codes to Shift + Ctrl + F1 to F8.

Assign key codes to Ctrl + F1 to F8.

Assign key codes to Shift + F1 to F8.

Assign key codes to F1 to F8.

F1
F2
F3
F4
F5
F6
F7
F8
4 4  FUNCTIONS OF GT SoftGOT2000
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Precautions

When displaying a window screen on a base screen
When displaying a window screen on a base screen, and the alarm list display function or the alarm history display function 
has been set up on both the screens, key input is enabled for the alarm list display function or the alarm history display 
function on the base screen.

When a touch switch to which the simultaneous press disable setting has been made is 
ON
The touch switch will not operate when pressing a key in the case the simultaneous press disable setting has been made to 
the touch switch and the touch switch is ON.

Precautions on screen saving
When the screen save is set on GT SoftGOT2000, the monitor screen does not turn black as GOT even though the screen 
save operates. (The monitor screen keeps the same screen as before setting the screen save.)
The first input operation (touch, mouse, or keyboard) while GT SoftGOT2000 is in screen saver mode is not recognized as an 
input because the input is recognized as clearing the screen saver mode.
Be sure not to make inputs incorrectly when canceling the screen saves.
The GT SoftGOT2000 screen save and Windows screen save are different functions.
If the GT SoftGOT2000 screen save and Windows screen save are being active, it is required to cancel the respective screen 
saves.

Keyboard inputs
The keyboard input function is not compatible with the utility screen.
Operate the utility screen with the mouse.
Do not use software keyboards (keyboard applications).

Precautions for function keys
Function keys cannot be used during clicking the mouse.
For an input with a function key, the input is executed when the function key is released.
As a result, operations are not correctly executed even though the following are set on GT Designer3.
Setting [Operation Timing] of [Action of Go To Screen Switch] in [Screen Switching/Window] of [Environmental Setting].
Setting [Momentary] for the action of the bit in the [Action] tab of the Edit Action/Key Code screen for the operation panel 
setting
Setting [Auto Repeat] in the [Trigger] tab of the Edit Action/Key Code screen for the operation panel setting
When input methods, including IME of Windows, are enabled, inputs with function keys cannot be executed.
For inputs with function keys, disable input methods, including IME of Windows.
4  FUNCTIONS OF GT SoftGOT2000
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4.8 Popup Menu
The right-click of the mouse can be disabled (the menu can be hidden).
When the Popupmenu is set to be disabled, the menu is not displayed if you right-click the mouse.
This setting is also enabled when you exit and then restart GT SoftGOT2000.

Popup menu effective/ineffective
1. Perform the following operation.
Select [Set] → [Popup Menu] from the menu.
Right-click the mouse to select [Set] → [Popup Menu] from the menu.

2. The right-click of the mouse is disabled.

3. When you want to enable the right-click of the mouse again, choose [Set] - [Popup Menu].

Precautions
When the full screen mode and Popupmenu disable are set, the operations of the menu bar and mouse right-click menu 
cannot be performed.
Therefore, the pop-up menu cannot be enabled until the full screen mode is canceled.
When you want to enable the pop-up menu, cancel the full screen mode in the following method.

When the keyword of the full screen mode was added to the property of the GT 
SoftGOT2000 icon.
After exiting GT SoftGOT2000 (pressing the [F12] key or turning ON the GOT internal device GS500.b0), delete the added 
keyword.

When the full screen mode was executed from the menu.
As the full screen mode is canceled by pressing the [Alt] + [F9] key, enable the Popupmenu from the menu.
6 4  FUNCTIONS OF GT SoftGOT2000
4.8  Popup Menu



4

4.9 Script Error Information
Monitor the execution status of a script (Error Information) to display the current status.

1. Perform the following operation.
Select [Tool] → [Script Error] menu.
Right-click the mouse to select [Tool] → [Script Error] from the menu.

2. The [Script Error Info.] dialog is displayed.

*1 Refer to the following manual for script function.
 GT Designer3 (GOT2000) Screen Design Manual

Item Description
[Script No.] *1 Script No. where error occurs is displayed.

[Error No.] Error code of occurring error is displayed.

[Error Message] Error contents are displayed.

[Retry] Retries the script.
If a screen in which no scrip runs is displayed, the retry is not performed.

[Clear] Clears the displayed error message by performing the following.
If a screen in which no scrip runs is displayed, the retry is not performed.
• GS14.b0, b7, b8, and b12 store 0
• GS15 stores -1
• GS16 to GS47 store 0

For the details of the GOT internal devices, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual
When the error has not been cleared, the error message is displayed again.

[Close] The dialog is closed.
4  FUNCTIONS OF GT SoftGOT2000
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4.10 Object Script Error Information
Monitor the execution status of an object script (Error Information) to display the current status.

1. Perform the following operation.
Select [Tool] → [Object Script Error] from the menu.
Right-click the mouse to select [Tool] → [Object Script Error] from the menu.

2. The [Object Script Error Info.] dialog is displayed.

*1 Refer to the following manual for object script function and corrective actions for error messages.
GT Designer3 (GOT2000) Screen Design Manual

Item Description
[Script number] *1 User ID of the object script where error occurs is displayed.

[Error No.] Error code of occurring error is displayed.

[Error Message] Error contents are displayed.

[Retry] Retries the object script.
If a screen in which no scrip runs is displayed, the retry is not performed.

[Clear] Clears the displayed error message by performing the following.
If a screen in which no scrip runs is displayed, the retry is not performed.
• GS80.b0, b7, b8, and b12 store 0
• GS81 stores -1
• GS82 to GS113 store 0

For the details of the GOT internal devices, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual
When the error has not been cleared, the error message is displayed again.

[Close] The dialog is closed.
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4.11 Importing and Exporting the Settings
This function is used to import and export the settings of GT SoftGOT2000as a setting file (.SGTS).
Settings can be backed up per module number, restored when an error occurs, or imported to another module.
By importing the settings to GT SoftGOT2000 in another personal computer, the same system as the import source can be 
configured.

Importable and exportable settings
The following shows importable and exportable settings of GT SoftGOT2000.
For details on each setting menu, refer to the following.
Page 64 Menu Bar

○: Available, -: Not available

Menu Availability
[Project] [Open] [Open a Project] -

[Open a File] -

[Snap Shot] -

[Print Setup] ○

[Page Setup] ○

[Print Preview] -

[Print] ○*1

[Properties] -

[License Registration Information] -

[Exit] -

[View] [Toolbar] ○

[Status Bar] ○

[Scroll Bar] ○

[Full Screen Mode] ○

[Back Screen Mode] ○

[Switch Display Langage] -

GT SoftGOT2000

Setting file (.SGTS)

GT SoftGOT2000
Export
(Backup of the settings)

Import
(Import of the settings)
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*1 [Print to file] and [Print range] in the [Print] dialog are not available.
*2 [Display the start-up selection dialog (GT SoftGOT2000 Start-up) when starting GT SoftGOT2000] in the [Environment Setup] dialog 

([Auxiliary Setup] tab) is not available.
*3 It is recommended to perform export with this setting disabled.

For the details, refer to the following.
Page 596 Export of the startup in online mode setting

*4 When [Connection] in the [Communication Setup] dialog ([Connection Setup] tab) is set to [OPC], [Step1: Access destination device 
setting] and [Step2: Client certificate setting] are not available.

[Set] [Environment Setup] ○*2

[Mail Setup] [Mail Setup] ○

[Mail Condition] ○

[Mail History] -

[Application Setup] [Application Start-up Setting] ○

[Application Start-up History] -

[PX Developer Function Setting] [PX Developer Function Call Setting] -

[PX Developer Function Call Sub-Setting] ○

[PX Developer Function Call History] -

[SoftGOT-GOT Link Function Setting] ○

[Edgecross Interaction Function Setting] ○

[Keyboard] ○

[Monitor-only Mode] ○

[Popup Menu] ○

[Close Menu] ○

[Exit Key [F12]] ○

[Online] [Monitor Start] -

[Monitor Stop] -

[Startup in Online Mode] ○*3

[Comm. Error Dialog] ○

[Communication Setup] ○*4

[Tool] [Resource Data] -

[File Information in PLC] ○

[SoftGOT-GOT Link Function] [GOT Project Data Acquisition] -

[Resource Data Upload Status] -

[Script Error] -

[Object Script Error] -

[Import] -

[Export] -

[Window] [Cascade] -

[Minimize All Windows] -

[Move Window] -

[Move to Start-up Display Position] -

[Move to Previous Display] -

[Move to Next Display] -

Move to Display □ -

[Help] [GT SoftGOT2000 Help] -

[Manual List] -

[Connection to MITSUBISHI ELECTRIC FA Global Website] -

[About GT SoftGOT2000] -

Menu Availability
0 4  FUNCTIONS OF GT SoftGOT2000
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Import and export procedure

Import procedure
1. Store the setting file (.SGTS) to be imported to a folder.

2. Perform one of the following operations to display the [Import/Export Setting] dialog.
 • Click the [Import/Export Setting] button in the [GT SoftGOT2000 Start-up] dialog.
 • Select [Tool] → [Import] from the menu.

3. Set the storage folder of the setting files to be imported to [Folder path] and click the [Read import files] button to list the 
setting files in the specified folder.

4. Select the checkbox of the setting file to be imported in the [Target] column, and set [Destination module No.] and [Import 
source file name].

Click the [Execute import] button to import the setting file.

5. The imported settings are applied to the applicable GT SoftGOT2000 module at its next startup.

Setting file list
4  FUNCTIONS OF GT SoftGOT2000
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Export procedure
1. Perform one of the following operations to display the [Import/Export Setting] dialog.
 • Click the [Import/Export Setting] button in the [GT SoftGOT2000 Start-up] dialog.
 • Select [Tool] → [Export] from the menu.

2. Set the path to the storage folder of the setting file to be exported to [Folder path].

3. In the setting file list, select the checkbox of the setting file to be exported in the [Target] column. Rename the file if 
desired.

Click the [Execute export] button to export the setting file.

Setting file list
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[Import/Export Setting] dialog
1. Perform one of the following operations.
 • Click the [Import/Export Setting] button in the [GT SoftGOT2000 Start-up] dialog.
 • Select [Tool] → [Import] from the menu.
 • Select [Tool] → [Export] from the menu.

2. The [Import/Export Setting] dialog is displayed. Refer to the following description to configure the settings.

[Import] tab

*1 The following shows the error causes and corrective actions.

Item Description
[Folder path] Set the path to the folder that stores the setting file to be imported by directly entering the path (170 

characters max.) or clicking the [...] button.

[Read import files] button Displays the setting files stored in the folder specified in [Folder path] in the setting file list.

[Target] Select the checkbox of the setting file to enable import.
Up to 30 setting files can be imported at a time.

[Destination module No.] Set the module number of the setting file import destination.
The setting range is [1] to [32767].

[Import source file name] Select the setting file to be imported.

[Result] Displays the import result.

[Error code] Displays the error code if the [Result] is [Failed] or [Warning].*1

[Select All] button Enables import of all the setting files.

[Deselect All] button Disables import of all the setting files.

[Copy] button Copies the selected row and pastes it to the new row in the bottom of the list.

[Delete] button Deletes the selected row.

[Execute import] button Imports the setting file with the settings configured in the setting file list.
The import result is displayed in the [Result] and [Error code].

[Result] [Error code] Error cause Corrective action
[Warning] 0x01 The version of GT SoftGOT2000 in the setting file 

import destination is older than that in the import 
source.

Install the latest version of GT SoftGOT2000, and then 
import the setting file.
When performing import to GT SoftGOT2000 old 
version, display the setting dialog of the imported 
setting file, check the setting details, and click the [OK] 
button after the import.
Then, validate the operation of GT SoftGOT2000.
For the settings to be imported, refer to the following.
Page 589 Importable and exportable settings

Setting file list
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[Export] tab

[Failed] 0x80 A file access error. Perform the following.
• Wait for some time, and then click the [Execute 

import] button again.
• Restart the personal computer.
• Stop the real-time monitoring of the anti-virus 

software, and click the [Execute import] button 
again.

[Failed] 0x81 The setting file is corrupt. Export the setting file again.

The setting file cannot be accessed. Check the access privilege for the setting file.

[Failed] 0x82 The setting file for which import is enabled in the 
setting file list does not exist in the folder specified in 
[Folder Path].

Check the folder specified in [Folder Path].

Item Description
[Folder path] Set the path to the setting file to be exported by directly entering the path (170 characters max.) or 

clicking the [...] button.

[Target] Selecting the checkbox enables export of the settings of the module with the selected module number.
Up to 30 setting files can be exported at a time.

[Module No.] Module number to be exported

[File Name] Set the name of the setting file to be exported.
Up to 120 characters can be used to name the setting file.
The following characters cannot be used for the setting file name.
\ / : * ? " < > |

[Select All] button Enables export of all the modules in the list.

[Deselect All] button Disables export of all the modules in the list.

[Execute export] button Exports the setting file with the settings configured in the setting file list.

[Result] [Error code] Error cause Corrective action

Setting file list
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Precautions

Different module numbers between the setting file import source and import 
destination
Check that the settings of the import destination (virtual drive) are configured as intended.
A folder created for each module number is handled as a virtual drive. If module numbers differ between the import source 
and import destination, the settings of the import destination (virtual drive) may not be configured as intended.
For details on virtual drives, refer to the following.
Page 68 [Environment Setup] dialog

Different personal computers used between the setting file import source and import 
destination
GT SoftGOT2000 may operate differently in the import source and import destination depending on the environment and 
settings of the personal computer used.
Check that the following settings are enabled in the import destination.

Different personal computer OSs used between the setting file import source and 
import destination
GT SoftGOT2000 may operate differently in the import source and import destination because supported functions differ by 
OS.
Check that the following settings are set as intended.
 • [Environment Setup] dialog ([Display Setup] tab)
Page 70 [Display Setup] tab
 • [Environment Setup] dialog ([Touch Operation Setup] tab)
Page 73 [Touch Operation Setup] tab

Dialog name Setting item Setting item display method Reference
[Environment Setup] dialog ([Action 
Setup] tab)

[Virtual Drive Setting] - Page 68 [Action Setup] tab

[Communication Setup] dialog 
([Connection Setup] tab)

[Comm. Port] • Select [RS232] or [C24] for 
[Connection].

• Select [Use Bar Code].
• Select [Use RFID].

Page 76 [Communication Setup] 
dialog ([Connection Setup] tab)

[Port No.] Select [Ethernet] or [MELIPC Direct] 
for [Connection].

[Type] Select [NET/H], [CC IE Control], or 
[CC IE Field] for [Connection].

[GX Developer Project] Select [GX Simulator] for 
[Connection].

[Project Name] Select [GX Simulator2] or [GX 
Simulator2/MT Simulator2] for 
[Connection].

[Connection Destination URL] Select [MELSOFT Mirror] for 
[Connection]

[Communication Setup] dialog 
([Gateway Server Function Setting] tab)

[IP Address] - Page 102 [Communication 
Setup] dialog ([Gateway Server 
Function Setting] tab)

[Print Setup] dialog [Name] - Page 576 Performing print setup

[Application Start-up Setting] dialog 
([APP Setup 1] and [APP Setup 2] tabs)

[File Name] - Page 598 [APP Setup 1] and 
[APP Setup 2] tabs[Option] -

[Application Start-up Setting] dialog 
([Advanced APP Setup] tab)

Advanced APP setup file to be set in 
[Advanced APP Setup]

- Page 601 [Advanced APP 
Setup] tab

[Edgecross Interaction Function Setting] 
dialog

Edgecross interaction configuration 
file to be set in [Allocation Setting]

- Page 669 Settings on GT 
SoftGOT2000
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Different languages used between the GT SoftGOT2000 installer and OS of the personal 
computer
Import or export a setting file under the condition that the languages are the same between the GT SoftGOT2000 installer and 
the OS of the personal computer.
If the languages differ, GT SoftGOT2000 may not operate properly.

Different languages used between the import source GT SoftGOT2000 installer and the 
import destination GT SoftGOT2000 installer
If the languages differ between the import source GT SoftGOT2000 installer and the import destination GT SoftGOT2000 
installer, the following settings will be changed to the default values in the import destination GT SoftGOT2000.
 • [Application Start-up Setting] dialog ([Advanced APP Setup] tab)
Page 601 [Advanced APP Setup] tab
 • [Mail Setup] dialog
Page 609 Mail setup

Version of GT SoftGOT2000 older in the import destination than in the import source
If the version of GT SoftGOT2000 in the import destination is older than the version of the software in the import source, the 
software may not operate properly.
Install the latest version of GT SoftGOT2000, and then import the setting file.
When performing import to GT SoftGOT2000 old version, display the setting dialog of the imported setting file, check the 
setting details, and click the [OK] button after the import.
Then, validate the operation of GT SoftGOT2000.
For the settings to be imported, refer to the following.
Page 589 Importable and exportable settings

Export of the startup in online mode setting
It is recommended to disable the startup in online mode before exporting a setting file.
When a setting file for which the startup in online mode is enabled is imported, monitoring starts automatically at GT 
SoftGOT2000 startup in the import destination. You cannot check the imported settings in advance.

Language of the personal computer OS: English
Language of the GT SoftGOT2000 installer: English

Personal computer A

Language of the personal computer OS: English
Language of the GT SoftGOT2000 installer: English

Personal computer B

Language of the personal computer OS: Japanese
Language of the GT SoftGOT2000 installer: English

Personal computer C
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4.12 Application Start-up
Various applications (such as Microsoft Excel) can be started from GT SoftGOT2000GOT2000 while GT SoftGOT2000 
monitor is running.
A file to be started up can be specified.
This allows reference to the resource data of each function in CSV or BMP format.

An application can be started up by clicking a touch switch, for example.

Trigger and setting points of application start-up
For the application start-up, GOT internal devices are used as a trigger to start applications.
Set the trigger in the [APP Setup 1]/[APP Setup 2]/[Advanced APP Setup] tabs of the [Application Start-up Setting] dialog.
The following shows the GOT internal devices to be used in each tab and the number of applications whose start-up setting 
can be set.

For details of GOT internal devices and the method of device settings, refer to the following manual.
 GT Designer3 (GOT2000) Screen Design Manual

Tab Description Reference
[APP Setup 1] Up to 16 applications can be allotted for the device GS501. Page 598 [APP Setup 1] and [APP Setup 2] tabs

[APP Setup 2] Up to 16 applications can be allotted for the device GS502.

[Advanced APP Setup] Up to 8160 applications can be allotted for the devices GS505 
to GS507.

Page 601 [Advanced APP Setup] tab
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Setting method
1. Follow the procedure below.
Select [Set] → [Application Start-up Setting] from the menu.
Right-click the mouse, and select [Set] → [Application Start-up Setting] from the menu.

2. The [Application Start-up Setting] dialog is displayed.
Make the settings referring to the explanation below.

[APP Setup 1] and [APP Setup 2] tabs

Item Description
[Application to be allotted to the device [GS501]]
[Application to be allotted to the device [GS502]]

Specify an application to be allotted to the bit of device GS501 or GS502.Up to 32 applications can be 
allotted.
Applications allotted start up when these bits turn ON.
The bits which were turned ON will automatically turn OFF after the application is started up.
8 4  FUNCTIONS OF GT SoftGOT2000
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[File Name] Specify the path to the application to be started up by typing (Up to 1023 characters can be entered.) or 
clicking  .
Available file extensions are as follows:
* .exe, * .com, * .bat
Numeric characters, A to Z, a to z, one-byte spaces, and the following symbols are usable.
!#$%&'()-^@[;],.=~`{+}_

[Option setting specification 
method]

Select how to specify option settings at application startup.
• [Fixed option]: Specify option settings with character strings.
• [Internal device]: Specify option settings with character strings or numerical values stored in the GOT 

internal devices or SoftGOT2000 internal devices.

[Option] By specifying a file name, the specified file is opened simultaneously with start-up of the application.
Also, the mode or processing of the application can be specified by specifying options for the 
application.
Available options and characters differ depending on the application to be used.
For options available for each application, refer to the manual or Help of the application to be used.
The setting method depends on the selection for [Option setting specification method].
• When [Fixed option] is selected

Set a character string to specify the option setting.
Up to 1023 characters can be entered.
• When [Internal device] is selected

Set the start device number of the GOT internal devices (GB or GD) or SoftGOT2000 internal devices 
(SGB or SGD) to specify option settings.
Option settings are enabled according to the values stored in the internal devices.

[Data format] Set this item when [Option setting specification method] is [Internal device].
Select the data type of the values stored in the internal devices.
The following shows selectable items.
• [Character string]: The values stored in the internal devices are handled as character strings.

Unicode is supported.
Data will be read from the specified devices starting from the higher-order bits.
NULL (0x00) is supported as the termination character.
Up to 1023 characters except the termination character can be entered.
• [Numerical value]: The values stored in the internal devices are handled as numerical values.

The setting range is 0 to 65535.
Values are read as a decimal number.

[Test] Click this button to check if the set application operates normally.
Before executing monitoring with the GT SoftGOT2000, click this button to confirm the normal operation 
of the set application.

Item Description
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■Using environment variables
Using the environment variables (Path) provided by Windows, paths no longer need to be set each time.
For details of environment variables, refer to the manual or Help of Windows.
The following shows an example setting of environment variables.

1. In the Windows Control Panel, select [System and Security] → [System] to display the [System] window.

2. Select [Advanced system settings] to display the [System Properties] dialog.

3. In the [Advanced] tab, click the [Environment Variables] button to display the [Environment Variables] dialog.

4. In [Environment Variables], select [Path] and click the [Edit] button to display the [Edit environment variable] dialog.

5. Click the [New] button, and add a path containing an executable file to the variable value.
(To set multiple paths, place ; (semi-colon) between paths.)
Example) C:\Program Files\MyProgram

Select [Path]

4)
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[Advanced APP Setup] tab

 • Creation and storage destination of Advanced APP setup file
When GT SoftGOT2000 is started, an Advanced APP setup file (AppStartSet.csv) is created for each module.
Example) Path of the Advanced APP setup file when starting the module No.1.
C:\Program Files\MELSOFT\SGT2000\Multi\00001\AppStartSet.csv
The advanced application setting can be changed by editing the Advanced APP setup file directly.
 • Setting check
The setting check may take few minutes according to the file size of the Advanced APP setup file 
(AppStartSet.csv).
Click [No] in the confirmation dialog when not executing the setting check.
Returns to the [Advanced APP Setup] tab.

Item Description
[Advanced APP Setup] Click this item to open the Advanced APP setup file (AppStartSet.csv).

Use the program for opening CSV files, which is set in the personal computer, to open the Advanced APP setup file.
Allot GOT internal devices and applications in the Advanced APP setup file.
Page 602 Advanced application settings
Page 602 Setting method of Advanced APP setup file
Page 603 Precautions for advanced application settings

[Check] Click this item to check the setting contents of the Advanced APP setup file (AppStartSet.csv).
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■Advanced application settings
In the advanced application settings, use the combination of the following two triggers for the application start-up.
Trigger 1: Values of GS505 (1 to 255)
Trigger 2: Bit ON of either GS506.b0 to b15 or GS507.b0 to b15
Up to 8160 application start-up settings can be set by the combination of Trigger 1 and Trigger 2.

The application starts when both Trigger 1 and Trigger 2 are approved.
After the application starts, 0 is stored to GS505.
Bits of Trigger 2 which were turned ON (GS506.b0 to b15 and GS507.b0 to b15) will automatically turn OFF.

■Setting method of Advanced APP setup file
In the Advanced APP setup file, rows and columns are referred to as Record and Field, respectively.
For Record, up to 8160 settings can be set by the combination of Trigger 1 and Trigger 2.
The following explains the method of setting the Advanced APP setup file in case of opening the file with Microsoft Excel.

Item Description
Record One Record is configured with Field 1 to 5.

Field 1 Set whether to enable or disable the setting of record.
• 0: Disabled
• 1: Enabled

Field 2 Set Trigger 1 to start the application.
Set the value of GS505 as Trigger 1. (1 to 255)

Field 3 Set Trigger 2 to start the application.
Set the bit position of GS506/GS507 as Trigger 2. (0 to 31)
• GS506.b0 to b15 :0 to 15
• GS507.b0 to b15 :16 to 31

Field 4 Set the path of the application to be started.
The following applications can be started.
* .exe, * .com, * .bat
Up to 1023 characters can be input.

Field 5 By specifying a file name, the specified file is opened simultaneously with start-up of the application.
Also, the mode or processing of the application can be specified by specifying options for the application.
Up to 1023 characters can be entered in [Option].
Availability of options differs depending on the application.
For options available for each application, refer to the manual or Help of the application to be used.

255 patterns

Values of GS505
1
2

255
254
253

…

×
GS506

b0 b1 b14 b15…
GS507

b0 b1 b14 b15…

Trigger 1

32 patterns

=  8160

Trigger 2

Field 1 Field 4Field 2 Field 5Field 3

Record
2 4  FUNCTIONS OF GT SoftGOT2000
4.12  Application Start-up



4

Example) When the following two records are set

In the status that 100 is stored in GS505, the application (EXCEL.EXE) set in Setting 1 starts when GS506.b15 is turned ON.
In the status that 200 is stored in GS505, the application (WINWORD.EXE) set in Setting 2 starts when GS506.b15 is turned 
ON.

■Precautions for advanced application settings
 • Settings of Field 1 to 3 which disable record
The record including Field 1 to 3 in the following status is disabled.
The value is not set.
Invalid characters are included.
A value outside of the range is set.
 • Settings of Field 4 in which an error occurs at the application startup
The record including Field 4 in the following status causes an error at the application startup.
The path is not set.
Invalid characters are included.
The specified file does not exist.
The specified file cannot be executed.
 • Settings of Field 5 in which an error occurs at the application startup
The record including Field 5 in the following status causes an error at the application startup.
A line feed is included.
 • When multiple records with the same setting exist
When multiple records have the same settings of Field 2 and 3, only the top record is valid.
 • When Field 5 does not exist
When the settings are configured correctly for Field 1 to Field 4 in the record, and when Field 5 does not exist, Field 5 is 
processed with no data.
Although Field 5 does not exist, the record is processed.
 • When the record begins with a semicolon
The record is invalid.

Item Description
Setting 1 • Trigger 1: 100

• Trigger 2: 15 (GS506.b15)
• Application to be started: EXCEL.EXE

Setting 2 • Trigger 1: 200
• Trigger 2: 15 (GS506.b15)
• Application to be started: WINWORD.EXE

Setting 1
Setting 2
4  FUNCTIONS OF GT SoftGOT2000
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[Auxiliary Setup] tab

Item Description
[Action of when startup condition satisfied] Select how the application that was started up from GT SoftGOT2000 behaves when its start-up 

condition is satisfied again.
Activate an application in motion:
Select this item to make an application that is already in motion active.
Separately start another application:
Select this item to start up the same application in addition to the one currently running.

[Exit the applications when exiting GT 
SoftGOT2000]

Check this item to terminate GT SoftGOT2000 together with applications that were started up from GT 
SoftGOT2000.
Note that applications that are started up after checking [Separately start another application] in [Action 
of when startup condition satisfied] are not terminated.

[Create application start-up history] Check this item to store a startup status of an application in a history.
Data that can be stored in a history differ by the selection made in [Action of when startup condition 
satisfied].
For details of data storable in a history, refer to the following.
Page 605 Application start-up history

[Display a dialog when application start-up error is 
detected.]

Check this item to display an error dialog when an error occurs at application start-up.
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Application start-up history
Information involving application start-ups can be stored in a history.

Information storable in a history
The following lists information storable in a history.
Successful application start-ups
Erroneous application start-ups
Activation processing of applications *1

Termination processing of applications *1

*1 This applies only for applications that are started up after [Activate an application in motion] is selected in [Action of when startup 
condition satisfied].

Referring to history data
The following explains how to refer to history data.

1. Follow the procedure below.
Select [Set] → [Application Start-up History] from the menu.
Right-click the mouse, and select [Set] → [Application Start-up History] from the menu.

2. History data are displayed.

History data
Any application start-up history cannot be referred to when no history data are stored.
To create history data, check [Create application start-up history] in the application start-up setting.
For details of the application start-up setting, refer to the following section.
Page 598 Setting method
Historical data are stored for each module as follows.
They are not deleted even when GT SoftGOT2000 is closed.
Delete unnecessary history data.

2013/08/01 19:56:26 No.1 GS501.b0 : The application has been started.
2013/08/01 20:10:30 No.1 GS501.b0 : The application has been terminated.
2013/08/01 13:51:28 No.10000 GS501.b10 : The application has been started.
2013/08/01 14:00:30 No.10000 GS501.b10 : The application has been terminated.
2013/08/01 16:47:02 No.1 GS501.b0 : The application has been started.
2013/08/01 16:57:07 No.1 GS501.b0 : The application has been activated.

MELSOFT(installation folder)

SGT2000

Multi

00001

Application start-up history data
SoftGOT_AppliLog.txt
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Precautions

Duplication of the internal devices
When setting the GOT internal devices (GB or CD) or SoftGOT2000 internal devices (SGB or SGD) in the [Application Start-
up Setting] dialog ([APP Setup 1] or [APP Setup 2] tab), do not set the internal devices that are used for other functions.
If you set the internal devices that are used for a function, the function may not operate as intended.

Operation when the data type of the internal device data is [Numerical value]
When [Data format] is [Numerical value] in the [Application Start-up Setting] dialog ([APP Setup 1] or [APP Setup 2] tab), the 
internal device stores 0 until a value is set.
Therefore, the application always starts on the assumption that an option setting is specified.
If no option setting is necessary, select [Character string] for the [Data format].

Timing for reflecting the application startup setting
When a setting is changed while GT SoftGOT2000 is operating, the setting after change is valid only for applications started 
up after the change.
For this reason, even when [Exit the applications when exiting GT SoftGOT2000.] is enabled, some applications may not be 
terminated simultaneously with termination of GT SoftGOT2000.
Example) When changed from [Activate an application in motion] to [Separately start another application]

Timing of setting 
and starting up

Images of application 
starting up

Set to [Activate an application in motion]
Set to [Separately start another application]

Start-up Start-up Start-up

Simultaneous 
termination with GT 
SoftGOT2000

Store information involving 
activation processing/ 
termination processing to the 
application start-up history

Start-up Active Active

Available

Available

Not available

The application currently 
running must be terminated 
before starting the same 
application separately.
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Example) When changed from [Separately start another application] to [Activate an application in motion]

Precautions for setting
With personal computers employing VGA (640 x 480) resolution, the Application Start-up Setting dialog cannot entirely seen 
on the screen.
Move the dialog with the mouse to make settings, or employ resolutions of SVGA (800 x 600) or higher to the display.

Precautions for creating application start-up history data
If an application fails to start up, the error dialog is displayed.
The application cannot be restarted in this state.
Close the error dialog before starting the application.
Choose not to display the error dialog in the application start-up setting, if necessary.

Precautions for exiting applications when exiting GT SoftGOT2000
Applications started from other than GT SoftGOT2000 are not terminated.
Also, some applications may not be terminated with this function.

Precautions for use
Applications may not be started up if device ON time is too short.
Keep the device ON until applications are started up.

Set to [Activate an 
application in motion]

Set to [Separately start 
another application]

Start-up

Timing of setting 
and starting up

Simultaneous 
termination 
with GT SoftGOT2000

Images of application 
starting up

Not available

Start-up

Not available

Start-up

Start-upStart-upStart-upStart-up

Active 

Only (3) can be terminated simultaneously 

Available only for (3)

The setting after change is valid only for 
applications that are started up after 
[Activate an application in motion] is set.

 

Store information 
involving activation 
processing/ termination 
processing to the application 
start-up history 
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4.13 Mail Send Function

Before using the mail send function
GT SoftGOT2000 sends an e-mail using the mail send function, and therefore no additional e-mail software is 
required.
To use the mail send function, make a contract with a provider and establish an environment in which the mail 
send function is usable.

Mail send function overview
You can e-mail a message from GT SoftGOT2000 to a personal computer or smartphone.
The mail send function is usable in the user alarm observation.

Language used in the mail send function
A language set in the [Mail Send Language Setting] dialog of GT Designer3 is used.
For the details of the [Mail Send Language Setting] dialog, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

How to use the mail send function
1. Create a monitor screen with GT Designer3.
(Configure the mail send setting in the user alarm observation.)
GT Designer3 (GOT2000) Screen Design Manual

2. Start GT SoftGOT2000.
GT Designer3 (GOT2000) Screen Design Manual

3. Set the mail destination.
Page 609 How to set up the mail send function

4. Perform a transmission test.
Page 609 How to set up the mail send function

5. Check the conditions for sending an e-mail as necessary.
Page 609 How to set up the mail send function

6. Start monitoring with GT SoftGOT2000.
An e-mail is sent to a personal computer or smartphone when the conditions are met.
Page 104 Opening the Project

Personal computer

Smartphone

E-mailing

E-mailing

Error occurrence or recovery

Personal computer
(GT SoftGOT2000)
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How to set up the mail send function
The following explains how to set up the mail send function to send an e-mail on GT SoftGOT2000.

Mail setup
Used to set the mail send destination and perform a mail transmission test.

1. Perform the following operation.

Click  [Mail Setup].
Select [Set] → [Mail Setup] → [Mail Setup] from the menu.
Right-click the mouse to select [Set] → [Mail Setup] from the menu.

2. The [Mail Setup] dialog is displayed.

Item Description
[Dial-up] Set whether or not to send e-mail via dialup.

(The default is [Manual].)

[Auto] Check this radio button to send e-mail via dialup.
If [Auto] is checked, a connection to the mail server is made and e-mail is sent when the mail conditions are 
established.
The connection to the server is canceled after e-mail is sent.
It is necessary to set [Entry,] [Retry,] and [Interval.]

[Manual
(No Dial-up)]

Check this radio button to send e-mail without using dialup.
If [Manual] is set, the connection to the mail server is always active when e-mail is sent.
The connection to the server is not canceled even after e-mail is sent.

[Entry] Select the dialup connection entry name in Windows.
Refer to the Help function in Windows for how to create a dial up entry.

[Retry] Set the number of retries made if a dialup fails.
"0" to "10"
(The default is "1.")

[Interval] Set the interval between retries.
"1" to "10" (minutes)
(The default is "1.")

[Mail Header] Enter the origin, destination, server name, and title of mail.
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*1 If more than one address is entered, they should be separated with a space or a comma.
Up to 32 addresses are applicable to each setting.
Up to 64 characters can be used for one address.

Mail settings
 • Precautions for mail settings
The setting contents made by selecting [Common] → [Gateway] → [Mail...] in GT Designer3 are not reflected 
on GT SoftGOT2000.
 • Dialup settings
Refer to the manual of the service provider and the Help function in Windows for how to set the dialup network 
connection.
 • Setup
GT SoftGOT2000 is not compatible with the SSL encrypted communication (SMTP over SSL, TLS) when 
sending e-mails.
For the items to be set, check the server specifications.

[FROM] Enter the address of the mail origin.

[TO]  *1 Enter the address of the mail destination.

[CC]  *1 Enter the address of the mail destination (copy).
(E-mail can be sent even this field is blank.)

[BCC]  *1 Enter the address of the mail destination (blind copy).
(E-mail can be sent even this field is blank.)

[Subject] Enter the title of the mail.

[Setup] Enable the check box and enter the necessary information if POP3 authentication is required when sending e-
mail.
(The check box is disabled by default.)

[SMTP Port] Enter the port No. for SMTP.

[SMTP Server] Enter the SMTP server name.

[Require SMTP Authentication] Enable the check box and enter the necessary information if SMTP Server authentication is required when 
sending e-mail.
(The default is "Use SMTP Authentication")

[Use SMTP Authentication] Check the SMTP Server circumstances automatically and send according to following precedence.
[SMTP-AUTH CRAM-MD5]  [SMTP-AUTH LOGIN]  [SMTP-AUTH PLAIN]

[Use POP before 
SMTP]

Send by Use POP before SMTP to the POP3 server set.

[User Name] Enter the user name.

[Password] Enter the password corresponding to the user name.

[POP3 Server] Enter the POP3 server name used for [Use POP before SMTP].

[Delay time] Specify the send interval between e-mails.
[0] to [10] (seconds)
(Default: [0])
The mail server may restrict you to send many e-mails at once to avoid suspicious e-mails.
With this setting, e-mails are sent at specified intervals.

[Create Mail History] Enable this check box to create a mail transmission history.
(The check box is disabled by default.)

[Mail Test] Test e-mail is sent to the destination by clicking the [Send] button.

[OK] Used to update the settings and close the dialog.

[Cancel] Used to cancel the settings and close the dialog.

[Apply] Used to update the settings.

Item Description
0 4  FUNCTIONS OF GT SoftGOT2000
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■Mail test
It is possible to check whether e-mail can be sent properly before starting monitoring by GT SoftGOT2000.
In the mail test, the following sample massage of GT SoftGOT2000 is sent to the destination based on the definition set in the 
Mail Setup dialogue box.
GT SoftGOT2000 sample message displayed at the destination.

Mail history
If [Create mail history] is checked in the Mail Setup dialogue box, the status of the mail test is saved as one of 
the history data items.
Refer to the following for mail history.
Page 609 How to set up the mail send function

Mail Condition
Set the mail send conditions.
If the mail transmission is set with GT SoftGOT2000, it is possible to set not to send e-mail for certain functions without 
modifying the monitor screen data.
Disable the functions for which e-mail is not to be sent.
(Check boxes are enabled by default.)

1. Perform the following operation.

Click  [Mail Condition].
Select [Set] → [Mail Setup] → [Mail Condition] from the menu.
Right-click the mouse to select [Set] → [Mail Condition].

2. The [Mail Condition] dialog is displayed.

Precautions for setting mail conditions
If the mail function is not set by Alarm history display function, this setting is ignored for that function (e-mail is 
not sent even if the check boxes are checked).
For the object setting, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Item Description
[Mail Condition] Set whether the mail function will be used or not with each function.

[Alarm History] Turn on this checkbox to use the alarm history display function with the mail function.

GT SoftGOT2000 TEST MAIL

This is a test message.
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Sending e-mail
When e-mail is sent from GT SoftGOT2000 to the target device, the reception header part shown at the destination displays a 
message that shows that the e-mail is from GT SoftGOT2000.
Example of display in the reception header part at the destination

Precautions for mail sending
The format and contents of the display of e-mail sent vary depending on the mailer specifications used at the 
destination.
When a smartphone receives an e-mail from the GOT, the display details of the received e-mail may differ 
depending on the specifications (screen size) of the smartphone.
GT SoftGOT2000 can send up to 64 e-mails at once.

Sending an e-mail using the alarm history display function
If an alarm occurs in GT SoftGOT2000, the time and information of the alarm are sent to the destination by e-mail.
Moreover, if the alarm recovers, the time and information of the alarm recovery are sent to the destination by e-mail.
For the alarm history display function settings, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Example of the header part display in the mail send destination when an alarm occurred

1) The comment entered in the alarm history display function is displayed.
2) The content of detailed display entered in the alarm history display function is displayed.
[Detailed Information] is not displayed if the detail display setting of the alarm history display function has not been made or if 
it has been made to the base screen or window screen.
[detail comment nothing] appears under [Detailed Information]
Set the details to be displayed in the comment window in order to display the [Detailed Information].

■Example of display at destination (when an alarm recovered)

From:****************

To:******************

Cc:******************

Subject:GT SoftGOT2000 Mail.

            :

X-Mailer:GT SoftGOT2000(Version1)

[Alarm history: Occurrence Notification]
[Occurrence Data and Time]

 2013/08/01 14:23:13
[Alarm Information]

An error occurred in the tank.
[Detailed Information] 

The hydraulic pressure of tank is low.

1)

2)

[Alarm History: Restoration Notification]
[Restored Time]
2013/08/01 15:05:47
[Restoration Information]
Alarm of the tank has been restored.
[Detailed Information]
The hydraulic pressure of tank is low.
2 4  FUNCTIONS OF GT SoftGOT2000
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Mail history
It is possible to reference the operation history data of the e-mail sent from GT SoftGOT2000.
It is also possible to reference the errors generated at the time e-mail was sent.
The mail history data can be displayed using Notepad or a similar editor in Windows.

How to reference mail history
The following explains how to reference the mail history data.

1. Perform the following operation.

Click  (Mail History).
Select [Set] → [Mail Setup] → [Mail History] from the menu.
Right-click the mouse to select [Set] → [Mail History] from the menu.

2. The mail history information is displayed.

■Example of mail history data display

Mail history
The mail history cannot be referenced if the data does not exist.
To create a mail history, enable [Create Mail History] in the Mail Setup dialogue box.
For the Mail Setup dialog, refer to the following.
Page 609 How to set up the mail send function
The mail history data is not deleted even if GT SoftGOT2000 is exited.
The unnecessary history data is required to delete by the user.

:
2013/8/1 15:10:52 No.1 POP:##### Searching...
2010/8/1 15:10:52 No.1 POP:##### Connecting...
2010/8/1 15:10:52 No.1 POP:##### Connection is completed.
2010/8/1 15:10:52 No.1 SMTP:##### Searching...
2010/8/1 15:10:52 No.1 SMTP:##### Connecting...
2010/8/1 15:10:52 No.1 SMTP:##### Connection is completed.
2010/8/1 15:10:52 No.1 Mail was sent successfully.
:
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4.14 SoftGOT-GOT Link Function
The SoftGOT-GOT link function enables GT SoftGOT2000 to connect the GOT via Ethernet.
And then, the function synchronizes GT SoftGOT2000 data with GOT project data and resource data.
To prevent simultaneous operations from GT SoftGOT2000 and the GOT, the authorization (operational authority) is required 
to operate input objects (the touch switch, numerical input, and text input).
GT SoftGOT2000 can monitor a controller connected to the GOT.

With the GOT network interaction function, multiple GT SoftGOT2000 modules can communicate with one GOT.
For the GOT network interaction function, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Ethernet

GT SoftGOT2000

GOT Controller

Controller

GT SoftGOT2000 monitors the controller connected to the GOT.
GT SoftGOT2000 (Single channel) only monitors the controller with the 
channel number 1 assigned on the GOT. It cannot communicate with 
the controller other than the channel number 1 assigned.
GT SoftGOT2000 (Multiple channels) monitors the controllers with the 
channel number 1 to 4 assigned on the GOT.

GT SoftGOT2000 reads GOT project data from the GOT, 
and monitors the controller with the same project data as 
the read GOT project data.

Ethernet

GT SoftGOT2000

GT SoftGOT2000

GOT

Controller

When the GOT network 
interaction function is used, 
up to seven GT 
SoftGOT2000 modules can 
communicate with one 
GOT.

GT SoftGOT2000 reads GOT 
project data from the GOT, 
and monitors the controller 
with the same project data as 
the read GOT project data.
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GT SoftGOT2000 project data
GT SoftGOT2000 uses project data read from the GOT.
Creating new GT SoftGOT2000 project data is not required.

Number of GT SoftGOT2000 modules that can communicate with one GOT
The following shows the number of GT SoftGOT2000 modules that can communicate with one GOT.

■When the GOT network interaction function is used
Up to seven GT SoftGOT2000 modules can communicate with one GOT.
In this case, each GT SoftGOT2000 module must be run on different personal computers.
If multiple modules of GT SoftGOT2000 are run on one personal computer, the modules cannot connect to the same GOT 
simultaneously.

■When the GOT network interaction function is not used
Only one GT SoftGOT2000 module can communicate with one GOT.
A GT SoftGOT2000 module cannot communicate with a GOT that is communicating with another GT SoftGOT2000 module.

Controller monitored by SoftGOT2000 (Single channel/Multiple channels)
GT SoftGOT2000 (Single channel) only monitors a controller connected to the GOT that assigns channel number 1 to the 
controller.
It cannot communicate with the controller other than the channel number 1 assigned.
GT SoftGOT2000 (Multiple channels) monitors the controllers connected to the GOT that assigns channel numbers 1 to 4 to 
the controllers.
Configure the common controller settings for each channel between the GOT and GT SoftGOT2000.

When the GOT uses the multi-channel function
GT SoftGOT2000 (Single channel) cannot monitor a controller of channel number other than 1. Therefore, objects are not 
displayed on the screen when devices of a controller other than channel number 1 are assigned.
With a touch switch or others, when devices are written to the controller other than the channel number 1 assigned, a system 
alarm occurs.

Communication status between the GOT and a controller
To monitor a controller connected to the GOT by using GT SoftGOT2000, enable communications between the GOT and the 
controller.
If the GOT cannot communicate with the controller, the SoftGOT-GOT link function is not available.
For how to connect the controller to the GOT, refer to the following.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

Support of the base screen size expansion
GT SoftGOT2000 does not support the base screen size expansion.
Note that the expanded base screen of the GOT can be operated on GT SoftGOT2000 by using the SoftGOT-GOT link 
function.
For details on the base screen size expansion, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
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Differences between functions for remotely operating a GOT
You can use the following three functions to operate the GOT screen with a personal computer connected by Ethernet.
VNC server function
SoftGOT-GOT link function
GOT Mobile function
The following shows differences between the functions.

The following shows the details and references of each function.

Item Function

SoftGOT-GOT link function VNC server function GOT Mobile function
Equipment Personal computer, PC CPU module, or 

MELIPC on which GT SoftGOT2000 is 
installed

Information device (such as a tablet and 
personal computer) on which an 
applicable VNC client is installed

Information device (such as a tablet and 
personal computer) on which an 
applicable browser is installed

Number of modules or 
clients connectable to 
one GOT

One GT SoftGOT2000 module is 
connectable.
Up to seven GT SoftGOT2000 modules 
are connectable when the GOT network 
interaction function is enabled.

One VNC client is connectable. Counting one browser as one client:
GOT: 5 clients
GT SoftGOT2000: 15 clients

Required number of 
licenses

One license key is required for one 
personal computer.

One license is required for one GOT. One license is required for one GOT.

Screen display 
contents

The GOT and a GT SoftGOT2000 module 
can display different contents.

The GOT and the remote screen on the 
personal computer display the same 
contents.

The GOT and each client display different 
contents.
(The client displays the dedicated mobile 
screens.)

Screen targeted for the 
exclusive authorization 
control

All screens All screens Screen in which the exclusive 
authorization control is enabled (This 
control can be enabled for each screen.)

Creation of dedicated 
screens (project data 
setting)

Not needed Not needed Mobile screens must be created.

Storage location of 
project data

The GOT and a GT SoftGOT2000 module 
each store project data.
(The GT SoftGOT2000 module reads 
project data from the GOT.)

Only the GOT stores project data. The GOT or GT SoftGOT2000 stores 
project data.

Storage location of 
resource data

When a GT SoftGOT2000 module reads 
project data from the GOT, the module 
also reads resource data.
Accordingly, the GOT and the GT 
SoftGOT2000 module each store the 
resource data.

Only the GOT stores resource data. The GOT or GT SoftGOT2000 stores 
project data.

Availability of extended 
functions for equipment

Limited
Page 46 Function that can be used in 
GT SoftGOT2000, features that are not 
available

Not limited Limited
GT Designer3 (GOT2000) Screen 
Design Manual
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■VNC server function
With the VNC server function, the remote screen of the personal computer displays the GOT screen.
You can view the data collected by the GOT, including alarm data and logging data, on the personal computer in real time.
Even though an extended function is used, you can also remotely operate the GOT from the personal computer.

Since the VNC server function increases the processing load on the GOT, the GOT can delay displaying data and collecting 
data, including alarm data and logging data.
The GOT can also delay responding to an operation from the VNC client (personal computer).

■SoftGOT-GOT link function
With the SoftGOT-GOT link function, GT SoftGOT2000 and the GOT each have a project data and monitor a controller.
Since GT SoftGOT2000 displays the GOT screen on the personal computer, the processing load on the GOT is reduced.
By using a GOT internal device for the screen switching device, GT SoftGOT2000 and the GOT can display different screens.

The GOT and GT SoftGOT2000 each operate independently.
Therefore, collecting data, including alarm data and logging data, can make a difference in the collection result between the 
GOT and the personal computer.
The extended functions which are unavailable for GT SoftGOT2000 cannot be used with the SoftGOT-GOT link function.

Personal computer 
(VNC® client)

A 1254

348B
A 1254

348B

In remote operation (10s)

A 1254

348B
A 1254

348B

In remote operation (10s)

GOT 
(VNC® server)

Monitoring Remote operation

GOT screen display

Remotely operating the GOT from the personal 
computer (VNC® client)
(The personal computer does not monitor the PLC.)Ethernet

PLC

Personal computer
(GT SoftGOT2000)

A 1254
348B

A 1254
348B

In remote operation (10s)

A 1254
348B

A 1254
348B

In remote operation (10s)

GOT

The personal computer 
reads project data and 

resource data from 
the GOT.

Ethernet

PLC

Monitoring

The personal computer (GT SoftGOT2000) and 
the GOT each monitor the PLC independently.

Monitoring
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■GOT Mobile function
It is recommended to use GT SoftGOT2000 (Multiple channels) for this function.
With the GOT Mobile function, an information device, such as a tablet, displays mobile screens that are stored in the server 
(GOT).
One browser is handled as one client. Up to 5 clients (GOTs) or 15 clients (GT SoftGOT2000 modules) can make access 
simultaneously.
Each client can display different mobile screens.
The information device does not store project data and resource data, and the server (GOT) stores the data for management.

You cannot use the functions that are incompatible with the GOT Mobile function, such as objects incapable of being placed 
on mobile screens.
For the details of the GOT Mobile function, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Up to 20 Pocket GOT modules (mobile terminals) can be simultaneously connected to one personal computer 
on which GT SoftGOT2000 runs.
When Pocket GOT and the GOT Mobile function are used, up to 20 mobile terminals can be simultaneously 
connected to one personal computer on which GT SoftGOT2000 runs.
Example: When 15 mobile terminals using the GOT Mobile function are connected, up to 5 mobile terminals 
using Pocket GOT can be connected.

A 1254

B 348

A 1254

B 348

Tablet

Mobile screen 1

Line A 258

Mobile screen 2

Products
Line A

Line B

558

197

Ethernet

PLC
GOT

(Server)

Personal computer Client 1

Accessing the mobile screen

Accessing the mobile screen

Client 2

Monitoring
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Project data/resource data synchronization
When the SoftGOT-GOT link function is used, GT SoftGOT2000 reads project data or resource data from the GOT, and 
synchronizes GT SoftGOT2000 data with the GOT data.
When the project data is synchronized, GT SoftGOT2000 can display the same screen as that of the GOT.
Because the project data used for GT SoftGOT2000 is read from the GOT, creating new GT SoftGOT2000 project data is not 
required.

Project data synchronization
Project data is synchronized at the following timing.
○: Synchronized, ×: Not synchronized

*1 This setting shortens the time before monitoring by not synchronizing the project data at the start of second or subsequent monitoring.
For the setting, refer to the following.
Page 639 SoftGOT-GOT link function setting

Synchronized project data are managed by individual modules.
Manage project data with different module numbers when multiple GOTs are connected.

The following shows the processes of the project data synchronization.

■Synchronization when GT SoftGOT2000 starts monitoring
When GT SoftGOT2000 starts monitoring, if the time stamps of the project data do not match between GT SoftGOT2000 and 
the GOT, the project data synchronization is performed.
(When [Synchronize project data at the start of initial monitoring only] is selected, project data is not synchronized at the start 
of the second or subsequent monitoring.)
The following shows the operation when the project data synchronization is performed.

1. Start the project data and monitoring.

2. The confirmation dialog for the project data synchronization appears. Click the [Yes] button.

3. If the data transfer password has been set for the project data, the password entry dialog appears. Enter the password.

4. Click the [OK] button to synchronize the project data and resource data of GT SoftGOT2000 with the ones of the GOT, 
then start monitoring.

■Synchronization by user operation
The following shows the operation when the user performs project data synchronization.

1. Select [Tool] → [SoftGOT-GOT Link Function] → [GOT Project Data Acquisition] from the menu, and click the [Yes] 
button in the confirmation dialog that appears for project data synchronization.

2. If the data transfer password has been set for the project data, the password entry dialog appears. Enter the password.

3. Click the [OK] button to synchronize the project data and resource data of GT SoftGOT2000 with the ones of the GOT, 
then start monitoring.

Synchronization timing Setting of [Synchronize project data at the 
start of initial monitoring only] *1

Reference

Deselected Selected
Starting the monitor with GT SoftGOT2000 First time ○ ○ Page 619 Synchronization when 

GT SoftGOT2000 starts monitoringSecond or 
subsequent 
time

○ ×

Selecting [Tool] →[SoftGOT-GOT Link Function] → [GOT 
Project Data Acquisition] from the menu

○ ○ Page 619 Synchronization by user 
operation

Changing project data of the GOT that is communicating with 
GT SoftGOT2000

○ ○ Page 620 Synchronization when 
the project data of the GOT is changed
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■Synchronization when the project data of the GOT is changed
If the project data of the GOT is changed during communication with GT SoftGOT2000, project data synchronization is 
performed.
The following shows the operation when project data synchronization is performed.

1. If the data transfer password has been set for the project data, the input dialog of the password appears. Enter the 
password.

2. Click the [OK] button to synchronize the project data and resource data of GT SoftGOT2000 with the ones of the GOT, 
then start monitoring.

 • Automatic password entry for project data synchronization
To automatically enter the password when project data are synchronized, enter a password in the [GOT Link 
Setup] dialog beforehand.
Page 83 [Ethernet]
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Resource data synchronization
When resource data are stored in the GOT, the data are also synchronized when project data are synchronized.
Select the timing to synchronize resource data so that the data are synchronized even when project data of the GOT are 
unchanged.
Resource data are copied from each drive of the GOT to each virtual drive of GT SoftGOT2000.
Page 41 Precautions for using GT SoftGOT2000

■Types of resource data to be synchronized and synchronization timing
The following shows the types of resource data to be synchronized.
 • Alarm log file (G2A)
 • logging file (G2L)
 • image file (JPG, BMP, PNG)
 • PDF file (PDF)
 • GOT Embedded Memory (SRAM)
The resource data are synchronized at the following timings.
○: Synchronized, ×: Not synchronized

*1 This setting is used to select the timing to synchronize the resource data.
For the setting, refer to the following.
Page 639 SoftGOT-GOT link function setting

*2 The resource data is synchronized only when the data is different from the project data in the connected GOT.
The type of the resource data to be synchronized and the synchronization timing can be selected in the [SoftGOT-GOT Link 
Function Setting] dialog.
For how to select the type and timing, refer to the following.
Page 639 SoftGOT-GOT link function setting
After resource data synchronization, GT SoftGOT2000 and the GOT update the resource data independently.
Therefore, the synchronized resource data may differ between GT SoftGOT2000 and the GOT.

Synchronization timing Setting of [Synchronize at the start of 
every monitoring] *1

Reference

Deselected Selected
Starting the monitor with GT SoftGOT2000 ○ *2 ○ Page 619 Synchronization when 

GT SoftGOT2000 starts monitoring

Selecting [Tool] →[SoftGOT-GOT Link Function] → [GOT 
Project Data Acquisition] from the menu

○ ○ Page 619 Synchronization by user 
operation

Changing project data of the GOT that is communicating with 
GT SoftGOT2000

○ *2 ○ Page 620 Synchronization when 
the project data of the GOT is changed
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Authorization control
When you use the SoftGOT-GOT link function, the authorization (operational authority) is required to operate input objects 
(the touch switch, numerical input, and text input).
Thus, you can prevent simultaneous operations from GT SoftGOT2000 and the GOT.
For the following operations and functions, the authorization is not required.

When you use the GOT network interaction function in combination, the authorization control of the SoftGOT-GOT link 
function becomes disabled.
The authorization control of the GOT network interaction function becomes enabled.
For the details of the GOT network interaction function, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Precaution for authorization control
■Operations not recognized by GT SoftGOT2000/GOT
A touch operation is not recognized as an input when Disable Touch Operation signal (System signal 1-1.b9) is on.

■How to check the authorization status
 • How to check the status with GT SoftGOT2000
When the SoftGOT-GOT link function is used, the status bar on GT SoftGOT2000 displays the status whether the 
authorization or the exclusive authorization is obtained or not.
When the network interaction function is used, the status bar on GT SoftGOT2000 displays whether the software obtains the 
authorization control.

*1 While the GOT network interaction function is being used, the exclusive authorization status of the GOT is not displayed.
The status is checked by GOT internal devices.
Page 626 Control or notification with GOT internal devices
 • How to check the status with the GOT
Whether the GOT obtains the authorization or the exclusive authorization can be checked by the GOT internal devices.
Page 626 Control or notification with GOT internal devices

Operation/Function Description
Screen operation • Moving windows

• Switching the order of windows

Function • Functions controlled by triggers (system information, screen switching device, trigger action function, and 
others)

• GOT internal devices (GS654, 655, and 656)

Item Description
[OPE] Displays the status whether GT SoftGOT2000 obtains the authorization or not.

Lights in green when GT SoftGOT2000 obtains the authorization.

[PRI]*1 Displays the status whether the GOT obtains the exclusive authorization or not.
Lights in blue when the GOT obtains the exclusive authorization.

[NMG] This item is displayed when GT SoftGOT2000 is the master GOT.
If it is not the master GOT, this item will not be displayed.

When the network interaction function is used

When the SoftGOT-GOT link function is used
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 • Operation status popup notification function
This function notifies whether the authorization is obtained or not and the operation status at the target side with a popup 
display.
The display position of the operation status popup display is common with the display position set for the advanced alarm 
popup display, and is displayed in bands either on the bottom, center or bottom of the display.
If the base screen is switched when displaying the operation status popup, the popup is displayed at the display position set 
for the advanced alarm popup display in the base screen after switching.
If authorization is obtained, the operation status popup display is cleared.
The display is set by using the GOT utility or GOT setup of GT Designer3.
For how to set the utility, refer to the following.
User's Manual of GOT used
For how to set GT Designer3, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual
 • Popup display when the GOT network interaction function is used
The popup display of the GOT network interaction function is applied to the GT SoftGOT2000 or GOT screen.
For the details of the GOT network interaction function, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
4  FUNCTIONS OF GT SoftGOT2000
4.14  SoftGOT-GOT Link Function 623



62
Obtaining the authorization
■Obtaining the authorization by using the GOT
When GT SoftGOT2000 starts monitoring, the GOT automatically obtains the authorization.
When input objects are input without obtaining the authorization with the GOT, the dialog for obtaining the authorization 
appears.

In the following cases, the GOT automatically obtains the authorization.
The GOT is restarted.
The GOT obtains the exclusive authorization.
While GT SoftGOT2000 obtains the authorization, the user does not operate GT SoftGOT2000 within the authorization 
obtained time set in the GOT utility or GOT setup of GT Designer3.
User's Manual of GOT used
GT SoftGOT2000 stops monitoring.
GT SoftGOT2000 is terminated.
The communication between GT SoftGOT2000 and the GOT is disconnected by a communication cable disconnection or 
others.

■Obtaining the authorization by using GT SoftGOT2000
When input objects are input without obtaining the authorization with the GT SoftGOT2000, the dialog for obtaining the 
authorization appears.
When the GOT has the exclusive authorization, GT SoftGOT2000 cannot obtain the authorization.

O K Cancel

The GOT is being operated remotely
by the SoftGOT-GOT link function.
Do you want to obtain operating
authority?

O K Cancel

The GOT is being operated remotely
by the SoftGOT-GOT link function.
Do you want to obtain operating
authority?

O K

The host has higher operating
priority. Failed to obtain operating
authority.

When the GOT obtains the exclusive authorization

When the GOT does not obtain the exclusive authorization
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Exclusive authorization for the GOT
■Exclusive authorization
This right allows only the GOT to obtain the authorization. (Exclusive authorization)
When the GOT obtains the exclusive authorization, the GOT automatically obtains the authorization.

■How to obtain the exclusive authorization
The exclusive authorization is obtained by using the GOT internal device (GS447) or the GOT utility.
For how to set the GOT internal device, refer to the following.
Page 626 Control or notification with GOT internal devices
For how to set the utility, refer to the following.
the User's Manual for the GOT used

 • Operation that automatically obtains the exclusive authorization
When the utility screen or the dedicated screen for any extended function is displayed, the GOT obtains the 
exclusive authorization regardless of the value of the Exclusive Authorization Control signal (GS447.b0).
When such a screen is switched to a user-created screen, the exclusive authorization is controlled according 
to the value of the signal (GS447.b0).
Page 626 Control or notification with GOT internal devices
 • SoftGOT-GOT link function
The following settings are set by using the GOT utility or GOT setup of GT Designer3.
Authorization obtained time
Authorization guarantee time
Operation status popup notification
For how to set the utility, refer to the following.
GOT2000 Series User's Manual (Utility)
For how to set GT Designer3, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
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Control or notification with GOT internal devices
GOT internal devices enable to check the exclusive authorization control or the communication status between GT 
SoftGOT2000 and the GOT.
For details of the GOT internal devices, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Exclusive Authorization Control (GS447)

*1 This control is disabled when the GOT network interaction function is used.

SoftGOT-GOT Link Status Control/Notification (GS244)

*1 This control is disabled when the GOT network interaction function is used.

Authorization Guarantee Status Notification signal (GS984)

*1 This control is disabled when the GOT network interaction function is used.

■How to utilize GOT internal devices
Objects or others displayed only on the GOT can be set by using the GT SoftGOT2000/GOT identification signal (GS244.b2).
Example) Bit switch displayed only on the GOT

1. Register a shape to a part to display the shape when the bit switch turns on or off.
For how to register the part, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

2. Create the following objects.

For how to set objects, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual

3. Arrange the bit switch on the created parts display.

Bit number Signal name Description
b0 Exclusive Authorization Control signal *1 Turn on this signal to grant the authorization to the GOT.

Not available for GT SoftGOT2000

b1 Authorization Guarantee Time Cancel signal 
*1

Turn on this signal to cancel the authorization guarantee time setting.

b2 to b15 Use prohibited -

Bit number Signal name Description
b0 Communication Status Notification signal *1 Turns on while GT SoftGOT2000 communicates with the GOT.

b1 Obtaining Authorization Notification signal *1 Turns on when the GOT or GT SoftGOT2000 obtains the authorization.

b2 GT SoftGOT2000/GOT Identification signal Notifies that SoftGOT2000 or the GOT is in use.
• 0: GOT
• 1: GT SoftGOT2000 (Changes to 0 if GT SoftGOT2000 does not communicate with the 

GOT.)

b3 Obtaining Exclusive AuthorizationNotification 
signal *1

Turns on when the GOT obtains the exclusive authorization.
Always off for GT SoftGOT2000

b4 System Screen Displaying Notificationsignal 
*1

Turns on when the utility screen or the dedicated screen for any extended function is 
displayed.
Always off for GT SoftGOT2000

b5 to b15 Use prohibited -

Signal name Description
Authorization Guarantee Status Notification signal *1 Stores the remaining authorization guarantee time (seconds) when the authorization 

guarantee time is set in GT SoftGOT2000 (Single channel) or the GOT.

Object Setting item
Bit switch • Set [Device] on the [Device] tab.

• Select [None] in [Shape] on the [Style] tab.
• Set [OFF] in [Trigger Type], or set GS244.b2 in [Trigger Device] on the [Trigger] tab.

Parts display (Bit parts) • Set the same device as that of the bit switch in [Parts Switching Device] on the [Device/Style] tab.
• Set the part registered in the step 1. to the part for [ON] or [OFF] on the [Device/Style] tab.
• Set [OFF] in [Trigger Type], or set GS244.b2 in [Trigger Device] on the [Trigger] tab.
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Setting method
This section explains the system configuration and setting method to use the SoftGOT-GOT link function.
The SoftGOT-GOT link function in the following system configuration is used as an example to explain the procedures.

How to use the SoftGOT-GOT link function
1. Connect the GOT and controllers.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

2. Connect the GOT and a personal computer on which GT SoftGOT2000 is installed.
Page 628 GOTs available with the SoftGOT-GOT link function
Page 629 Controllers that can be monitored and connection types

3. Create project data with GT Designer3, and write the data to the GOT.
 GT Designer3 (GOT2000) Screen Design Manual

4. Configure the communication setting and environmental setting on GT SoftGOT2000.
Page 638 Operation and setting on GT SoftGOT2000

5. Start monitoring with GT SoftGOT2000.
Page 638 Operation and setting on GT SoftGOT2000

Ethernet
(Network No.1)

GT2710-V

GT SoftGOT2000

Controller

IP address
PC No.

Port No.

: 192.168.3.1
: 1
: 5001

IP address
PC No.

Port No.

: 192.168.3.39
: 2
: 5001

IP address
PC No.

GOT Communication Port No.
Peripheral S/W Communication Port No.

: 192.168.3.18
: 3
: 5001
: 5015

Ethernet connection
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GOTs available with the SoftGOT-GOT link function
The following shows the supported GOTs.
 • GT27
 • GT25
 • GS25

■Communication interface of the GOT
The following shows the communication interfaces of the GOT that are used for the communication with GT SoftGOT2000.

*1 The Ethernet communication unit is usable only when the connected GOT satisfies the following conditions.
Version Z or later of BootOS
Project data created with GT Designer3 Version 1.175H or later

*2 Not available to GT25HS-V.

■Cables connecting a personal computer (GT SoftGOT2000) with the GOT
Use the cables applicable to an interface of the GOT to be used.

■Connection conditions for a personal computer (GT SoftGOT2000) and the GOT

Item Type
GT27 - (Built-in interface)

GT25-J71E71-100 (Ethernet communication unit) *1

GT25-WLAN (Wireless LAN communication unit)

GT25 (except GT25-W) - (Built-in interface)

GT25-J71E71-100 (Ethernet communication unit) *1*2

GT25-WLAN (Wireless LAN communication unit) *2

GT25-W, GS25 - (Built-in interface: Port 1, port 2)

GT25-WLAN (Wireless LAN communication unit)

Connection type Connection conditions

Distance between controller and PC Number of connectable PCs
Ethernet connection 100 m

(max. segment length)
1
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Controllers that can be monitored and connection types
The controller that can be monitored by GT SoftGOT2000 varies with the following conditions.
Connection type between a GOT and the monitored controller
Communication route from GT SoftGOT2000 to the monitored controller
For the communication route setting, refer to the following.
Page 641 Communication setting
The following shows the communication routes to the monitored controller supported by GT SoftGOT2000 (Single channel) 
and GT SoftGOT2000 (Multi channels).
○: Supported, ×: Not supported

When the GOT network interaction function is used, the controller cannot be monitored through the GOT using the SoftGOT-
GOT link function.

■Monitoring a PLC through a GOT
Not available to GT SoftGOT2000 (Multiple channels).

○: Can be monitored, ×: Cannot be monitored

Communication route from GT 
SoftGOT2000 to the monitored 
controller

GT SoftGOT2000 (Single 
channel)

GT SoftGOT2000 (Multiple 
channels)

Reference

Monitoring a PLC through a GOT ○ × Page 629 Monitoring a PLC 
through a GOT

Monitoring a PLC on a different 
network through a GOT and a relay 
station

○ × Page 631 Monitoring a PLC on a 
different network through a GOT and 
a relay station

Monitoring a PLC directly ○ ○ Page 633 Monitoring a PLC 
directly

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored controller)

Bus connection Direct CPU 
connection (RS-232, 
USB)

Serial 
communication 
connection

Ethernet 
connection

RCPU R□CPU × × ○ ○

R□PCPU × × × ×

In the redundant system × × × ×

R□SFCPU × × × ×

R□ENCPU × × ○ ○

C Controller module (MELSEC iQ-R series) × × × ×

MELSECWinCPU (MELSEC iQ-R series) × × × ×

QCPU
(Q mode)

Not in the redundant 
system

○ ○ ○ ○

In the redundant system × × × ×

QCPU (A mode) × × × ×

C Controller module (Q series) × ○ ○ ○

QSCPU × × × ×

LCPU × ○ ○ ○

QnACPU × × × ×

A 1254

348B
A 1254

348B

Ethernet: Network No. 1

PLC 

Standard Ethernet
interface of the GOT

(IP address: 192.168.3.18)

GOT

A 1254

348B
A 1254

348B

(IP address: 192.168.3.20)
GT SoftGOT2000

In remote operation (10s)

In remote operation (10s)
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ACPU Other than A1FXCPU × × × ×

A1FXCPU × × × ×

MELSEC iQ-F series × × × ×

FXCPU × × × ×

Motion CPU MELSEC iQ-R series × × × ×

MELSEC-Q series × × × ×

MELSEC-A series × × × ×

MELSECNET/H remote I/O station × × × ×

CC-Link IE Field Network head module × × × ×

CC-Link IE Field Network Ethernet adapter 
module

× × × ×

MELIPC × × × ○

OMRON PLC × × × ×

KEYENCE PLC × × × ×

TOSHIBA PLC × × × ×

YASKAWA PLC × × × ×

YASKAWA robot controller × × × ×

YOKOGAWA PLC × × × ×

LS Industrial Systems PLC × × × ×

ALLEN-BRADLEY PLC × × × ×

SIEMENS PLC × × × ×

Microcomputer × × × ×

CNC CNC C80 × × × ×

CNC C70 ○ ○ ○ ○

MELDAS C6/C64 × × × ×

Robot controller CR800-R
(R16RTCPU)

× × × ×

CR800-D × × × ×

CRnQ-700 ○ ○ ○ ○

CR750-Q ○ ○ ○ ×

CR751-Q ○ ○ ○ ×

CRnD-700 × × × ×

CR750-D × × × ×

CR751-D × × × ×

CR800-Q
(Q172DSRCPU)

○ ○ ○ ○

Servo amplifier × × ○ ×

Inverter × × × ×

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored controller)

Bus connection Direct CPU 
connection (RS-232, 
USB)

Serial 
communication 
connection

Ethernet 
connection
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■Monitoring a PLC on a different network through a GOT and a relay station
Not available to GT SoftGOT2000 (Multiple channels).

○: Can be monitored, ×: Cannot be monitored

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored 
controller)

Ethernet connection
RCPU R□CPU ×

R□PCPU ×

In the redundant system ×

R□SFCPU ×

R□ENCPU ×

C Controller module (MELSEC iQ-R series) ×

MELSECWinCPU (MELSEC iQ-R series) ×

QCPU
(Q mode)

Not in the redundant system ○

In the redundant system ×

QCPU (A mode) ×

C Controller module (Q series) ○

QSCPU ×

LCPU ○

QnACPU ×

ACPU Other than A1FXCPU ×

A1FXCPU ×

MELSEC iQ-F series ×

FXCPU ×

Motion CPU MELSEC iQ-R series ×

MELSEC-Q series ×

MELSEC-A series ×

MELSECNET/H remote I/O station ×

CC-Link IE Field Network head module ×

CC-Link IE Field Network Ethernet adapter module ○

MELIPC ×

OMRON PLC ×

KEYENCE PLC ×

TOSHIBA PLC ×

A 1254

348B
A 1254

348B

Ethernet: Network No. 1

Ethernet: Network No. 2

Ethernet: Network No. 3

PLC 2

PLC 1 (relay station)

Standard Ethernet
interface of the GOT

(IP address: 192.168.3.18)

Extended Ethernet
interface of the GOT

(IP address: 192.168.5.22) GOT

A 1254

348B
A 1254

348B

(IP address: 192.168.3.20)
GT SoftGOT2000

(IP address: 192.168.5.10)

(IP address: 192.168.7.15)

(IP address: 192.168.7.20)

In remote operation (10s)

In remote operation (10s)
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*1 This controller cannot be used as a relay station when it is connected through the Ethernet port built in the CPU.

YASKAWA PLC ×

YASKAWA robot controller ×

YOKOGAWA PLC ×

LS Industrial Systems PLC ×

ALLEN-BRADLEY PLC ×

SIEMENS PLC ×

Microcomputer ×

CNC CNC C80 ×

CNC C70 ○

MELDAS C6/C64 ×

Robot controller CR800-R
(R16RTCPU)

×

CR800-D ×

CRnQ-700 ○

CR750-Q ×

CR751-Q ×

CRnD-700 ×

CR750-D ×

CR751-D ×

CR800-Q
(Q172DSRCPU)

○ *1

Servo amplifier ×

Inverter ×

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored 
controller)

Ethernet connection
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■Monitoring a PLC directly

○: Can be monitored, ×: Cannot be monitored

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored 
controller)

Ethernet connection
RCPU R□CPU ○

R□PCPU ×

In the redundant system ×

R□SFCPU ×

R□ENCPU ○

C Controller module (MELSEC iQ-R series) ×

MELSECWinCPU (MELSEC iQ-R series) ○

QCPU
(Q mode)

Not in the redundant system ○

In the redundant system ×

QCPU (A mode) ×

C Controller module (Q series) ○

QSCPU ×

LCPU ○

QnACPU ×

ACPU Other than A1FXCPU ×

A1FXCPU ×

MELSEC iQ-F series ×

FXCPU ×

Motion CPU MELSEC iQ-R series ×

MELSEC-Q series ×

MELSEC-A series ×

MELSECNET/H remote I/O station ×

CC-Link IE Field Network head module ×

CC-Link IE Field Network Ethernet adapter module ○ *1

MELIPC ○

OMRON PLC ○

KEYENCE PLC ×

TOSHIBA PLC ×

YASKAWA PLC ×

YASKAWA robot controller ×

YOKOGAWA PLC ×

LS Industrial Systems PLC ×

ALLEN-BRADLEY PLC ×

SIEMENS PLC ×

Microcomputer ×

CNC CNC C80 ×

CNC C70 ○

MELDAS C6/C64 ×

Ethernet: Network No. 1

PLC
(IP address: 192.168.3.39)

A 1254

348B
A 1254

348B

(IP address: 192.168.3.20)
GT SoftGOT2000

A 1254

348B
A 1254

348B

GOT

In remote operation (10s)

In remote operation (10s)
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*1 Only access to other stations via NZ2GF-ETB is available.

Robot controller CR800-R
(R16RTCPU)

×

CR800-D ×

CRnQ-700 ○

CR750-Q ○

CR751-Q ○

CRnD-700 ○

CR750-D ○

CR751-D ○

CR800-Q
(Q172DSRCPU)

○

Servo amplifier ○

Inverter ×

Controller monitored Connection type between a GOT and the monitored controller
(Communication route from GT SoftGOT2000 to the monitored 
controller)

Ethernet connection
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Operation and setting on GT Designer3 (for the GOT)
■Settings in the [Controller Setting] window
Configure the communication setting between the GOT and the controller.

1. Select [Common] → [Controller Setting] from the menu to display the [Controller Setting] window.

2. Set the following items in [Detail Setting], and click the [OK] button.

For details of the communication setting, refer to the following.
GOT2000 Series Connection Manual (Mitsubishi Electric Products) for GT Works3

Item Description
[GOT NET No.] [1]

[GOT PC No.] [3]

[GOT Communication Port No.] [5001]
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■Settings in the [PC (Data Transfer)] dialog
Configure the settings to connect GT SoftGOT2000 to the Ethernet interface of the GOT to transfer data between them.

1. Select [Common] → [Peripheral Setting] → [PC (Data Transfer)] from the menu to display the [PC (Data Transfer)] 
dialog.

2. Select [Ethernet: Multi] for [Destination I/F] in [Ethernet Download], and click the [OK] button.

■Settings in the [GOT Ethernet Setting] window
Set [GOT IP Address Setting] and [Peripheral S/W Communication Port No.].

1. Select [Common] → [GOT Ethernet Setting] → [GOT IP Address Setting] from the menu to display the [GOT Ethernet 
Setting] window ([GOT IP Address Setting]).

2. In the [Standard Port] tab, set [GOT IP Address] to [192.168.3.18].
6 4  FUNCTIONS OF GT SoftGOT2000
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3. In [GOT Ethernet Common Setting] in the [GOT Ethernet Setting] window, set [Peripheral S/W Communication Port No.] 
to [5015].

4. Click the [OK] button to complete the settings.

 • Setting the firewall
When the port for the Ethernet communication is blocked by the firewall, a communication error occurs.
Disable the firewall or configure the setting to open the port.
 • Unusable port No. (Port No.49154, 49158)
The GOT port No.49154 and 49158 are used for the command communication port.
Do not use these port No. for the communication or others between the GOT and the controller.
 • Communication interface of the GOT
The extended Ethernet interface of the GOT cannot be used for the communication with GT SoftGOT2000.
To communicate with GT SoftGOT2000, use the standard Ethernet interface of the GOT.
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■Transparent mode setting
When you use the SoftGOT-GOT link function to monitor a controller through a GOT, specify [CH1] in the GOT transparent 
mode setting.
Otherwise, a communication timeout error occurs, or an unintended controller is monitored.
The following shows the setting procedure on GT Designer3.

1. Select [Common] → [GOT Setup] → [Basic Setting] → [Transparent Mode Setting] from the menu to display 
[Transparent Mode Setting] of the [GOT Setup] window.

2. Select [Update the transparent mode setting].

3. Select [CH1] for [Controller CH No.], and click the [OK] button.

■Writing project data and install the extended function OS to the GOT
Write the created project data and install the extended function OS (SoftGOT-GOT Link Function) to the GOT.
For writing project data and OS to the GOT, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Operation and setting on GT SoftGOT2000
■Environmental setting
For setting items of the [Environment Setup] dialog, refer to the following.
Page 68 [Environment Setup] dialog

1. Perform either of the following operations to display the [Environment Setup] dialog.

Clicking  [Environment Setup]
Selecting [Set] → [Environment Setup] from the menu
Right-clicking the mouse to select [Environment Setup] from the menu

 • When the resolutions of GT SoftGOT2000 and the GOT differ
The resolution of GT SoftGOT2000 is automatically changed according to the resolution of the GOT when GT 
SoftGOT2000 starts monitoring.
 • When a vertically-installed GOT is connected
When GT SoftGOT2000 is connected to a vertically-installed GOT, GT SoftGOT2000 displays the startup logo 
and the utility screen in the vertical orientation.
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■SoftGOT-GOT link function setting
Select the type of the resource data to be synchronized with the GOT and the synchronization timing.

1. Perform one of the following operations to display the [SoftGOT-GOT Link Function Setting] dialog.
Select [Set] → [SoftGOT-GOT Link Function Setting] from the menu.
Right-click the mouse to select [Set] → [SoftGOT-GOT Link Function Setting] from the menu.

2. Select the type of the resource data to be synchronized and the synchronization timing.

*1 When the file save and power-failure backup settings are configured in the GOT, select the files such as [Alarm Log File] and [GOT 
Embedded Memory (SRAM)] applicable to the settings as the synchronization targets.
In [Synchronize at the start of every monitoring], select both the target files and [GOT Embedded Memory (SRAM)].

Large resource data size affects the time required to start monitoring.
For a large amount of resource data, either of the following settings is recommended.
 • Deselect [Upload].
 • Deselect [Synchronize at the start of every monitoring].

Item Description
[Project Data Upload Setting] -

[Synchronize project data at the start of 
initial monitoring only]

Project data is synchronized only at the start of the initial monitoring in GT SoftGOT2000.
Since the second or subsequent monitoring starts with the initially synchronized project data, the time required 
to start monitoring can be shortened.
For the precautions for this setting, refer to the following.
Page 656 Precautions for setting the SoftGOT-GOT link function

[Resource Data Upload Setting] -

[Resource Data] *1 The following lists the selectable resource data.
• [Alarm log file (G2A)]
• [Logging file (G2L)]
• [Image file (JPG)]
• [Image file (BMP)]
• [Image file (PNG)]
• [PDF file (PDF)]
• [GOT Embedded Memory (SRAM)]

[Upload] Select the type of resource data to be synchronized.

[Synchronize at the start of every 
monitoring]

Select the timing to synchronize the resource data.
If this item is deselected, the resource data is synchronized only when the data is different from the project data 
in the connected GOT.
If this item is selected, the resource data is synchronized at every synchronization timing.
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■Operation at logging file (G2L) synchronization
 • Synchronizing a logging file (G2L)
When you synchronize a logging file (G2L), only its management file is uploaded before the start of monitoring.
The logging file (G2L) is uploaded in the background after the start of monitoring.
 • Upload status of a logging file (G2L)
To check the upload status of a logging file (G2L), select [Tool] → [SoftGOT-GOT Link Function] → [Resource Data Upload 
Status] from the menu.
To cancel the upload, click the [Upload Cancel] button.
If you cancel the upload of resource data, the resource data may not be uploaded even though the upload progress indicates 
that the upload has been completed.

If you cancel the upload of the logging file (G2L), the logging file is uploaded again when project data is synchronized next 
time.
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■Communication setting
For setting items of the [Communication Setup] dialog, refer to the following.
Page 83 [Communication Setup] dialog ([Connection Setup] tab)

1. Perform either of the following operations to display the [Communication Setup] dialog.

Clicking  [Communication Setup]
Selecting [Online] → [Communication Setup] from the menu
Right-clicking the mouse to select [Communication Setup] from the menu

2. Set the following items.

*1 Not available to GT SoftGOT2000 (Multiple channels).

Item Description
[Connection] [Ethernet]

[Type] Set the communication route from GT SoftGOT2000 to a controller as shown below.
• For monitoring a controller through a GOT (Ethernet connection, bus connection, direct CPU 

connection (serial), or serial communication connection) *1

[GOT]
• For monitoring a controller directly (Ethernet connection)

[MITSUBISHI ELECTRIC] or [OMRON SYSMAC]
• For using the GOT network interaction function

[MITSUBISHI ELECTRIC]

[Ethernet] [NET No.] [1]

[PC No.] [1]

[Port No.] [5001]

[Wait Time] Transmission wait time

[Option] [CPU No. switching GD 
device first No. (3 points)]

Set the values that are specified in the [Controller Setting] window in GT 
Designer3.
GT Designer3 (GOT2000) Screen Design Manual[Module No. switching GD 

device first No. (16 points)]

[Servo axis switching GD 
device first No. (16 points)]
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3. Select [Use GOT Link], and then set the following items.

4. Click the [Communication Test] button to execute the communication test between GT SoftGOT2000 and the GOT.

Precautions for the Ethernet connection
When a controller is connected to a GOT by Ethernet, use GT SoftGOT2000 to monitor the controller within 
the access range of GT SoftGOT2000 directly.
If you monitor the controller through the GOT, the communication speed decreases.

Item Description
[Destination GOT IP Address] [192.168.0.18]

[Destination GOT Port No.] [5015]

[Communication method] [TCP]

GT SoftGOT2000

A 1254

348B
A 1254

348B

A 1254

348B
A 1254

348B

GOT

Ethernet 

PLC

In remote operation (10s)

In remote operation (10s)
2 4  FUNCTIONS OF GT SoftGOT2000
4.14  SoftGOT-GOT Link Function



4

■Starting the monitor
1. GT SoftGOT2000 starts monitoring when either of the following operations is executed.
Click  [Monitor Start]
Select [Online] → [Monitor Start] from the menu.
Right-click the mouse and select [Monitor Start] from the menu.

2. The project data of GT SoftGOT2000 and the GOT are synchronized when monitoring starts.
When a password is set for a GOT project data, enter the password.

 • When using the SoftGOT-GOT link function, the project data saved in a personal computer cannot be 
opened on GT SoftGOT2000.

To open the project data in GT SoftGOT2000, deselect [Use GOT Link] in the [Communication Setup] dialog.
 • To automatically enter the password when project data are synchronized, enter a password in the [GOT 

Link Setup] dialog beforehand.
Page 83 [Ethernet]
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Managing GT SoftGOT2000 and GT SoftGOT1000 modules that 
use the SoftGOT-GOT link function (GT SoftGOT2000 
Commander)
GT SoftGOT2000 Commander is used to manage multiple modules of GT SoftGOT2000 and GT SoftGOT1000 that use the 
SoftGOT-GOT link function.
On GT SoftGOT2000 Commander, you can check the monitoring status of GT SoftGOT2000 and GT SoftGOT1000 modules, 
and start or stop monitoring on the modules.

Operating environment
The operating environment is the same as that of GT SoftGOT2000.
For details of the operating environment of GT SoftGOT2000, refer to the following.
Page 30 Operating environment
The following restrictions apply to GT SoftGOT1000 modules to be managed with GT SoftGOT2000 Commander.
Use version 3.64S or later of GT SoftGOT1000.
For details of the operating environment of GT SoftGOT1000, refer to the following.
GT SoftGOT1000 Version3 Operating Manual for GT Works3

How to install or uninstall the tool
SoftGOT2000 Commander is installed or uninstalled automatically when GT SoftGOT2000 is installed or uninstalled.
However, if comments are set by GT SoftGOT2000 Commander, the comments are not deleted even if GT SoftGOT2000 
Commander is unstalled.

Ethernet

GOT (station No.2)
Controller Controller

GOT (station No.1)

GT SoftGOT2000
Commander

GT SoftGOT2000 
(module No.2)
: Communicating with the GOT 
  (station No.2)

Management Management

Monitoring the controller 
connected to the GOT 
(station No.2) by GT 
SoftGOT2000 (module No.2)

Monitoring the controller 
connected to the GOT 
(station No.1) by GT 
SoftGOT2000 (module No.1)

GT SoftGOT2000 
(module No.1)
: Communicating with the GOT 
 (station No.1)
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Starting or exiting the tool
From the Windows start menu], select [MELSOFT] → [GT Works3] → [GT SoftGOT2000 Commander] to start GT 
SoftGOT2000 Commander. *1*2

To exit GT SoftGOT2000 Commander, perform either of the following operations.
 • Click [Menu] → [Stop] in GT SoftGOT2000 Commander.
 • Click the [×] button or the [Close] button.
*1 How to open the start menu differs depending on the Windows version.

Check how to operate Windows.
*2 For GT Works3 version 1.136S or earlier, [MELSOFT Application] appears instead of [MELSOFT].

Software license agreement
The software license agreement screen appears at the first startup of GT SoftGOT2000 Commander on MI3000.
Click the [Agree] button to start GT SoftGOT2000.
The screen does not appear if you already accepted the software license agreement on GT SoftGOT2000.

Operating procedure
The following shows the procedure to start GT SoftGOT2000 or GT SoftGOT1000 from GT SoftGOT2000 Commander.
For details on the menu, refer to the following.
Page 647 Menu item
For details on the setting items, refer to the following.
Page 648 Setting item
For details on the [Monitor Status] tab, refer to the following.
Page 649 [Monitor Status] tab
For details on the [GOT Search] tab, refer to the following.
Page 653 [GOT Search] tab

■Starting a GT SoftGOT2000 or GT SoftGOT1000 module
1. Click the [Start SoftGOT2000] button on the [Monitor Status] tab in GT SoftGOT2000 Commander.

2. The [Start SoftGOT2000] dialog appears. Configure the settings and click the [OK] button.

3. A GT SoftGOT2000 or GT SoftGOT1000 module will start.

■Exiting a GT SoftGOT2000 or GT SoftGOT1000 module
1. Select a GT SoftGOT2000 or GT SoftGOT1000 module to exit on the monitor status list in GT SoftGOT2000 

Commander.

2. Perform either of the following operations to exit the GT SoftGOT2000 or GT SoftGOT1000 module.
 • Click the [Stop] button.
 • Right-click the row of the selected GOT and select [Stop] from the context menu.

3. The GT SoftGOT2000 or GT SoftGOT1000 module will end.

For the ended GT SoftGOT2000 or GT SoftGOT1000 module, [Status] becomes [Not Started], and the module 
information remains displayed in the monitor status list.
To delete the information of the "Not Started" module from the monitor status list, select the row of the module 
and click the [Erase Machine Info] button.
To start a "Not Started" GT SoftGOT2000 or GT SoftGOT1000 module from the monitor status list, refer to the 
following.
Page 646 Starting a "Not Started" GT SoftGOT2000 or GT SoftGOT1000 module from the monitor status 
list
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■Starting a "Not Started" GT SoftGOT2000 or GT SoftGOT1000 module from the monitor status 
list

1. Select a GT SoftGOT2000 or GT SoftGOT1000 module whose [Status] is "Not Started" on the monitor status list in GT 
SoftGOT2000 Commander.

2. Perform one of the following operations to switch [Status] from [Not started] to [Online] or [Offline].
 • Click the [Status Switching] button.
 • Right-click the row of the selected GOT and select [Status Switching] from the context menu.
 • Double-click the [Status] column of the row of the selected GOT.

3. The previously started GT SoftGOT2000 or GT SoftGOT1000 module will start.
For exiting the GT SoftGOT2000 or GT SoftGOT1000 module, refer to the following.
Page 645 Exiting a GT SoftGOT2000 or GT SoftGOT1000 module

■Searching for network-connected GOTs and starting GT SoftGOT2000 or GT SoftGOT1000
1. Click the [Auto Acquisition] button on the [GOT Search] tab in GT SoftGOT2000 Commander.

2. The found GOTs are displayed in the GOT Search list. Select the target GOT and perform either of the following 
operations.

 • Click the [Start SoftGOT2000] button.
 • Double-click the row of the selected GOT.

3. The [Start SoftGOT2000] dialog appears. Configure the settings and click the [OK] button.
The settings of [GOT Type], [IP Address], and [Port No.] of the found GOTs are reflected.

4. GT SoftGOT2000 or GT SoftGOT1000 to be synchronized with the found GOTs will start.
For exiting the GT SoftGOT2000 or GT SoftGOT1000 module, refer to the following.
Page 645 Exiting a GT SoftGOT2000 or GT SoftGOT1000 module
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Menu item
■[Menu]

■[Help]

Item Description
[GT SoftGOT2000 Activation Default Setting] • [Environment Setup]

[Environment Setup] of GT SoftGOT2000 (Single channel) can be registered as default.
The default value registered can be applied as a set value when GT SoftGOT2000 (Single channel) is started 
from GT SoftGOT2000 Commander.
• [Communication Setup]

[Communication Setup] of GT SoftGOT2000 (Single channel) can be registered as default.
The default value registered can be applied as a set value when GT SoftGOT2000 (Multiple channels) is 
started from GT SoftGOT2000 Commander.
• [Reset]

Restores the setting of [Environment Setup] and [Communication Setup] to the initial value.

[GT SoftGOT2000 (Multi-channel) Activation 
Default Setting]

• [Environment Setup]
[Environment Setup] of GT SoftGOT2000 (Multiple channels) can be registered as default.
The default value registered can be applied as a set value when GT SoftGOT2000 (Multiple channels) is 
started from GT SoftGOT2000 Commander.
• [Communication Setup]

[Communication Setup] of GT SoftGOT2000 (Multiple channels) can be registered as default.
The default value registered can be applied as a set value when GT SoftGOT2000 (Multiple channels) is 
started from GT SoftGOT2000 Commander.
• [Reset]

Restores the setting of [Environment Setup] and [Communication Setup] to the initial value.

[GT SoftGOT1000 Activation Default Setting] • [Environment Setup]
[Environment Setup] of GT SoftGOT1000 can be registered as default.
The default value registered can be applied as set value when starting GT SoftGOT1000 from GT 
SoftGOT2000 Commander.
• [Communication Setup]

[Communication Setup] of GT SoftGOT1000 can be registered as default.
The default value registered can be applied as set value when starting GT SoftGOT1000 from GT 
SoftGOT2000 Commander.
• [Reset]

Restores the setting of [Environment Setup] and [Communication Setup] to the initial value.

[Exit] • Exits GT SoftGOT2000 Commander.

Item Description
[About GT SoftGOT2000 Commander] The version information of GT SoftGOT2000 Commander can be checked.
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Setting item

Item Description
[Always display GT SoftGOT2000 
Commander in front]

Select this item to display the GT SoftGOT2000 Commander window on the top front.

Checks the version information of GT SoftGOT2000 Commander.

[Monitor Status] Displays the monitoring status of GT SoftGOT2000 and GT SoftGOT1000 modules that use the SoftGOT-GOT link 
function.
Page 649 [Monitor Status] tab

[GOT Search] Searches GOTs connected to the Network.
Page 653 [GOT Search] tab

[Close] Exits GT SoftGOT2000 Commander.
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[Monitor Status] tab

Item Description
Monitor status list Displays GT SoftGOT2000 and GT SoftGOT1000 modules that use the SoftGOT-GOT link function.

When any of rows are clicked, the clicked row is highlighted and selected.
The display contents of the monitor status list displayed in icon display by the display switching button differs from the same in detail 
display.
Page 650 Display switching button

[Series] Displays the GOT series.
• [GOT2000]
• [GOT1000]

[No.] Displays the module numbers of GT SoftGOT2000 and GT SoftGOT1000.

[IP Address] Displays the IP addresses of the GOTs that communicate with GT SoftGOT2000 and GT SoftGOT1000 modules.

[N/W No.] Displays the network numbers of the GOTs that communicate with GT SoftGOT2000 and GT SoftGOT1000 
modules.
When the connection type between the GOT and controller is the bus connection or direct CPU connection 
(serial), [-] is displayed.

[PC No.] Displays the station numbers of the GOTs that communicate with GT SoftGOT2000 and GT SoftGOT1000 
modules.
When the connection type between the GOT and controller is the bus connection or direct CPU connection 
(serial), [-] is displayed.

[Project Title] Displays the project title of the project data read by the GOT.

[Status] Displays the status of GT SoftGOT2000 and GT SoftGOT1000 modules.
• [Online]: During monitoring
• [Offline]: Stopped monitoring
• [Uploading]: During reading project data from the GOT
• [Not Started]: The target GT SoftGOT2000 or GT SoftGOT1000 module is not started.

[Comment] Displays the comment entered in the [No. n Property] dialog.

Display switching button Clicking the  button displays the monitor status list in detail.
Clicking the  button displays the monitor status list with icons.
Page 650 Display switching button

[Front Display] Displays the GT SoftGOT2000 or GT SoftGOT1000 module selected in the monitor status list in the foreground.
The target module is displayed in the foreground also by double-clicking a cell of the [Series], [No.], [IP Address], [N/W No.], [PC 
No.], or [Project Title] column in the target module row in the monitor status list.
However, the target module in the back screen mode is not displayed in the foreground by clicking the [Front Display] button.
If you overlap a GT SoftGOT2000 or GT SoftGOT1000 module in the foreground and GT SoftGOT2000 Commander, GT 
SoftGOT2000 Commander is displayed in front of the module.

[Status Switching] Switches the status of the GT SoftGOT2000 or GT SoftGOT1000 selected from the monitor status list (Online and Offline, or Not 
Started to Online/Offline).
The monitor status can also be switched when [Status] in each row of the monitor status list is double-clicked.
However, the monitor status cannot be switched while [Uploading] is displayed on [Status].

Display switching 
button

Monitor status 
list
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■Display switching button
The display switching button switches the monitor status list between detail display and icon display.
When in icon display, [No.] and [IP Address] are displayed in the monitor status list.

■Context menu
Right-click a row in the detail display or an icon in the icon display in the monitor status list to display the context menu.
In the context menu, [Front Display], [Status Switching], [Stop], [Comment Edit], and [Erase Machine Info] can be selected.

[Start SoftGOT2000] Displays the [Start SoftGOT2000] dialog.
Page 651 [Start SoftGOT2000]

[Stop] Ends the GT SoftGOT2000 or GT SoftGOT1000 selected from the monitor status list.

[Comment Edit] Displays the [No. n - Property] dialog.
The [No. n - Property] dialog is displayed also by double-clicking a cell in the [Comment] column in the monitor status list.
Page 652 n module number property

[Erase Machine Info] Erases the module information of the GT SoftGOT2000 and GT SoftGOT1000 selected from the monitor status list.
The information of the GT SoftGOT2000 and GT SoftGOT1000 being activated cannot be erased.

Item Description

Detail display 
button

Icon display 
button
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■[Start SoftGOT2000]

*1 If the setting of [Series] is switched to [GOT1000], the displayed item is changed to [Activate GT SoftGOT1000 and start monitoring].

Item Description
[Series] The software applicable to the selected series is started.

• [GOT2000]: GT SoftGOT2000 starts.
• [GOT1000]: GT SoftGOT1000 starts.

[No.] Set the module number of GT SoftGOT2000 or GT SoftGOT1000 to start.

[Environmental Setup] Configure the environment settings of GT SoftGOT2000 or GT SoftGOT1000 to start.
The settings are identical to [Environment Setup] of GT SoftGOT2000 or GT SoftGOT1000.
Page 68 [Environment Setup] dialog

[GT SoftGOT2000], [GT SoftGOT2000 
(Multi-channel)]

When [GT SoftGOT2000] is selected, the setting dialog for GT SoftGOT2000 (Single channel) opens.
When [GT SoftGOT2000(Multi-channel)] is selected, the setting dialog for GT SoftGOT2000 (Multiple channels) 
opens.

[Communication Setup] Configure the communication settings of GT SoftGOT2000 or GT SoftGOT1000 to start.
The settings are identical to [Communication Setup] of GT SoftGOT2000 or GT SoftGOT1000.
Page 75 [Communication Setup] dialog

[Default Setting Reflection] Collectively applies the default settings to the environment setup and the communication setup of GT SoftGOT2000 
or GT SoftGOT1000 to start.
If the environmental setup or the communication setup has already been configured in the specified software, the 
setup contents are overwritten with the default settings.

[Activate GT SoftGOT2000 and start 
monitoring] *1

Starts monitoring automatically after GT SoftGOT2000 is started.

[Activate in the monitor-only mode] Starts GT SoftGOT2000 or GT SoftGOT1000 in the monitor-only mode.
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■n module number property

Item Description
[Comment] Up to 255 characters can be entered.

One line feed is counted as two characters.
The comments are saved with the IP address of the GOT linked.
Comments are related to the IP addresses of GOTs. Therefore, even though the module numbers of the GT 
SoftGOT2000 and GT SoftGOT1000 to communicate with the GOTs have been changed, the comments set to the 
modules before the changes will be displayed.
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[GOT Search] tab

*1 When no [No.] checkbox is selected, selecting [Display the checked GOT only] will display nothing in the GOT Search list.

■Search target GOT
The auto acquisition searches only GOT2000 (GT27, GT25, and GS25) and GOT1000 (GT16) models.
GOTs that do not use the SoftGOT-GOT link function will also be searched for, and [GOT Type], [IP Address], and [Port No.] 
will be displayed.

■IP Address duplication
If a duplicated IP address is found in the search result, the applicable GT SoftGOT2000 or GT SoftGOT1000 module cannot 
be started from the GOT Search list.
Also, the duplication of [IP Address] may not be found, even if existing.
Therefore, make sure to check the whole system before searching again.

Item Description
[Display the checked GOT only] The GOT Search list displays only the GOTs corresponding to the [No.] checkboxes selected. *1

Once this item is selected, the displayed GOTs will remain the same even when GT SoftGOT2000 Commander is started 
again or the [Auto Acquisition] button is clicked.

GOT Search list Displays found GOTs.
Click the row to select and highlight it.

[No.] Displays the number of found GOTs.

[GOT type] Displays the type of found GOTs.

[IP Address] Displays the IP address of found GOTs.

[Port No.] Displays the port No. used for uploading the project data of found GOTs.

[Auto Acquisition] Clicking the [Auto Acquisition] button displays the [GOT Type], [IP Address] and [Port No.] of the searched GOT.

[Start SoftGOT2000] Displays the [Start SoftGOT2000] dialog.
The [Start SoftGOT2000] dialog can be also displayed by double-clicking the GOT row selected in the GOT Search list.
The settings are identical to the [Start SoftGOT2000] dialog in the [Monitor Status list] tab.
Page 651 [Start SoftGOT2000]

GOT Search list
4  FUNCTIONS OF GT SoftGOT2000
4.14  SoftGOT-GOT Link Function 653



65
■Settings on Resolution, IP Address and Destination GOT Port No.
Clicking [Communication Setup], [Environment Setup] or [OK] on the [Start SoftGOT2000] dialog displays the following dialog.

 • Select [Yes].
Changes [Resolution] in the environmental setting to [GOT Type] of the row selected in the GOT Search list.
Changes [Destination GOT IP Address] and [Destination GOT Port No.] in the [Communication Setup] dialog to [IP
Address] and [Port No.] of the row selected in the GOT Search list.
 • Select [No].
GT SoftGOT2000 and GT SoftGOT1000 are started with the values set in the [Communication Setup] and [Environment 
Setup] dialogs.
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Precautions

Settings and OS required for the GOT
■Ethernet setting
Set [GOT IP Address] and [Ethernet Download Port No.] for project data.
Page 636 Settings in the [GOT Ethernet Setting] window

■Extended function OS
Install the extended function OS (SoftGOT-GOT Link Function) on the GOT.
GT Designer3 (GOT2000) Screen Design Manual

Precautions for the Ethernet connection
For the precautions for the Ethernet connection, refer to the following.
Page 298 Precautions

Setting devices which affect the control of GOT/GT SoftGOT2000
It is recommended to set a GOT internal device for a control device of the function which affects the control of the GOT/GT 
SoftGOT2000 (including the system signal, screen switching device, or security level device).
When a controller device is set for the device which affects the control of the GOT/GT SoftGOT2000, due to an operation of 
either GT SoftGOT2000 or the GOT, an unexpected behavior may be caused to the other.
The following shows the setting example of how to enable the function which affects the control of the GOT/GT SoftGOT2000 
only when the authorization is obtained by using a GOT internal device and the script function.
Example: When the authorization is obtained, the screens of GT SoftGOT2000 and the GOT are switched  according to the 
value (screen number) of a controller device (D1000)

For the screen switching device, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual
For the script function, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

Function not available with the SoftGOT-GOT link function
The following functions cannot be used with the SoftGOT-GOT link function.
 • Gateway server function
 • PX developer function call
 • GOT Mobile function

Operation without the authorization
Clicking and touching an input object are not recognized as input operations if the authorization is not obtained.
The dialog for obtaining the authorization appears.
(When the GOT has the exclusive authorization, GT SoftGOT2000 cannot obtain the authorization.)

Function Setting
Screen switching device Set a GOT internal device (GD1000).

Script function Set the following project script in which the trigger type is set to [Ordinary].
if([b:GS244.b1] == ON){
[w:GD1000] = [w:D1000];
}
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Precautions for project data/resource data synchronization
■Precautions during project data synchronization
Do not perform the following operations during the project data synchronization.
 • Turn off the GOT or a controller.
 • Press the reset button of the GOT.
 • Disconnect the communication cable.
 • Turn off the personal computer.
If the operations listed above are performed during the project data synchronization, GT SoftGOT2000 project data and GOT 
project data may differ.
Select [Tool] → [GOT Project Data Acquisition], and synchronize GT SoftGOT2000 project data with GOT project data again.

■Synchronization when the GOT network interaction function is used
When the GOT network interaction function is used together with the SoftGOT-GOT link function, multiple GT SoftGOT2000 
modules can communicate with one GOT.
When the GOT project data is synchronized, the SoftGOT2000 modules start reading the data from the GOT in sequence.

■When the GOT network interaction function is enabled or disabled
During the project data synchronization, if you enable or disable the GOT network interaction function while the GOT is in 
online mode, restart GT SoftGOT2000.

■Timing of which the project data synchronization is not executed
During the following operations, project data are not synchronized.
The project data synchronization is executed when the operation ends.
While displaying the print preview
While displaying the dialog which disables operation of other screens if the dialog is displayed

■Resource data in drive N
The resource data in drive N is not synchronized.
To synchronize the resource data, copy the necessary data in drive N to a virtual drive before starting monitoring.

■Resource data in drive V
The resource data in drive V is not synchronized.

■Resource data when the multi-channel function is used for the GOT
Regardless of the number of channels for controllers connected to the GOT, GT SoftGOT2000 data is synchronized with all 
GOT resource data.
After resource data synchronization, GT SoftGOT2000 only monitors a controller of channel number 1. Therefore, GT 
SoftGOT2000 only updates resource data for the controller of channel number 1.
(In GT SoftGOT2000 (Single channel), the resource data are not updated for controllers of channel numbers other than 1.)

■Precautions for setting the SoftGOT-GOT link function
 • The SoftGOT-GOT link function cannot be set after the start of monitoring.
Set the function before starting the monitoring.
 • When an image file is used for the document display or parts, select the image file format that is set with GT Designer3.
 • Store up to 499 files in one folder.
If you store 500 files or more in one folder, file access performance may be slowed down.
 • When [Synchronize project data at the start of initial monitoring only] is selected in the [SoftGOT-GOT Link Function 

Setting] dialog
When [Synchronize project data at the start of initial monitoring only] is selected, monitoring starts with initially synchronized 
project data without subsequent synchronization.
Therefore, the data may differ from the project data in the connected GOT.
Page 639 SoftGOT-GOT link function setting
To synchronize the project data in the connected GOT, perform one of the following operations.
Deselect [Synchronize project data at the start of initial monitoring only ] and start monitoring again.
After the start of monitoring, select [Tool] - [SoftGOT-GOT Link Function] - [GOT Project Data Acquisition] to synchronize 
the project data.
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■Precautions for logging file (G2L) synchronization
The logging file (G2L) in GT SoftGOT2000 may be overwritten with the one uploaded from the GOT, if the file names are the 
same.
To avoid overwriting the logging file (G2L) in GT SoftGOT2000, select [Add date information to the file name] in the [Logging] 
dialog on GT Designer3.
For details of the [Logging] dialog, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

■Precautions for synchronizing the built-in memory (SRAM) of the GOT
When the built-in memory (SRAM) of the GOT is synchronized, the data in the SRAM user area of GT SoftGOT2000 will be 
deleted.
In this case, GT SoftGOT2000 operates with the settings configured in the GOT.
For the functions that use the built-in memory of the GOT, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual
When [Initialize SRAM user area at the time of initial monitoring] in the [Environment Setup] dialog is selected, GT 
SoftGOT2000 starts monitoring after deleting the data acquired in the built-in memory (SRAM) of the GOT.
To synchronize the built-in memory (SRAM) of the GOT, deselect [Initialize SRAM user area at the time of initial monitoring].

Using the SoftGOT-GOT link function in the system that requires the quick 
communication response
When the SoftGOT-GOT link function is used in the system that requires the quick communication response, the Ethernet 
connection is recommended between the GOT and the monitor PLC.
If a PLC connected to a GOT by the direct CPU connection (serial) is monitored by the SoftGOT-GOT link function, the 
response of GT SoftGOT2000 becomes slow.

When the started GOT has project data protected with a security key
GT SoftGOT2000 cannot read the project data.
To read the project data from the GOT, delete the security key from the project data, and then start the GOT.
For the details of the security key, refer to the following.
GT Designer3 (GOT2000) Screen Design Manual

When using the SoftGOT-GOT link function of GT SoftGOT1000
For the precautions and restrictions for using the SoftGOT-GOT link function of GT SoftGOT1000, refer to the following.
GT SoftGOT1000 Version3 Operating Manual for GT Works3
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4.15 Interaction with PX Developer
The monitor tool function of PX Developer can be called on GT SoftGOT2000.
In PX Developer, when registering GT SoftGOT2000 as the user graphic screen, the registered GT SoftGOT2000 can be 
started up.
With interaction between GT SoftGOT2000 and PX Developer, their functions can be shared.
Thus, the interaction improves the operational performance for combining the functions.

For methods of interaction between GT SoftGOT2000 and PX Developer, refer to the following manual.
 PX Developer Version □ Operating Manual (Monitor Tool)
To call monitor tool functions for PX Developer on GT SoftGOT2000, the setting for the special function switch is required.
For details on the setting, refer to the following.
 GT Designer3 (GOT2000) Screen Design Manual

Security level change
By changing the mode with the monitor tool of PX Developer, the security level of GT SoftGOT2000 can be changed to the 
level corresponding to the mode.
For how to change the security level when changing the mode, refer to the following.
 PX Developer Version □ Operating Manual (Monitor Tool)
When changing the security level, use PX Developer Version1.31H or later.

<Setting on GT Designer3> <Interaction between GT SoftGOT2000 and PX Developer>

Set the PX Developer function call for a special function 
switch on GT Designer3.

Touch the special function switch, and then the monitor tool 
function for PX Developer set on GT Designer2 is called.

Screen of the called monitor tool function
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Setting method

Before interaction with PX Developer
For interaction with PX Developer, the setting is required respectively for GT SoftGOT2000 and PX Developer.
The following describes the settings required for interaction with PX Developer.

■Settings on GT SoftGOT2000
Set to the online mode at start-up.
Page 56 Starting GT SoftGOT2000 automatically when starting Windows
Do not check the [Display dialog when starting GT SoftGOT2000, specified with the module that has been activated.] of the 
[Auxiliary Setup] tab on the environment setup dialog.
Page 67 Environment Setup
Do not check [Display dialog when closing GT SoftGOT2000.].
Page 67 Environment Setup
Call project data on GT SoftGOT2000.
Page 104 Opening the Project

Opening project data
Set the PX Developer function call for the current project data opened on the GT SoftGOT2000.
For the following cases, open the project data on GT SoftGOT2000.
When the project data has never been opened on GT SoftGOT2000
When the target project data differs from the last monitored project data

When GT SoftGOT2000 is displayed in the full screen mode for the interaction with PX Developer, set the back screen mode 
for GT SoftGOT2000, and then monitor tool windows are not behind GT SoftGOT2000.
Page 676 Back Screen Mode

■Settings on PX Developer
For the settings on PX Developer, refer to the following manual.
 PX Developer Version □ Operating Manual (Monitor Tool)
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PX Developer function call setting
Set to call monitor tool functions on GT SoftGOT2000.
To call monitor tool functions for PX Developer on GT SoftGOT2000, the special function switch to which the [PX Developer 
function call] is set is required.
Set the special function switch with GT Designer3.
For details on the setting, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual
After setting the PX Developer function call in the special function switch with GT Designer3, the settings can be changed on 
GT SoftGOT2000.
(To change the settings, starting GT Designer3 is not needed.)
The following describes the method for changing the settings on GT SoftGOT2000.

1. Operate any of the followings.

Click  [PX Developer Function Call Setting].
Select [Set] → [PX Developer Function Setting] → [PX Developer Function Call Setting] from the menu.
Right-click the mouse and select [Set] → [PX Developer Function Call Setting] from the menu.

2. The dialog appears for the [PX Developer function call setting].
Set the dialog with reference to the following list.

Item Description
[Toolbar] The functions of the toolbar are shown.

[OK] Press the button to accept the settings and close the dialog.

[Cancel] Press the button to cancel the setting and close the dialog.

[Test] Call the monitor tool function that is checked in the [Call] column.
The name of the function is shown in the [Function] column.
The function is used to check a monitor tool function to be called and the position to be displayed when setting with GT Designer3.
The display position for the monitor tool is always at the upper left of screen.
([Set to the relative coordinates to GT SoftGOT2000] checked in [Display Position Setting] are disabled.)
For restrictions for calling monitor tool functions, refer to the following manual.
 PX Developer Version □ Operating Manual (Monitor Tool)

[Call] Assign the functions that is checked in the [Call] column to the special function switch.
The setting is available only with GT Designer3.
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Precautions for changing PX Developer function call setting
During changing the PX Developer function call setting on GT SoftGOT2000, do not change the PX developer 
function call setting of the same project data on other GT SoftGOT2000 or GT Designer3.
When the PX Developer function call setting of the same project data is changed on multiple software, the 
setting saved at the last is enabled.
The settings saved before the last one are deleted.

■Setting for display position
In the setting dialog for the display position, the position can be set for displaying monitor tool windows to be called.

[Function] Select monitor tool functions to be called when touching the special function switch.
The following indicates the applicable functions.
• [Faceplate]
• [Control Panel]
• [Trend Graph]
• [Alarm List]
• [Event List]
• [Find]
• [Change Mode]
• [Communication Status]
• [Stop Buzzer]
• [Show the Monitor toolbar]
• [Hide the Monitor toolbar]
• [Deactivate the Monitor tool]

For details for each function, refer to the following manual.
 PX Developer Version □ Operating Manual (Monitor Tool)

[Parameter] Input an argument when calling a monitor tool function.
The following indicates the applicable functions and their settings.
• Faceplate         : Tag name
• Control Panel   : Group name
• Trend Graph     : Group name

[Position] Set the display position of monitor tool windows to be called.
Click the  button to show the setting dialog for the display position.
For the details, refer to the following.
Page 661 Setting for display position

[Comment] Comments can be entered arbitrarily.
(Up to 512 characters regardless of whether single-byte or double-byte)

[Status bar] The function call number, which is checked in the [Call] column, is indicated.
Double-click the displayed function call number to show the column checked in [Call].
The setting is available with GT Designer3.

Item Description
[Set to the relative 
coordinates to GT 
SoftGOT 2000.]

To display monitor tool windows in the fixed position on the display regardless of whether display is GT SoftGOT2000, do not 
check the item.
If not checked, the coordinates of the display position can be set with their origin at the upper left on the display of a personal 
computer.
Check the item to always display monitor tool windows in the fixed position on GT SoftGOT2000.
If checked, the coordinates of the display position can be set with their origin at the upper left on the display of a personal 
computer.

Item Description
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[Window selection] Set the display position when calling monitor tool functions.
To display monitor tool windows, Set the coordinates in [Top], [Left], [Right] and [Bottom].

The coordinates can be automatically set with the  (Aiming mark).
The following describes how to use aiming mark.
1) Set a window at the position of a monitor tool window to be displayed.
(Any windows, including monitor tool windows, can be positioned.)

2) Drag the aiming mark to the set window.
If dragged, the window is surrounded with a black frame.
Release the mouse button on the window surrounded with a black flame.

3) The coordinates of the set window are input in the setting dialog for the display position.

Do not use  (Aiming mark) if [Set to the relative coordinates to GT SoftGOT2000.] is checked.
Directly input the coordinates. (Applicable range: -32768 to 32767)

[Top] Set X-coordinate on the upper left of the window.

[Left] Set Y-coordinate on the upper left of the window.

[Right] Set X-coordinate on the upper right of the window.

[Bottom] Set Y-coordinate on the upper right of the window.

Item Description

100

100 300

600
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PX Developer function call sub-setting
1. Operate any of the followings.

Click  [PX Developer Function Call Sub-Setting].
Select [Set] → [PX Developer Function Setting] → [PX Developer Function Call Sub-Setting] from the menu.
Right-click the mouse and select [Set] → [PX Developer Function Call Sub-Setting] from the menu.

2. The dialog appears for the [PX Developer function call sub-setting].
Set the dialog with reference to the following explanation.

Item Description
[Create PX Developer 
Function call history.]

Check the item to register the calling status of monitor tool functions as a history.
For available information as history, refer to the following.
Page 664 PX Developer function call history
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PX Developer function call history
Histories for calling monitor tool functions can be registered.

Available information as history
The following information can be registered as a history.
Success of calling monitor tool functions
Failure of calling monitor tool functions

Referencing history data
The following describes the reference method of the history data.

1. Operate any of the followings.

Click  [PX Developer Function Call History].
Select [Set] → [PX Developer Function Setting] → [PX Developer Function Call History] from the menu.
Right-click the mouse and select [Set] → [PX Developer Function Call History] from the menu.

2. The history data appears.

History data
When history data is not registered, the PX Developer function call history cannot be referenced.
To reference the history data, check [Create PX Developer Function call history.] in the PX Developer function 
call sub-setting.
For the PX Developer function call sub-setting, refer to the following.
Page 659 Setting method
The history data is managed for each module as shown below.
The data is not deleted even if GT SoftGOT2000 is exited.
The unnecessary data is required to delete by the user.

Precautions

Manipulation of the setting file for calling the PX Developer function
When you save the project for GT SoftGOT2000 in the single file format (*.GTX), a setting file (*.dat) for calling the PX 
Developer function is created in the same folder.
Do not delete the setting file (*.dat).
If you copy or move the project to another folder, also copy or move the setting file (*.dat) to the folder.

2007/01/10 10:56:47 No.1 Function Call No.1 : Failed to call PX Developer Function.
2007/01/10 10:57:39 No.1 Function Call No.1 : PX Developer Function has been called.
2007/01/10 10:57:53 No.1 Function Call No.2 : Failed to call PX Developer Function.
2007/01/10 11:07:56 No.1 Function Call No.2 : PX Developer Function has been called.
2007/01/11 17:10:35 No.1 Function Call No.3 : PX Developer Function has been called.
2007/01/12 13:25:11 No.1 Function Call No.4 : PX Developer Function has been called.

PX Developer function call history data

MELSOFT (Installation folder)

SGT2000

Multi

00001

SoftGOT_PXFuncLog.txt
4 4  FUNCTIONS OF GT SoftGOT2000
4.15  Interaction with PX Developer



4

4.16 Edgecross Interaction Function
The Edgecross interaction function enables GT SoftGOT2000 to monitor the data collected by Edgecross.
To use this function, install GT SoftGOT2000 on an Edgecross-installed personal computer or MELIPC.
The data collected by Edgecross is stored into SoftGOT2000 internal devices (SGB and SGD).
You can perform real-time diagnostics or feedback from GT SoftGOT2000 to a controller.
The Edgecross interaction function is supported by Edgecross version 1.00.
The following illustrates a system configuration.

*1 The Edgecross interaction function is usable without physical connection between GT SoftGOT2000 and a controller.

Personal computer

Reading the file, and storing the file data 
into GT SoftGOT2000 internal devicesOutputting a file

Applicable connection type
*1

Controller

Production sites

Edgecross

Data 
collector

Data 
collector

Data 
collector

Networks

GT SoftGOT2000
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Setup procedure
The following outlines how to configure the Edgecross interaction function.

1. On Real-time Flow Designer, configure the settings of data to be collected.
Manual of Edgecross

2. On Real-time Flow Designer, specify the file format in which the collected data will be saved.
Manual of Edgecross

3. On GT SoftGOT2000, assign the data items to be collected by Edgecross to GT SoftGOT2000 internal devices.
Page 669 Settings on GT SoftGOT2000

4. Create an Edgecross interaction configuration file.
For the format of the configuration file, refer to the following.
Page 667 Format of an Edgecross interaction configuration file

5. On GT Designer3, create a project.
Specify the SoftGOT2000 internal devices set in step 3 for objects and common settings.
GT Designer3 (GOT2000) Screen Design Manual

6. On GT SoftGOT2000, configure the communication settings between GT SoftGOT2000 and a controller.
Page 74 Setting the Communication Method

7. On GT SoftGOT2000, start monitoring using the project created in step 5.

 • When using the Edgecross interaction function
If you use the Edgecross interaction function without physical connection between GT SoftGOT2000 and a 
controller, configure the settings as shown below.
Doing so will allow you to use the Edgecross interaction function without a communication error.
In GT Designer3, set [Manufacturer] to [MODBUS], and set [Controller Type] to [MODBUS 
Slave(GOT:Master)] in the [Controller Setting] window.
On GT SoftGOT2000, set [Connection] to [Ethernet], and set [Type] to [MODBUS Master(GOT:Slave)] in the 
[Communication Setup] dialog.
 • When shortening the refresh cycle of Edgecross monitoring
Edgecross monitoring is refreshed every time a file is created.
To shorten the refresh cycle, set the following in Real-time Flow Designer.
Minimize the cycle of saving files.
Specify the number of rows of data output to a file to 1.
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Specifications of an Edgecross interaction configuration file and 
SoftGOT2000 internal devices

Supported data types
The following shows the data types handled by Edgecross and their availability on GT SoftGOT2000.
○: Supported, ×: Not supported

Format of an Edgecross interaction configuration file
An Edgecross interaction configuration file must be in Shift-JIS CSV (comma-separated) format.
Configure the settings in the file according to the data collection settings made on Real-time Flow Designer.
The following shows the format of the configuration file.

1):VERSION
Version of the data structure.
Specify 0.
2):FILE_FORMAT
Specify the file format of the real-time data that is set on Real-time Flow Designer.
The following shows the setting range.
0: CSV format (Character code: Shift JIS)
1: CSV format (Character code: UTF-8 with BOM)
3):SAVE_DESTINATION_FOLDER
Specify the storage folder of the real-time data that is specified on Real-time Flow Designer.
4):FILE_NAME_PREFIX
Specify a string to be prefixed to the filename of the real-time data that is set on Real-time Flow Designer.

Data type handled by Edgecross Output format Use on GT SoftGOT2000
BOOL (Bit) ON: 1OFF: 0 ○

UINT (Word [Unsigned]) Integer ○

Hexadecimal ×

UDINT (Double word [Unsigned]) Integer ○

Hexadecimal ×

ULINT Integer ×

Hexadecimal ×

INT (Word [Signed]) Integer ○

DINT (Double word [Signed]) Integer ○

LINT Integer ×

REAL (Single-precision real number) Decimal (number of digits: n) ○

Exponent (number of digits: n) ×

LREAL None ×

STRING None ×

WSTRING None ×

1)
2)
3)

4)
5)

6)
7)

8) 9) 10)
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5):MONITORING_CYCLE
Specify the monitoring interval for the files output from Edgecross.
The setting range is 1 to 100 (× 100 ms).
6):DATA_NUM
Specify the number of data items to be monitored.
The setting range is 1 to 256.
Match the number of data items set for [:DATA_NUM] with the number of data items set for [:NO], [:DATA_NAME] and 
[:DATA_TYPE].
7):NO
Specify a consecutive number.
The setting range is 0 to 255.
8):DATA_NAME
Specify a data item name that is set on Real-time Flow Designer.
Up to 32 characters can be set.
9):DATA_TYPE
Specify the data type of a SoftGOT2000 internal device to which a data item is assigned.
For the usable data types, refer to the following.
Page 667 Supported data types
10):DEVICE
Specify a SoftGOT2000 internal device to which a data item is assigned.
The following shows the setting ranges.
SGB0 to SGB65535
SGD0 to SGD65535

Specifications of accessing the files output from Edgecross
The data collected by Edgecross is written into SoftGOT2000 internal devices according to the allocation settings made in the 
[Edgecross Interaction Function Setting] window.
If inconsistency exists between the data collection settings of Real-time Flow Designer and the allocation settings, the 
relevant data will not be written into the specified SoftGOT2000 internal device.
When consecutive SoftGOT2000 internal devices are required to store data, if any of the devices is out of the device range, 
the relevant data will not be written into the devices.
In this case, no write error message appears.
Example) If a double-word data item is assigned to SGD65535, the value of the data item will not be written.

SoftGOT2000 internal devices (SGB and SGD)
SoftGOT2000 internal device refers to a data storage area used by GT SoftGOT2000.
SoftGOT2000 internal devices are usable for any connection type, but they cannot be controlled by the sequenceprogram of 
a controller.
When you exit GT SoftGOT2000, these devices are reset to 0.
The SoftGOT2000 internal devices are classified into two types: SoftGOT bit registers and SoftGOT data registers.

Device Description
SoftGOT bit register (SGB) Can be used as bit devices.

The devices come in useful if they are used in processing that does not need connection by way 
of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.

SoftGOT data register (SGD) Can be used as word devices.
The devices come in useful if they are used in processing that does not need connection by way 
of a controller, such as the following.
• Screen switching device
• Work area for the script function
• Read value storage area for bar codes.
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Settings on GT SoftGOT2000
To use the Edgecross interaction function, configure the following settings.
Select [Set] → [Edgecross Interaction Function Setting] from the menu to display the following window.

Configuring the settings during monitoring
Configure the settings in this window before start monitoring.
The settings cannot be configured during monitoring.

Precautions

Settings in an Edgecross interaction configuration file
■Settings of DATA_TYPE and DEVICE
Ensure consistency in the data collection settings of Real-time Flow Designer and the SoftGOT2000 internal device settings.
If any data type or device type is inconsistent, values may be written into unexpected areas.

■Settings of DATA_NAME
Do not set TIME and INDEX in DATA_NAME.
Doing so disables the correct monitoring.

■Invalid character code
Use Shift-JIS characters for an Edgecross interaction configuration file.
The Edgecross interaction function may not operate properly if any character other than Shift-JIS characters are used.

Specifying the maximum number of files to be saved on Real-time Flow Designer
Specify the maximum number of files to be saved to 2 or more on Real-time Flow Designer.
If 1 is specified, the Edgecross interaction function may not operate properly.

Item Description
[Use Edgecross Interaction Function] Enables the Edgecross interaction function.

[Allocation Setting] Select the checkbox for the allocation setting to be used.
Click the corresponding allocation setting button to create an Edgecross interaction configuration file.
The default application for CSV files will open a new file.
In the file, assign Edgecross data items to SoftGOT2000 internal devices.
Page 667 Specifications of an Edgecross interaction configuration file and SoftGOT2000 internal devices
An Edgecross interaction configuration file is created for the GT SoftGOT2000 module in use.
Example) Path to the Edgecross interaction configuration file when [Allocation Setting 1] is selected on GT 
SoftGOT2000 module No. 1
(Installation path of the module)\Multi\00001\EdgecrossSet\EdgecrossSet_001.csv
You can copy an Edgecross interaction configuration file, and edit the copied file to configure another allocation 
setting.
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4.17 Full Screen Mode
The full monitor screen of GT SoftGOT2000 can be displayed on the personal computer screen.

Operations in full screen mode
Full screen mode hides the menu bar, toolbar and status bar, and so you cannot perform some operations such as exiting GT 
SoftGOT2000.
The following shows how to operate GT SoftGOT2000 in full screen mode.
Displaying the menu bar and toolbar
Right-click anywhere in the window.
Press and hold anywhere on the screen to display the right-click context menu.
To display the right-click context menu with press-and-hold operation, configure settings in the [Environment Setup] dialog.
Page 73 [Touch Operation Setup] tab
Minimizing the window
Hold down the [Shift] key and double-click anywhere in the window.
Exiting GT SoftGOT2000
Press the [F12] key.

Resolution of the project data
To display a monitor screen in full screen mode, set the same resolution for the personal computer display and 
the project data.

When the full screen mode

function is not use
When the full screen mode

function is used

When the full screen mode function is used,

the part of the frame  is hidden and the full monitor 

screen can be displayed on the personal computer.

When the full screen mode function is not used,

the part of the frame is displayed.
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Full screen mode types
There are three full screen modes: full screen 1, full screen 2, and full screen 3.

Full screen 1
Only a monitor screen is displayed fully on the screen.
Use this function with the personal computer or panel computer where a mouse and keyboard are connected.

Full screen 2
A monitor screen is displayed fully on the screen, and a small dialog is displayed.
The following operations are available in the small dialog.
[Min]: Minimizes the window of GT SoftGOT2000.
[Exit]: Exits GT SoftGOT2000.
Since GT SoftGOT2000 can be exited on the monitor screen, it can be used for the panel computer where a mouse and 
keyboard are not connected.
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Full screen 3
A monitor screen is displayed fully on the screen, and a small dialog is also displayed.
The following operations are available in the small dialog.
[Open]: Opens a project.
[Online]: Starts monitoring. (Not selectable during monitoring)
[Min]: Minimizes the window of GT SoftGOT2000.
[Exit]: Exits GT SoftGOT2000.
Since GT SoftGOT2000 can be exited on the monitor screen, it can be used for the panel computer where a mouse and 
keyboard are not connected.

Exiting the full screen mode
Turning ON the GOT internal device (system information area of GT SoftGOT2000: GS500.b0) exit GT 
SoftGOT2000.
By setting the above device as a touch switch, GT SoftGOT2000 can be exited without using a mouse and 
keyboard.
For details of the GOT internal device, refer to the following manual
GT Designer3 (GOT2000) Screen Design Manual
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Setting method
The full screen mode can be set either before or after starting GT SoftGOT2000.

Setting before starting GT SoftGOT2000
The following shows how to start GT SoftGOT2000 in full screen mode from a shortcut.
In the following procedure, you start GT SoftGOT2000 (Single channel) in full screen 1 as an example.

1. Create a shortcut to GT SoftGOT2000.
For GT SoftGOT2000 (Single channel): SGT2000.exe
For GT SoftGOT2000 (Multiple channels): SGT2000_MultiCH.exe

2. Right-click the shortcut, and select [Properties].

3. As the GT SoftGOT2000 properties appear, choose the [Shortcut] tab and add the keyword of the mode to be used to 
[Target].

*1 A one-byte blank is required to be prefixed to "-".

4. After addition, click the [OK] button.

5. When GT SoftGOT2000 is started next, GT SoftGOT2000 is started in the full screen mode.

6. When you cancel the full screen mode, delete the keyword added to [Target].

When starting the GT SoftGOT2000 with the specified module number in the full-screen mode
The specified module of GT SoftGOT2000 can be started in the full-screen by entering the keyword for both 
full screen mode and module No. in the [Target] of [GT SoftGOT2000 Properties].
(There are no rules for the order of entering keywords.)
Example) Starting GT SoftGOT2000 (Single channel) module No. 3 in full screen 1

Refer to the following for module keyword.
Page 58 Directly starting the specified GT SoftGOT2000 module

Keyword Description
-NOFRAME *1 Displays the screen in full screen 1.

-NOFRAMEDLG *1 Displays the screen in full screen 2.

-NOFRAMEDLGMENU *1 Displays the screen in full screen 3.

C:\Program Files\MELSOFT\SGT2000\SGT2000.exe -SGT3 -NOFRAME

A one-byte space is necessary 
in front of keyword
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Setting after starting GT SoftGOT2000
1. Select either of the following.
Select [View] → [Full Screen Mode] from the menu.
Right-click the mouse to select [View] → [Full Screen Mode] from the menu.

2. The GT SoftGOT2000 is displayed in full screen 1 mode.

3. To cancel the full screen mode, right-click the mouse to select [View] → [Full Screen Mode] from the menu.

Enabling and disabling full screen mode with GOT internal device
The full screen mode of GT SoftGOT2000 can be switched between enabled and disabled states by turning 
on and off the GOT internal device (GS500.b1).
ON: GT SoftGOT2000 is displayed in the full screen mode.
OFF: The full screen mode of GT SoftGOT2000 is canceled.
For GOT internal devices, refer to the following manual.
GT Designer3 (GOT2000) Screen Design Manual

Precautions

Small dialog
The small dialog is movable but cannot be closed.
It is always displayed on the front position.

Switching to the standard screen display
When the GT SoftGOT2000 was started with a keyword, the screen cannot be switched to the standard screen display.
([Full Screen Mode] in the menu is displayed in gray.)

Full screen mode setting
The full screen mode setting is valid even when exiting the GT SoftGOT2000 and restarting it.

Display position in full screen mode
When switching to full screen mode under the environment where the resolution of the PC display and GT SoftGOT2000 are 
different, the GT SoftGOT2000 window is displayed so that the upper-left corner of the window is on the upper-left of the PC 
display.

When displaying the screen in full screen mode after starting the GT SoftGOT2000
When displaying the screen in full screen mode after starting the GT SoftGOT2000, the screen is displayed in full screen 1.
To display the screen in full screen 2 or 3, set the full screen mode with the procedure shown in Page 670 Full Screen Mode.

When multiple GT SoftGOT2000 modules are started up in the full screen mode
If multiple modules of GT SoftGOT2000 are started up in the full screen mode, only the very front screen is accessible.
To access other windows, rearrange the windows so that the window of the module to be operated is at the very front.
Refer to the following section for how to move the windows.
Page 679 Moving the Window
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4.18 Close Menu
The Close menu at the upper right of the title bar can be disabled (enabled).
The Close menu at the upper right of the title bar is grayed out when it is disabled.
Clicking the Close menu in this status does not terminate GT SoftGOT2000.
The setting selected here remains valid even after GT SoftGOT2000 is terminated and then restarted.
After making this setting, [Exit] provided in the right-click menu and the Project menu is enabled.

Close menu on the title bar

1. Follow the procedure below.
Select [Set] → [Close Menu] from the menu.
Right-click the mouse, and select [Set] → [Close Menu] from the menu.

2. The Close menu at the upper right of the title bar is disabled.

3. To enable back the Close menu at the upper right of the title bar, select [Set] → [Close Menu].
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4.19 Back Screen Mode
The monitor screen of GT SoftGOT2000 is always displayed behind all the other screens.
In this mode, other applications can be used while GT SoftGOT2000 is displayed in full-screen.

1. Operate any of the followings.
Select [View] → [Back Screen Mode] from the menu.
Right-click the mouse and select [View] → [Back Screen Mode] from the menu.

2. GT SoftGOT2000 is displayed behind all other screens.

3. To cancel the settings, operate any of the followings.
Select [View] → [Back Screen Mode] from the menu.
(Note that the settings cannot be canceled in the menu bar if displayed in full screen.)
Right-click the mouse and select [View] → [Back Screen Mode] from the menu.
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4.20 Enabling or Disabling the Exit Key
Disable (or enable) exiting GT SoftGOT2000 with the [F12] key of the keyboard.

1. Select [Set] → [Exit Key [F12]] from the menu.

2. Exiting GT SoftGOT2000 with the [F12] key is disabled.
To exit GT SoftGOT2000, use other methods such as clicking the relevant menu command.

3. To enable exiting GT SoftGOT2000 with the [F12] key again, select [Set] → [Exit Key [F12]] from the menu.
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4.21 Scroll Function
The scroll bars are displayed when GT SoftGOT2000 pane is resized to a smaller size.

1. Operate the following.
Select [View] → [Scroll Bar] from the menu.

2. The scroll bars are displayed when GT SoftGOT2000 pane is resized to a smaller size.
Scroll the monitor screen with the scroll bars, and then the hidden part of the monitor screen is displayed.
The scroll bars cannot be operated with keyboards.
The scroll bars are not displayed with the full screen mode.

3. For hiding the scroll bars, select [View] → [Scroll Bar] from the menu.
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4.22 Moving the Window
GT SoftGOT2000 can be moved by operating the mouse.
GT SoftGOT2000 can also be moved when the full screen display function, where the title bar is not displayed, is used.

Window movement types and operating procedures
There are the following window movement types.

Cascade
Cascades the windows of the active GT SoftGOT2000.
(These windows may not necessarily be in the order of module numbers, depending on the Windows specifications.)

The following shows the operating procedure.

1. Perform one of the following operations.
 • Select [Window] → [Cascade] from the menu.
 • Right-click the mouse to select [Window] → [Cascade] from the menu.

2. All the active GT SoftGOT2000 windows are displayed in a stack.

Minimize all windows
Minimizes all the windows of the active GT SoftGOT2000 modules.
The following shows the operating procedure.

1. Perform one of the following operations.
 • Select [Window] → [Minimize All Windows] from the menu.
 • Right-click the mouse to select [Window] → [Minimize All Windows] from the menu.

2. All the active GT SoftGOT2000 windows are minimized.
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Window movement
A window is moved in either of the following methods.
 • Movement with mouse
Setting the cursor of the mouse to the Move mode and moving the mouse also moves GT SoftGOT2000 with the motion of the 
mouse.
Clicking the mouse cancels the Move mode.
 • Movement with Move buttons
The UP, DOWN, LEFT or RIGHT button in the [Move window] dialog moves GT SoftGOT2000 on a 10-dot every clicking.
A window can also be moved on a panel computer that cannot use a mouse.
Set the moving method on the [Auxiliary Setup] tab in the [Environment Setup] dialog.
For the setting details, refer to the following.
Page 67 Environment Setup
The following shows the operating procedure.

■Movement with a mouse
1. Perform one of the following operations.
 • Select [Window] → [Move Window] from the menu.
 • Right-click the mouse to select [Move Window] from the menu.
After the operation, the cursor enters in the movement mode.

2. As the mouse is moved, the window moves at the same time.
Click the mouse at the window move destination to complete the movement.
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■Movement with the move buttons
1. Perform one of the following operations.
 • Select [Window] → [Move Window] from the menu.
 • Right-click the mouse to select [Move Window] from the menu.
After the operation, the [Move Window] dialog appears.

2. Click the UP, DOWN, LEFT or RIGHT button to move the window in units of 10 dots.
Close the [Move Window] dialog with the [×] button to complete the movement.

Movement to the startup display position
Moves the window to the startup display position.
The window startup display position can be set on the [Display Setup] tab in the [Environment Setup] dialog.
For the setting details, refer to the following.
Page 67 Environment Setup
The following shows the operating procedure.

1. Perform one of the following operations.
 • Select [Window] → [Move to Start-up Display Position] from the menu.
 • Right-click the mouse to select [Window] → [Move to Start-up Display Position] from the menu.

2. The window moves to the startup display position.
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Movement to the previous/next display
When multiple displays are used, move the window to the display with the previous or next display No.

The following shows the operating procedure.

■Movement to the previous display
1. Perform one of the following operations.
 • Select [Window] → [Move to Previous Display] from the menu.
 • Right-click the mouse to select [Window] → [Move to Previous Display] from the menu.

2. The window moves to the previous display.

■Movement to the next display
1. Perform one of the following operations.
 • Select [Window] → [Move to Next Display] from the menu.
 • Right-click the mouse to select [Window] → [Move to Next Display] from the menu.

2. The window moves to the next display.

Display number
Display numbers are assigned according to the display arrangement.
With the top leftmost display as [Display 1], the other displays are numbered in ascending order as shown 
below.

Up to 8 display numbers can be assigned.

1 2 43

ラインA 258

7 8 9 削除
4 5 6 クリア
1 2 3
0 . 確定

Personal computer
(GT SoftGOT2000)

Move to the previous/next display

Display 1 Display 2 Display 3 Display 4

Display number
1

Display number
2

Display number
3

Display number
4

2 4  FUNCTIONS OF GT SoftGOT2000
4.22  Moving the Window



4

Movement to the specified display
When multiple displays are used, move the window by specifying the display number.

1. Perform one of the following operations.
(□ indicates the display number of the move destination.)
 • Select [Window] → Move to Display □ from the menu.
 • Right-click the mouse to select [Window] → Move to Display □ from the menu.

2. The window moves to the display with the selected display number.

Precautions

Precautions for using multiple displays
To change the mounting state of the display while GT SoftGOT2000 is running, restart GT SoftGOT2000.
Otherwise, the display numbers assigned in GT SoftGOT2000 do not match those of the actual displays.

Move from display 1 
to display 3

1 2 43

ラインA 258

7 8 9 削除
4 5 6 クリア
1 2 3
0 . 確定

Personal computer
(GT SoftGOT2000)

Display 1 Display 2 Display 3 Display 4
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4.23 Monitor-only Mode
In the monitor-only mode, you cannot operate the monitor screen with a mouse or keyboard, or via the touchscreen.
It is useful when using GT SoftGOT2000 only for monitoring.
When the monitor-only mode is enabled, and when the mouse cursor is moved on the monitor screen, the mouse cursor is 
disabled. (The mouse cursor appearance is the same as the appearance set on the personal computer.)
Even if the mouse cursor is disabled, the menu can be displayed by clicking the right mouse button.

After starting GT SoftGOT2000
1. Enable the monitor-only mode by either of the following operations.
Select [Set] → [Monitor-only Mode] from the menu.
Right-click the mouse, and select [Set] → [Monitor-only Mode] from the menu.

2. Start monitoring.
Page 108 Starting Monitoring

Before starting GT SoftGOT2000
The following shows how to start GT SoftGOT2000 in the monitor-only mode from a shortcut.
In the following procedure, you start GT SoftGOT2000 (Single channel) in the monitor-only mode as an example.

1. Create a shortcut to GT SoftGOT2000.
For GT SoftGOT2000 (Single channel): SGT2000.exe
For GT SoftGOT2000 (Multiple channels): SGT2000_MultiCH.exe

2. Right-click the shortcut, and select [Properties].

3. The [GT SoftGOT2000 Properties] dialog appears.
Select the [Shortcut] tab, and then add [/MNTONLY] to the end of the character strings in [Target].
(A one-byte space is required before “/”.)

4. After adding [/MNTONLY], click the [OK] button.

5. At the next GT SoftGOT2000 startup, GT SoftGOT2000 starts with the monitor-only mode enabled.
4 4  FUNCTIONS OF GT SoftGOT2000
4.23  Monitor-only Mode



4

 • Precautions for the monitor-only mode
Once monitoring starts, the monitor-only mode cannot be switched between enabled and disabled.
When the monitor-only mode is enabled, the keyboard input function cannot be set.
 • Confirmation dialog displayed at monitor startup in the monitor-only mode
The confirmation dialog appears when monitoring starts with the monitor-only mode enabled.
Whether to display the confirmation dialog or not can be set by selecting the following item in the 
[Environment Setup] dialog.
[Display dialog at the start of monitoring in the monitor-only mode.] in the [Auxiliary Setup] tab
Page 72 [Auxiliary Setup] tab
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5.1 Internal Device Interface Function
Internal device interface functions can be used with Microsoft Visual C++, Microsoft Visual C#, Microsoft Visual Basic, 
Embarcadero C++ Builder, and Microsoft Excel.
A user-created application with the internal device interface function can read data from or write data to GT SoftGOT2000 
internal devices.

Development environment
The following shows development environment for an application using the internal device interface function.

*1 Only available to the 32-bit version.
*2 Only available to the 64-bit version.

Development environment

Language Software Framework
C++ Microsoft Visual C++ 6.0 .NET Framework2.0

Microsoft Visual C++ .NET(2002)

Microsoft Visual C++ .NET 2003

Microsoft Visual C++ 2005

Microsoft Visual C++ 2008

Microsoft Visual C++ 2010

Microsoft Visual C++ 2012 .NET Framework4.0
.NET Framework4.5
.NET Framework4.5.1
.NET Framework4.5.2
.NET Framework4.6

Microsoft Visual C++ 2013

Microsoft Visual C++ 2015

Microsoft Visual C++ 2017 .NET Framework4.6

Microsoft Visual C++ 2019

Embarcadero C++ Builder XE -

C# Microsoft Visual C# .NET(2002) .NET Framework2.0

Microsoft Visual C# .NET 2003

Microsoft Visual C# 2005

Microsoft Visual C# 2008

Microsoft Visual C# 2010

Microsoft Visual C# 2012 .NET Framework4.0
.NET Framework4.5
.NET Framework4.5.1
.NET Framework4.5.2
.NET Framework4.6

Microsoft Visual C# 2013

Microsoft Visual C# 2015

Microsoft Visual C# 2017 .NET Framework4.6

Microsoft Visual C# 2019

BASIC Microsoft Visual Basic 6.0 .NET Framework2.0

Microsoft Visual Basic .NET(2002)

Microsoft Visual Basic .NET 2003

Microsoft Visual Basic 2005

Microsoft Visual Basic 2008

Microsoft Visual Basic 2010

Microsoft Visual Basic 2012 .NET Framework4.0
.NET Framework4.5
.NET Framework4.5.1
.NET Framework4.5.2
.NET Framework4.6

Microsoft Visual Basic 2013

Microsoft Visual Basic 2015

Microsoft Excel VBA Microsoft Excel 2007 -

Microsoft Excel 2010 *1

Microsoft Excel 2013 *1

Microsoft Excel 2019 *2
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Accessible devices
The following devices are accessible: GB, GD, GS, SGB, and SGD.
For the GT SoftGOT2000 internal devices whose data can be read or written with a user-created application, refer to the 
following.
GT Designer3 (GOT2000) Screen Design Manual

Access to internal devices
Internal devices can be accessed only while GT SoftGOT2000 is running.
Internal devices hold their values while GT SoftGOT2000 is running.
Internal devices can be accessed irrespective of the connection type of GT SoftGOT2000.

Internal device interface function
Internal device interface functions are usable in a user-created program for operating internal devices.
The following describes the internal device interface functions.

*1 Only Microsoft Excel VBA is supported.
*2 The function is usable for the following applications.

• Microsoft Visual C++ 2017
• Microsoft Visual C++ 2019
• Microsoft Visual C# 2017
• Microsoft Visual C# 2019
• Microsoft Excel VBA

The following files are required to use internal device interface functions.

32-bit version

Internal device interface function Description Reference
unsigned long GDev_OpenMapping() Opens and maps the shared memory of the GOT internal device. Page 694 GDev_OpenMapping 

(Opening and mapping the internal device 
shared memory)

long GDev_Read() Reads from the GOT internal device. Page 696 GDev_Read (Reading data 
from internal devices)

long GDev_Write() Writes to the GOT internal device. Page 700 GDev_Write (Writing data to 
internal devices)

void GDev_CloseUnMapping() Unmaps and closes the shared memory of the GOT internal device. Page 704 GDev_CloseUnMapping 
(Unmapping and closing the internal device 
shared memory)

long sgt_GDevOpenMapping()*2 Opens and maps the shared memory of the GOT internal device. Page 706 sgt_GDevOpenMapping 
(Opening and mapping the internal device 
shared memory)

void sgt_GDevCloseUnMapping()*2 Unmaps and closes the shared memory of the GOT internal device. Page 708 sgt_GDevCloseUnMapping 
(Unmapping and closing the internal device 
shared memory)

long sgt_ReadDeviceRandom()*2 Reads data from individual GOT internal devices. Page 709 sgt_ReadDeviceRandom 
(Reading data from individual internal 
devices)

long sgt_WriteDeviceRandom()*2 Writes data to individual GOT internal devices. Page 711 sgt_WriteDeviceRandom 
(Writing data to individual internal devices)

long sgt_ReadDeviceBlock() *1 Reads data from consecutive GOT internal devices. Page 713 sgt_ReadDeviceBlock 
(Reading data from consecutive internal 
devices)

long sgt_WriteDeviceBlock() *1 Writes data to consecutive GOT internal devices. Page 716 sgt_WriteDeviceBlock 
(Writing data to consecutive internal 
devices)

File name Description
GDevlib_GT27.dll DLL for the internal device interface

GDevlib_GT27.lib LIB for the internal device interface

GDevlib_GT27.h Header file for the internal device interface
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64-bit version
The following lists the software applications compatible with the 64-bit OS.
Microsoft Visual C++ 2008
Microsoft Visual C++ 2010
Microsoft Visual C++ 2012
Microsoft Visual C++ 2013
Microsoft Visual C++ 2015
Microsoft Visual C++ 2017
Microsoft Visual C++ 2019
Microsoft Visual C# 2008
Microsoft Visual C# 2010
Microsoft Visual C# 2012
Microsoft Visual C# 2013
Microsoft Visual C# 2015
Microsoft Visual C# 2017
Microsoft Visual C# 2019
Microsoft Visual Basic 2008
Microsoft Visual Basic 2010
Microsoft Visual Basic 2012
Microsoft Visual Basic 2013
Microsoft Visual Basic 2015
Microsoft Excel 2019

The above files are stored in the GT Works3 DVD (Disk4 folder). If GT Works3 is downloaded, the files are stored in a folder 
into which GT Works3 is unpacked.
To use an application that includes the internal device interface function, store GDevlib_GT27.dll or GDevlib64_GT27.dll in 
the folder where the application is stored or the folder specified in the application.
The folder storing the above files is shown below.

File name Description
GDevlib64_GT27.dll DLL for the internal device interface

GDevlib64_GT27.lib LIB for the internal device interface

GDevlib64_GT27.h Header file for the internal device interface
0 5  APPENDICES
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*1 To use GDevlib64_GT27.dll, run this EXE file to install relevant modules.

GDevlib

Module

GDevlib_GT27.dll

GDevlib_GT27.lib

GDevlib_GT27.h

SGT2000

For the downloaded GT Works3, the files are stored in a folder into which GT Works3 is unpacked.
For the GT Works3 DVD, the files are stored in the Disk4 folder.

DLL for internal device interface (32 bits)

LIB for internal device interface (32 bits)

Header file for internal device interface (32 bits)

Module_x64

GDevlib64_GT27.dll

GDevlib64_GT27.lib

GDevlib64_GT27.h

DLL for internal device interface (64 bits)

LIB for internal device interface (64 bits)

Header file for internal device interface (64 bits)

vcredist_x64.exe Microsoft Visual C++ 2008 SP1 Redistributable Package 

(x64) (English version)*1
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Before using the internal device interface function
Make sure to use the following files in the GT Works3 software package that contains GT SoftGOT2000 to be used.

■32-bit version
GDevlib_GT27.dll
GDevlib_GT27.lib
GDevlib_GT27.h

■64-bit version
GDevlib64_GT27.dll
GDevlib64_GT27.lib
GDevlib64_GT27.h
If you copy the target files from another GT Works3 software package, an application error may occur.

Processing flow when the internal device interface function is used
The following shows the processing flow when the internal device interface function is used in a program.
The following (1) and (2) can be processed simultaneously.

■When using GB, GD, and GS devices

Open and map the shared memory of internal device
· GDev_OpenMapping function

Read/write data from/to internal devices.
· GDev_Read function
· GDev_Write function

Unmap and close the shared memory of internal device
· GDev_CloseUnMapping function
2 5  APPENDICES
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■When using GB, GD, GS, SGB, and SGD devices

Structure
The following shows the details of the structures of the internal device interface functions.
For information on how to specify a structure, refer to sample programs.
Page 720 Sample program

■Structure for storing the shared memory handle and shared memory address
 • For 32 bit

 • For 64 bit

■Structure for storing device information
 • For 32 bit

 • For 64 bit

Open and map the shared memory of internal device
· sgt_GDevOpenMapping function

Read/write data from/to internal devices.
· GDev_Read function
· GDev_Write function
· sgt_ReadDeviceRandom function
· sgt_WriteDeviceRandom function
· sgt_ReadDeviceBlock function
· sgt_WriteDeviceBlock function

Unmap and close the shared memory of internal device
· sgt_GDevCloseUnMapping function

typedef struct _STMAPINFO{
HANDLE     hMapFile;    Shared memory handle  
unsigned long    ulMapPointer;    Shared memory address
} STMAPINFO, *LPSTMAPINFO;

typedef struct _STMAPINFO{
HANDLE     hMapFile;    Shared memory handle  
ULONG_PTR    ulMapPointer;    Shared memory address
} STMAPINFO, *LPSTMAPINFO;

typedef struct _STDEVINFO{
long       lDevNameID;       Device name ID
long       lDevNum;       Device number 
long*       lplDataValue;       Device value
long       lError;        Error code
} STDEVINFO, *LPSTDEVINFO;

typedef struct _STDEVINFO{
long                 lDevNameID;       Device name ID
long                 lDevNum;                       Device number 
LONG_PTR* lplDataValue;       Device value
long                 lError;        Error code
} STDEVINFO, *LPSTDEVINFO;
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GDev_OpenMapping (Opening and mapping the internal device 
shared memory)
The following shows details of the GDev_OpenMapping function.

Function
Opens and maps the shared memory of the GOT internal device.
The target devices are GB, GD, and GS.

Format
■32-bit version
 • For Visual C++ and C++ Builder
ulMapPointer = GDev_OpenMapping(*lphMapFile, sGotNo)

 • For Visual C#
ulMapPointer = GDev_OpenMapping(*lphMapFile, sGotNo)

 • For Visual Basic and Excel VBA
ulMapPointer = GDev_OpenMapping(hMapFile, sGotNo)

■64-bit version
 • For Visual C++
ulMapPointer = GDev_OpenMapping(*lphMapFile, sGotNo)

 • For Visual C#
ulMapPointer = GDev_OpenMapping(*lphMapFile, sGotNo)

 • For Visual Basic
ulMapPointer = GDev_OpenMapping(hMapFile, sGotNo)

Variable name Variable type Description I/O
ulMapPointer unsigned long Return value (shared memory address) Output

*lphMapFile HANDLE Shared memory handle Output

sGotNo short Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Variable type Description I/O
ulMapPointer uint32 Return value (shared memory address) Output

*lphMapFile intPtr Shared memory handle Output

sGotNo int16 Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Variable type Description I/O
ulMapPointer unsigned long Return value (shared memory address) Output

hMapFile HANDLE Shared memory handle Output

sGotNo short Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Variable type Description I/O
ulMapPointer ULONG_PTR Return value (shared memory address) Output

lphMapFile HANDLE* Shared memory handle Output

sGotNo short Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Variable type Description I/O
ulMapPointer UInt64 Return value (shared memory address) Output

lphMapFile IntPtr* Shared memory handle Output

sGotNo Int16 Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Variable type Description I/O
ulMapPointer UInt64 Return value (shared memory address) Output

lphMapFile IntPtr* Shared memory handle Output

sGotNo short Module No. of GT SoftGOT2000 (1 to 32767) Input
4 5  APPENDICES
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 • For Excel VBA
ulMapPointer = GDev_OpenMapping(*lphMapFile, sGotNo)

Explanation
The shared memory handle for the internal device of GT SoftGOT2000 that is specified by sGotNo is obtained, and map 
processing is performed with the handle.
The obtained shared memory handle is stored to lphMapFile or hMapFile, and the obtained shared memory address is stored 
to ulMapPointer.

Variable

Return value
Normal termination: A number other than "0" (shared memory address) is returned.
Abnormal termination: "0" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the GDev_OpenMapping function
After the GDev_OpenMapping function is called and required processings are performed, the GDev_CloseUnMapping 
function must always be called.
If it is not called, a memory leak may result and an error such as application error may occur.

Variable name Variable type Description I/O
ulMapPointer LongPtr Return value (shared memory address) Output

lphMapFile LongPtr Shared memory handle Output

sGotNo Integer Module No. of GT SoftGOT2000 (1 to 32767) Input

Variable name Description
lphMapFile Shared memory handle

sGotNo Module No. of GT SoftGOT2000 (1 to 32767)
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GDev_Read (Reading data from internal devices)
The following shows details of the GDev_Read function.

Function
Reads data from GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■32-bit version
 • For Visual C++and C++ Builder
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

 • For Visual C#
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

 • For Visual Basic and Excel VBA
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, sDataTable(0), lDataSize)

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer unsigned long Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum long Device number Input

*lpsDataTable short Device value read Output

lDataSize long Amount of data to be read Input

Variable name Variable type Description I/O
lReturn int32 Return value Output

ulMapPointer uint32 Shared memory address Input

sDevNameID int16 Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum int32 Device number Input

*lpsDataTable int16 Device value read Output

lDataSize int32 Amount of data to be read Input

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer unsigned long Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device (settable for Excel VBA only)
• 4: SGD device (settable for Excel VBA only)

Input

lDevNum long Device number Input

sDataTable(n) short Device value read Output

lDataSize long Amount of data to be read Input
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■64-bit version
 • For Visual C++
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Specify the short (Int16) type for the device to store a read value. The value is casted to the short (Int16) type when the function is 
called.

 • For Visual C#
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Specify the short (Int16) type for the device to store a read value. The value is casted to the short (Int16) type when the function is 
called.

 • For Visual Basic
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, sDataTable(0), lDataSize)

*1 Specify the short (Int16) type for the device to store a read value. The value is casted to the short (Int16) type when the function is 
called.

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer ULONG_PTR Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum long Device number Input

lpsDataTable INT_PTR* Device value read *1 Output

lDataSize long Amount of data to be read Input

Variable name Variable type Description I/O
lReturn Int32 Return value Output

ulMapPointer UInt64 Shared memory address Input

sDevNameID Int16 Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum Int32 Device number Input

lpsDataTable IntPtr* Device value read *1 Output

lDataSize Int32 Amount of data to be read Input

Variable name Variable type Description I/O
lReturn Int32 Return value Output

ulMapPointer Short Shared memory address Input

sDevNameID Int16 Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum Int32 Device number Input

lpsDataTable IntPtr* Device value read *1 Output

lDataSize Int32 Amount of data to be read Input
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5.1  Internal Device Interface Function 697



69
 • For Excel VBA
lReturn = GDev_Read(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Specify the short (Int16) type for the device to store a read value. The value is casted to the short (Int16) type when the function is 
called.

Explanation
This function accesses the shared memory of the specified devices, and reads device values by batch.
The shared memory address, the devices, and the amount of data to be read are specified with ulMapPointer, sDevNameID 
and lDevNum, and lDataSize.
The read device values are stored to lpsDataTable or sDataTable.
Specify the shared memory address that has been obtained by the GDev_OpenMapping function.

Variable

Return value
Normal termination: "0" is returned.
Abnormal termination: "-1", "-2", "-3", or "-9" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Variable name Variable type Description I/O
lReturn Long Return value Output

ulMapPointer LongPtr Shared memory address Input

sDevNameID Integer Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

Input

lDevNum Long Device number Input

lpsDataTable LongPtr Device value read *1 Output

lDataSize Long Amount of data to be read Input

Variable name Description
ulMapPointer • When reading data from GB, GD, or GS devices: Specify the shared memory address obtained by 

GDev_OpenMapping function.
• When reading data from SGB or SGD devices: Specify the shared memory address obtained by the 

sgt_GDevOpenMapping function.

sDevNameID Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Start device number

lpsDataTable Stores the read device values.

lDataSize Amount of data to be read
Page 699 Precautions for using the GDev_Read function
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Precautions for using the GDev_Read function
When you specify the amount of data to be read using IDataSize, make sure that the end device number of the devices from 
which the data is read falls within the following range.
For bit device (GB/SGB) specification
Start device number + (Amount of data to be read × 16) - 1 ≤ Maximum valid device number
For word device (GD/GS/SGD) specification
Start device number + Amount of data to be read - 1 ≤ Maximum valid device number
For bit devices (GB or SGB), specify the device number in multiples of 16.
Secure the area for lpsDataTable with the same size as lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Device specifying method
For bit device (GB/SGB) specification
Example) Reading 1-word (16-bit) data from the devices starting from GB64

Example) Reading 3-word (48-bit) data from the devices starting from GB80

For word device (GD/GS/SGD) specification
Example) Reading 3-word data from the devices starting from GD5

Example) Reading 1-word data from GS500

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lpsDataTable[0] 0 64 1 GB64 to GB79

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lpsDataTable[0] 0 80 3 GB80 to GB95

lpsDataTable[1] GB96 to GB111

lpsDataTable[2] GB112 to GB127

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lpsDataTable[0] 1 5 3 GD5

lpsDataTable[1] GD6

lpsDataTable[2] GD7

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lpsDataTable[0] 2 500 1 GS500
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GDev_Write (Writing data to internal devices)
The following shows details of the GDev_Write function.

Function
Writes data to GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■32-bit version
 • For Visual C++and C++ Builder
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

 • For Visual C#
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

 • For Visual Basic and Excel VBA
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, sDataTable(0), lDataSize)

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer unsigned long Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum long Device number Input

*lpsDataTable short Device value to be written Input

lDataSize long Amount of data to be written Input

Variable name Variable type Description I/O
lReturn int32 Return value Output

ulMapPointer uint32 Shared memory address Input

sDevNameID int16 Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum int32 Device number Input

*lpsDataTable int16 Device value to be written Input

lDataSize int32 Amount of data to be written Input

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer unsigned long Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device (settable for Excel VBA only)
• 4: SGD device (settable for Excel VBA only)

Input

lDevNum long Device number Input

sDataTable(n) short Device value to be written Input

lDataSize long Amount of data to be written Input
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■64-bit version
 • For Visual C++
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Secure the areas in the short (Int16) type, and cast them before calling a function.
 • For Visual C#
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Secure the areas in the short (Int16) type, and cast them before calling a function.
 • For Visual Basic
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Secure the areas in the short (Int16) type, and cast them before calling a function.
 • For Excel VBA
lReturn = GDev_Write(ulMapPointer, sDevNameID, lDevNum, *lpsDataTable, lDataSize)

*1 Secure the areas in the short (Int16) type, and cast them before calling a function.

Variable name Variable type Description I/O
lReturn long Return value Output

ulMapPointer ULONG_PTR Shared memory address Input

sDevNameID short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum long Device number Input

lpsDataTable INT_PTR* Device value to be written *1 Input

lDataSize long Amount of data to be written Input

Variable name Variable type Description I/O
lReturn Int32 Return value Output

ulMapPointer UInt64 Shared memory address Input

sDevNameID Int16 Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum Int32 Device number Input

lpsDataTable IntPtr* Device value to be written *1 Input

lDataSize Int32 Amount of data to be written Input

Variable name Variable type Description I/O
lReturn Int32 Return value Output

ulMapPointer UInt64 Shared memory address Input

sDevNameID Short Device name ID
• 0: GB device
• 1: GD device
• 2: GS device

Input

lDevNum Int32 Device number Input

lpsDataTable IntPtr* Device value to be written *1 Input

lDataSize Int32 Amount of data to be written Input

Variable name Variable type Description I/O
lReturn Long Return value Output

ulMapPointer LongPtr Shared memory address Input

sDevNameID Integer Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

Input

lDevNum Long Device number Input

lpsDataTable IntPtr* Device value to be written *1 Input

lDataSize Long Amount of data to be written Input
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Explanation
This function accesses the shared memory of the specified devices, and writes data to the devices by batch.
The shared memory address, the devices, and the amount of data to be written are specified with ulMapPointer, sDevNameID 
and lDevNum, and lDataSize.
The device values to be written are stored to lpsDataTable or sDataTable.
Specify the shared memory address that has been obtained by the GDev_OpenMapping function.

Variable

Return value
Normal termination: "0" is returned.
Abnormal termination: "-1", "-2", "-3", or "-9" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the GDev_Write function
When you specify the amount of data to be written using lDataSize, make sure that the end device number of the devices to 
which the data is written falls within the following range.
For bit device (GB/SGB) specification
Start device number + (Amount of data to be written × 16) - 1 ≤ Maximum valid device number
For word device (GD/GS/SGD) specification
Start device number + Amount of data to be written - 1 ≤ Maximum valid device number
For bit devices (GB or SGB), specify the device number in multiples of 16.
Secure the area for lpsDataTable with the same size as lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Variable name Description
ulMapPointer • When reading the values of the GB, GD, and GS devices: Specify the shared memory address obtained by 

GDev_OpenMapping function.
• When reading the values of the SGB and SGD devices: Specify the shared memory address obtained by 

sgt_GDevOpenMapping function.

sDevNameID Device name ID
• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Start device number

lpsDataTable Stores the device values to be written.
The size of the area reserved for lpsDataTable must be equal to or larger than the data size specified with IDataSize.
If the area is insufficient, an error such as application error may occur.

lDataSize Amount of data to be written
Page 702 Precautions for using the GDev_Write function
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Device specifying method
For bit device (GB/SGB) specification
Example) Writing 1-word (16-bit) data to the devices starting from GB64

Example) Writing 3-word (48-bit) data to the devices starting from GB80

For word device (GD/GS/SGD) specification
Example) Writing 3-word data to the devices starting from GD5

Example) Writing 1-word data to GS500

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lpsDataTable[0] 0 64 1 GB64 to GB79

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lpsDataTable[0] 0 80 3 GB80 to GB95

lpsDataTable[1] GB96 to GB111

lpsDataTable[2] GB112 to GB127

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lpsDataTable[0] 1 5 3 GD5

lpsDataTable[1] GD6

lpsDataTable[2] GD7

Variable name Device name ID
(sDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lpsDataTable[0] 2 500 1 GS500
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GDev_CloseUnMapping (Unmapping and closing the internal 
device shared memory)
The following shows details of the GDev_CloseUnMapping function.

Function
Unmaps and closes the shared memory of the GOT internal device.
The target devices are GB, GD, and GS.

Format
■32-bit version
 • For Visual C++ and C++ Builder
GDev_CloseUnMapping(hMapFile, ulMapPointer)

 • For Visual C#
GDev_CloseUnMapping(hMapFile, ulMapPointer)

 • For Visual Basic and Excel VBA
GDev_CloseUnMapping(hMapFile, ulMapPointer)

■64-bit version
 • For Visual C++
GDev_CloseUnMapping(hMapFile, ulMapPointer)

 • For Visual C#
GDev_CloseUnMapping(hMapFile, ulMapPointer)

 • For Visual Basic
GDev_CloseUnMapping(hMapFile, ulMapPointer)

 • For Excel VBA
GDev_CloseUnMapping(lphMapFile, ulMapPointer)

Variable name Variable type Description I/O
hMapFile HANDLE Shared memory handle Input

ulMapPointer unsigned long Shared memory address Input

Variable name Variable type Description I/O
hMapFile intPtr Shared memory handle Input

ulMapPointer uint32 Shared memory address Input

Variable name Variable type Description I/O
hMapFile HANDLE Shared memory handle Input

ulMapPointer unsigned long Shared memory address Input

Variable name Variable type Description I/O
lphMapFile HANDLE* Shared memory handle Input

ulMapPointer ULONG_PTR Shared memory address Input

Variable name Variable type Description I/O
lphMapFile IntPtr* Shared memory handle Input

ulMapPointer UInt64 Shared memory address Input

Variable name Variable type Description I/O
lphMapFile IntPtr* Shared memory handle Input

ulMapPointer UInt64 Shared memory address Input

Variable name Variable type Description I/O
lphMapFile LongPtr Shared memory handle Input

ulMapPointer LongPtr Shared memory address Input
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Explanation
This function performs unmapping on the shared memory address specified with ulMapPointer, and releases the shared 
memory handle specified with hMapFile.
Specify the shared memory address and shared memory handle that have been obtained by the GDev_OpenMapping 
function.

Variable

Return value
None

Precautions for using the GDev_CloseUnMapping function
After the GDev_OpenMapping function has completed the required processing, make sure to call the GDev_CloseUnMapping 
function.
Not doing so may result in a memory leak and an application error or other errors.

Variable name Description
lphMapFile Shared memory handle obtained by the GDev_OpenMapping function

ulMapPointer Shared memory address obtained by the GDev_OpenMapping function
5  APPENDICES
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sgt_GDevOpenMapping (Opening and mapping the internal 
device shared memory)
The following shows the details of the sgt_GDevOpenMapping function.

Function
Opens and maps the shared memory of the GOT internal device.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■For Visual C++
lReturn = sgt_GDevOpenMapping(*lpstMapInfo, sGotNo)

■For Visual C#
lReturn = sgt_GDevOpenMapping(*lpstMapInfo, sGotNo)

■For Excel VBA
lReturn = sgt_GDevOpenMapping(lpstMapInfo(0),sGotNo)

Explanation
This function obtains the shared memory handle for accessing the internal devices of the GT SoftGOT2000 module specified 
with sGotNo, and performs mapping on the handle.
The shared memory handle and shared memory address that have been obtained are stored in lpstMapInfo.

Variable

Return value
Normal termination: "1" is returned.
Abnormal termination: "0" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Variable name Variable type Description I/O
lReturn long Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Output

sGotNo short GT SoftGOT2000 module No. Input

Variable name Variable type Description I/O
lReturn Int32 Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Output

sGotNo Int16 GT SoftGOT2000 module No. Input

Variable name Variable type Description I/O
lReturn Long Return value Output

lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Output

sGotNo Integer GT SoftGOT2000 module No. (1 to 32767) Input

Variable name Description
lpstMapInfo Pointer to the structure for storing the shared memory handle and shared memory address

Page 707 How to specify the shared memory handle and shared memory address

sGotNo Module No. of GT SoftGOT2000 (1 to 32767)
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Precautions for using the sgt_GDevOpenMapping function
Reserve a 4-word or more area for lpstMapInfo.
If the area is insufficient, an error such as application error may occur.
After the sgt_GDevOpenMapping function has completed the required processing, make sure to call the 
sgt_GDevCloseUnMapping function.
Not doing so may result in a memory leak and an application error or other errors.

How to specify the shared memory handle and shared memory address
Example) Specifying a 4-word area with lpstMapInfo

Variable name Structure member Description
lpstMapInfo[0] hMapFile Shared memory handle for accessing GB/GD/GS devices

ulMapPointer Shared memory address for accessing GB/GD/GS devices

lpstMapInfo[1] hMapFile Shared memory handle for accessing SGB/SGD devices

ulMapPointer Shared memory address for accessing SGB/SGD devices
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sgt_GDevCloseUnMapping (Unmapping and closing the internal 
device shared memory)
The following shows the details of the sgt_GDevCloseUnMapping function.

Function
Unmaps and closes the shared memory of the GOT internal device.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■For Visual C++
sgt_GDevCloseUnMapping(*lpstMapInfo)

■For Visual C#
sgt_GDevCloseUnMapping(*lpstMapInfo)

■For Excel VBA
sgt_GDevCloseUnMapping(lpstMapInfo(0))

Explanation
This function performs unmapping on the shared memory address and releases the shared memory handle, which are 
specified with lpstMapInfo.

Variable

Return value
None

Precautions for using the sgt_GDevCloseUnMapping function
After the sgt_GDevOpenMapping function has completed the required processing, make sure to call the 
sgt_GDevCloseUnMapping function.
Not doing so may result in a memory leak and an application error or other errors.

Variable name Variable type Description I/O
*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Output

Variable name Variable type Description I/O
*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Output

Variable name Variable type Description I/O
lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Input

Variable name Description
lpstMapInfo • Pointer to the structure for storing the shared memory handle and shared memory address

• Specify the shared memory address and shared memory handle obtained by the sgt_GDevOpenMapping function.
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sgt_ReadDeviceRandom (Reading data from individual internal 
devices)
The following shows the details of the sgt_ReadDeviceRandom function.

Function
Reads data from GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■For Visual C++
lReturn = sgt_ReadDeviceRandom(*lpstMapInfo, *lpstDevInfo, lDataSize)

■For Visual C#
lReturn = sgt_ReadDeviceRandom(*lpstMapInfo, *lpstDevInfo, lDataSize)

■For Excel VBA
lReturn = sgt_ReadDeviceRandom(lpstMapInfo(0),lpstDevInfo(0),lDataSize)

Explanation
This function accesses the shared memory of the specified devices, and reads the device values.
The shared memory address, the devices, and the amount of data to be read are specified with lpstMapInfo, lpstDevInfo, and 
lDataSize.
The read device values and error codes are stored in lpstDevInfo.
If any of the lpstDevInfo structure members has an invalid value, an error code is stored into lpstDevInfo.
A value indicating an abnormal termination is returned in the above case.
If all the lpstDevInfo structure members have a valid value, the read device values are stored into lpstDevInfo.

Variable

Variable name Variable type Description I/O
lReturn long Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Input

*lpstDevInfo STDEVINFO Device name ID, device number, read device value, and error code Input/Output

lDataSize long Amount of data to be read Input

Variable name Variable type Description I/O
lReturn int32 Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Input

*lpstDevInfo STDEVINFO Device name ID, device number, read device value, and error code Input/Output

lDataSize int32 Amount of data to be read Input

Variable name Variable type Description I/O
lReturn Long Return value Output

lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Input

lpstDevInfo(n) STDEVINFO Device name ID, device number, read device value, and error code Input/Output

lDataSize Long Amount of data to be read Input

Variable name Description
lpstMapInfo • Pointer to the structure for storing the shared memory handle and shared memory address

• Specify the shared memory address and shared memory handle obtained by the sgt_GDevOpenMapping function.

lpstDevInfo Pointer to the structure for storing device information
Page 710 Device specifying method

lDataSize Amount of data to be read (1 to 1024)
Page 710 Precautions for using the sgt_ReadDeviceRandom function
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Structure member
The variable lpstDevInfo has structure members.
The following shows the structure members.

For the structures, refer to the following.
Page 693 Structure

Return value
Normal termination: "0" is returned.
Abnormal termination: "-9", "-10", or "-11" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the sgt_ReadDeviceRandom function
For lplDataValue, reserve the area for lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Device specifying method
Example) When GB64, GB80, SGB90, SGB600, GD50, GD5, GS500, SGD60, and an invalid device (invalid device name ID 
or device number) are specified
The variable lDataSize is set to 10.
The following shows other variables.
When the following arguments are specified, -11 will be returned to lReturn.

Structure member Description
lDevNameID Device name ID

• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Device number

lplDataValue Device value read

lError Error code
• 0: Reading succeeded.
• -1: The specified device name ID is invalid.
• -4: The specified device number is invalid.
• -5: The address of the specified device value is invalid.

Variable name Device name
(lDevNameID)

Device number
(lDevNum)

Device value read
(lplDataValue)

Error code
(lError)

Device from which data is read

Input Input Output Output
lpstDevInfo[0] 0 64 1 0 GB64

lpstDevInfo[1] 0 80 0 0 GB80

lpstDevInfo[2] 3 90 0 0 SGB90

lpstDevInfo[3] 6 100 0 -1 -

lpstDevInfo[4] 3 600 1 0 SGB600

lpstDevInfo[5] 1 50 30 0 GD50

lpstDevInfo[6] 1 5 500 0 GD5

lpstDevInfo[7] 2 500 0 0 GS500

lpstDevInfo[8] 4 60 900 0 SGD60

lpstDevInfo[9] 2 6000 0 -4 GS6000
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sgt_WriteDeviceRandom (Writing data to individual internal 
devices)
The following shows the details of the sgt_WriteDeviceRandom function.

Function
Writes data to GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
■For Visual C++
lReturn = sgt_WriteDeviceRandom(*lpstMapInfo, *lpstDevInfo, lDataSize)

■For Visual C#
lReturn = sgt_WriteDeviceRandom(*lpstMapInfo, *lpstDevInfo, lDataSize)

■For Excel VBA
lReturn = sgt_WriteDeviceRandom(lpstMapInfo(0), lpstDevInfo(0), lDataSize)

Explanation
This function accesses the shared memory of the specified devices, and writes data to the devices.
The shared memory address, the devices, and the amount of data to be written are specified with lpstMapInfo, lpstDevInfo, 
and lDataSize.
The error codes are stored in lpstDevInfo.
If any of the lpstDevInfo structure members has an invalid value, an error code is stored into lpstDevInfo.
A value indicating an abnormal termination is returned in the above case.
If all the lpstDevInfo structure members have a valid value, the device values are correctly written to lpstDevInfo.

Variable

Variable name Variable type Description I/O
lReturn long Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Input

*lpstDevInfo STDEVINFO Device name ID, device number, device value to be written, and error code Input/Output

lDataSize long Amount of data to be written Input

Variable name Variable type Description I/O
lReturn int32 Return value Output

*lpstMapInfo STMAPINFO Shared memory handle and shared memory address Input

*lpstDevInfo STDEVINFO Device name ID, device number, device value to be written, and error code Input/Output

lDataSize int32 Amount of data to be written Input

Variable name Variable type Description I/O
lReturn Long Return value Output

lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Input

lpstDevInfo(n) STDEVINFO Device name ID, device number, device value to be written, and error code Input/Output

lDataSize Long Amount of data to be written Input

Variable name Description
lpstMapInfo • Pointer to the structure for storing the shared memory handle and shared memory address

• Specify the shared memory address and shared memory handle obtained by the sgt_GDevOpenMapping function.

lpstDevInfo Pointer to the structure for storing device information
Page 712 Device specifying method

lDataSize Amount of data to be written (1 to 1024)
Page 712 Precautions for using the sgt_WriteDeviceRandom function
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Structure member
The variable lpstDevInfo has structure members.
The following shows the structure members.

For the structures, refer to the following.
Page 693 Structure

Return value
Normal termination: "0" is returned.
Abnormal termination: "-9", "-10", or "-11" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the sgt_WriteDeviceRandom function
For lplDataValue, reserve the area for lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Device specifying method
Example) When GB64, GB80, SGB90, SGB600, GD50, GD5, GS500, SGD60, and an invalid device (invalid device name ID 
or device number) are specified
The variable lDataSize is set to 10.
The following shows other variables.
When the following arguments are specified, -11 will be returned to lReturn.

Structure member Description
lDevNameID Device name ID

• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Device number

lplDataValue Device value to be written

lError Error code
• 0: Writing succeeded.
• -1: The specified device name ID is incorrect.
• -4: The specified device number is incorrect.
• -5: The address of the specified device value is incorrect.
• -6: The specified device value is incorrect.

Variable name Device name
(lDevNameID)

Device number
(lDevNum)

Device value to be written
(lplDataValue)

Error code
(lError)

Device to which data is written

Input Input Input Output
lpstDevInfo[0] 0 64 1 0 GB64

lpstDevInfo[1] 0 80 0 0 GB80

lpstDevInfo[2] 3 90 0 0 SGB90

lpstDevInfo[3] 6 100 0 -1 -

lpstDevInfo[4] 3 600 1 0 SGB600

lpstDevInfo[5] 1 50 30 0 GD50

lpstDevInfo[6] 1 5 500 0 GD5

lpstDevInfo[7] 2 500 0 0 GS500

lpstDevInfo[8] 4 60 900 0 SGD60

lpstDevInfo[9] 2 6000 0 -4 GS6000
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sgt_ReadDeviceBlock (Reading data from consecutive internal 
devices)
The following shows the details of the sgt_ReadDeviceBlock function.

Function
Reads data from GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
The following shows the formats for Excel VBA.
lReturn = sgt_ReadDeviceBlock(lpstMapInfo(0), lpstDevInfo(0), lDataSize)

Explanation
This function accesses the shared memory of the specified devices, and reads the device values.
The shared memory address, the devices, and the amount of data to be read are specified with lpstMapInfo, lpstDevInfo, and 
lDataSize.
The read device values and error codes are stored in lpstDevInfo.
If any of the lpstDevInfo structure members has an invalid value, an error code is stored into lpstDevInfo.
A value indicating an abnormal termination is returned in the above case.
If the specified lpstDevInfo structure member is normal, the read device values are stored in lpstDevInfo.

Variable

Variable name Variable type Description I/O
lReturn Long Return value Output

lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Input

lpstDevInfo(n) STDEVINFO Device name ID, device number, read device value, and error code Input/Output

lDataSize Long Number of read data points Input

Variable name Description
lpstMapInfo • Pointer of structure for storing the shared memory handle and shared memory address

• Specify the shared memory address and shared memory handle that have been obtained by the 
sgt_GDevOpenMapping function.

lpstDevInfo Pointer of the structure for storing device information
Page 715 Device specifying method

lDataSize Amount of data to be read
Page 714 Precautions for using the sgt_ReadDeviceBlock function
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Structure member
The variable lpstDevInfo has structure members.
The following shows the structure members.

For the structures, refer to the following.
Page 693 Structure

Return value
Normal termination: "0" is returned.
Abnormal termination: "-9", "-10", or "-11" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the sgt_ReadDeviceBlock function
When you specify the amount of data to be read using IDataSize, make sure that the end device number of the devices from 
which the data is read falls within the following range.
For bit device (GB/SGB) specification
Start device number + (Amount of data to be read × 16) - 1 ≤ Maximum valid device number
For word device (GD/GS/SGD) specification
Start device number + Amount of data to be read - 1 ≤ Maximum valid device number
For bit devices (GB or SGB), specify the device number in multiples of 16.
For lplDataTable, reserve the area for lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Structure member Description
lDevNameID Device name ID

• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Start device number

lplDataValue Stores the read device values.

lError Error code
• 0: Reading succeeded.
• -1: The specified device name ID is incorrect.
• -2: The specified start device  is outside the range.
• -3: The specified end device is outside the range.
• -5: The address of the specified device value is incorrect.
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Device specifying method
For bit device (GB/SGB) specification
Example) Reading 1-word (16-bit) data from the devices starting from GB64

Example) Reading 3-word (48-bit) data from the devices starting from GB80

For word device (GD/GS/SGD) specification
Example) Reading 1-word data from GS500

Example) Reading 3-word data from the devices starting from GD5

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lplDataValue[0] 0 64 1 GB64 to GB79

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lplDataValue[0] 0 80 3 GB80 to GB95

lplDataValue[1] GB96 to GB111

lplDataValue[2] GB112 to GB127

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lplDataValue[0] 2 500 1 GS500

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be read
(lDataSize)

Device from which data is read

lplDataValue[0] 1 5 3 GD5

lplDataValue[1] GD6

lplDataValue[2] GD7
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sgt_WriteDeviceBlock (Writing data to consecutive internal 
devices)
The following shows the details of the sgt_WriteDeviceBlock function.

Function
Writes data to GOT internal devices.
The target devices are GB, GD, GS, SGB, and SGD.

Format
The following shows the formats for Excel VBA.
lReturn = sgt_WriteDeviceBlock(lpstMapInfo(0), lpstDevInfo(0), lDataSize)

Explanation
This function accesses the shared memory of the specified devices, and writes data to the devices.
The shared memory address, the devices, and the amount of data to be written are specified with lpstMapInfo, lpstDevInfo, 
and lDataSize.
The error codes are stored in lpstDevInfo.
If any of the lpstDevInfo structure members has an invalid value, an error code is stored into lpstDevInfo.
A value indicating an abnormal termination is returned in the above case.
If the specified lpstDevInfo structure member is normal, the device values to be written are written to lpstDevInfo correctly.

Variable

Variable name Variable type Description I/O
lReturn Long Return value Output

lpstMapInfo(n) STMAPINFO Shared memory handle and shared memory address Input

lpstDevInfo(n) STDEVINFO Device name ID, device number, device value to be written, and error code Input/Output

lDataSize Long Amount of data to be written Input

Variable name Description
lpstMapInfo • Pointer to the structure for storing the shared memory handle and shared memory address

• Specify the shared memory address and shared memory handle obtained by the sgt_GDevOpenMapping function.

lpstDevInfo Pointer to the structure for storing device information
Page 718 Device specifying method

lDataSize Amount of data to be written
Page 717 Precautions for using the sgt_WriteDeviceBlock function
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Structure member
The variable lpstDevInfo has structure members.
The following shows the structure members.

For the structures, refer to the following.
Page 693 Structure

Return value
Normal termination: "0" is returned.
Abnormal termination: "-9", "-10", or "-11" is returned.
For error codes, refer to the following.
Page 735 Error code list when using the internal device interface function

Precautions for using the sgt_WriteDeviceBlock function
When you specify the amount of data to be written using lDataSize, make sure that the end device number of the devices to 
which the data is written falls within the following range.
For bit device (GB/SGB) specification
Start device number + (Amount of data to be written × 16) - 1 ≤ Maximum valid device number
For word device (GD/GS/SGD) specification
Start device number + Amount of data to be written - 1 ≤ Maximum valid device number
For bit devices (GB or SGB), specify the device number in multiples of 16.
For lplDataTable, reserve the area for lDataSize or more.
If the area is insufficient, an error such as application error may occur.

Structure member Description
lDevNameID Device name ID

• 0: GB device
• 1: GD device
• 2: GS device
• 3: SGB device
• 4: SGD device

lDevNum Start device number

lplDataValue Stores the device values to be written.

lError Error code
• 0: Writing succeeded.
• -1: The specified device name ID is incorrect.
• -2: The specified start device  is outside the range.
• -3: The specified end device is outside the range.
• -5: The address of the specified device value is incorrect.
• -6: The specified device value is incorrect.
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Device specifying method
For bit device (GB/SGB) specification
Example) Writing 1-word (16-bit) data to the devices starting from GB64

Example) Writing 3-word (48-bit) data to the devices starting from GB80

For word device (GD/GS/SGD) specification
Example) Writing 1-word data to GS500

Example) Writing 3-word data to the devices starting from GD5

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lplDataValue[0] 0 64 1 GB64 to GB79

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lplDataValue[0] 0 80 3 GB80 to GB95

lplDataValue[1] GB96 to GB111

lplDataValue[2] GB112 to GB127

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lplDataValue[0] 2 500 1 GS500

Variable name Device name ID
(lDevNameID)

Start device number
(lDevNum)

Amount of data to be written
(lDataSize)

Device to which data is written

lplDataValue[0] 1 5 3 GD5

lplDataValue[1] GD6

lplDataValue[2] GD7
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Precautions for the internal device interface function
The following shows precautions for using an application that uses the internal device interface function.

When using GB, GD, and GS devices
■When the GDev_OpenMapping function is called
The GDev_OpenMapping function must be called after GT SoftGOT2000 is started.

■When the GDev_Read function or the GDev_Write function is called
The following functions must be called during GT SoftGOT2000 startup.

■When exiting GT SoftGOT2000
If the sgt_GDevOpenMapping function is being executed, make sure to call the sgt_GDevCloseUnMapping function before 
exiting GT SoftGOT2000.
Not doing so may cause GT SoftGOT2000 to operate abnormally when you start it again.
In such a case, call the sgt_GDevCloseUnMapping function and then exit GT SoftGOT2000.

When using GB, GD, GS, SGB, and SGD devices
■When the sgt_GDevOpenMapping function is called
The sgt_GDevOpenMapping function must be called after GT SoftGOT2000 is started.

■When other functions are called
The following functions must be called while GT SoftGOT2000 is running.
GDev_Read function
GDev_Write function
sgt_ReadDeviceRandom function
sgt_WriteDeviceRandom function
sgt_ReadDeviceBlock function
sgt_WriteDeviceBlock function

■When exiting GT SoftGOT2000
If GT SoftGOT2000 has been exited with the sgt_GDevOpenMapping function called, the sgt_GDevCloseUnMapping function 
must be called immediately.
If GT SoftGOT2000 is started again without calling the sgt_GDevCloseUnMapping function, after GT SoftGOT2000 is exited, 
GT SoftGOT2000 may not operate normally.
If GT SoftGOT2000 does not operate normally, the sgt_GDevCloseUnMapping function should be called before GT 
SoftGOT2000 is exited.
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Sample program
A sample program using the internal device interface function is stored in the DVD (Disk4 folder) of GT Works3.
Use the sample program as a reference when creating an application using the internal device interface function.
The following shows folders storing the sample programs.

Disk4 folder

GDevlib

Sample

Visual Studio 6.0/.NET(2002)

Visual Studio 2013

DVD

Storage folder for Visual Studio 6.0/.NET (2002)
sample programs (32-bit version)

Excel 2007 Storage folder for Microsoft Excel 2007 sample programs
(32-bit version)

Storage folder for Visual Studio 2013 sample programs
(32-bit version)

VB

VC

Visual Basic 6.0 sample programs (32-bit version)

Visual C++ 6.0 sample programs (32-bit version)

VC# Visual C# .NET (2002) sample programs (32-bit version)

Sample_x64

Visual Studio 2008 Storage folder for Visual Studio 2008 sample programs
(64-bit version)

Visual Studio 2013 Storage folder for Visual Studio 2013 sample programs
(64-bit version)

VB

VC

Visual Basic 2008 sample programs (64-bit version)

Visual C++ 2008 sample programs (64-bit version)

VC# Visual C# 2008 sample programs (64-bit version)

SGT2000

VB

VC

Visual Basic 2013 sample programs (64-bit version)

Visual C++ 2013 sample programs (64-bit version)

VC# Visual C# 2013 sample programs (64-bit version)

VBA Microsoft Excel 2007 sample programs (32-bit version)

VB

VC

Visual Basic 2013 sample programs (32-bit version)

Visual C++ 2013 sample programs (32-bit version)

VC# Visual C# 2013 sample programs (32-bit version)

Excel 2013 Storage folder for Microsoft Excel 2013 sample programs
(32-bit version)

Microsoft Excel 2013 sample programs (32-bit version)VBA

Excel 2019 Storage folder for Microsoft Excel 2019 sample programs 
(64-bit version)

Microsoft Excel 2019 sample programs (64-bit version)VBA
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Sample program
When using a sample program, store GDevlib_GT27.dll or GDevlib64_GT27.dll in the folder where the 
application and xmls files are stored.

Visual Studio 6.0/.NET(2002), Visual Studio 2013, or Microsoft Excel 2007
The following sample program reads/writes data from/to the internal devices (GB, GD, and GS) of GT SoftGOT2000 module 
No. 1.
Example) Sample program for Visual C++

Setting item Description
[GB Device] GB device monitor area

[Device No.] Specify a device number (GB0 to GB65535).

[Write Value] [ON] Turns on the device specified with [Device No.].

[OFF] Turns off the device specified with [Device No.].

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Bit device status
• [1]: ON
• [0]: OFF

[GD Device] GD device monitor area

[Device No.] Specify a device number (GD0 to GD65535).

[Write Value] Write value input area 
(GD)

Specify a value to be written to the device specified with [Device No.].
Input format: Signed decimal number (-32768 to 32767)

[Write] Writes the specified value to the specified device.

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Display format: Signed decimal number (-32768 to 32767)
The value is read from the internal device specified with [Device No.].

[GS Device] GS device monitor area

[Device No.] Specify a device number (GS0 to GS2047).

[Write Value] Write value input area 
(GS)

Specify a value to be written to the device specified with [Device No.].
Input format: Signed decimal number (-32768 to 32767)

[Write] Writes the specified value to the specified device.

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Display format: Signed decimal number (-32768 to 32767)
The value is read from the internal device specified with [Device No.].

Write value input area (GD)

Write value input area (GS)

Monitor execution status
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Microsoft Excel 2013, Microsoft Excel 2019
The following sample program reads or writes data from or to the internal devices (GB, GD, GS, SGB, and SGD) of the 
specified GT SoftGOT2000 module.

[Start monitor] Starts monitoring.

[Start monitor] Stops monitoring.

Setting item Description
[Module No.] Specify a GT SoftGOT2000 module number (1 to 32767) to read data from the internal 

devices of the module.

[GB Device] GB device monitor area

[Device No.] Specify a device number (GB0 to GB65535).

[Write Value] [ON] Turns on the device specified with [Device No.].

[OFF] Turns off the device specified with [Device No.].

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Bit device status
• [1]: ON
• [0]: OFF

[GD Device] GD device monitor area

[Device No.] Specify a device number (GD0 to GD65535).

[Write Value] Write value input area 
(GD)

Specify a value to be written to the device specified with [Device No.].
Input format: Signed decimal number (-32768 to 32767)

[Write] Writes the specified value to the specified device.

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Display format: Signed decimal number (-32768 to 32767)
The value is read from the internal device specified with [Device No.].

[GS Device] GS device monitor area

Setting item Description

Write value input area (GD)

Write value input area (GS)

Monitor execution status

Write value input area (SGD)
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[Device No.] Specify a device number (GS0 to GS2047).

[Write Value] Write value input area 
(GS)

Specify a value to be written to the device specified with [Device No.].
Input format: Signed decimal number (-32768 to 32767)

[Write] Writes the specified value to the specified device.

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Display format: Signed decimal number (-32768 to 32767)
The value is read from the internal device specified with [Device No.].

[SGB Device] SGB device monitor area

[Device No.] Specify a device number (SGB0 to SGB65535).

[Write Value] [ON] Turns on the device specified with [Device No.].

[OFF] Turns off the device specified with [Device No.].

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Bit device status
• [1]: ON
• [0]: OFF

[SGD Device] SGD device monitor area

[Device No.] Specify a device number (SGD0 to SGD65535).

[Write Value] Write value input area 
(SGD)

Specify a value to be written to the device specified with [Device No.].
Input format: Signed decimal number (-32768 to 32767)

[Write] Writes the specified value to the specified device.

[Read Value] Displays the value read from the specified device.
The value is updated only while monitoring is performed.
Display format: Signed decimal number (-32768 to 32767)
The value is read from the internal device specified with [Device No.].

[Start monitor] Starts monitoring.

[Start monitor] Stops monitoring.

Setting item Description
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5.2 Troubleshooting
Error message
The following table indicates the error messages occurred in [GT SoftGOT2000] themselves, the Descriptions and 
resolutions.

Error message Error code Definition and cause Corrective action
Adobe Reader is not installed properly.
Install Adobe Reader included with the 
product.

- • Adobe Reader is not installed.
• Adobe Reader is not installed correctly.

• Install Adobe Reader.
• After uninstalling Adobe Reader, reinstall 

it.

Easysocket is not installed. - Perhaps GT SoftGOT2000 is not installed 
correctly.

After uninstalling GT SoftGOT2000, reinstall 
it.

GS###.b##: The .exe file is invalid (not .exe 
or error in .exe image).

- • Access to the specified file (application) 
was not made.

• The specified file (application) is corrupted.
• The specified file (application) is not an 

executable file.

• Check the settings of the application start-
up setting.

• Check the access right of the specified file 
(application).

• Specify an operable file (application).
• Specify an executable file (application).

GS###.b##: Failed to start the application. 
<ErrCode:##>

- • The specified file (application) is corrupted.
• Relevant applications are not installed 

properly.
• There is not sufficient space left in 

memory/hard disk.
• GT SoftGOT2000 was terminated illegally 

last time.

• Check the settings of the application start-
up setting.

• Specify an operable file (application).
• Install relevant applications again.
• Terminate unnecessary applications.
• Increase free space in the hard disk.
• Restart GT SoftGOT2000.
• Restart the personal computer.

GS###.b##: The operating system denied 
access to the specified file.

- • Access to the specified file (application) 
was not made.

• The specified file (application) is corrupted.
• Relevant applications are not installed 

properly.

• Check the settings of the application start-
up setting.

• Check the access right of the specified file 
(application).

• Specify an operable file (application).
• Install relevant applications again.

GS###.b##: The specified file was not found. - The specified file (application) does not exist. • Check the settings of the application start-
up setting.

• Specify an existing file (application).
• Install relevant applications again.

GS###.b##: The specified path was not 
found.

-

GS###.b##: There was not enough memory 
to complete the operation.

- • There is not sufficient space left in 
memory/hard disk.

• GT SoftGOT2000 was terminated illegally 
last time.

• Terminate unnecessary applications.
• Increase free space in the hard disk.
• Restart GT SoftGOT2000.
• Restart the personal computer.

Please do logoff/the termination of Windows 
after ending 'GT SoftGOT2000'.

- Close 'GT SoftGOT2000' before log out or 
shut down the Windows.

Close 'GT SoftGOT2000' before log out or 
shut down the Windows.

Advanced APP setup file was not found. - • The Advanced APP setup file does not 
exist.

Create the Advanced APP setup file 
[<InstallPath>\SGT2000\Multi\*****\AppStart
Set.csv].

There is no application associated with the 
extension of Advanced APP setup file (.csv).

- • The application associated with the 
extension (.csv) of the Advanced APP 
setup file does not exist.

• The application associated with the file 
extension is not installed correctly.

Set the application associated with the 
extension (.csv) of the Advanced APP setup 
file.
Install the application associated with the file 
extension again.

Failed to start the application. - • Access to the Advanced APP setup file is 
disabled.

• The Advanced APP setup file is corrupted.
• The application associated with the file 

extension is not installed correctly.
• Not enough free memory or hard disk 

space.
• GT SoftGOT2000 was exited illegally last 

time.
• Illegal process is running.

• Check the access right of the Advanced 
APP setup file.

• Create the Advanced APP setup file again.
• Install the application associated with the 

file extension again.
• Exit unnecessary applications.
• Increase the free space of the hard disk.
• Restart GT SoftGOT2000.
• After restarting the personal computer, 

restart GT SoftGOT2000.
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The check result cannot be displayed. - Access to the Advanced APP check file is 
disabled.
The Advanced APP setup check file is 
corrupted.
The application associated with the file 
extension is not installed correctly.

Check the access right of the Advanced APP 
setup check file.
Install the application associated with the file 
extension again.

Access to the Advanced APP Setup file is 
denied.

- Access to the Advanced APP setup file is 
disabled.

Check the access right of the Advanced APP 
setup file.

Failed to open the Advanced APP Setup 
check file.

- Access to the Advanced APP setup check 
file is disabled.
The Advanced APP setup check file is 
corrupted.

Check the access right of the Advanced APP 
setup check file.

Failed to check Advanced APP Setup. - The operating environment is not supported. Install GT SoftGOT2000GOT2000 again.

History file was not found. - The application start-up history file cannot be 
started up.

Check the application start-up history file.

Easysocket has an invalid version. - GT SoftGOT2000 may be not installed 
correctly.

After uninstalling GT SoftGOT2000, reinstall 
it.

The specified project data was created by 
using a previous version of the GT 
Designer3.
Some functions may not operate properly.
Do you want to proceed?

- The version of the GT Designer3 on which 
the project data is created is later than the 
GT SoftGOT2000.

Select a button on the displayed dialog.
Yes: Execute reading and perform monitoring 
with operable functions.
No: Install GT SoftGOT2000 of the same 
version as GT Designer3 and execute 
reading again.

The major versions of the specified project 
data and GT SoftGOT2000 Standard monitor 
OS do not match.
Project data : Ver. ##.##
GT SoftGOT2000 Standard monitor OS
: Ver. ##.##
Specify the project data of the same version.

- The following OS major versions are not 
matched.
• The major version of OS in GT Designer3 

that stores the created project data to be 
read.

• The standard monitor OS in GT 
SoftGOT2000

• Install GT SoftGOT2000 with the same 
version as GT Designer3 that stores the 
created project data, and read the data 
again.

• Create the project data for GT Designer3 
that version is same as the version of GT 
SoftGOT2000, and read the data again.

Failed to take a snap shot. - • GT SoftGOT2000 was closed illegally last 
time.

• Illegal process is running.

• Restart GT SoftGOT2000.
• After restarting the personal computer, 

restart GT SoftGOT2000.

A Communication error occurred.
Retry : Executes communication again.
Cancel : Cancels all communication.
To retry communication, restart the GT 
SoftGOT2000.
<ES:0x########>

- • Cable was disconnected.
• Cable was broken.
• Transmission speed (Baud rate) is 

incorrect.
• The PLC CPU type is different from that of 

the project setting.

After checking for the left causes, select the 
button in the displayed dialog.
[Retry]
Restarts communication.
[Cancel]
After Cancel is selected, all communications 
will not be made.
When performing monitoring, restart GT 
SoftGOT2000.

Path name is too long. - Save the GT Designer3 under too many 
directory levels.

In Option setting, set the project of GT 
Designer3 again.

Manual file cannot be found.
Please install manuals.

- • GT Manual3 is not installed.
• GT Manual3 is not installed properly.

Uninstall GT Manual3, and then reinstall it.

Cannot set up the operating environment.
Insufficient disk space or memory may be the 
cause.

0x1103 • Not enough free disk space.
• GT SoftGOT2000 was exited illegally last 

time.
• Illegal process is running.

• Exit unnecessary applications.
• Increase the free space of the hard disk.
• Restart GT SoftGOT2000.
• After restarting the personal computer, 

restart GT SoftGOT2000.

Failed to set up an operating environment.
Check the followings and retry the operation.
• Free disk space.
• Access privileges to the environment file.
• Validity of environment files (invalid files or 

files not found).

0x1104 - • Increase the free space of the hard disk.
• Check the file access privilege.
• After uninstalling GT SoftGOT2000, 

reinstall it.

0x1200 to 
0x120E

0x2601

0x2700

Error message Error code Definition and cause Corrective action
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The GT SoftGOT2000 is not installed 
correctly.

0x2201 • Configuring the execution environment for 
GT SoftGOT2000 has failed.

• GT SoftGOT2000 is not installed correctly.

• After restarting the personal computer, 
restart GT SoftGOT2000.

• After uninstalling GT SoftGOT2000, 
reinstall it.

0x2401

0x2403

0x2600

0x2A00

0x2B00

0x3700

0x3800

The license key should be installed to 
operate the GT SoftGOT2000.
The GT SoftGOT2000 will be terminated in 
about 3 hours when operating without the 
license key.
Do you want to proceed?

0x2301 to 
0x2304

• Installing the system driver has failed.
• The system driver is not installed.

• Check that the system driver is installed.
• Reinstall the system driver.
• Check the license key with Windows 

Device Manager.
For troubleshooting the license key-related 
problems, refer to the following.
Page 728 Troubleshooting for license 
key

0x2307 to 
0x230D

0x230F to 
0x2315

0x231D to 
0x2320

0x2327

0x232A

0x232C

0x232D

0x232F

0x2330

0x2339 to 
0x233C

Access to the license key is denied.
Possible causes are as follows:
• The system driver is not installed.
• The parallel port is unusable or does not 

exist.
• The USB port is unusable or does not 

exist.

0x233D • The system driver is not installed.
• The parallel port is unusable or 

nonexistent.
• The USB port is unusable or nonexistent.

• Install the system driver.
• Make sure that the parallel port is usable.
• Make sure that the USB port is usable.

Initialization for reading failed.
Execute one of the following operations.
• Close the dialog if it is displayed.
• Switching to offline mode may have been 

failed.
Wait for several seconds and retry the 
operation.

0x2500 Since the message such as "This function 
cannot be used now" was displayed on the 
screen, this function can not be loaded.

After selecting [OK] in the dialog to erase the 
on-screen message, re-load the function.

0x2501 Waiting for completion of internal process. re-load the function after a few minutes.

Failed to read a project data.
Check the following items and retry the 
operation.
• Data size and number of the data.
• Free disk space.
• Access privileges to the environment file.
• Validity of project data (invalid file or file not 

found).

0x3101 - • Decrease the screen data size to 57MB or 
less.

• Increase the free space of the hard disk.
• Check the access privilege of the project 

data.
• Check that the project data has no 

problems, or use an uncorrupted version of 
the project data.

• Check that the project data exists.

0x3165 to 
0x318C

0x31FD

0x31FF

0x3201

0x3265 to 
0x328C

0x32FD

0x32FF

0x3301

0x3401

0x3465 to 
0x348C

0x34FD

0x34FF

GOT type of the project is different from the 
one specified in the GT SoftGOT2000.
[Project data setting]
GOT type : #####(###x###)

0x3500 The GOT type set in the project is different 
from the GOT type specified in GT 
SoftGOT2000.

Make correction so that the GOT type of the 
project created on GT Designer3 is the same 
as the GOT type of GT SoftGOT2000.

Error message Error code Definition and cause Corrective action
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GOT type (Resolution) of the project is 
different from the one specified in the GT 
SoftGOT2000.
[Project data setting]
GOT type : #####(###x###)
[GT SoftGOT2000 setting]
Resolution : ###x###

0x3501 The GOT type (Resolution) set in the project 
is different from the GOT type (Resolution) 
specified in GT SoftGOT2000.

Set the same resolution in the project in GT 
Designer3 and in GT SoftGOT2000.

Vertical project data is not supported. 0x3502 The project data for vertical display type has 
been read.

Read project data for horizontal display.

PLC type of the project is different from the 
one specified in the GT SoftGOT2000.
Check the setting and retry.
[Project data setting]
CH1 : #####
[GT SoftGOT2000 setting]
CH1 : #####(#####)

0x3601 The PLC type set in the project is different 
from that in GT SoftGOT2000.

Make correction so that the PLC type of the 
project created on GT Designer3 is the same 
as the CPU type of GT SoftGOT2000.

Controller type of the project is different from 
the one specified in 'GT SoftGOT2000'.
Check the setting and retry.
[Project data setting]
CH1 : ####
CH2 : ####
CH3 : ####
CH4 : ####
[GT SoftGOT2000 setting]
CH1 : ####(####)
CH2 : ####(####)
CH3 : ####(####)
CH4 : ####(####)

0x3601 The controller type set in the read project is 
different from the controller type set in GT 
SoftGOT2000.

Set the same controller type in the project in 
GT Designer3 and in GT SoftGOT2000.

Fail in the delete of resource data.
• Please close resource data if it is opened.
• Check the file access privilege.

0x3801 Failed in erasing resource data after loading 
screen data.

• If there is resource data opened by another 
software, close that file.

• Check the file access privilege.

Error message Error code Definition and cause Corrective action
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Troubleshooting for license key
When attaching a USB license key to the personal computer and it is not recognized, check the following.

If the system driver is not installed or uninstalled properly even if the above corrective actions are taken, use 
the installer of the following system driver.
(GT SoftGOT2000 installation folder)\SGT2000\SystemDriver\SPI_771.exe

Error Definition and cause Corrective action
The dialog for starting a wizard to search an 
added hardware is displayed.

The license key was attached to the PC before 
the installation of system driver.

Exit the GT SoftGOT2000 without any installation and 
then remove the license key.
When attaching the GT27-SGTKEY-U after installing 
the system driver, it is recognized as license key.

The GT27-SGTKEY-U is not recognized as 
license key by the OS when attached to the PC.

The GT27-SGTKEY-U was attached to the PC 
before the installation of system driver, and an 
illegal driver was installed.

Install the system driver after removing the GT27-
SGTKEY-U.
When attaching the GT27-SGTKEY-U after 
installation, it is recognized as license key.

The GT SoftGOT2000 displays an error message 
involving license key despite System Driver is 
installed/license key is installed/the port is ready 
for use.

System Driver has an error. Remove the GT27-SGTKEY-U and uninstall System 
Driver once.
Install System Driver again.
Install the GT27-SGTKEY-U after installing System 
Driver.
Then it is recognized as license key.
For information on how to install and uninstall the 
system driver, refer to the following.
Page 45 Installing and uninstalling the system 
driver

When the license key is attached, the dialog 
asking you to specify the storage location of the 
system file is displayed.

The automatic detection of the system file failed. Specify the system file in the following location.
C:\Program Files\Common Files\SafeNet 
Sentinel\Sentinel System Driver\sntnlusb.sys

Although the license key is attached, an error 
message related to the license key appears in 
GT SoftGOT2000.

The parallel driver is not installed. Remove the license key GT27-SGTKEY-U, and install 
the parallel driver manually from the installer of the 
system driver.
For how to install the parallel driver, refer to the 
following.
Page 729 Installing the parallel driver
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Installing and uninstalling the parallel driver
For Sentinel Protection Installer 7.6.9 or later, the parallel driver is not automatically installed at the time of automatic 
installation.
Customers should install it manually.
Before installing or uninstalling the parallel driver, remove the license key GT27-SGTKEY-U.
Otherwise, installation may fail.
If installation fails, uninstall and reinstall the parallel driver with the license key GT27-SGTKEY-U removed.
The following shows the installation procedure for the parallel driver.

■Installing the parallel driver
To install the parallel driver, uninstall the system driver if installed, then install the system driver again.
Page 45 Uninstalling the system driver

1. Run the installer of the following system driver.
(GT SoftGOT2000 installation folder)\SGT2000\SystemDriver\SPI_771.exe

2. Running the installer displays the following dialog.
Click the [Next] button.

3. Select [I accept the terms in the license agreement], then click the [Next] button.
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4. Select [Custom], then click the [Next] button.

5. Click the icon to the left of [Parallel Driver].

6. Select [This feature will be installed on local hard drive.].
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7. The icon changes.

8. Click the [Next] button.

9. Click the [Install] button.

10.Click the [Yes] button.
If the confirmation message appears, follow the on-screen instructions.
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11. Click the [Finish] button.

■Uninstalling the parallel driver
In [Programs and Features] in the Windows Control Panel, uninstall [Sentinel Protection Installer □.□.□].
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Troubleshooting related to mail transmission

Troubleshooting

Error code
No dialogue boxes are displayed by GT SoftGOT2000 for errors related to mail transmission and dialup.
Refer to the mail history data for error codes and error messages.
Refer to Page 613 Mail history for how to reference the mail history data.
The following table lists the error codes related to mail transmission and dialup, their definitions and causes, and the 
corrective actions to take:

Error notifications from the mail server
When an error is notified from the mail server, the error message will be displayed in the mail history data.
The following shows an example.
Example) Error message displayed when an error is notified from the SMTP server

When an error as shown above occurs, consult the server administrator.

Troubleshooting for print

Troubleshooting for file save problems

Error description Definition and cause Corrective action
Mail is not sent. The mail send setting of GT SoftGOT2000 has not been made. Make the mail send setting of GT SoftGOT2000.

Mail send setting has been made on GT Designer3.

The mail send setting method is wrong. Reexamine the mail send setting of GT SoftGOT2000.

Error code Definition and cause Corrective action
600 to 750s Setting errors of personal computers and peripheral devices (e.g., modem) Refer to the Help function in Windows.

Error Definition and cause Corrective action
GT SoftGOT2000 does not output data to a printer 
even when the hard copy is executed from a 
monitor screen with [Print to printer (Hard Copy 
Function)] enabled.

Printing is disabled due to a problem in the printer. • Select [Project] [Print Setup] on GT 
SoftGOT2000 to check the settings of the printer.

• Print a test page from Windows to check the 
settings of the printer.

• Check if the printer is powered on and online.
• Install the printer driver again.

The output target in the hard copy setting of the 
project data is set to [File].

Open the project data with GT Designer3, and 
select [Printer] for [Target] in the hard copy setting.

Error Definition and Cause Corrective action
No files are output when the hard copy command 
is executed from the monitor screen of the GT 
SoftGOT2000.

The file cannot be saved due to problems with the 
output destination disk.

• Check that the folder specified as the virtual 
drive exists.

• Check the access privilege for the folder 
specified as the virtual drive.

• Free up space on the disk where the folder 
specified as the virtual drive is located.

The file cannot be saved, since file number 
external control device value is set to a value 
outside of the range 1 to 9999.

• Check that the file No. external control device 
value is set within 1 to 9999.

Error message

SMTP Error Report: #####.
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Troubleshooting for the OPC UA client connection
The following shows the causes of errors occurring when the OPC UA client connection is used and their corrective actions.

Error code Error Cause Corrective action
322 The number of set characters is out of 

the specification range.
The number of acquired characters is more than 
326.

Set the number of characters in a tag name 
within 326 characters on the server.

326 The data type used for the request 
does not match with the data type of 
the target tag.

The data type of the tags set on the client does 
not match with the data type of the tags set on 
the server.

• Set tags on the server again.
• In GT Designer3, import the latest tag 

information of the server and set the tags 
again.

328 The specified tag is invalid. The tag is nonexistent on the server. Import the latest tag information of the server to 
GT Designer3, and set the tags again.The access direction does not match. • You have tried to write data to a read-only tag.

• You have tried to read data from a write-only 
tag.

401 An abnormal code is received from the 
server.

The memory is insufficient. • Restart GT SoftGOT2000.
• Restart the personal computer.

402 Initializing OpenSSL has failed. The server certificate is invalid. Delete the server certificate, and configure the 
settings again.

Reading a client certificate has failed. • No client certificate has been created.
• No client certificate has been imported.

• Create a client certificate in the 
[Communication Setup] dialog in GT 
SoftGOT2000.

• In the [Communication Setup] dialog in GT 
SoftGOT2000, import the client certificate 
created with GT OPC UA Client Setting Tool.

Obtaining the endpoint URL of the 
OPC UA server has failed.

• The cable is disconnected.
• The cable is broken.
• The endpoint URL is invalid.
• The port number is invalid.
• The server is not started.
• The status of the server is abnormal.

• Check the communication environment.
• Check that the endpoint URL and port No. are 

correct.
• Check that the status of the server is normal.

Connection error • The cable is disconnected.
• The cable is broken.
• The server is not started.
• The status of the server is abnormal.
• The security mode does not match.
• User authentication has failed.
• The client certificate has expired.
• The maximum number of sessions allowed on 

the server has been reached.

• Check the communication environment.
• Check that the status of the server is normal.
• Set the security mode according to the server.
• Check that the user name and password are 

correct.
• Create a client certificate in the 

[Communication Setup] dialog in GT 
SoftGOT2000.

• Create a client certificate in the 
[Communication Setup] dialog in GT 
SoftGOT2000 again.

• Disconnect unnecessary clients.

Read error or write error • The cable is disconnected.
• The cable is broken.
• The server is not started.
• The status of the server is abnormal.
• The client certificate is expired.

• Check the communication environment.
• Check that the status of the server is normal.
• Create a client certificate in the 

[Communication Setup] dialog in GT 
SoftGOT2000.
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Troubleshooting for the Edgecross interaction function
The following shows the error messages, definitions and causes, and corrective actions related to the Edgecross interaction 
function.

GOT error code list
For the system alarm detected with GOT, refer to the following manual.
GOT2000 Series User's Manual (Utility)

Error code list when using the internal device interface function
The following shows lists of error codes that occur when the internal device interface function is used.

Error message Definition and cause Corrective action
Access to [Setting for Edgecross Interaction 
Function] - [Allocation Setting □] file is denied.
Check the followings and retry.

• File access privilege
• The file is invalid or does not exist.

The Edgecross interaction configuration file does 
not exist.

Check if the Edgecross interaction configuration 
file exists.

The setting in the row No.□ in [Setting for 
Edgecross Interaction Function] - [Allocation 
Setting □] file is invalid.
Check the setting and retry.

• The item name is invalid.
• The number of items is insufficient.
• Necessary items are not set.
• A value outside the setting range is set.

Check each setting item of the file.

Access to the save destination folder specified in 
[Setting for Edgecross Interaction Function] - 
[Allocation Setting □] file is denied.
Check the followings and retry.

• File access privilege
• The file is invalid or does not exist.

The save destination folder of the real-time data 
that is specified in Real-time Flow Designer is 
inaccessible.

Check the access privilege for the save destination 
folder.

Error code Definition and cause Corrective action
1 Succeeded -

0 Opening or mapping of the shared memory was failed.
(Access to internal devices disabled)

• Start GT SoftGOT2000.
• Specify a valid GT SoftGOT2000 module number (1 to 32767).
• Exit unnecessary applications to secure memory space.
• Restart the personal computer.

-1 The specified device name ID is invalid. • Specify a valid device name ID.

-2 The specified start device is outside the range. • Specify a valid device number.

-3 The specified end device is outside the range. • Specify the number of devices within the valid device range.

-4 The specified device number is invalid. • Specify a valid device number.

-5 The address of the specified device value is invalid. • Secure the device value storage area and specify the start address of the 
read device value.

• Secure the device value storage area and specify the start address of the 
device value to be written.

-6 The specified device value is invalid. • Specify a valid device value.

-9 The specified shared address is illegal. • Specify the shared memory address obtained by the 
GDev_OpenMapping function.

• Specify the shared memory address obtained by the 
sgt_GDevOpenMapping function.

-10 The specified number of devices is invalid. • Specify the number of devices within the range.

-11 The specified argument is invalid. • Check the error code value (IError) in the structure for storing device 
information, check the relevant corrective action, and then specify the 
correct argument.
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5.3 Applicable Project Data
Use GT SoftGOT2000 of the same version as the GT Designer3.
When the versions of GT SoftGOT2000 and GT Designer3 are different, install the same version of GT SoftGOT2000/GT 
Designer3.

When using the project data created on the GT Designer3 version older than the GT SoftGOT2000 version
Open the project data on the GT Desinger3 of the same version as the GT SoftGOT2000, and save the 
project data.
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5.4 Open Source Software
OpenSSL toolkit
This product uses OpenSSL toolkit licensed under the OpenSSL License and the Original SSLeay License.
The permission notices of OpenSSL License and Original SSLeay License are described below.

 LICENSE ISSUES
 ==============

 The OpenSSL toolkit stays under a double license, i.e. both the conditions of
 the OpenSSL License and the original SSLeay license apply to the toolkit.
 See below for the actual license texts.

 OpenSSL License
 ---------------

/* ====================================================================
* Copyright (c) 1998-2018 The OpenSSL Project.  All rights reserved.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
*
* 1. Redistributions of source code must retain the above copyright
*    notice, this list of conditions and the following disclaimer.
*
* 2. Redistributions in binary form must reproduce the above copyright
*    notice, this list of conditions and the following disclaimer in
*    the documentation and/or other materials provided with the
*    distribution.
*
* 3. All advertising materials mentioning features or use of this
*    software must display the following acknowledgment:
*    "This product includes software developed by the OpenSSL Project
*    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
*
* 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
*    endorse or promote products derived from this software without
*    prior written permission. For written permission, please contact
*    openssl-core@openssl.org.
*
* 5. Products derived from this software may not be called "OpenSSL"
*    nor may "OpenSSL" appear in their names without prior written
*    permission of the OpenSSL Project.
*
* 6. Redistributions of any form whatsoever must retain the following
*    acknowledgment:
*    "This product includes software developed by the OpenSSL Project
*    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
*
* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
* EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
* PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
* ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
* SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.
* ====================================================================
*
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* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com).  This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).
*
*/

Original SSLeay License
-----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.
*
* This package is an SSL implementation written
* by Eric Young (eay@cryptsoft.com).
* The implementation was written so as to conform with Netscapes SSL.
*
* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to.  The following conditions
* apply to all code found in this distribution, be it the RC4, RSA,
* lhash, DES, etc., code; not just the SSL code.  The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).
*
* Copyright remains Eric Young's, and as such any Copyright notices in
* the code are not to be removed.
* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.
* This can be in the form of a textual message at program startup or
* in documentation (online or textual) provided with the package.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the copyright
*    notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
*    notice, this list of conditions and the following disclaimer in the
*    documentation and/or other materials provided with the distribution.
* 3. All advertising materials mentioning features or use of this software
*    must display the following acknowledgement:
*    "This product includes cryptographic software written by
*     Eric Young (eay@cryptsoft.com)"
*    The word 'cryptographic' can be left out if the rouines from the library
*    being used are not cryptographic related :-).
* 4. If you include any Windows specific code (or a derivative thereof) from
*    the apps directory (application code) you must include an acknowledgement:
*    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
*
* THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
* ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
* FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
* DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
* OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
* LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
* OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
* SUCH DAMAGE.
*
* The licence and distribution terms for any publically available version or
* derivative of this code cannot be changed.  i.e. this code cannot simply be
* copied and put under another distribution licence
* [including the GNU Public Licence.]
*/
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PDFium
PDFium, which is the BSD license, is used in this product.
The following describes the copyright notice and agreement notice of PDFium.

// Copyright 2014 PDFium Authors. All rights reserved.
//
// Redistribution and use in source and binary forms, with or without
// modification, are permitted provided that the following conditions are
// met:
//
// * Redistributions of source code must retain the above copyright
// notice, this list of conditions and the following disclaimer.
// * Redistributions in binary form must reproduce the above
// copyright notice, this list of conditions and the following disclaimer
// in the documentation and/or other materials provided with the
// distribution.
// * Neither the name of Google Inc. nor the names of its
// contributors may be used to endorse or promote products derived from
// this software without specific prior written permission.
//
// THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
// "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
// LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
// A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
// OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
// SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
// LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
// DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
// THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
// (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
// OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Perl-Compatible Regular Expressions
The copyright and permission notices of Perl-Compatible Regular Expressions are described below.

/*************************************************
*       Perl-Compatible Regular Expressions      *
*************************************************/

/* This is the public header file for the PCRE library, to be #included by
applications that call the PCRE functions.

          Copyright (c) 1997-2014 University of Cambridge

-----------------------------------------------------------------------------
Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

   * Redistributions of source code must retain the above copyright notice,
     this list of conditions and the following disclaimer.

   * Redistributions in binary form must reproduce the above copyright
     notice, this list of conditions and the following disclaimer in the
     documentation and/or other materials provided with the distribution.

   * Neither the name of the University of Cambridge nor the names of its
     contributors may be used to endorse or promote products derived from
     this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
-----------------------------------------------------------------------------
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OpenJPEG
The copyright and permission notices of OpenJPEG are described below.

/*
* The copyright in this software is being made available under the 2-clauses 
* BSD License, included below. This software may be subject to other third 
* party and contributor rights, including patent rights, and no such rights
* are granted under this license.
*
* Copyright (c) 2002-2014, Universite catholique de Louvain (UCL), Belgium
* Copyright (c) 2002-2014, Professor Benoit Macq
* Copyright (c) 2003-2014, Antonin Descampe
* Copyright (c) 2003-2009, Francois-Olivier Devaux
* Copyright (c) 2005, Herve Drolon, FreeImage Team
* Copyright (c) 2002-2003, Yannick Verschueren
* Copyright (c) 2001-2003, David Janssens
* Copyright (c) 2011-2012, Centre National d'Etudes Spatiales (CNES), France 
* Copyright (c) 2012, CS Systemes d'Information, France
*
* All rights reserved.
*
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the above copyright
*    notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
*    notice, this list of conditions and the following disclaimer in the
*    documentation and/or other materials provided with the distribution.
*
* THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS `AS IS'
* AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
* IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
* ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE
* LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
* CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
* SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS
* INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
* CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
* POSSIBILITY OF SUCH DAMAGE.
*/
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Little cms color engine
The copyright and permission notices of Little cms color engine are described below. 

//---------------------------------------------------------------------------------
//
//  Little Color Management System
//  Copyright (c) 1998-2012 Marti Maria Saguer
//
// Permission is hereby granted, free of charge, to any person obtaining
// a copy of this software and associated documentation files (the "Software"),
// to deal in the Software without restriction, including without limitation
// the rights to use, copy, modify, merge, publish, distribute, sublicense,
// and/or sell copies of the Software, and to permit persons to whom the Software
// is furnished to do so, subject to the following conditions:
//
// The above copyright notice and this permission notice shall be included in
// all copies or substantial portions of the Software.
//
// THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
// EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO
// THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
// NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
// LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
// OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
// WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
//
//---------------------------------------------------------------------------------
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FreeTypeProject
The copyright and permission notices of FreeTypeProject are described below.

                   The FreeType Project LICENSE
                   ----------------------------

                           2006-Jan-27

                   Copyright 1996-2002, 2006 by
         David Turner, Robert Wilhelm, and Werner Lemberg

Introduction
============

 The FreeType  Project is distributed in  several archive packages;
 some of them may contain, in addition to the FreeType font engine,
 various tools and  contributions which rely on, or  relate to, the
 FreeType Project.

 This  license applies  to all  files found  in such  packages, and
 which do not  fall under their own explicit  license.  The license
 affects  thus  the  FreeType   font  engine,  the  test  programs,
 documentation and makefiles, at the very least.

 This  license   was  inspired  by  the  BSD,   Artistic,  and  IJG
 (Independent JPEG  Group) licenses, which  all encourage inclusion
 and  use of  free  software in  commercial  and freeware  products
 alike.  As a consequence, its main points are that:

   o We don't promise that this software works. However, we will be
     interested in any kind of bug reports. (`as is' distribution)

   o You can  use this software for whatever you  want, in parts or
     full form, without having to pay us. (`royalty-free' usage)

   o You may not pretend that  you wrote this software.  If you use
     it, or  only parts of it,  in a program,  you must acknowledge
     somewhere  in  your  documentation  that  you  have  used  the
     FreeType code. (`credits')

 We  specifically  permit  and  encourage  the  inclusion  of  this
 software, with  or without modifications,  in commercial products.
 We  disclaim  all warranties  covering  The  FreeType Project  and
 assume no liability related to The FreeType Project.

 Finally,  many  people  asked  us  for  a  preferred  form  for  a
 credit/disclaimer to use in compliance with this license.  We thus
 encourage you to use the following text:

  """
   Portions of this software are copyright © <year> The FreeType
   Project (www.freetype.org).  All rights reserved.
  """

 Please replace <year> with the value from the FreeType version you
 actually use.

Legal Terms
===========

0. Definitions
--------------
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5.4  Open Source Software 743



74
 Throughout this license,  the terms `package', `FreeType Project',
 and  `FreeType  archive' refer  to  the  set  of files  originally
 distributed  by the  authors  (David Turner,  Robert Wilhelm,  and
 Werner Lemberg) as the `FreeType Project', be they named as alpha,
 beta or final release.

 `You' refers to  the licensee, or person using  the project, where
 `using' is a generic term including compiling the project's source
 code as  well as linking it  to form a  `program' or `executable'.
 This  program is  referred to  as  `a program  using the  FreeType
 engine'.

 This  license applies  to all  files distributed  in  the original
 FreeType  Project,   including  all  source   code,  binaries  and
 documentation,  unless  otherwise  stated   in  the  file  in  its
 original, unmodified form as  distributed in the original archive.
 If you are  unsure whether or not a particular  file is covered by
 this license, you must contact us to verify this.

 The FreeType  Project is copyright (C) 1996-2000  by David Turner,
 Robert Wilhelm, and Werner Lemberg.  All rights reserved except as
 specified below.

1. No Warranty
--------------

 THE FREETYPE PROJECT  IS PROVIDED `AS IS' WITHOUT  WARRANTY OF ANY
 KIND, EITHER  EXPRESS OR IMPLIED,  INCLUDING, BUT NOT  LIMITED TO,
 WARRANTIES  OF  MERCHANTABILITY   AND  FITNESS  FOR  A  PARTICULAR
 PURPOSE.  IN NO EVENT WILL ANY OF THE AUTHORS OR COPYRIGHT HOLDERS
 BE LIABLE  FOR ANY DAMAGES CAUSED  BY THE USE OR  THE INABILITY TO
 USE, OF THE FREETYPE PROJECT.

2. Redistribution
-----------------

 This  license  grants  a  worldwide, royalty-free,  perpetual  and
 irrevocable right  and license to use,  execute, perform, compile,
 display,  copy,   create  derivative  works   of,  distribute  and
 sublicense the  FreeType Project (in  both source and  object code
 forms)  and  derivative works  thereof  for  any  purpose; and  to
 authorize others  to exercise  some or all  of the  rights granted
 herein, subject to the following conditions:

   o Redistribution of  source code  must retain this  license file
     (`FTL.TXT') unaltered; any  additions, deletions or changes to
     the original  files must be clearly  indicated in accompanying
     documentation.   The  copyright   notices  of  the  unaltered,
     original  files must  be  preserved in  all  copies of  source
     files.

   o Redistribution in binary form must provide a  disclaimer  that
     states  that  the software is based in part of the work of the
     FreeType Team,  in  the  distribution  documentation.  We also
     encourage you to put an URL to the FreeType web page  in  your
     documentation, though this isn't mandatory.

 These conditions  apply to any  software derived from or  based on
 the FreeType Project,  not just the unmodified files.   If you use
 our work, you  must acknowledge us.  However, no  fee need be paid
 to us.

3. Advertising
--------------

 Neither the  FreeType authors and  contributors nor you  shall use
 the name of the  other for commercial, advertising, or promotional
 purposes without specific prior written permission.

 We suggest,  but do not require, that  you use one or  more of the
 following phrases to refer  to this software in your documentation
 or advertising  materials: `FreeType Project',  `FreeType Engine',
 `FreeType library', or `FreeType Distribution'.
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 As  you have  not signed  this license,  you are  not  required to
 accept  it.   However,  as  the FreeType  Project  is  copyrighted
 material, only  this license, or  another one contracted  with the
 authors, grants you  the right to use, distribute,  and modify it.
 Therefore,  by  using,  distributing,  or modifying  the  FreeType
 Project, you indicate that you understand and accept all the terms
 of this license.

4. Contacts
-----------

 There are two mailing lists related to FreeType:

   o freetype@nongnu.org

     Discusses general use and applications of FreeType, as well as
     future and  wanted additions to the  library and distribution.
     If  you are looking  for support,  start in  this list  if you
     haven't found anything to help you in the documentation.

   o freetype-devel@nongnu.org

     Discusses bugs,  as well  as engine internals,  design issues,
     specific licenses, porting, etc.

 Our home page can be found at

   https://www.freetype.org

--- end of FTL.TXT ---
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JQuery
The copyright and permission notices of JQuery are described below.

Copyright 2014 jQuery Foundation and other contributors
http://jquery.com/

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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JQuery Marquee
The copyright and permission notices of JQuery Marquee are described below.

MIT License

Copyright (c) 2017 Aamir Afridi http://www.aamirafridi.com

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
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JQuery UI
The copyright and permission notices of JQuery UI are described below.

Copyright OpenJS Foundation and other contributors, https://openjsf.org/

This software consists of voluntary contributions made by many
individuals. For exact contribution history, see the revision history
available at https://github.com/jquery/jquery-ui

The following license applies to all parts of this software except as
documented below:

====

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be
included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION
OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

====

Copyright and related rights for sample code are waived via CC0. Sample
code is defined as all source code contained within the demos directory.

CC0: http://creativecommons.org/publicdomain/zero/1.0/

====

All files located in the node_modules and external directories are
externally maintained libraries used by this software which have their
own licenses; we recommend you read them, as their terms may differ from
the terms above.
8 5  APPENDICES
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CreateJS
The copyright and permission notices of CreateJS are described below.

MIT License

Copyright (c) 2018 CreateJS

Permission is hereby granted, free of charge, to any person obtaining a copy
of this software and associated documentation files (the "Software"), to deal
in the Software without restriction, including without limitation the rights
to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all
copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
5  APPENDICES
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Web Font Loader
The copyright and permission notices of Web Font Loader are described below.

Web Font Loader Copyright (c) 2010 Adobe Systems Incorporated, Google Incorporated.

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance with
the License. You may obtain a copy of the License at

  http://www.apache.org/licenses/LICENSE-2.0 

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed on an
"AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for
the specific language governing permissions and limitations under the License.
0 5  APPENDICES
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jsSHA
The copyright and permission notices of jsSHA are described below.

Copyright (c) 2008-2016, Brian Turek
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this
  list of conditions and the following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice,
  this list of conditions and the following disclaimer in the documentation
  and/or other materials provided with the distribution.
* Neither the name of the the copyright holder nor the names of its
  contributors may be used to endorse or promote products derived from this
  software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCEOR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISEDOF THE POSSIBILITY OF SUCH DAMAGE.

--------------------------------------------------------------------------------

Portions of this software are derived from code under the same license and

Copyright (c) 1998 - 2009, Paul Johnston & Contributors
All rights reserved.

Original code is available on http://pajhome.org.uk/crypt/md5
5  APPENDICES
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libexpat
The copyright and permission notices of libexpat are described below.

Copyright (c) 1998-2000 Thai Open Source Software Center Ltd and Clark Cooper
Copyright (c) 2001-2022 Expat maintainers

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to
permit persons to whom the Software is furnished to do so, subject to
the following conditions:

The above copyright notice and this permission notice shall be included
in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT,
TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE
SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
2 5  APPENDICES
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Revisions
* The manual number is given on the bottom left of the back cover.

Revision date * Manual Number Revision
Sep., 2013 SH(NA)-081201ENG-A Compatible with GT SoftGOT2000 Version1.100E

Nov., 2013 SH(NA)-081201ENG-B Compatible with GT SoftGOT2000 Version1.104J
• Compatible with PX Developer cooperation

Jan., 2014 SH(NA)-081201ENG-C Compatible with GT SoftGOT2000 Version1.108N
• Compatible with Keycode
• Compatible with MT Simulator2

Apr., 2014 SH(NA)-081201ENG-D Compatible with GT SoftGOT2000 Version1.111R
• Writing errors have been corrected

Jun., 2014 SH(NA)-081201ENG-E Compatible with GT SoftGOT2000 Version1.117X
• Compatible with MELSEC iQ-R
• Compatible with Q24DHCCPU-VG

Jul., 2014 SH(NA)-081201ENG-F Compatible with GT SoftGOT2000 Version1.118Y
• Writing errors have been corrected.

Oct., 2014 SH(NA)-081201ENG-G Compatible with GT SoftGOT2000 Version1.122C
• The abbreviations, generic terms, and icon indications have been changed.
• The display language switching function is supported.
• TCP is supported as a communication format for connecting to RCPU in the communication setup for 
the SoftGOT-GOT link function.
• Support for GT SoftGOT2000 running on Windows XP Service Pack2 and Windows 2000 has ended.

Jan., 2015 SH(NA)-081201ENG-H Compatible with GT SoftGOT2000 Version1.126G
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• The Motion CPU (MELSEC iQ-R series) is supported.
• MELSEC iQ-F is supported.
• GX Simulator3 is supported.
• The internal device interface function is applicable to Micorsoft Excel VBA.

Apr., 2015 SH(NA)-081201ENG-I Compatible with GT SoftGOT2000 Version1.130L
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• R08PCPU, R16PCPU, R32PCPU, and R120PCPU are supported.
• R12CCPU-V is supported.

Jun., 2015 SH(NA)-081201ENG-J Compatible with GT SoftGOT2000 Version1.134Q
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• TOSHIBA PLC (Unified Controller nv) is supported.
• GT SoftGOT2000 Commander supports the management of GT SoftGOT1000.
• Visual Studio2010 is supported.

Jul., 2015 SH(NA)-081201ENG-K Compatible with GT SoftGOT2000 Version1.136S
• R04ENCPU, R08ENCPU, R16ENCPU, R32ENCPU, and R120ENCPU are supported.
• The folder name [MELSOFT Application] displayed in the Windows start menu has been changed to 
[MELSOFT].

Oct., 2015 SH(NA)-081201ENG-L Compatible with GT SoftGOT2000 Version1.144A
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• R08SFCPU, R16SFCPU, R32SFCPU, and R120SFCPU are supported.
• R64MTCPU is supported.
• YASKAWA PLC (MP3000 series) is supported.
• The GOT network interaction function is supported.
• The USB barcode reader connection is supported.

Dec., 2015 SH(NA)-081201ENG-M Compatible with GT SoftGOT2000 Version1.150G
• SAFETY PRECAUTIONS changed.
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• Q26DHCCPU-LS is supported.
• Access to an LCPU or a QCPU via an RCPU by the Ethernet connection, direct CPU connection, CC-
Link IE Controller Network connection, or CC-Link IE Field Network connection is supported.

May, 2016 SH(NA)-081201ENG-N Compatible with GT SoftGOT2000 Version1.155M
• SAFETY PRECAUTIONS changed.
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• R16NCCPU-S1 is supported.
• The SLMP connection is supported.
• GT SoftGOT2000 is compatible with Windows 10.
753
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Aug., 2016 SH(NA)-081201ENG-O Compatible with GT SoftGOT2000 Version1.160S
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• RJ72GF15-T2 is supported.
• MELSERVO-J4 series is supported.
• MELSERVO-JE series is supported.
• The redundant system (RCPU) is supported.
• The SoftGOT-GOT link function supports the monitoring of a controller through a GOT by Ethernet.
• The Ethernet connection supports the TCP/IP protocol.

Oct., 2016 SH(NA)-081201ENG-P Compatible with GT SoftGOT2000 Version1.165X
• SAFETY PRECAUTIONS changed.
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• Access to the MELSEC iQ-F on the CC-Link IE Field Network through a MELSEC iQ-R or MELSEC iQ-
F is supported.
• [Servo axis switching device first No.] has been added to the communication setup (for RCPU and 
MELSEC iQ-F).
• [Delay time] has been added to the mail setup.

Jan., 2017 SH(NA)-081201ENG-Q Compatible with GT SoftGOT2000 Version1.170C
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• The MODBUS/TCP connection is renamed to the MODBUS/TCP master connection.
• The MODBUS/TCP slave connection is supported.
• RD77GF32 is supported.
• FX5-80SSC-S is supported.
• Retaining print settings is supported.

Apr., 2017 SH(NA)-081201ENG-R Compatible with GT SoftGOT2000 Version1.175H
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• The setting to unmute GT SoftGOT2000 at its startup has been added to the environment setup.
• The SoftGOT-GOT link function supports the PDF file synchronization.
• The SoftGOT-GOT link function supports the Ethernet communication unit to connect the personal 
computer and GOT.

Jun., 2017 SH(NA)-081201ENG-S Compatible with GT SoftGOT2000 Version1.180N
• The description of Abbreviations, Generic Terms, the meaning of the icon has been changed.
• R800-R (R16RTCPU) and CR800-D are supported.
• The internal device interface functions are available on Visual Studio 2012, Visual Studio 2013, and 
Visual Studio 2015.
• Accessing a different network via the GOT and a QCPU or LCPU by using the SoftGOT-GOT link 
function and the Ethernet connection is supported.

Oct., 2017 SH(NA)-081201ENG-T Compatible with GT SoftGOT2000 Version1.185T
• The abbreviations, generic terms, and icon indications have been changed.
• The time setting function and the time notification function are supported.

Dec., 2017 SH(NA)-081201ENG-U Compatible with GT SoftGOT2000 Version1.190Y
• R00CPU, R01CPU, and R02CPU are supported.
• Global labels are supported when GX Simulator3 is connected.

Apr., 2018 SH(NA)-081201ENG-V Compatible with GT SoftGOT2000 Version1.195D
• Windows Server 2016, Windows Server 2012 R2, and Windows Server 2008 R2 are supported.
• MELIPC is supported.
• The Edgecross interaction function is supported.
• The troubleshooting descriptions have been modified.

Jul., 2018 SH(NA)-081201ENG-W Compatible with GT SoftGOT2000 Version1.200J
• R08PSFCPU, R16PSFCPU, R32PSFCPU, and R120PSFCPU are supported.
• The MODBUS/TCP master connection between GT SoftGOT2000 and controllers with unit ID 255 is 
supported.

Oct., 2018 SH(NA)-081201ENG-X Compatible with GT SoftGOT2000 Version1.205P
• The abbreviations, generic terms, and icon indications have been changed.
• Help (e-Manual) is supported.
• CR800-Q (Q172DSRCPU) is supported.
• TOSHIBA PLC (Unified Controller nv) type1 light is supported.
• The virtual drive N is supported.
• The following internal device interface functions are usable for SGB and SGD devices.
GDev_Read function
GDev_Write function
• The following internal device interface functions are supported.
sgt_GDevOpenMapping function
sgt_GDevCloseUnMapping function
sgt_ReadDeviceRandom function
sgt_WriteDeviceRandom function
sgt_ReadDeviceBlock function
sgt_WriteDeviceBlock function
• Sample programs for Microsoft Excel 2013 have been added.

Revision date * Manual Number Revision
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Jan., 2019 SH(NA)-081201ENG-Y Compatible with GT SoftGOT2000 Version1.210U
• The description for using an MI3000 has been added.
• The description for starting multiple modules has been modified.

Apr., 2019 SH(NA)-081201ENG-Z Compatible with GT SoftGOT2000 Version1.215Z
• The multi-channel function is supported.
• The OPC UA client connection is supported.
• A press-and-hold operation on a touchscreen is supported.
• Retaining GOT internal device data at intervals is supported.
• Specifying CPU numbers and module numbers with devices is supported.
• A description of OpenSSL toolkit has been added.

Jul., 2019 SH(NA)-081201ENG-AA Compatible with GT SoftGOT2000 Version1.220E
• The microcomputer connection (serial) is supported.
• Some items selectable for [Connection] have been renamed. ([RS232], [USB])
• The connection with the CC-Link IE TSN master/local module (RJ71GN11-T2) via Ethernet is 

supported.

Oct., 2019 SH(NA)-081201ENG-AB Compatible with GT SoftGOT2000 Version1.225K
• GT SoftGOT2000 (Multiple channels) supports the inverter connection.
• The connection to FX5UJ is supported.
• Specifying the window startup display position is supported.
• When multiple displays are used, moving a window to other display from the menu options is 

supported.
• The SoftGOT-GOT link function supports the connection with the GOT that uses the base screen size 

expansion.

Jan., 2020 SH(NA)-081201ENG-AC Compatible with GT SoftGOT2000 Version1.230Q
• The connection to the MELSEC iQ-L series is supported.
• The connection to the FR-A800 series (FR-A8□0-GN, FR-A8□2-GN) is supported.
• The connection to the FR-E800 series is supported.
• GT SoftGOT2000 (Multiple channels) supports the SoftGOT-GOT link function.
• The built-in memory (SRAM) of the GOT has been added to the types of resource data to be 

synchronized.
• Selecting the timing to synchronize the resource data is supported.

Apr., 2020 SH(NA)-081201ENG-AD Compatible with GT SoftGOT2000 Version1.235V
• GT SoftGOT2000 (Multiple channels) supports the direct inverter connection by Ethernet.
• GT SoftGOT2000 (Multiple channels) supports the connection with the Motion module (RD78G□) by 

Ethernet.

Jun., 2020 SH(NA)-081201ENG-AE Compatible with GT SoftGOT2000 Version1.240A
• GT SoftGOT2000 (Multiple channels) supports the connection with the Motion module (RD78GHV, 

RD78GHW) by Ethernet.
• GT SoftGOT2000 (Multiple channels) supports the FR-A800 Plus series (FR-A8□0-E-AWH, FR-A8□0-

LC, FR-A8□0-E-LC).
• GT SoftGOT2000 (Multiple channels) supports MR-J5 (MR-J5-G(-RJ), MR-J5W2-G, MR-J5W3-G).
• OMRON PLC (CP2E) is supported.
• KEYENCE PLC (KV-8000 series) is supported.
• The SoftGOT-GOT link function supports selecting the timing to synchronize the project data.
• The company name of TOSHIBA MACHINE CO., LTD. has been changed to SHIBAURA MACHINE 

CO., LTD.

Oct., 2020 SH(NA)-081201ENG-AF Compatible with GT SoftGOT2000 Version1.245F
• SAFETY PRECAUTIONS changed.
• The virtual drive V is supported.
• CPU assignment when starting multiple modules is supported.
• GT SoftGOT2000 (Multiple channels) supports the connection with the CC-Link IE TSN master/local 

module (FX5-CCLGN-MS) by Ethernet.
• The connection to MR-JET-□G is supported.

Jan., 2021 SH(NA)-081201ENG-AG Compatible with GT SoftGOT2000 Version1.250L
• The abbreviations, generic terms, and model icon indications have been changed.
• The SoftGOT-GOT link function is supported by GT2512-WX.

Apr., 2021 SH(NA)-081201ENG-AH Compatible with GT SoftGOT2000 Version1.255R
• The abbreviations, generic terms, and model icon indications have been changed.
• Windows Server 2012 and Windows Server 2019 are supported.
• Importing and exporting of setting files are supported.
• The gateway server function is supported.
• Monitoring an RCPU redundant system through a module on the redundant extension base unit is 

supported.
• FX5-ENET and FX5-ENET/IP are supported.
• HITACHI IES PLCs are supported.
• SIEMENS PLCs (SIMATIC S7-200 SMART and SIMATIC S7-1500) are supported.
• Specifying application startup option settings with devices is supported.
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Jul., 2021 SH(NA)-081201ENG-AI Compatible with GT SoftGOT2000 Version1.260W
• The connection to MR-J4 (MR-J4-GF(-RJ)) through a Simple Motion module or CC-Link IE Field 

Network master/local module is supported.
• The connection to MR-J5 and MR-JET (MR-J5-□G(-RJ), MR-J5W-□G, and MR-JET-□G) by Ethernet 

is supported.
• Direct CPU connection has been renamed to the direct CPU connection (RS-232) or direct CPU 

connection (USB).

Oct., 2021 SH(NA)-081201ENG-AJ Compatible with GT SoftGOT2000 Version1.265B
• SAFETY PRECAUTIONS changed.
• GT SoftGOT2000 (Multiple channels) supports the GOT Mobile function.
• The connection to microcomputers (Ethernet) is supported.
• GT SoftGOT2000 (Multiple channels) supports the connection with the Motion module (FX5-40SSC-G, 

FX5-80SSC-G) by Ethernet.
• The connection to the OMRON PLCs (CJ2H(-EIP)) by using the communication unit CJ1W-EIP21 is 

supported.
• The connection to the LS IS PLCs is supported.
• The connection to the YASKAWA robot controllers is supported.
• Specification of the master GOT for the network interaction function is supported.
• The internal device interface functions are available on Microsoft Visual C++ 2017, Microsoft Visual 

C++ 2019, Microsoft Visual C# 2017, Microsoft Visual C# 2019, and Microsoft Excel 2019.
• GT SoftGOT2000 (Multiple channels) supports the system launcher.
• GT SoftGOT2000 (Multiple channels) supports the system launcher (servo network).
• GT SoftGOT2000 (Multiple channels) supports the drive recorder.
• GT SoftGOT2000 (Multiple channels) supports the servo amplifier graph.
• The mobile screen display is supported.
• The hyperlink is supported.
• The ANDON connection is supported.
• The GOT Mobile information is supported.
• CC-Link IE Field Network diagnostics supports CC-Link IE TSN.
• Support for GT SoftGOT2000 running on Windows XP/Vista has ended.

Jan., 2022 SH(NA)-081201ENG-AK Compatible with GT SoftGOT2000 Version1.270G
• Compatible with FX3U-ENET and FX Configurator-EN.
• GT SoftGOT2000 (Multiple channels) supports the connection to MELSECWinCPU (MELSEC iQ-R 

series).
• The following functions are usable for Microsoft Visual C++ 2017, Microsoft Visual C++ 2019, 

Microsoft Visual C# 2017, and Microsoft Visual C# 2019.
long sgt_GDevOpenMapping()
void sgt_GDevCloseUnMapping()
long sgt_ReadDeviceRandom()
long sgt_WriteDeviceRandom()
• GT SoftGOT2000 (Multiple channels) supports the connection to MR-J5D-□G4 through a Motion 

module.
• GT SoftGOT2000 (Multiple channels) supports the connection to MR-J5-B(MR-J5-□B(-RJ), MR-

J5W2-□B, or MR-J5W3-□B) through a Motion controller or Simple Motion module.
• GT SoftGOT2000 (Multiple channels) supports the connection to MR-J5D-□G4 via Ethernet.
• RD78G□ supports Simple Motion mode.
• OMRON PLCs support the communication unit CJ1W-EIP21.
• GT SoftGOT2000 (Single channel) supports the GOT Mobile function.

Apr., 2022 SH(NA)-081201ENG-AL Compatible with GT SoftGOT2000 Version1.275M
• The connection to the MELSEC iQ-F series (FX5S) is supported.
• Windows 11 is supported.
• GT SoftGOT2000 (Multiple channels) supports the connection to OMRON PLC (NJ and NX series).
• GT SoftGOT2000 (Multiple channels) supports the connection to ALLEN-BRADLEY PLC.
• The connection to a PLC or MELIPC through a servo amplifier using Ethernet connection is supported.

Jul., 2022 SH(NA)-081201ENG-AM Compatible with GT SoftGOT2000 Version1.280S
• GT SoftGOT2000 (Multiple channels) supports the connection to the RnCPU or RnENCPU through 

the CC-Link IE TSN Plus master/local module (RJ71GN11-EIP) by Ethernet.
• The connection to YASKAWA robot controller YRC1000micro is supported.

Oct., 2022 SH(NA)-081201ENG-AN Compatible with GT SoftGOT2000 Version1.285X
• GT SoftGOT2000 (Multiple channels) supports the connection to a servo amplifier (MR-J5-□B(-RJ), 

MR-J5W2-□B, or MR-J5W3-□B) through a Motion controller (R16MTCPU, R32MTCPU, or 
R64MTCPU) or Simple Motion module (RD77MS4, RD77MS8, or RD77MS16).

• The connection to a servo amplifier (MR-J5-□G(-RJ), MR-J5W2-□G, MR-J5W3-□G, or MR-JET-□G) 
through the CC-Link IE TSN master/local module (RJ71GN11-T2) is supported.
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Apr., 2023 SH(NA)-081201ENG-AP Compatible with GT SoftGOT2000 Version1.295H
• The connection to the MELSEC iQ-L series (L32HCPU) is supported.
• Support for GT SoftGOT2000 running on Windows Server 2012, Windows Server 2008, Windows 8.1, 

Windows 8, and Windows 7 has ended.
• The connection to a servo amplifier (MR-J5-□G(-RJ), MR-J5W2-□G, MR-J5W3-□G, or MR-JET-□G) 

through the CC-Link IE TSN Plus master/local module (RJ71GN11-EIP) is supported.
• GS2512-WXTBD is supported.

Jul., 2023 SH(NA)-081201ENG-AQ Compatible with GT SoftGOT2000 Version1.300N
• GT SoftGOT2000 (Multiple channels) supports the Ethernet connection to FX5UJ through the CC-Link 

IE TSN master/local module (FX5-CCLGN-MS).

Oct., 2023 SH(NA)-081201ENG-AR Partial corrections

Jan., 2024 SH(NA)-081201ENG-AS Compatible with GT SoftGOT2000 Version 1.310Y
• The connection to a servo amplifier (MR-J5-□B(-RJ), MR-J5W2-□B, or MR-J5W3-□B) via a Motion 

controller (Q170MSCPU) is supported.
• Descriptions of PDFium, Perl-Compatible Regular Expressions, OpenJPEG, Little cms color engine, 

FreeTypeProject, JQuery, JQuery Marquee, JQuery UI, CreateJS, Web Font Loader, jsSHA, and 
libexpat have been added.

Jul., 2024 SH(NA)-081201ENG-AT Compatible with GT SoftGOT2000 Version1.320J
• MELSOFT Mirror is supported.
• Microsoft Windows 10 IoT Enterprise 2021 LTSC is supported.

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot 
be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

©2013 MITSUBISHI ELECTRIC CORPORATION
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Intellectual Property Rights
Trademarks
MELDAS, MELSEC, iQ Platform, MELSOFT, GOT, CC-Link, CC-Link/LT, and CC-Link IE are trademarks or registered 
trademarks of Mitsubishi Electric Corporation in Japan and other countries.
Microsoft, Microsoft Access, Excel, SQL Server, Visual Basic, Visual C++, Visual C#, Windows, Windows NT, Windows 
Server, and Windows Vista are trademarks of the Microsoft group of companies.
MODBUS is a registered trademark of Schneider Electric SA.
DeviceNet is a trademark of ODVA (Open DeviceNet Vendor Association, Inc.).
VNC is a registered trademark of RealVNC Ltd. in the United States and other countries.
Unicode is a trademark or registered trademark of Unicode, Inc. in the United States and other countries.
PictBridge is a registered trademark of Canon Inc.
Adobe and Adobe Reader are registered trademarks of Adobe Systems Incorporated.
Oracle and JavaScript are registered trademarks of Oracle Corporation and/or its affiliates in the United States and other 
countries.
QR Code is a trademark or registered trademark of DENSO WAVE INCORPORATED in Japan, the United States, and/or 
other countries.
Anybus is a registered trademark of HMS Industrial Networks AB.
Android and Google Chrome are trademarks or registered trademarks of Google Inc.
IOS is a trademark or registered trademark of Cisco in the United States and other countries and is used under license.
Safari and iPhone are trademarks of Apple Inc. registered in the United States and other countries. The iPhone trademark is 
used under license from AIPHONE CO., LTD.
Intel and Intel Core are trademarks or registered trademarks of Intel Corporation in the United States and other countries.
Other company and product names herein are trademarks or registered trademarks of their respective owners.
Copyrights
The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
VS-FlexGrid Pro
Copyright © 2003 ComponentOne LLC.
SPREAD
Copyright © 1999 FarPoint Techonologies, Inc.
"OPC UA Client Server SDK" is used in this product.
C++ based OPC UA Client SDK
(c)2006-2019 Unified Automation GmbH. All rights reserved
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